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This manual describes the following R&S®SGT100A, stock no. 1419.4501.02 and its options.
● R&S®SGT-B1, Reference Oscillator OCXO (1419.5608.02)
● R&S®SGT-B88, Extension Unit (1419.8207.02)
● R&S®SGT-KB106, Frequency extension to 6 GHz (1419.5708.02)
● R&S®SGT-K16, Diff. analog I/Q outputs
● R&S®SGT-K18, Digital baseband connectivity (1419.6240.02)
● R&S®SGT-K22, Pulse modulation (1416.6279.02)
● R&S®SGT-K62, Additive White Gaussian Noise (AWGN) (1419.6304.02)
● R&S®SGT-K90, Phase Coherent Input/Output (1419.6333.02)
● R&S®SGT-K510, ARB baseband generator (1419.7500.02)
● R&S®SGT-K511/512, ARB memory extension (1419.6362.02/1419.6391.02)
● R&S®SGT-K521/522, ARB bandwidth extension (1419.6247.02/1419.6456.02)
● R&S®SGT-K523, Baseband Extension to 240 MHz (1419.7952.02)
● R&S®SGT-K540, Envelope Tracking (1419.7800.02)
● R&S®SGT-K541, AM/AM AM/PM Predistortion (1419.7852.02)
● R&S®SGT-K543, Envelope ARB (1419.7900.02)
● R&S®SGT-K548, Crest Factor Reduction (1419.8471.02)
● R&S®SGT-K200, Waveform package for signals from R&S®WinIQSIM2TM (1419.5850.71/72/75)
● R&S®SGT-K110/-K111/-K112-/K113/-K114/-K115-/K116/-K117/-K118/-K119/-K120/-K121/-K122/-K151,

Waveform Libraries for ARB Generator

This manual describes firmware version FW 5.00.232.xx and later of the R&S®SGT100A.
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1  Safety and regulatory information
The product documentation helps you use the product safely and efficiently. Follow the
instructions provided here and in the following chapters.

Intended use

The product is intended for the development, production and verification of electronic
components and devices in industrial, administrative, and laboratory environments.
Use the product only for its designated purpose. Observe the operating conditions and
performance limits stated in the data sheet.

Where do I find safety information?

Safety information is part of the product documentation. It warns you of potential dan-
gers and gives instructions on how to prevent personal injury or damage caused by
dangerous situations. Safety information is provided as follows:
● In Chapter 1.1, "Safety instructions", on page 11. The same information is provi-

ded in many languages as printed "Safety Instructions". The printed "Safety
Instructions" are delivered with the product.

● Throughout the documentation, safety instructions are provided when you need to
take care during setup or operation.

1.1  Safety instructions

Products from the Rohde & Schwarz group of companies are manufactured according
to the highest technical standards. To use the products safely, follow the instructions
provided here and in the product documentation. Keep the product documentation
nearby and offer it to other users.

Use the product only for its intended use and within its performance limits. Intended
use and limits are described in the product documentation such as the data sheet,
manuals and the printed "Safety Instructions". If you are unsure about the appropriate
use, contact Rohde & Schwarz customer service.

Using the product requires specialists or specially trained personnel. These users also
need sound knowledge of at least one of the languages in which the user interfaces
and the product documentation are available.

Reconfigure or adjust the product only as described in the product documentation or
the data sheet. Any other modifications can affect safety and are not permitted.

Never open the casing of the product. Only service personnel authorized by
Rohde & Schwarz are allowed to repair the product. If any part of the product is dam-
aged or broken, stop using the product. Contact Rohde & Schwarz customer service at
https://www.rohde-schwarz.com/support.

Safety instructions

https://www.rohde-schwarz.com/support
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Lifting and carrying the product

The maximum weight of the product is provided in the data sheet. You can lift or carry
the product by yourself, if you can manage the weight on your own. Alternatively, you
can use lifting or transporting equipment. Follow the instructions provided by the equip-
ment manufacturer.

Choosing the operating site

Only use the product indoors. The product casing is not waterproof. Water that enters
can electrically connect the casing with live parts, which can lead to electric shock,
serious personal injury or death if you touch the casing. If Rohde & Schwarz provides
accessories designed for your product, e.g. a carrying bag, you can use the product
outdoors.

Unless otherwise specified, you can operate the product up to an altitude of 2000 m
above sea level. The product is suitable for pollution degree 2 environments where
nonconductive contamination can occur. For more information on environmental condi-
tions such as ambient temperature and humidity, see the data sheet.

Setting up the product

Always place the product on a stable, flat and level surface with the bottom of the prod-
uct facing down. If the product is designed for different positions, secure the product so
that it cannot fall over.

If the product has foldable feet, always fold the feet completely in or out to ensure sta-
bility. The feet can collapse if they are not folded out completely or if the product is
moved without lifting it. The foldable feet are designed to carry the weight of the prod-
uct, but not an extra load.

If stacking is possible, keep in mind that a stack of products can fall over and cause
injury.

If you mount products in a rack, ensure that the rack has sufficient load capacity and
stability. Observe the specifications of the rack manufacturer. Always install the prod-
ucts from the bottom shelf to the top shelf so that the rack stands securely. Secure the
product so that it cannot fall off the rack.

Connecting to power

The product is an overvoltage category II product. Connect the product to a fixed
installation used to supply energy-consuming equipment such as household applian-
ces and similar loads. Keep in mind that electrically powered products have risks, such
as electric shock, fire, personal injury or even death. Replace parts that are relevant to
safety only by original parts, e.g. power cables or fuses.

Take the following measures for your safety:
● Before switching on the product, ensure that the voltage and frequency indicated

on the product match the available power source. If the power adapter does not
adjust automatically, set the correct value and check the rating of the fuse.

● Only use the power cable delivered with the product. It complies with country-spe-
cific safety requirements. Only insert the plug into an outlet with protective conduc-
tor terminal.

Safety instructions
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● Only use intact cables and route them carefully so that they cannot be damaged.
Check the power cables regularly to ensure that they are undamaged. Also ensure
that nobody can trip over loose cables.

● If you connect the product to an external power supply, use the one delivered with
the product or recommended in the product documentation. The external power
supply must conform to the country-specific regulations.

● Only connect the product to a power source with a fuse protection of maximum
20 A.

● Ensure that you can disconnect the product from the power source at any time.
Pull the power plug to disconnect the product. The power plug must be easily
accessible. If the product is integrated into a system that does not meet these
requirements, provide an easily accessible circuit breaker at the system level.

Cleaning the product

Use a dry, lint-free cloth to clean the product. When cleaning, keep in mind that the
casing is not waterproof. Do not use liquid cleaning agents.

Meaning of safety labels

Safety labels on the product warn against potential hazards.

Potential hazard

Read the product documentation to avoid personal injury or product damage.

Electrical hazard

Indicates live parts. Risk of electric shock, fire, personal injury or even death.

Hot surface

Do not touch. Risk of skin burns. Risk of fire.

Protective conductor terminal

Connect this terminal to a grounded external conductor or to protective ground. This connec-
tion protects you against electric shock if an electric problem occurs.

1.2  Labels on R&S SGT

Labels on the casing inform about:
● Personal safety, see "Connecting to power" on page 12.
● Product and environment safety, see Table 1-1.
● Identification of the product, see the serial number on the rear panel.
Table 1-1: Labels regarding R&S SGT and environment safety

Labeling in line with EN 50419 for disposal of electrical and electronic equipment after the prod-
uct has come to the end of its service life. For more information, see Chapter 14, "Maintenance,
storage and disposal", on page 586.

Labels on R&S SGT
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1.3  Warning messages in the documentation

A warning message points out a risk or danger that you need to be aware of. The sig-
nal word indicates the severity of the safety hazard and how likely it will occur if you do
not follow the safety precautions.

WARNING

Potentially hazardous situation. Could result in death or serious injury if not avoided.

CAUTION

Potentially hazardous situation. Could result in minor or moderate injury if not avoided.

NOTICE

Potential risks of damage. Could result in damage to the supported product or to other
property.

1.4  Korea certification class A

이 기기는 업무용(A급) 전자파 적합기기로서 판매자 또는 사용자는 이 점을 주의하시기
바라며, 가정외의 지역에서 사용하는 것을 목적으로 합니다.

Korea certification class A
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2  Welcome
The R&S SGT is a signal generator intended for the generation of IQ-modulated sig-
nals and the playback and output of externally calculated modulation signals in the
form of waveforms.

Optimized for use in automated test equipment (ATE), the instrument offers fast settling
times in an exceptionally small form factor and low power consumption. The R&S SGT
is equipped with an active electronic step attenuator and can be equipped optionally
with a high stability reference oscillator.

2.1  Key features

The key features of the R&S SGT include the following:

● Compact size and low power consumption
● Remote connection via PCI Express, minimizing the setup time

Alternatively, LAN or USB connections available
● Coherent LO input and output connectors, also usable as MIMO input/output and

phase coherent I/Q demodulation
● Linux operating system
● Graphical user interface R&S SGMA-GUI to set up and control one or more

R&S SGT instruments simultaneously from one remote computer, available for
Windows and Linux systems

2.2  What's new

This manual describes firmware version FW 5.00.232.xx and later of the
R&S®SGT100A.

Compared to the previous version, it provides the new features listed below:
● Peak cancelation algorithm added for crest factor reduction (R&S SGT-K548):

– Background information on the algorithm, see "Peak cancellation algorithm"
on page 136.

– Algorithm settings, see "Algorithm" on page 138, "Cancellation Pulse Band-
width" on page 141 and "Transition Bandwidth" on page 141.

● Instrument security settings for LAN interface and LAN services added:
– LAN interface added, see "LAN Interface" on page 285.
– Remote commands for LAN service states added, see Chapter 10.16, "SYS-

Tem subsystem", on page 533.
● Editorial changes

What's new
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2.3  Documentation overview

This section provides an overview of the R&S SGT user documentation. Unless speci-
fied otherwise, you find the documents at:

www.rohde-schwarz.com/manual/sgt100a

2.3.1  User manual and help

Separate manuals for the base unit and the software options are provided for down-
load:
● Base unit manual

Contains the description of all instrument modes and functions. It also provides an
introduction to remote control, a complete description of the remote control com-
mands with programming examples, and information on maintenance, instrument
interfaces and error messages. Includes the contents of the getting started manual.

● Software option manual
Contains the description of the specific functions of an option. Basic information on
operating the R&S SGT is not included.

The contents of the user manuals are available as help in the R&S SGT. The help
offers quick, context-sensitive access to the complete information for the base unit and
the software options.

2.3.2  Data sheets and brochures

The data sheet contains the technical specifications of the R&S SGT. It also lists the
options and their order numbers and optional accessories.

The brochure provides an overview of the instrument and deals with the specific char-
acteristics.

See www.rohde-schwarz.com/brochure-datasheet/sgt100a

2.3.3  Release notes and open source acknowledgment (OSA)

The release notes list new features, improvements and known issues of the current
firmware version, and describe the firmware installation.

The open source acknowledgment document provides verbatim license texts of the
used open source software.

See www.rohde-schwarz.com/firmware/sgt100a

2.3.4  Application notes, application cards, white papers, etc.

These documents deal with special applications or background information on particu-
lar topics.

Documentation overview

http://www.rohde-schwarz.com/manual/sgt100a
http://www.rohde-schwarz.com/brochure-datasheet/sgt100a
http://www.rohde-schwarz.com/firmware/sgt100a
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See www.rohde-schwarz.com/application/sgt100a.

2.4  Typographical conventions

The following text markers are used throughout this documentation:

Convention Description

"Graphical user interface ele-
ments"

All names of graphical user interface elements on the screen, such as
dialog boxes, menus, options, buttons, and softkeys are enclosed by
quotation marks.

[Keys] Key and knob names are enclosed by square brackets.

Filenames, commands,
program code

Filenames, commands, coding samples and screen output are distin-
guished by their font.

Input Input to be entered by the user is displayed in italics.

Links Links that you can click are displayed in blue font.

"References" References to other parts of the documentation are enclosed by quota-
tion marks.

2.5  Notes on screenshots

When describing the functions of the product, we use sample screenshots. These
screenshots are meant to illustrate as many as possible of the provided functions and
possible interdependencies between parameters. The shown values may not represent
realistic usage scenarios.

The screenshots usually show a fully equipped product, that is: with all options instal-
led. Thus, some functions shown in the screenshots may not be available in your par-
ticular product configuration.

Notes on screenshots

http://www.rohde-schwarz.com/application/sgt100a


Getting startedR&S®SGT100A

18User Manual 1176.8674.02 ─ 12

3  Getting started

3.1  Preparing for use

Here, you can find basic information about setting up the product for the first time.

3.1.1  Lifting and carrying

See also "Lifting and carrying the product" on page 12.

► Use the carrying handles at the side for lifting and carrying the R&S SGT.
The handles at the front are only for pushing and pulling the instrument when
mounting in a rack, see Chapter 3.1.4.2, "Mounting the R&S SGT in a rack",
on page 20.

3.1.2  Unpacking and checking

1. Unpack the R&S SGT carefully.

2. Retain the original packing material. Use it to protect the control elements and con-
nectors when transporting or shipping the R&S SGT later.
See also Chapter 13, "Transporting", on page 585.

3. Using the delivery notes, check the equipment for completeness.

4. Check the equipment for damage.

If the delivery is incomplete or equipment is damaged, contact Rohde & Schwarz.

3.1.3  Choosing the operating site

Specific operating conditions ensure proper operation and avoid damage to the prod-
uct and connected devices. For information on environmental conditions such as ambi-
ent temperature and humidity, see the data sheet.

For safety information, see "Choosing the operating site" on page 12.

Electromagnetic compatibility classes

The electromagnetic compatibility (EMC) class indicates where you can operate the
product. The EMC class of the product is given in the data sheet.
● Class B equipment is suitable for use in:

– Residential environments
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– Environments that are directly connected to a low-voltage supply network that
supplies residential buildings

● Class A equipment is intended for use in industrial environments. It can cause
radio disturbances in residential environments due to possible conducted and radi-
ated disturbances. It is therefore not suitable for class B environments.
If class A equipment causes radio disturbances, take appropriate measures to
eliminate them.

3.1.4  Setting up the R&S SGT

See also:
● "Setting up the product" on page 12
● "Intended use" on page 11

3.1.4.1  Placing the R&S SGT on a bench top

To place the product on a bench top

1. Place the product on a stable, flat and level surface. Ensure that the surface can
support the weight of the product. For information on the weight, see the data
sheet.

2. WARNING! A stack of products can fall over and cause injury. Never stack more
than three products on top of each other. Instead, mount them in a rack.
Stack as follows:

● If the products have foldable feet, fold them in completely.
● It is best if all products have the same dimensions (width and length). If the

products have different dimensions, stack according to size and place the
smallest product on top.

● Do not exceed the permissible total load placed on the product at the bottom of
the stack:
– 50 kg when stacking products of identical dimensions (left figure).
– 25 kg when stacking smaller products on top (middle figure).
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Left = Stacked correctly, same dimensions
Middle = Stacked correctly, different dimensions
Right = Stacked incorrectly, too many products

3. NOTICE! Overheating can damage the product.
Prevent overheating as follows:

● Keep a minimum distance of 10 cm between the fan openings of the product
and any object in the vicinity.

● Do not place the product next to heat-generating equipment such as radiators
or other products.

3.1.4.2  Mounting the R&S SGT in a rack

To prepare the rack

1. Observe the requirements and instructions in "Setting up the product" on page 12.

2. NOTICE! Insufficient airflow can cause overheating and damage the product.
Design and implement an efficient ventilation concept for the rack.

To mount the R&S SGT in a rack

1. Use an adapter kit that fits the dimensions of the R&S SGT to prepare the instru-
ment for rack mounting.

a) Order the rack adapter kit designed for the R&S SGT. For the order number,
see data sheet.

b) Mount the adapter kit. Follow the assembly instructions provided with the
adapter kit.

2. Push the R&S SGT onto the shelf until the rack brackets fit closely to the rack.

3. Tighten all screws at the rack brackets with a tightening torque of 1.2 Nm to secure
the R&S SGT in the rack.

To unmount the R&S SGT from a rack

1. Loosen the screws at the rack brackets.

2. Remove the R&S SGT from the rack.

3. If placing the R&S SGT on a bench top again, unmount the adapter kit from the
R&S SGT. Follow the instructions provided with the adapter kit.

3.1.5  Considerations for test setup

Cable selection and electromagnetic interference (EMI)

Electromagnetic interference (EMI) can affect the measurement results.
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To suppress electromagnetic radiation during operation:
● Use high-quality shielded cables, especially for the following connector types:

– SMA/SMB
Double-shielded SMA/SMB cables.
How to: Chapter 3.1.8, "Connecting to RF 50Ω", on page 22

– USB
Double-shielded USB cables.
How to: Chapter 3.1.13.4, "Connecting a controller via USB", on page 31.

– LAN
At least CAT6 STP cables.
How to: Chapter 3.1.7, "Connecting to LAN", on page 22

● Always terminate open cable ends.
● Ensure that connected external devices comply with EMC regulations.
● Use cables of the same type and equal length for connection to the I/Q and I/Q Bar

interfaces of the instrument.
● Use the cable R&S SMU-Z6 for connection to the "DIG I/Q" interface of the instru-

ment. The cable is available under material number 1415.0201.02.

Signal input and output levels

Information on signal levels is provided in the data sheet. Keep the signal levels within
the specified ranges to avoid damage to the R&S SGT and connected devices.

Preventing electrostatic discharge (ESD)

Electrostatic discharge is most likely to occur when you connect or disconnect a DUT.

► NOTICE! Electrostatic discharge can damage the electronic components of the
product and the device under test (DUT).
Ground yourself to prevent electrostatic discharge damage:

a) Use a wrist strap and cord to connect yourself to ground.
b) Use a conductive floor mat and heel strap combination.

3.1.6  Connecting to power

For safety information, see "Connecting to power" on page 12.

1. Plug the AC power cable into the AC power connector on the rear panel of the
instrument. Only use the AC power cable delivered with the R&S SGT.

2. Plug the AC power cable into a power outlet with ground contact.

The required ratings are listed next to the AC power connector and in the data
sheet.

There is no need to set the voltage manually or change fuses.
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3.1.7  Connecting to LAN

Network environment

Before connecting the product to a local area network (LAN), consider the following:
● Install the latest firmware to reduce security risks.
● For internet or remote access, use secured connections if applicable.
● Ensure that the network settings comply with the security policies of your company.

Contact your local system administrator or IT department before connecting your
product to your company LAN.

● When connected to the LAN, the product may potentially be accessed from the
internet, which may be a security risk. For example, attackers might misuse or
damage the product.

To connect to LAN

The connector is on the rear panel.

► Connect the LAN socket via an RJ-45 cable to the LAN.

By default, the R&S SGT is configured to use DHCP (dynamic host configuration proto-
col) and no static IP address is configured.

3.1.8  Connecting to RF 50Ω

The connector is on the rear panel.

Option R&S SGT-B88: The RF output connector is on the front panel.

To prepare for connecting to RF 50Ω

1. NOTICE! Damaged or not clean connections can lead to RF insertion loss and mis-
match, and even premature wear of the connectors.
Before connecting to the port, inspect the RF connector visually to check that it is
clean, undamaged and mechanically compatible.
See the application note 1MA99 for information on how to handle and maintain the
RF port, to minimize measurement deviations and ensure its longevity.

2. NOTICE! Risk of instrument damage. Excessive reverse power or DC voltage at
the RF 50Ω connector can damage the instrument.
Make sure that the values do not exceed the reverse power and DC limits as given
in the data sheet.

3. If switched-on, deactivate the RF output of the R&S SGT, before connecting an RF
cable to the RF 50Ω connector.
On the front panel, press the [RF ON] key.
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To connect to screwable connectors

Additional to the RF 50Ω connector, the following procedure holds for all screwable
connectors of the R&S SGT. Screwable connectors include connector types as listed in
Table 3-1.

1. Use a high-quality cable that matches the connector type.
See "Cable selection and electromagnetic interference (EMI)" on page 20.

2. NOTICE! Excessive tightening can damage the connectors.
To connect the cable with the connector, proceed as follows:

a) Carefully align the connector of the cable and the connector along a common
axis.

b) Mate the connectors along the common axis until the male pin of the inner con-
nector engages with the female socket of the outer connector.

c) Turn the nut of the outer connector until the connectors are firmly coupled.
d) Torque the nut to the specified limit using a calibrated torque wrench. Hold the

opposite connector part stationary with a spanner.
For torque limits of the most relevant connector types, see Table 3-1. For more
information, see chapter "Handling" of the application note 1MA99.

3. Torque the nut to the specified limit using a calibrated torque wrench. Hold the
opposite connector part stationary with a spanner.

Table 3-1: Connector types and torque limits

Type Torque limit Nut opening

 lb-Inch Nm Inch mm

N 13.3 1.5 3/4 20

SMA

SMB

5 0.56 5/16 8

To prevent RF output switch-off

► NOTICE! If you set a too high output level without a load connected to the instru-
ment, the reverse power can exceed a limit forcing the R&S SGT to switch off the
RF output.
Connect a load with sufficient return loss.

3.1.9  Connecting to non-screwable connectors

Non-screwable connectors of the R&S SGT are BNC type connectors on the rear
panel.

► To connect the RF cable with the RF 50Ω connector, proceed as follows:

a) Carefully align the connector of the cable and the RF 50Ω connector along a
common axis.
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b) Mate the connectors along the common axis until the male pin of the connector
of the cable engages with the female socket of the RF 50Ω connector.

3.1.10  Switching on or off

The following table provides an overview of power states, LEDs and power switch posi-
tions.
Table 3-2: Overview of power states

State LED Position of power switch

Off  gray [0]

Standby  orange [I]

Ready  green [I]

To switch on the R&S SGT

The R&S SGT is off but connected to power. See Chapter 3.1.6, "Connecting to
power", on page 21.

1. Set the switch on the power supply to position [I].
The switch is on the rear panel.

The LED of the [POWER ON/STANDBY] key is orange.

2. If equipped with an oven-controlled oscillator (OCXO), option R&S SGT-B1, wait
until the OCXO warms up.
For the warm-up time, see data sheet.

3. Press the [POWER ON/STANDBY] key.
Key and LED are on the front panel.

The LED changes to green. The R&S SGT boots.

When starting for the first time, the R&S SGT starts with the default settings. When
restarting the instrument, the settings depend on the instrument configuration
before shut-down.
See Chapter 5.1.1, "File menu", on page 54.

To perform functional checks

When the instrument is switched on, it automatically monitors main functions. You can
query erroneous functions.

See Chapter 12, "Error messages and troubleshooting", on page 581.

In addition to the automatic monitoring, the R&S SGT offers the following capabilities to
ensure correct functioning:
● Internal adjustments

In the R&S SGMA-GUI, select the "Instrument > Setup > Internal Adjustments" dia-
log to access the dialog for performing and configuring the adjustments settings. A
maximum level accuracy can be obtained, for instance.
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● Selftest
A selftest is provided for service purposes ("SGMA-GUI > Instrument > Diagnostic/
Test > Self Test").

To switch between standby and ready state

► Press the [POWER ON/STANDBY] key briefly to switch the instrument from the
standby to ready state or vice versa.

In ready state, the button is green. The instrument is ready for operation. All mod-
ules are power-supplied and the R&S SGT initiates its startup procedure.
In standby state, the button is orange. The standby power only supplies the power
switch circuits and built-in oscillator to keep it at its operating temperature. The
remote control system is not active.

To start up and boot

The instrument boots the operating system and starts the instrument firmware. During
the booting process, the green [POWER ON/STANDBY] key blinks. If the previous ses-
sion was terminated regularly, the instrument uses the last setup with the relevant
instrument settings.

Once the startup procedure has been terminated, the instrument is ready for operation.

In the R&S SGMA-GUI, select "Instrument > Preset" function to return the instrument
to its defined reset/preset state, if the current setup is no longer relevant.

To customize the start settings, use the "SGMA-GUI > File > Save As/Open" function.

To shut down the product

The product is in the ready state.

► Press the [POWER ON/STANDBY] key.

The operating system shuts down. The LED changes to orange.

In standby state, the power switch circuits and the OCXO are active. To deactivate
them, disconnect the instrument from the power supply.

To disconnect from power

The R&S SGT is in the standby state.

1. NOTICE! Risk of data loss. If you disconnect the product from power when it is in
the ready state, you can lose settings and data. Shut it down first.
Set the toggle switch on the power supply to position [0].

The LED of the [POWER ON/STANDBY] key is switched off.

2. Disconnect the R&S SGT from the power source.
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3.1.11  Checking default settings

When the instrument is switched on, it is not the preset state that is active, but rather
the instrument state that was set before the instrument was switched off. It is recom-
mended that you use the "SGMA-GUI > Instrument > Preset" function to return the
instrument to its defined preset state every time a new configuration is required or the
current setup is no longer relevant.

The R&S SGT offers a two-stage preset concept:
● Preset the instrument to a predefined state.

The "SGMA-GUI > Instrument Name > Preset" function calls up a defined instru-
ment setup. All parameters and switching states are preset. The default instrument
settings provide a reproducible initial basis for all other settings. However, functions
that concern the integration of the instrument into a measurement setup are not
changed.

● Preset the instrument to its factory settings.
The instrument can also be forced to load its default factory settings. To access the
corresponding dialog box, select the "SGMA-GUI > Instrument Name > Setup >
Factory Preset" function.
For more information and an overview of the settings affected by the factory preset
function, see Chapter 7.12, "Factory preset", on page 294.

User-defined instrument states can be stored and called up using the functions
"SGMA-GUI > File > Save As/Open".

3.1.12  Working with Linux operating system

The instrument uses an embedded Linux operating system, optimally adapted to the
instrument.

Accessing the operating system
No access to the operating system is required for normal operation.
All necessary system settings can be made in the "Setup" dialog.

3.1.13  Connecting an external PC and devices

For control and operation, the R&S SGT requires a connection to an external device.
The external device, e.g. an external PC, controls the R&S SGT via remote control or
manual operation via the R&S SGMA-GUI software installed on the external PC.

Both the remote control and the manual operation of the instrument require an external
controller. For the prerequisites and the instructions on how to configure an external
controller for remote control, refer to the user manual. A brief introduction to the remote
control capabilities is provided in Chapter 9, "Network operation and remote control",
on page 312.
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This section gives an introduction on how to configure the external PC for manual
operation. See Chapter 3.1.13.1, "Installing the R&S SGMA-GUI software",
on page 27.

In addition to connecting an external controller, you can connect other external devi-
ces, e.g. a memory stick. The following interfaces are on the rear panel of the
R&S SGT:

● "LAN": Chapter 3.1.13.2, "Connecting a remote PC via LAN", on page 28
● "PCIe": Chapter 3.1.13.3, "Connecting a controller via PCI Express", on page 31
● "USB IN": Chapter 3.1.13.4, "Connecting a controller via USB", on page 31

3.1.13.1  Installing the R&S SGMA-GUI software

The R&S SGMA-GUI software is a graphical user interface program for one or more
instruments. It runs on a remote PC.

The R&S SGMA-GUI software is provided as separate installation package for the dif-
ferent operating systems. The latest version of the software together with the release
notes is available for download at:

http://www.rohde-schwarz.com/product/SGT100A.html > "Downloads" > "Software"

This page always offers the latest information on your R&S SGMA-GUI.

The R&S SGMA-GUI installation package for Windows 64-bit operating system con-
sists of the file SGMA-GUI_<version_number>.exe. The version number within the
file name (<version_number>=v.vv.vvv.vv) varies with each update.

To install the R&S SGMA-GUI, check that you PC and drivers fulfill the following hard-
ware and software requirements.
Table 3-3: Hardware and software requirements

Requirement Remark

Operating system:

Windows 10, 1607 "Anniver-
sary Edition" and later

Install R&S SGMA-GUI on one of the supported operating systems. Also,
make sure that Microsoft offers support for the version of the operating sys-
tem.

Note: Any other Windows version or other operating systems are not sup-
ported. During installation, the operation system is checked. The installation
is terminated if this requirement is not fulfilled.

System type:
● 64-bit operating system
● x64-based or x86-based

processor

You can only run the latest software on a 64-bit operating system.

R&S VISA VISA drivers can be obtained on the Rohde & Schwarz website:

http://www.rohde-schwarz.com/rsvisa

CPU At least Pentium or compatible, as from 1 GHz (recommended).

VGA color display resolution At least 800*600 pixels

Installing a new software version

1. Download the R&S SGMA-GUI software.
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2. In Windows Explorer, navigate to the download folder of the installation file
SGMA-GUI_V.VV.VVV.VV.exe (<version_number>=v.vv.vvv.vv).

3. Open the installation file using administrator rights.

4. Follow the instructions in the installation wizard.

After the installation of the R&S SGMA-GUI software, two icons will be shown in your
Windows menu: one is the standard version and one for which the remote command of
the software through SCPIs is disabled. The SCPI disabled version allows you to install
and use the R&S SGMA-GUI on other instruments, without interfering with the remote
control of the host instrument.

Start the version that is required for your application.

Uninstalling an old software version

You can uninstall a previous version of the software before the installing a new soft-
ware version, but this step is not mandatory.

1. To uninstall this version, go to "Start > Settings > Control Panel > Add/Remove
Programs".

2. Select the entry SGMA-GUI_V.VV.VVV.VV.

The script file identifies and removes all currently installed R&S SGMA-GUI soft-
ware items.

3.1.13.2  Connecting a remote PC via LAN

The R&S SGT is equipped with a network interface and can be connected to an Ether-
net LAN (local area network). The interface can be used, for example:

● To connect an external computer for manual control of the instrument by the R&S
SGMA-GUI software.

● To operate the device by a remote control program.
See Chapter 9, "Network operation and remote control", on page 312.

This section describes how to configure the LAN interface. It covers the following top-
ics:

● Connecting to the network...................................................................................... 29
● Assigning the IP address........................................................................................ 29
● Adding instruments to R&S SGMA-GUI..................................................................31
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Connecting to the network

There are two methods to establish a LAN connection to the instrument:

● A non-dedicated network (Ethernet) connection from the instrument to an existing
network.

● A dedicated network connection (Point-to-point connection) between the instru-
ment and a single computer.

In both cases, an IP address has to be assigned to the instrument and the computer,
see "Assigning the IP address" on page 29.

Setting up a non-dedicated network (LAN) connection

► See Chapter 3.1.7, "Connecting to LAN", on page 22.

Setting up a dedicated network connection

If your network does not support DHCP, set a dedicated network connection between a
stand-alone PC and a R&S SGT.

Prerequisite: The external PC and the R&S SGT are turned on and running.

1. Start the R&S SGMA-GUI.

2. Connect the computer and the R&S SGT with a LAN network cable.

3. Wait for about one minute for the automatic assignment of IP addresses to com-
plete.

4. R&S SGMA-GUI main panel, select "Setup > Instruments".

5. In the "Configure Instruments" dialog, click "Scan".

The new instrument appears with a Zeroconf IP address 169.254.xx.yy.

6. To assign a static IP address to the instrument, see "Assigning a static IP address
to the R&S SGT" on page 30.

7. To assign a static IP address to the PC, see "Assigning a static IP address to your
Windows-PC network card" on page 30.

Assigning the IP address

Depending on the network capacities, the TCP/IP address information for the instru-
ment can be obtained in different ways.
● If the network supports dynamic TCP/IP configuration using the Dynamic Host

Configuration Protocol (DHCP), all address information can be assigned automati-
cally.

● If the network does not support DHCP, the instrument tries to obtain the IP address
via Zeroconf (APIPA) protocol. If this attempt does not succeed or if the instrument
is set to use, alternate TCP/IP configuration, the addresses must be set manually,
see "Setting up a dedicated network connection" on page 29.
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The R&S SGT uses the Zeroconf IP addresses 169.254.xxx.yyy, where xxx takes val-
ues from 1 to 254 and yyy the values from 1 to 255. The subnet mask is always
255.255.0.0. The IP address of the host must be within the same address area for Zer-
oconf.

Assigning a static IP address to the R&S SGT

Prerequisites: A connection is established between the R&S SGT and the controller
with installed SGMA-GUI.

For how to set up a LAN connection, see "Connecting to the network" on page 29.

For how to set up a USB connection, see "Setting up a USB connection from a PC to
the R&S SGT" on page 32.

1. Open "SGMA-GUI > Instrument > Setup > Network Settings" dialog.

2. Set the "Address Mode" to "Static".

3. Enter the "IP Address", for example 192.168.0.1..

4. Enter the "Subnet mask", for example 255.255.255.0.

5. Enter the "Default Gateway", for example 192.168.0.1.

Assigning a static IP address to your Windows-PC network card

1. Obtain the IP address and subnet mask for the R&S SGT and the IP address for
the local default gateway from your network administrator. If necessary, also obtain
the name of your DNS domain and the IP addresses of the DNS and WINS servers
on your network. If you use more than one LAN connector, you need separate
address information for each connector.

2. Press the "Windows" key to access the operating system.

3. Open the "Control Panel" by selecting "Start > Settings > Control Panel".

4. Select "Network and Sharing Center".

5. In the left panel, click "Change adapter settings".

6. Select the network adapter that you want to change. Click "Change settings of this
connection".

7. On the "Networking" tab, click "Internet Protocol Version 4 (TCP/IPv4)". Select
"Properties".

8. Select "Use the following IP address".

9. Enter the address information as obtained from the network administrator.

10. If necessary, you can also select "Use the following DNS server addresses" and
enter your own DNS addresses.

For more information, refer to your Windows system help.
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Adding instruments to R&S SGMA-GUI

For information on how to install the R&S SGMA-GUI software, refer to Chap-
ter 3.1.13.1, "Installing the R&S SGMA-GUI software", on page 27.

1. For each new instrument perform the following steps:

a) Connect the instrument to the network.
b) Press the [POWER ON/STANDBY] key to switch on the instrument.
c) Wait until the [POWER ON/STANDBY] LED is green and not blinking.
d) Press the [ID] key on the front panel of the instrument.

2. Start the SGMA-GUI on a computer connected to the same network.

3. Open the "Instruments" dialog.

4. Select "Scan".

Note: This step is performed automatically on the first start and can also be omit-
ted for instruments with a direct LAN connection to the computer.

All instruments are added automatically to the main panel of the SIGMA-GUI.

3.1.13.3  Connecting a controller via PCI Express

Using the "PCIe" interface for remote control of the R&S SGT requires extended
knowledge. See Chapter 9.3, "Advanced remote control using PCIe", on page 322.

3.1.13.4  Connecting a controller via USB

The USB interface on the rear panel of the R&S SGT allows you to connect either a
USB device or use the R&S SGT as a device and connect it to a controller.

Connecting a controller (host PC or compatible signal generator)

If you connect a controller (host PC or compatible signal generator) to the R&S SGT,
the R&S SGT acts as a USB device.

To connect the controller to the USB interface of the R&S SGT, always connect the
USB type Micro-B connector to the R&S SGT. Refer to the documentation of the con-
troller to find out which USB connector type you can connect to the controller.

The Figure 3-1 illustrates schematically the required connector type to emphasize on
the different connector shape.

Figure 3-1: USB type Micro-B connectors
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An external PC with installed R&S SGMA-GUI is required for manual operation of the
R&S SGT.

Setting up a USB connection from a PC to the R&S SGT

If your network does not support DHCP, you can set a USB connection between a PC
and a R&S SGT.

Prerequisite: the computer and the R&S SGT are turned on and running.

1. Start the R&S SGMA-GUI.

2. Connect the computer and the R&S SGT with a USB cable.

In the "Setup > Instruments > Configure Instruments" table, the new instrument
appears automatically.
If it does not appear, open the "Setup > Instruments > Configure Instruments" dia-
log and select "Scan".

3. If your network does not support DHCP, you can now set a static IP address to
your computer.

a) To assign a static IP address to the instrument, see "Assigning a static IP
address to the R&S SGT" on page 30.

b) To assign a static IP address to the PC, see "Assigning a static IP address to
your Windows-PC network card" on page 30.

Connecting a USB device

If you connect a USB device (memory stick, CD-ROM, an instrument) to the R&S SGT,
the R&S SGT acts as a host.

To connect a USB device to the interface of the R&S SGT, always connect the
USB type Micro-A connector to the R&S SGT. Refer to the documentation of the USB
device to find out which USB connector type you can connect to the USB device.

The Figure 3-2 illustrates schematically the required connector type to emphasize on
the different connector shape.

Figure 3-2: USB type Micro-A connectors

3.2  Instrument tour

This chapter explains the control elements and the connectors of the R&S SGT. The
views of the front panel and the rear panel help you to get familiar with the instrument
and to perform first steps. For specifications of the interfaces, see the data sheet.

Instrument tour
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The meanings of the labels on the R&S SGT are described in Chapter 1.2, "Labels on
R&S SGT", on page 13.

3.2.1  Front panel tour

This section provides an overview of control elements on the front panel of the
R&S SGT. The front panel contains LEDs to inform you about the status of the instru-
ment, in particular for remote control of the R&S SGT.

The connectors of the R&S SGT are on the rear panel.

1 2 3 4 5 6

Figure 3-3: R&S SGT front panel controls

1 = [POWER ON/STANDBY]
2 = [RF ON]
3 = [REF EXT]
4 = [ERROR / WARNING]
5 = [LAN]
6 = [ID]

[POWER ON/STANDBY]
The [POWER ON/STANDBY] key switches the instrument from the standby to the
ready state or vice versa.
The LED above the [POWER ON/STANDBY] key indicates the instrument state, see
Table 3-2.
How to:
● Chapter 3.1.10, "Switching on or off", on page 24
● "To switch between standby and ready state" on page 25

[RF ON]
The [RF ON] key switches the RF signal on or off. If activated, the key is green.
Table 3-4: Overview of RF signal states

[RF ON] state LED Remark

On  green RF signal output at the RF 50Ω connector.

Off  gray No RF signal output.

How to: Chapter 3.1.8, "Connecting to RF 50Ω", on page 22

[REF EXT]
The [REF EXT] key activates synchronization to an external reference signal.
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Use the "USER 1/2" on the rear panel for input of the external reference signal.
Table 3-5: Overview of external reference signal states

[REF EXT] state LED Remark

Synchronized  green R&S SGT synchronizes to the external clock signal.

Error  red R&S SGT cannot synchronize to the external clock signal.

Off  gray The internal reference signal is used.

[ERROR / WARNING]
The [ERROR / WARNING] LED indicates the status of the R&S SGT.
Table 3-6: Overview of [ERROR / WARNING] key states

[ERROR /
WARNING] state

LED Remark

Error  red Error occurred, e.g. temperature exceeded or power failure.

Running process  blinking orange Indicates a running process (e.g calibration, self-test).

No error  gray No errors or warnings occurred.

See also Chapter 12, "Error messages and troubleshooting", on page 581.

[LAN]
The [LAN] key indicates the LAN connection state.
Pressing the [LAN] key resets the network settings, e.g., "IP Adress Mode" is reset to
"DHCP".
Table 3-7: Overview of LAN connection states

[LAN] state LED Remark

Connected  green Connected to the network.

Running process  blinking orange Resets the network settings, applies the default settings.

Error  red Network error occurred.

Off  gray Disconnected from the network.

How to:
● Chapter 3.1.7, "Connecting to LAN", on page 22
● Chapter 3.1.13.2, "Connecting a remote PC via LAN", on page 28

[ID]
The [ID] key allows you to identify your R&S SGT, e.g. in complex test setups with
more instruments.
The following applies if the R&S SGT is connected to a remote controller with
R&S SGMA-GUI installed:
● Press the [ID] key identify your R&S SGT on the remote controller. In the dialog

"SGMA-GUI > Setup > Instruments > Configure Instruments > Edit Instrument", the
R&S SGT is active.
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● Set "Edit Instrument > Device Identify > On" to identify your R&S SGT from the
remote controller. The LED of the [ID] key is orange and blinking.

Table 3-8: Overview of [ID] key states

[ID] state LED Remark

Identification  blinking orange Identification of the R&S SGT.

Off/Inactive  gray No identification.

3.2.2  Rear panel tour

This section provides an overview of the connectors on the rear panel of the instru-
ment. For technical data of the connectors, refer to the data sheet.

1 2 3 4 6 7 8

11 10 9

5

Figure 3-4: R&S SGT rear panel controls and connectors

1 = AC power supply connector and power switch
2 = I/Q, I/Q Bar
3 = LAN
4 = PCIe
5 = USB IN
6 = DIG I/Q
7, 10 = USER 1/2
8 = RF 50Ω
9 = LO IN, LO OUT, REF IN, REF OUT
11 = I/Q

AC power supply connector and power switch
Mains power switch for performing the following tasks:
● Connecting the internal power supply to the power source
● Disconnecting the internal power supply from the power source
How to: Chapter 3.1.6, "Connecting to power", on page 21

I/Q, I/Q Bar
SMB male connectors for output of direct (single-ended) or analog I/Q signals.
How to: Chapter 3.1.8, "Connecting to RF 50Ω", on page 22

LAN
RJ-45 connector to connect the R&S SGT to a LAN for remote control.
How to:
● Chapter 3.1.7, "Connecting to LAN", on page 22
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● Chapter 3.1.13.2, "Connecting a remote PC via LAN", on page 28

PCIe
PCIe (Peripheral Component Interconnect Express) single lane interface for remote
control with optimized speed.
How to: Chapter 9.3.4, "Connecting the controller and the instrument", on page 326.

USB IN
USB (universal serial bus) type Micro-B connector for remote control via various exter-
nal devices.
How to: Chapter 3.1.13.4, "Connecting a controller via USB", on page 31

DIG I/Q
Connector for the input of a digital I/Q signal from a Rohde & Schwarz instrument, like
a signal generator.

USER 1/2
"USER 1" is an SMB connector, "USER 2" is an SMA female connector.
Both connectors are multipurpose connectors for input signals and output signals, e.g.,
for the following signals: "Trigger", "Marker 1/2", "Clock In/Out", "Sync In/Out". Also,
use the "USER 2" connector for input of an external pulse modulator signal.
How to: Chapter 3.1.8, "Connecting to RF 50Ω", on page 22

RF 50Ω
SMA female connector for output of the RF signal.
How to: Chapter 3.1.8, "Connecting to RF 50Ω", on page 22

LO IN, LO OUT, REF IN, REF OUT
SMA female type connectors, for reference or local oscillator signals, and alternatively
also in MIMO setups.
Reference input and output:
● "REF IN": Input for external reference signal.
● "REF OUT": Output of internal reference signal.
Local oscillator input and output connectors:
● "LO IN": Input for external LO signals
● "LO OUT": Output of internal LO signals.
How to: "To connect to screwable connectors" on page 23

I/Q
SMA female connectors for input of external I/Q signals. The signals are fed directly
into the I/Q modulator.
How to: "To connect to screwable connectors" on page 23
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3.2.3  Connector extension unit (R&S SGT-B88)

This chapter provides an overview of control elements and connectors of the R&S SGT
connector extension unit.

Order the R&S SGT connector extension unit R&S SGT-B88 together with a new
R&S SGT instrument.
You cannot extend an existing R&S SGT unit.

3.2.3.1  Front panel

This section provides an overview of the connectors on the front panel of the extension
unit. For an overview of the front panel connectors of the R&S SGT, refer to Chap-
ter 3.2.1, "Front panel tour", on page 33.

1

2

Figure 3-5: R&S SGT connector extension unit: controls and connectors

1 = R&S SGT front panel controls, page 33
2 = RF 50Ω, page 37

RF 50Ω
N-type connector for a 50 Ohm RF signal output.
How to: Chapter 3.1.8, "Connecting to RF 50Ω", on page 22

3.2.3.2  Rear panel

This section provides an overview of the connectors on the rear panel of the extension
unit.

For an overview of the connectors of the rear panel of R&S SGT, refer to Chap-
ter 3.2.2, "Rear panel tour", on page 35.
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4

1

23

Figure 3-6: Rear panel view of the R&S SGT and the connector extension unit

1 = R&S SGT rear panel, page 35
4 = REF IN, REF OUT, LO IN, LO OUT, page 38
3 = User 2, page 38
2 = I/Q, page 38

REF IN, REF OUT, LO IN, LO OUT
BNC type connectors, for reference signals or local oscillator signals, and alternatively
also in MIMO setups.
Reference input and output:
● "REF IN": Input for external reference signal.
● "REF OUT": Output of internal reference signal.
Local oscillator input and output connectors:
● "LO IN": Input for external LO signals
● "LO OUT": Output of internal LO signals.
How to: "To connect to screwable connectors" on page 23

User 2
BNC multipurpose connector for input and output signal, e.g., for the following signals:
"Trigger", "Marker 1/2", "Clock In/Out", "Sync In/Out".
Also, use the connector for input of external pulse modulator signal.
How to: Chapter 3.1.9, "Connecting to non-screwable connectors", on page 23

I/Q
BNC connectors for input of an external I/Q modulator. The signal is fed directly into
the I/Q modulator.
How to: Chapter 3.1.9, "Connecting to non-screwable connectors", on page 23
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3.3  Trying out the instrument

This chapter introduces the most important functions and settings of the R&S SGT step
by step.

Prerequisites

Before you try out the following tasks, connect the R&S SGT to a remote PC. Install
the R&S SGMA-GUI software on this PC and add the R&S SGT to the list of "Available
Instruments".

For information on how to fulfill these requirements, refer to:
● "Connecting to the network" on page 29
● Chapter 3.1.13.1, "Installing the R&S SGMA-GUI software", on page 27
● "Adding instruments to R&S SGMA-GUI" on page 31

● How to generate a CW signal................................................................................. 39
● How to create and load a waveform file..................................................................41

3.3.1  How to generate a CW signal

Configuring the R&S SGT to generate a CW signal

Figure 3-7: Example of the setup

1. Check, that [POWER ON/STANDBY] key is green.
The key is on the front panel of the R&S SGT.

2. On the connected remote PC, start the R&S SGMA-GUI software application.

The main panel of the application opens. The panel provides a quick access to the
main settings of the configured and activated instruments. The display shows one
row per instrument with the instrument-specific settings. The rows comprise the
instrument, the connection state, the used frequency and power level, the state of
the RF output and the modulator and the used reference frequency source.
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3. In the R&S SGMA-GUI main panel, the green indicator in front of the name of the
instrument confirms an active connection.
The software recognizes the instrument and displays the connection state between
the instrument and the remote PC.

4. In the R&S SGMA-GUI main panel, select the row of the instrument, that you want
to configure.

5. Select "Instrument Name > Preset" to restore the predefined instrument's settings.

6. In the R&S SGMA-GUI main panel, select the row of the instrument that you want
to configure.

7. Set the "Frequency" as required.

8. Select "SGMA-GUI > RF On" to enable the output of the CW signal.

Trying out the instrument
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The 2 GHz signal is output at the [RF OUT] connector at the rear panel of the
R&S SGT.

3.3.2  How to create and load a waveform file

The following is an example of how to use the R&S WinIQSIM2 to generate a wave-
form and load it in the ARB of the R&S SGT.

The workflow consists of three main steps, each described in a separate step-by-step
instruction:
● Configuring the connection between the R&S WinIQSIM2 and the R&S SGT.
● Generating a waveform file with the required settings.
● Transferring the waveform file and playing it with the R&S SGT.

This section does not describe the R&S WinIQSIM2 but focuses only the task-related
settings.
For more information on configuration and working with the R&S WinIQSIM2, refer to
description "software manual R&S WinIQSIM2".

You cannot remotely control the instrument via the R&S SGMA-GUI and R&S WinIQ-
SIM2 from the same controller computer, if the instrument is connected to the com-
puter through USB.
You can connect the R&S SGT and the computer via LAN and assign different SCPI
socket port numbers for the remote control through the two software applications.

To configure the R&S SGT as destination instrument in the R&S WinIQSIM2

In this example, we assume that the R&S WinIQSIM2 is installed on a remote control-
ler. This remote controller is connected over LAN to the R&S SGT.
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The general instrument settings of the destination instrument affect various functions,
like, the maximum size of the file the waveform is stored in. It is recommended that you
configure the destination instrument before you generate the waveform with the R&S
WinIQSIM2.

1. In the R&S WinIQSIM2, select "File > New" to preset the software to a defined
state.

2. In the block diagram, select "Vector Sig Gen > Config > Instruments".

The "Configure Instruments" dialog opens. The list of configured instruments is
empty.

3. Select "Configure Instruments > Scan".

The software scans the network for connected and active instruments.
Alternatively, use the "New" function to add the R&S SGT manually to the list of
instruments.

4. Close the dialog.

5. In the block diagram, select "Vector Sig Gen" block and select the R&S SGT form
the list.

6. In the block diagram, select "Arb Sig Gen" block and select the R&S SGT form the
list.
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The two lines to the "Vector Sig Gen" and "Arb Sig Gen" blocks on the block dia-
gram confirm that a remote connection to the R&S SGT is established.

To generate an LTE example waveform file with the R&S WinIQSIM2

1. In the R&S WinIQSIM2, select "Block diagram > Baseband > Config. > EUTRA/
LTE".

2. Adjust the settings as required, for example:

a) Select "Link Direction > Downlink"
b) Select a predefined test model, "Test Setups/Models > E-TM1_1__10MHz".

3. Enable "EUTRA/LTE > State > On".
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The R&S WinIQSIM2 calculates the signal and displays important signal parame-
ters, like the used "Sample Rate" and "Number of Samples".

Use "Graphics > Graphic 1" view to retrieve more information on the generated signal.

The display confirms the expected EUTRA/LTE 10 MHz spectrum.

Trying out the instrument
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To transfer the generated file to the R&S SGT

1. In the R&S WinIQSIM2, select "Transmission > Transmit".

2. In the "Waveform Transmission to Arbitrary Waveform Generator" dialog, select:

a) "Source > Internal (WinIQSIM2)"
b) "Destination > Instrument" and define the file name for the transmitted file.
c) Enable "Automatically Load and Start Waveform > On".
d) Select the required baseband, e.g. "Path A".
e) Add a comment to the waveform.
f) Select "Transmit".

The waveform is transmitted to the default directory of the R&S SGT.

3. In the R&S SGT, select "Baseband > ARB".

The dialog confirms that the ARB is enabled and plays the transmitted waveform.

3.4  Instrument control

As a rule, the R&S SGT is operated exclusively via programmatic remote control from
a connected PC. For service and diagnostic tasks, and for manual configuration, a
graphical user interface (R&S SGMA-GUI) is provided which runs on the remote PC.

Also, some basic functionality is provided via the keys on the front panel of the instru-
ment (see Chapter 3.2.1, "Front panel tour", on page 33).

3.4.1  Manual operation via R&S SGMA-GUI

The R&S SGMA-GUI software application can be installed on a PC with Windows or
Linux operating system. This program allows you to control several devices of the
SGMA product family at the same time and to monitor the device status during remote
control. R&S SGMA-GUI requires one of the external interfaces described in Chap-
ter 3.1.13, "Connecting an external PC and devices", on page 26.

Instrument control
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3.4.1.1  Introduction to the user interface

After the start of R&S SGMA-GUI, the main dialog of the application is displayed.

The main dialog with an overview of the configured instruments is the operating and
control interface for the whole program. From here, all program functions are accessi-
ble.

The menus and dialogs are built using elements like selection lists, check boxes, and
entry fields. A blue frame indicates that the selected item is active. Entries can be
made in the highlighted element.

The main dialog comprises two main areas:
● On the top of the main panel, there are bars: the menu bar, the tool bar and the

info bar with the corresponding "Info" button.
The menu bar provides access to the functions related to the software application
itself, like saving current configurations, retrieving information about the installed
software version or configuring the connected instruments.
The messages displayed in the info line indicate information, warnings, and errors.
They are displayed in different colors depending on their importance and display
duration. Use the "Info" button to open a dialog with information on the messages
in greater detail.

● The central part of the R&S SGMA-GUI main dialog is the main panel that shows
the list of all active instruments.
The main panel is the core element for the manual operation and provides quick
access to the main settings of the configured instruments. The display shows one
row per active instrument. Each row comprises the instrument's name and state,
the used frequency and level, the state of the RF output and the modulator and the
kind of used frequency reference.
The buttons with the instrument's symbolic name on it provides access to menus
and dialogs for further instrument configuration. Refer to the user manual for a
detailed description of all parameters and functions provided for configuration.

A detailed description of the R&S SGMA-GUI, in-depth information on how to work with
the application and on how to operate the R&S SGT is provided in the user manual.
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3.4.1.2  How to use the help system

The R&S SGMA-GUI is equipped with a context-sensitive help function. A help page is
available for each parameter and can be called anytime during instrument operation.

Calling context-sensitive and general help

► To display the general help dialog box, select the "SGMA-GUI > Help > Contents"
or use the F1 key.

The help dialog is displayed. A topic containing information about the current menu
or the currently opened dialog box and its function is displayed.

Contents of the help dialog box

The help dialog box contains two main areas:
● "Contents" - contains a table of help contents
● "Topic" - contains a specific help topic

The help system also provides an "Index", "Find" and "Zoom" functions that are
accessed with the corresponding buttons.

Navigating in the table of contents and in the help topics

1. To move through the displayed contents entries, use the mouse or the [Up/Down]
keys. Entries that contain further entries are marked with a plus sign.

2. To display a help topic, double click on the topic name or press the [ENTER] key.

3. To jump to the linked topic, press the link text.

4. Use the "Previous" or "Next" links to jump to the corresponding topic.

5. Use the "Scroll Right" or "Scroll Left" buttons to shift the indicated area of the navi-
gation window to the left or right.
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Using the index

1. Select "SGMA-GUI > Help > Index" or use the "Go to Index" button in the "Help"
display.

2. Enter the first characters of the topic that you are interested in. The entries starting
with these characters are displayed.

3. Press the [ENTER] key to display the help topic.

The corresponding help topic is displayed.

Instrument control
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4  System overview
The R&S SGT RF Source is a vector signal generator intended for the generation of
IQ-modulated signals and the playback and output of externally calculated modulation
signals in the form of waveforms.

Optimized for use in automated test equipment (ATE), the instrument offers fast settling
times in an exceptionally small formfactor and low power consumption. The R&S SGT
is equipped with an active electronic step attenuator and can be equipped optionally
with a high stability reference oscillator.

4.1  Setups for instrument control

The R&S SGT is an instrument designed for the automated test equipment (ATE)
needs. To maintain the small size, the instrument is not equipped with a display and
hence additional equipment is required to control the instrument.

This section provides an overview of the possible configuration setups for controlling
the R&S SGT.

4.1.1  Manual operation from the R&S SGMA-GUI

The following example represents a basic configuration of the R&S SGT, operated
manually by the configuration software R&S SGMA-GUI. The configuration software is
installed on a remote PC and controls several instruments. The instruments are con-
nected to the remote PC over different remote control interfaces. Any combination of
the used interfaces is possible.

Figure 4-1: Configuration example: manual control from R&S SGMA-GUI

For information about the manual control, refer to:
● Chapter 5, "Understanding R&S SGMA-GUI", on page 53
● Chapter 6, "Signal generator settings", on page 85
● Chapter 7, "General instrument settings and instrument setup", on page 270

4.1.2  Remote control from a controller

The remote control provides access to the instrument's settings from a remote com-
puter (external controller) by remote commands. To automate often repeating settings

Setups for instrument control
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and sequences, these settings are grouped in the remote control programs, i.e. appli-
cation programs.

An instrument can be connected to the controller via any of the supported interfaces
LAN, USB or PCIe.

Figure 4-2: Configuration example: remote control from a controller

For information about remote control, refer to Chapter 9, "Network operation and
remote control", on page 312.

4.2  Managing files on the R&S SGT

The R&S SGT has internal memory, where you can store waveforms, lists etc. You can
also access these files and manage them as required.

To access files on the R&S SGT

1. Connect the R&S SGT and a Windows PC to the same network.

2. On the PC, open a Windows Explorer window.

3. To connect to the R&S SGT, enter the name of the instrument or its IP address in
the Windows address bar.
For example, enter \\rssgt100a101840:

4. Enter the user name and password to connect to the R&S SGT. The default user
name is instrument and the password is instrument.

Managing files on the R&S SGT
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A folder opens, containing the share and the update folder.
The share folder contains the user files, e.g. waveforms, lists. You can copy,
delete and rename the files contained in this folder.
The update folder allows you to start an update of the instrument's firmware. If
you copy a firmware update file in this folder, the update starts automatically.

Types of user data

The user data includes saved instrument settings, lists for the list mode and the user
correction, and the waveforms for the arbitrary waveform generator.

Depending on the content, the user data can be roughly divided into the following
data types:
● Settings, e.g. the current instrument settings, can be saved and loaded later or

used in other instrument of the same kind.
● Externally or internally generated lists, e.g. user correction lists, or data lists can be

loaded in the instrument.
● Externally generated waveforms can be loaded in the "Arbitrary Waveform Genera-

tion" dialog.

Depending on the data storage method, user data can be:
● Persistent, i.e. user files that are recorded on the data storage.

Data is preserved when instrument is powered off and can be accessed and modi-
fied subsequently.

Managing files on the R&S SGT
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● Temporary, i.e. volatile data that the instrument retains while it is powered on.
Volatile data is immediately lost when the R&S SGT is switched off.

File storage location

Without any additional measures, the R&S SGT stores user files on the internal mem-
ory, the removable memory, or if connected, on a memory stick.

Both, the user directory /var/user/ on the internal memory or the usb directory on
the memory stick, can be used to preserve user-defined data. Any directory structure
can be created.

The /var/volatile directory serves as a RAM drive and can be used to protect
sensitive information. The data is available temporarily.

Managing files on the R&S SGT
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5  Understanding R&S SGMA-GUI
This section gives a detailed description of the R&S SGMA-GUI user interface and
information on how to work with it. The main panel with the overview of the configured
instruments is the operating and control interface for the whole program. From here, all
program functions are accessible. This panel is displayed after the start of R&S SGMA-
GUI. The software always loads the previously used settings, so you can continue your
work in the next session.

● Operating menu and toolbar................................................................................... 53
● Info dialog and messages in the info bar................................................................ 64
● Main panel...............................................................................................................66
● Block diagram......................................................................................................... 69
● Working with R&S SGMA-GUI................................................................................70
● Remote control of R&S SGMA-GUI........................................................................ 76

5.1  Operating menu and toolbar

On the top of the main panel, there is the menu bar, the toolbar and the info bar with
the corresponding "Info" key. Some of the functions are accessible via the toolbar with
its icons below the menu selection line.

The dialogs are built using elements, e.g., selection lists, checkboxes, and entry fields.
A blue frame indicates that the selected item is active. In a highlighted element, entries
can be made.
Table 5-1: Content of the operating menu

File Setup Help

 New Instruments About

 Open Software Contents

Operating menu and toolbar
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File Setup Help

Save Reset SGMA-GUI Index

 Save as For R&S SGS/R&S SGT: Protection  

Exit For R&S SGS/R&S SGT: Remote  

Shut down instruments and exit   

● File menu................................................................................................................ 54
● Setup menu.............................................................................................................55
● Help menu...............................................................................................................64

5.1.1  File menu

The R&S SGMA-GUI employs the standard Save/Recall file management function and
allows you to save and reload settings in/to a file with a user-defined name and loca-
tion (see also Chapter 5.5.1, "Saving and loading settings", on page 70).

In the following, the "File" menu of the R&S SGMA-GUI is described in detail. It incor-
porates standard functions.

New
Resets R&S SGMA-GUI and all connected instruments to their preset settings.

Open
Opens the standard file open browser for loading a saved R&S SGMA-GUI file
(*.savrcl). The file contains the user-specific settings of a session, such as instru-
ments configured in the software. The complete settings of a session can be saved
and loaded.
Only files of this type are selectable.
Note: Instrument-specific settings, e.g. frequency and level settings, are saved locally
on the particular instrument itself. These instruments settings are saved automatically
in a predefined directory and loaded by default when starting the instrument again.
The files with instrument settings are not accessible.

Save
Standard quick save of the settings of the current session if a filename previously has
been applied. If not, the "Save As" dialog is opened.

Save as
Opens the standard file save browser for saving the settings of the current session.
R&S SGMA-GUI files have the file extension .savrcl so the name typed in is equip-
ped with this extension. The complete settings of a session are saved.

Exit
Quits the R&S SGMA-GUI. The current settings of the instrument's session are saved
and loaded by default when starting the software again.
Note: The instruments configured in the R&S SGMA-GUI are not shut down.
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Shut down instruments and exit
Quits the R&S SGMA-GUI and switches the connected instruments to the standby
state (see also Chapter 8.7, "How to switch between operating states", on page 306).

5.1.2  Setup menu

Access:

► Select "SGMA-GUI" > "Setup".

The setup menu provides access to general settings of the software, like dialogs
for managing the connected instruments or dialogs providing information about the
installed options.

Settings:

● Configure instruments.............................................................................................56
● Add/Edit instrument.................................................................................................59
● Software..................................................................................................................62
● Reset SGMA-GUI....................................................................................................62
● Protection................................................................................................................62
● Remote....................................................................................................................63
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5.1.2.1  Configure instruments

Access:

► Select "Setup" > "Instruments".

The dialog provides settings to manage connections of SGMA instruments via the
R&S SGMA-GUI software. You can add new instruments, remove instruments or
edit instrument connection settings.
Also, you can search for instruments in your network:
● Select "Scan" to search for instruments in the whole network.
● Select "Scan LAN instruments with host name prefix" to fine-tune the search for

instruments via their hostnames.
● Select "Scan Subnet" and enter the IP address to search for instruments within

a subnet of the network.

How to: Chapter 5.5.2, "Managing instruments with R&S SGMA-GUI", on page 71

Settings:

Available Instruments....................................................................................................57
Scan.............................................................................................................................. 57
New............................................................................................................................... 57
Delete............................................................................................................................57
Clear..............................................................................................................................57
Edit................................................................................................................................ 57
Export............................................................................................................................57
Scan LAN instruments with host name prefix............................................................... 58
Scan Subnet..................................................................................................................58
IP Address.....................................................................................................................58
Prefix Length................................................................................................................. 58
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Available Instruments
This section comprises a list of configured instruments. Each instrument is represented
by a "Symbolic Name" which is also displayed in the main panel and an "Instrument
Type". It is also displayed whether the instrument is activated in the R&S SGMA-GUI
and hence displayed in the main panel or not.
Remote command: 
:INSTruments:COUNt? on page 80
:INSTruments:NAME on page 81
:INSTruments:TYPE on page 83
:INSTruments:ACTive[:STATe] on page 79

Scan
Triggers a scan function and searches for instruments connected to the remote com-
puter via all the available interfaces. During the scan process, a progress bar is dis-
played.
Tip: The first initialization of a newly connected instrument in a network and the instru-
ment's request to the DHCP server for an IP address may take some time. During this
time, the instrument does not respond to the query sent by the scan function. If the
instrument does not appear in the list of "Available Instruments", trigger the scan func-
tion again after some minutes.
Remote command: 
:INSTruments:SCAN on page 82

New
Calls the Add/Edit instrument dialog.

Delete
Removes the selected instrument from the list of Available Instruments.

Clear
Removes all instruments from the list of Available Instruments.

Edit
Calls the Add/Edit instrument dialog.

Export
Opens the standard file save browser for saving the list of the available instruments in
a mapping file. The mapping files have the file extension .map so the filename typed in
is automatically equipped with this extension.
A mapping file provides a cross-reference between the instruments' symbolic names
and their respective remote control parameters. The information in the mapping file is
grouped in rows, where one row corresponds to one configured instrument. The rows
have the following structure:
<InstrumentType> <SymbolicName> <IP_Address/Hostname>
<RemoteChannel> <SerialNumber>

Operating menu and toolbar



Understanding R&S SGMA-GUIR&S®SGT100A

58User Manual 1176.8674.02 ─ 12

Figure 5-1: Mapping file example

Tip: In a remote control application program, address the instruments by their symbolic
names and retrieve the remain required settings from the mapping file. This workflow is
especially useful for frequent exchange of instruments.
Remote command: 
:INSTruments:MAPPing:FILE on page 81

Scan LAN instruments with host name prefix
Sets the prefix the searched host names begin with. Use this function to limit the
amount of the searched instruments and to speed up the scan process.
For example, set this field to "RsSGS, RsSGU, RsSGT", if you want to search for all
available instruments.
If your instrument is not listed in the "Avalable Instruments" dialog, leave the field
empty and execute another scan.
Remote command: 
:INSTruments:SCAN:HNPRefix on page 82

Scan Subnet
Activates scanning of the subnet.
If you click "Scan" the scanning procedure includes instruments detected in the subnet.
Remote command: 
:INSTruments:SCAN:SNET[:STATe] on page 83

IP Address
Sets the IP address with the subnet.
Remote command: 
:INSTruments:SCAN:SNET:IPADdress on page 82

Prefix Length
Sets the prefix length in bits.
Remote command: 
:INSTruments:SCAN:SNET:PLENgth on page 83
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5.1.2.2  Add/Edit instrument

Access:

► Select "Setup" > "Instruments" > "New"/"Edit".

The dialogs provide settings to add or edit an instrument.

How to: Chapter 5.5.2, "Managing instruments with R&S SGMA-GUI", on page 71

Settings:

Instrument Nr.................................................................................................................60
Symbolic Name............................................................................................................. 60
Instrument Type............................................................................................................ 60
Active............................................................................................................................ 60
Exclusive Access.......................................................................................................... 60
Device Identity...............................................................................................................60
Hardware Channel........................................................................................................ 61
Instrument Name / IP Address...................................................................................... 61
GPIB Address............................................................................................................... 61
Board Number...............................................................................................................61
Serial Number............................................................................................................... 61
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Ok..................................................................................................................................61
Apply............................................................................................................................. 61
Cancel........................................................................................................................... 61

Instrument Nr.
Automatically assigned number that indicates the instrument's index in the list of "Avail-
able Instruments".

Symbolic Name
Selects the alias name of the instrument.
Remote command: 
:INSTruments:NAME on page 81

Instrument Type
Selects the instrument's family.
Remote command: 
:INSTruments:TYPE on page 83

Active
Activates control of the instrument and displays the instrument in the main panel.
Note: You can only control active instruments via R&S SGMA-GUI.

Remote command: 
:INSTruments:ACTive[:STATe] on page 79

Exclusive Access
Checks whether the instrument is locked by another user and if not locks the instru-
ment.
When an instrument is locked, it is reserved for manual and remote operation. Locking
means, that you can operate the instrument exclusively from the remote PC on which
the R&S SGMA-GUI is running or from which the SCPI command is sent.
For interfaces using VISA, i.e. for LAN and USB, enabling the "Exclusive Access" trig-
gers the standard viLock request. For remote control over PCIe or Socket, the lock
request is performed on a higher application level.
Tip: We recommend that you lock the instrument before further configuration. Locked
instruments are not found by the scan function. Unlock the instrument to allow opera-
tion from another remote PC.
Note: The two functions "Exclusive Access" and monitoring are mutually exclusive.
Disable "Exclusive Access" if the instrument is monitored by an external PC.
Remote command: 
:INSTruments:EACCess[:STATe] on page 80
:LOCK? on page 353
:UNLock on page 353

Device Identity
Triggers the device identification function. The [LAN] LED on the front panel of the
selected instrument blinks.
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See also Chapter 5.5.4, "Bidirectional instrument identification", on page 74.

Hardware Channel
Selects the hardware interface used by the remote channel.
Remote command: 
:INSTruments:REMote:CHANnel on page 81

Instrument Name / IP Address
Enters the IP address or the host name of the connected instrument.
See also Chapter 5.5.3, "Finding out the default hostname of the instrument",
on page 74.
Remote command: 
:INSTruments:REMote:NAME on page 82

GPIB Address
Enters the GPIB address of the connected instrument.
See also Chapter 9.1.5, "GPIB interface (IEC/IEEE bus interface)", on page 320.
Remote command: 
:INSTruments:GPIB:ADDRess on page 80

Board Number
Identifies the GPIB bus card of the controller to that the adapter is connected.
See also Chapter 9.1.5, "GPIB interface (IEC/IEEE bus interface)", on page 320.
Remote command: 
:INSTruments:GPIB:BOARd on page 81

Serial Number
Enters the serial number as instrument's identification while using the USB or PCIe
interfaces for remote control.
Remote command: 
:INSTruments:SERial on page 83

Ok
Confirms the settings and closes the dialog.

Apply
Confirms the settings.

Cancel
Discards settings and closes the dialog.
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5.1.2.3  Software

To find out the software version and installed options

► Select "Setup > Software".

The dialog provides information on the software opens showing program informa-
tion.

Software
Displays information on:
"Package" Installed software packages.
"Version" Release of the software package.

Show Open Source Acknowledgments
Accesses the list of the used open source software packages and the corresponding
verbatim license texts.

Versions
Shows the installed software platform and its version.

5.1.2.4  Reset SGMA-GUI

Resets R&S SGMA-GUI to its factory preset settings.

The connected instruments are not affected by this preset.
To preset one specific instrument to its factory preset settings, select "SGMA-GUI >
Instrument Name > Setup > Factory Preset". Refer to Chapter 7.12, "Factory preset",
on page 294 for an overview of the settings affected by this function.

5.1.2.5  Protection

The "Protection" dialog is available for R&S SGS and R&S SGT. It provides settings to
unlock protected service functions (authorized personnel of Rohde & Schwarz service
departments only).
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Unlocking of protected service functions

1. Select "SGMA-GUI > Setups > Protection".

After the instrument has been switched on, the protection levels 1 to 4 are auto-
matically activated.

2. To deactivate the protection, enter the correct password.
Enter "Protection Level 1" > "Password" > "123456".

Protection Level 1 is activated.

Protection Level / Password
"Protection Level 1" can be activated to expand the functionality of the internal adjust-
ment. The password is 123456.
The other protection levels 2 to 4 provide access to protected service functions. Only
the authorized personnel of Rohde & Schwarz service departments can access these
functions.

5.1.2.6  Remote

Access: "SGMA-GUI" > "Setup" > "Remote".

SCPI Port
Sets the port number of the LAN interface for remote control with TCP/IP socket proto-
col.
Set different port numbers to control different software from the same application, e.g.
R&S SGMA-GUI and R&S WinIQSIM2.
Remote command: 
:SYSTem:COMMunicate:SOCKet:PORT on page 543
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5.1.3  Help menu

The R&S SGMA-GUI software is equipped with a context-sensitive help function. A
help page can be called anytime during software operation.

The context-sensitive page which is opened with the [F1] key is part of a comprehen-
sive help system.

It is possible to move from this context-sensitive page to any page of the help system.
An overview of the contents of the online help can be reached via the menu "SGMA-
GUI > Help > Contents".

A search for keywords within the help function is available via menu item "SGMA-GUI
> Help > Index".

5.2  Info dialog and messages in the info bar

A few operating states and the current messages are displayed in the info line. For
information on messages in greater detail and their management, an "Info" dialog can
be opened.

5.2.1  Info dialog

The "Info" dialog provides a list of currently active permanent messages and a detailed
description of each message. The messages are color-coded according to their level.

To access the info dialog

► In the main panel, select the "Info" key.

The "Info" dialog opens.

1

2

3

1 = Info line
2 = List of current messages with short description
3 = Detailed description of a selected message
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The upper part of the "Info" dialog lists the currently active permanent messages. See
the following table for explanation of the displayed information.

Parameter Description

"LEV" Message level. Messages referring to a logical component of R&S SGMA-GUI, e.g.,
Unicode, are marked in red color, info messages are marked in black color.
The following level messages can occur:
● Err: Error message
● Info: Information message
● Sys: System message
● Crit: Critical message

For detailed information on the message types, see Chapter 5.2.2, "Understanding the
messages in the info bar", on page 65.

"SCPI" Indicates the SCPI error code.

Text A list of all currently permanent messages in the order of their occurrence, i.e., the most
recent message is displayed first.

The keys in the lower part of the "Info" dialog provide quick access to some functions
for managing these messages. For a detailed description on how to clear error mes-
sages or display a history of all messages, refer to Chapter 5.5.5, "Managing mes-
sages in the info dialog", on page 75.

Function Description

"Delete" Clears the highlighted message. This key is available only if the history of the mes-
sages is displayed.

"Delete All" Clears all messages.

This key is available only if the history of the messages is displayed.

"Del. volatile" Clears all brief messages. This key is available only if the history of the messages
is displayed.

"Show History/Static" Calls the list of all messages that have occurred since instrument switch-on. The
most recent messages are displayed at the top of the list. When the key is pressed
again, the list of current messages is displayed.

How to: Chapter 5.5.5, "Managing messages in the info dialog", on page 75

5.2.2  Understanding the messages in the info bar

Messages indicate information, warnings, and errors. They are displayed in the info
line in different colors depending on their importance and display duration. The follow-
ing messages are displayed:
● Error

There are two options:
– Critical errors are errors that prevent the instrument from working, e.g. an HW

failure. Critical errors are displayed in red color.
– System errors are errors that concern the operating system, e.g., wrong file

path. System errors are displayed in black color.
● Information
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The information, e.g., file not found, is displayed in black color.
● Warning

A warning indicates a less significant error and is displayed in black color.
● Brief message

Brief messages report automatic settings in the program, e.g. switching on illegal
entries that are not accepted by the program, e.g., range violations. They are dis-
played in the info line on a yellow background. They are displayed on top of status
information or permanent messages.
Brief messages usually do not demand user actions and disappear automatically
after a short period of time. They are saved in the history, however.

● Permanent messages
Permanent messages are displayed if an error occurs that impairs further program
operation. The error signaled by a permanent message must be eliminated before
correct software operation can be ensured.
The message is displayed until the error is eliminated. It covers the status display
in the info line. After error elimination, the message automatically disappears and is
also recorded in the history.

5.3  Main panel

The main panel of the R&S SGMA-GUI software provides quick access to the main
settings of the configured instruments. The display shows one row per instrument and
comprises the instrument name and state. It also shows the used frequency and power
level, the states of the RF output and modulator and the used reference source.

Click one of the keys with an instrument name on it to access the menu tree with fur-
ther settings for the corresponding instrument. For a detailed description of the provi-
ded settings, see:
● Chapter 7, "General instrument settings and instrument setup", on page 270 for

general settings
● Chapter 6, "Signal generator settings", on page 85 for R&S SGT settings.
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Settings:

Instrument/Connection State.........................................................................................67
Maximum Frequency.....................................................................................................67
Pulse Modulation...........................................................................................................67
Instrument Name / IP Address...................................................................................... 67
Freq/Freq (Offs).............................................................................................................67
RF On/Off......................................................................................................................68
I/Q Mod State................................................................................................................ 68
Level/Level Offset..........................................................................................................68
Ref. Oscillator Source/Ext Ref On/Off...........................................................................68
LO Scr Ext.....................................................................................................................69

Instrument/Connection State
The three colors of the state indicator in front of the instrument's name distinguish
between the following states:
● Gray: the instrument is configured and activated in the R&S SGMA-GUI software

but there is no connection to the instrument.
● Green: the instrument is active, the connection is working and the instrument can

be manually and remotely operated.
● Red: the instrument is in one of the following states:

– Standby state
To operate the instrument manually, it has to be switched to ready state (see
"To return the instrument from standby to ready state" on page 307).

– Instrument locked
The red state indication together with the message "Instrument Locked" in the
"Info" line indicates that the instrument is locked for Exclusive Access from
another R&S SGMA-GUI software or controller.

– The instrument is performing a time consuming operation, e.g. a selftest.

Maximum Frequency
The numbers in the rectangular box  on the left of the instrument's name indicate the
maximum frequency of the instrument.

Pulse Modulation
A  sign on the left of the instrument's name indicates that the pulse modulation is
switched on.

Instrument Name / IP Address
Displays the alias name of the instrument and the IP address, as set by the parameters
in "SGMA-GUI > Setup > Instruments > Add/Edit Instruments" dialog.
Click the key to access a menu tree for configuring the available instrument's settings,
e.g. "Level" settings.

Freq/Freq (Offs)
For R&S SGT, sets the RF frequency, incl. enabled frequency offset.
The following apples:
"Freq" = Frequency + Offset

Main panel
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The value of the parameter "SGMA-GUI main panel > instrument name > Frequency/
Phase > Frequency" is the RF frequency at the RF output without the frequency offset.
The icon "Freq (Offs)" indicates that a frequency offset is applied.
Remote command: 
[:SOURce]:FREQuency[:CW|FIXed] on page 390

RF On/Off
Activates and deactivates the RF output signal.
The current state of the RF output (activated and deactivated) is indicated in the main
panel by the different block color (blue or grey) and the status "On/Off".
Remote command: 
:OUTPut[:STATe] on page 374

I/Q Mod State
Switches the I/Q modulation on and off.
The following functions have the same effect:
● The "Mod On/Off" icon in the SGMA-GUI.
● The "I/Q Mod > On/Off" in the I/Q Mod block in the block diagram.
● The "I/Q Modulator" > State parameter.
Remote command: 
[:SOURce]:IQ:STATe on page 480

Level/Level Offset
Sets the RF level at the RF output connector of the selected instrument.
If you set a digital attenuation, while "I/ Q Mod > Modulation Source > Internal Base-
band" and "I/ Q Mod > Modulation State > ON", it will be indicated in the R&S SGMA-
GUI main panel by a change in the name of this parameter from "Level" to "Level Off-
set".

Note: The SCPI command [:SOURce]:POWer[:LEVel][:IMMediate][:
AMPLitude] sets the level of the "Level" display, that means the level containing off-
set while [:SOURce]:POWer:POWer sets the level at the RF output connector.

Remote command: 
[:SOURce]:POWer[:LEVel][:IMMediate][:AMPLitude] on page 526
[:SOURce]:POWer:POWer on page 523

Ref. Oscillator Source/Ext Ref On/Off
Determines whether the internal built-in oscillator (TXCO or OXCO) is used as a refer-
ence source or if an external reference is used.
The internal reference oscillator OCXO requires the additional option R&S SGT-B1.
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To feed in an external instrument reference, use the input connector "REF/LO IN". To
output the reference frequency at the output "REF/LO OUT", select "SGMA-GUI >
Instrument Name > RF > Ref. Oscillator > REF/LO Output > REF".
"Int" The internal reference signal of 10 MHz is used.
"Ext" An external reference signal is used. The frequency of the external

reference signal must be selected with the parameter "SGMA-GUI >
Instrument Name > RF > Ref. Oscillator > Ex. Ref. Input Frequency".

Remote command: 
[:SOURce]:ROSCillator:SOURce on page 527

LO Scr Ext
This icon indicates that the internal local oscillator is switched off.
See "Source" on page 220.

5.4  Block diagram

For R&S SGT, the block diagram, shows provided options, signal configuration and the
currently selected signal flow of the generator with inputs and outputs used. Signal
generation can be operated from the block diagram.

To display the block diagram, click the  key next to the instrument's name.

5.4.1  Function blocks in the block diagram

Each block represents a function of signal generation. The function is indicated in the
headline of the block. In the checkbox, the respective function can be quickly activated/
deactivated. After activation, the block is displayed in blue. Status information is dis-
played below the checkbox. It is different for the different blocks.

Example: Baseband block

In this block, the arbitrary waveform generation and trigger, marker and clock are set.

Block diagram
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5.4.2  Signal flow and input/output symbols in the block diagram

The input/output symbols in the block diagram show the currently used inputs and out-
puts of the signal generator. Unused inputs and outputs are not shown. The lines indi-
cate the signal flow.

Symbols and labels refer to the corresponding inputs and outputs on the front and rear
panel of the signal generator. The direction - input or output - is indicated by an arrow.

Example: 

The symbols indicate the inputs for the analog I and Q signal.

Symbols and lines are displayed in different colors depending on their function.

● The baseband signal is indicated by a three line arrow, the I- and Q-components of
the signal by a single-line arrow.

● Connections are indicated by a "solder point".
● Black is used for the generated signal.
● Green is used for control signals.

5.5  Working with R&S SGMA-GUI

This section explains how to work with the R&S SGMA-GUI software and perform con-
figuration tasks for manual operation of the instruments.

5.5.1  Saving and loading settings

To proceed work with a particular configuration of the instruments in the R&S SGMA-
GUI software, it is useful to save the used settings and load them again later.

To save and load settings

1. Select "SGMA-GUI main panel > File > Save As".

2. Navigate to the desired directory.

3. Enter the filename.
The software adds the file extension *.savrcl automatically.

4. Select "Save".

The current settings of the software are saved to the selected file.

5. To load settings from a file, select "SGMA-GUI main panel > File > Open"
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6. Navigate to the storage directory of the saved file.

7. Select this file.

Loads the saved settings to the R&S SGMA-GUI software and the main panel dis-
plays the saved configuration of the instrument.

5.5.2  Managing instruments with R&S SGMA-GUI

This section provides information on how to configure and manage instruments in the
R&S SGMA-GUI software.

It covers the following topics:
● "To add instruments automatically" on page 71
● "To add instruments manually" on page 71
● "To scan for new instruments" on page 72
● "To activate instruments for control" on page 72
● "To reserve an instrument" on page 72
● "To edit instruments" on page 73
● "To delete an instrument" on page 73
● "To delete all instruments" on page 73

To add instruments automatically

1. Connect the instrument to the network.

2. Switch on the instrument.

3. Press the [ID] key on the front panel of the instrument.

4. Start the R&S SGMA-GUI software on a computer connected to the same network.

All instruments are added automatically to the main panel of the R&S SGMA-GUI
software.

To add instruments manually

1. In the main panel, select "Setup" > "Instruments".

The Configure Instruments dialog opens.

2. Select "New".

The Add Instrument dialog opens to register a new instrument.

3. In the "Symbolic Name" field, enter an alias name of your choice, e.g.
SGT-100021.

4. In the "Instrument Type" field, select the device family to connect to.

5. To select the hardware interface, select "Remote Control > Hardware Channel".

6. For LAN or Socket interfaces, select "Remote Control > Instrument Name / IP
Address".
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7. Enter the IP address or the hostname of the connected instrument, e.g.
rssgt100a100021.
See also Chapter 5.5.3, "Finding out the default hostname of the instrument",
on page 74.

8. For USB or PCIe interfaces, select "Remote Control > Serial Number".

9. Enter the serial number of the connected instrument, e.g., 100021.

10. Set "Active > On" to activate the instrument. Only active instruments are displayed
in the main panel.

11. To apply the settings, you have two options:

● Click "OK".
The dialog also closes.

● Click "Apply".
● The dialog remains opened.

12. Click the "Cancel" key to discard settings and to close the dialog.

To scan for new instruments

1. In the main panel, select "Setup" > "Instruments".

The Configure Instruments dialog opens.

2. Select "Scan" to scan all remote channel interfaces for connected instruments.

Tip: To limit the amount of the searched instruments and to speed up the scan
process, select "Configure Instruments > Scan LAN instruments with hostname
prefix" and enter the prefix the searched hostnames begin with.
The scan function searches only for instruments whose hostnames begin with the
selected prefix.

The "Available Instruments" list all instruments that are connected to one of the
available interfaces, switched on and not locked by a control instrument.
The R&S SGMA-GUI software obtains all information for connecting to the instru-
ment, so further configuration is not necessary.

To activate instruments for control

1. In the main panel, select "Setup" > "Instruments".

The "Available Instruments" in the Configure Instruments dialog lists all instruments
configured in the software.

2. Select the new or deactivated instrument.

3. To activate the instrument, select "Active > On".

Tip: The main panel only displays active instruments.

To reserve an instrument

1. Open the "SGMA-GUI > Setup > Instruments > Configure Instruments" dialog.

2. Select the instrument in the list of "Available Instruments".
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3. Select "Edit".

4. In the "Edit Instrument" dialog, enable "Exclusive Access".

5. Alternatively, send the SCPI command :INSTruments:EACCess[:STATe] from
the external PC that has an R&S SGMA-GUI software installation.

The instrument is reserved for control from this external PC and cannot be
accessed from any other controller. A scan function started from another controller
finds the instrument but the instrument is indicated as locked.

The two functions "Exclusive Access" and monitoring are mutually exclusive.
The "Exclusive Access" must be disabled to remote control or monitor the instrument
form another external PC (see Chapter 9.7, "Monitoring remote control operation with
R&S SGMA-GUI", on page 345).

To edit instruments

1. In the R&S SGMA-GUI main panel, select "Setup > Instruments".

The Configure Instruments dialog opens and lists the "Available Instruments".

2. Select the instrument, that you want to edit.

3. Click the "Edit" key.

The Edit Instrument dialog opens.

4. Change the settings.

5. Confirm with "Ok".

The edited settings are applied.

To delete an instrument

1. In the R&S SGMA-GUI main panel, select "Setup > Instruments".
The Configure Instruments dialog opens.

2. Select the instrument, that you want to delete.

3. Click the "Delete" key.

The selected instrument is deleted from the list of "Available Instruments".

To delete all instruments

1. In the R&S SGMA-GUI main panel, select "Setup > Instruments".
The Configure Instruments dialog opens.

2. Click the "Clear" key.

All instruments are deleted from the list of "Available Instruments".

Working with R&S SGMA-GUI
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5.5.3  Finding out the default hostname of the instrument

The default hostname of the instrument is a non-case-sensitive string built as follows:

● hostname = <instrument name><serial number>
● <serial number> is the individual serial number of the instrument.
● <instrument name> is the complete name of the instrument, written without

spaces.

To query the hostname of the instrument

1. Find the individual serial number on rear of the instrument, e.g. 100021.

2. Build the default hostname.

For the R&S SGT with serial number 100021, the default hostname is
rssgt100a100021.

For instructions on how to change the default hostname, see Chapter 8.8, "How to use
computer names", on page 308.

5.5.4  Bidirectional instrument identification

In practice, instruments are integrated into a large network or placed in racks together
with several other instruments of the same kind. It can be difficult to find out, which of
the instruments configured in the R&S SGMA-GUI corresponds to which physical
instrument. Also, localizing all instruments operated by the current controller.

The R&S SGMA-GUI and the instrument provide the "Device Identification" function for
this purpose.

To find an instrument in the R&S SGMA-GUI

► If you activate several instruments in the R&S SGMA-GUI, press the [ID] key on
the instrument's front panel to trigger device identification.

The "Edit Instrument" dialog of this instrument opens.
Field "Edit Instrument > Symbolic Name" displays the name of the instrument as
shown in the R&S SGMA-GUI main panel.
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Dialog "Edit Instrument" does not appear
If this dialog does not open, perform the following:
● Check whether the instrument is correctly connected to the external PC on which

you work with the R&S SGMA-GUI.
● Check if the instrument is configured in the R&S SGMA-GUI and perform, if neces-

sary, the steps described in Chapter 5.5.2, "Managing instruments with
R&S SGMA-GUI", on page 71.

● Select "SGMA-GUI > Setup > Instruments", check the state of the instrument in the
"Configure Instruments > Available Instruments" table and activate it, if disabled.

To identify an instrument in an instrument set

1. To identify the instrument in an instrument set, use one of the device identification
functions:

● Select "SGMA-GUI > Setup > Instruments > Available Instruments > Instrument
> Edit > Edit Instrument".

● Select "SGMA-GUI > Instrument Name > Setup > Remote > Remote Chan-
nels".

● Select "SGMA-GUI > Instrument Name > Setup > LXI Status".

2. Select "Device Identify" to trigger identification.

The green [LAN] LED on the front panel of the instrument blinks.

5.5.5  Managing messages in the info dialog

To get additional information on the message

► In the "Info" dialog, click a message to select it.

In the lower section of the dialog, additional information on the highlighted mes-
sage is displayed.
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To display all messages

► In the "Info" dialog, click the "History" key.

A history of all messages that have occurred since the R&S SGMA-GUI software
was started is listed in the upper dialog pane. The most recent message is dis-
played first.

To delete an error message

1. In the "Info" dialog, select the highlighted message and

2. Click the "Delete" key.

Tip: This key is available only when the history of the messages is displayed.

The highlighted message is cleared.

To delete all error messages

► In the "Info" dialog, click the "Delete All" key.

Tip: This key is available only when the history of the messages is displayed.

All messages are cleared.

To delete all brief messages

► In the "Info" dialog, click the "Del. volatile" key.

Tip: This key is available only when the history of the messages is displayed.

All brief messages are cleared.

To call the history

1. In the "Info" dialog, click the "History" key.

A list of all messages that have occurred since the instrument switch-on is dis-
played. The most recent messages are displayed at the top of the list.

2. Click the "History" key once more.
The history lists current instrument messages.

5.6  Remote control of R&S SGMA-GUI

This section focuses on remote control of the R&S SGMA-GUI software. Also, all
remote-control commands are presented in detail with their parameters and the ranges
of numerical values.

Remote control of R&S SGMA-GUI
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Prerequisites for remote control of R&S SGMA-GUI

Remote control of R&S SGMA-GUI requires the following:
● A remote PC is connected to the SGMA instrument.
● The remote PC and the SGMA instrument are switched on.
● A connection between remote PC and the SGMA instrument is established
● The security setting "System Config > Setup > Security > SCPI over LAN" is

enabled.

For more information, see Chapter 3.1.13, "Connecting an external PC and devices",
on page 26.

For general information on remote control of Rohde & Schwarz products via SCPI,
refer to www.rohde-schwarz.com/rc-via-scpi.

5.6.1  Programming examples

The corresponding sections of the same title provide simple programming examples for
the R&S SGT. The purpose of the examples is to present all commands for a given
task. In real applications, one would rather reduce the examples to an appropriate sub-
set of commands.

The programming examples have been tested with a software tool which provides an
environment for the development and execution of remote tests. To keep the examples
as simple as possible, only the "clean" SCPI syntax elements are reported. Non-exe-
cutable command lines (for example comments) start with two characters //.

At the beginning of the most remote control programs, an instrument preset/reset is
recommended to set the R&S SGT to a definite state. The commands *RST and
SYSTem:PRESet are equivalent for this purpose. *CLS also resets the status registers
and clears the output buffer.

The programming examples address the following tasks:
● Example"Searching for SGMA instruments" on page 77
● Example"Scanning a subnet for SGMA instruments" on page 78
● Example"Evaluating scan results" on page 78
● Example"Configuring SGMA instruments" on page 79

Example: Searching for SGMA instruments
// Search for SGMA instruments using the scan function. It detects instruments
// that are connected to the remote computer via all of the available interfaces.
INSTruments:SCAN 1
*OPC?

// Query the number of available instruments.
INSTruments:COUNt?
// Response: 3
// Query instrument types.
INSTruments:TYPE?

Remote control of R&S SGMA-GUI
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// Response: SGU,SGS,SGT
// Query the symbolic names.
INSTruments:NAME?
// Response: SGU-100002,SGS-100006,SGT-100008
// Query the serial numbers. 
INSTruments:SERial?
// Response: 100002,100006,100008
// Query the remote channel used.
INSTruments:REMote:CHANnel?
// Response: LAN,USB,PCIe
// Query the hostname/IP address.
INSTruments:REMote:NAME?
// Response: rssgu100a100002, rssgs100a100006, rssgt100a100008

// You can also define a hostname prefix to filter detected SGMA instruments.
:INSTruments:SCAN:HNPRefix "rssg"
// The scan returns only instruments with hostname beginning with "rssg".
:INSTruments:SCAN 1

Example: Scanning a subnet for SGMA instruments
// Set the IP address of an instrument of the subnet.
INSTruments:SCAN:SNET:IPADdress 10.111.1.11
// Set the prefix length of the subnet.
INSTruments:SCAN:SNET:PLENgth 20
// Higher prefix lengths accelerate the scan but lower the ability to detect all
// instruments within the subnet.
INSTruments:SCAN 1

Example: Evaluating scan results
// Check the instrument state and activate instruments, if required.
INSTruments:ACTive:STATe?
// Response: 0,1,1
INSTruments:ACTive:STATe ON,OFF,OFF
// Activates the first instrument in the list, i.e. the instrument SGS-100006.

// Export the configuration into a mapping file.
INSTruments:MAPPing:FILE "d:\mapping_files\mapping.map"
// Enable exclusive access for the selected instrument.
INSTruments:EACCess:STATe?
// Response: 0,0,0
INSTruments:EACCess:STATe ON,OFF,OFF
// Locks the first instrument.
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Example: Configuring SGMA instruments
// Clear the device list and add new instruments manually.
INSTruments:CLEar
INSTruments:NAME "MYSGT100A","MYSGS100A","MYSGU100A"
// Define the instrument types.
INSTruments:TYPE "SGT","SGS"
// Specify the remote interface and name or address for the instruments in the
// device list.
INSTruments:REMote:CHANnel LAN,USB,GPIB
INSTruments:REMote:NAME "10.124.1.247","RSSGS100A1000025", 
INSTruments:USB:SERial 0,0,100025
INSTruments:GPIB:ADDRess 0,0,28
INSTruments:GPIB:BOARd 0,0,0

5.6.2  R&S SGMA-GUI commands

This section comprises the SCPI commands provided for remote control of the R&S
SGMA-GUI software.

:INSTruments:ACTive[:STATe]........................................................................................... 79
:INSTruments:CLEar........................................................................................................ 80
:INSTruments:COUNt?..................................................................................................... 80
:INSTruments:EACCess[:STATe]........................................................................................80
:INSTruments:GPIB:ADDRess...........................................................................................80
:INSTruments:GPIB:BOARd..............................................................................................81
:INSTruments:MAPPing:FILE............................................................................................ 81
:INSTruments:NAME........................................................................................................ 81
:INSTruments:REMote:CHANnel....................................................................................... 81
:INSTruments:REMote:NAME............................................................................................82
:INSTruments:SCAN........................................................................................................ 82
:INSTruments:SCAN:HNPRefix......................................................................................... 82
:INSTruments:SCAN:SNET:IPADdress............................................................................... 82
:INSTruments:SCAN:SNET:PLENgth................................................................................. 83
:INSTruments:SCAN:SNET[:STATe]................................................................................... 83
:INSTruments:SERial........................................................................................................83
:INSTruments:TYPE......................................................................................................... 83

:INSTruments:ACTive[:STATe] <State>

Enables/disables the instrument for the R&S SGMA-GUI. The main panel of this soft-
ware displays only activated instruments.

Parameters:
<State> List of BOOL-values

<StateInstr#1>,<StateInstr#2>,...
0, 1, ON, OFF

Example: See Example"Evaluating scan results" on page 78.
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Manual operation: See "Available Instruments" on page 57
See "Active" on page 60

:INSTruments:CLEar

Clears all instruments in the device list.

Parameters:
<Count> float

Range: 0  to  12

Example: See Example"Configuring SGMA instruments" on page 79.

Usage: Event

:INSTruments:COUNt?

Queries the number of the currently available instruments.

Return values: 
<Count> float

Range: 0  to  12

Example: See Example"Searching for SGMA instruments" on page 77.

Usage: Query only

Manual operation: See "Available Instruments" on page 57

:INSTruments:EACCess[:STATe] <State>

"Locks" the instruments, meaning the instrument is reserved and can be operated
exclusively from the remote PC that sent this SCPI command.

Tip: It is recommended to lock the instrument prior to further configuration.

Parameters:
<State> List of BOOL-values

<LockInstr#1>,<LockInstr#2>,...
0,1,OFF,ON

Example: See Example"Evaluating scan results" on page 78.

Manual operation: See "Exclusive Access" on page 60

:INSTruments:GPIB:ADDRess <Serial>

Sets the GPIB address of the connected instrument.

Parameters:
<Serial> List of Numbers

Example: See Example"Configuring SGMA instruments" on page 79.
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Manual operation: See "GPIB Address" on page 61

:INSTruments:GPIB:BOARd <Board>

Identifies the GPIB bus card the controller uses.

Parameters:
<Board> List of Numbers

Example: See Example"Configuring SGMA instruments" on page 79.

Manual operation: See "Board Number" on page 61

:INSTruments:MAPPing:FILE <File>

Saves the list of the available instruments in a mapping file. Mapping files are stored
with the predefined file extension .map; the file extension may be omitted.

The file is saved in the default directory. Use the command MMEM:CDIRectory to
change the default directory or specify the complete path.

Parameters:
<File> string

Example: See Example"Evaluating scan results" on page 78.

Manual operation: See "Export" on page 57

:INSTruments:NAME <Name>

Selects the alias name of the instruments, i.e. sets the "Symbolic Name".

Parameters:
<Name> <SymbolicNameInstr#1>,<SymbolicNameInstr#2>,...

Example: See Example"Searching for SGMA instruments" on page 77.

Manual operation: See "Available Instruments" on page 57
See "Symbolic Name" on page 60

:INSTruments:REMote:CHANnel <Channel>

Sets the hardware interface used by the remote channel.

Parameters:
<Channel> List of CHAR-Data

<Channellnstr#1>,<Channellnstr#2>,...
The available interfaces are: LAN, USB, SOCKET, PCIe, GPIB,
HiSLIP

Example: See Example"Searching for SGMA instruments" on page 77.

Manual operation: See "Hardware Channel" on page 61
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:INSTruments:REMote:NAME <Name>

Enters the IP Address or the host name of the connected instrument.

Parameters:
<Name> <Hostname/IP-AddressInsr#1>,<Hostname/IP-Addres-

sInsr#2>,...

Example: See Example"Searching for SGMA instruments" on page 77.

Manual operation: See "Instrument Name / IP Address" on page 61

:INSTruments:SCAN <State>

Triggers a scan function and searches for instruments connected to the remote com-
puter via all of the available interfaces.

Parameters:
<State> number

1 = triggers the scan function, 0 = aborts the running scan proc-
ess
The query command returns 1 as long as scan is running; 0 indi-
cates completed scan process.

Example: See Example"Searching for SGMA instruments" on page 77.

Manual operation: See "Scan" on page 57

:INSTruments:SCAN:HNPRefix <Prefix>

Sets the prefix the searched host names begin with.

Parameters:
<Prefix> string

Example: See Example"Searching for SGMA instruments" on page 77.

Manual operation: See "Scan LAN instruments with host name prefix" on page 58

:INSTruments:SCAN:SNET:IPADdress <Address>

Sets the IP address of an instrument within a subnet.

Use the IP address to optimize scanning for instruments within a subnet.

Parameters:
<Address> string

Example: See Example"Scanning a subnet for SGMA instruments"
on page 78.

Manual operation: See "IP Address" on page 58
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:INSTruments:SCAN:SNET:PLENgth <Number>

Sets the prefix length of the subnet mask.

Use the prefix length to optimize scanning for instruments within a subnet. A higher
value accelerates the scanning procedure but lowers the ability to detect all instru-
ments within the subnet.

Parameters:
<Number> integer

Range: 18  to  30
*RST: 18
Default unit: bit

Example: See Example"Scanning a subnet for SGMA instruments"
on page 78.

Manual operation: See "Prefix Length" on page 58

:INSTruments:SCAN:SNET[:STATe] <State>

Activates scanning of a subnet with given IP address and prefix length of the subnet.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (no preset. default: OFF)

Example: See Example"Scanning a subnet for SGMA instruments"
on page 78.

Manual operation: See "Scan Subnet" on page 58

:INSTruments:SERial <Serial>

Enters the serial number as instrument's identification while using the USB interface for
remote control.

Parameters:
<Serial> <SerialNumberInstr#1>, <SerialNumberInstr#2>,...

Example: SeeExample"Configuring SGMA instruments" on page 79.

Manual operation: See "Serial Number" on page 61

:INSTruments:TYPE <Type>

Sets the instrument type.

Parameters:
<Type> List of CHAR-Data

<TypeInstr#1>,<TypeInstr#2>,...

Example: See Example"Configuring SGMA instruments" on page 79.
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Manual operation: See "Available Instruments" on page 57
See "Instrument Type" on page 60

5.6.3  List of R&S SGMA-GUI commands

:INSTruments:ACTive[:STATe].........................................................................................................................79
:INSTruments:CLEar........................................................................................................................................80
:INSTruments:COUNt?.................................................................................................................................... 80
:INSTruments:EACCess[:STATe].....................................................................................................................80
:INSTruments:GPIB:ADDRess........................................................................................................................ 80
:INSTruments:GPIB:BOARd............................................................................................................................ 81
:INSTruments:MAPPing:FILE.......................................................................................................................... 81
:INSTruments:NAME....................................................................................................................................... 81
:INSTruments:REMote:CHANnel.....................................................................................................................81
:INSTruments:REMote:NAME......................................................................................................................... 82
:INSTruments:SCAN........................................................................................................................................82
:INSTruments:SCAN:HNPRefix....................................................................................................................... 82
:INSTruments:SCAN:SNET:IPADdress............................................................................................................82
:INSTruments:SCAN:SNET:PLENgth.............................................................................................................. 83
:INSTruments:SCAN:SNET[:STATe]................................................................................................................83
:INSTruments:SERial.......................................................................................................................................83
:INSTruments:TYPE........................................................................................................................................ 83
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6  Signal generator settings
This section summarizes the settings necessary to configure the instrument for signal
generation. The description in this section follows the menu tree structure of the graph-
ical user interface.

6.1  Baseband

6.1.1  System configuration

Access:

► Select "SGMA-GUI > Instrument Name > Baseband > System Configuration".

In the "System Configuration" dialog, you can select the signal settings. Depending on
the selected settings the signal flow block diagram can look different, see Table 6-1.

Table 6-1: System configuration modes

"Standard"

"ARB for Envelope Tracking"

Baseband
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When the "ARB for Envelope Tracking" mode is selected, a second ARB for the enve-
lope tracking is generated, which is output at the analog I/Q output. The ARB of the
first "Baseband" is then output at the [RF] output.

You can configure the envelope tracking signal in the "Arbitrary Waveform for ET" dia-
log. To access this dialog, click on the "Baseband 2" block or select "SGMA-GUI >
Instrument Name > Baseband > ARB for Envelope Tracking". For a description of the
settings, see Chapter 6.1.2, "ARB", on page 87.

The ARB waveform for the envelope tracking ("Baseband 2") uses the same trigger,
marker and clock settings as the first ARB waveform ("Baseband").

For more information on the envelope tracking, see Chapter 6.5, "Generation of enve-
lope tracking signals", on page 165.

Settings

System Configuration....................................................................................................86
Apply............................................................................................................................. 87
OK................................................................................................................................. 87

System Configuration
Selects the signal flow settings.
"Standard" Selects the standard mode for the signal generator.
"ARB for Envelope Tracking"

When this mode is enabled, a second ARB signal is generated, which
is output at the analog output connectors. This ARB can be only used
for envelope tracking.

Baseband
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Remote command: 
:SCONfiguration:MODE on page 374

Apply
Triggers the instrument to adopt the selected configuration.

OK
Applies the configuration and exits the dialog.

6.1.2  ARB

The arbitrary waveform generator (ARB) is an I/Q modulation source forming a part of
the R&S SGT. The ARB allows the playback and output of any externally calculated
modulation signals in the form of waveform files and the generation of multi-carrier or
multi-segment signals from waveform files.

The ARB generator requires option R&S SGT-K510.

6.1.2.1  About ARB

This section provides background information on the ARB functionality and the impact
of the provided settings.

For a description of the multi-carrier and multi-segment wave functions, refer to:
● Chapter 6.1.2.4, "Multi-carrier waveforms", on page 104
● Chapter 6.1.2.3, "Multi-segment waveforms", on page 93

Waveform file sources

In ARB mode, the R&S SGT uses ARB waveform files to obtain the digital I/Q data of
the baseband signal. The R&S SGT can replay any waveform file stored on its solid-
state drive (SSD) but it can also generate and replay simple waveforms for test purpo-
ses.

A waveform is a file with specified file format containing raw IQ samples. The IQ values
are calculated in advance and stored as waveform files with a predefined extension
*.wv. When created by the R&S SGT, the instrument inserts a tagged waveform
header at the beginning of each created ARB file. For more information, refer to Chap-
ter 11, "Waveform and list format", on page 565.

Depending on whether the R&S SGT creates the waveform files itself or not, two wave-
form files sources can be distinguished:
● Internally generated waveforms

The ARB generator enables calculation and generation of multi-segment and multi-
carrier waveform files. Also, it provides a built-in function to create a test waveform
(e.g. a sine or rectangle signal) and keep it as a file or in the RAM.

● Externally generated waveforms
The ARB can process externally generated waveform files. For example, waveform
files generated by software, such as R&S WinIQSIM2, R&S ARB Toolbox, the

Baseband
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R&S Pulse Sequencer. Besides, waveform files can also consist of signals calcula-
ted using a mathematical program such as Matlab.
Generation of waveform files and their transfer from R&S WinIQSIM2 or
R&S Pulse Sequencer to the R&S SGT is menu-guided.
The externally generated waveform files can be loaded into the instrument via one
of the available interfaces (USB, LAN or PCIe). For a detailed description, see
Chapter 8.5, "How to load and play waveform files", on page 305.

For more information on generation and transfer of waveform files, see:
● R&S WinIQSIM user manual
● R&S Pulse Sequencer software user manual

Required options

Two types of software options are relevant in this context:
● R&S SGT-K2xx/-K4xx:

These options are required to process a waveform file generated with R&S WinIQ-
SIM2.
Multi-segment waveform files require the options for all included digital standards.
For some of the R&S SGT-K2xx/-K4xx options, Rohde & Schwarz provides also a
library containing some already generated waveform files.

● R&S SGT-KVxx:
Additional waveform libraries are offered as R&S SGT-KVxx options. Such an
option allows you to process all waveform files included in the library.

If your instrument order includesR&S SGT-KVxx options, the related waveform libraries
are pre-installed on your instrument.

For more information, see:
● R&S SGT product page for required options (Chapter 2.3, "Documentation over-

view", on page 16).
● Application note 1MA028 “IQWizard - I/Q Signal Measurement and Conversion" for

IQ data management.

ARB test signals

The following test signals are available:
● Sine test signal: Two sine wave signals with a selectable (but equal) number of

samples per period and equal frequencies. When the generation is triggered, the
number of samples per period, together with the frequency of the test signal, deter-
mine the ARB clock frequency: "Clock Frequency" = "Frequency" * "Samples per
Period".
Note: Because the resulting clock rate must not exceed the maximum ARB clock
rate (see data sheet), the number of sample values is automatically restricted
depending on the selected frequency.
The first sine signal is mapped on the I samples, the second on the Q samples.
The two signals differ by a selectable phase offset. For a –90 deg offset, the result
is a unit vector in the I/Q plane, rotating counter-clockwise and starting at I = 0, Q =
–1. For a 0 deg offset, the I and Q samples are on the diagonal of a unit square (I(t)
= Q(t)).
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In general, the I/Q samples are located on a deformed circle which is confined to
the dashed square in the upper diagrams.

● Rectangular test signal: Rectangle signal with selectable but equal On and Off
periods and amplitude. The period is defined by the selected frequency: <Period>
= 1 / "Frequency".
The signal is mapped on both the I and Q samples. The mapping results in two dis-
tinct points in the I/Q plane. The "Offset DC" shifts both points along the diagonal
I(t) = Q(t).

● Constant I/Q test signal: Continuous test signal with constant IQ and constant
clock frequency of 10 KHz. The values for each I and Q components are selectable
but constant. They are defined as a decimal number, which is decimal-to-binary
converted internally. The signal is provided as a 16-bit wide digital signal for both I
and Q channels.
After converting to an analog signal, the signal is output directly at the BNC con-
nectors [I] and [Q] outputs of the instrument.

Baseband
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6.1.2.2  General settings

Access:

► Select "SGMA-GUI > Instrument Name > BB > ARB > General".

The "Arbitraty Waveform Modulation" menu provides settings for enabling the ARB
and calling further dialogs for selecting and configuring a waveform.

Settings:

State..............................................................................................................................90
Set To Default................................................................................................................91
Waveform Location....................................................................................................... 91
Load Waveform.............................................................................................................91
Waveform Info...............................................................................................................92
Clock Frequency........................................................................................................... 92
Multi Segment............................................................................................................... 92
Multi Carrier...................................................................................................................92
Create Test Signal.........................................................................................................93

State
Enables/disables ARB modulation.
The output is based on the waveform file that is loaded. The name of the waveform file
is displayed next to "Load Waveform".
If a multi-segment waveform is loaded, the section "Multi Segment Waveform Options"
is indicated. In this section, the segment to be output is selected.
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If no waveform file is loaded, ARB modulation cannot be powered up. "None" is dis-
played next to "Load Waveform". An error message asks you to load a waveform file:
"No waveform file loaded. ARB MOD state remains off. Please select a waveform file
to load, before switching on ARB MOD state."
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:STATe on page 402

Set To Default
Calls default settings. The values are shown in Table 6-2.
Table 6-2: Default settings

Parameter Value

"State" Off

"Clock Frequency" 1 MHz

"Trigger Mode" Auto

"Trigger Source" Internal

"Marker State" Off

"Marker Mode" Unchanged

"Clock Source" Internal

Remote command: 
[:SOURce<hw>]:BB:ARBitrary:PRESet on page 401

Waveform Location
Selects the location of the waveform that you want to load.
"Instrument" The waveform file is located on the instrument's internal memory.
"Local file system"

The waveform file is located on the local computer. In this case, the
waveform is first automatically copied on the instrument's internal
memory and then selected.
Note: To load a waveform from a USB memory stick (or external hard
disk) plug the stick into the controller PC, select "Waveform Location
> Local file system" and in the "Load Waveform" >"File Select" dialog
navigate to the external drive.

Load Waveform
Calls the "File Select" menu for loading the waveform file.
The files last used are listed in the "Recent Data Sets" section. The directory can be
selected from the center left section. All waveform files (file extension *.wv) available
from the selected directory are listed on the right side. The file info (tag contents and
multi-segment state) for the selected file is displayed below the file section.
The "Select..." button selects the marked file. This file is loaded when the ARB modula-
tion is enabled ("State On").
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For a description on how to manage the waveform files, refer to Chapter 4.2, "Manag-
ing files on the R&S SGT", on page 50.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:WAVeform:SELect on page 437

Waveform Info
Opens a dialog with detailed information about the currently selected waveform.
The waveform information displayed in this dialog depends on whether the selected
waveform file is a multisegment one or not. All parameters are read-only.

For non-multi-segment waveform files, the values of the settings can be queried by the
tag commands (see Chapter 11, "Waveform and list format", on page 565).
Remote command: 
n.a.

Clock Frequency
Displays or enters the ARB output clock rate.
When the waveform file is loaded, this value is automatically set to the clock rate
defined in the file (clock tag). If necessary, you can change the value later.
When intending to work with an external clock source, the frequency to be applied
must be entered here.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:CLOCk on page 403

Multi Segment
Calls the menu for calculating multi-segment waveforms (seeChapter 6.1.2.3, "Multi-
segment waveforms", on page 93).
Remote command: 
n.a.

Multi Carrier
Calls the dialog for calculating multi-carrier waveforms (see Chapter 6.1.2.4, "Multi-car-
rier waveforms", on page 104).
Remote command: 
n.a.
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Create Test Signal...
Selects the form of the test signal and calls the menu for generating it. A sinusoidal,
rectangular or test signal with constant I/Q can be selected.
See the corresponding section for detailed description of the parameters for the
selected test signal:
● Chapter 6.1.2.5, "Sine test signal", on page 117
● Chapter 6.1.2.6, "Rect Test Signal", on page 118
● Chapter 6.1.2.7, "Const I/Q Test Signal", on page 120
Remote command: 
n.a.

6.1.2.3  Multi-segment waveforms

Modern chip technologies implement several communication standards within one chip
and rise special verification and test requirements. To fulfill the requirements of these
test systems and to enable rapid alternation between different waveforms with differing
test signals, the R&S SGT provides the functionality to generate multi-segment wave-
form files.

This section introduces the concept of the multi-segment waveform files, together with
description of the provided settings and some typical configuration examples.

Introduction

A multi-segment waveform is a composed signal containing multiple independent
waveforms called segments. Each segment represents an independent waveform that
can be output with its own marker and clock settings.

The Figure 6-1 shows the principle of building a multi-segment waveform.

Figure 6-1: ARB multi-segment waveform concept
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It is also possible to create and output a blank segment, i.e. segments containing a
zero signal.

Multi-segment waveforms processing

Processing of the waveform is triggered by the "Create" or "Create and Load" function.
To process the waveform, the instrument loads the entire multi-segment waveform into
the memory. It is therefore possible to alternate between the individual waveforms with-
out delay due to loading. You can define the output order of the segments, and the
segment intended to be output at any given moment.

File concept

To provide flexible configuration, the building of a composed multi-segment waveform
file involves different stages; by completing of each of them, the R&S SGT creates and
stores a dedicated file. The following files are used:
● Configuration list: is a dedicated file with details on how a multi-segment wave-

form is made up from different waveforms, the level and the clock rate settings, and
the filename. The file extension is *.inf_mswv.
You can create any number of configurations as a basis for defining further multi-
segment waveforms.

● Output file: is the created output multi-segment waveform file. The R&S SGT
stores it under a user-definable name; as with the standard waveforms, the used
file extension is *.wv. The instrument appends additional information to the header
of the composed waveform file, e.g. user comments.

Multi-segment waveform settings

Access:

► Select "SGMA-GUI > Instrument Name > Baseband > ARB > Multi Segment".

To create multi-segment waveform file

1. Select "New List" to create an empty list.

The "Create Multi Segment Waveform List" dialog opens.

Store the list in the default directory, e.g. with filename
MyMultiSegmentWaveform:
C:/ProgramData/Rohde-Schwarz/sgt/volatile
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2. Use the "Append" function to add two or more waveform files.

3. Adjust the "Level", "Clock" and "Segment Marker" settings.

4. Select the "Output File".

5. Enter a filename.

6. Select "Save" to save the configuration.

7. Select "Create" or "Create and Load" to create and save the multi-segment wave-
form.

● General settings......................................................................................................95
● Segment table.........................................................................................................98
● Level/clock/marker settings...................................................................................100
● Multi-segment waveform sequencing....................................................................102

General settings

Access:

► Select "SGMA-GUI > Instrument Name > Baseband > ARB > Multi Segment.. >
General".

This dialog comprises the settings for managing files, lists and the possibility to add
a comment.

Settings:

New List........................................................................................................................ 96
Load List........................................................................................................................96
Save List....................................................................................................................... 96
Create........................................................................................................................... 96
Create and Load........................................................................................................... 96
Comment.......................................................................................................................97
Output file......................................................................................................................97
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New List
Calls the "Create Multi Segment Waveform List" dialog to enter the name of the new
file.
A new configuration table is created.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:SELect on page 445

Load List
Opens the file menu to select the configuration file to be edited.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:CATalog? on page 440
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:SELect on page 445

Save List
Saves the current entries of the table in a configuration file, including the level mode,
clock mode, segment marker mode and output filename settings.
The filename is entered in the "File" menu. Configuration files have the file extension
*.inf_mswv. They can be used later as the basis for further multi-segment wave-
forms.
Before a multi-segment configuration file can be saved, a filename must be entered in
"Output File". The output file is saved with the configuration file for internal purposes.
Remote command: 
The configuration file to be used for the creation of the multi-segment waveform is
defined with the command:
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CREate
The filename of the waveform file is always determined with the command:
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:OFILe

Create
Creates a multi-segment waveform using the current table entries.
This multi-segment waveform is saved with the filename specified in "Output File". As
with normal waveforms, the file extension is "*.wv".
Depending on the configuration of the multi-segment waveform, calculation can take
some time. A panel with a progress bar and an "Abort" button appears during creating
of the multi-segment waveform.
In remote control, create or create and load the multi-segment waveform file with the
following commands:
● [:SOURce<hw>]:BB:ARBitrary:WSEGment:CREate on page 445
● [:SOURce<hw>]:BB:ARBitrary:WSEGment:CLOad on page 439.
To specify the filename, use the following command:
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:OFILe on page 443

Remote command: 
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CREate on page 445

Create and Load
Creates a multi-segment waveform using the current table entries.
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The multi-segment waveform is saved with the filename specified in "Output File". As
with normal waveforms, the file extension is *.wv.

Depending on the configuration of the multi-segment waveform, calculation can take
some time. Afterwards, the "Create Multi Segment Waveform File" submenu is closed
and the new multi-segment waveform is loaded.
In remote control, create or create and load the multi-segment waveform file with the
following commands:
● [:SOURce<hw>]:BB:ARBitrary:WSEGment:CREate on page 445
● [:SOURce<hw>]:BB:ARBitrary:WSEGment:CLOad on page 439.
To specify the filename, use the following command:
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:OFILe on page 443

Remote command: 
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CLOad on page 439

Comment
Adds a comment to the multi-segment file.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:COMMent on page 441

Output file
Opens the file menu, where the filename of the multi-segment waveform which has to
be calculated can be entered. The multi-segment waveform is saved under this name
by clicking the "Create" or "Create and Load" button.
Enter a name before saving the list as a configuration file ("Save List"). In this case, the
name is needed for internal storage procedures. It is entered as the default name for
the multi-segment waveform file when loading the list.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:OFILe on page 443
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Segment table

Access:

► Select "SGMA-GUI > Instrument Name > Baseband > ARB > Multi Segment >
Segment Table".

This dialog comprises the settings for creating and adjusting the contents of the
multi-segment file.

Settings:

Multi Segment Table......................................................................................................98
Append..........................................................................................................................99
Delete............................................................................................................................99
Shift Seg.# Up/Down.....................................................................................................99
Clock Rate.....................................................................................................................99
Samples........................................................................................................................ 99
Period............................................................................................................................99
Append Blank................................................................................................................99

Multi Segment Table
The table lists the individual waveforms (segments) of the selected multi-segment
waveform. The information about the segments is taken from the tags of the corre-
sponding waveform files.
"Segment#" Indication of segment index. The segment index is used to select the

segment to be output.
The segment index also defines the sequence of the output during
triggering in the "Next Segment" or "Next Segment Seamless".

"Filename" Indication of the waveform filename of the segment.
"Clock Rate" Indication of the clock rate of the segment.
"Samples" Indication of the number of samples in the segment.
"Period" Indication of the segment duration.
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"Path" Indication of the location of the waveform file used for the corre-
sponding segment.

"Comment" Indication of the comment on the segment.
"Info" Opens a dialog with detailed information about the currently selected

waveform.
Remote command: 
n.a.

Append
Opens the file menu to enter the filename of the waveform file to be appended.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:SEGMent:CATalog?
on page 444
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:SEGMent:APPend
on page 444

Delete
Deletes the selected segment.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:DELete on page 441

Shift Seg.# Up/Down
Shifts the selected segment up and down.

Clock Rate
Selects the clock rate of the blank segment.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:BLANk:APPend
on page 439

Samples
Selects the number of samples for the blank segment.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:BLANk:APPend
on page 439

Period
Displays the resulting period for the blank segment.
Remote command: 
n.a.

Append Blank
Adds the blank segment to the multi-segment file.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:BLANk:APPend
on page 439
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Level/clock/marker settings

Access:

► Select "SGMA-GUI > Instrument Name > Baseband > ARB > Multi Segment.. >
Segment Table".

The Level/Marker/Clock section provides the parameters necessary to adjust the
level, marker and clock settings for the selected multi-segment waveform file.

Settings:

Level............................................................................................................................100
Clock........................................................................................................................... 100
User Clock Rate.......................................................................................................... 101
Segment Marker..........................................................................................................101
Sequence Restart....................................................................................................... 101
Segment Restart......................................................................................................... 102

Level
Defines the level mode for the multi-segment waveform.
"Unchanged" Concerning the level settings, the segments are output exactly as

defined in the files. The "Level" display applies only to the segment
with the highest rms value. In some circumstances, the remaining
segments are output at a lower level than displayed.

"Equal RMS" Segments are output so that all segments have the same rms value.
The "Level" display applies to all segments.

Remote command: 
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:LEVel[:MODE]
on page 442

Clock
Selects the clock rate mode for the multi-segment waveform.
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"Unchanged" A segment is output with the clock rate defined in the file.
If segments have different clock rates, extended trigger mode "Next
Segment" allows internal segment switchovers only ("Internal" trigger
source).
Extended trigger mode "Next Segment Seamless" can only be
selected if all segments have the same clock rate.

"Highest" All segments are output at the highest available clock rate.
This mode provides short switchover times between segments.
The time for calculating the multi-segment waveform is increased
since the individual segments have to be resampled.

"User" All segments are output at the clock rate defined in "User Clock".
This mode provides short switchover times between segments.
The time for calculating the multi-segment waveform is increased
since the individual segments have to be resampled.

Remote command: 
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:CLOCk:MODE
on page 441

User Clock Rate
Requires "Clock Mode > User".
Defines the sample rate used for multi-segment waveform output.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:CLOCk on page 440

Segment Marker
Defines the way the marker information within the separate segments is processed.
"Ignore" The marker information carried in the individual segment waveform

files is not considered.
"Take Over" The output waveform file contains the marker information as config-

ured in the individual waveform files.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:MARKer:MODE
on page 443

Sequence Restart
Enables/disables the generation of an additional marker restart signal in the output
waveform file.
If additional marker generation is enabled, the existing marker signals in the individual
segment waveform files are not considered.
"Disable" No additional marker is generated.
"Marker
1/2/3/4"

Generates a restart marker signal at the beginning of the first seg-
ment for the corresponding marker.
Use this setting to generate a restart marker for the complete
sequence.
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Remote command: 
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:MARKer:FSEGment
on page 442

Segment Restart
Enables/disables the generation of an additional marker restart signal in the output
waveform file.
If additional marker generation is enabled, the existing marker signals in the individual
segment waveform files are not considered.
"Disable" No additional marker is generated.
"Marker
1/2/3/4"

Generates a restart marker signal at the beginning of each segment
for the corresponding marker.
The starting point of the segment is set at the low-high slope of the
marker. The setting applies for switching between two segments and
for replaying segments.

Remote command: 
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:MARKer:ESEGment
on page 442

Multi-segment waveform sequencing

The settings provided in the "Multi Segment Waveform Sequencing" dialog can be
adjusted to crate a “play list”, i.e. to define the sequence in which the waveform file
segments are processed and how many times each of them is repeated. The config-
ured play list is displayed in form of a "Sequencing Graphic".

All segments in a “play list” must have the same clock rate.
In the "ARB" main dialog or in the "ARB Trigger/Marker/Clock" dialog, set the "Next
Segment Mode" to "Sequencer" to activate the configured “play list”.

Sequencing List
Displays the name of the selected sequencing list file, i.e. the file with the “play list” set-
tings.
The sequencing list file has an extension *.wvs and is automatically assigned to but
independent from the multi-segment file. By default, both files have the same name
and are located in the same file directory. More than one sequencing list files can be
created per multi-segment waveform file.
The sequencing list file carries information only about the segment number. The corre-
sponding waveform file names are retrieved from the assigned multi-segment wave-
form file. I.e., the same sequencing list file can be reused for different multi-segment
waveform files with the same number of segments.
Changes and recalculations of a multi-segment waveform file cause a recheck whether
the assigned sequencing list files are still valid. A message is displayed to inform about
necessary corrections in the “play list”.
Remote command: 
n.a.
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Assigned to Multi Seg. Waveform
Displays the name of the multi-segment waveform file that the current sequencing list
file is assigned to.
Remote command: 
n.a.

Sequencing Play List
The "Sequencing Play List" table defines the sequence order that the waveform file
segments are processed and how many times each of them is repeated.
"Id#" Indicates the row number.
"State" Enables/disables the selected row. Only active segments are pro-

cessed.
"Segment#" Indicates the segment index.

The sequencing list file carries information only about the segment
index, the corresponding filenames are retrieved from the assigned
multi-segment waveform file.

"Waveform" Indicates the waveform file mapped to the corresponding segment.
The filename is retrieved from the assigned multi-segment waveform
file.
Available are only waveform files from the pool of segments of the
selected multi-segment waveform file.

"Repetition Cycles"
Sets the number of times the selected segment is cyclically repeated
before the next segment in the sequence is processed.

"Info" Opens a dialog with detailed information about the currently selected
waveform.

Remote command: 
See "Append" on page 103.

Next ← Sequencing Play List
Determines the action after completing the current one, like, for instance, which seg-
ment is processed after the processing of the current one is finished.
"Next Id#" The next active segment in the play list is processed.
"Blank" After the processing of the current segment is completed, the signal

output is stopped until a signal restart like a retrigger signal is
received.
A restart signal causes a complete restart of the sequencing play list.

"Endless" The current segment is replayed until a signal restart like a retrigger
signal is received and the complete sequencing play list is restarted.
Only active segments are considered.

"Goto Id#" Determines the row number of the segment to be processed next.
This feature is limited to the first 32 rows.

Append ← Sequencing Play List
Inserts a new row at the end of the sequencing play list table.
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Remote command: 
[:SOURce<hw>]:BB:ARBitrary:WSEGment:SEQuence:SELect on page 448
[:SOURce<hw>]:BB:ARBitrary:WSEGment:SEQuence:APPend on page 447

Delete ← Sequencing Play List
Deletes the selected row.

Shift Id# Up/Down ← Sequencing Play List
Rearranges the rows, i.e. moves the selected row up and down.

Sequencing Graphic
Displays the play list graph according to the current configuration.
The graph shows the segment sequence, the segment number and the number of
times, the segment is repeated; considered are only the active segments.
Remote command: 
n.a.

New/Load Sequencing List
Accesses the standard "Select Sequencing List" function to define the name of the new
play list file or select of an existing one.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:WSEGment:SEQuence:SELect on page 448

Save Sequencing List
Saves the current entries of the table in a play list file.
The default filename of the play list file is the same as the multi-segment waveform file-
name, but it can be changed.
Play list files have the file extension *.wvs.

Remote command: 
n.a.

6.1.2.4  Multi-carrier waveforms

Multi-carrier waveforms consisting of up to 512 carriers modulated by user-selectable
baseband signals can be created to simulate complex multi-carrier scenarios with dif-
ferent baseband signals (e.g. CDMA2000 or 3GPP FDD).

The carriers are centered toward the RF frequency or baseband DC line, respectively.
The carrier spacing is adjustable within the total available baseband bandwidth. Each
carrier can be separately defined in terms of power, phase and modulated input signal.
Optionally, crest factor optimization can be applied.

Thus, multi-carrier waveforms can be easily configured as broadband test signals and
used for such purposes as transmitter or receiver tests. Even complex multi-carrier
scenarios composed of signals from different digital standards can be created and
used for these tests.
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Creating a multi-carrier waveform file

1. Configure general settings.

2. Configure carrier table.

3. Enter filename of the multi-carrier waveform ("Output File").

4. Save and load the multi-carrier waveform ("Create" or "Create and Load").

Accessing the multi-carrier settings

To access the "Multi Carrier" dialog, select "Baseband > ARB >General > Multi Car-
rier...".

The menu can be used to create a multi-carrier waveform and save it under its own
name. As with normal waveforms, the file extension is *.wv. Information on clock rate,
number of samples and creation day is displayed in the file menu when a waveform is
loaded.

Default settings and state

The upper part of the "General"dialog is used for calling the default settings and saving
and recalling existing ARB multi carrier submenu settings.

Set to Default
Calls default settings. The values are shown in the following table.
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Parameter Value

"Number of Carriers" 1

"Carrier Spacing" 0 MHz

"Crest Factor Mode" Off

"Signal Period Mode" Longest file wins

Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:PRESet on page 430

Save/Recall Frame
Calls the "Save/Recall" dialog.
From the "Save/Recall" menu, the "File Select" windows for saving and recalling the
configurations of the ARB "Multi Carrier" submenu and the "File Manager" can be
called.
Multi-carrier configurations are stored as files with extension *.arb_multcarr. File-
name and storage directory are user-definable. The complete settings in the "Multi Car-
rier" menu are saved and recalled.
"Recall Multi Carrier Settings"

Opens the "File Select" window for loading a saved multi carrier con-
figuration.
The configuration of the selected (highlighted) file is loaded by press-
ing the "Select" button.

"Save Multi Carrier Settings"
Opens the "File Select" window for saving the current multi carrier
signal configuration.
The name of the file is specified in the "filename" entry field, the direc-
tory selected in the "Save Into" field. The file is saved by pressing the
"Save" button.
The "Fast Save" checkbox determines whether the instrument per-
forms an absolute or a differential storing of the settings. Enable this
function to accelerate the saving process by saving only the settings
with values different to the default ones. "Fast Save" is not affected
by the "Preset" function.

"File Manager" Calls the "File Manager" window.
The "File Manager" is used to copy, delete, and rename files and to
create directories.

Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:SETTing:CATalog? on page 431
[:SOURce<hw>]:BB:ARBitrary:MCARrier:SETTing:LOAD on page 431
[:SOURce<hw>]:BB:ARBitrary:MCARrier:SETTing:STORe:FAST on page 432
[:SOURce<hw>]:BB:ARBitrary:MCARrier:SETTing:STORe on page 431

General settings

The "General Settings" section is used to configure the multi carrier signal.
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Settings:

Mode........................................................................................................................... 107
Number of Carriers......................................................................................................107
Carrier Spacing........................................................................................................... 107
Crest Factor Mode...................................................................................................... 108
Clipping....................................................................................................................... 108
Target Crest Factor..................................................................................................... 108
Filter Cut Off Frequency..............................................................................................109
Signal Period Mode.....................................................................................................109
Signal Period...............................................................................................................109
Power Reference.........................................................................................................110
Carrier Table................................................................................................................110

Mode
Selects the carrier frequency mode.
"Equidistant Carrier Spacing"

Sets an equidistant carrier spacing. The carrier frequency in the car-
rier table is not configurable.

"Arbitrary Carrier Frequency"
Enables you to specify the carrier frequency in the carrier table. Car-
rier spacing is not relevant.

Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier:MODE on page 420

Number of Carriers
Sets the number of carriers for the multi carrier waveform.
By default the multi carrier table lists 1 carrier. When the number of carriers is
increased, the multi carrier table is extended by adding further lines at the end of the
table. If these carrier already have been defined before, the settings are preset accord-
ing to the former settings. Otherwise the parameters are preset with the default values.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier:COUNt on page 419

Carrier Spacing
Sets the frequency spacing between adjacent carriers of the multi carrier waveform.
The carriers are arranged symmetrically around the RF carrier and the maximum car-
rier spacing is limited to:
"Carrier Spacing" = Total Baseband Bandwidth /("Number of Carriers" - 1).
The total baseband bandwidth is 160 MHz.
Note: To avoid wrap-around problems, the effective "Carrier Spacing" is modified
slightly.
The "Carrier Spacing" is rounded in that way that the carrier closest to the center RF
frequency shows no phase jump assuming that the carrier is unmodulated.
● For odd number of carriers:

RoundedCarrierSpacing=1/OutputSignalDuration* round(CarrierSpacing * Output-
SignalDuration)
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● For even number of carriers:
RoundedCarrierSpacing=2/OutputSignalDuration*round(0.5 *CarrierSpacing * Out-
putSignalDuration)

Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier:SPACing on page 420

Crest Factor Mode
Selects the mode for optimizing the crest factor by calculating the carrier phases.
The crest factor represents the ratio of the peak voltage value to the rms voltage value.
The higher the crest factor and resulting dynamics of a signal, the greater the require-
ment for a power amplifier fed by the signal to be linear.
The following modes are available:
"Off" There is no automatic setting for minimizing or maximizing the crest

factor. The "Phase" setting as defined in the carrier table is in use.
"Minimize" The crest factor is minimized by internally calculating optimized car-

rier phases. The "Phase" setting displayed in the carrier table is inva-
lid.

"Maximize" The crest factor is maximized by internally calculating optimized car-
rier phases. The "Phase" setting displayed in the carrier table is inva-
lid.

Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CFACtor:MODE on page 423

Clipping
Switches baseband clipping on and off.
Clipping reduces the peak power of the resulting multi carrier signal according to the
input parameter "Target Crest Factor".
The resulting clipped peak power is defined by the sum of the RMS level of the unclip-
ped multi carrier signal and the input parameter "Target Crest Factor". Note that clip-
ping reduces also the RMS level. Hence the resulting crest factor of the clipped signal
is slightly above the "Target Crest Factor".
To match unclipped parts of the clipped multicarrier signal with the unclipped multicar-
rier signal, reduce the RF output power. Reduce it by the difference between resulting
crest factor and "Target Crest Factor".
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CLIPping[:STATe] on page 425

Target Crest Factor
Available only for "Clipping > On".
Sets the value of the desired crest factor.
A "Target Crest Factor" above the crest factor of the unclipped multicarrier signal has
no effect.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CLIPping:CFACtor on page 424
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Filter Cut Off Frequency
Available only for "Clipping > On"
Sets the cut-off frequency of the final lowpass filter.
If the cut-off frequency is set as half of the output sample rate, a final lowpass filter
improves the spectrum of the clipped multicarrier signal. As a trade-off, the resulting
crest factor can increase.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CLIPping:CUToff on page 424

Signal Period Mode
Selects the mode for calculating the resulting signal period of the multi carrier wave-
form. The carrier table provides an information button to obtain sample rate and file
length data of each carrier.
The resulting period is always calculated for all carriers in the carrier table irrespective
of their state (On/Off).
Note: Wrap-around and timing problems can occur when I/Q signals of different length
are used. Thus, demodulation of a carrier can be difficult or even impossible.
We recommend you to consider timing already when creating the input I/Q files. Also,
adjust the signal duration to the carrier which is later demodulated (in this case, the
other carriers are for interfering the signal only). The problems do not arise with signals
of the same standard (e.g. 3GPP).
The following modes are available:
"Longest File Wins"

The resulting signal period is defined by the longest I/Q file in the car-
rier table. Shorter I/Q files are periodically repeated.

"Shortest File Wins"
The resulting signal period is defined by the shortest I/Q file in the
carrier table. Only the first part of longer I/Q files is used.

"User" The signal period can be set in the "Signal Period" field. Shorter I/Q
files are repeated periodically, and only the first part of longer I/Q files
is used.

"Least Common Multiple"
The output file duration is the least common multiple of all input file
durations.

Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:TIME:MODE on page 432

Signal Period
Available only for "Signal Period Mode > User"
Sets the signal period. Shorter I/Q files are repeated periodically, and only the first part
of longer I/Q files is used.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:TIME on page 432
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Power Reference
Defines the way the individual carriers in a composed multi carrier signal are leveled.
The difference between the provided modes is especially important if signals with dif-
ferent crest factors are composed together into a multi carrier signal.
"RMS" The individual carriers are leveled based on their RMS power and the

configured "Carrier Gain".

Example: 
A multi carrier signal is composed from two waveform files.
First carrier "Gain" = 0 dB
Second carrier "Gain" = -3 dB
In the resulting multi carrier signal, the RMS power of the second car-
rier signal is 3 dB lower than the RMS power of the first carrier signal.

"Peak" The individual carriers are leveled based on their peak power and the
configured "Carrier Gain".

Example: 
A multi carrier signal is composed from two waveform files.
First carrier "Gain" = 0 dB
Second carrier "Gain" = -3 dB
In the resulting multi carrier signal, the peak power of the second car-
rier signal is 3 dB lower than the peak power of the first carrier signal.

Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:POWer:REFerence on page 423

Carrier Table
Calls the table for configuring individual carriers. A selectable carrier range can be set
with the aid of the optional "Carrier Table Assistant" (see "Multi carrier table settings"
on page 111).
The multi carrier configuration can be checked with the aid of the "Carrier Graph".

Output settings

The "Output Settings" section in the multi carrier dialog indicates the name, the size
and the clock rate of the currently calculated multi carrier output file.

Settings:

Output File...................................................................................................................110
Clock Rate................................................................................................................... 111
File Size.......................................................................................................................111
Create..........................................................................................................................111
Create and Load..........................................................................................................111

Output File
Opens the "File" dialog, where the output filename of the multi carrier waveform which
has to be calculated can be entered.
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The multi carrier waveform is calculated and saved under this name by clicking the
"Create" or "Create and Load" button.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:OFILe on page 430

Clock Rate
Displays the resulting sample rate at which the multi carrier waveform is output by the
arbitrary waveform generator. The output clock rate depends on the number of carriers,
carrier spacing and input sample rate of the leftmost or rightmost carriers.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CLOCk? on page 426

File Size
Displays the resulting number of samples of the multi carrier waveform.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:SAMPles? on page 430

Create
Creates a multi carrier waveform defined by the multi carrier table and general setting
entries.
This multi carrier waveform is saved with the filename specified in "Output File". If no
filename is specified, the "File Manager" opens so that the filename can be entered. As
with normal waveforms, the file extension is *.wv.

Depending on the configuration of the multi carrier waveform, calculation can take
some time. A panel with a progress bar and an "Abort" button appears during the cal-
culation process.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CREate on page 426

Create and Load
Creates a multi carrier waveform defined by the multi carrier table and general setting
entries and loads it later into the "ARB" main menu.
This multi carrier waveform is saved with the filename specified in "Output File". If no
filename is specified, the "File Manager" opens so that the filename can be entered. As
with normal waveforms, the file extension is *.wv.

Depending on the configuration of the multi carrier waveform, calculation can take
some time. A panel with a progress bar and an "Abort" button appears during the cal-
culation process.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CLOad on page 425

Multi carrier table settings

The "Multi Carrier Table" dialog is opened with the "Carrier Table" button in the middle
part of the multi carrier waveforms menu. The carrier settings can be checked in the
graphical "Carrier Graph" subdialog.
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The "Carrier Table Assistant" section can be used to set a selectable carrier range.
Use it to set up a multi carrier scenario within a specified carrier range.

Settings:

Number of Carriers......................................................................................................112
Carrier Start.................................................................................................................113
Carrier Stop................................................................................................................. 113
Carrier State................................................................................................................ 113
Gain Start.................................................................................................................... 113
Gain Step.....................................................................................................................113
Phase Start..................................................................................................................113
Phase Step..................................................................................................................114
Delay Start...................................................................................................................114
Delay Step...................................................................................................................114
Input Waveform File.................................................................................................... 114
Apply Assistant Settings..............................................................................................114
Carrier Table................................................................................................................114

└ No..................................................................................................................114
└ State..............................................................................................................115
└ Carrier Freq Offs........................................................................................... 115
└ Gain...............................................................................................................115
└ Phase............................................................................................................ 115
└ Delay............................................................................................................. 115
└ File................................................................................................................ 115
└ Info................................................................................................................ 115
└ !!!................................................................................................................... 115

Number of Carriers
Sets the number of carriers for the multi carrier waveform.
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By default the multi carrier table lists 1 carrier. When the number of carriers is
increased, the multi carrier table is extended by adding further lines at the end of the
table. If these carrier already have been defined before, the settings are preset accord-
ing to the former settings. Otherwise the parameters are preset with the default values.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier:COUNt on page 419

Carrier Start
Defines the start index of the carrier range to which the assistant settings are intended
to apply.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:STARt on page 429

Carrier Stop
Defines the stop index of the carrier range to which the assistant settings are intended
to apply.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:STOP on page 429

Carrier State
Switches the carriers in the range "Carrier Start" to "Carrier Stop" on/off.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:STATe on page 430

Gain Start
Sets the gain of the carrier marked by "Carrier Start".
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:POWer[:STARt]
on page 429

Gain Step
Sets the step width that is used to increment the gain.
The resulting carrier gain in the carrier table equals:
GainStart + n* Gain Step
Where n ranges from 0 to ("Carrier Stop" - "Carrier Start" ).
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:POWer:STEP
on page 429

Phase Start
Sets the phase of the carrier marked by "Carrier Start".
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:PHASe[:STARt]
on page 428
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Phase Step
Sets the step width that is used to increment the phase.
The resulting phase in the carrier table equals:
PhaseStart + n* PhaseStep
Where n ranges from 0 to (Carrier Stop – Carrier Start)
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:POWer:STEP
on page 429

Delay Start
Sets the delay of the carrier marked by "Carrier Start".
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:DELay[:STARt]
on page 427

Delay Step
Sets the step width that is used to increment the delay.
The resulting delay in the carrier table equals:
DelayStart + n* DelayStep
Where n ranges from 0 to (Carrier Stop – Carrier Start).
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:DELay:STEP
on page 426

Input Waveform File
Calls the "File" dialog for selecting the input file with the I/Q signal to be modulated
onto all carriers of the selected carrier range.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:FILE on page 427

Apply Assistant Settings
Transfer the assistant settings to the carrier table.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:EXECute
on page 427

Carrier Table
The table displays the settings of all available carriers. Previously applied assistant set-
tings can be further refined. The number of lines corresponds to the number of carriers.
Note: The phase/deg settings are only valid if optimization of the crest factor is dis-
abled ("Crest Factor Mode" = Off).

No ← Carrier Table
Indicates the carrier index ranging from 0 to (number of carriers -1).
Individual carriers can be set using the remote control commands by specifying the
index in the parameter CARR.
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State ← Carrier Table
Switches On/Off a carrier.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier<ch>:STATe on page 423

Carrier Freq Offs. ← Carrier Table
Sets the carrier frequency offset.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier<ch>:FREQuency
on page 422

Gain ← Carrier Table
Sets the gain of a carrier.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier<ch>:POWer on page 422

Phase ← Carrier Table
Sets the starting phase of a carrier.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier<ch>:PHASe on page 422

Delay ← Carrier Table
Sets the starting delay of a carrier.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier<ch>:DELay on page 421

File ← Carrier Table
Calls the "File" menu for selecting the input file with the I/Q signal to be modulated onto
the carrier.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier<ch>:FILE on page 421

Info ← Carrier Table
Indicates the sample rate, number of I/Q value pairs (number of samples), and the
resulting signal period of the selected I/Q input file.
Remote command: 
n.a.

!!! ← Carrier Table
Indicates an occurred conflict by a red LED. A conflict arises when the carriers overlap.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier<ch>:CONFlict?
on page 421
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Carrier graph table

► To access this dialog select "Baseband > ARB > Multi Carrier... > Carrier Graph"

Carrier Graph
Calls a graphical representation of the current multi carrier configuration in the fre-
quency domain.
The height of the bars corresponds to the chosen gain of each individual carrier. The
bandwidth of the carriers signals is indicated by the width of the bars.
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6.1.2.5  Sine test signal

This dialog provides settings for configuration of a sinusoidal test signal. A sine wave is
generated on the I path, and a sine wave of the same frequency but phase-shifted is
generated on the Q path.

The dialog displays the characteristic of the currently selected signal.

Settings:

Frequency....................................................................................................................117
Samples per Period.....................................................................................................117
Phase Offset Q............................................................................................................118
Generate Signal File....................................................................................................118
Generate Signal RAM..................................................................................................118

Frequency
Enters the frequency of the test signal.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:SINE:FREQuency on page 417

Samples per Period
Enters the number of sample values required from the sine wave per period.
The maximum allowed value is determined by the maximum ARB clock rate (see data
sheet) and the selected frequency.
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Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:SINE:SAMPles on page 418

Phase Offset Q
Enters the phase offset of the sine wave signal on the Q channel relative to the sine
wave signal on the I channel.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:SINE:PHASe on page 418

Generate Signal File
Generates a signal and saves it to a file.
The "File Select" window opens automatically and the signal can be stored as a wave-
form file.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:SINE:CREate:NAMed on page 416
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:RECTangle:CREate:NAMed
on page 416
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:CIQ:CREate:NAMed on page 416

Generate Signal RAM
Generates a signal and uses it as output straight away.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:SINE:CREate on page 415
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:RECTangle:CREate on page 415
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:CIQ:CREate on page 415

6.1.2.6  Rect Test Signal

This dialog provides settings for configuration of a rectangular test signal. A rectangu-
lar test signal with a duty factor of 0.5 is created. Amplitude and offset are adjustable.
Both paths, I and Q, use the same signal.

Baseband



Signal generator settingsR&S®SGT100A

119User Manual 1176.8674.02 ─ 12

Settings:

Frequency....................................................................................................................119
Samples per Period.....................................................................................................119
Amplitude.....................................................................................................................119
Offset DC.....................................................................................................................119
Generate Signal File....................................................................................................119
Generate Signal RAM..................................................................................................119

Frequency
Enters the frequency of the test signal.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:RECTangle:FREQuency on page 417

Samples per Period
Enters the number of sample values required for the rectangular signal per period.
The maximum allowed value is determined by the maximum ARB clock rate (see data
sheet) and the selected frequency.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:RECTangle:SAMPles on page 417

Amplitude
Enters the digital amplitude of the rectangular wave.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:RECTangle:AMPLitude on page 416

Offset DC
Enters a DC component.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:RECTangle:OFFSet on page 417

Generate Signal File
Generates a signal and saves it to a file.
The "File Select" window opens automatically and the signal can be stored as a wave-
form file.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:SINE:CREate:NAMed on page 416
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:RECTangle:CREate:NAMed
on page 416
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:CIQ:CREate:NAMed on page 416

Generate Signal RAM
Generates a signal and uses it as output straight away.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:SINE:CREate on page 415
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:RECTangle:CREate on page 415
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:CIQ:CREate on page 415
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6.1.2.7  Const I/Q Test Signal

This dialog provides settings for configuration of a continuous test signal with constant
IQ. The I and Q values for each path are adjustable but constant.

After converting to an analog signal, the signal is output directly at the I and Q connec-
tors of the instrument.

Settings:

I Value......................................................................................................................... 120
Q Value........................................................................................................................120
Generate Signal File................................................................................................... 120
Generate Signal RAM................................................................................................. 120

I Value
Enters the value for the I component of the test signal.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:CIQ:I on page 416

Q Value
Enters the value for the Q component of the test signal.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:CIQ:Q on page 416

Generate Signal File
Generates a signal and saves it to a file.
The "File Select" window opens automatically and the signal can be stored as a wave-
form file.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:SINE:CREate:NAMed on page 416
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:RECTangle:CREate:NAMed
on page 416
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:CIQ:CREate:NAMed on page 416

Generate Signal RAM
Generates a signal and uses it as output straight away.
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Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:SINE:CREate on page 415
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:RECTangle:CREate on page 415
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:CIQ:CREate on page 415

6.1.3  Trigger, marker and clock settings

6.1.3.1  Trigger in settings

Access:

► Select "SGMA-GUI > Instrument Name > Baseband > ARB > Trigger In".

The "Trigger In" section is where the trigger for the signal is set. Various parame-
ters are provided for the settings, depending on which trigger source - internal or
external - is selected. The status of signal generation ("Running" or "Stopped") is
indicated for all trigger modes.

Settings:

Trigger Mode...............................................................................................................121
Signal Duration Unit.................................................................................................... 122
Signal Duration............................................................................................................122
Running/Stopped........................................................................................................ 122
Arm..............................................................................................................................123
Execute Trigger...........................................................................................................123
Trigger Source.............................................................................................................123
Sync. Output to External Trigger.................................................................................123
External Delay Unit..................................................................................................... 124
Trigger Delay...............................................................................................................124
Actual Trigger Delay....................................................................................................124
Trigger Inhibit.............................................................................................................. 124

Trigger Mode
Selects trigger mode.
The trigger mode determines the effect of a trigger on the signal generation.
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"Auto" The signal is generated continuously.
"Retrigger" The signal is generated continuously. A trigger event (internal or

external) causes a restart.
"Armed_Auto" The signal is generated only when a trigger event occurs. Then the

signal is generated continuously.
"Armed_Retrigger"

The signal is generated only when a trigger event occurs. Then the
signal is generated continuously. Every subsequent trigger event cau-
ses a restart.
Button "Arm" stops the signal generation. A subsequent trigger event
(internal with "Execute Trigger" or external) causes a restart.

"Single" The signal is generated only when a trigger event occurs. Then the
signal is generated once to the length specified at "Signal Duration".
Every subsequent trigger event (internal with "Execute Trigger" or
external) causes a restart.

Remote command: 
[:SOURce<hw>]:BB:ARBitrary[:TRIGger]:SEQuence on page 411

Signal Duration Unit
Available only for "Trigger Mode > Single".
Defines the unit for the entry of the length of the signal sequence to be output.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TRIGger:SLUNit on page 408

Signal Duration
Available only for "Trigger Mode > Single".
Defines the length of the signal sequence to be output. The unit of the entry is defined
under "Signal Duration Unit". You can output just a part of the signal, an exact
sequence of the signal, or a defined number of repetitions of the signal.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TRIGger:SLENgth on page 408

Running/Stopped
Displays the status of signal generation.
"Running" The waveform is output; a trigger was (internally or externally) initi-

ated in triggered mode.
If "Armed_Auto" or "Armed_Retrigger" have been selected, the gen-
eration of signals can be stopped with the "Arm" button. A new trigger
(internally with "Execute Trigger" or externally) causes a restart.

"Stopped" The waveform output is stopped. The instrument waits for an internal
or external trigger event to restart. ARB modulation is disabled.

Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TRIGger:RMODe? on page 407
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Arm
Available only in the "Running mode" and for "Trigger Mode > Armed_Auto" or "Trigger
Mode > Armed_Retrigger".
Stops the waveform output.
Signal output can be restarted by a new trigger (internally with "Execute Trigger" or
externally).
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TRIGger:ARM:EXECute on page 406

Execute Trigger
Executes the trigger manually. A manual trigger can be executed only when an internal
trigger source and a trigger mode other than "Auto" have been selected.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TRIGger:EXECute on page 406

Trigger Source
Selects trigger source.
"Internal" The trigger event is executed by "Execute Trigger".
"External" The trigger event is executed with the aid of the active edge of an

external trigger signal.
The trigger signal is supplied via the [USER 1/2] connector.
The polarity, the trigger threshold and the input impedance of the trig-
ger input can be set in the "Connector" dialog.

Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TRIGger:SOURce on page 409

Sync. Output to External Trigger
Available only for "Trigger Source > External".
Enables/disables output of the signal synchronous to the external trigger event.
"On" Corresponds to the default state of this parameter.

The signal calculation starts simultaneously with the external trigger
event but because of the instrument’s processing time that the first
samples are cut off and no signal is outputted. After the internal pro-
cessing time elapses, the output signal is synchronous to the trigger
event.
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"Off" The signal output begins after the elapsing of the processing time and
starts with sample 0, i.e. the complete signal is outputted.
This mode is recommended for triggering of short signal sequences
with signal duration comparable to the processing time of the instru-
ment.

Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TRIGger[:EXTernal]:SYNChronize:OUTPut
on page 406

External Delay Unit
Determines whatever the trigger delay is expressed in samples or directly defined as a
time period (seconds).
The parameter displays the delay converted in time.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TRIGger:DELay:UNIT on page 409

Trigger Delay
Sets the trigger signal delay in samples on external triggering. Setting the delay ena-
bles the R&S SGT to be synchronized with the device under test or other external devi-
ces.
The parameter displays the delay converted in time.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TRIGger[:EXTernal<1|2>]:DELay
on page 410
[:SOURce<hw>]:BB:ARBitrary:TRIGger[:EXTernal<1|2>]:TDELay
on page 410

Actual Trigger Delay
Displays the time (in seconds) an external trigger event is delayed by.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TRIGger[:EXTernal<1|2>]:RDELay?
on page 410

Trigger Inhibit
Sets the duration for inhibiting a new trigger event after triggering. The input is to be
expressed in samples.
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In the "Retrigger" mode, every trigger signal causes signal generation to restart. This
restart is inhibited for the specified number of samples.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TRIGger[:EXTernal<1|2>]:INHibit
on page 411

6.1.3.2  Next segment trigger in settings

The section "Next Segment Trigger In" of the menu is only displayed if a multi-segment
waveform is loaded.

The section comprises the settings necessary to adjust the trigger for the switch
between the segments of a multi-segment waveform. The parameters displayed
depend on the selected trigger source.

Settings:

Current Segment.........................................................................................................125
Next Segment............................................................................................................. 126
Next Segment Mode................................................................................................... 126
Execute Next Segment............................................................................................... 130
Sequencing List...........................................................................................................130
Trigger Example..........................................................................................................131

Current Segment
Indication of the waveform segment (segment filename and index) that is output.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:WSEGment? on page 438
[:SOURce<hw>]:BB:ARBitrary:WSEGment:NAME? on page 446
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Next Segment
Selects the waveform segment to be output next. It determines the start segment when
switching on the ARB and enables switchover to any other segment.
The switchover is performed either after receiving an external next segment trigger
event or, for the internal trigger case, by changing the segment index in the "Next Seg-
ment" field. The definition whether the new segment is generated immediately or only
after the previous segment has been fully generated (wrap around) is determined by
the parameter Next Segment Mode.
The segment currently being output (segment index and filename) is displayed at "Cur-
rent Segment". The subsequent trigger event after the last segment causes the first
segment to be output again.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:WSEGment:NEXT on page 446

Next Segment Mode
Sets the segmented trigger mode of a multi-segment waveform, i.e. defines the switch
over between segments in a multi-segment waveform:
● In "Same Segment" mode, the processing of the multi-segment waveform file is

similar to the processing of a non-multi-segment waveform, i.e. there is no switch-
ing to consecutive segments, when receiving a trigger event.
Switching between the segments is triggered by changing the segment index in the
"Next Segment" field.

● When "Next Segment" is selected, the current segment ceases to be output when
a trigger event for a new segment occurs, and the new segment starts to be output
after a system-imposed signal gap.
The following figure shows an example of the transition from a sine-wave signal
segment to a sawtooth segment (I channel, above) for next segment external trig-
gering (below).

● When "Next Segment" seamless is selected and a new segment trigger event
occurs, the new segment is not output until the whole of the current segment has
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been output (wrap around). The signal transition is seamless. As a prerequisite for
a seamless switchover, all segments must have the same sample rate.
The following figure shows an example of the seamless transition from a sine-wave
signal segment to a sawtooth segment (I channel, above) for next segment exter-
nal triggering (below).

The regular trigger mode for starting the waveform generation and triggering the
whole multi-segment sequence is set with the parameters in the "Trigger In" section
of the "Trigger/Marker/Clock" dialog.
The segment currently being output is displayed at "Current Segment".
The "Trigger Example" graph displays schematically the waveform output, depending
on the activated trigger and the next segment settings.
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"Same Segment"
Depending on the trigger setting, the currently selected segment is
continuously output either immediately or after a trigger event.
Signal generation takes place differently according to the trigger
selected in the "Trigger In" section:
● For "Trigger = Auto", output starts at once and the segment is

generated continuously. Trigger events are ignored.
If the segment is changed in "Next Segment", output of the cur-
rent segment is stopped and the new segment is output immedi-
ately, following a system-imposed signal gap (see above).

● For "Trigger = Armed_Auto", output starts after the first trigger
event. The segment is then generated continuously. Further trig-
ger events are ignored.
If the segment is changed in "Next Segment", signal output is
stopped and the new segment is not output until a trigger occurs.

● For "Trigger = Retrigger", output starts at once and the segment
is generated continuously, a trigger event causes a restart.
If the segment is changed in "Next Segment", output of the cur-
rent segment is stopped and the new segment is output immedi-
ately, following a system-imposed signal gap (see above).

● For "Trigger = Armed_Retrigger", output starts after the first trig-
ger event. The segment is then generated continuously. Further
trigger events cause a restart.
If the segment is changed in "Next Segment", signal output is
stopped and the new segment is not output until a trigger occurs.

● For "Trigger = Single", output starts after the first trigger event.
The segment is then generated once. Further trigger events
cause a restart.
If the segment is changed in "Next Segment", signal output is not
stopped. The new segment is not output until a trigger occurs.
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"Next Segment"
Depending on the trigger setting, the segment selected under "Next
Segment" is output either immediately or after a trigger event.
● For "internal Trigger = Auto", output starts at once and the seg-

ment is generated continuously.
If the segment index is changed in "Next Segment", output of the
current segment is stopped and the new segment is output imme-
diately, following a system-imposed signal gap.

● For "internal Trigger = Armed_Auto", output starts after the first
trigger event. The segment is then generated continuously.
If the segment index is changed in "Next Segment", output of the
current segment is stopped and the new segment is output imme-
diately, following a system-imposed signal gap.

● For "internal Trigger = Armed_Auto", output starts after the first
trigger event. The segment is then generated continuously.
If the segment index is changed in "Next Segment", signal output
is stopped and the new segment is not output until a trigger
occurs.

● For "internal Trigger = Single", output starts after the first trigger
event. The segment is then generated once. Further trigger
events cause a restart.
If the segment index is changed in "Next Segment", the new seg-
ment is not output until a trigger occurs.

● For "External Trigger = Auto", output starts at once and the seg-
ment is generated continuously.
If the segment index is changed in "Next Segment", output of the
current segment is stopped and the new segment is output imme-
diately, following a system-imposed signal gap.
The subsequent trigger event after the last segment causes the
first segment to be output again.

● For "External Trigger = Armed_Auto", output starts after the first
trigger event. The segment is then generated continuously.
If the segment is changed in next segment, signal output is stop-
ped and the new segment is not output until a trigger occurs.
The subsequent trigger event after the last segment causes the
first segment to be output again.

● For "External Trigger = Single", output starts after the first trigger
event. The segment is then generated once.
If the segment is changed in "Next Segment", signal output is not
stopped. The new segment is not output until a trigger occurs.
The subsequent trigger event after the last segment causes the
first segment to be output again.
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"Next Segment Seamless"
The segment selected under "Next Segment" is output.
This mode is only available if all segments have the same sample
rate.
● For "Internal Trigger = Auto", output starts at once and the seg-

ment is generated continuously.
If the segment is changed in "Next Segment", the new segment is
output seamlessly after the output of the current segment is com-
plete.

● For "internal Trigger = Armed_Auto", output starts after the first
trigger event. The segment is then generated continuously.
If the segment is changed in "Next Segment", signal output is
stopped and the new segment is not output until a trigger occurs.

● For "External Trigger = Auto", output starts at once and the seg-
ment is generated continuously.
If the segment is changed in "Next Segment", the new segment is
output seamlessly after the output of the current segment is com-
plete.

● For "External Trigger = Armed_Auto", output starts after the first
trigger event. The segment is then generated continuously.
If the segment is changed in "Next Segment", signal output is
stopped and the new segment is not output until a trigger occurs.

The remaining trigger modes ("Retrigger" and "Armed_Retrigger") are
not available.

"Sequencer" The waveform files are processed according to the order and repeti-
tion cycles defined in the special sequencing list file (*.wvs)
assigned to the multi-segment waveform file.
This “play list” is defined in the Multi-segment waveform sequencing
dialog.
Note: This feature is disabled in case the segments in the multi-seg-
ment waveform file have different clock rates.

Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TRIGger:SMODe on page 409

Execute Next Segment
Triggers manually switchover to the subsequent segment in the multi-segment file. A
manual trigger can be executed only when an internal "Next Segment Source" has
been selected.
To perform a switchover to any segment within the multi-segment file, adjust the
parameter "Next Segment".
This parameter is disabled, if a sequencing play list is enabled.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:WSEGment:NEXT:EXECute on page 447

Sequencing List
Open a dialog box for defining the “play lists” (see "Multi-segment waveform sequenc-
ing" on page 102).
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Remote command: 
[:SOURce<hw>]:BB:ARBitrary:WSEGment:SEQuence:SELect on page 448

Trigger Example
Displays an example of a multi-segment waveform. The currently enabled trigger and
next segment mode are considered. After the instrument switch on, the graph of the
last loaded waveform is displayed.
Note: The curves plotted in this dialog box are textbook examples, "not measured"
waveforms. They are intended to visualize the trigger and next segment settings more
clearly.
Remote command: 
n.a.

6.1.3.3  Marker settings

► To access this dialog, select "SGMA-GUI > Instrument Name > Baseband > ARB >
Marker".

Provides the settings necessary to define the marker output signal for synchroniz-
ing external instruments and the delay of the marker signals on the [USER 1/2]
connector.

Settings:

Marker Mode............................................................................................................... 131
Marker x Delay............................................................................................................ 132
Current Range without Recalculation..........................................................................132
Fix marker delay to current range............................................................................... 133

Marker Mode
Marker configuration for up to 2 marker channels. The settings are used to select the
marker mode defining the shape and periodicity of the markers. The contents of the
dialog change with the selected marker mode; the settings are self-explanatory.
Note: The marker trace in the waveform file remains unchanged. It is not overwritten,
even if something else than "Unchanged" has been selected.
"Unchanged" The marker signal remains unchanged as defined in the waveform

file.
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"Restart" A marker signal is generated at the start of each ARB sequence.
This marker mode is not enabled for multi-segment waveforms.

"Pulse" A regular marker signal is generated. The pulse frequency is defined
by entering a divider. The frequency is derived by dividing the sample
rate by the divider. The input box for the divider opens when "Pulse"
is selected, and the resulting pulse frequency is displayed below it.
The precision of the frequency setting depends on the sampling rate.
The maximum pulse frequency is equal to half of the sampling rate.

"Pattern" A marker signal that is defined by a bit pattern is generated. The pat-
tern has a maximum length of 64 bits and is defined in an input field
which opens when "Pattern" is selected.
The pattern bits switch the marker signal to high and low state.

"ON/OFF
Period"

A regular marker signal that is defined by an ON/OFF ratio is gener-
ated. A period lasts one ON and OFF cycle.

The "ON Time" and "OFF Time" are each expressed in "Samples"
and are set in an input field which opens when ON/OFF ratio is
selected.

Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:MODE on page 412
[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:PULSe:DIVider
on page 413
[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:PULSe:FREQuency?
on page 414
[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:PATTern on page 413
[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:OFFTime on page 413
[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:ONTime on page 413

Marker x Delay
Enters the delay between the marker signal at the marker output and the start of the
frame or slot.
If the setting "Fix marker delay to dynamic range" is enabled, the setting range is
restricted to the dynamic range. In this range, the delay of the marker signals can be
set without restarting the marker and signal.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:DELay on page 415

Current Range without Recalculation
Displays the dynamic range within which the delay of the marker signals can be set
without restarting the marker and signal.
The delay can be defined by moving the setting mark.

Baseband



Signal generator settingsR&S®SGT100A

133User Manual 1176.8674.02 ─ 12

Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:DELay:MINimum?
on page 407
[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:DELay:MAXimum?
on page 407

Fix marker delay to current range
Restricts the marker delay setting range to the dynamic range. In this range, the delay
can be set without restarting the marker and signal.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut:DELay:FIXed on page 414

6.1.3.4  Clock settings

Access:

► Select "SGMA-GUI > Instrument Name > Baseband > ARB > Marker".

In the dialog, you can set the clock source and a delay.

Settings:

Sync Mode.................................................................................................................. 133
Clock Source...............................................................................................................134
Clock Mode................................................................................................................. 134
Sample Clock Multiplier...............................................................................................134
Measured External Clock............................................................................................ 134
Synchronisation State................................................................................................. 134

Sync Mode
Selects the synchronization mode.
"None" The instrument is working in stand-alone mode.
"Sync Primary" The instrument provides all connected instrument with its synchroni-

zation (including the trigger signal) and reference clock signal.
"Sync Secondary"

The instrument receives the synchronization and reference clock sig-
nal from another instrument working in a primary instrument mode.
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"Sync Dig I/Q In"
The instrument receives the synchronization and reference clock sig-
nal from the [DIGITAL I/Q] connector.

Remote command: 
[:SOURce<hw>]:BB:ARBitrary:CLOCk:SYNChronization:MODE on page 404

Clock Source
Selects the clock source.
"Internal" The internal clock reference is used to generate the symbol clock.
"External" The external clock reference is fed in as the symbol clock or multiple

thereof via the [USER 1/2] connector.
The symbol rate must be correctly set to an accuracy of +/-2 % (see
data sheet).
The polarity of the clock input can be changed in the "Connector" dia-
log.

Remote command: 
[:SOURce<hw>]:BB:ARBitrary:CLOCk:SOURce on page 404

Clock Mode
Available only for "Clock Source > External"
Enters the type of externally supplied clock.
"Sample" A sample clock is supplied via the [USER 1/2] connector.
"Multiple Sam-
ple"

A multiple of the sample clock is supplied via the [USER 1/2] connec-
tor; the sample clock is derived internally from it.
The "Multiplier" window provided allows the multiplication factor to be
entered.

Remote command: 
[:SOURce<hw>]:BB:ARBitrary:CLOCk:MODE on page 403

Sample Clock Multiplier
Available only for "Clock Mode > Multiplier".
Enters the multiplication factor.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:CLOCk:MULTiplier on page 403

Measured External Clock
Provided for permanent monitoring of the enabled and externally supplied clock signal.
Remote command: 
:CLOCk:INPut:FREQuency? on page 357

Synchronisation State
Requires instruments working in secondary synchronization mode.
Displays the status of the external clock source. The status indicates, if the external
clock source of the secondary instrument is synchronized or not synchronized yet.
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Remote command: 
:CLOCk:SYNC[:STATe]? on page 358

6.1.4  ARB offsets

► To access this dialog, select "SGMA-GUI > Instrument Name >Baseband > Fre-
quency/Phase Offsets".

Settings:

Frequency Offset
Sets the frequency offset and shifts the ARB signal in the center frequency.
Remote command: 
[:SOURce]:BB:FOFFset on page 400

Phase Offset
Sets the phase offset of the ARB signal.
Remote command: 
[:SOURce]:BB:POFFset on page 400

6.1.5  Crest factor reduction

Required option: R&S SGT-K548

The R&S SGT-K548 is a software option that allows you to generate signals with
reduced crest factor.

6.1.5.1  About the crest factor reduction

Communication standards utilizing higher order modulation techniques or using multi-
ple carrier and complex signals consisting of the signals of more than one digital stan-
dard can feature a high crest factor. The signals of some digital standards can have
high crest factors also particularly with many channels and long sequences.
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About crest factors

The crest factor represents the ratio of the peak voltage value to the RMS voltage
value, i.e. the peak to average ratio (PAR). The higher the crest factor and the resulting
dynamics of a signal, the greater the requirement for a power amplifier fed by the sig-
nal to be linear.

A high crest factor arises, for example, for a multi carrier signal that has carriers with
an identical start phase. The carriers are periodically superposed that leads to high
peak voltages in relation to the RMS voltage values.

High crest factors entail two basic problems:
● The nonlinearity of the power amplifier (compression) causes intermodulation

which expands the spectrum (spectral regrowth).
● Since the level of the digital to analog (D/A) converter is relative to the maximum

value, the average value is converted with a relatively low resolution. This low res-
olution leads to a high quantization noise.

Both effects increase the adjacent-channel power.

Clipping and filtering algorithm

A common and simple approach for achieving a lower PAR is the combination of clip-
ping and filtering.
● Clipping is a technique that applies a wanted distortion to the signal.

The principle includes specifying a threshold, finding out the signal peaks once the
defined limits are exceeded and clipping them off. The level limit is specified as a
percentage of the highest peak value. Because clipping is done before filtering, the
procedure does not influence the spectrum. The error vector magnitude (EVM)
however increases.
However, signal clipping not only changes the peak value but also the average
value and the effect on the crest factor is unpredictable.

● Filtering is applied after clipping. The used filters are specially designed so that
they filter out the distortion.

Peak cancellation algorithm

The peak cancellation algorithm uses Blackman windowed sinc pulses and subtracts
them from the original baseband signal wherever the signal amplitude exceeds a
defined threshold. This threshold equals maximum peak of the baseband signal minus
a user-definable crest factor difference ("Desired Crest Factor Delta").

This algorithm often provides better EVM results of the output signal versus out of
band noise introduced by the pulses, compared to the clipping and filtering method.
The cancellation pulse bandwidth is configurable and the cancellation pulse transition
bandwidth. The achieved resulting crest factor can be higher than expected, because
of filters in the signal processing chain increasing the crest factor again after a previous
crest factor reduction.
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6.1.5.2  Crest factor reduction settings

Access:

► Select "Baseband" > "ARB" > "Crest Factor Reduction".

The dialog provides settings to configure and activate crest factor reduction.

Activating crest factor reduction

Crest factor reduction requires an active "ARB" state and a valid waveform file loaded
to the ARB application.

1. Load a waveform file.

a) Select "ARB" > "General" > "Load Waveform".
b) In the file-select dialog, select the waveform file from the directory.

See also chapter "How to load and play waveform files" in the R&S SGT user man-
ual.

2. Select "General" > "State" > "On".

3. Select "Crest Factor Reduction" > "State" > "On".

The remote commands required to define these settings are described in Chap-
ter 10.14.5, "SOURce:BB:ARBitrary:CFR subsystem", on page 449.

Settings:

State............................................................................................................................138
Generate Waveform....................................................................................................138
Algorithm..................................................................................................................... 138
Desired Crest Factor Delta..........................................................................................138
Max Iterations..............................................................................................................138
Original Crest Factor................................................................................................... 139
Resulting Crest Factor................................................................................................ 139
Filter Mode.................................................................................................................. 139
Channel Spacing.........................................................................................................140
Signal Bandwidth........................................................................................................ 140
Stopband Frequency...................................................................................................140
Passband Frequency.................................................................................................. 140
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Maximum Filter Order................................................................................................. 141
Cancellation Pulse Bandwidth.....................................................................................141
Transition Bandwidth...................................................................................................141

State
Requires an active "ARB" state, see "Activating crest factor reduction" on page 137.
Activates crest factor reduction calculation.
Note: You cannot activate the crest factor reduction and the notch filter simultaneously.
Enabling the notched filter automatically disables the crest factor reduction.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:CFR[:STATe] on page 450

Generate Waveform
With enabled signal generation, triggers the instrument to save the current settings of
an arbitrary waveform signal in a waveform file with predefined extension *.wv. You
can define the filename and the directory, in that you want to save the file.
Using the ARB modulation source, you can play back waveform files and/or process
the file to generate multi-carrier or multi-segment signals.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:CFR:WAVeform:CREate on page 454

Algorithm
Defines the algorithm for crest factor reduction.
"Clipping and Filtering"

This algorithm performs a hard clipping. It is followed by a low pass
filtering of the result in an iterative manner until the target crest factor
is reached. You can define the settings of the filter that is used for the
calculation.

"Peak Cancelation"
This algorithm subtracts Blackman windowed sinc pulses from the
signal wherever the amplitude is above a defined threshold.

Remote command: 
[:SOURce<hw>]:BB:ARBitrary:CFR:ALGorithm on page 450

Desired Crest Factor Delta
Sets the value difference by which you want to change your crest factor.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:CFR:DCFDelta on page 451

Max Iterations
Requires "Algorithm" > "Clipping and Filtering".
Sets the number of iterations that are used for calculating the resulting crest factor. The
iteration process is stopped when the desired crest factor delta is achieved by 0.1 dB.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:CFR:ITERations on page 452
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Original Crest Factor
Displays the original crest factor of the waveform after the calculation of the resulting
crest factor is completed. The original crest factor is calculated as an average over the
whole waveform, including any idle periods that can be present in TDD waveforms.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:CFR:OCFactor? on page 452

Resulting Crest Factor
Displays the resulting crest factor of the waveform after the calculations are completed.
The resulting crest factor is calculated as an average over the whole waveform, includ-
ing any idle periods that can be present in TDD waveforms.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:CFR:RCFactor? on page 453

Filter Mode
Requires "Algorithm" > "Clipping and Filtering".
Selects which filter mode is used for the filtering.
"Simple" You can specify the RF bandwidth and channel spacing of the signal.

The lowpass filter is designed to pass through frequency components
inside the signal bandwidth and suppress components in the adjacent
channel.

Figure 6-2: Simple filter mode
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"Enhanced" In the enhanced filter mode, you can specify the passband and stop-
band frequencies of the lowpass filter.

Figure 6-3: Enhanced filter mode

Remote command: 
[:SOURce<hw>]:BB:ARBitrary:CFR:FILTer on page 451

Channel Spacing
Requires "Algorithm" > "Clipping and Filtering" and "Filter Mode" > "Simple".
Sets the channel spacing.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:CFR:CSPacing on page 451

Signal Bandwidth
Requires "Algorithm" > "Clipping and Filtering" and "Filter Mode" > "Simple".
Sets the signal bandwidth. Set a value that is lower than the value of the "Channel
Spacing".
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:CFR:SBANdwidth on page 453

Stopband Frequency
Requires "Algorithm" > "Clipping and Filtering" and "Filter Mode" > "Enhanced".
Sets the stopband frequency of the filter. Frequency components higher than the stop-
band frequency are filtered out by the lowpass filter.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:CFR:SFReq on page 454

Passband Frequency
Requires "Algorithm" > "Clipping and Filtering" and "Filter Mode" > "Enhanced".
Sets the passband frequency. Frequency components lower than the passband fre-
quency are passed through unfiltered.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:CFR:PFReq on page 453
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Maximum Filter Order
Requires "Algorithm" > "Clipping and Filtering" and "Filter Mode" > "Enhanced".
Sets the maximum filter order.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:CFR:FORDer on page 452

Cancellation Pulse Bandwidth
Requires "Algorithm" > "Peak Cancellation".
Sets the bandwidth of the cancellation pulse.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:CFR:CPBandwidth on page 451

Transition Bandwidth
Requires "Algorithm" > "Peak Cancellation".
Sets the transition bandwidth of the cancellation pulse.
Remote command: 
[:SOURce<hw>]:BB:ARBitrary:CFR:TBANdwidth on page 454

6.2  Additive white Gaussian noise (AWGN) - noise gener-
ator

This section introduces the concept of the AWGN generator and describes the settings
for generation of noise, sine wave interferer and adding noise to the generated signal.

The AWGN requires option R&S SGT-K62.

6.2.1  About the AWGN generator

The R&S SGT allows you to superimpose noise on the generated signal. The built-in
internal noise generator generates an AWGN signal (Additive White Gaussian Noise)
with selectable bandwidth and adds it to the digital baseband signal. The main charac-
teristic of this kind of noise signal is the Gaussian distribution of the noise power den-
sity and uniform frequency distribution.

AWGN modes

The AWGN generator generates signal in one of the following different modes:
● "Additive Noise": the generated noise signal superimposes the interference-free

useful signal
● "Noise Only": a pure noise signal is generated and modulated to the carrier; the

connection to the baseband is interrupted.

Additive white Gaussian noise (AWGN) - noise generator
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Figure 6-4: Representation of an "AWGN > Mode > Noise Only" in the block diagram

● "CW Interferer mode": a sinusoidal signal with an adjustable frequency offset and
carrier-to-interferer (C/I) power ratio is added to the baseband signal by a counter
instead of a shift register.

Signal and noise parameters

The Figure 6-5 illustrates the relation between the signal and noise parameters.

Figure 6-5: Graphical representation of the relation between system bandwidth and noise bandwidth
(Minimum Noise/System BW = 2)

System BW* = Occupied BW

The system bandwidth is a measure for the transmitted RF bandwidth. The selected
value is usually the occupied bandwidth and can therefore be a value greater than the
pure signal bandwidth.

In the most test cases, the signal and the noise power are not defined directly but by
the target's signal-to-noise ratio (SNR) or carrier/noise ratio.

The carrier power is a measure for the signal without the noise distribution.

To ensure flat noise within the selected system bandwidth, set a larger noise band-
width than the system bandwidth. The minimum noise bandwidth is sometimes part of
the specifications and is calculated as follows:

"Noise Bandwidth" = "System Bandwidth" x "Minimum Noise/System Bandwidth Ratio"

Make sure that the calculated noise bandwidth does not exceed the total available
bandwidth of the instrument, as specified in the data sheet.

By default, the noise power within the system bandwidth is not defined directly but cal-
culated depending on the selected system bandwidth and the desired SNR. The noise
power over the noise bandwidth is calculated respectively.

Additive white Gaussian noise (AWGN) - noise generator
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The noise signal is not generated arbitrarily for a particular bandwidth, but instead it is
generated in steps. Noise therefore also occurs outside the set system bandwidth. The
total measurable noise power usually exceeds the displayed value "Noise Power".

For a correct measurement of the noise power within the system bandwidth, measure
the channel power with a signal analyzer.

In the "Additive Noise" mode, the output signal is the signal with the noise distribution.
Hence, the power level at the RF output corresponds to the carrier+noise power.

The noise power of digitally modulated signal is characterized by the parameter Eb/N0

indicating the ratio of bit energy to noise power density. The correlation to the SNR is
as follows:

C/N or S/N = (Eb/N0)*(fbit/Bsys)

Bsys is the system bandwidth and Bit Rate fbit = "Symbol Rate" * Modulation Value.

Application fields

Typically, the noise generator is required for the following tests:
● In receiver sensitivity tests with predefined SNR of the receiver
● In bit-error or block-error measurements, depending on the set signal-to-noise ratio

(SNR)
● Whenever a pure noise signal is required

6.2.2  AWGN settings

6.2.2.1  General settings

► To access the dialog box, select "SGMA-GUI > Instrument Name > AWGN > Gen-
eral"

Additive white Gaussian noise (AWGN) - noise generator
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Settings:

State............................................................................................................................144
Mode........................................................................................................................... 144
System Bandwidth...................................................................................................... 144
Minimum Noise/System Bandwidth Ratio................................................................... 145
Target CW Frequency Offset.......................................................................................145
Resulting CW Frequency Offset..................................................................................145

State
Activates/deactivates the generation of an AWGN signal. The interferer (AWGN or CW
interferer, depending on the selected mode) is generated after the generator is activa-
ted.
Remote command: 
[:SOURce<hw>]:AWGN:STATe on page 399

Mode
Selects the mode for generating the interfering signal.
"Additive Noise"

The AWGN noise signal with selectable system bandwidth is added
to the baseband signal.

"Noise Only" The pure AWGN noise signal with selectable system bandwidth is
modulated to the carrier. The connection to the baseband is interrup-
ted.

"CW Interferer" A sine with a defined frequency offset is added to the baseband sig-
nal. The calculation of Eb/N0 ratio is omitted.

Remote command: 
[:SOURce<hw>]:AWGN:MODE on page 396

System Bandwidth
Available only for "Mode > Additive Noise" or "Mode > Noise Only".
Sets the RF bandwidth to which the set carrier/noise ratio relates.
Within this frequency range, the signal is superimposed with a noise signal which level
corresponds exactly to the set C/N or S/N ratio.

Additive white Gaussian noise (AWGN) - noise generator
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Remote command: 
[:SOURce<hw>]:AWGN:BWIDth on page 393

Minimum Noise/System Bandwidth Ratio
Available only for "Mode > Additive Noise" or "Mode > Noise Only".
Sets the ratio of minimum noise bandwidth to system bandwidth, as required by some
standards.
Noise Bandwidth = System BW x Minimum Noise/System BW Ratio

The parameter Noise Bandwidth displays the resulting noise bandwidth.
The calculation of level from the selected C/N or S/N ratio in relation to system band-
width is not influenced.
Remote command: 
[:SOURce<hw>]:AWGN:BWIDth:RATio on page 393

Target CW Frequency Offset
Available only for "Mode > CW Interferer".
Sets the desired frequency of the sine wave.
Remote command: 
[:SOURce<hw>]:AWGN:FREQuency:TARGet on page 395

Resulting CW Frequency Offset
Available only for "Mode > CW Interferer".
Indicates the resulting frequency offset of the sine wave.
Remote command: 
[:SOURce<hw>]:AWGN:FREQuency:RESult? on page 395

6.2.2.2  Noise power/output results settings

► To access the dialog box, select "SGMA-GUI > Instrument Name > AWGN > Noise
Power/ Output Results"

Additive white Gaussian noise (AWGN) - noise generator
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Settings:

Noise Bandwidth......................................................................................................... 146
Display Mode.............................................................................................................. 146
Set Noise Power Via................................................................................................... 147
Reference Mode..........................................................................................................147
Bit Rate....................................................................................................................... 147
Carrier/Noise Ratio / Signal/Noise Ratio..................................................................... 147
Eb/N0............................................................................................................................148
Carrier Power / Signal Power......................................................................................148
Noise Power (System Bandwidth) / Interferer Power..................................................148
Noise Power (Total Bandwidth)................................................................................... 149
Carrier + Noise Power / Signal + Noise Power (System Bandwidth) / Carrier + Inter-
ferer Power / Signal + Interferer Power.......................................................................150
Carrier + Noise PEP / Signal + Noise PEP (Total Bandwidth) / Carrier + Interferer PEP /
Signal + Interferer PEP............................................................................................... 150

Noise Bandwidth
Available only for "Mode > Additive Noise" and "Mode >Noise Only" and when the
AWGN generator is activated.
Indicates the real noise bandwidth.
Remote command: 
[:SOURce<hw>]:AWGN:BWIDth:NOISe? on page 393

Display Mode
Sets the output to which the displayed settings are related to.
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This setting also influences:
● The way the interfering parameters are displayed, e.g. if the SNR value is defined

as C/N or as S/N.
● The value units:

– The values related to the RF outputs are displayed in dBm
– The values related to the baseband outputs - in dB

Remote command: 
[:SOURce<hw>]:AWGN:DISP:MODE on page 394

Set Noise Power Via
Available only for "Mode > Additive Noise".
Selects the way that the noise power is determined.
The following correlation applies:
"C/N or S/N"= ("Eb/N0")*(fbit/Bsys), where:
● "C/N or S/N" is the carrier/noise ratio
● "Eb/N0" is the ratio of bit energy to noise power density.
● "Bit Rate"fbit= "Symbol Rate" x Modulation Value
● Bsys is the system bandwidth.

Remote command: 
[:SOURce<hw>]:AWGN:POWer:MODE on page 397

Reference Mode
Selects whether the carrier or the noise power is kept constant if the C/N or Eb/N0 ratio
is changed.
Remote command: 
[:SOURce<hw>]:AWGN:POWer:RMODe on page 398

Bit Rate
Available only for "Mode > Additive Noise".
Indicates the bit rate used for converting C/N or S/N to Eb/N0.

Remote command: 
[:SOURce<hw>]:AWGN:BRATe on page 392

Carrier/Noise Ratio / Signal/Noise Ratio
Available only for "Mode > Additive Noise" and "Mode > CW Interferer".
Sets the carrier/noise, signal/noise or respectively signal/interferer ratio.
Whether a configuration of C/N or S/N is enabled depends on the selected output Dis-
play Mode.
● For "Reference Mode > Carrier", this entry determines the power of the output sig-

nal, i.e. the carrier + noise signal. It does not affect the power of the useful signal,
i.e. the carrier power remains constant.

● For "Reference Mode > Noise", this entry determines the power of the useful sig-
nal, i.e. the carrier power. The power of the output signal remains constant.

● The power of the noise signal is derived from the entered C/N or S/N value and
displayed with the parameter "Noise Power" in the units of the useful signal.

Additive white Gaussian noise (AWGN) - noise generator
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● The power of the useful signal is displayed with the parameter Carrier Power / Sig-
nal Power and can also be changed there. This indication corresponds to the
"Level" value in the "Status bar".

● The power of the output signal is displayed under Carrier + Noise Power / Signal +
Noise Power (System Bandwidth) / Carrier + Interferer Power / Signal + Interferer
Power.

Remote command: 
[:SOURce<hw>]:AWGN:CNRatio on page 394

Eb/N0

Available only for "Mode > Additive Noise".
Sets the ratio of bit energy to noise power density.
● For "Reference Mode > Carrier", this entry determines the noise power and hence

the power of the output signal, i.e. the carrier + noise signal. It does not affect the
power of the useful signal, i.e. the carrier power is kept constant.

● For "Reference Mode > Noise", this entry determines the power of the useful sig-
nal, i.e. the carrier power. The noise power is kept constant.

● The power of the noise signal is derived from the selected Eb/N0 and displayed with
the parameter "Noise Power" in the units of the useful signal.

● The power of the useful signal is displayed with the parameter Carrier Power / Sig-
nal Power. This indication corresponds to the "Level" value in the "Status bar".

● The power of the output signal is displayed under Carrier + Noise Power / Signal +
Noise Power (System Bandwidth) / Carrier + Interferer Power / Signal + Interferer
Power.

Remote command: 
[:SOURce<hw>]:AWGN:ENRatio on page 395

Carrier Power / Signal Power
Available only for "Mode > Additive Noise" and "Mode > CW Interferer".
The name of this parameter depends on the selected output Display Mode.
● For "Reference Mode > Carrier", this parameter sets the carrier power. This indica-

tion corresponds to the "Level" value in the "Status bar".
The power of the noise signal is derived from the selected C/N or S/N value and
displayed with the parameter "Noise Power" in the units of the useful signal.

● For "Reference Mode > Noise", this parameter indicates the carrier power as
derived from the entered C/N or S/N value. This indication corresponds to the
"Level" value in the "Status bar".
The noise power can be set under "Noise Power".

Note: The peak envelope power (PEP) displayed in the "Status bar" corresponds to
the PEP value of the carrier. The parameter "Carrier+Noise (PEP)" indicates the PEP
value of the overall signal.
Remote command: 
[:SOURce<hw>]:AWGN:POWer:CARRier on page 396

Noise Power (System Bandwidth) / Interferer Power
Available only for "Mode > Additive Noise" and "Mode > CW Interferer".
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Displays the power of the noise signal in the system respectively to the total band-
width.
● "Noise Only" mode

Sets the power of the noise signal. This indication corresponds to the "Level" value
in the "Status bar".

● "Additive Noise" mode
– "Reference Mode > Noise"

Sets the power of the noise signal. The power of the carrier is derived from the
entered C/N or S/N or Eb/N0 value.

– "Reference Mode > Carrier"
Displays the power of the noise signal in the system bandwidth. The power of
the noise signal is derived from the entered C/N or S/N or Eb/N0 value. The
carrier power is selected with "Carrier Power"; respectively the signal power is
displayed by "Signal Power".

● "CW Interferer" mode
– "Noise Reference Mode"

Sets the power of the interfering signal. The power of the carrier is derived from
the entered C/N or S/N value.

– "Carrier Reference Mode"
Displays the power of the interfering signal. The power of the interfering signal
is derived from the entered C/N or S/N value. The carrier power is entered
under "Carrier Power".

Note: The noise signal is not generated arbitrarily for a particular bandwidth, but
instead it is generated in steps. Noise therefore also occurs outside the set system
bandwidth. The total measurable noise power (see below) usually exceeds the value
displayed here. For correct measurement of the noise power within the system band-
width, measure the channel power with a signal analyzer.

Remote command: 
[:SOURce<hw>]:AWGN:POWer:NOISe on page 397

Noise Power (Total Bandwidth)
Displays the power of the noise signal in the total bandwidth in "Noise Only" and "Addi-
tive Noise" mode.
Remote command: 
[:SOURce<hw>]:AWGN:POWer:NOISe:TOTal? on page 397
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Carrier + Noise Power / Signal + Noise Power (System Bandwidth) / Carrier +
Interferer Power / Signal + Interferer Power
Available only for "Mode > Additive Noise" and "Mode > CW Interferer".
Displays the overall power of the noise/interferer signal plus useful signal.
The output selected with the parameter Display Mode determines:
● The name of this parameter
● The units the overall power is measured in, dBm or dB (full scale)
Remote command: 
[:SOURce<hw>]:AWGN:POWer:SUM? on page 398

Carrier + Noise PEP / Signal + Noise PEP (Total Bandwidth) / Carrier + Interferer
PEP / Signal + Interferer PEP
Available only for "Mode > Additive Noise" and "Mode > CW Interferer".
Displays the peak envelope power (PEP) of the overall signal comprised of noise sig-
nal plus useful signal.
The output selected with the parameter Display Mode determines:
● The name of this parameter
● The units the overall power is measured in, dBm or dB (full scale)
Note: The peak envelope power ("PEP") displayed in the "Status bar" corresponds to
the PEP value of the carrier.
Remote command: 
[:SOURce<hw>]:AWGN:POWer:SUM:PEP? on page 399

6.3  I/Q modulation and impairment settings

6.3.1  I/Q modulation

The R&S SGT offers I/Q modulation with:
● External analog I/Q signals,
● External digital signals,
● Internal digital signals.

Either the external digital signal or the externally/internally generated baseband signal
is fed into the I/Q modulator ("I/Q Mod" function block).

The external signal is input via the I and Q connector and transferred directly to the I/Q
modulator ("I/Q Mod" function block). The external digital signal is configured in the
"BB In" function block (see Chapter 6.9, "External baseband signal - baseband input",
on page 262).
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The internally generated baseband signal is configured in the baseband function block
(see Chapter 6.1, "Baseband", on page 85). Before the signal is fed into the I/Q modu-
lator, noise can be added and/or the signal can be impaired.

Impairments can also be set in the"I/Q Mod" menu to allow an externally applied ana-
log I/Q signal to be impaired. An internal baseband signal can thus be impaired both
digital (in the "Impairment" block in the "Impairment" menu) and analog in the I/Q mod-
ulator. If impairments are set in both menus, they superimpose each other in the signal.

6.3.2  Impairments

The R&S SGT allows the digital I/Q signal to be impaired before it is passed on to the
I/Q modulator. These settings are available in the block diagram in the "Impairements"
functional block.

6.3.2.1  I and Q offset

An I offset adds a constant value to all I amplitudes, leaving the Q amplitudes
unchanged. A Q offset has the opposite effect. A combination of I and Q values results
in an I/Q offset, which is usually due to carrier feedthrough in the I/Q modulator. Possi-
ble reasons are interfering signals at the RF carrier frequency, e.g. an unsuppressed
RF carrier subchannel. The effect of a positive I and Q offset in the I/Q constellation
diagram is shown below.

Figure 6-6: I offset (left) and Q offset (right) in the I/Q constellation diagram
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6.3.2.2  Gain and gain imbalance

An I/Q gain is a multiplication of all I/Q amplitudes by a common factor. The effect is
equivalent to two identical I and Q gain factors. The effect of an increased gain factor
in the I/Q constellation diagram is shown below.

Figure 6-7: Effect of an increased amplitude in the I/Q constellation diagram

An I gain multiplies the I amplitudes by a factor, leaving the Q amplitudes unchanged.
A Q gain has the opposite effect. Different I and Q gain factors result in an I/Q imbal-
ance. The imbalance occurs usually due to different gains of the amplifiers in the I and
Q channels of the I/Q modulator. The effect of a positive and negative gain imbalance
is shown below.

Figure 6-8: Negative gain imbalance (left) and positive (right) gain imbalance in the I/Q constellation
diagram

6.3.2.3  Quadrature offset

Changes the phase angle between the I and Q vectors from the ideal 90 degrees,
while the amplitudes are maintained. A positive quadrature offset results in a phase
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angle greater than 90 degrees. The effect of a positive quadrature offset in the I/Q con-
stellation diagram is shown below.

Figure 6-9: Positive quadrature offset in the I/Q constellation diagram

6.3.3  I/Q modulator settings

6.3.3.1  General settings

► To access this dialog, select:

a) "SGMA-GUI > Instrument Name > IQ Mod > General"
b) "SGMA-GUI > Instrument Name > Impairments > General"
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Settings:

State............................................................................................................................154
IQ Source.................................................................................................................... 154
I/Q Swap..................................................................................................................... 154
I/Q Wideband.............................................................................................................. 155
Optimization Mode...................................................................................................... 155
Crest Factor................................................................................................................ 156

State
Activates/deactivates I/Q modulation.
If "Analog Wideband I/Q In" is selected, the I/Q modulator is also deactivated and acti-
vated.
If "Internal Baseband I/Q In" is selected, the I/Q modulator is always activated automat-
ically when signal generation is activated in the "Baseband" block. It can, however, be
deactivated later.
The following functions have the same effect:
● The Mod On/Off icon in the SGMA-GUI.
● The "I/Q Mod > On/Off" in the I/Q Mod block in the block diagram.
● The "I/Q Modulator" > "State" on page 154 parameter.
Remote command: 
[:SOURce]:IQ:STATe on page 480

IQ Source
Selects the input signal for the I/Q modulator.
"Analog Wideband I/Q In"

Selects an external analog signal as the input signal. The signal must
be applied at the inputs I and Q.

"Internal Baseband I/Q In"
Selects the internal baseband signal as the input signal. This setting
requires the additional equipment options for generating the various
baseband signals.

Remote command: 
[:SOURce]:IQ:SOURce on page 480

I/Q Swap
Available only for "Source > Internal Baseband".
Selects normal or swapped I/Q control. The modulation sidebands are inverted by
swapping the I and Q signals.
This parameter enables I/Q modulation to be performed on signals according to
IS2000 (cdma2000 standard) and most all other standards. As a result, an I/Q demod-
ulator defined according to IS2000 can also be used for demodulating the generated
signals.
The I/Q modulator defined in the IS2000 standard differs from the definition in the
R&S SGT. The definition on which the R&S SGT is based is used by virtually all digital
communication standards (except IS95 and IS2000).
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In the final step, the filtered I/Q signal is modulated to the desired RF in a different way
in the I/Q modulator:

Figure 6-10: Definition of I/Q modulator in IS2000 and R&S SGT

According to IS2000, the RF signal s(t) is derived from the baseband I/Q signal as fol-
lows:
s(t)=i(t)cos(2pifct)+q(t)sin(2pifct)

The instrument family is based on the following definition:
s(t)=i(t)cos(2pifct)-q(t)sin(2pifct)

Set "I/Q Swap > On" so that an I/Q modulator defined according to IS2000 can cope
with the RF signal generated by the R&S SGT.

"Off" I/Q control is normal.
"On" The I and Q signals are swapped.
Remote command: 
[:SOURce<hw>]:IQ:SWAP[:STATe] on page 480
[:SOURce]:IQ:IMPairment:SWAP[:STATe] on page 479

I/Q Wideband
Optimized setting for wideband modulation signals (>5 MHz).
The modulation frequency response is decreased at the expense of poorer harmonic
suppression. The decrease is achieved by shifting the switching frequencies of the low-
pass filters in the output section.
Remote command: 
[:SOURce]:IQ:WBSTate on page 480

Optimization Mode
Available only for "Source > Internal Baseband".
Selects the optimization mode.
"Fast" Fast optimization by compensation for I/Q skew.

Use this mode in time sensitive environments.
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"High Quality" With "Source > Internal Baseband", enable an optimization by com-
pensation for I/Q skew and frequency response correction. The set-
ting times, however, increase.
Use this mode to generate an extremely flat signal. For information
on the I/Q modulation performance, see the data sheet.

Remote command: 
[:SOURce<hw>]:BB:IMPairment:OPTimization:MODE on page 465

Crest Factor
Available only for "Source > Analog Wideband I/Q Input"
Sets the crest factor of the external analog signal.
The crest factor gives the difference in level between the peak envelope power (PEP)
and average power value (RMS) in dB.
This value is necessary to allow the correct output power to be generated at the RF
output. When the set output power is generated, the R&S SGT uses this value to com-
pensate the average power which is lower compared to the peak power.
The maximum input voltage at the I/Q input is equated to the peak power and is used
as the "reference" for setting the level of the output signal. Since the signal does not
usually supply the peak power at a constant level. Instead it supplies lower average
power. The crest factor specifies how many dB have to be added internally so that the
correct output power is achieved.
Remote command: 
[:SOURce]:IQ:CREStfactor on page 478

6.3.3.2  Analog impairments

► To access this dialog, select:

a) "SGMA-GUI > Instrument Name > IQ Mod > Analog Impairments"
b) "SGMA-GUI > Instrument Name > Impairments >Analog Impairments"
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I/Q impairment for specific impairment of the I/Q modulation is set in the "Analog
Impairments" dialog.

Settings:

State............................................................................................................................157
I/Q Offset.....................................................................................................................157
Gain Imbalance........................................................................................................... 157
Quadrature Offset........................................................................................................158

State
Activates/deactivates I/Q impairment.
If activated, the settings for leakage, I/Q imbalance and quadrature offset become
effective.
The state is indicated in the function block.
Remote command: 
[:SOURce<hw>]:BB:IMPairment:STATe on page 465

I/Q Offset
Sets the carrier offset (in percent) of the amplitudes (scaled to the peak envelope
power (PEP) for the I and/or Q signal component. An ideal I/Q modulator suppresses
the carrier offset completely (offset = 0 percent).
For more information, see Chapter 6.3.2.1, "I and Q offset", on page 151.
Remote command: 
[:SOURce]:IQ:IMPairment:LEAKage:I on page 479
[:SOURce]:IQ:IMPairment:LEAKage:Q on page 479

Gain Imbalance
Sets the imbalance of the I and Q vector, see Chapter 6.3.2.2, "Gain and gain imbal-
ance", on page 152.
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The entry is made in dB (default) or %, where 1 dB offset is roughly 12 % according to
the following:
Imbalance [dB] = 20log ( | GainQ | / | GainI |)

Positive values mean that the Q vector is amplified more than the I vector by the corre-
sponding percentage. Negative values have the opposite effect.
Remote command: 
[:SOURce]:IQ:IMPairment:IQRatio[:MAGNitude] on page 478

Quadrature Offset
Sets the quadrature offset, see Chapter 6.3.2.3, "Quadrature offset", on page 152.
Remote command: 
[:SOURce]:IQ:IMPairment:QUADrature[:ANGLe] on page 479

6.3.3.3  Digital impairments

Access:

1. Select "SGMA-GUI > Instrument Name > IQ Mod > Digital Impairments".

2. Select "SGMA-GUI > Instrument Name > Impairments > Digital Impairments".

Settings:

State............................................................................................................................159
I/Q Offset.....................................................................................................................159
Gain Imbalance........................................................................................................... 159
Quadrature Offset........................................................................................................159
Skew........................................................................................................................... 159
IQ Delay...................................................................................................................... 160
Phase Offset................................................................................................................160
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State
Activates/deactivates digital I/Q impairment.
When activated, the settings for carrier leakage, I/Q imbalance and quadrature offset
become effective.
Internal predistortion for compensating the I/Q modulator is not influenced by this set-
ting.
Remote command: 
[:SOURce<hw>]:BB:IMPairment:STATe on page 465
[:SOURce]:BB:IMPairment:IQOutput<ch>:STATe on page 465

I/Q Offset
Sets the carrier leakage (in percent) of the amplitudes (scaled to the peak envelope
power (PEP)) for the I and/or Q signal component. An ideal I/Q modulator suppresses
the carrier leakage completely (offset = 0 percent).
For more information, see Chapter 6.3.2.1, "I and Q offset", on page 151.
Remote command: 
[:SOURce<hw>]:BB:IMPairment:LEAKage:I on page 463
[:SOURce<hw>]:BB:IMPairment:LEAKage:Q on page 464
[:SOURce]:BB:IMPairment:IQOutput<ch>:LEAKage:I on page 467
[:SOURce]:BB:IMPairment:IQOutput<ch>:LEAKage:Q on page 467

Gain Imbalance
Sets the imbalance of the I and Q vector (see Chapter 6.3.2.2, "Gain and gain imbal-
ance", on page 152).
The entry is made in dB (default) or %, where 1 dB offset is roughly 12 % according to
the following:
Imbalance [dB] = 20log ( | GainQ | / | GainI |)

Positive values mean that the Q vector is amplified more than the I vector by the corre-
sponding percentage. Negative values have the opposite effect.
Remote command: 
[:SOURce<hw>]:BB:IMPairment:IQRatio[:MAGNitude] on page 463
[:SOURce]:BB:IMPairment:IQOutput<ch>:IQRatio[:MAGNitude]
on page 466

Quadrature Offset
Sets the quadrature offset (see Chapter 6.3.2.3, "Quadrature offset", on page 152).
Remote command: 
[:SOURce<hw>]:BB:IMPairment:QUADrature[:ANGLe] on page 464
[:SOURce]:BB:IMPairment:IQOutput<ch>:QUADrature[:ANGLe]
on page 467

Skew
Sets the time offset between the I and Q vectors.
In an I/Q modulator without I/Q skew, the I and Q vectors are aligned to the marker.
With an I/Q skew, both vectors are shifted relative to the marker. The offset of each of
the vectors to the marker is half of the I/Q skew value.
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A positive I/Q skew means that the Q vector delays relative to the I vector and vice
versa.
Remote command: 
[:SOURce<hw>]:BB:IMPairment:SKEW on page 464
[:SOURce]:BB:IMPairment:IQOutput<ch>:SKEW on page 467

IQ Delay
Sets the time delay of both I and Q vectors relative to the selected trigger and marker
or relative to the other instruments working in the primary/secondary instrument mode.
A positive value means that the I and Q vectors delay relative to the marker/trigger or
to the other instrument and vice versa.
Remote command: 
[:SOURce<hw>]:BB:IMPairment:DELay on page 462
[:SOURce]:BB:IMPairment:IQOutput<ch>:DELay on page 466

Phase Offset
Adds a phase offset to the digital impairments in the I/Q modulator. The phase of the
digital impairments is shifted relatively to the I/Q samples.
Remote command: 
[:SOURce]:BB:IMPairment:POFFset on page 465
[:SOURce]:BB:IMPairment:IQOutput<ch>:POFFset on page 466

6.4  I/Q analog output settings

The I/Q Analog Output requires option Differential Analog I/Q Outputs R&S SGT-K16.

I/Q analog output settings



Signal generator settingsR&S®SGT100A

161User Manual 1176.8674.02 ─ 12

Maximum overall output voltage

The voltage of the analog output signals is defined as a combination of output voltage
of the I and Q signal components and an optional bias voltage. If the differential output
is used, an additional offset can be set, too. The values of these parameters are inter-
dependent so that the magnitude of the sum of output voltage and bias voltage must
not exceed 4V.

The following applies:
● Single ended signal:

Vp + Vbias ≤ 4 V
● Differential signal:

0.5*Vp + |Vbias| + 0.5*Voffset ≤ 4 V

Where:
● Vp is the output voltage as set with the parameter I/Q Level Vp EMF
● Vbias is the bias voltage as set with the parameter Bias (EMF)
● Voffset is the offset between inverting and non-inverting output as set with the

parameter Offset (EMF)

For more information, see data sheet.

6.4.1  General analog I/Q output settings

Access:

► Select "I/Q Analog > I/Q Analog Outputs > General".

Settings:

State............................................................................................................................161
Set to Default.............................................................................................................. 162
Save/Recall................................................................................................................. 162
RF Envelope............................................................................................................... 162
I/Q Output Type...........................................................................................................162
Mode........................................................................................................................... 163
I/Q Level Vp EMF........................................................................................................163
Couple I/Q Bias........................................................................................................... 163
Bias (EMF).................................................................................................................. 163
Offset (EMF)................................................................................................................164

State
Enables/disables the analog I/Q output.
Note: By default, these output connectors are deactivated.
Remote command: 
[:SOURce<hw>]:IQ:OUTPut:ANALog:STATe on page 481
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Set to Default
Calls the default settings. The values of the main parameters are listed in the following
table.

Parameter Value

"State" Not affected by the "Set to Default"

"RF Envelope" Off

"I/Q Output Type" Single Ended

"I/Q Level Vp (EMF)" 1 V

"Bias (EMF)" 0 mV

Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:PRESet on page 481

Save/Recall
Accesses the "Save/Recall" dialog, that is the standard instrument function for saving
and recalling the complete dialog-related settings in a file. The provided navigation
possibilities in the dialog are self-explanatory.
The settings are saved in a file with predefined extension. You can define the filename
and the directory, in that you want to save the file.
Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:SETTing:CATalog? on page 482
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:SETTing:STORe on page 482
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:SETTing:LOAD on page 482
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:SETTing:DELete on page 483

RF Envelope
In instruments equipped with option R&S SGT-K540, enables the output of a control
signal that follows the RF envelope. This control signal is provided for power amplifiers
envelope tracking testing. The signal is output at the I/I Bar connectors.
The envelope tracking (ET) is a method used by modern power amplifiers (PA) to
improve their efficiency, especially when amplifying high crest factor RF signals. With
envelope tracking, the PA estimates, i.e. "tracks", the RF signal and varies the supply
voltage at the end-amplifying stage synchronous to the changes in the RF signal.
Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:STATe

I/Q Output Type
Selects the type of output signal.
The provided parameters in the "I/Q Analog Outputs" dialog depend on the selected
output mode.
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"Single-Ended" ● If "RF Envelope > Off"
Single-ended output at the I/Q connectors.

● If "RF Envelope > On"
The envelope signal E is output at the I connectors.

You can define a bias between the output signal and ground.
"Differential" ● If "RF Envelope > Off"

The analog I/Q signal components are output at the I/Q and I/Q
Bar connectors.

● If "RF Envelope > On"
The inverted envelope signal Ē is output at the I Bar connectors.

Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:TYPE on page 483

Mode
Selects the mode for setting the outputs, independent or together.
"Fixed" The I/Q signal components settings are predefined fix values:

● "Bias (EMF)" = "Offset (EMF)" = 0V
● "I/Q Level Vp (EMF)"

– Single-ended mode: "I/Q Level Vp (EMF)" = 1 V
– Differential mode: "I/Q Level Vp (EMF)" = 2 V

"Variable" (R&S SGT-K16)
Enables modification of the I/Q signal components settings.

Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:MODE on page 484

I/Q Level Vp EMF
In "Mode > Variable", sets the output voltage for the I and Q signal components.
The value range is adjusted so that the maximum overall output voltage does not
exceed 4V, see "Maximum overall output voltage" on page 161.
Remote command: 
[:SOURce<hw>]:IQ:OUTPut:LEVel on page 484

Couple I/Q Bias
In "Variable Mode", couples the bias setting of the I signal and the Q signal component.
With activated coupling, the settings of the I signal component automatically apply to
the Q signal component.
Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:BIAS:COUPling[:STATe] on page 483

Bias (EMF)
If a bias is enabled, a DC voltage is superimposed upon the I or Q signal.
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Effect of a positive bias Effect of a negative bias

In "Single Ended" mode, this parameter defines the bias between the output signal and
ground. It can be used to define the operating point of a DUT.
The value range is adjusted so that the maximum overall output voltage does not
exceed 4V, see "Maximum overall output voltage" on page 161.
Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:BIAS:I on page 483
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:BIAS:Q on page 483

Offset (EMF)
Sets an offset between the inverting and the non-inverting output.
The value range is adjusted so that the maximum overall output voltage does not
exceed 4V, see "Maximum overall output voltage" on page 161.
The selected offset is set half in the positive and half in the negative direction.

Effect of a positive offset Effect of a negative offset

A positive offset is set with half of the value in posi-
tive direction at the non-inverting outputs, in nega-
tive direction at the inverting outputs.

A negative offset is set with half of the value in neg-
ative direction at the non-inverting outputs, in posi-
tive direction at the inverting outputs.

Example: Effect of a positive offset on the I signal component
"I Offset" = 100.0 mV
The offsets applied on the two output connectors as follows:
● +50.0 mV at the positive signal output
● -50.0 mV at the inverted signal output
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Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:OFFSet:I on page 484
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:OFFSet:Q on page 484

6.5  Generation of envelope tracking signals

Envelope tracking (ET) is a method used by modern power amplifiers (PA) to improve
their efficiency, especially when amplifying RF signals with a high peak to average
power (PAPR). An envelope tracking detector "tracks" the power variations in the input
signal of the PA. The PA then varies synchronously to this variation the supply voltage
vcc at its end-amplifying stage.

This section introduces the concept of the envelope tracking functionality and the way
that it is implemented in the R&S SGT.

6.5.1  Required options

The equipment layout for generation and output of envelope tracking signal includes:
● Option Differential Analog I/Q Outputs (R&S SGT-K16)
● Option Envelope Tracking (R&S SGT-K540)
● Optional option AM/AM AM/PM Predistortion (R&S SGT-K541)

For more information, see data sheet.

6.5.2  About the envelope tracking

The R&S SGT allows you to generate an envelope tracking signal, that follows the
envelope variation of the RF signal.

Principle of the envelope tracking

The Figure 6-11 shows a simplified test setup for testing of a PA with an envelope
tracking. This illustration is intended to explain the principle in general, not all connec-
tions and required equipment are considered.
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Figure 6-11: Simplified test setup for power amplifier envelope tracking tests

The R&S SGT in this setup is configured to generate both, an RF signal with complex
modulation scheme and an envelope signal, that follows the envelope variation of this
RF signal. A suitable test signal is, for example, an EUTRA/LTE DL signal.

The R&S SGT generates the envelope signal directly from the baseband signal. The
envelope signal is a voltage signal, with voltage level Vout proportional to the power of
the RF signal (√[I(t)2+Q(t)2]) of the corresponding path. If you do not apply a shaping
function, the envelope signal linear dependent follows the variation of the RF signal's
envelope.

The envelope signal is output at the I out and I Bar out rear panel connectors. This
envelope signal is then further fed to an external DC modulator.

The PA receives the RF input signal and the dynamically adapted supply voltage vcc.
Ideally, the PA gain stays constant.

Suitable ARB signal to observe the effect of the envelope tracking settings

To simplify the explanation in the following sections, we use a simple ramp function as
an ARB waveform modulated on the RF carrier.

6.5.2.1  Envelope voltage adaptation modes

In the R&S SGT, you define the voltage of the generated envelope signal using one of
the following modes:
● Auto Power/Normilized Envelope Voltage Adaptation:

In this mode, you define the desired input characteristics of the power amplifier.
Based on these values and depending on the crest factor of the generated signal,
the R&S SGT calculates:
– The voltage on the I out/I Bar out connectors (VoutMin/Max) and a bias (Bias),

– The RMS level of the RF signal
The auto voltage adaptation mode is a suitable choice, if you have knowledge on
the power amplifier components and characteristics. Common PA characteristics
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are the supply voltage Vcc, the input power PEPin required for working in the linear
range and the gain characteristics of the external DC modulator.
You find the required values in the documentation of your power amplifier, for
example in its data sheet.

● Manual Envelope Voltage Adaptation:
In this mode, you can also define the operating range of the power amplifier based
on a pre-gain and a post-gain range. Based on these values, the instrument calcu-
lates the supply voltage Vcc.

All modes support envelope shaping.

6.5.2.2
 Signal parameters for testing according to the eTrak® specification

In the R&S SGT, you can select one of the predefined eTrak® interface types so that
the generated signal is conformed with the MIPI®Alliance specification "Analog Refer-
ence Interface for Envelope Tracking Specification".

Table 6-3: Default parameters per eTrak® Interface Type

Parameter 1.2 Vpp 1.5 Vpp 2 Vpp

I/Q output Type Differential Differential Differential

Bias 500 mV 600 mV 900 mV

Vpp Max 1.2 V 1.5 V 2 V

Vpp Max 1.2 V 1.5 V 2 V

Bipolar Input On On On

6.5.2.3  Envelope shaping and shaping methods

Envelope shaping is a method that uses functions to describe the relationship between
supply voltage and RF input power. An envelope-shaping function is a trade-off
between effectivity and improved linearity of the PA.

In the R&S SGT, you can select the way you define the shaping function. You can
choose between:
● 2 predefined simple linear functions

(see "About the linear functions" on page 168)
● 3 detroughing functions with a configurable factor

(see "About the detroughing function" on page 169)
● A polynomial function with up to 10 polynomial coefficients

(see "About the polynomial function" on page 169)
● A shaping function defined as a shaping table

(see "About the shaping table" on page 170)
● To set the correction values in raw format with a single remote control command

(see "Shaping function in raw data format" on page 171)

The linear, the detroughing and the polynomial shaping functions are mathematical
expressions that are described as function of the variable x, see Table 6-4.
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Table 6-4: Definition of the variable x depending on the envelope voltage adaptation mode

"Envelope Voltage Adaptation" x

Auto Power x = Vin - Vin, min

x ≥ 0

Auto Normalized x = Vin/Vin,max

Manual x = VEnv/VEnv,max

The mathematical expressions and further information on the shaping functions are
provided in the corresponding sections.

See also "Converting shaping functions and understanding the displayed values"
on page 171.

● About the linear functions......................................................................................168
● About the detroughing function............................................................................. 169
● About the polynomial function...............................................................................169
● About the shaping table........................................................................................ 170
● Shaping function in raw data format......................................................................171
● Converting shaping functions and understanding the displayed values............... 171

About the linear functions

The linear shaping can be used for less demanding applications, simple analysis, and
the first interactions by designing the optimum envelope shape. Because the shaping
gain of the linear function is 0 dB, in "Envelope Voltage Adaptation > Manual" mode
this function is suitable for determining the "Pre-/Post-Gain" values (see Example"Cal-
culating the current VCC in "Manual" mode" on page 175).

Provided are two linear functions, where each of them depends on the "Envelope Volt-
age Adaptation" mode:
● Linear (Voltage)

– f(x) = x in "Auto Normalized/Manual"
– f(x) = b*x + Vcc,min in "Auto Power"

● Linear (Power)
– f(x) = x2 in "Auto Normalized/Manual"
– f(x) = b*x2 + Vcc,min in "Auto Power"

Where:
● The variable x depends on the "Envelope Voltage Adaptation" mode, see

Table 6-4.
● The constant b is calculated as:

b = (Vcc,max - Vcc,min)/(Vin,max - Vin,min)

See also "Converting shaping functions and understanding the displayed values"
on page 171.
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About the detroughing function

Detroughing functions are well defined mathematical functions that prevent that the
supply voltage Vcc drops down to zero or falls under specified limits. That is, they pre-
vent that the signal is clipped.

Provided are the following functions:
● f(x) = x + d*e-x/d

● f(x) = 1 - (1 - d)*cos(x*pi/2)
● f(x) = d + (1 - d)*xa

Where:
● x is a variable, that depends on the "Envelope Voltage Adaptation" mode, see

Table 6-4
● a is the Exponent (a).
● d is the Detroughing Factor (d), that limits the supply voltage Vcc in the low-power

region and controls the shaping.
The detroughing factor (d) can be set manually or derived from the selected Vcc

value. In the latter case, it is calculated as follows:
d = Vcc,min/Vcc,max

See Couple Detroughing Factor with Vcc.
A "Detroughing Factor = 0" defines a linear function.

See also "Converting shaping functions and understanding the displayed values"
on page 171.

About the polynomial function

The polynomial function is an analytical method to describe a shaping function. The
polynomial function is defined as follows:

f(x) = a0 + ∑(an*xn), where n ≤10 and:
● Depending on the "Envelope Voltage Adaptation" mode, f(x) is:

– f(x) = Vcc(x) in "Auto Power"

– f(x) = Vcc/Vcc,max(x) in "Auto Normalized/Manual"
● The polynomial order n, the polynomial constant a0, and polynomial coefficients a0

to an are user-definable, see Chapter 6.5.7, "Polynomial coefficients settings",
on page 196

● x depends on the "Envelope Voltage Adaptation" mode, see Table 6-4

The default polynomial function with n = 1, a0 = 0 and a0 = 1 describes a linear func-
tion.

See also:
● Figure 6-22
● "Converting shaping functions and understanding the displayed values"

on page 171.
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File format of the polynomial function file

You can store a polynomial function in a file or even define the polynomial coefficients,
store them as a file and load this file into the instrument. The polynomial files are files
with extension *.iq_poly.

The file contains an optional header # Rohde & Schwarz - IQ Output
Envelope Polynomial Coefficients # a0,a1,a2,... and a list of comma-
separated coefficient values.

Example: Polynomial function file content
# Rohde & Schwarz - IQ Output Envelope Shaping Table
# a0,a1,a2,...
0.135,0.91,0.34,-0.59,-0.11

About the shaping table

The envelope-shaping table is a widely used method to define the shaping function.
This kind of definition is suitable if you have knowledge on or aim to achieve an exact
relation between supply voltage and RF input power. For example, with suitable set-
tings, the shaping table can precisely describe the transition region of the PA.

You can receive information on suitable envelope-shaping values form the power
amplifier manufacturer.

In the R&S SGT, there are two ways to define a shaping table function:
● Externally

Create a shaping table file as a CSV file with Microsoft Excel, with a Notepad or a
similar tool. Save it with the predefined extension, transfer it to and load it into the
instrument.
See also "File format of the shaping table file" on page 170.

● Internally
Use the built-in editor table editor, see Chapter 6.5.6, "Edit I/Q envelope shape set-
tings", on page 194.

File format of the shaping table file

The shaping table files are files with predefined extension and simple file format, see
Table 6-5.
Table 6-5: Shaping table files: format and extensions

"Envelope Voltage Adaptation" File extension Header (optional)

Auto Power *.iq_lutpv # Rohde & Schwarz - IQ Output
Envelope Shaping Table
# Power[dBm],Vcc[V]

Auto Normalized/Manual *.iq_lut # Rohde & Schwarz - IQ Output
Envelope Shaping Table
# Vin/Vmax,Vcc/Vmax

The header is optional. The file content is list of up to 4000 comma-separated value
pairs; a new line indicator separates the pairs.
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Example: Shaping table file content (*.iq_lut file)
# Rohde & Schwarz - IQ Output Envelope Shaping Table
# Vin/Vmax,Vcc/Vmax
0.3,0.4
0.35,0.45
0.56,0.55
0.4,0.5
0.6,0.65
0,0.135

Shaping function in raw data format

The shaping values are defined directly, with a single remote control command. You
define up to 4000 comma-separated value pairs, describing the Vin/Vmax,Vcc/Vmax
or Power[dBm],Vcc[V].

Example: 
SOURce1:OUTPut:ANALog:ENVelope:SHAPing:PV:FILE:DATA 0,0, 0.1,0.2, 1,1

See:
● [:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:FILE:DATA

on page 497
● [:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:PV:FILE:

DATA on page 497
● [:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:FILE:NEW

on page 497
● [:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:PV:FILE:NEW

on page 497

Converting shaping functions and understanding the displayed values

If an envelope function is defined, the "Shaping" dialog displays the diagram of the
resulting envelope shape.

See for example Figure 6-17.

Several parameters influence the displayed information:
● The selected "Envelope Voltage Adaptation" determines whether the x-axis uses

normalized or linear values
● The selected "Graphic Configuration > Scale" sets the x-axis units
● The selected VccMin/Max and PEPinMin/Max values set the borders of the clipping

areas
● The selected "Shaping" function and the parameters influence the envelope shape.

The illustration on Figure 6-12 shows how these parameters influence a linear shaping
function.
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Figure 6-12: Understanding the displayed values ("Shaping > Linear (Voltage)")

Shaded area = Area where the signal is clipped and the envelope signal is held constant.
1a, 1b, 2a, 2b = Vcc,min/Vcc,max and PEPinMin/Max values that set the borders of the clipping areas
Shaping = Linear (Voltage)
3a = Linear function (dashed line) in "Auto Power" mode, if Vcc,min = 0 V
3b = Linear function in "Auto Power" mode, if Vcc,min > 0 V
4a = Linear function (dashed line) in "Auto Normalized" mode, if Vcc,min = 0 V
4b = Linear function in "Auto Normalized" mode, if Vcc,min > 0 V
Vin = Operating point
VccNorm = Vcc in "Auto Normalized" mode
VccPow0 = Vcc in "Auto Power" mode and Vcc,min = 0 V
VccPow1 = Vcc in "Auto Power" mode and Vcc,min > 0 V

For information on the provided shaping functions and their formulas, see:
● "About the linear functions" on page 168
● "About the detroughing function" on page 169
● "About the polynomial function" on page 169

The group of examples in this section uses the same linear shaping function to explain
the representation in the different voltage adaptation modes. The example explains the
displayed values and how they are calculated and converted. The same principle
applies for the other shaping methods.

Common settings

● "Envelope Voltage Adaptation > Auto Power"
● Vcc Max = 1 V
● PEPinMin = -30 dBm corresponds to Vin,min = 0.0071 V
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● PEPinMax = 0 dBm corresponds to Vin,max = 0.2236 V
● Pin = -15 dBm corresponds Vin = 0.04 V
● PEP = -3.4 dB
● "Shaping > Linear (Voltage)"

"Graphic Scale > Power" "Graphic Scale > Voltage"

Example: Calculating the current VccPow0 ("Auto Power" mode, Vcc Min = 0 V)
Configuration as described in Common settings and:
● Vcc,min = 0 V
● f(x) = b*x + Vcc,min

(see "About the linear functions" on page 168)
VccPow0 = [(Vcc,max - Vcc,min)/(Vin,max - Vin,min)] * (Vin - Vin,min) + Vcc,min

VccPow0 = [(1 - 0)/(0.2236 - 0.0071)]*(0.04 - 0.0071) + 0

VccPow0 = 0.151 V
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Example: Calculating the current VccPow1 ("Auto Power" mode, Vcc Min > 0 V)
Configuration as described in Common settings and:
● Vcc,min = 200 mV

VccPow1 = [(Vcc,max - Vcc,min)/(Vin,max - Vin,min)] * (Vin - Vin,min) + Vcc,min

VccPow1 = [(1 - 0.2)/(0.2236 - 0.0071)]*(0.04 - 0.0071) + 0.2

VccPow1 = 0.321 V

Example: Calculating the current VccNorm ("Auto Normalized" mode)
Configuration as described in Common settings and:
● "Envelope Voltage Adaptation > Auto Normalized"
● The x-axis shows the normalized values Vin/Vin,max;

The operating point with Vin = 0.04 V corresponds to
Vin/Vin.max = 0.04 / 0.2236 = 0.178

● f(x) = x, i.e.
VccNorm = Vin/Vin,max

VccNorm = 0.178 V

Generation of envelope tracking signals



Signal generator settingsR&S®SGT100A

175User Manual 1176.8674.02 ─ 12

If the Vcc,min value is changed (Vcc,min > 0 V), then the following applies:
● If 0 < Vin/Vin,max ≤ Vcc,min, the signal is clipped and VccNorm = Vcc,min

● If Vin/Vin,max > Vcc,min, then VccNorm = Vin/Vin,max

For the previous example, if Vcc,min = 200 mV, that VccNorm = Vcc,min = 0.2 V.

Example: Calculating the current VCC in "Manual" mode
In "Envelope Voltage Adaptation > Manual" mode, set the parameter "Pre-Gain = PEP
= - 3.4 dB".
The displayed shaping function resembles the shaping function in "Auto Normalized"
mode; the same formulas apply, too.

You can also query the VCC values for any specified x in the supported voltage adapta-
tion mode and units.
See [:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VCC:VALue?
on page 494.
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Additional information

The described principle applies for any shaping function.

Only if linear shaping is used, the VCCNorm can also be directly converted to VCCPow
according to the following formula:

fPow(x) = [fNorm(x) - Vin,min/Vin,max]*[(Vcc,max - Vcc,min)/(1 - Vin,min/Vin,max)]

For example, if fNorm(x) = VCCNorm = 0.178 V, fPow(x) = VccPow0 is:

VccPow0 = [0.178 - 0.0071/0.2236]*[(1 - 0)/(1 - 0.0071/0.2236)]

VccPow0 = 0.151 V

6.5.3  General RF envelope settings

Access:

1. In the block diagram, select the "I/Q OUT" connector to unfold the "I/Q Analog"
block.

2. Select "I/Q Analog > I/Q Analog Settings > General".

3. Select "RF Envelope > On".

Figure 6-13: RF Envelope Settings (Example)

1 = Termination and input impedance of the circuit board
2 = Voltage level measured at the circuit board
3 = Signal characteristics of the DC Modulator
4 = Signal characteristics at the inputs of the PA (see the documentation of the PA, for example its data

sheet)
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The remote commands required to define these settings are described in Chap-
ter 10.14.13, "SOURce:IQ:OUTPut:ENVelope commands", on page 485.

Settings:

State............................................................................................................................177
Set to Default.............................................................................................................. 177
Save/Recall................................................................................................................. 178
RF Envelope............................................................................................................... 178
Envelope Voltage Adaptation...................................................................................... 178
eTrak® Interface Type..................................................................................................178
I/Q Output Type...........................................................................................................179
Envelope Voltage Reference.......................................................................................179
VoutMin/Max.................................................................................................................179
Bias............................................................................................................................. 179
DC Modulator characteristics...................................................................................... 180

└ EMF.............................................................................................................. 180
└ Rin................................................................................................................. 180
└ Termination................................................................................................... 180
└ Bipolar Input..................................................................................................181
└ VppMax.......................................................................................................... 182
└ Gain.............................................................................................................. 182
└ VccOffset........................................................................................................182

PA characteristics........................................................................................................182
└ VccMin/Max....................................................................................................183
└ Power Offset................................................................................................. 183
└ PEPinMin/Max............................................................................................... 184

State
Enables/disables the analog I/Q output.
Note: By default, these output connectors are deactivated.
Remote command: 
[:SOURce<hw>]:IQ:OUTPut:ANALog:STATe on page 481

Set to Default
Calls the default settings. The values of the main parameters are listed in the following
table.

Parameter Value

"State" Not affected by the "Set to Default"

"RF Envelope" Off

"I/Q Output Type" Single Ended

"I/Q Level Vp (EMF)" 1 V

"Bias (EMF)" 0 mV
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Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:PRESet on page 481

Save/Recall
Accesses the "Save/Recall" dialog, that is the standard instrument function for saving
and recalling the complete dialog-related settings in a file. The provided navigation
possibilities in the dialog are self-explanatory.
The settings are saved in a file with predefined extension. You can define the filename
and the directory, in that you want to save the file.
Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:SETTing:CATalog? on page 482
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:SETTing:STORe on page 482
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:SETTing:LOAD on page 482
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:SETTing:DELete on page 483

RF Envelope
Enables the output of a control signal that follows the RF envelope. This control signal
is provided for power amplifiers envelope tracking testing. The signal is output at the I
out and I Bar out connectors.
Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:STATe on page 488

Envelope Voltage Adaptation
Defines the way you configure the voltage of the envelope tracking generator (see
Chapter 6.5.2.1, "Envelope voltage adaptation modes", on page 166).
"Auto Normalized"

Generation based on the physical characteristics of the power ampli-
fier; the power values are normalized based on the selected PEPin
Max value.
This mode enables you to use the complete range of a selected
detroughing function.
See also Shaping settings and compare the values on the X axis on
the graphical display.

"Auto Power" Generation based on the physical characteristics of the power ampli-
fier, where the input power of the PA "PEPin" is defined with its min
and max values.

"Manual" Generation, in that the operating range of the amplifier is defined
based on a pre-gain and a post-gain range.

Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:ADAPtion on page 488

eTrak® Interface Type
Selects one of the predefined interface types or allows user-defined settings.

See Chapter 6.5.2.2, "Signal parameters for testing according to the eTrak® specifica-
tion", on page 167.
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Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:ETRak on page 489

I/Q Output Type
Selects the type of output signal.
The provided parameters in the "I/Q Analog Outputs" dialog depend on the selected
output mode.
"Single-Ended" ● If "RF Envelope > Off"

Single-ended output at the I/Q connectors.
● If "RF Envelope > On"

The envelope signal E is output at the I connectors.
You can define a bias between the output signal and ground.

"Differential" ● If "RF Envelope > Off"
The analog I/Q signal components are output at the I/Q and I/Q
Bar connectors.

● If "RF Envelope > On"
The inverted envelope signal Ē is output at the I Bar connectors.

Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:TYPE on page 483

Envelope Voltage Reference
Defines whether the envelope voltage Vout is set directly or it is estimated from the
selected supply voltage Vcc.

Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VREF on page 489

VoutMin/Max
Displays the minimum and maximum values of the peak-to-peak voltage Vout voltage
on the interface between the circuit board and the DC modulator.
For "Envelope Voltage Reference" , sets the value of this parameter.
To measure the Vout voltage:
● Use a suitable probe, i.e. use a differential probe if a "Wire to Wire" termination is

used and a single ended probe otherwise
● Measure at the circuit board after the termination impedance Rin.

Estimated "VoutMin/Max" values are calculated based on the selected supply voltage
VccMin/Max, enabled Gain and VccOffset in the DC modulator.

Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VOUT:MIN on page 490
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VOUT:MAX on page 490

Bias
Sets a DC voltage, superimposed upon the envelope signal E and the inverted enve-
lope signal E Bar.
Use this parameter to define the operating point of a DUT.

Generation of envelope tracking signals



Signal generator settingsR&S®SGT100A

180User Manual 1176.8674.02 ─ 12

"I/Q Output Type" Termination "Bias" defines

"Single Ended" - The bias between the envelope signal E and ground

"Differential" "To Ground" Superimposed DC voltage, where "Bias" is related to
the selected Rin.

See also Table 6-6

 "Wire To Wire" Superimposed DC voltage, where "Bias" is related to
high impedance (1 MΩ).

Table 6-6: Effect of enabled bias

Effect of a positive bias Effect of a negative bias

Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:BIAS on page 490

DC Modulator characteristics
Refer to the product documentation of the external DC modulator for information on its
characteristics.
The following settings are required:

EMF ← DC Modulator characteristics
Activates EMF, which defines whether the EMF or the voltage value is displayed.
An EMF-based calculation assumes an open-end circuit. Disable this parameter for
testing in more realistic conditions, where you define the input impedance of the used
external DC modulator Rin. The R&S SGT then calculates the envelope output voltage
VoutMin/Max based on it.

Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:EMF[:STATe] on page 491

Rin ← DC Modulator characteristics
If "EMF > Off", sets the input impedance Rin of the external DC modulator.

Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:RIN on page 491

Termination ← DC Modulator characteristics
If "I/Q Output Type > Differential" and "EMF > Off", defines the way the inputs of the
DC modulator are terminated.
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The termination influences the way an enabled Bias is applied.

"To Ground" "Wire to Wire"

*) Bias = 0 and VccOffset = 0 *) Bias = 0 and VccOffset = 0

Both inputs of the DC modulator are terminated to
ground.

This termination is also referred as a common mode
voltage.

Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:TERMination on page 492

Bipolar Input ← DC Modulator characteristics
If "I/Q Output Type> Differential", enables the instrument to generate a bipolar signal.
The envelope signal E swings above and below the inverted envelope signal E Bar; the
R&S SGT calculates and applies a suitable envelope VccOffset automatically.

Figure 6-14: Effect of a "Bipolar Input > On"

This parameter influences the lower limit of the supply voltage Vcc.

The generated signal is conformed with the MIPI®Alliance specification "Specification
for Analog Reference Interface for Envelope Tracking".
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Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:BINPut on page 492

VppMax ← DC Modulator characteristics
Sets the maximum value of the peak-to-peak driving voltage Vpp of the external DC
modulator.
The Vpp limits:
● The value range of the supply voltage VccMin/Max

Vpp ≥ VCCMax
● In "I/Q Output Type > Differential", the voltage of the generated envelope signal

VoutMin/Max as follows:
Vpp ≥ VoutMax[E] - VoutMax[E Bar], where [E] and [E Bar] refer to the envelope sig-
nal and the inverted envelope signal.

Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VPP[:MAX] on page 491

Gain ← DC Modulator characteristics
Sets the gain of the external DC modulator.
Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:GAIN on page 492

VccOffset ← DC Modulator characteristics
Applies a voltage offset on the supply voltage VccMin/Max, i.e. compensates a possible
offset from the external DC modulator. Reduces the envelope output voltage
VoutMin/Max by this value to maintain the supply voltage Vcc in the defined value range.

Figure 6-15: Effect of a Vcc offset

Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VCC:OFFSet on page 492

PA characteristics
Refer to the product documentation of the power amplifier (PA) for information on its
characteristics.
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The following settings are required:

VccMin/Max ← PA characteristics
Displays the minimum and maximum values of the supply voltage Vcc, as required by
the power amplifier (PA).
For "Envelope Voltage Reference > Vcc", sets the minimum and maximum values of
the supply voltage Vcc.

The value range of the supply voltage Vcc is determined by the allowed peak-to-peak
driving voltage Vpp of the external DC modulator and the enabled VccOffset.

VccMax ≤ VppMax

The Vcc is calculated as follows:

Vcc = Vout * Gain + Vcc Offset

Example: 
Envelope Voltage Reference = Vcc

VccOffset = 0 mV

VccMax = 1 V = 0 dBV

Gain = 3 dB
VccMax [dBV] - Gain [dB] = VoutMax or

VoutMax = 0 dBV - 3 dB = -3 dBV = 0.708 V

"Bipolar Input" Value range "VccMin"

"State > On" VccMin = - 0.5*VppMax

Note: Implemented as a VccOffset, see Effect of a "Bipolar
Input > On".

"State > Off" VccMin = 0 to VccMax

Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VCC:MIN on page 493
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VCC:MAX on page 493

Power Offset ← PA characteristics
Indicates an enabled power offset, for example to compensate power attenuation
because of cable lengths.
The displayed value is applied as level offset to the generated RF signal and considers
the following settings:
● "RF > RF Level > Level > Offset"
● "RF > RF Level > UCOR"
Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:POWer:OFFSet?
on page 495
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PEPinMin/Max ← PA characteristics
Sets the minimum and maximum values of the input power PEPin, as required by the
power amplifier (PA).
The "PEPinMin/Max" parameters define the linear range of the PA. Refer to the product
documentation of the PA for information on the characteristics of the required input sig-
nal.
The value range corresponds to the value range of output level.
Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:PIN:MIN on page 494
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:PIN:MAX on page 495

6.5.4  Envelope settings

Access:

1. Enable the generation of envelope tracking signal.
See Chapter 6.5.3, "General RF envelope settings", on page 176.

2. Select "I/Q Analog Settings > Envelope Settings".

1 = Enabled Digital Predistortion
2 = Envelope detector, √[I(t)2+Q(t)2]; indication changes, depending on the Envelope Voltage

Adaptation
3a, 3b = (for "Envelope Voltage Adaptation > Manual") Pre-Gain/Post-Gain
4 = Shaping state and shaping function; gray background color = deactivated shaping
5 = Enabled Envelope to RF Delay
6 = Indicates the output connectors, depending on the I/Q Output Type

The dialog displays an interactive overview diagram of the ET processing chain.
The diagram displays information on shaping state, incl. current shaping method
and setting, like gains or delay.

Tip: Hotspots for quick access. The displayed blocks are hotspots. Select one of
them to access the related function.

The remote commands required to define these settings are described in Chap-
ter 10.14.13, "SOURce:IQ:OUTPut:ENVelope commands", on page 485.
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Settings:

Envelope to RF Delay................................................................................................. 185
Calculate Envelope from Predistorted Signal..............................................................185

Envelope to RF Delay
Sets the time delay of the generated envelope signal relative to the corresponding RF
signal. A positive value means that the envelope signal delays relative to the RF signal
and vice versa.

1

2a

2b

Figure 6-16: Effect of enabled positive RF delay

1 = RF signal
2a, 2b = Envelope signal E and inverted envelope signal E BAR

Use this parameter to compensate possible timing delays caused by connected cables
and align the input signals at the PA to prevent unwanted effects, like memory effects
or decreased linearity.
Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:DELay on page 489

Calculate Envelope from Predistorted Signal
Option: R&S SGT-K541
Enables the calculation of the envelope signal from the original baseband signal or
from the AM/AM and/or AM/FM predistorted signal.
See also Chapter 6.6, "Applying digital predistortion", on page 198.
Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:FDPD on page 490
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6.5.5  Shaping settings

Access:

1. Enable the generation of envelope tracking signal.
See Chapter 6.5.3, "General RF envelope settings", on page 176.

2. Enable "Envelope Voltage Adaptation > Auto Power/Normalized".

3. Select "I/Q Analog Outputs > Shaping".

Figure 6-17: Understanding the displayed information ("Envelope Voltage Adaptation > Auto
Power", "Shaping > Detroughing")

1a, 1b = Indicates the values of VccMin/Max
2a = Values smaller than PEPinMin are clipped.
2b = Values greater than PEPinMax are clipped.
3 = Operating point; corresponds to the RF RMS power level.
3a = Current RF RMS power level; an enabled "RF Level > Level Offset" is considered.
3b = Current VCC

4 = Crest factor of the generated signal
5a, 5b = The values correspond to the PEP of the generated RF signal and the VCC; shaded area indi-

cates the calculated Pre-Gain.
6 = Current envelope shape, defined by the detroughing function and detroughing factor

The settings allow the configuration of the shape of the RF envelope signal. The
instrument applies the settings and calculates the shaping function. A diagram vis-
ualizes the resulting envelope shape, as function of the selected supply voltage Vcc

and PEPin value limits, the calculated pre-gain and the estimated operating point of
the PA.
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See also:
● "Converting shaping functions and understanding the displayed values"

on page 171.

The remote commands required to define these settings are described in Chap-
ter 10.14.13, "SOURce:IQ:OUTPut:ENVelope commands", on page 485.

Settings:

Shaping....................................................................................................................... 187
Detroughing Function..................................................................................................191
Detroughing Factor (d)................................................................................................ 192
Couple Detroughing Factor with Vcc...........................................................................192
Exponent (a)................................................................................................................192
Pre-Gain......................................................................................................................192
Post-Gain.................................................................................................................... 192
Polynomial Coefficients...............................................................................................193
Shaping Table............................................................................................................. 193
Interpolation................................................................................................................ 193
Graphic Configuration................................................................................................. 194

└ Scale.............................................................................................................194
└ Diagram........................................................................................................ 194

Shaping
Enables envelope shaping and selects the method to define the shaping function.
For detailed information on the shaping functions, see:
● Chapter 6.5.2.3, "Envelope shaping and shaping methods", on page 167
● "Converting shaping functions and understanding the displayed values"

on page 171.
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"Off" Envelope shaping is not adopted.
Previously configured values of the parameters Pre-Gain and Post-
Gain are ignored.

1

2a

2b

Figure 6-18: Generated RF, envelope and inverted envelope signal

1 = RF signal (simple ramp function)
2a, 2b = Envelope signal E and inverted envelope signal E Bar

"Linear (Voltage)/Linear (Power)"
The shaping function is a simple linear function.
The linear shaping is not used in practice but can be used for less
demanding applications, simple analysis, and the first interactions by
designing the optimum envelope shape. For "Envelope Voltage Adap-
tion > Manual", this function is suitable to determine the "Pre-/Post-
Gain" values, because the shaping gain of the linear function is 0 dB.
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"Polynomial" The shaping function is defined by a polynomial with configurable
order and coefficients.
Select Polynomial coefficients settings to access the settings.

1

2a

2b

Figure 6-19: Effect of a polynomial shaping on the envelope and inverted enve-
lope signal

1 = RF signal (simple ramp function)
2a, 2b = Envelope signal E and inverted envelope signal E Bar
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"From Table" The shaping function is defined by user-defined value pairs in form of
a shaping table.
This shaping function is suitable if you have knowledge on or aim to
achieve an exact relation between the supply voltage and RF output
power. For example, by describing the transition region of a PA.
Select "Shaping Table" to access the settings.

1

2a

2b

Figure 6-20: Effect of a table shaping on the envelope and inverted envelope sig-
nal

1 = RF signal (simple ramp function)
2a, 2b = Envelope signal E and inverted envelope signal E Bar
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"Detroughing" The shaping function applies a detroughing to prevent that the supply
voltage Vcc drops down to zero.
Use the "Detroughing Factor" to limit the supply voltage Vcc in the
low-power region.

1

2a

2b

Figure 6-21: Effect of a detroughing function on the envelope and inverted enve-
lope signal

1 = RF signal (simple ramp function)
2a, 2b = Envelope signal E and inverted envelope signal E Bar

Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:MODE on page 495

Detroughing Function
Selects the mathematical function describing the detroughing.
The following functions are available:
● f(x) = x + d*e-x/d

● f(x) = 1 - (1 - d)*cos(x*pi/2)
● f(x) = d + (1 - d)*xa

Where:
● x depends on the "Envelope Voltage Adaptation" mode, see Table 6-4
● d = Detroughing Factor (d)
● a = Exponent (a)
For more information, see "Converting shaping functions and understanding the dis-
played values" on page 171.
Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:DETRoughing:
FUNCtion on page 499
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Detroughing Factor (d)
For inactive coupling of the detroughing factor with Vcc, sets a start offset to limit the
supply voltage Vcc in the low-power region.

The detroughing factor also controls the shaping. "Detroughing Factor = 0" defines a
linear function.
See also "Couple Detroughing Factor with Vcc" on page 192.
Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:DETRoughing:
FACTor on page 500

Couple Detroughing Factor with Vcc
Enable this parameter to derive the detroughing factor (d) from the selected Vcc value.
This ensures that the minimum supply voltage Vcc does not drop under the specified
limits and the signal is not clipped.
The detroughing factor is calculated as follows:
d = VccMin/VccMax

Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:DETRoughing:
COUPling on page 499

Exponent (a)
For the third detroughing function, sets the exponent (a), see Detroughing Function.
Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:DETRoughing:
PEXPonent on page 500

Pre-Gain
For "Envelope Voltage Adaptation > Manual", sets a pre-gain (i.e. an attenuation) to
define the operating range of the power amplifier. The pre-gain can be used to define
and test only a specific (required) part of the operating range.
For "Envelope Voltage Adaptation > Auto", calculates the value automatically as follow-
ing:
Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:GAIN:PRE
on page 496

Post-Gain
For "Envelope Voltage Adaption > Manual", sets a post-gain to compensate the attenu-
ation introduced by the pre-gain and the gain of the shaping function.
Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:GAIN:POST
on page 496
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Polynomial Coefficients
For "Shaping > Polynomial", accesses a dialog to describe the envelope shape as a
polynomials function, see Chapter 6.5.7, "Polynomial coefficients settings",
on page 196.

Shaping Table
For "Shaping > From Table", accesses the standard "Envelope Select" dialog with
functions to define a new shaping table file, select or edit an existing one.
The shaping table files are files with predefined extension and file format, see "File for-
mat of the shaping table file" on page 170.
You can create a shaping table externally or internally.
"Select" Selects and loads an existing file.
"New" Creates a file
"Edit" Access a standard built-in table editor, see Chapter 6.5.6, "Edit I/Q

envelope shape settings", on page 194.
Remote command: 
For "Envelope Voltage Adaption > Manual":
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:FILE:CATalog?
on page 496
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:FILE[:SELect]
on page 496
For "Envelope Voltage Adaption > Auto":
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:PV:FILE:
CATalog? on page 496
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:PV:FILE[:
SELect] on page 496

Interpolation
For "Shaping > From Table", enables a linear interpolation between limited number of
defined value pairs in the table, to prevent abrupt changes.
Table 6-7: Effect of parameter "Interpolation"

"Interpolation > Off" "Interpolation > Linear Voltage"
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Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:INTerp
on page 497

Graphic Configuration
Comprises settings to configure the graphical display.

Scale ← Graphic Configuration
Determines the units, "Voltage" or "Power", used on the x and y axis.
Table 6-8: Units on the x axis

"Envelope Voltage Adaption" "Scale > Power" "Scale > Voltage"

Auto Power Pin [dBm] Vin [V] = √Pin

Auto Normalized Pin/Pmax Vin/Vmax

Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:SCALe
on page 496

Diagram ← Graphic Configuration
Visualizes the resulting envelope shape, as function of the selected supply voltage Vcc

and PEPin value limits, the calculated pre-gain and the estimated operating point of the
PA.
See Figure 6-17.
Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VCC:VALue:LEVel?
on page 493
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VCC:VALue:PEP?
on page 493
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VCC:VALue? on page 494

6.5.6  Edit I/Q envelope shape settings

The envelope shaping table is a method to define the shaping function.

Access:

1. Enable the generation of envelope tracking signal.
See Chapter 6.5.3, "General RF envelope settings", on page 176.

2. Select "Envelope Voltage Adaptation > Manual".

3. Select "Shaping Settings > Shaping > From Table".

4. Select "Shaping Table > New"

5. Enter the "File Name", e.g. MyLUT

The "Envelope Shaping File" dialog closes.
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The "Shaping > Shaping Table" confirms that the newly created file is assigned.

6. Select "Shaping Table > MyLUT > Edit"

7. Define the value pairs "Vin/Vmax" and "Vcc/Vmax". The order is uncritical.

8. Select "Save".

The instrument loads the configured values automatically and displays the shaping
function.

9. Select "Shaping Settings > Interpolation > Linear (Voltage)".

The display confirms the used interpolation.

The remote commands required to define these settings are described in Chap-
ter 10.14.13, "SOURce:IQ:OUTPut:ENVelope commands", on page 485.

Settings:

Vin/Vmax, Vcc/Vmax/Power (dBm), Vcc (V)...............................................................195
Fill Table Automatically................................................................................................195
Goto, Edit, Save As, Save...........................................................................................195

Vin/Vmax, Vcc/Vmax/Power (dBm), Vcc (V)
Sets the normalized values of the value pairs.
"Vin/Vmax, Vcc/Vmax"

Value pairs in "Envelope Voltage Adaptation > Manual/Auto Normal-
ized" mode.

"Power(dBm), Vcc(V)"
Value pairs in "Envelope Voltage Adaptation > Auto Power" mode.

Remote command: 
n.a.

Fill Table Automatically
Standard function for filling a table automatically with user-defined values.
"From / Range"

Defines the start line and number of the rows to be filled.
"Select Column to Fill"

Selects the respective value, including the unit.
"Start / End Value"

Default values corresponding to the selected column.
"Increment" Determines the step size.
"Fill" Fills the table.

Fill both columns and then save the list. Otherwise the entries are
lost.

Goto, Edit, Save As, Save
Standard functions for editing of data lists.
Changed and unsaved values are displayed on a yellow background.
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Remote command: 
n.a.

6.5.7  Polynomial coefficients settings

Access:

1. Enable the generation of envelope tracking signal.
See Chapter 6.5.3, "General RF envelope settings", on page 176.

2. Select "Envelope Voltage Adaptation > Auto Normalized".

3. Select "Shaping Settings > Shaping > Polynomial".

4. Select "Polynomial Coefficients".

Figure 6-22: Polynomial Coefficients: Understanding the displayed information

The polynomial function is an analytical method to describe a shaping function.
With the provided settings, you can define a polynomial function with up to 10th

order to describe the envelope shape.

5. Select "Polynomial Order = 2" (n = 2).

6. Set the constant a0 and the polynomial coefficients a1 and a2.

7. Select "Apply".

The instrument loads the configured values and displays the shaping function.

8. To store the defined shaping function:

a) Select "Save/Recall Polynomial"
b) Navigate throughout the file system.
c) Enter a "File Name", e.g. MyPolynomial_2thOrder
d) Select "OK".

9. Select "Polynomial Coefficients > OK" to close the dialog.

The remote commands required to define these settings are described in Chap-
ter 10.14.13, "SOURce:IQ:OUTPut:ENVelope commands", on page 485.
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Settings:

Save/Recall Polynomial.............................................................................................. 197
Polynomial Order........................................................................................................ 197
Polynomial constant and coefficients.......................................................................... 197
Apply, OK.................................................................................................................... 197

Save/Recall Polynomial
Accesses the "Save/Recall" dialog, that is the standard instrument function for saving
and recalling the complete dialog-related settings in a file. The provided navigation
possibilities in the dialog are self-explanatory.
The settings are saved in a file with predefined extension. You can define the filename
and the directory, in that you want to save the file.
The polynomial files are files with extension *.iq_poly, see "File format of the poly-
nomial function file" on page 170.
Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:COEFficients:
CATalog? on page 498
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:COEFficients:
STORe on page 498
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:COEFficients:
LOAD on page 498

Polynomial Order
Defines the polynomial order n, that is the number of polynomial coefficients (see
"About the polynomial function" on page 169).
To confirm the settings, select "Apply".
Remote command: 
See [:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:
COEFficients on page 497.

Polynomial constant and coefficients
Sets the polynomial constant a0 and the polynomial coefficients a1 to an.

The polynomial constant and coefficients influence the envelope shape.
Remote command: 
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:COEFficients
on page 497

Apply, OK
Triggers the instrument to adopt the selected function.
Use "OK" to apply the setting and exits the dialog.
Remote command: 
See [:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:
COEFficients on page 497
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6.6  Applying digital predistortion

Digital predistortion (DPD) is a method to improve the efficiency of RF power amplifi-
ers. In the R&S SGT, the generated digital signal can be deliberately AM/AM and
AM/PM predistorted.

6.6.1  Required options

The equipment layout for digital predistortion includes:
● Option AM/AM AM/PM predistortion (R&S SGT-K541)
● Optional option envelope tracking (R&S SGT-K540)

6.6.2  About digital predistortion

Power amplifiers are an essential part of any telecommunication systems. While ampli-
fying the transmitted signal, power amplifiers sometimes also distort this signal and
change its amplitude and/or phase characteristics. Such distortions result in undesired
effects like spectrum regrowth, harmonic generation, intermodulation (IM) products, or
increased bit error rate.

The principle of the digital predistortion

To compensate for the distortions caused by the transmission system, the signal is
deliberately digitally predistorted. Digital predistortion (DPD) is a method to apply wan-
ted and well-defined predistortion on the transmitted signal. When this signal is ampli-
fied, the resulting signal features the identical characteristics, as the initial signal before
the predistortion.

Pout

Pin Pin

Pout

Pin Pout

a b c

signal DPD PA

Figure 6-23: Illustration of predistortion principle

DPD = Digital predistortion
PA = Power amplifier
a = Predistortion function
b = Characteristic of the power amplifier, for example the non-linear input power vs. output power

(AM/AM) function
c = Ideal linearized characteristic of the amplified signal

Digital predistortion models

When testing power amplifiers, it is important to measure and analyze signal distor-
tions.
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Of several known models, this implementation focuses on the following two types of
distortion:
● The AM/AM (amplitude-to-amplitude) distortion and
● The AM/PM (amplitude-to-phase) distortion.

An AM/AM representation is a standard method that shows the signal power level at
the input of the DUT against the power level at the output of the DUT. The default unit
for both axes is dBm but the AM/AM representation can also be normalized.

An AM/PM curve shows the phase difference in degrees (y-axis) for every input power
level (x-axis).

With option R&S SGT-K541, you can define both, an AM/AM and an AM/PM predistor-
tion and apply them separately or superimposed on each other on the generated digital
baseband signal.

If your instrument is equipped with the option R&S SGT-K540, you can also apply pre-
distortions on the generated envelope signal.

Refer to Chapter 6.5, "Generation of envelope tracking signals", on page 165 for more
information.

6.6.2.1  Defining the power level of the generated signal

You can define the level of the generated signal in one of the following ways:
● "Level Reference > Before DPD"

In this mode, the "Level" parameter in the status bar of the instrument defines the
signal level before the DPD is applied.
Signal with selected level is pre-distorted and depending on the selected AM/AM
and AM/PM functions, attenuated or boosted.

● "Level Reference > After DPD"
In this mode, you define the resulting signal level. Based on this value and depend-
ing on current predistortion function, the R&S SGT calculates the level of the signal
to be pre-distorted.
The level calculation requires several interaction cycles; the number of iterations is
a trade-off between level accuracy and speed.

6.6.2.2  Defining the correction values

In the R&S SGT, you can select the way you define the predistortion function and
choose between:
● A polynomial function with up to 10 polynomial coefficients

(see "Polynomial function" on page 200)
● A predistortion function defined as a look-up table

(see "Shaping table" on page 200)
● A normalized data

(see "Normalized data" on page 201)
● To set the correction values in raw format with a single remote control command

(see "Predistortion function in raw data format" on page 202).
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Polynomial function

The polynomial function is an analytical method to describe a predistortion function.
When using the polynomial function, you do not define the correction values (ΔPower
and ΔPhase) directly as it is in the look-up table. You describe the predistortion func-
tion and the R&S SGT derives the correction values out of it.

See Chapter 6.6.3.4, "Polynomial coefficients settings", on page 211.

This implementation uses a polynomial with complex coefficients defined as follows:

PDPD(x) = ∑[(an+j*bn)*xn],

Where:
● n = "Polynomial Order" ≤ 10
● x = Pin/PinMax
● an and bn are user-defined coefficients, defined as Cartesian (polar) or cylindrical

coordinates.
In Cartesian coordinates system, the coefficients bn are expressed in degrees.

The R&S SGT calculates the AM/AM and AM/PM predistortion functions as follows:
● AM/AM(x) = abs[PDPD(x)]
● AM/PM(x) = tan-1{Im[PDPD(x)]/Re[PDPD(x)]}

The R&S SGT calculates the correction values (ΔAM/AM and ΔAM/PM functions) as
follows:
● ΔAM/AM(x) = AM/AM(x) - x = abs[PDPD(x)] -x
● ΔAM/PM(x) = AM/PM(x) = tan-1{Im[PDPD(x)]/Re[PDPD(x)]}

File format of the polynomial file

You can store a polynomial function in a file or even define the polynomial coefficients,
store them as a file and load this file into the instrument. The polynomial files are files
with the extension *.dpd_poly.

The file contains an optional header # Rohde & Schwarz - Digital
Predistortion Polynomial Coefficients # a0,b0, a1,b1, a2,b2, ...
and a list of comma-separated coefficient value pairs, stored in Cartesian coordinates.

For values above the selected Input Range (PEPin) From/To, the predistortion function
assumes a linear ratio of the input to output power.

Example: Polynomial function file content
# Rohde & Schwarz - Digital Predistortion Polynomial Coefficients
# a0,b0, a1,b1, a2,b2, ...
0,0,-0.25,0.2,0.6,-0.3,0.3,0.3,0.5,-0.4

Shaping table

In the R&S SGT, there are two ways to define the predistortion function in form of a
shaping table:
● Externally
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Create a correction table file as a CSV file with Microsoft Excel, with a Notepad or
a similar tool. Save the file with the predefined extension, transfer and load it into
the instrument.
See also "File format of the correction table file" on page 201.

● Internally
Use the built-in editor table editor, see Chapter 6.6.3.3, "Edit predistortion table set-
tings", on page 210.

File format of the correction table file

The correction table files are files with predefined extension and simple file format, see
Table 6-9.
Table 6-9: Shaping table files: format and extensions

Predistortion model File extension Header (optional)

AM/AM *.dpd_magn # Rohde & Schwarz - Digital AM/AM
Predistortion 
Table Pin[dBm],deltaPower[dB]

AM/PM *.dpd_phase # Rohde & Schwarz - Digital AM/PM
Predistortion 
Table Pin[dBm],deltaPhase[deg]x

The header is optional. The file content is a list of up to 4000 comma-separated value
pairs, describing the delta values for amplitude or phase related to the absolute input
power Pin. A new line indicator separates the pairs.

For values above the selected Input Range (PEPin) From/To, the predistortion function
assumes a linear ratio of the input to output power.

Example: Shaping table file content (*.dpd_magn file)
# Rohde & Schwarz - Digital AM/AM Predistortion Table
Pin[dBm],deltaPower[dBm]
-30,0.5
3,-0.01

Normalized data

In the R&S SGT, there are two ways to define the predistortion function as normalized
data:
● Externally

We recommend that you calculate the normalized correction data by a connected
R&S®FSW equipped with R&S®FSW-K18 power amplifier and envelope tracking
measurements option.
You can also create the correction table file as a CSV file with Microsoft Excel, with
a Notepad or a similar tool. Save the file with the predefined extension, transfer
and load it into the instrument.
See also "File format of the correction table file" on page 201.

● Internally
Use the built-in editor table editor, see Chapter 6.6.3.3, "Edit predistortion table set-
tings", on page 210.
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File format of the normalized data

The normalized data files are files with predefined extension *.dpd_norm and simple
file format, see "File format of the normalized data" on page 202.

The file contains an optional header # Rohde & Schwarz - Digital
Predistortion Normalized Table Data # PinMax [dBm] # number of
points # Vin/Vmax, deltaV/V, deltaPhase [deg], the values of the PinMax,
the number of the subsequent points and a list of comma-separated groups of three
values.

Example: Normalized data file content
# Rohde & Schwarz - Digital Predistortion Normalized Table Data
# PinMax [dBm]
# number of points
# Vin/Vmax, deltaV/V, deltaPhase [deg] 
10
4096
0,0,0
0.0002442,-0.00018246,0.28052
0.0004884,-0.00036487,0.28041
0.0007326,-0.00054723,0.2803
0.0009768,-0.00072954,0.28019
0.001221,-0.00091181,0.28008
0.0014652,-0.001094,0.27996
...

Predistortion function in raw data format

The predistortion values are defined directly, with a single remote control command:
● Define up to 4000 comma-separated value pairs, describing the absolute input

power Pin and the delta values for amplitude or phase (ΔPower and ΔPhase).
Example:
SOURce1:IQ:DPD:SHAPing:TABLe:AMAM:FILE:DATA -30.4,-5.2,
-25.1,-4.5, -18.5,-2.5, -10.5,-1
See:
– [:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMAM:FILE:DATA

on page 511
– [:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMPM:FILE:DATA

on page 511
– [:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMAM:FILE:NEW on page 510
– [:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMPM:FILE:NEW on page 510

● Define the absolute maximum input power Pinmax, the number of subsequent
points, and the normalized values Vin/Vmax, ΔV/V, ΔPhase [deg] as binary data.
See [:SOURce<hw>]:IQ:DPD:SHAPing:NORMalized:DATA on page 513.
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6.6.2.3  Finding out the correction values

If you know the properties of the used power amplifier, you can calculate suitable cor-
rection values.

We assume that the characteristics of a power amplifier have been measured and that
the left graphic in the following table shows the AM/AM curve of this amplifier.

Defining correction coefficients for an AM/AM predistortion
(example)

Resulting AM/AM predistortion function (example)

a = ideal characteristic; if the amplifier did not distort the signal,
the normalized magnitude would be a line

b = measured AM/AM curve; the normalized magnitude varies
as a function of input power

a = ideal characteristic

b = measured AM/AM curve

c = resulting AM/AM predistortion function, i.e. correction values
curve

d = ideal predistorted signal

The required correction coefficient ΔPower is the difference between the ideal and the
real normalized amplitude for one particular input power. To compensate for the nonli-
nearity and the deviation from the ideal line: select a negative correction value (-Δ) for
any input power where the real normalized amplitude is greater than the ideal one (1).
Logically, a positive correction value (+Δ) compensates for (i.e. boost) an amplitude
that is smaller than the ideal one (2).

Ideally, a signal predistorted with a suitable function (c) and then amplified by the par-
ticular PA would have a linear characteristic (a).

6.6.3  Digital predistortions AM/AM and AM/PM settings

You can add digital predistortion to the generated baseband signal and thus compen-
sate an amplitude and a phase distortion of the DUT, for example of the tested power
amplifier.
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Access:

► Select "I/Q Mod > Digital Predistortion > AM/AM AM/PM".

The dialog covers the settings for digital predistortion, like select and enabling an
AM/AM and/or AM/PM predistortion, select the way the predistortion function is
defined and specify the correction values.

The remote commands required to define these settings are described in Chap-
ter 10.14.14, "SOURce:IQ:DPD subsystem", on page 500.

Settings:

6.6.3.1  General settings

State............................................................................................................................204
Set to Default.............................................................................................................. 204
Save/Recall................................................................................................................. 205
AM/AM First................................................................................................................ 205
Level Reference.......................................................................................................... 205
Maximum Output Level Error...................................................................................... 205
Maximum Number of Iterations................................................................................... 205
Achieved Output Level Error....................................................................................... 206
Input/Output PEP, Level and Crest Factor.................................................................. 206
AM/AM and AM/PM State........................................................................................... 206

State
Enables/disables the generation of digital predistorted signals.
Remote command: 
[:SOURce<hw>]:IQ:DPD:STATe on page 503

Set to Default
Calls the default settings. The values of the main parameters are listed in the following
table.

Parameter Value

"State" Not affected by the "Set to Default"

"Level Reference" Before DPD
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Parameter Value

"AM/AM First" Off

"AM/PM, AM/AM" Off

Remote command: 
[:SOURce<hw>]:IQ:DPD:PRESet on page 503

Save/Recall
Accesses the "Save/Recall" dialog, that is the standard instrument function for saving
and recalling the complete dialog-related settings in a file. The provided navigation
possibilities in the dialog are self-explanatory.
The settings are saved in a file with predefined extension. You can define the filename
and the directory, in that you want to save the file.
Remote command: 
[:SOURce<hw>]:IQ:DPD:SETTing:CATalog? on page 503
[:SOURce<hw>]:IQ:DPD:SETTing:STORe on page 504
[:SOURce<hw>]:IQ:DPD:SETTing:LOAD on page 504
[:SOURce]:IQ:DPD:SETTing:DELete on page 504

AM/AM First
Toggles the order the AM/AM and AM/PM predistortions are applied.
Remote command: 
[:SOURce<hw>]:IQ:DPD:AMFirst on page 507

Level Reference
Switches between dynamic and static adaptation of the range the selected DPD is
applied on.
"Before DPD/After DPD"

Selects dynamic range calculation and defines whether the selected
"Level" value corresponds to the signal level before or after the pre-
distortion, see Chapter 6.6.2.1, "Defining the power level of the gen-
erated signal", on page 199.

"Static DPD" Selects static (constant) range limits. To adjust the range, use the
parameter Pre-Gain.

Remote command: 
[:SOURce<hw>]:IQ:DPD:LREFerence on page 507

Maximum Output Level Error
For "Level Reference > After DPD", sets the allowed maximum error, see Chap-
ter 6.6.2.1, "Defining the power level of the generated signal", on page 199.
Remote command: 
[:SOURce<hw>]:IQ:DPD:OUTPut:ERRor:MAX on page 508

Maximum Number of Iterations
For "Level Reference > After DPD", sets the maximum number of performed iterations
to achieving the required Maximum Output Level Error.
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See also Chapter 6.6.2.1, "Defining the power level of the generated signal",
on page 199.
Remote command: 
[:SOURce<hw>]:IQ:DPD:OUTPut:ERRor:MAX on page 508

Achieved Output Level Error
Displays the resulting level error, see Chapter 6.6.2.1, "Defining the power level of the
generated signal", on page 199.
Remote command: 
[:SOURce<hw>]:IQ:DPD:OUTPut:ERRor? on page 507

Input/Output PEP, Level and Crest Factor
Displays the calculated values the before and after the DPD.
A value of -1000 indicates that the calculation is impossible or there are no measure-
ments results available.
Remote command: 
[:SOURce<hw>]:IQ:DPD:INPut:PEP? on page 509
[:SOURce<hw>]:IQ:DPD:INPut:LEVel? on page 509
[:SOURce<hw>]:IQ:DPD:INPut:CFACtor? on page 509
[:SOURce<hw>]:IQ:DPD:OUTPut:PEP? on page 509
[:SOURce<hw>]:IQ:DPD:OUTPut:LEVel? on page 509
[:SOURce<hw>]:IQ:DPD:OUTPut:CFACtor? on page 509

AM/AM and AM/PM State
Enables/disables the AM/AM and AM/PM digital predistortion.
If both predistortions are enabled simultaneously, the instrument applies the AM/AM
predistortion first and compensates the phase error of the PA afterwards.
Compare the displayed signal processing chain.
Remote command: 
[:SOURce<hw>]:IQ:DPD:AMAM:STATe on page 504
[:SOURce<hw>]:IQ:DPD:AMPM:STATe on page 504

6.6.3.2  Predistortion settings

Access:

1. Select "I/Q Mod > Digital Predistortion > AM/AM AM/PM > Predistortion Settings".

Applying digital predistortion



Signal generator settingsR&S®SGT100A

207User Manual 1176.8674.02 ─ 12

2. Select a shaping function, for example the shaping file form Example"Shaping
table file content (*.dpd_magn file)" on page 201.

Figure 6-24: Predistortion Settings > From Table: Understanding the displayed information

1a = Normalized value of the current RF RMS power level
2a = Normalized value of the current PEP of the generated RF signal
1b, 2b = Correction values
White dashed line = Ideal zero correction function; no correction is necessary.
Yellow curve = Predistortion function
3a, 3b = Input Range (PEPin) From/To
4 = Positive correction coefficients to compensate values below the ideal ones
5 = Values greater than the PEPin Max are ignored.

The dialog covers the settings for digital predistortion, like select and enabling an
AM/AM and/or AM/PM predistortion, select the way the predistortion function is
defined and specify the correction values.

Settings:

Shaping....................................................................................................................... 207
Interpolation................................................................................................................ 208
Invert Correction Values..............................................................................................208
Input Range (PEPin) From/To......................................................................................209
Pre-Gain......................................................................................................................209
Shaping Table............................................................................................................. 209
Polynomial Coefficients...............................................................................................210
Normalized Data......................................................................................................... 210

Shaping
Selects the method to define the correction coefficients.
"From Table" As value pairs in form of a shaping table.

Select "AM/AM or AM/PM Shaping Table" to access the settings, see
Chapter 6.6.3.3, "Edit predistortion table settings", on page 210.
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"Polynomial" By a polynomial with configurable order and coefficients.
Select "Polynomial Coefficients" to access the settings, see Chap-
ter 6.6.3.4, "Polynomial coefficients settings", on page 211.

"Normalized" As a normalized data.
Select "Normalized Data" to access the settings, see Chapter 6.6.3.5,
"Normalized data settings", on page 214.

Remote command: 
[:SOURce<hw>]:IQ:DPD:SHAPing:MODE on page 510

Interpolation
For "Shaping > From Table/Normalized", enables a linear interpolation between limited
number of defined value pairs in the table, to prevent abrupt changes.
Table 6-10: Effect of parameter Interpolation

"Interpolation > Off" "Interpolation > Linear (Power)"

Remote command: 
[:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:INTerp on page 511

Invert Correction Values
Inverts the defined correction values.
Applies the exact invert predistortion coefficients without changing the defined predis-
tortion table.
This function is also useful to toggle between predistortions with corrections related to
the input power and to the output power.
Table 6-11: Effect of parameter Invert correction values

"Invert correction values > Off" "Invert correction values > On"
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Remote command: 
[:SOURce<hw>]:IQ:DPD:SHAPing[:TABLe]:INVert on page 511

Input Range (PEPin) From/To
Defines the minimum and maximum input power PEPin.

If you apply digital predistortion on signals used for power amplifier tests with envelope
tracking, set the PEPinMax value to the maximum value of the input power PEPin Max,
as required by the power amplifier (PA).
Remote command: 
[:SOURce<hw>]:IQ:DPD:PIN:MIN on page 509
[:SOURce<hw>]:IQ:DPD:PIN:MAX on page 509

Pre-Gain
For "General > Level Reference > Static DPD", sets a pre-gain (i.e. an attenuation) to
define the range the DPD is applied in. The pre-gain can be used to define and test
only a specific (required) part of the operating range.
For "General > Level Reference > Before/After DPD", the range is limited by the cur-
rent PEP of the signal.
See Figure 6-24.

1 = Pre-gain limits the effective range of the shaping function
2 = Values above this limit are ignored

Remote command: 
[:SOURce<hw>]:IQ:DPD:GAIN:PRE on page 509

Shaping Table
Accesses the standard "Predistortion Select" dialog with functions to define a new
shaping table file, select, or edit an existing one.
The shaping table files are files with predefined extension and file format, see "File for-
mat of the correction table file" on page 201.
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You can create a shaping table externally or internally.
"Select" Selects and loads an existing file.
"New" Creates a file.
"Edit" Access a standard built-in table editor, see Chapter 6.6.3.3, "Edit pre-

distortion table settings", on page 210.
Remote command: 
For AM/AM distortions:
[:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMAM:FILE:CATalog? on page 510
[:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMAM:FILE[:SELect] on page 510
For AM/PM distortions:
[:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMPM:FILE:CATalog? on page 510
[:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMPM:FILE[:SELect] on page 510

Polynomial Coefficients
For "Shaping > Polynomial", accesses a dialog to describe the predistortion function as
a polynomial function, see Chapter 6.6.3.4, "Polynomial coefficients settings",
on page 211.

Normalized Data
For "Shaping > Normalized", accesses a dialog to describe the predistortion function
as a normalized data, see Chapter 6.6.3.5, "Normalized data settings", on page 214.

6.6.3.3  Edit predistortion table settings

The predistortion table is an internal editor where you define the correction values,
ΔPower and ΔPhase, in form of a look-up table.

Access:

1. Select "I/Q Mod > Digital Predistortion > AM/AM AM/PM > Predistortion Settings".

2. Select "Shaping > From Table".

3. Select "AM/AM > Shaping Table > Predistortion AM/AM Shaping File > New"

4. Enter the "File Name", e.g. My_DPD_AM-AM

The "Predistortion AM/AM Shaping File" dialog closes.
The "Shaping Table > My_DPD_AM-AM" confirms that the newly created file is
assigned.

5. Select "Shaping Table > Predistortion AM/AM Shaping File > Edit"

6. Define the value pairs "Pin/dBm" and "ΔPower/dB". The order is uncritical.

7. Select "Save".

The instrument loads the configured values automatically and displays the function
of the delta correction values.

8. Select "Predistortion Settings > Interpolation > Linear".

The display confirms the used interpolation.
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Settings:

Pin (dBm), Delta Power (dB)/Pin (dBm), Delta Phase (deg)....................................... 211
Fill Table Automatically................................................................................................211
Goto, Edit, Save As, Save...........................................................................................211

Pin (dBm), Delta Power (dB)/Pin (dBm), Delta Phase (deg)
Sets the correction value pairs.
"Pin, ΔPower"

Value pairs for the AM/AM predistortion
"Pin, ΔPhase"

Value pairs for the AM/PM predistortion
Remote command: 
See [:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMAM:FILE[:SELect]
on page 510
and [:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMPM:FILE[:SELect]
on page 510

Fill Table Automatically
Standard function for filling a table automatically with user-defined values.
"From / Range"

Defines the start line and number of the rows to be filled.
"Select Column to Fill"

Selects the respective value, including the unit.
"Start / End Value"

Default values corresponding to the selected column.
"Increment" Determines the step size.
"Fill" Fills the table.

Fill both columns and then save the list. Otherwise the entries are
lost.

Goto, Edit, Save As, Save
Standard functions for editing of data lists.
Changed and unsaved values are displayed on a yellow background.
Remote command: 
n.a.

6.6.3.4  Polynomial coefficients settings

Alternatively to the look-up table, you can define the predistortion functions as a poly-
nomial function. The R&S SGT calculates the AM/AM and AM/PM predistortion func-
tions and the required correction coefficients out of the defined polynomial.

To access the polynomial coefficients setting and define a higher-order polyno-
mial

1. Select "I/Q Mod > Digital Predistortion > AM/AM AM/PM > Predistortion Settings".
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2. Select "Shaping > Polynomial".

3. Select "AM/PM > Polynomial Coefficients".

Figure 6-25: Polynomial Coefficients: Understanding the displayed information

n = Polynomial order
a0, b0, ... = Polynomial coefficients
1 = Ideal AM/AM function (the normalized amplitude is a line).
2 = Resulting AM/AM predistortion function, calculated as AM/AM(x) = abs[PDPD(x)]
3 = Ideal AM/PM function (constant phase at 0 degrees)
4 = Resulting AM/PM predistortion function, calculated as AM/PM(x) = tan-1{Im[PDPD(x)]/

Re[PDPD(x)]}

With the provided settings, you can define a polynomial function with up to 10th

order to describe the predistortion function.
The graphical display updates on-the-fly and visualizes the resulting AM/AM and
AM/PM functions.

4. Select "Polynomial Order = 4" (n = 4).

5. Set the polynomial coefficients a0 to b4.

6. Select "Apply".

The instrument loads the configured values, calculates the correction values, and
displays the predistortion functions.
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Figure 6-26: Predistortion Settings > Polynomial: Understanding the displayed information

1a = Normalized value of the current RF RMS power level
2a = Normalized value of the current PEP of the generated RF signal
1b, 2b = Correction values
White dashed line = Ideal zero function; no correction is necessary.
AM/AM yellow curve = AM/AM correction values, calculated as ΔAM/AM(x) = AM/AM(x) - x
AM/PM yellow curve = AM/PM correction values, calculated as ΔAM/PM(x) = AM/PM(x)
3a, 3b = X-axis scale, calculated from the Input Range (PEPin) From/To
4 = Negative correction coefficients
5 = Values greater than the PEPin Max are ignored.

7. To store the defined predistortion function:

a) Select "Save/Recall Polynomial"
b) Navigate throughout the file system.
c) Enter a "File Name", e.g. MyPolynomial_4thOrder
d) Select "OK".

8. Select "Polynomial Coefficients > OK" to close the dialog.

Settings:

Save/Recall Polynomial.............................................................................................. 213
System Coordinates....................................................................................................214
Polynomial Order........................................................................................................ 214
Apply, OK.................................................................................................................... 214
Polynomial coefficients................................................................................................214

Save/Recall Polynomial
Accesses the "Save/Recall" dialog, that is the standard instrument function for saving
and recalling the complete dialog-related settings in a file. The provided navigation
possibilities in the dialog are self-explanatory.
The settings are saved in a file with predefined extension. You can define the filename
and the directory, in that you want to save the file.
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The polynomial files are files with extension *.dpd_poly, see "File format of the poly-
nomial file" on page 200. The polynomial function is stored in Cartesian format.
Remote command: 
[:SOURce<hw>]:IQ:DPD:SHAPing:POLYnomial:COEFficients:CATalog?
on page 512
[:SOURce<hw>]:IQ:DPD:SHAPing:POLYnomial:COEFficients:LOAD
on page 512
[:SOURce<hw>]:IQ:DPD:SHAPing:POLYnomial:COEFficients:STORe
on page 513

System Coordinates
Defines whether the polynomial function is defined in Cylindrical (Polar) or in Cartesian
coordinates.
Remote command: 
n.a.

Polynomial Order
Defines the polynomial order n, that is the number of polynomial coefficients (see "Pol-
ynomial function" on page 200).
The polynomial order defines the degree, complexity, and the number of terms in the
polynomial function.
Remote command: 
See [:SOURce<hw>]:IQ:DPD:SHAPing:POLYnomial:COEFficients
on page 511.

Apply, OK
Triggers the instrument to adopt the selected function.
Use "OK" to apply the setting and exits the dialog.
Remote command: 
[:SOURce<hw>]:IQ:DPD:SHAPing:POLYnomial:COEFficients on page 511

Polynomial coefficients
Sets the polynomial coefficients a0 to an and b0 to bn.

In "System Coordinates > Cylindrical", the polynomial coefficients b0 to bn are
expressed in degrees.
The polynomial coefficients influence the shape of the predistortion function.
Select "Apply" to confirm the settings.
Remote command: 
See "Apply, OK" on page 214.

6.6.3.5  Normalized data settings

The normalized data table is an internal editor where you define the correction values,
Vin/Vmax, ΔV/V and ΔPhase, in form of a table.
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To access the internal editor

1. Select "I/Q Mod > Digital Predistortion > AM/AM AM/PM > Predistortion Settings".

2. Select "Shaping > Normalized Data".

3. Select "Normalized Data".

4. Enter the Pinmax.
Note: Enter the correction values in the required order. The value range of the sub-
sequent correction values adjusts automatically.

5. To store the setting in a file, select "Save/Recall Normalized Data > Save".
Enter a "File Name", e.g. My_DPD_Normalized.

Settings:

Save/Recall Normalized Data..................................................................................... 215
PinMax.......................................................................................................................... 216
Vin/Vmax, Delta V/V, Delta Phase (deg)..................................................................... 216
Apply, OK.................................................................................................................... 216

Save/Recall Normalized Data
Accesses the "Save/Recall" dialog, that is the standard instrument function for saving
and recalling the complete dialog-related settings in a file. The provided navigation
possibilities in the dialog are self-explanatory.
The settings are saved in a file with predefined extension. You can define the filename
and the directory, in that you want to save the file.
The normalized data files are files with extension *.dpd_norm, see "File format of the
normalized data" on page 202.
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Remote command: 
[:SOURce<hw>]:IQ:DPD:SHAPing:NORMalized:DATA:CATalog? on page 514
[:SOURce<hw>]:IQ:DPD:SHAPing:NORMalized:DATA:LOAD on page 514
[:SOURce<hw>]:IQ:DPD:SHAPing:NORMalized:DATA:STORe on page 514

PinMax

Sets the value of the maximum input power level.
Pinmax corresponds to a normalized input power of 1, that is the max. allowed value on
the x-axis.
Select "Apply" to confirm the settings.
Remote command: 
n.a.

Vin/Vmax, Delta V/V, Delta Phase (deg)
Sets the correction as a group of three values.
Select "Apply" to confirm the settings.
Remote command: 
See "Apply, OK" on page 216.

Apply, OK
Triggers the instrument to adopt the normalized data.
Use "OK" to apply the setting and exits the dialog.
Remote command: 
[:SOURce<hw>]:IQ:DPD:SHAPing:NORMalized:DATA on page 513

6.7  RF settings

6.7.1  Overview of RF signal

Settings for the RF output signal and analog modulation are made under "RF Signal"
and "Analog Modulations". These settings can be accessed in the block diagram by the
"RF" function block, or by the dialog with the same name which is opened through
"SGMA-GUI > Instrument Name > RF".

The function block is available for the basic unit R&S SGT without any additional
equipment options.

RF settings



Signal generator settingsR&S®SGT100A

217User Manual 1176.8674.02 ─ 12

RF On/Off
Activates and deactivates the RF output signal.
The current state of the RF output (activated and deactivated) is indicated in the main
panel by the different block color (blue or grey) and the status "On/Off".
Remote command: 
:OUTPut[:STATe] on page 374

6.7.2  Operation mode

You can operate the R&S SGT in two modes, normal mode and baseband bypass
mode. In baseband bypass mode, an external IF signal fed in at the [I] or [Q] connec-
tors is directly routed to the [RF OUT] connector. The level of the signal can be adjus-
ted.

► To access the "Operation Mode" dialog, select "SGMA-GUI > Instrument Name >
RF > Operation Mode".

Operation Mode
Sets the operation mode.
"Normal" The complete signal processing chain is used.
"Baseband Bypass"

The IF signal fed in at the "I" or "Q" connectors is directly routed to
the "RF OUT" connector.

Remote command: 
[:SOURce]:OPMode on page 391

6.7.3  Frequency / phase

The frequency and phase-related settings are provided in the "Frequency/Phase" dia-
log.

► To access this dialog, select "SGMA-GUI > Instrument Name > RF > Frequency/
Phase".
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Configuring the RF frequency

1. To change the RF frequency of the selected instrument, perform one of the follow-
ing:

a) To set the frequency at the RF output, select "SGMA-GUI > Instrument Name >
Frequency/Phase > Frequency".

b) To set the frequency, select "SGMA-GUI main panel > Freq".
If configured, the frequency value includes a frequency offset.

2. To enable frequency offset, for example, to consider the frequency shift of a down-
stream instrument, set the parameter "Frequency/Phase > Offset".

Changes of the RF frequency have an immediate effect on the output signal.

Frequency
Sets the RF frequency at the RF output connector of the selected instrument.
The displayed value does not consider an enabled frequency offset (Offset).
Remote command: 
See [:SOURce]:FREQuency[:CW|FIXed] on page 390

Offset
Sets a frequency offset.
The frequency offset value represents the frequency shift of a downstream instrument,
as, for example, an attenuator or an amplifier.
Enabled frequency offset does not change the frequency at the RF output (Frequency).
It influences the value of the parameter "SGMA-GUI main panel > Freq".
The following applies:
"Freq" = Frequency + "Offset"
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In the "SGMA-GUI main panel", enabled frequency offset is also indicated with the key-
word "Freq (Offs)".
Remote command: 
[:SOURce]:FREQuency:OFFSet on page 390

Delta Phase
Sets the phase of the RF signal. The current phase of the signal is used as the refer-
ence. This function allows, for example, the phase of the output signal to be synchron-
ized with the phase of a signal from a second signal generator.
Remote command: 
[:SOURce]:PHASe on page 515

Reset Delta Phase Display
Resets delta phase value. The set phase is adopted as the new current phase, i.e. the
delta phase value is reset to 0.
Remote command: 
[:SOURce]:PHASe:REFerence on page 515

6.7.4  Local oscillator (LO) coupling

The LO coupling function allows you to distribute the local oscillator signal. The signal
is distributed in a way that multiple R&S SGTs or other R&S signal generators can be
driven by the same LO signal.

A precise synchronization to the same LO signal is mandatory for phase coherent
application, e.g. the generation of beamformed signals, and for phase coherent
demodulation.

The LO coupling function is available only for instruments equipped with the option
R&S SGT-K90 (phase coherence). This option enables phase coherent RF outputs of
two or more RF signals. The local oscillator signal is provided at the REF/LO OUT con-
nector. An external signal can be input at the REF/LO IN connector.

6.7.4.1  Phase coherence

Phase coherence of RF signals designates a defined, constant delta phase between
two or more RF carrier signals with the same frequency or a multiple of the frequency.
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If two signal generators are coupled via their 10 MHz reference, they are generating
the same frequency but only in the long-term perspective. Having a closer look into the
instantaneous differential phase (“delta phase”) of the two RF signals, the phase of the
signals are instable due to:
● Phase noise of the two synthesizers
● “Weak” coupling at 10 MHz and a long synthesis chain up to the RF domain
● Temperature differences which cause slightly different phase drifts for the different

synthesizers

Most critical for a stable delta phase is the thermal RF phase fluctuation between multi-
ple RF synthesizers. These fluctuations can be minimized by using a common synthe-
sizer (common local oscillator (LO) signal) for all RF carriers.

6.7.4.2  Local oscillator (LO) coupling settings

The LO coupling settings are provided in the "Frequency/Phase" dialog.

► To access this dialog, select "SGMA-GUI > Instrument Name > Frequency/Phase >
Local Oscillator (LO) Coupling".

Source
Selects the source of the local oscillator signal.
"Int" The instrument uses the built-in local oscillator.
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"Ext" The signal fed-in at the [REF/LO IN] input connector is used as signal
source.

An icon in the block diagram indicates that an external LO source is
used.

Note: The local oscillator input/output requires the additional software
option R&S SGT-K90.

Remote command: 
[:SOURce]:LOSCillator:SOURce on page 391

REF/LO Output
Determines the signal provided at the output connector [REF/LO OUT].
"OFF" No signal is provided.
"LO" The signal of the local oscillator (LO) is available at the [REF/LO

OUT] connector.
"REF" The signal of the reference oscillator is available at the [REF/LO

OUT] connector.
Remote command: 
:CONNector:REFLo:OUTPut on page 359

6.7.5  Reference oscillator

The R&S SGT is equipped with an internal TXCO reference oscillator. If equipped with
the additional HW option R&S SGT-B1, an OXCO can be used as an internal reference
frequency source for the synthesizer. Moreover, an external reference signal source
can be connected to the REF/LO IN connector of the instrument.

► To access this dialog, select "SGMA-GUI > Instrument Name > RF > Reference
Oscillator".
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Ref. Oscillator Source/Ext Ref On/Off
Determines whether the internal built-in oscillator (TXCO or OXCO) is used as a refer-
ence source or if an external reference is used.
The internal reference oscillator OCXO requires the additional option R&S SGT-B1.
To feed in an external instrument reference, use the input connector "REF/LO IN". To
output the reference frequency at the output "REF/LO OUT", select "SGMA-GUI >
Instrument Name > RF > Ref. Oscillator > REF/LO Output > REF".
"Int" The internal reference signal of 10 MHz is used.
"Ext" An external reference signal is used. The frequency of the external

reference signal must be selected with the parameter "SGMA-GUI >
Instrument Name > RF > Ref. Oscillator > Ex. Ref. Input Frequency".

Remote command: 
[:SOURce]:ROSCillator:SOURce on page 527

Ext. Ref. Input Frequency
Available only for "Source > Ext".
Selects the frequency of the external reference signal.
Remote command: 
[:SOURce]:ROSCillator:EXTernal:FREQuency on page 527

Synchronization Bandwidth
Available only for "Source > Ext".
Selects the synchronization bandwidth for an external reference signal. The wideband
setting is provided for using good reference sources of high spectral purity.
"Wide" Synchronization bandwidth is app. 250 Hz.
"Narrow" Synchronization bandwidth is app. 40 Hz.
Remote command: 
[:SOURce]:ROSCillator:EXTernal:SBANdwidth on page 528

Output Frequency
Selects the output for the reference oscillator signal. The available values depend on
the input frequency and the reference oscillator source.
Table 6-12: Output frequency

Reference oscillator source Input frequency Output frequency

"Internal" 10 MHz 10 MHz

1 GHz

"External" 10 MHz

13 MHz

100 MHz

1 GHz

10 MHz, 1 GHz

13 MHz, 1 GHz

100 MHz, 1 GHz

1 GHz

Support of 13 MHz reference frequency requires that the instrument is equipped with
hardware module RF board with part number 1419.5308.02.
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To find out the RF board installed in the instrument:
● Select "SGMA-GUI > instrument name > Setup > Hardware Config" > "RF Assem-

bly"
● Observe the part number of the assembly "RfBoard".
Remote command: 
[:SOURce]:ROSCillator:OUTPut:FREQuency on page 528

REF/LO Output
Determines the signal provided at the output connector [REF/LO OUT].
"OFF" No signal is provided.
"LO" The signal of the local oscillator (LO) is available at the [REF/LO

OUT] connector.
"REF" The signal of the reference oscillator is available at the [REF/LO

OUT] connector.
Remote command: 
:CONNector:REFLo:OUTPut on page 359

Active Adjustment Data
Displays whether the factory or user defined (custom) calibration value is used for the
external calibration of the reference oscillator.
Adjusting the calibration value for the OCXO adjustments is a protected service proce-
dure, that requires a "Protection Level 2" password.

Adjustment Active
Available only for "Source > Int".
Selects adjustment mode.
"Off" Uses the calibrated internal reference frequency. This value is deter-

mined at one of the R&S service centers during calibration.
"On" A user-defined adjustment value is used. The value is entered under

DAC Value.
A user-defined value allows the frequency to be impaired freely, for
example, to simulate a frequency error.
The instrument is no longer in the calibrated state. However, the cali-
bration value is not changed and the instrument resumes the calibra-
ted state after disabling the adjustment.

Remote command: 
[:SOURce]:ROSCillator[:INTernal]:ADJust[:STATe] on page 528

DAC Value
Enters a user-defined adjustment value for the internal reference frequency. This value
is not used unless "Adjustment Active > On" is selected. "0" represents the calibrated
state. The setting range depends on the reference oscillator type and its factory cali-
bration value.
Remote command: 
[:SOURce]:ROSCillator[:INTernal]:ADJust:VALue on page 529
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6.7.6  RF level settings

This section explains the level settings of the R&S SGT.

Configuring RF level

► To change the RF level of the selected instrument, perform one of the following:

a) Select "SGMA-GUI main panel > Level".
b) Enter the desired value.
c) Select "SGMA-GUI > Instrument Name > RF > Level Settings > RF Level >

Level"
d) Enter the desired value.

Changes of the RF level have an immediate effect on the output signal.

6.7.6.1  RF level settings

► To access the RF level settings, select "SGMA-GUI > Instrument Name > RF >
Level > RF Level".

This dialog comprises settings like the RF level and level limit.

Level/Level Offset
Sets the RF level at the RF output connector of the selected instrument.
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If you set a digital attenuation, while "I/ Q Mod > Modulation Source > Internal Base-
band" and "I/ Q Mod > Modulation State > ON", it will be indicated in the R&S SGMA-
GUI main panel by a change in the name of this parameter from "Level" to "Level Off-
set".

Note: The SCPI command [:SOURce]:POWer[:LEVel][:IMMediate][:
AMPLitude] sets the level of the "Level" display, that means the level containing off-
set while [:SOURce]:POWer:POWer sets the level at the RF output connector.

Remote command: 
[:SOURce]:POWer[:LEVel][:IMMediate][:AMPLitude] on page 526
[:SOURce]:POWer:POWer on page 523

Digital Attenuation
Available only for "I/Q Mod > State > On" and "I/Q Mod > Source > Internal Baseband".
Attenuates the level of the internal, digitally modulated I/Q baseband signals, and thus
the level of the RF signal accordingly.
The function allows fast level changes of the internal I/Q signals, but it has no effect on
externally provided I/Q signals.
Note: If you specify a digital attenuation value, the R&S SGT still shows the level as
set with "Level/Level Offset" on page 68. That is, the calculated signal level is not dis-
played, but the level at the RF signal output is higher or lower according to the digital
attenuation.
Remote command: 
[:SOURce]:POWer:ATTenuation:DIGital on page 521

Offset / Offset (Gain)
Sets an RF level offset.
"Offset" Sets an RF level offset.

This offset value represents the level shift of a downstream instru-
ment, as, for example, an attenuator or an amplifier, and is indicated
in the status bar of the display. It does not change the level at the RF
output.

"Offset (Gain)" For a power servoing test, sets the expected level offset, i.e. the gain
of the DUT.
After completion of a power servoing procedure this field shows the
actual gain of the DUT. Setting the "Offset (Gain)" close to the true
value of the DUT speeds up the procedure.
The setting is also applied to the level offset configured in "Offset /
Offset (Gain)" on page 225.

Remote command: 
[:SOURce]:POWer[:LEVel][:IMMediate]:OFFSet on page 526
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Mode
Allows you to optimize the RF output signal for applications, where improved harmonic
distortion or improved wideband noise is required.
"Normal" In normal mode, the generator provides an RF output signal with high

signal to noise ratio and low distortion, according to the data sheet.
"Low Noise" The setting forces the generator to continue optimizing the signal to

noise ratio.
"Low Distortion"

In this mode, the generator reduces distortions of the RF signal to a
minimum.

Remote command: 
[:SOURce]:POWer:LMODe on page 522

Setting Characteristic
Selects the characteristic for the level setting. For some general applications, the
instrument operation can be optimized by selecting one of the predefined level setting
characteristics.
"Auto" The instrument provides the highest dynamic range and the fastest

setting times according to the data sheet.
The RF signal is shortly blanked during the moment that the step
attenuator is switched on.

"Uninterrupted Level setting"
Suppresses level blanking at frequency and level changes.
This mode reduces the dynamic range of the instrument. The step
attenuator is fixed.

"Strictly Monotone"
Provides level setting without discontinuities. All electronic switches in
the RF path are clamped. The operation mode is useful for applica-
tions using level-searching algorithms.
This mode further reduces the dynamic range of the instrument. The
step attenuator is also fixed.

"Constant-VSWR"
Suppresses output impedance variations at the [RF Out] connector
due to changed level setting.
This mode reduces the dynamic range of the instrument. The step
attenuator is fixed.

Remote command: 
[:SOURce]:POWer:SCHaracteristic on page 523

Level Range
Displays the level range. Within this range, the level settings work properly. The range
limits depend on level mode, setting characteristic, crest factor of the I/Q signal and
other parameters.
Remote command: 
[:SOURce]:POWer:RANGe:LOWer? on page 526
[:SOURce]:POWer:RANGe:UPPer? on page 526
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Limit
Sets the level limit.
The value specifies the upper limit of the level at the [RF Out] connector. A message
appears if an attempt is made to set a level above this limit and the level at the RF out-
put is confined to the upper limit. However, the level indication is not influenced.
Remote command: 
[:SOURce]:POWer:LIMit[:AMPLitude] on page 522

Readjust
Recalculates the instrument internal settings optimized for the current level. Not
required for automatic modes.
Remote command: 
[:SOURce]:POWer:ALC:SONCe on page 521

6.7.6.2  Attenuator

Access:

► Select "SGMA-GUI > Instrument Name > RF > Level > Attenuator".

This dialog comprises the settings for the power-on behavior of the instrument.

Mode
Sets the attenuator mode at the RF output.
"Auto" Standard mode.

The electronically switching attenuator switches with a ~ 6 dB step
width at optimized switching points. The entire level range is availa-
ble.
The level setting is performed by continuous electronic level control
combined with switching the step attenuator.
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"Fixed" The level settings are made without switching the attenuator.
When this operating mode is switched on, the attenuator is fixed in
the current position to provide level settings without interruption. The
resulting variation range is defined and displayed with the parameters
Level Range.
Note: The function is effective when automatic level control is activa-
ted ("ALC State = On").
If the normal variation range is overranged or underranged, level
errors increase considerably. The warning "Level under/overrange"
appears in the info line.
The spectral purity of the output signal decreases with high attenua-
tion.

"Auto Passive" The attenuator is switched automatically.
The level settings are made only for the passive reference circuits.
The high-level ranges are not available.

Remote command: 
:OUTPut:AMODe on page 373

SATT Switch-Over Offset
Sets the switch-over offset value of the attenuator.
Remote command: 
[:SOURce]:POWer:ATTenuation:SOVer[:OFFSet] on page 522

Level Range
Displays the level range in which the level is set without interruption for the "Attenuator
Mode Fixed" setting.
Remote command: 
:OUTPut:AFIXed:RANGe:LOWer? on page 373
:OUTPut:AFIXed:RANGe:UPPer? on page 373

RF-Off-Mode
Determines the attenuator's state after the instrument is switched off.
In default setting, the electronic step attenuator switches to highest attenuation when
RF is off. By setting the RF-Off mode, the electronic step attenuator can be fixed to
keep the output impedance constant during RF off.
Remote command: 
[:SOURce]:POWer:ATTenuation:RFOFf:MODE on page 522
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6.7.6.3  Power-On settings

Access:

► Select "SGMA-GUI > Instrument Name > RF > Level > Power-On/EMF".

This dialog comprises the settings for the power-on behavior of the instrument.

Power-On State
Selects the state which the RF output takes after the instrument is switched on.
"RF Off" The output is deactivated when the instrument is switched on.
"Previous Setting"

When the instrument is switched on, the output takes the same state
as it had when the instrument was switched off.

Remote command: 
:OUTPut[:STATe]:PON on page 374

6.7.6.4  ALC

Access:

► Select "SGMA-GUI > Instrument Name > RF > Level > ALC".

Automatic level control can be used with almost all applications, especially I/Q
modulation. Deactivate the function for certain settings in the baseband and when
I/Q impairments ("Impairments State On") are activated. Indication is visualized
under the respective function.
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By default, the instrument operates in "Table & On" mode to provide the highest
level accuracy and fastest setting time. Level control can be switched to "Off
(Table)" or "On" for particular applications. The "Off (Table)" state (level control Off)
is recommended if in CW mode the signal/intermodulation ratio is to be improved
for multi-transmitter measurements.

State
Sets the internal level control.
"Table & On" Default mode.

First sets the level to the target value using the internal level table.
Then activates the level control circuit to achieve maximum level
accuracy.

"On" Internal level control is permanently activated.
If "On" and "Attenuator Mode Fixed" is selected, the level is recalibra-
ted for every level and frequency setting.

"Off (Table)" Internal level control is performed according to the ALC table.
Remote command: 
[:SOURce]:POWer:ALC[:STATe] on page 521

Detector Sensitivity
Allows you to fix the internal level detector. Use the Auto mode (default).
"Auto" Automatic detector selection. Recommended mode of operation.
"Low" Low sensitivity detector selected.

This setting is intended for signals with high internal electronic levels.
"Med" Medium sensitivity detector selected.

This setting corresponds to normal mode. It is intended for signals
with medium internal electronic levels.

"High" High sensitivity detector selected.
Selects the detector path with high sensitivity, intended for signals
with low internal electronic levels.

"Fix" Fixes the last set sensitivity setting.
Remote command: 
[:SOURce]:POWer:ALC:DSENsitivity on page 521

6.7.6.5  User correction settings

Access:

► Select "SGMA-GUI > Instrument Name > RF > Level > UCOR".
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The "User Correction" function is used to create and activate lists in which level correc-
tion values predefined by the user are freely assigned to RF frequencies. Correction is
performed by the user-defined table values being added to the output level for the
respective RF frequency.

With frequencies which are not contained in the list, the level correction is determined
by interpolation of the closest correction values.

The lists are created in the "List Editor". Each list is stored in its own file with the prede-
fined file extension *. uco. The name of the "User Correction" file can be freely
selected. The files are loaded from the "Lists..." file manager. Externally created tables
with pairs of frequency and level values can be converted into "User Correction" files
using the import function. The external files must have the file extension *.txt or
*.csv. These file formats are provided, e.g., by the Microsoft Excel program. The sep-
arators for table columns and for decimal floating-point numerals can be set. In addi-
tion, internally created "User Correction" data can be exported into ASCII files using
the export function.

If user correction is activated, the "UCOR" display ("User Correction") is shown in the
header together with the "Level" display. The RF output level is the sum of both values.

"Level" + "UCOR" = Output level

If activated, user correction is effective in all operating modes.

State
Activates/deactivates user correction.
Remote command: 
[:SOURce<hw>]:CORRection[:STATe] on page 477

User Correction
Indicates the current value for level correction.
Remote command: 
[:SOURce<hw>]:CORRection:VALue? on page 477
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User Cor. Data - User Correction
Calls the "File Select" menu for selecting and creating a list or the "File Manager".

Remote command: 
[:SOURce]:CORRection:CSET:DELete on page 472
[:SOURce<hw>]:CORRection:CSET[:SELect] on page 476

Edit User Cor. Data
Calls the editor for editing the selected user correction list.
A list consists of any number of frequency/level value pairs. The currently selected list
is displayed.
Each list is saved as a separate file with extension *.uco. The file name and the direc-
tory to which the file is saved are user-selectable. For example, Figure 6-27 displays
user correction data for the file ucor.uco.

Note: Save list only after filling both columns (frequency and level), otherwise the
entries are lost.

Figure 6-27: User correction data for file ucor.uco

"Frequency /Hz"
Enters the frequency to which the level correction value applies.
Note: The "Fill..." function allows you to automatically enter any num-
ber of frequencies with freely selectable range and increment.
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"Power/dB" Enters the level correction value to which the specified frequency
applies.

"Goto" Selects row for editing.

If "Goto Row" is selected, a window opens for entering the requested
row.

"Edit" Calls a selection of possible actions described below.

"Insert Range" Insert new rows before the marked row. The number of rows to be
inserted can be defined in an entry window.

"Insert Row" Insert a new row before the marked row.
"Fill...." Opens a sub menu for defining a set of list values to be automatically

entered in the ucor list, see Filling the correction list automatically).
"Fill with sensor..."

Opens a dialog to configure the settings for automatic filling of user
correction data with an R&S NRP power sensor, see Chapter 6.7.6.7,
"Fill with sensor", on page 237.

"Delete Row" Deletes the marked row.
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"Delete Range..."
Allows you to delete any number of rows starting with the marked
row. The number of rows to be deleted can be defined in an entry
window.

"Save as" Open the file menu to save the list under a new name.
Note: Save list only after filling both columns (frequency and level),
otherwise the entries are lost.
Each list is saved to the R&S SGT hard disk as a separate file with
the file prefix *.uco. The file name and the directory to which the file
is saved are user-selectable.

"Save" The list is saved under its current name.
Remote command: 
[:SOURce<hw>]:CORRection:CSET[:SELect] on page 476
[:SOURce<hw>]:CORRection:CSET:DATA:FREQuency on page 470
[:SOURce<hw>]:CORRection:CSET:DATA:POWer on page 471

Import/Export >>>
Expands the menu with the area for import and export of user correction files.
Externally edited Excel tables with any number of frequency/level value pairs can be
imported as text or *.csv files and used for user correction.

Conversely, you can also export internally created user correction lists as text or
*.csv files.

Mode - User Correction
Selects if user correction lists are imported or exported. The settings offered depend
on the selected mode.
Remote command: 
[:SOURce<hw>]:CORRection:DEXChange:MODE on page 475

Extension
Selects the file extension of the ASCII file to be imported or exported. Selection "TXT"
(text file) or "CSV" (Excel file) is available.
Remote command: 
[:SOURce<hw>]:CORRection:DEXChange:AFILe:EXTension on page 473

Decimal Point
Selects the decimal separator used in the ASCII data between '.' (decimal point) and ','
(comma) with floating-point numerals.
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Remote command: 
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:DECimal
on page 474

Column Separator
Selects the separator between the frequency and level column of the ASCII table that
the user correction list is exported to or imported from.
Remote command: 
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:COLumn
on page 474

Select ASCII Source/Destination
Calls the "File Manager" for selecting the ASCII file to be imported into a user correc-
tion list (source) or the ASCII file the user correction list is exported (destination) in.
Remote command: 
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SELect on page 473

Select Destination/Source
Calls the "File Manager" for selecting the user correction list to be exported (source)
into an ASCII file or the destination for the ASCII file to be imported (destination) in.
Remote command: 
[:SOURce<hw>]:CORRection:DEXChange:SELect on page 476

Import/Export
Starts the export or import of the selected file.
When import is selected, the ASCII file is imported as user correction list.
When export is selected, the user correction list is exported into the selected ASCII file.
Remote command: 
[:SOURce<hw>]:CORRection:DEXChange:EXECute on page 475

6.7.6.6  Filling the correction list automatically

The "Fill Table" menu enables you to set the level correction values automatically.
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The start line and the number of rows to be filled are defined under "From" and
"Range".

The column to be filled is selected under "Select column to fill". Depending on the
selection here, the default for start, end, and increment value are set. As the settings
are interdependent, a change of one parameter can result in the automatic change of
one or more of the other parameters. The filling of the column with the selected value
settings is started with button "Fill".

The correction list entries are only computed when the "Fill" button is pressed.

From
Sets the start value of the index range.
Remote command: 
n.a.

Range
Sets the range for filling the table.
Remote command: 
n.a.

Select column to fill
Selects either the frequency or the level column to be filled with the value defined
below.
Remote command: 
n.a.

Start value
Sets the start value for the frequency or the level entries.
Remote command: 
n.a.

End value
Displays the end value for the frequency or the level entries.
Remote command: 
n.a.

Increment value
Sets the increment for the frequency or the level entries.
Remote command: 
n.a.

Fill
Fills the selected column in the set range with values, starting with the start value and
using the set increment.
Remote command: 
n.a.
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6.7.6.7  Fill with sensor

► To access this dialog, select "SGMA-GUI > Instrument Name > Level > UCOR >
Edit User Cor. Data> Fill With Sensor".

This dialog describes all parameters for filling a table automatically with sensor
readings.

Since the settings are interdependent, the affected parameters change accordingly if
you set a value.
To fill the table, press the "Execute" button.
To select the sensor and determine its parameters, refer to Chapter 6.7.7.2, "NRP
power viewer", on page 245.

Fill User Correction Data with Sensor
● "Sensor"

Displays connected sensors for selection.
● "List To Fill"

Indicates the used list.
● "Include Zeroing"

Performs a zeroing procedure before acquiring the user correction data to improve
precision. Since during zeroing no signal can be applied to the sensor, RF is tem-
porarily switched off at the generator.
When unchecked, the zeroing procedure is skipped. However, the RF signal level
can be blanked shortly. This setting is recommended if blanking of RF is undesira-
ble or the absence of power at the sensor cannot be guaranteed.

● "Execute"
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The "Execute" button is only enabled if a sensor is detected and the user correction list
contains at least one frequency value.
Remote command: 
[:SOURce<hw>]:CORRection:ZERoing:STATe on page 477
[:SOURce<hw>]:CORRection:CSET:DATA[:SENSor<ch>][:POWer]:SONCe
on page 472

Used Instrument Settings For Measurement
Displays the settings relevant for the measurement.
"Modulation" Indicates the modulation state
"Amplitude" Shows the currently set level.
"Use SParameter"

Indicates whether SParameter correction is used.
"Attenuator Mode"

Displays the selected mode of the attenuator.
"Fixed range (PEP) In"

Shows the level range.
Remote command: 
n.a.

6.7.6.8  Power servoing

Access:

► Select "SGMA-GUI > Instrument Name > RF > Level > Power Servoing".

The tab provides settings to configure power servoing.
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About power servoing

Component tests are complicated by the fact that they can be defined as a function of
the DUT output power, e.g. a power amplifier. To the test engineer, this dependency
poses a problem because the DUT gain is not necessarily:
● Known beforehand
● Constant over the input power
● Constant over time or temperature

By using the R&S SGT / R&S NRQ6 power servoing and the high-speed remote con-
trol of the R&S SGT, setting the desired power typically takes 1 ms to 1.5 ms. The
function is much faster than using a traditional SCPI based control loop.

To achieve short setting periods:
● The power sensor measures continuously and sends results using a dedicated

serial connection to the signal generator - direct field-programmable gate array
(FPGA) to FPGA communication, no SCPI overhead.

● The control algorithm runs on the signal generator - again, no SCPI overhead. The
application only needs to set the desired level in one command.

Test setup

Required equipment:
● R&S SGT
● R&S NRQ6 power sensor with power servoing option R&S NRQ6-K2
● Computer equipped with the R&S SGMA-GUI software for control of the R&S SGT
● DUT
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In Figure 6-28, the test setup also comprises an optional spectrum analyzer and a
power splitter for additional power measurements. For more information, see the appli-
cation sheet.

NRQ
6Frequency Selective Power Sensor

LAN PoE+

Host
Interface

Sample Clock I/O (Default: 
120 MHz)

LO I/
0

1 2 4 5 6 7

10

3 8

9

11

Figure 6-28: Test setup

1 = R&S SGT
2 = LAN interface
3 = USER 2 connector
4 = RF 50 Ω connector
5 = DUT
6 = RF connector
7 = R&S NRQ6 power sensor
8 = LAN PoE+ interface
9 = "TRIG2" connector at the power sensor
10 = Ethernet switch supporting PoE+ power delivery, for example.
11 = Computer

To prepare the R&S SGT for power servoing

1. Connect the instruments as in Figure 6-28.

2. Using the "NRP Sensor Mapping" dialog, detect the power sensor connected at the
R&S SGT.
See Chapter 6.7.7.3, "NRP sensor mapping", on page 253.

3. Activate the RF output, set "RF Off > RF On".

4. Configure power servoing at the R&S SGT:

a) Open "SGMA-GUI > Instrument Name > RF > Level > Power Servoing".
b) Select the connected "Sensor".
c) Define "Target" and "Offset (Gain)", that is the desired output power level and

the expected gain of the DUT.
d) Set the "Sensor Aperture Time".

The R&S SGT retrieves the "Sensor Bandwidth" automatically from the con-
nected sensor.

e) Optionally, enable "Level Tracking (500 ms)" to compensate droop effects.
f) Activate power servoing by setting "Power Servoing > State > On".
g) Start power servoing procedure by pressing "Start".
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For more information, see the application sheet "R&S NRQ6 Power Servoing".

Settings

Sensor.........................................................................................................................241
State............................................................................................................................241
Target.......................................................................................................................... 241
Offset / Offset (Gain)................................................................................................... 241
Tolerance.....................................................................................................................242
Sensor Aperture Time................................................................................................. 242
Sensor Bandwidth....................................................................................................... 242
Level Tracking (500 ms)..............................................................................................242
Start.............................................................................................................................242

Sensor
Sets the power sensor from a list as detected in the "NRP Sensor Mapping" dialog.
If the list has only one entry, this power sensor is displayed automatically.
Remote command: 
[:SOURce]:POWer:SERVoing:SENSor on page 524

State
Activates/deactivates power servoing.
Remote command: 
[:SOURce]:POWer:SERVoing:STATe on page 525

Target
Sets the desired output power level required at the DUT.
Remote command: 
[:SOURce]:POWer:SERVoing:TARGet on page 525

Offset / Offset (Gain)
Sets an RF level offset.
"Offset" Sets an RF level offset.

This offset value represents the level shift of a downstream instru-
ment, as, for example, an attenuator or an amplifier, and is indicated
in the status bar of the display. It does not change the level at the RF
output.

"Offset (Gain)" For a power servoing test, sets the expected level offset, i.e. the gain
of the DUT.
After completion of a power servoing procedure this field shows the
actual gain of the DUT. Setting the "Offset (Gain)" close to the true
value of the DUT speeds up the procedure.
The setting is also applied to the level offset configured in "Offset /
Offset (Gain)" on page 225.

Remote command: 
[:SOURce]:POWer[:LEVel][:IMMediate]:OFFSet on page 526
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Tolerance
Sets the tolerance level interval, in which the "Target" output power level of the DUT
lies.
A large tolerance accelerates the power servoing procedure but also reduces the accu-
racy of the target output power level.
Remote command: 
[:SOURce]:POWer:SERVoing:TOLerance on page 525

Sensor Aperture Time
Sets the aperture time (size of the acquisition interval) of the power sensor during
power servoing.
For periodic signals, set "Sensor Aperture Time" to multiples (twice or more) of the sig-
nal period.
Remote command: 
[:SOURce]:POWer:SERVoing:SENSor:APERture on page 524

Sensor Bandwidth
Displays the measurement bandwidth of the set "Sensor".
The bandwidth is automatically retrieved from the detected sensor.
Remote command: 
n.a.

Level Tracking (500 ms)
Activates/deactivates continuous level tracking.
Activate level tracking to compensate droop effects.
Remote command: 
[:SOURce]:POWer:SERVoing:TRACking on page 526

Start
Triggers the start of the power servoing procedure.
The status is displayed below the "Start" button.
Remote command: 
[:SOURce]:POWer:SERVoing:SET? on page 524

6.7.7  Using power sensors

The R&S SGT works with any of the R&S NRP power sensors and thus supports vari-
ous application tasks. Using power sensors, you can for example determine attenua-
tion characteristics of downstream equipment or cables. You can use the measured
values to compensate the losses with internal control functions or with an external con-
trol circuit in real time.

R&S NRP power sensors are highly accurate standalone measuring devices, suitable
for a wide range of applications. The power sensors communicate directly with the sig-
nal generator, calculate the average or peak power internally, include S-parameter cor-
rection and return the measurement results to the generator.
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The R&S SGT supports up to four R&S NRP, allowing up to four power measurements
simultaneously.

Check the firmware version of the R&S NRP sensors regularly. Update the firmware, if
necessary.
For updates, see the Rohde & Schwarz website http://www.rohde-schwarz.com in sec-
tion "Power Meters & Voltmeters".

6.7.7.1  Connecting R&S NRP power sensors to the R&S SGT

R&S NRP sensors are connected to the R&S SGT in the following ways:
● Connection to the USB IN connector

Requires a USB Adapter Micro-A to A and the following cables, depending on the
used sensor type:
– R&S NRP-ZK6 and an R&S NRP-Z3 with external power supply for R&S

NRPxx power sensors
– R&S NRP-Z3 with external power supply for sensors of the R&S NRP-Zxx fam-

ily
● Connection via R&S NRP-Z5 sensor hub, see Using the R&S NRP-Z5 sensor hub.
● Connection via USB hub with external power supply unit, see Using USB hub.
● Connection via LAN for R&S NRPxxxSN power sensors

Using the Ethernet interface requires PoE (Power over Ethernet) to provide the
electrical power.
To establish the connection, you can use:
– A PoE Ethernet switch, e.g. R&S NRP-ZAP1 and an RJ-45 Ethernet cable.
– A PoE injector and an RJ-45 Ethernet cable.

Using the R&S NRP-Z5 sensor hub

The R&S NRP-Z5 USB sensor hub (high-speed USB 2.0) can host up to 4 R&S NRP
sensors. It provides simultaneous internal and external triggering of all connected sen-
sors.

Figure 6-29 illustrates the connection as principle. For details, see the description
R&S®NRP®Series Power Sensors getting started.

Figure 6-29: Connecting power sensors to the R&S SGT via R&S NRP-Z5 sensor hub
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I, II = Connection order
G = Signal source (R&S SGT)
1 = USB type Micro-A connector
2 = USB Adapter Micro-A to A
3 = Standard USB cable with USB type A and USB type B connectors
4 = USB type B connector
4a = External power supply unit, incl. power cable (supplied with the R&S NRP-Z5)
5 = Cable R&S NRP-ZK6 per sensor of the R&S NRPxx power sensor family; no further adapter cables for

sensors of the R&S NRP-Zxx family

Using USB hub

Figure 6-30 illustrates the connection as principle. For details, see the description
R&S®NRP®Series Power Sensors getting started.

Figure 6-30: Connecting power sensors to the R&S SGT via USB hub

I, II = Connection order
G = Signal source (R&S SGT)
1 = USB type Micro-A connector
2 = USB Adapter Micro-A to A
3 = Standard USB cable with USB type A and USB type B connectors
4 = USB type B connector
4a = External power supply unit and extra power cable
5 = Cable R&S NRP-ZKU per sensor of the R&S NRPxx power sensor family; R&S NRP-Z3 or R&S NRP-

Z4 USB adapter cables for sensors of the R&S NRP-Zxx family

Connection order

Always connect the equipment in the following order:

1. Connect the R&S NRP-Z5 sensor hub or the USB hub to the power supply and to
the R&S SGT

2. Switch on the R&S SGT

3. Connect/disconnect the R&S NRP sensors

Detection and mapping

The R&S SGT automatically detects a connected R&S NRP power sensor and indi-
cates it in the "NRP Power Viewer" and "NRP Sensor Mapping" dialogs.

You can change the default mapping, see Chapter 6.7.7.3, "NRP sensor mapping",
on page 253.
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On connection, the R&S SGT immediately starts the measurement of a detected
R&S NRP power sensor. If you perform an instrument preset, the R&S SGT stops the
measurements. The connection and the mapping of the power sensors remain, the
measurements must be restarted.

6.7.7.2  NRP power viewer

The R&S SGT features the power viewer function for measuring or monitoring signals
with R&S NRP power sensors.

About

The R&S SGT can perform up to four power measurements simultaneously.

The measured signals can be the RF output power or other selected signal sources.

Depending on the signal characteristic (CW, AM, pulsed, etc.) or the parameter to be
measured (average, peak, etc.) a suitable R&S power sensor must be used.

About the measuring principle, averaging filter, filter length, and achieving stable
results

A sensor measures the average or peak RF power of the source continuously. The
measurement results are displayed in the "NRP Power Viewer" dialog.

The power viewer function uses averaging filters for getting a stable readout.

Measurement results could be interfered, for instance, by too much noise in your
setup, by a bad suppression of harmonics or non-harmonics or when you reach the
sensitivity level of your power sensor.

Measurements are continuously repeated in a predefined time window. The measure-
ment result is obtained by averaging the measured values for the last 2N time win-
dows. This approach is referred as a two-step averaging process.

The factor of 2 in the formula arises because the output signals from the microwave
detector are chopped at the same rate as the time windows to suppress low-frequency
noise. An independent measured value can only be obtained from two consecutive val-
ues.

The variable N in the formula indicates the filter length. The filter length then directly
influences the measurement time. The filter length can be selected automatically or it
can be manually set to a fixed value.

Depending on the R&S NRP power sensor type, the manual setting of the filter length
varies in resolution:
● Resolution = 1 for the R&S NRPxx power sensor family
● Resolution = 2n for R&S NRP-Zxx power sensors, with n = 1 to 16

Follow the following general recommendation to find out the optimum filter length:
● Always start a measurement in auto mode ("Filter > Auto").

Check if the measurement results are sufficient.
● If the power is not constant, select the filter length manually ("Filter > User").
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Trigger the "Auto Once" function to search for the optimum filter length for the cur-
rent measurement conditions.
The estimated value is indicated as filter length.

● If the target measurement accuracy value is known, select "Filter > Fixed Noise".
The averaging factor is selected automatically and so that the sensor's intrinsic
noise (two standard deviations) does not exceed the specified noise content.

● Different sensor types achieve the same filtering result with different filter and time
window lengths.
The time window length depends on the sensor type:
– For most sensors, it is fixed to 20 ms.
– For the R&S NRP-Z81 sensor, it is 10 μs.

The R&S NRP-Z81 uses filter length that is 1000 times larger than the filter
length for other sensors.

About zeroing

Activates the auto zero function.

Zeroing calibrates the external power sensor by adjusting its reading at zero signal
power. For this purpose, the RF power source must be switched off or disconnected
from the sensor. If a Rohde & Schwarz power sensor receives an input power during
the zeroing process, it aborts zeroing and generates an error message. Zeroing takes
a few seconds, depending on the sensor model. Refer to the documentation of your
power sensor for more information.

Tips for zeroing

When to perform zeroing:
● During warm up after switching on or connecting the instrument
● After a substantial change of the ambient temperature
● After fastening the power sensor module to an RF connector at high temperature
● After several hours of operation
● When low-power signals are to be measured, e.g. less than 10 dB above the lower

measurement limit.
● Switch off the RF power source for zeroing, but do not disconnect it from the power

sensor. This proceeding keeps the thermal equilibrium, and the zeroing process
also compensates the noise that superimposes the measured signal (e.g. from a
broadband amplifier).

Related settings and functions

● Measurements-related settings, like results, filter, filter length:
NRP power viewer settings

● Software version of the connected power sensor:
:SENSe<ch>[:POWer]:TYPE? on page 389

● Acquisition of level correction data:
Chapter 6.7.6.5, "User correction settings", on page 230.
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Additional information

See the Rohde & Schwarz website http://www.rohde-schwarz.com, section "Power
Meters & Voltmeters" for:
● R&S NRP power sensor manual.
● Information on the R&S NRP-Z5 sensor hub and the available accessories.
● Sensor software updates.

NRP power viewer settings

Access:

1. Select "Instrument" > "RF" > "NRP Power Viewer".

The "Overview" tab shows the list of detected sensors, and provides a separate tab
per sensor.

2. Select a sensor tab.
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A sensor tab contains all parameters for configuring the sensor settings, like aver-
age or peak display, reference source, filter and level offset.

The remote commands required to define these settings are described in Chap-
ter 10.13, "SENSe, READ, INITiate and SLISt subsystems", on page 375, including
the triggering of the measurement and the retrieval of measurement results.

Settings:

Sensor type and serial number................................................................................... 249
Level (Peak) / Level (Average)....................................................................................249
Sensor Mapping.......................................................................................................... 249
Sensor.........................................................................................................................249
Sensor Settings...........................................................................................................249

└ State..............................................................................................................249
└ Zero...............................................................................................................249
└ Display.......................................................................................................... 249

└ Permanent.......................................................................................... 250
└ Display................................................................................................250

└ Source...........................................................................................................250
└ Frequency.....................................................................................................250
└ Level Offset State,Level Offset..................................................................... 250
└ Filter..............................................................................................................251
└ Filter Length..................................................................................................251
└ Auto Once.....................................................................................................251
└ Noise Content............................................................................................... 251
└ Timeout......................................................................................................... 252
└ Default Aperture Time...................................................................................252
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└ Aperture Time............................................................................................... 252
└ S-Parameter..................................................................................................252
└ Enable Logging.............................................................................................252

Sensor type and serial number
The side tab label indicates type and serial number of an R&S NRP power sensor and
its mapping index.
The Level (Peak) / Level (Average) values display the current readings of the sensor.
Remote command: 
:SENSe<ch>[:POWer]:TYPE? on page 389
:SENSe<ch>[:POWer]:SNUMber? on page 387

Level (Peak) / Level (Average)
Indicates the measured peak or average level value.
You can also change the unit for the results display: Watt, dBm or dBμV.

Note: Peak level measurements are provided if the power sensor supports this feature.
Remote command: 
:READ<ch>[:POWer]? on page 381
:SENSe<ch>:UNIT[:POWer] on page 381

Sensor Mapping
Accesses the NRP sensor mapping dialog.

Sensor
Indicates the connector the sensor is connected to.

Sensor Settings
One tab per sensor provides the corresponding setting parameters.

State ← Sensor Settings
Enables level measurement of the R&S NRP power sensor.
Remote command: 
:INITiate<hw>[:POWer]:CONTinuous on page 380
To query the availability of a sensor at a given connector, use the command :
SENSe<ch>[:POWer]:STATus[:DEVice]? on page 388.

Zero ← Sensor Settings
Activates the auto zeroing.
For details, see "About zeroing" on page 246.
Remote command: 
:SENSe<ch>[:POWer]:ZERO on page 389

Display ← Sensor Settings
Sets the display mode for power readings.
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Permanent ← Display ← Sensor Settings
Activates the permanent indication of the power measurement result in the block dia-
gram.
The task bar label shows the measurement result, the channel, the sensor is mapped
to and its serial number. Optionally, "(Offset,Peak)" appear when you have set these
parameters.
You can activate the permanent display for several sensors.
Remote command: 
:SENSe<ch>[:POWer]:DISPlay:PERManent:STATe on page 383

Display ← Display ← Sensor Settings
Sets the display of results on mean or peak power.
Remote command: 
:SENSe<ch>[:POWer]:DISPlay:PERManent:PRIority on page 383

Source ← Sensor Settings
Selects the source for measurement.
"RF" Assigns the signal to the RF path of the R&S SGT.

The R&S SGT transfers the RF frequency and level settings to the
R&S power sensor automatically. Thus you achieve power readings
of high accuracy, irrespective from the connected sensor type.

"User" Sets a user defined frequency.

Example: 
If you have a frequency converting device between the generator and
the DUT. If the frequency converter doubles the frequency, you can
set twice the frequency in the R&S SGT. The R&S power sensor con-
siders this RF frequency setting.

Set the parameter Frequency to the measurement's frequency.
Remote command: 
:SENSe<ch>[:POWer]:SOURce on page 388

Frequency ← Sensor Settings
Defines the frequency value if "Source > User" is used.
Remote command: 
:SENSe<ch>[:POWer]:FREQuency on page 386

Level Offset State,Level Offset ← Sensor Settings
Activates and defines a level offset which is considered in the power measurement
result. The level offset value is always expressed in dB, irrespective of the display of
the measurement result.
This function allows you to consider, for example, an attenuator in the signal path.
Remote command: 
:SENSe<ch>[:POWer]:OFFSet on page 387
:SENSe<ch>[:POWer]:OFFSet:STATe on page 387
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Filter ← Sensor Settings
Selects the way the length of the used filter is defined.
See also "About the measuring principle, averaging filter, filter length, and achieving
stable results" on page 245.
"Auto" Selects the filter length automatically and adjusts it to the measured

value. The value is indicated with the parameter Filter Length.
When high output power is applied, the filter length and therefore the
measurement time can be short.
When low output power is applied, the filter length and therefore the
measurement time is increased which reduces the considered noise
content in your measurement.

"User" The filter length is defined manually, with the parameter Filter Length.
As the filter length works as a multiplier for the time window, constant
filter length results in a constant measurement time.
Values 1 and 2N are allowed.

"Fixed Noise" The averaging factor is taken automatically in accordance to the
value Noise Content. Thus, the sensor's intrinsic noise (2 standard
deviations) does not exceed the specified noise content.
To avoid long measurement times when the power is too low, set a
Timeout.
Timeout is the maximum acceptable measurement time which limits
the averaging factor and therefore leads to a more unstable readout.

Remote command: 
:SENSe<ch>[:POWer]:FILTer:TYPE on page 386

Filter Length ← Sensor Settings
Sets or indicates the filter length, depending on the selected filter mode.
● "Filter > Auto" indicates the automatically adjusted filter length.
● "Filter > User" enables you to set the filter length manually.
● "Filter > Fixed Noise" hides the setting parameter.
Remote command: 
:SENSe<ch>[:POWer]:FILTer:LENGth:AUTO? on page 384
:SENSe<ch>[:POWer]:FILTer:LENGth[:USER] on page 384

Auto Once ← Sensor Settings
Searches the optimum filter length for the current measurement conditions. The result
is indicated with the parameter Filter Length.
See also "About the measuring principle, averaging filter, filter length, and achieving
stable results" on page 245.
Remote command: 
:SENSe<ch>[:POWer]:FILTer:SONCe on page 385

Noise Content ← Sensor Settings
For Filter > Fixed Noise, sets the noise content.
Remote command: 
:SENSe<ch>[:POWer]:FILTer:NSRatio on page 385
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Timeout ← Sensor Settings
For "Filter > Fixed Noise", sets a time limit for the averaging process.
Remote command: 
:SENSe<ch>[:POWer]:FILTer:NSRatio:MTIMe on page 385

Default Aperture Time ← Sensor Settings
The sensor default setting is sufficient. Disable this parameter to specify a user-defined
aperture time per sensor, if, for example, the readings vary.
To obtain stable readings, set the Aperture Time exactly to one modulation period.
Remote command: 
:SENSe<ch>[:POWer]:APERture:DEFault:STATe on page 382

Aperture Time ← Sensor Settings
If "Use Default Aperture Time > Off", defines the acquisition time per sensor.
For example, to obtain a sufficient low average value, set the aperture time exactly to
one modulation period.
Remote command: 
:SENSe<ch>[:POWer]:APERture:TIMe on page 382

S-Parameter ← Sensor Settings
S-Parameter correction is used to mathematically shift the reference plane to the DUT
by considering the S-parameters for any components connected upstream of the sen-
sor.
The S-Parameter table can be changed with the S-Parameters tool, provided as part of
the free R&S NRP Toolkit software. For more information, refer to the manual of the
connected R&S NRP power sensor.
Remote command: 
:SENSe<ch>[:POWer]:CORRection:SPDevice:STATe on page 383
:SENSe<ch>[:POWer]:CORRection:SPDevice:LIST? on page 383
:SENSe<ch>[:POWer]:CORRection:SPDevice:SELect on page 382

Enable Logging ← Sensor Settings
Activates recording of R&S NRP power sensor readings in a log file.
There is 1 log file per sensor. The log files are created automatically and filled in con-
tinuously. They are text files with predefined filename SensLog<n>.txt, where <n>
indicates the connected sensor. Log files are stored on the internal memory, in the
directory /var/user/SensorLogging.

Each log file contains the measured value (2 readings when you work with peak sen-
sors), the sensor type, and the measurement time (timestamp). Logged data is not
overwritten. When a new measurement is started, the collected logging data is appen-
ded in the log file.
Check the used disc space regularly and remove log files to maintain storage capacity.
Note: The logging function is intended for measurements with long time intervals. It is
suitable source for data reconstructions if the connection to the sensor was interrupted.
Remote command: 
:SENSe<ch>[:POWer]:LOGGing:STATe on page 387
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6.7.7.3  NRP sensor mapping

The "NRP Sensor Mapping" lists the sensors detected by the instrument.

Any R&S NRP sensor that supports the USB legacy protocol and is connected to one
of the USB interfaces, is detected automatically and added to the list. When you dis-
connect a power sensor, the R&S SGT removes it from the list accordingly.

R&S NRP sensors that are connected in the LAN or use the USBTMC protocol are
only detected by the scan search function.

Access:

► Select "Instrument" > "RF" > "NRP Sensor Mapping".

The dialog lists all detected R&S NRP sensors for selection and mapping. You can
also browse the network for sensors.
The list informs on the sensor type with serial number, specific features and the
revision of the sensor firmware.
For each sensor, you find the used protocol and the connector icon of the interface.
In the "Mapping" column, you can assign a mapping index to enable the sensor for
use. The list can contain several entries but the R&S SGT can only use up to four
sensors simultaneously.

Settings

Sensor Mapping List................................................................................................... 254
Scan............................................................................................................................ 254
Clear............................................................................................................................254
Add Sensor/Hide 'Add Sensor'....................................................................................254
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Add Sensor settings.................................................................................................... 254
└ Add LAN Sensor settings..............................................................................254
└ Add USB Sensor settings............................................................................. 255

Sensor Mapping List
Shows the sensors that are connected to the R&S SGT.
The table informs on the sensor type, specific features and the installed sensor firm-
ware. It also shows the interface the sensor is connected to, including the communica-
tion protocol and the mapping index.
Remote command: 
:SLISt[:LIST]? on page 378
:SLISt:ELEMent<ch>:MAPPing on page 380
:SLISt:SENSor:MAP on page 380

Scan
Scans the network and the USB connections for sensors connected using the VISA
communication protocol, i.e. sensors that are addressed over LAN or USBTMC.
The instrument detects sensors communicating over the USB legacy protocol automat-
ically.
Remote command: 
:SLISt:SCAN[:STATe] on page 378

Clear
Removes the selected sensor from the sensor mapping list.
Remote command: 
:SLISt:CLEar:LAN on page 379
:SLISt:CLEar:USB on page 379
:SLISt:CLEar[:ALL] on page 380

Add Sensor/Hide 'Add Sensor'
Shows or hides the "Add Sensor" settings.

Add Sensor settings
Configures settings to add sensors connected to the R&S SGT over USB or LAN.

Add LAN Sensor settings ← Add Sensor settings
Configures settings to add sensors connected to the R&S SGT over LAN.

"IP Address or Host Name"
Displays the host name or the IP address of a R&S NRP power sen-
sor.
If the R&S SGT does not detect a connected R&S NRP sensor, you
can assign the address information manually.

"Add LAN Sensor"
Adds a detected R&S NRP sensor connected in the LAN to the list of
sensors, including its device ID or name and its serial number.

Remote command: 
:SLISt:SCAN:LSENsor on page 378
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Add USB Sensor settings ← Add Sensor settings
Configures settings to add sensors connected to the R&S SGT via USB.

"Device ID or Sensor Name"
Displays the device identifier or the name of the R&S NRP power
sensor.
If the R&S SGT does not detect a connected R&S NRP sensor, you
can assign the ID or name manually.

"Serial Number"
Displays the serial number of the R&S NRP power sensor.
If the R&S SGT does not detect a connected R&S NRPsensor, you
can assign the serial number manually.

"Add USBTMC Sensor"
Adds a detected R&S NRP sensor connected at the USB interface to
the list of sensors, including its device ID or name and its serial num-
ber.

Remote command: 
:SLISt:SCAN:USENsor on page 379

6.7.8  Pulse modulation

This section explains the pulse modulation settings of the R&S SGT.

To configure and perform a pulse modulation, you need to select the modulation signal
source and provide the corresponding settings.

Modulation signal sources

The R&S SGT provides the following signal sources for the signal modulation:
● Internal: A high-performance pulse generator, that allows you to generate either

single or double pulse signals
● Externally supplied signal: the instrument expects the pulse modulation signals

at the [TRIG] connector.

Pulse modulation signal waveforms

The high-performance pulse generator enables you to generate single or double pulse
signals.
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Figure 6-31: Pulse generator - single pulse mode

1 = Pulse period
2 = Pulse width
3 = Pulse delay

Figure 6-32: Pulse generator - double pulse mode

1 = Pulse period
2 = Pulse width
3 = Double pulse width
4 = Double pulse delay
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6.7.8.1  Pulse modulation settings

► To access the pulse modulation settings, select "SGMA-GUI > Instrument Name >
RF > Pulse Modulation".

The "Pulse Modulation" dialog contains all parameters required to configure pulse
modulation and pulse signal generation.

State
Activates pulse modulation.
The R&S SGMA-GUI indicates an activated pulse modulation as follows:

Remote command: 
[:SOURce<hw>]:PULM:STATe on page 519

Source
Selects between the internal "Pulse Generator", or an "External" pulse signal for the
modulation. In the later case, the instrument expects the pulse modulation signals at
the [USER 2] connector.
Remote command: 
[:SOURce<hw>]:PULM:SOURce on page 518

Polarity
Sets the polarity of the active slope of the modulation signal for "Source > External".
Remote command: 
[:SOURce<hw>]:PULM:POLarity on page 518

External Impedance
Selects the input impedance for an external pulse modulation signal.
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Remote command: 
[:SOURce<hw>]:PULM:TRIGger:EXTernal:IMPedance on page 519

6.7.8.2  Pulse generator settings

► To access the pulse connector/trigger settings, select "SGMA-GUI > Instrument
Name > RF > Pulse Modulation > Connector/Trigger".

Comprises the settings necessary to configure the internal pulse modulation signal.

Pulse Mode
Sets the operating mode of the pulse generator.
"Single" Generates a single pulse in one pulse period
"Double" Generates two pulses in one pulse period.
Remote command: 
[:SOURce<hw>]:PULM:MODE on page 517

Pulse Period
Sets the repetition rate of the generated pulse signal.
Remote command: 
[:SOURce<hw>]:PULM:PERiod on page 518

Pulse Width
Sets the pulse duration of the generated pulse signal.
Remote command: 
[:SOURce<hw>]:PULM:WIDTh on page 520

Double Pulse Width
Sets the width of the second pulse.
Remote command: 
[:SOURce<hw>]:PULM:DOUBle:WIDTh on page 517

Double Pulse Delay
Sets the delay between the start of the first pulse and the start of the second pulse.
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Remote command: 
[:SOURce<hw>]:PULM:DOUBle:DELay on page 517

6.7.8.3  Pulse connector/trigger settings

► To access the pulse connector/trigger settings, select "SGMA-GUI > Instrument
Name > RF> Pulse Modulation > Connector/Trigger".

Comprises the settings necessary to configure the signal at the multi-purpose
[TRIG] connector in the external trigger mode.

Mode
Selects the mode for the correspondent connector. Some settings are only available for
connector "USER 2".
"Marker 1/2" Output for a defined marker signal.
"Trigger/ Trigger Out"

Input/output for an external trigger signal.
"Clock In/Out" Input/Output for a clock signal.
"Sync In/Out" Input/Output for SYNC signals used for SYNC-Mode in baseband.
"Next Trigger" Input next segment for triggering of multi-segment waveform files.
"Signal Valid" Output of high signal to mark valid frequency and level settings.
"Not Signal Valid"

Output of high signal to mark the transition state when frequency and
level change.

"Pulse Video Out"
Available only for "USER 2".
Output of the internally generated pulse video (modulating) signal.
The video signal level corresponds to the RF envelope.

"Pulse Gen Ext Trigger"
Available only for "USER 2".
Input for an external trigger signal, used to trigger the pulse genera-
tor.
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"Pulse Mod Ext Source"
Available only for "USER 2".
Input for an externally provided pulse modulation signal.
Used when an external pulse modulator source is provided at the
connector.

Remote command: 
:CONNector:USER<ch>:OMODe on page 359

Trigger Mode
Selects between continuous pulse modulation or pulse modulation triggered by an
external signal.
"Auto" Generates the modulation signal continuously.
"Ext Single" Generates the signal each time an external trigger event occurs.
"Ext Gated" Generates the signal triggered by an external gate signal.
Remote command: 
[:SOURce<hw>]:PULM:TRIGger:MODE on page 520

Ext. Trigger Input Slope
Available only for "Trigger Mode > Ext Triggered"
Sets the polarity of the active slope of an applied external trigger signal.
Remote command: 
[:SOURce<hw>]:PULM:TRIGger:EXTernal:SLOPe on page 519

Gate Input Polarity
Available only for "Trigger Mode > Ext Gated"
Sets the polarity of the active slope of an applied gate signal.
Remote command: 
[:SOURce<hw>]:PULM:TRIGger:EXTernal:GATE:POLarity on page 519

6.8  Connectors

The "USER 1/2" connectors of the R&S SGT can be used for multiple purposes. In the
"Connector" dialog, the correct mode for each connector can be set, and additional set-
tings for some modes.

► To access this dialog select "SGMA-GUI > Instrument Name > Connectors"
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Mode
Selects the mode for the correspondent connector. Some settings are only available for
connector "USER 2".
"Marker 1/2" Output for a defined marker signal.
"Trigger/ Trigger Out"

Input/output for an external trigger signal.
"Clock In/Out" Input/Output for a clock signal.
"Sync In/Out" Input/Output for SYNC signals used for SYNC-Mode in baseband.
"Next Trigger" Input next segment for triggering of multi-segment waveform files.
"Signal Valid" Output of high signal to mark valid frequency and level settings.
"Not Signal Valid"

Output of high signal to mark the transition state when frequency and
level change.

"Pulse Video Out"
Available only for "USER 2".
Output of the internally generated pulse video (modulating) signal.
The video signal level corresponds to the RF envelope.

"Pulse Gen Ext Trigger"
Available only for "USER 2".
Input for an external trigger signal, used to trigger the pulse genera-
tor.
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"Pulse Mod Ext Source"
Available only for "USER 2".
Input for an externally provided pulse modulation signal.
Used when an external pulse modulator source is provided at the
connector.

Remote command: 
:CONNector:USER<ch>:OMODe on page 359

Trigger Slope
Sets the polarity of the active slope of the externally applied signal.
Remote command: 
:CONNector:USER<ch>:TRIGger:SLOPe on page 360

Clock Slope
Sets the polarity of the active slope of the externally applied signal.
Remote command: 
:CONNector:USER<ch>:CLOCk:SLOPe on page 360

Impedance
Selects the input impedance for the modulation signal.
Remote command: 
:CONNector:USER<ch>:TRIGger:IMPedance on page 360
:CONNector:USER<ch>:CLOCk:IMPedance on page 360

Threshold
Sets the high/low threshold of the signal.
Remote command: 
:CONNector:USER<ch>:THReshold on page 360

6.9  External baseband signal - baseband input

The R&S SGT makes it possible to feed an external digital baseband signal into the
signal path.

User-specific wanted signals or interference signals can be frequency and offset shif-
ted, detuned or loaded with noise (see Chapter 6.2, "Additive white Gaussian noise
(AWGN) - noise generator", on page 141).

The R&S SGT is equipped with the [DIGITAL IQ IN] interface at the rear of the instru-
ment as input connector for the external digital signal.

This interface provides direct communication with other R&S instruments.

The Chapter 6.9.2, "BB input block", on page 264 describes the settings for configuring
an input signal.

External baseband signal - baseband input
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6.9.1  Important signal parameters

The correct signal processing of input signals in the instrument requires information of
some signal parameters. Among these parameters are sampling rate, crest factor and
signal level, that is expressed as peak or as RMS level value.

● Sample rate
The sample rate of the input signal can be defined manually or automatically
retrieved from the input signal.

● Crest factor
Test setups can require feeding of external signal to the digital/analog input of the
R&S SGT. If you want to transfer an I/Q signal between two instruments, make
sure that the crest factors match. At the source instrument, transfer an output sig-
nal with a crest factor that matches with the crest factor at the input interfaces of
the receiving instrument.
The crest factor gives the difference in level between the peak level and RMS level
value in dB. The R&S SGT uses the crest factor value for the calculation of power
levels. The general principle is, that the R&S SGT compensates the RMS levels of
the externally supplied signal by the crest factor.

Figure 6-33: Relation between the level settings

In the instrument, level values are represented relative to the full scale.

Fulfilling the prerequisites for a correct signal processing of the externally sup-
plied baseband signal

In the instrument, the crest factor, peak level and RMS level values can be adjusted
in one of the following ways:
● Adjusted manually

If you know these values, it is best to enter them directly (see Crest Factor)
● Estimated automatically by the internal measurement function

Use the function Auto Level Set to trigger the R&S SGT to measure the input sig-
nal, estimate the peak level and RMS level and calculate the crest factor out of
them.
Tip: For accurate level measurements, set the measurement period to a time value
that is long enough to capture several periods of the input signal.

● Determined automatically (digital baseband input only)
The R&S SGT can receive the values from the connected transmitter.
If the external digital signal source is a second Rohde & Schwarz instrument, it sig-
nals the peak level and RMS level of the signal over the digital input interface. To
enable the R&S SGT to receive these values, trigger the DIG IQ Auto Setting func-
tion.

External baseband signal - baseband input
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In the two automatic ways, the R&S SGT adjusts the corresponding input fields with
the measured/received values. The internal gain control mechanism uses these
received values to adjust the input signal gain to achieve an optimal dynamic range.

Sample rate
● External input signals with sample rates different than the system clock are resam-

pled, as shown in Figure 6-34.

Figure 6-34: Resampling of external digital baseband signals

The R&S SGT can process digital signals with sample rate from 400 Hz to 200
MHz, whereas the internal signal processing is based on a sample rate with 300
MHz.

● Estimating or defining the sample rate
The sample rate of the signal at the digital interface can be determined with one of
the following methods:
– User-defined sample rate

Provide both the external signal source and the receiving instrument with a
common external reference signal and set the sample rate value.

– Estimated sample rate
Enable the instrument to evaluate the received I/Q data clock

Maximum modulation bandwidth
● A baseband signal with a sample rate that is smaller than the used system clock is

interpolated (see Figure 6-34). The resulting modulation bandwidth is calculated as
Sample Rate * 0.8, i.e. with a sample rate of exactly 200 MHz, the modulation
bandwidth is 160 MHz.

6.9.2  BB input block

The settings for signal routing, frequency offset and phase offset are available in the
"BB Input" function block.

The external baseband signal is activated by switching on in the "Baseband Input Set-
tings" dialog and by ticking the checkbox of the "BB Input" function block.

External baseband signal - baseband input
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6.9.2.1  Baseband input settings menu

This dialog comprises the settings necessary to adjust the signal parameters, like the
sample rate, the baseband input level and to perform simple signal monitoring.

Baseband input general settings

► To access this dialog, select "SGMA-GUI > Instrument Name > BB Input > Digital
BB In >General".

In this section, you can activate the baseband input and get information about the
connected devices.

State
Switches On/Off the feeding of an external digital signal into the signal path.
"On" Switches On the external I/Q input signal of the "BB In" block. The

input symbol displays the active signal mode.
"Off" Switches Off the external I/Q input signal.
Remote command: 
[:SOURce<hw>]:BBIN:STATe on page 462

I/Q-Swap
Activates swapping of the I and Q signal components, which mirrors the spectrum at
the f=0 line and inverts the sign of the frequency.
Remote command: 
[:SOURce<hw>]:BBIN:IQSWap[:STATe] on page 457

Connected Device
Indicates the ID of a connected R&S Instrument or R&S device.
If supported by the transmitter, also the transmitter sample rate is shown.
Note: The connected instrument is indicated only, if the connection is properly estab-
lished and signal transmission is active.
Remote command: 
[:SOURce<hw>]:BBIN:CDEVice? on page 456

External baseband signal - baseband input
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Sample rate

► To access this dialog, select "SGMA-GUI > Instrument Name > BB Input > Digital
BB In > Sample Rate".

In this section, you can set the sample rate of the external digital baseband signal.

Sample Rate Source
Selects the source for estimating the sample rate or defining it by the user.
"User Defined" Enables the user to define the sample rate in the entry field value.
"Digital I/Q In" Estimates the sample rate on the digital I/Q input and displays the

value in the value field.
Note: Estimation works best if the sample rate is close to the user-
defined value.

Remote command: 
[:SOURce<hw>]:BBIN:SRATe:SOURce on page 461

Sample Rate Value
Sets the sample rate of the external digital baseband input signal.
Remote command: 
[:SOURce<hw>]:BBIN:SRATe[:ACTual] on page 461

Baseband input level

► To access this dialog, select "SGMA-GUI > Instrument Name > BB Input > Digital
BB In > Sample Rate".

External baseband signal - baseband input
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The crest factor and the peak power of the external baseband signal are entered in
the section "Baseband Input Level". These values are necessary for a correct inter-
nal signal processing in the R&S SGT. They can also be automatically estimated
by a measurement using the "Auto Level Set" button.

DIG IQ Auto Setting
Activates automatic adjustment of the baseband input signal.
The R&S SGT receives peak level, level and crest factor values directly from the con-
nected transmitter and recognizes changes automatically.
Remote command: 
[:SOURce<hw>]:BBIN:DIGital:ASETting:STATe on page 456

Measurement Period
Sets the recording duration for measuring the baseband input signal by "Auto Level
Set". For accurate level measurements, set the measurement period to a time value
that is long enough to capture several periods of the input signal.
Remote command: 
[:SOURce<hw>]:BBIN:MPERiod on page 458

Auto Level Set
Starts measuring the input signal. The measurement estimates the crest factor, the
peak power and the rms power. The estimated values are automatically entered into
the input fields "Crest Factor", "Peak Level" and "Level". Using these estimated values
the internal gain control adjusts the input signal gain to achieve an optimal dynamic
range.
Remote command: 
[:SOURce<hw>]:BBIN:ALEVel:EXECute on page 455

Crest Factor
Sets the crest factor of the external analog or digital baseband signal. Indicates the
crest factor acquired with "Auto Level Set".
Remote command: 
[:SOURce<hw>]:BBIN:CFACtor on page 456

Peak Level
Enters the peak level of the external digital baseband signal relative to full scale of 0.5
V (in terms of dB full scale).
Indicates the peak level acquired with "Auto Level Set".
Remote command: 
[:SOURce<hw>]:BBIN:POWer:PEAK on page 460

Level
Indicates the estimated rms level acquired with "Auto Level Set".
Remote command: 
[:SOURce<hw>]:BBIN:POWer:RMS? on page 460

External baseband signal - baseband input
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Signal monitoring

The section "Signal Monitoring" indicates an overload.

Overflow
Indicates that the I/Q input is overloaded.
If overload is indicated, either the amplitude of the external signal is too high (full scale
of 0.5 V) and must be reduced or the entered "Peak Level" (in dB full scale) value does
not correspond with the real value and must be corrected. It also can be evaluated
automatically with button "Auto Level Set".
Remote command: 
[:SOURce<hw>]:BBIN:OLOad:STATe? on page 459

Overflow Hold
Indicates an overload since last reset for evaluating the measurement.
The Overload Hold state can be reset via the "Reset" button next to the LED, or is
reset automatically by starting a new measurement ("Auto Level Set") or by setting
new values (Crest Factor, Peak Level, Level).
Remote command: 
[:SOURce<hw>]:BBIN:OLOad:HOLD:STATe? on page 459

Reset
Executes a reset of the "Overflow Hold" state.
Remote command: 
[:SOURce<hw>]:BBIN:OLOad:HOLD:STATe? on page 459

6.9.2.2  BB in offset

► To access this dialog, select "SGMA-GUI > Instrument Name >BB Input/Output >
Frequency/Phase Offsets".

A frequency and phase offset can be set in this dialog.

Frequency Offset
Enters the frequency offset for the external baseband signal and shifts the useful base-
band signal in the center frequency.

External baseband signal - baseband input
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Remote command: 
[:SOURce<hw>]:BBIN:FOFFset on page 456

Phase Offset
Enters the phase offset for the external baseband signal. The offset affects the signal
on the output of the "Baseband In/Out" block.
Remote command: 
n.a.

External baseband signal - baseband input
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7  General instrument settings and instrument
setup
This section describes the general settings of the instrument that do not directly affect
signal generation.

Access:

1. Select "SGMA-GUI > Instrument Name > Setup".

2. Select the required dialog.

Settings:

● Internal adjustments..............................................................................................271
● Hardware configuration.........................................................................................273
● Software and hardware options............................................................................ 275
● Manage license keys.............................................................................................276
● Protection..............................................................................................................281
● Security................................................................................................................. 282
● Network settings....................................................................................................286
● Remote channels.................................................................................................. 289
● LXI status.............................................................................................................. 290
● Emulations............................................................................................................ 292
● Date and time........................................................................................................293
● Factory preset....................................................................................................... 294
● Standby and restart...............................................................................................295
● Diagnostic and tests..............................................................................................295
● External adjustments.............................................................................................300
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7.1  Internal adjustments

Access:

► Select "Setup > Internal Adjustments".

The dialog provides settings for internal adjustments of the R&S SGT.

All internal adjustments for which no external measuring equipment is needed can be
started in the "Internal Adjustments" dialog. The adjustments with external measuring
equipment are described in the service manual.

Deciding whether to run internal adjustments

1. Select "Setup > Internal Adjustments".

2. Observe the status and color indication in the section "Since Last Full Adjustment".

Green: Internal adjustments are not required.
Red: Internal adjustments are required. Observe also the indication in the "Informa-
tion" field.

3. We recommend you to run internal adjustments in the following cases:
● Before starting any application that requires a maximum of level accuracy and

frequency accuracy
● When a long period of time has passed since the last adjustments
● If the ambient temperature of the instrument significantly differs from the one of

the last adjustments

4. Proceed as described in "Running internal adjustments" on page 271.

Running internal adjustments

1. NOTICE! Adjustments can be invalid if performed when the instrument is not
warmed-up.

Internal adjustments
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Wait until the instrument has reached its operating temperature before you start the
adjustment procedure.
The warm-up time is up to 30 minutes.

2. Select "Setup > Internal Adjustment > Adjust All".

The adjustment process starts.

3. Do not interrupt the adjustment process.
The extent of the adjustments depends on the installed options. It can last up to 2
hours.

A progress indicator shows the status of the adjustment process. If errors occur the
process aborts. An error message appears in the "Info" line.

Settings

Adjust All..................................................................................................................... 272
Adjust I/Q Modulator at Current Frequency................................................................ 272
Synthesis.....................................................................................................................272
Level............................................................................................................................272
I/Q Modulator.............................................................................................................. 273

└ I/Q Modulator................................................................................................ 273
└ Baseband......................................................................................................273

Adjust All
Starts all internal adjustments for which no external measuring equipment is needed.
The adjustments with external measuring equipment are described in the service man-
ual.
Remote command: 
:CALibration:ALL[:MEASure]? on page 355

Adjust I/Q Modulator at Current Frequency
Starts the adjustment for the I/Q modulator for the currently set frequency. The I/Q
modulator is adjusted regarding carrier leakage, I/Q imbalance and quadrature.
The adjustment is only possible when "RF > On" and "I/Q Mod > State > On".
Adjustment for only the set frequency is considerably faster than adjustment across the
entire frequency range. An adjustment of the entire range is possible with the I/Q Mod-
ulator button of this dialog.
Remote command: 
:CALibration:IQModulator:LOCal? on page 356

Synthesis
Performs all adjustments which affect the frequency.
Remote command: 
:CALibration:FREQuency[:MEASure]? on page 355

Level
Performs all adjustments which affect the level. The acquired correction values
improve the settling time and the signal quality.

Internal adjustments
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Remote command: 
:CALibration:LEVel[:MEASure]? on page 356

I/Q Modulator
Starts the adjustment procedure for the I/Q modulator and/or the baseband for the
entire frequency range. The I/Q modulator is adjusted regarding carrier leakage, I/Q
imbalance and quadrature.
To accelerate the adjustment procedure, you can enable performing adjustments for
the I/Q modulator and the baseband separately.
Remote command: 
:CALibration:IQModulator:FULL? on page 356

I/Q Modulator ← I/Q Modulator
Acitvates/deactivates a separate internal adjustment procedure for the I/Q modulator.
Remote command: 
:CALibration:IQModulator:IQModulator[:STATe] on page 356

Baseband ← I/Q Modulator
Acitvates/deactivates a separate internal adjustment procedure for the baseband.
Remote command: 
:CALibration:IQModulator:BBANd[:STATe] on page 355

7.2  Hardware configuration

Querying information about the installed assemblies

► Select "SGMA-GUI > Instrument Name > Setup > Hardware Config".

In the "Hardware Config" dialog, the installed assemblies together with their var-
iants and revision states can be displayed for servicing purposes.

Hardware configuration
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The dialog is a table that lists the installed assemblies. It is divided into the sec-
tions:
● "Common Assembly"
● "RF Assembly"

Settings:

Assembly.....................................................................................................................274

Assembly
The tables list the installed assemblies.
"Assembly" Name of the assembly
"Part Number" Part number of the assembly
"Serial Number"

Serial number of the assembly
"Revision" Revision state of assembly
Remote command: 
R&S SGT: n.a.

Hardware configuration
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7.3  Software and hardware options

To check the software packages and installed options

► Select "SGMA-GUI > Instrument Name > Setup > Software/Options".

The "Software / Options" dialog shows the firmware version of the instrument soft-
ware and all installed hardware and software options.

The dialog is divided into the following sections:
● "Firmware"
● "Hardware"
● "Software"
● "WinIQSIM"
● "Loaded Modules"

Software options purchased at a later stage can be activated with a keycode. The acti-
vation code is supplied with the software option. An instruction on how to install options
is described in the service manual. You can install most hardware options at an author-
ized Rohde & Schwarz service center.

Software and hardware options
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Settings:

Software...................................................................................................................... 276
Hardware / Software / WinIQSIM................................................................................ 276
Loaded Modules..........................................................................................................276
Show Open Source Acknowledgments.......................................................................276
LucasFonts RSCorpid EULA.......................................................................................276

Software
Shows the software/firmware version and the version of the software platform.
Note: Your instrument is delivered with the latest firmware version available. Firmware
updates and the release notes are provided on the Internet at the download site of the
instrument's home page. This home page always offers the latest information on your
instrument, e.g. also on changes of the firmware update procedure.

Hardware / Software / WinIQSIM
The tables in the sections "Hardware" and "Software" list the installed hardware and
software options.
"Option" Short name of the option
"Designation" Name of the option
"Licenses" Number of licenses
"Expiration
Date"

For regular options, "Permanent" is indicated in this column. Some
options are available as trial versions. This column shows their expi-
ration date. After this date, the option is no longer available on the
instrument.

Loaded Modules
Section "Loaded Modules" is provided for service purposes. It lists all loaded software
modules with their versions and offers a short description of each module.

Show Open Source Acknowledgments
Accesses the list of the used open-source software packages and the corresponding
verbatim license texts.
For R&S SGMA-GUI, the list shows the open-source acknowledgement for software
with Windows® operating system.
For R&S SGU/SGS/SGT, the list shows the open-source acknowledgement for soft-
ware with Linux® operating system.

LucasFonts RSCorpid EULA
Accesses copyright information on LucasFonts font type RSCorpid EULA.

7.4  Manage license keys

The dialog comprises settings for enabling newly purchased and/or newly registered
options. You can also execute instrument-related steps during the process of unregis-
tration and/or moving of licenses.

Manage license keys
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An option is ready to operate after it is enabled by a license key code supplied with the
option. The license key is delivered as a file or on paper. Unregistered licenses must
be registered for a particular instrument before the corresponding option can be
enabled for operation.

License registration
If your purchased license is delivered unregistered, you must register it before you can
activate the option.
For detailed information about the license registration, refer to the installation instruc-
tions provided with the option (Supplement A) and the documentation of the online tool
"Manage Licenses" (https://extranet.rohde-schwarz.com/service).

Only if the R&S SGT is equipped with an older firmware version, a firmware update
before enabling the software option can be required. The information on the valid firm-
ware versions for the purchased software option is provided together with the option.

Example: Moving a portable license
This example is intended to explain how to perform the required steps at the instru-
ment.
Use a USB flash drive to transfer the license key files between the instrument and the
browser.

We assume knowledge about the handling of the R&S License Manager online tool
and the description of the whole process.

1. In your browser, open https://extranet.rohde-schwarz.com/service.
Select "Manage Licenses > Move Portable License".

The first step requires the device IDs of the source and target instruments.

2. To find out the device IDs, proceed as follows:

Manage license keys
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a) On the source instrument, select "Setup > Manage License Keys > Device ID".

b) On the target instrument, select "Setup > Manage License Keys > Device ID".
c) In the browser, select "Manage Licenses > Move Portable License > Select

Devices".
d) Enter the device IDs.

3. On the source instrument, select "Setup > Manage License Keys > Installed
License Keys table".
Navigate to the portable license that you want to move and click the "Export
License to File" column, e.g. R&S SGT-K540.

A standard file manager dialog opens. Enter a user-specific filename and save the
exported license key, e.g. k540_portable_key_to_move.xml.

4. In the browser, select "Manage Licenses > Move Portable License > Select
License (from file)".

5. Select the exported license key.

6. Check "Show Deactivated", to create the deactivation key.

7. Save the deactivation key to a file.

8. On the source instrument, select "Setup > Manage License Keys > Import License
Keys from File".

9. Select the transferred deactivation key.

10. On the source instrument, select "Manage License Keys > Export Deactivation
Response to File".

The instrument confirms the deactivation of the option. The deactivation key
response is exported under the selected name, e.g.
K540_portable_decat.txt.

11. In the browser, go the step "Manage Licenses > Move Portable License > Install
Deactivation Key (from file)".

Manage license keys
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12. Enter the deactivation response of the instrument.

The license is deactivated for the source instrument.

13. In the section "Manage Licenses > Move Portable License", go to step "Create
License" to generate a license key for this portable option and the selected target
instrument.
Download the license key as a file. Transfer it to the target instrument.

14. In the target instrument, select "Setup > Manage License Keys > Import License
Keys from File".

15. Select the created license key file.

The portable option is installed on the target instrument.

Settings:

Device ID.....................................................................................................................279
Enter License Key....................................................................................................... 279
Import License Key from File...................................................................................... 279
Export Deactivation Response to File......................................................................... 279
Status Information....................................................................................................... 279
Show Inactive Licenses...............................................................................................280
Show Deactivated Licenses........................................................................................ 280
Manage Waveform Packages..................................................................................... 280
Register Selected Waveform.......................................................................................280
License Table.............................................................................................................. 280

Device ID
Displays the instrument-specific identification number. The device ID is a unique string
with the following structure:
<stock number>-<serial number>-<checksum>

Enter License Key
Type here the license key provided with the option.
For license keys delivered as a file, use Import License Key from File....

Import License Key from File...
Opens a dialog for selecting the file with the license key.
Use this function also to import the deactivation key file generated by the R&S License
Manager online tool (see Moving a portable license).

Export Deactivation Response to File...
Exports the generated deactivation response key to a file and opens a file manage-
ment dialog to save the file. This key is required during the unregistration process.
In case the unregistered option is a portable one, it can be afterwards registered at
another instrument (see Moving a portable license).

Status Information
Displays status information.

Manage license keys
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Show Inactive Licenses
Enables/disables the display of the inactive (expire) licenses in the License Table.

Show Deactivated Licenses
Enables/disables the display of the deactivated licenses in the License Table.
See Moving a portable license for information on how to activate deactivated licenses.

Manage Waveform Packages
Opens the "Manages Waveform Packages" dialog.
Waveform package licenses are provided for the registration of waveforms. The licen-
ses enable the instrument to play registered waveform files generated with the soft-
ware R&S WinIQSIM2. You do not need to equip the R&S SGT with the corresponding
software option R&S SGT-Kxy/-K2xy.
One waveform packages license per waveform is required. Once registered license
cannot be moved to another instrument.
Note: One waveform package license per segment is required for the registration of a
multi-segment waveform.
"Number of Licenses/Waveforms"

Displays the number of the available and used R&S SGT-K200 licen-
ses.

"Select Waveform"
Opens standard dialog to select the waveform to be registered.

"License Table"
Gives an overview of the registered waveforms, the registration date
and the number of used licenses.

Register Selected Waveform
Registers the selected waveform to the instrument.

License Table
Provides information about the currently installed options.
"Export License Key to File"

Opens dialog to save the generated license key file. This file is
required during the unregistration process. In case the unregistered
option is a portable one, it can be afterwards registered at another
instrument (see Moving a portable license).

"Option" Displays the option short designation.
Tip: Open the Chapter 7.3, "Software and hardware options",
on page 275 dialog to retrieve more information about the installed
options.

"License Count"
Displays the number of the licenses for the selected option key.

Manage license keys
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"License Type" Display the type of license.
A license type is a joint qualification for the duration of applicability
and the portability of a license. The following license types are provi-
ded: evaluation, permanent, portable, quantified, timed with duration
of 1, 3, 6 or 12 months. A license can also be in the states deactiva-
ted and expired.
For time-limited licenses, the left time of applicability is displayed too.

"Registrations" Opens the "Waveform Packages License" dialog (see Manage Wave-
form Packages).

7.5  Protection

The "Protection" dialog provides access to the unlocking of protected service functions
(authorized personnel of R&S service departments only).

Unlocking protected service functions

1. Select "SGMA-GUI main panel > Instrument Name > Setup > Protection".

The "Protection" dialog provides access to the unlocking of protected service func-
tions (authorized personnel of R&S service departments only).

2. To deactivate the protection, enter the correct password. After booting the instru-
ment, protection levels 1 to 4 are active.
Enter "Protection Level 1 > Password > 123456".

Protection Level 1 is activated.

Settings:

Protection Level / Password........................................................................................281

Protection Level / Password
"Protection Level 1" can be activated to expand the functionality of the internal adjust-
ment. The password is 123456.

Protection
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The other protection levels 2 to 4 provide access to protected service functions. Only
the authorized personnel of R&S service departments can access these functions.

7.6  Security

The R&S SGT employs a security concept based on a user password and the security
password. Use the security password to configure critical settings, like performing firm-
ware updates.

The "Security" dialog provides settings to configure the following security settings:
● Accessing connected USB storage devices.
● Saving information on the internal memory.
● Enabling or disabling the LAN interface.
● Managing the user password and security password.

Access:

1. Select "SGMA-GUI" > "<Instrument name>" > "Setup" > "Security".

2. Select "General".

The "General" tab covers security functions to protect the instrument from unau-
thorized access to USB storage devices. The volatile mode prevents writing infor-
mation permanently to the internal memory of the instrument.

3. Select "LAN Services".

In the "LAN Services" tab, you can disable the LAN interface, see "Disabling the
LAN interface" on page 283.

4. Select "Password Management".
The functions in this tab provide secure controlled user access to the instrument.
With the two-step password concept, you can assign a user-defined password for
the operating system, and a security password for accessing the mass storage of
the instrument.

Security
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a) To configure the user-defined password, select the "User Password" side-tab.

b) To configure the security password, select "Security Pasword".

Disabling the LAN interface

Remote control over LAN requires that you have enabled the LAN interface.

1. Select "LAN Services".

2. NOTICE! Risk of loosing access over LAN. Disabling the LAN interface locks the
remote access to the instrument.
If needed, disable the LAN interface. Do not disable the interface while you operate
the R&S SGT remotely.

3. To confirm disabling, proceed as follows:

a) Enter the security password.
b) Select "Accept".

If disabled, the connection state of the R&S SGT is gray on the main panel of
R&S SGMA-GUI, see "Instrument/Connection State" on page 67. Also, on the front
panel of the R&S SGT, the LAN LED is gray.
Proceed with the following steps for troubleshooting a disabled LAN interface.

4. To reestablish a remote control connection, you can use a USB connection
between R&S SGT and the host PC, see Chapter 3.1.13.4, "Connecting a control-
ler via USB", on page 31.

Security
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5. If you have locked the access accidentally, you have the following options:
● Update the instrument firmware using ISO image

(<instrument>_<version-number>.iso).
Note: A firmware update with the ISO image resets the instrument. The instru-
ment reset dismisses user-specific configurations and deletes user data.
Contact the Rohde & Schwarz (https://www.rohde-schwarz.com/support) to get
the ISO image.

● Ship the instrument to your local service department. The service center
experts can enable the remote access over LAN without loosing user-specific
settings and data.
See http://www.services.rohde-schwarz.com.

The remote commands required to define these settings are described in Chap-
ter 10.16, "SYSTem subsystem", on page 533.

Settings:

General....................................................................................................................... 284
└ USB Storage.................................................................................................284
└ Volatile Mode................................................................................................ 285
└ Security Password........................................................................................ 285
└ Accept...........................................................................................................285

LAN Services.............................................................................................................. 285
└ LAN Interface................................................................................................285

User Password............................................................................................................285
└ User Name....................................................................................................286
└ Old Password................................................................................................286
└ New Password..............................................................................................286
└ Confirm Password.........................................................................................286
└ Change Password.........................................................................................286

Security Password...................................................................................................... 286
└ Old Password................................................................................................286
└ New Password..............................................................................................286
└ Confirm Password.........................................................................................286
└ Change Password.........................................................................................286

General
In the "General" tab, you can determine the security level for firmware updates, and
configure the security settings for the mass memory and manual operation.
Note: All modified settings in this dialog are not applied until you enter the Security
Password and confirm with Accept.

USB Storage ← General
Enables the access to external USB storage media.
The instrument does not recognize any device connected to the USB interface when
the interface is disabled.
To apply the change: enter the security password and confirm with "Accept". Otherwise
the change has no effect.

Security

https://www.rohde-schwarz.com/support
http://www.services.rohde-schwarz.com
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Note: Remove all USB memory devices before disabling the USB storage. If any USB
memory device remains connected, disabling is blocked, and the instrument returns a
warning message.

Volatile Mode ← General
Enables volatile mode. Use the mode to ensure that no user data can be written to the
internal memory permanently. Internal memory is, e.g., a microSD or a solid-state drive
(SSD).
For further information and sanitizing procedures, see the "Instrument Security Proce-
dures" document.
Remote command: 
:SYSTem:SECurity:VOLMode[:STATe] on page 550

Security Password ← General
Enters the password that is required to enable or to disable the settings protected by a
security password. The default is '123456'.
Note: It is highly recommended to change the default security password before con-
necting the instrument to the network. To change the security password, select
"SGMA-GUI > Instrument Name > Setup > Security > Change Security Password".
The settings are only accepted after the "Accept" button is pressed.

Accept ← General
Accept a new entry or selection and change the settings accordingly.

LAN Services
Provides settings to enable or disable the LAN interface.
How to: "Disabling the LAN interface" on page 283

LAN Interface ← LAN Services
Enables the LAN interface.
Note: It is not possible to access the instrument via LAN while the LAN connection is
disabled. An enabled LAN connection is a prerequisite for the remote control of the
instrument via FTP or SMB.
How to: "Disabling the LAN interface" on page 283
Remote command: 
:SYSTem:SECurity:NETWork[:STATe] on page 548

User Password
The user name and password are required for remote access to the instrument over
VNC, FTP or SAMBA.
Note: We recommend that you change the default user password before connecting
the instrument to the network.
Note: Note that you cannot reset the password to factory state.
If you encounter problems with the password, contact the Rohde & Schwarz customer
support, see Chapter 12.5, "Contacting customer support", on page 584.

Security
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User Name ← User Password
Indicates the user name used for access to the Linux operating system and valid for
VNC, FTP and SAMBA access.

Old Password ← User Password
Enter the currently used user password. The default password is "instrument".

New Password ← User Password
Enter the new user password.

Confirm Password ← User Password
Enter the new password for conformation.
The new password is only valid after the "Change Password" button is pressed.

Change Password ← User Password
Changes the password accordingly.

Security Password
The security password is, for example, required when changing the status of the USB
and LAN interface or other security settings.
Note: We recommend that you change the default security password before connect-
ing the instrument to the network.
Note: Note that you cannot reset the password to factory state.
If you encounter problems with the password, contact the Rohde & Schwarz customer
support, see Chapter 12.5, "Contacting customer support", on page 584.

Old Password ← Security Password
Enter the currently used security password. The default password is '123456'.

New Password ← Security Password
Enter the new security password. The security password can only contain decimal
characters.

Confirm Password ← Security Password
Enter the new password for conformation.
The new password is only valid after the "Change Password" button is pressed.

Change Password ← Security Password
Changes the password accordingly.

7.7  Network settings

The instrument is equipped with a network interface and can be connected to an Ether-
net LAN (local area network). The "Network Settings" dialog provides access to the
network settings.

Network settings
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Access:

► Select "SGMA-GUI > Instrument Name > Setup > Network Settings".

The dialog provides access to the network settings, like settings about the general net-
work environment and specific identification of the computer in the network. The dialog
also displays an indication whether the instrument is connected to the network or not.

Settings:

Restart Network.......................................................................................................... 287
Hostname....................................................................................................................288
MAC Address.............................................................................................................. 288
Address Mode............................................................................................................. 288
IP Address...................................................................................................................288
Subnet Mask............................................................................................................... 288
Default Gateway..........................................................................................................289
Apply........................................................................................................................... 289

Restart Network
Shuts down the network connection of the instrument and then re-establishes the con-
nection.
This function can be used to resolve network problems.
Note: Only the connection of the instrument to the network restarts, the network itself
is not affected.

Network settings
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Hostname
Displays the individual computer name of the instrument.
A predefined name is indicated and can be used for network connections, see Chap-
ter 5.5.3, "Finding out the default hostname of the instrument", on page 74.
It is recommended that a connection of the instrument to the network is coordinated
with the network administrator. Connection errors can affect the entire network.
Remote command: 
:SYSTem:COMMunicate:NETWork[:COMMon]:HOSTname on page 540

MAC Address
Indicates the MAC address of the network adapter.

Address Mode
Selects if the IP address is assigned automatically or manually.
It is recommended that a connection of the instrument to the network is coordinated
with the network administrator. Connection errors can affect the entire network.
Note: Lost LAN connection to an instrument.
If the connection to an instrument configured to use static IP addresses is lost, press
the [LAN LED] on the instrument front panel.
Pressing triggers a reset of the assignment mode ("Address Mode > Auto (DHCP)".
"Auto (DHCP)" The IP address is assigned automatically.

The network used must support automatic assignment of IP address
via DHCP or APIPA (Zeroconf) to use this function.

"Static" The IP address is assigned manually.
Remote command: 
:SYSTem:COMMunicate:NETWork:IPADdress:MODE on page 539

IP Address
Displays the IP address. To enter the IP address manually, select "Address Mode >
Static".
If there is manual input of the IP address, it is recommended that a connection of the
instrument to the network is coordinated with the network administrator. Connection
errors can affect the entire network.
Remote command: 
:SYSTem:COMMunicate:NETWork:IPADdress on page 539

Subnet Mask
Displays the subnet mask. This number is used together with the IP address to identify
the network segment the instrument is in.
It is recommended that a connection of the instrument to the network is coordinated
with the network administrator. Connection errors can affect the entire network.
To enter the subnet mask manually, select "Address Mode > Static".
Note: When assigning the subnet mask manually, make sure that the address matches
with the subnet mask of the controlling host interface.

Network settings
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Remote command: 
:SYSTem:COMMunicate:NETWork[:IPADdress]:SUBNet:MASK on page 541

Default Gateway
Displays the IP address of the default gateway. To enter the default gateway manually,
select "Address Mode > Static".
This address identifies the router on the same network as the instrument that is used to
forward traffic to destinations beyond the local network.
It is recommended that a connection of the instrument to the network is coordinated
with the network administrator. Connection errors can affect the entire network.
Remote command: 
:SYSTem:COMMunicate:NETWork[:IPADdress]:GATeway on page 540

Apply
Applies the network settings to the instrument.

7.8  Remote channels

Access:

► Select "SGMA-GUI > Instrument Name > Setup > Remote".

The "Remote" dialog provides access to the settings for remote control.

Remote channels
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Settings:

Visa Resource Strings.................................................................................................290
Device Identity.............................................................................................................290

Visa Resource Strings
Indicates the VISA resource strings used for remote control of the instrument. A sepa-
rate string is provided for remote control via the different interfaces.
Note: For background information and description of the syntax of the VISA resource
strings, refer to the description of the corresponding interface in Chapter 9.1, "Remote
control interfaces and protocols", on page 312.
Remote command: 
:SYSTem:COMMunicate:HISLip:RESource? on page 542
:SYSTem:COMMunicate:NETWork:RESource? on page 541
:SYSTem:COMMunicate:SOCKet:RESource? on page 543
:SYSTem:COMMunicate:USB:RESource? on page 543
:SYSTem:COMMunicate:PCIexpress:RESource? on page 542

Device Identity
Triggers the device identification function. The [LAN] LED on the front panel of the
selected instrument blinks.
See also Chapter 5.5.4, "Bidirectional instrument identification", on page 74.

7.9  LXI status

The "LXI Status" dialog displays the settings and status of the LAN and allows you to
reset the LAN connection.

LXI status



General instrument settings and instrument setupR&S®SGT100A

291User Manual 1176.8674.02 ─ 12

Settings:

LAN Status.................................................................................................................. 291
LAN Reset...................................................................................................................291
Device Identity.............................................................................................................291

LAN Status
The LED indicates the LXI status.
The LAN status is also indicated with the LED "LAN Status" on the front panel of the
instrument.
"green" Normal operation
"green (flash-
ing)"

device identification

"red" LAN fault

LAN Reset
Initiates the network configuration reset mechanism for the instrument and resets the
hostname, MAC address and IP address.
According to the LXI standard, an LAN reset must place the following network settings
to a default state:

Parameter Value

"TCP/IP Mode" DHCP + Auto IP Address

"Dynamic DNS" Enabled

"ICMP Ping" Enabled

Password for LAN configuration "LxiWebIfc"

The LAN reset for the instrument also resets the following parameters:

Parameter Value

"Hostname" Instrument-specific host name

"Description" Vector signal generator

"Negotiation" Auto detect

"VXI-11 Discovery" Enabled

To open the "Instrument Home Page" (welcome page), type the instrument's computer
name (host name) or IP address in the address field of the browser on your PC, e.g.
http://10.111.10.175.
Note: Do not add the missing zeros in the IP address, while opening the instrument
home Page.

Device Identity
Triggers the device identification function. The [LAN] LED on the front panel of the
selected instrument blinks.

LXI status
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See also Chapter 5.5.4, "Bidirectional instrument identification", on page 74.

7.10  Emulations

You can control the R&S SGT remotely via the command set of another signal genera-
tor, for example the R&S SMATE generator. With this function you can, for example,
replace a signal generator with an R&S SGT in an automated test setup, without
adjusting the command scripts used.

For more information on this topic, see also application note 1GP109.

You find all the remote control command sets supported by the R&S SGT in a selection
list.

The selected instrument also defines the identification string that is retrieved with query
*IDN?. In addition to the preset values, you can enter a user-defined identification
string, for example to provide individual identification for each generator, like
'MY_R&S SGT' (see Identification Mode and IDN String).

As any other parameter, you can also change the remote control command set to be
emulated via the Language command. However, once you have switched to an emula-
tion, the R&S SGT-specific command set is disabled, that means this command is no
longer effective. To return, you need to know the corresponding remote control com-
mand of the simulated instrument.

Access:

► Select "SGMA-GUI > Instrument Name > Setup > Emulations".

Settings:

Language.................................................................................................................... 293
Identification Mode...................................................................................................... 293
Set to default............................................................................................................... 293
IDN String....................................................................................................................293
OPT String.................................................................................................................. 293

Emulations
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Language
Selects the instrument whose remote command set is emulated by the R&S SGT.
Remote command: 
:SYSTem:LANGuage on page 544

Identification Mode
Selects the way that the instrument identification is performed.
"Automatic" The "IDN String" and the "OPT String" are set automatically for the

instrument selected with the parameter Language.
"User Defined" Enables the selection of user definable "IDN String" and "OPT String"

for the instrument selected with the parameter Language.
Remote command: 
:SYSTem:IDENtification on page 544

Set to default
Overwrites the user-defined *IDN and *OPT strings with default strings.

Remote command: 
n.a.

IDN String
Indicates the identification string of the instrument when queried with the common
command *IDN?.

In addition to the preset values, a user-defined identification string can be entered, e.g.
to provide individual identification for each generator, like 'MY_R&S SGT' for instance.
Remote command: 
*IDN? on page 349

OPT String
Indicates the option string of the instrument as queried with the common command
*OPT?.

If "Mode > User Defined" is selected, a user-defined option string can be created also
to the automatically created one.
Remote command: 
*OPT? on page 350

7.11  Date and time

The "Date/Time" dialog provides access to setting a date and time.

Access:

► Select "SGMA-GUI > Instrument Name > Setup > Date/Time".

Date and time
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Settings:

Date.............................................................................................................................294
Time............................................................................................................................ 294
Time Zone................................................................................................................... 294

Date
Indicates the date in the format day.month.year.
To prevent accidental changes, this parameter is protected. It can be accessed with
protection level 1, see Chapter 7.5, "Protection", on page 281.
Remote command: 
n.a.

Time
Indicates the time in the format hour.minute.second.
To prevent accidental changes, this parameter is protected. It can be accessed with
protection level 1, see Chapter 7.5, "Protection", on page 281.
Remote command: 
n.a.

Time Zone
Selects a time zone from a list.
Remote command: 
:SYSTem:TIME:ZONE on page 549
:SYSTem:TIME:ZONE:CATalog? on page 549

7.12  Factory preset

The "Factory Preset" dialog provides a function to reset the instrument's settings to
their factory states.

Access:

1. Select "SGMA-GUI > Instrument Name > Setup > Factory Preset".

Factory preset
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2. Select "Execute Factory Preset".

The instrument's settings are reset to their factory states. Security settings and
user data are not affected.

Settings:

Execute Factory Preset...............................................................................................295

Execute Factory Preset
Reset the instrument's settings to their factory state.
Note: Because "Factory Preset" resets the "Remote Channel Settings" and "Network
Settings" to the default values, executing factory preset via remote control can termi-
nate the connection to the instrument, if these settings had been configured to values
different to the default ones.
The factory preset function resets nearly all instrument settings. In addition to the regu-
lar preset, a "Factory Preset" resets also the following values:
● Power on settings ("Level" dialog)
● Network settings including hostname ("Setup > Network Setting" dialog)
● Remote Channel settings ("Setup > Remote Channel" dialog)
To maintain security, password settings and all settings protected by these passwords
like disabled USB and LAN connections are not changed.
Not affected by the "Factory Preset" are also user data, lists or instrument settings
files, created, for example, with the "File Save As" function and currently saved on the
instrument's hard disc.
Remote command: 
:SYSTem:FPReset on page 354

7.13  Standby and restart

See Chapter 8.7, "How to switch between operating states", on page 306.

7.14  Diagnostic and tests

This section describes the settings provided for diagnostic and test purposes.

Diagnostic and tests
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Access:

► Select "SGMA-GUI > Instrument Name > Setup > Diagnostic / Test".

The selection provides the following settings.

Settings:

● Selftest.................................................................................................................. 296
● Connector test.......................................................................................................297
● Keyboard tests...................................................................................................... 297
● Power servoing test...............................................................................................298
● Simulation............................................................................................................. 299

7.14.1  Selftest

Access:

► Select "SGMA-GUI" > "<Instrument name>" > "Diagnostic / Test" > "Self Test".

To run a selftest

1. Select "SGMA-GUI" > "<Instrument name>" > "Diagnostic / Test" > "Self Test".

2. To trigger a selftest execution, select "Start Selftest".

Performs a self test on all installed hardware options.

The result of the selftest, succeeded or failed, is displayed. The list of the numeric
results of the performed test cases is protected by protection level 2.

Diagnostic and tests
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Settings:

Start Selftest
Triggers execution of a selftest off all installed hardware options.
How to: "To run a selftest" on page 296
Remote command: 
:TEST:ALL:STARt on page 551
:TEST:ALL:RESult? on page 551

7.14.2  Connector test

Access:

► Select "SGMA-GUI > Instrument Name > Diagnostic Tests > Connector Test".

The "Connector Test" dialog provides settings for testing the connection to an
external IQ device and performing a selftest of the baseband input.

Settings:

Execute Connection Test............................................................................................ 297

Execute Connection Test
Performs a connection test between the connectors [USER1] and [USER2].
Remote command: 
:TEST:BB:CONNection? on page 552

7.14.3  Keyboard tests

Access:

► Select "SGMA-GUI > Instrument Name > Diagnostic Tests > Keyboard Test".

Use this function to check the proper operation of all front panel elements.

Diagnostic and tests
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If "Keyboard Test" is enabled, all front panel LEDs except the [POWER ON] are
orange.

The exact test procedure is described in the service manual.

SCPI command:

:TEST:KEYBoard[:STATe] on page 551

7.14.4  Power servoing test

Access:

► Select "SGMA-GUI > Instrument Name > Diagnostic Tests > Power Servoing Test".

Use the test to check connections and settings of the power servoing function.

See also Chapter 6.7.6.8, "Power servoing", on page 238.

Settings:

Sensor.........................................................................................................................299
Run Test...................................................................................................................... 299
Result.......................................................................................................................... 299

Diagnostic and tests
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Sensor
Sets the power sensor from a list as detected in the "NRP Sensor Mapping" dialog.
If the list has only one entry, this power sensor is displayed automatically.
Remote command: 
[:SOURce]:POWer:SERVoing:SENSor on page 524

Run Test
Executes a power servoing test.
Remote command: 
[:SOURce]:POWer:SERVoing:TEST? on page 525

Result
Displays the state of the power servoing test
"Stopped" Initial state before executing "Run Test".
"Running" Intermediate state during test execution.
"Pass" Final state after successfully performing the test.
"Failed" Final state with errors during the test.

7.14.5  Simulation

The function is protected and can be used only in simulation mode. Simulation mode
requires creation of a virtual R&S SGT instrument.

Use the function for demonstration purposes, e.g. to show a specific hard- and soft-
ware configuration of the R&S SGT in the block diagram.

Access:

1. In the SGMA-GUI, create a virtual R&S SGT instrument:

a) Select "SGMA-GUI > Setup > Instruments > New".
b) Select "Instrument Type = SGT".

You can leave the other settings in the dialog.

2. Select "SGMA-GUI > Setup > Protection".

3. Enter the "Protection Level 1" password 123456.

4. Select "SGMA-GUI main panel > virtual instrument name > Setup > Diagnostic /
Test > Simulation".

Diagnostic and tests
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The dialog displays a list of software options.

5. Enable the option to be simulated.

The block diagram and the provided signal generator settings are updated accord-
ingly. You can open dialogs, interact with functions or observe the influence of set-
tings as if the virtual instrument is equipped with the selected options.
The signal generation function is disabled. The dialog and all unlicensed settings
disappear, if a connection to a physical instrument is detected.

7.15  External adjustments

The external adjustment is a protected service procedure that requires "Protection
Level 2" password. For a detailed test procedure, see the R&S SGT service manual.

Access:

► Select "SGMA-GUI > Instrument Name > Service > External Adjustments".

Depending on the installed options, the R&S SGT is equipped with a TCXO or OCXO
reference oscillator. The reference oscillator is factory calibrated to a specific calibra-

External adjustments



General instrument settings and instrument setupR&S®SGT100A

301User Manual 1176.8674.02 ─ 12

tion value. In the external adjustment dialog, you can select a different (custom) cali-
bration value.

Settings:

Active Adjustment Data...............................................................................................301
Calibration Value......................................................................................................... 301

Active Adjustment Data
Selects whether the factory provided or a user-defined calibration value is used to
adjust the reference oscillator.
Remote command: 
:CALibration:ROSCillator:DATA:MODE on page 357

Calibration Value
Sets a user-definable calibration value.
The permanent storage of this value in the instrument's memory is a password-protec-
ted function. The parameter is restored to its permanently stored value by "Preset" and
instrument restart.
Remote command: 
:CALibration:ROSCillator[:DATA] on page 357

External adjustments
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8  Performing configuration tasks
This section provides a general explanation on how to operate the instrument manually
via the R&S SGMA-GUI software.

We assume, that the R&S SGT is connected to a remote PC. The R&S SGMA-GUI
software is installed on this remote PC and the instrument has to be added to the list of
"Available Instruments".

For information on how to fulfill these requirements, refer to:
● "Connecting to the network" on page 29
● Chapter 3.1.13.1, "Installing the R&S SGMA-GUI software", on page 27
● "Adding instruments to R&S SGMA-GUI" on page 31

8.1  How to configure the reference oscillator source

To use the internal reference frequency source

1. To enable the instrument to use its internal reference frequency source, perform
one of the following:

a) Select "SGMA-GUI main panel > Ext Ref Off".
b) Select "SGMA-GUI > Instrument Name > RF > Reference Oscillator > Source >

Int".

2. In the "Reference Oscillator" dialog, set the "REF/LO Out > REF".

The "Output Frequency" can be configured to either 10 MHz or 1 GHz.

The instrument uses the internal reference signal. The [REF EXT] LED at the front
panel of the instrument is off.

To output the reference frequency (internal or external) at the REF/LO OUT connector
of the instrument, select "Reference Oscillator > REF/LO Output > REF".

To use an external reference frequency source

To improve measurement accuracy, provide one external reference frequency signal to
all the instruments in the test setup. Alternatively, distribute the internal reference sig-
nal of the R&S SGT to the remaining instruments.

1. Provide the signal of an external reference frequency source to the REF/LO IN
connector of the instrument.

2. To enable the instrument to use the external reference frequency source, perform
one of the following:

a) Select "SGMA-GUI main panel > REF > Ext Ref On".

How to configure the reference oscillator source
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b) Select "SGMA-GUI > Instrument Name > RF > Reference Oscillator > Source >
Ext".

3. In the "Reference Oscillator" dialog, set the parameter "Ext. Ref. Input Frequency"
to the value of the fed external reference frequency.

Now, the instrument uses an external reference signal. The green [REF EXT] LED
at the front panel of the instrument indicates that the instrument is synchronized to
the external reference signal.

If the instrument is configured to use an external reference signal but no signal is fed in
at the "REF IN" connector, the [REF EXT] LED on the front panel of the instrument is
red and an error message is displayed in the "Info" line.

8.2  How to configure the local oscillator coupling source

For local oscillator (LO) coupling, the R&S SGT can use two frequency sources: An
internal and an external frequency source. The first possibility is to use the output sig-
nal of the internal synthesizer. If an external LO signal is provided at the "REF/LO IN"
connector, this signal can alternatively be directly routed to the LO input of the I/Q
modulator.

To use an external LO source

1. Provide the signal of an external LO source to the "REF IN" connector of the instru-
ment.

Note: The local oscillator input/output requires the additional software option
R&S SGT-K90.

2. Select "SGMA-GUI > Instrument Name > Frequency/Phase > LO Coupling Source
> Ext".

Tip: When you select "Source > Ext", the icon LO Scr Ext appears in the
R&S SGMA-GUI.

The signal provided by the external frequency source is directly routed to the input
of the I/Q modulator and used as carrier frequency.

To use the internal LO source

► Select "SGMA-GUI > Instrument Name > Frequency/Phase > LO Coupling Source
> Int".

The output signal of the internal synthesizer is used.

How to configure the local oscillator coupling source
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8.3  How to define the signal at the REF/LO OUT connec-
tor

The reference oscillator and the LO use the same "REF IN" connector. Hence, it is not
possible to use both an external reference source and an external LO source signal at
the same time.

The signal at the "REF OUT" connector also depends on the selected reference oscil-
lator and LO sources. The following table gives an overview of this dependency.
Table 8-1: Selection available at the REF/LO OUT connector depending on the LO and reference

oscillator sources

 LO coupling source  

Ref. oscillator source Int "Ext"

"Int" "OFF/REF/LO" "OFF/LO"

"Ext" "OFF/REF/LO" Combination not possible

To define the signal at the REF/LO OUT connector

1. In the "Frequency / Phase > Local Oscillator (LO) Coupling" dialog, select the "LO
Source" as required.

2. In the "Reference Oscillator" dialog, select the "Ref. Oscillator Source" as required.

3. In the "Frequency / Phase > Local Oscillator (LO) Coupling" dialog, set the
"REF/LO Output".
For dependencies, see Table 8-1.

8.4  How to create and save ARB test signals

If your test case requires a simple sine or square test file, consider to use the provided
ARB test signals.

1. Select "Baseband > ARB >General"

2. Select "Create Test Signal > Sine".

3. In the "Sine Test Signals"dialog, adjust the settings as required.

4. To create the test signal file, proceed as follows:

a) Select "Generate Signal File".
b) Navigate through the directory tree (e.g. /var/user/).
c) Enter a file name (e.g. sine_waveform).
d) Select "Save".

The R&S SGT saves the generated waveform file and automatically loads it in the
ARB.

How to create and save ARB test signals
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5. Select "ARB > State > On".

The R&S SGT processes the waveform file.

8.5  How to load and play waveform files

Irrespective of the way a waveform file is generated, you can transfer it to the instru-
ment, load it in the ARB and play it.

To load and play a waveform file from the instrument

1. To transfer an externally created waveform file to the instrument, see Chapter 4.2,
"Managing files on the R&S SGT", on page 50.

2. Select "Baseband > ARB > General".

3. Set "Waveform Location > Instrument".

4. To load the waveform file, proceed as follows:

a) Select "Load Waveform".
b) Navigate to the directory in which you saved the file.
c) Select the waveform file (e.g. /var/user/lte_waveform).
d) Click "Select" to finish loading.

The "ARB" dialog confirms that the waveform file is loaded.

5. Select "ARB > State > On".

The R&S SGT processes the waveform file.

To load and play a waveform file from an external computer

1. Connect the R&S SGT and a Windows PC with an installed R&S SGMA-GUI to the
same network.

2. On the remote PC, select "SGMA-GUI > Instrument Name > Baseband > ARB >
General".

3. Set "Waveform Location > Local file system".

4. To load the waveform file, proceed as follows:

a) Select "Load Waveform".
b) Navigate to the directory in which you saved the file.
c) Select the waveform file (e.g. /var/user/lte_waveform).
d) Click "Select" to finish loading.

Note: You can also select an external USB connected to the PC at the available
local file directories.
The "ARB" dialog confirms that the waveform file is loaded.

How to load and play waveform files
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5. Select "ARB > State > On".

The R&S SGT processes the waveform file.

8.6  How to restore the LAN connection

If you lose the LAN connection of the instrument, for example, after assigning a static
IP address, proceed as follows:

► On the front panel of the instrument, press the [LAN] LED for more than 3 seconds.

Pressing trigger a reset of the LAN settings. In particular, the "Address Mode"
on page 288 switches to "DHCP".

If your network supports automatic assignment of IP address, the new IP address
is assigned to the instrument automatically.

8.7  How to switch between operating states

The Figure 8-1 gives an overview of the operating states of the instruments and how to
trigger the switch-over between them.

Figure 8-1: Operating states

"Setup" > "Standby", "Setup" > "Restart","Shut Down
Instruments and Exit"

= R&S SGMA-GUI controls

[POWER ON/STANDBY], power switch [I/0] = Hardkey controls on the front/rear panel of the
instrument

The Table 8-2 provides a short description of the operating states and their indication.

How to switch between operating states
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Table 8-2: Indication of the operating states

Operating
state

Description Indication

Off The instrument is shut down. All LEDs on the front panel of the instrument
are off.

Booting The instrument boots the operating system
and starts the instrument firmware.

If the previous session was terminated reg-
ularly, the instrument uses the last setup
with the relevant instrument settings.

The green [POWER ON/STANDBY] key blinks.

Standby In this state, it is safe to switch off the AC
power and disconnect the instrument from
the power supply.

The remote control system is not active.

In the R&S SGMA-GUI, the status indicator in
front of the instrument name is red.

The orange [POWER ON/STANDBY] key is
on.

Ready

(normal
operation)

The instrument is ready for operation. All
modules are power-supplied.

In the R&S SGMA-GUI, the status indicator in
front of the instrument name is green.

The green [POWER ON/STANDBY] key is on.

To switch the instrument to standby state

► Use one of the following:

a) On the remote PC, select "SGMA-GUI > Instrument Name > Setup > Standby".
b) Press the [POWER ON/STANDBY] key on the front panel of the instrument.
c) Send the SCPI command:

:SYSTem:REBoot
The current instruments settings are automatically saved. The instrument switches
to a power-saving mode.
In the R&S SGMA-GUI, the standby state is indicated by the red state symbol in
front of the corresponding instrument's name, on the front panel, by the orange
[POWER ON/STANDBY] button.

To return the instrument from standby to ready state

► Use one of the following:

a) On the remote PC, select "SGMA-GUI > Instrument Name > Setup > Restart".
b) Press the orange [POWER ON/STANDBY] key on the front panel of the instru-

ment.

The instrument loads the last setup with all instrument settings, switches to ready
state and is ready for normal operation.
In the R&S SGMA-GUI, the ready state is indicated by the green state symbol in
front of the instrument's name.
On the front panel, the ready state is indicated by the green [POWER ON/
STANDBY] button.

How to switch between operating states
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To switch all connected instruments to standby state and close the R&S SGMA-
GUI

► In the R&S SGMA-GUI main panel, select "File > Shut down instruments and exit".

The R&S SGMA-GUI quits and switches the connected instruments to standby
state.

For description on how to terminate work and shut down the instrument regularly, see
Chapter 3.1.10, "Switching on or off", on page 24.

8.8  How to use computer names

If there is a name server in the network, alternatively to the IP address each PC or
instrument connected in a LAN can be accessed via an unambiguous computer name.
Each instrument is delivered with an assigned computer name, but this name can be
changed.

For instruction on how to find out the default computer name, refer to Chapter 5.5.3,
"Finding out the default hostname of the instrument", on page 74.

To query and change a computer name

To avoid violations and to use easy identification provided by the computer name, we
recommend that you to keep the default hostname unchanged.

1. Open "SGMA-GUI > Instrument Name > Setup > Network Settings" dialog.

The computer name is displayed under "Hostname".

2. Select "SGMA-GUI > Instrument Name > Setup > Protection"

3. Enable the "Protection Level 1".

The parameter "Hostname" in the "Network Settings" dialog is now enabled for
configuration.

4. Change the "Hostname".

5. Press the [POWER ON/STANDBY] key to restart the instrument.

Note: The "Factory Preset" function restores the factory value of the parameter
"Hostname".

8.9  How to install a new firmware version on the instru-
ment

You can update the firmware of the R&S SGT.

How to install a new firmware version on the instrument
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Firmware installation via R&S SGMA-GUI

Install or update the firmware of the R&S SGT before installing or updating the soft-
ware R&S SGMA-GUI.

1. Select "SGMA-GUI main panel > Instrument Name > Setup > Maintenance > Oper-
ation > Install firmware package".

2. Press "Select Package" and navigate to the directory of the new firmware.

3. If several instruments require a firmware update, enable "Update All" to accelerate
the update procedure.

All instruments that are in active state and are connected to this controller are
updated simultaneously.

4. Enter the "Security Password".

5. Confirm the update with "Accept".

The software transfers the firmware file and automatically starts the update proce-
dure. During the update, the message "Updating Firmware" is displayed in the
"Info" line. The update process is indicated by an LED running light.

Note: The update procedure requires a restart of the instrument. The restart is per-
formed automatically. The instrument is not accessible during that time.

6. Wait until the message "Updating Firmware" disappears. After the message disap-
pears, the update is complete.

The [POWER ON/STANDBY] LED is green.

7. If necessary, install the new R&S SGMA-GUI.
For detailed description, refer to Chapter 3.1.13.1, "Installing the R&S SGMA-GUI
software", on page 27

8. If you connect the instrument and the controller/PC over the PCIe interface and the
external PC does not support hot-plugging, restart the external PC.

Firmware update through a session control protocol (SCP)

Install or update the firmware of the R&S SGT before installing or updating the soft-
ware R&S SGMA-GUI.

1. Connect the R&S SGT and a Windows PC to the same network.

2. On the PC, open a windows explorer window.

3. To connect to the R&S SGT, enter the name of the instrument or its IP address in
the windows taskbar.

How to install a new firmware version on the instrument
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4. Enter the user name and password to connect to the R&S SGT. The default user
name is instrument and the password is instrument.

A folder opens, containing the share and the update folder.

5. Open the update folder.

6. Copy the new firmware update file into the folder.

The update starts automatically.

How to install a new firmware version on the instrument
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Unsuccessful or erroneous firmware update
An erroneous or unsuccessful installation of firmware update package is indicated by a
combination of one orange and red LEDs on the front panel.
Refer to the service manual for a description of the displayed error code or contact the
customer support center, see Chapter 12.5, "Contacting customer support",
on page 584.

8.10  How to activate options

A firmware update before the activation of the SW option can be required.
Refer to the description of the SW option for the required firmware version.
See also Chapter 8.9, "How to install a new firmware version on the instrument",
on page 308 for instruction on how to update the firmware version.

1. Select "SGMA-GUI main panel > Instrument Name > Setup > Install SW-Options".

2. Select "Option Key".

3. Enter the key code delivered with the new option.

4. Restart the instrument.

The new option is now enabled and ready for operation.

How to activate options
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9  Network operation and remote control
As an alternative to operating the R&S SGT interactively via the R&S SGMA-GUI, you
can operate the R&S SGT also from a remote location.

Information on network operation and remote control
The following descriptions provide information required for operating the R&S SGT
remotely. The information applies to all applications and operating modes supported by
the instrument. Definitions specified in the SCPI standard are not provided.
For basic knowledge on remote control operation and additional information, see the
following documents, available on the Rohde & Schwarz website:
● Remote control via SCPI
● 1GP72: Connectivity of Rohde&Schwarz Signal Generators
● 1MA208: Fast Remote Instrument Control with HiSLIP

● Remote control interfaces and protocols...............................................................312
● Starting a remote control session..........................................................................321
● Advanced remote control using PCIe....................................................................322
● Advanced remote control using fast socket.......................................................... 327
● Status reporting system........................................................................................ 329
● LXI configuration................................................................................................... 337
● Monitoring remote control operation with R&S SGMA-GUI.................................. 345

9.1  Remote control interfaces and protocols

The instrument supports several interfaces for remote control. The following table gives
an overview.
Table 9-1: Remote control interfaces and protocols

Interface Protocols, VISA*) address string and Library Remarks

Local Area
Network
(LAN)

● HiSLIP High-Speed LAN Instrument Protocol
(IVI-6.1)
TCPIP::host address::hislip0[::
INSTR]

● VXI-11
TCPIP::host address::inst0[::INSTR]
Library: VISA

● Socket communication (Raw Ethernet, simple
Telnet, Fast Socket)
TCPIP::host address[::
LAN device name]::<port>::SOCKET
Library: VISA or socket controller

A LAN connector is located on the
rear panel of the instrument.

The interface is based on TCP/IP and
supports various protocols.

For details, see Chapter 9.1.2, "LAN
interface", on page 316

USB USBTMC
USB::<vendor ID>::<product ID>::
<serial number>[::INSTR]
Library: VISA

A USB connector is located on the
rear panel of the instrument.

For details, see Chapter 9.1.3, "USB
interface", on page 319

Remote control interfaces and protocols
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Interface Protocols, VISA*) address string and Library Remarks

PCIe Proprietary
PCIe::<vendor ID>::<product ID>::
<serial number>[::INSTR]
Library: PCIe controller

A PCIe connector is located on the
rear panel of the instrument.

For details, see Chapter 9.1.4, "PCI
Express interface", on page 319

GPIB (IEC/
IEEE Bus
Interface)

–
● GPIB::<address>[::INSTR] (no secondary

address)
VISA

The instrument is not equipped with
GPIB bus interfaces. Use a GPIB-to-
LAN or GPIB-to-USB adapter instead.

For details, see Chapter 9.1.5, "GPIB
interface (IEC/IEEE bus interface)",
on page 320

*) VISA is a standardized software interface library that provides input and output func-
tions to communicate with instruments. A VISA installation on the controller is a prereq-
uisite for remote control over LAN (when using VXI-11 or HiSLIP protocol) or USB.
However, no VISA installation is necessary for remote control while using socket com-
munication. For more information about VISA, refer to the user documentation.

Rohde & Schwarz provides the standardized I/O software library R&S VISA for com-
munication via TCP/IP (LAN: HiSLIP, VXI-11 and raw socket) or USB (USBTMC) inter-
faces.
R&S VISA is available for download at the Rohde & Schwarz website http://
www.rohde-schwarz.com/rsvisa.

SCPI (Standard Commands for Programmable Instruments)

SCPI commands are used for remote control. Commands that are not taken from the
SCPI standard follow the SCPI syntax rules. The instrument supports the SCPI version
1999. The SCPI standard is based on standard IEEE 488.2 and aims at the standardi-
zation of device-specific commands, error handling and the status registers. The tuto-
rial "Automatic Measurement Control - A tutorial on SCPI and IEEE 488.2" from John
M. Pieper (R&S order number 0002.3536.00) offers detailed information on concepts
and definitions of SCPI.

9.1.1  Remote control programs and libraries

The Figure 9-1 provides a schematic illustration of the remote control capabilities of the
instrument.

Remote control interfaces and protocols
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Figure 9-1: Remote control interfaces, protocols and libraries

The following examples give an overview of the dependencies between the available
libraries, the possible interfaces and protocols, and whether an instrument driver is pro-
vided. The involved parts are highlighted.
● Remote control program using VISA

Figure 9-2: Remote control program using VISA

Protocol Remote control program

Socket viOpen (..., "TCPIP:rssgt100a100010::5025::SOCKET", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

VXI-11 viOpen (..., "TCPIP:rssgt100a100010::inst0::INSTR", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

HiSLIP viOpen (..., "TCPIP:rssgt100a100010::hislip0::INSTR", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

USBTMC viOpen (..., "USB::0x0aad::0x00EC::1000010::INSTR", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

● Remote control program using instrument driver (VISA available)

Remote control interfaces and protocols
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Figure 9-3: Remote control program using instrument driver (VISA available)

Protocol Remote control program

Socket rssgt_init ("TCPIP:rssgt100a100010::5025::SOCKET", ...)
rssgt_SetFrequency (..., 2e9)

VXI-11 rssgt_init ("TCPIP:rssgt100a100010::inst0::INSTR", ...)
rssgt_SetFrequency (..., 2e9)

HiSLIP rssgt_init ("TCPIP:rssgt100a100010::hislip0::INSTR", ...)
rssgt_SetFrequency (..., 2e9)

USBTMC rssgt_init ("USB::0x0aad::0x00EC::1000010::INSTR", ...)
rssgt_SetFrequency (..., 2e9)

PCIe rssgt_init ("PCIe::0x162f::0x1336::1000010::INSTR", ...)
rssgt_SetFrequency (..., 2e9)

● Remote control program using instrument driver (VISA not available)

Figure 9-4: Remote control program using instrument driver (VISA not available)
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Protocol Remote control program

Socket rssgt_init ("TCPIP:rssgt100a100010::5025::SOCKET", ...)
rssgt_SetFrequency (..., 2e9)

PCIe rssgt_init ("PCIe::0x162f::0x1336::1000010::INSTR", ...)
rssgt_SetFrequency (..., 2e9)

9.1.2  LAN interface

To be integrated in a LAN, the instrument is equipped with a LAN interface, consisting
of a connector, a network interface card and protocols.

For remote control via a network, the PC and the instrument must be connected via the
LAN interface to a common network with TCP/IP network protocol. They are connected
using an RJ45 cable (shielded or unshielded twisted-pair category 5). The TCP/IP net-
work protocol and the associated network services are preconfigured on the instru-
ment. Software for instrument control and (for specified protocols only) the VISA pro-
gram library must be installed on the controller.

Identifying instruments in a network
If several instruments are connected to the network, each instrument has its own IP
address and associated resource string. The controller identifies these instruments by
the resource string.

9.1.2.1  VISA resource strings

The VISA resource string is required to establish a communication session between
the controller and the instrument in a LAN. The resource string is a unique identifier,
composed of the specific IP address of the instrument and some network and VISA-
specific keywords.

TCPIP::host address[::LAN device name][::INSTR]
● TCPIP designates the network protocol used
● Host address is the IP address or host name of the device

See also Chapter 5.5.3, "Finding out the default hostname of the instrument",
on page 74.

● [::LAN device name] defines the protocol and the instance number of a subinstru-
ment:

● [::INSTR] indicates the instrument resource class (optional)

The IP address (host address/computer name) is used by the programs to identify and
control the instrument. It is automatically assigned by the DHCP server the first time
that the device is registered on the network. Alternatively, you can also assign its LAN
device name.

You can find the IP address in the "SGMA-GUI > Instrument Name > Setup > Remote"
dialog, and also adjust it manually, if necessary.

Remote control interfaces and protocols
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See below the characteristics of the VISA resource strings for the corresponding inter-
face protocols. The highlighted characters are crucial.

HiSLIP

TCPIP::host address::hislip0[::INSTR]
● hislip0 HiSLIP device name, designates that the interface protocol HiSLIP is used

(mandatory).

hislip0 is composed of [::HiSLIP device name[,HiSLIP port]] and must be assigned.

For details of the HiSLIP protocol, refer to Chapter 9.1.2.2, "HiSLIP protocol",
on page 317.

VXI-11

TCPIP::host address[::inst0][::INSTR]
● [::inst0] LAN device name, indicates that the VXI-11 protocol is used (optional).

inst0 currently selects the VXI-11 protocol by default and can be omitted.

For details of the VXI-11 protocol, refer to Chapter 9.1.2.3, "VXI-11 protocol",
on page 318.

Socket communication

TCPIP::host address::port::SOCKET
● Port determines the used port number
● SOCKET indicates the raw network socket resource class

Socket communication requires the specification of the port (commonly referred to as
port number) and of "SOCKET" to complete the VISA resource string with the associ-
ated protocol used.

The registered port for socket communication is port 5025.

See also Chapter 9.1.2.4, "Socket communication", on page 318.

Example: 
● Instrument has the IP address 10.113.11.91; the valid resource string using VXI-11

protocol is:
TCPIP::10.113.11.91::INSTR

● The DNS host name is rssgt100a100021; the valid resource string is:
TCPIP::rssgt100a100021::hislip0 (HiSLIP)
TCPIP::rssgt100a100021::inst0 (VXI-11)

● A raw socket connection can be established using:
TCPIP::10.113.11.91::5025::SOCKET

9.1.2.2  HiSLIP protocol

The High Speed LAN Instrument Protocol (HiSLIP) is the successor protocol for VXI-11
for TCP-based instruments specified by the IVI foundation. The protocol uses two TCP
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sockets for a single connection - one for fast data transfer, the other for non-sequential
control commands (e.g. Device Clear or SRQ).

HiSLIP has the following characteristics:

● High performance as with raw socket network connections
● Compatible IEEE 488.2 support for Message Exchange Protocol, Device Clear,

Serial Poll, Remote/Local, Trigger, and Service Request
● Uses a single IANA registered port (4880), which simplifies the configuration of fire-

walls
● Supports simultaneous access of multiple users by providing versatile locking

mechanisms
● Usable for IPv6 or IPv4 networks

Using VXI-11, each operation is blocked until a VXI-11 instrument handshake returns.
However, using HiSLIP, data is sent to the instrument using the "fire and forget"
method with immediate return. Thus, a successful return of a VISA operation such as
viWrite() guarantees only that the command is delivered to the instrument's TCP/IP
buffers. There is no confirmation, that the instrument has started or finished the
requested command.

For more information see also the application note:

1MA208: Fast Remote Instrument Control with HiSLIP

9.1.2.3  VXI-11 protocol

The VXI-11 standard is based on the ONC RPC (Open Network Computing Remote
Procedure Call) protocol which in turn relies on TCP/IP as the network/transport layer.
The TCP/IP network protocol and the associated network services are preconfigured.
TCP/IP ensures connection-oriented communication, where the order of the
exchanged messages is adhered to and interrupted links are identified. With this proto-
col, messages cannot be lost.

9.1.2.4  Socket communication

An alternative way for remote control of the software is to establish a simple network
communication using sockets. The socket communication, also referred to as “Raw
Ethernet communication”, does not require a VISA installation on the remote controller
side.

The simplest way to establish socket communication is to use the built-in telnet pro-
gram. The telnet program is part of every operating system and supports communica-
tion with the software on a command-by-command basis.

Socket connections are established on a specially defined port. The socket address is
a combination of the IP address or the host name of the instrument and the number of
the port configured for remote-control. All instruments use port number 5025 for this
purpose. The port is configured for communication on a command-to-command basis
and for remote control from a program running on a connected PC.

Remote control interfaces and protocols
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The instrument also supports the fast socket channel. For details, see Chapter 9.4,
"Advanced remote control using fast socket", on page 327.

9.1.3  USB interface

For remote control via USB connection, the PC and the instrument must be connected
via the USB interface. A USB connection requires the VISA library to be installed. VISA
detects and configures the R&S instrument automatically when the USB connection is
established. You do not have to install a separate driver.

USB resource string

The syntax of the used USB resource string is:
USB::<vendor ID>::<product ID>::<serial number>[::INSTR], where:
● USB denotes the used interface
● <vendor ID> is the manufacturer ID for Rohde&Schwarz
● <product ID> is the product identification of the R&S instrument
● <serial number> is the individual serial number on the rear of the instrument
● [::INSTR] indicates the instrument resource class (optional)

You can retrieve the USB resource string from the "SGMA-GUI > Instrument Name >
Setup > Remote" dialog.

Example: 
USB::0x0AAD::0x00EC::100021::INSTR
0x0AAD is the vendor ID for Rohde & Schwarz.
0x00EC is the product ID for the R&S SGT.
100021 is the serial number of the particular instrument.

9.1.4  PCI Express interface

A PCI Express (PCIe) connector is provided on the rear panel of the instrument.

Refer to Chapter 9.3, "Advanced remote control using PCIe", on page 322 for a
description of how to set up a remote control connection via PCIe and the permitted
cables.

Via PCI Express some commands can be sent to the instrument with optimized speed
(memory-mapped remote control), e.g. frequency or level settings. Speed optimization
allows minimum setup time.

PCIe resource string

The syntax of the used PCIe resource string is:
PCIe::<vendor ID>::<product ID>::<serial number>[::INSTR], where:
● PCIe denotes the used interface
● <vendor ID> is the manufacturer ID for Rohde & Schwarz
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● <product ID> is the product identification of the R&S instrument
● <serial number> is the individual serial number on the rear of the instrument
● [::INSTR] indicates the instrument resource class (optional)

You can retrieve the PCIe resource string from the "SGMA-GUI > Instrument Name >
Setup > Remote" dialog.

Example: 
PCIe::0x162f::0x1336::100021::INSTR
0x162f is the vendor ID for Rohde & Schwarz.
0x1336 is the product ID for the R&S SGT.
100021 is the serial number of the particular instrument.

9.1.5  GPIB interface (IEC/IEEE bus interface)

The R&S SGT is not equipped with an IEC/IEEE bus interface.

To be able to control the instrument via the GPIB bus:

1. Connect a GPIB-to-LAN or a GPIB-to-USB adapter to the instrument.

2. Use a GPIB bus cable to connect the instrument and the controller.

3. Provide the GPIB bus card, the card drivers and the program libraries for the pro-
gramming language in the controller.

4. In the "SGMA-GUI > Setup > Instruments > instrument name > Remote Control",
set the "GPIB Address".
See "GPIB Address" on page 61.

5. If the controller has several GPIB bus cards, define the used "Board Number".

GPIB address

The controller must address the instrument with the GPIB bus channel. GPIB provides
channel addresses from 0 to 30.

The GPIB resource string is GPIB::<address>[::INSTR], where:
● GPIB denotes the used interface.
● <address> indicates the used channel.
● [::INSTR] indicates the instrument resource class (optional).

Note: If the VISA implementation supports the GPIB interface, you can optionally
define the VISA instrument control resource (INSTR). It is used to define the basic
operations and attributes for a device, such as reading, writing, or triggering.

Any connected IEC bus cable must be terminated by an instrument or controller.

Remote control interfaces and protocols



Network operation and remote controlR&S®SGT100A

321User Manual 1176.8674.02 ─ 12

9.2  Starting a remote control session

To start a remote control session, connect the instrument and the controller with a suit-
able cable and switch on both of them.

A remote control program must open a connection to the instrument, before it can send
commands to and receive device responses from the instrument.

Instrument address
To operate the instrument via remote control, it must be addressed using the defined
interface address.
See Chapter 9.1.2, "LAN interface", on page 316, Chapter 9.1.3, "USB interface",
on page 319 or Chapter 9.1.4, "PCI Express interface", on page 319 for details.

The VISA resource strings are indicated in the "SGMA-GUI main panel > Instrument
name > Setup > Remote Channels" dialog.

9.2.1  How to find the VISA resource string

To find the VISA resource strings of your instrument:

► Select "SGMA-GUI main panel > Instrument name > Setup > Remote Channels".

The "Remote Channel Settings" dialog shows all specified resource strings of the
supported remote control interfaces.

9.2.2  Remote control over LAN using socket communication

This section provides an example of how to establish a remote control connection over
telnet protocol and a simple sockets-based program example that can be further devel-
oped (see also Chapter A, "Telnet program examples", on page 587).

Basic knowledge of programming and operation of the controller are assumed. A
description of the interface commands can be obtained from the relevant manuals.

Refer to the getting started manual for an example of how to set up remote control con-
nection over LAN using VXI-11 protocol.

To set up a Telnet connection

To control the software, only a telnet program is required. The telnet program is part of
every operating system.

1. To establish a Telnet connection with the R&S SGT, start the telnet program.

2. Enter the socket address.

Starting a remote control session
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The socket address is a combination of the IP address or the host name of the
R&S SGT and the number of the port configured for remote-control via telnet.
Tip: The R&S SGT uses the port number 5025 for remote connection via Telnet.

The connection to the instrument is set up and remote-control commands can be
sent.

3. Even if the cursor is not visible on the screen, enter blind a remote-control com-
mand.

4. Confirm with "Enter".

9.3  Advanced remote control using PCIe

The PCIe bus is a high-speed serial bus, composed of point-to-point serial links. A pair
of serial links, one transmitting and one receiving link, make up a lane.

Fast settings

The PCIe interface can be utilized not only to transfer text messages, e.g., SCPI com-
mands but also to carry register based remote control messages. The latter mode is
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called fast settings mode. The specially for this purpose provided instrument's driver is
mandatory for the instrument control with fast settings. This instrument driver contains
special functions for fast setup.

To use the advantage of the fast settings, the following prerequisites must be fulfilled:
● Using the PCIe interface is mandatory (see also Chapter 9.3.1, "Setting up a

remote control connection via PCIe", on page 323)
● The fast settings must be enabled with the function rssgt_useFastSettings

(see also Chapter 9.3.5, "Enabling fast settings", on page 327).

The instrument driver automatically uses the fast settings method whenever possible -
currently only for the parameters frequency, level, RF state, modulator state - and
sends SCPI messages in all other cases.

Remote control programs written for PCIe will, without modifications, also run if one of
the other control channels, LAN or USB is used.

9.3.1  Setting up a remote control connection via PCIe

To set up a remote control connection vie PCIe, perform the following steps:

1. Download the drivers: See 9.3.2.

2. Configure the controller: See 9.3.3

3. Connect the controller and the instrument: See 9.3.4

4. Enable fast settings: See 9.3.5.

9.3.2  Downloading the drivers

All required driver files are available for download on the product page at:

http://www.rohde-schwarz.com/product/SGT100A.html > "Downloads" > "Drivers"

Provided are the following files:
● LabWindows/CVI, Linux/OSX driver rssgt (InstrumentDriver)

C source code files which provide a functional application programming interface
(API) to R&S SGT instruments. Required if you want to control an instrument via
PCIe.

● Low-Level SGT drivers
Archive file that contains the following:
– KernelDriver

C source code files from which you can build a Linux kernel mode driver for the
R&S SGT PCIe remote control interface.

– SgtDriverDemo
C source code module for a demo program using the instrument driver API.

Advanced remote control using PCIe
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– SharedLibraries-Dlls
Shared libraries (*.dll files) for remote control channels Socket and PCIe. To
be used with the instrument driver.

● VXIplug&play x64/x86 driver rssgt
Download the required archive and extract the files on a remote PC.

9.3.3  Configuring the controller

This section lists the steps necessary to configure a controller with Linux or Windows
operating system.

9.3.3.1  Building and installing the hardware driver

The hardware driver defines the way to communicate with the instrument via PCIe
interface.

For Windows operating systems, the hardware driver is installed automatically together
with the installation of the R&S SGMA-GUI software.
See also section "Installation of R&S SGMA-GUI Software" in the getting started man-
ual.

For Linux operating system, the source code of the driver is included in the
Low-Level SGT drivers file.

To build and install this driver, root authority is required.

1. Copy folder KernelDriver to your hdd

2. Go to directory host.

3. On the command line, enter make.

The driver sgshost.ko is automatically built.

4. Enter make install.

Device nodes sgtX are created under the folder /dev (X from 0 to 31).
The module sgthost is loaded.

5. Enter lsmod to verify the module.

9.3.3.2  Making shared libraries accessible

Two library files per operating system are included in SharedLibraries-Dlls file:
● For Linux operating system

libsocketcontroller.so and libpciecontroller.so
● For Windows operating system

SocketController.dll and PCIeController.dll

Advanced remote control using PCIe
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These libraries act as the dynamic link libraries for programs using the socket or PCIe
interface.

Linux operating system

► To make the libraries accessible, perform one of the following:

a) Append the environment variable LD_LIBRARY_PATH with the path of these
two files, e.g., by changing the /etc/environment file.

b) Move these two files to /usr/lib or /lib directory.

Windows operating system

► To make the libraries accessible, perform one of the following:

a) Copy these two files to the folder of your executable.
b) Copy these two files to the WINDOWS\system32 folder.

9.3.3.3  Building a program

The help file rssgt_vxi.chm shows all functions of the instrument which you can use
in your own remote control program.

An example file is provided ( SgtDriverDemo.c), too.

Building the example program (Linux)

1. Copy folders InstrumentDriver and SgtDriverDemo to your hard disk.

2. Go to folder Build

3. On the command line, enter cmake ..

4. Enter make
Folder Build contains the executable SgtDriverDemo.

Building the example program (Windows)

1. Copy folders InstrumentDriver and SgtDriverDemo to your hard disk.

2. Open SgtDriverDemo.vcproj with Visual Studio.

3. Build the program.

Running the example program

► On the command line, enter ./SgtDriverDemo RESOURCESTRING [cmd].

Where
● RESOURCESTRING is the (VISA) resource string of your instrument, e.g.

TCPIP::ipaddress::5025::SOCKET or PCIE::0x162f::
0x1336::serialno::INSTR.
Where ipaddress is the IP address or hostname of your instrument and
serialno is its serial number.
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● cmd is an optional command (see table).

The following table list the available commands.

Command Description

? Usage

q Quit

f value Set frequency

f? Query frequency

l value Set level

l? Query level

rvalue Set RF state (value = 0 | 1 | ON | OFF)

r? Query RF state

If you enter an additional optional command, SgtDriverDemo executes it and
enters a loop waiting for further commands.

Example: 
TCPIP::10.111.11.44::5025::SOCKET ?
Lists the available commands.

9.3.4  Connecting the controller and the instrument

The "PCIe" connector is located on the rear panel.

Permitted PCIe cables
PCIe extension cables must fulfill the following requirements:
● Single lane connectors
● Maximum cable length of 5 m.

For example: OSS-PCIe-CBL-x1 cable from One Stop Systems or 74576-000x cable
from Molex.

Connecting an external PC that does not support hot-plugging

1. Switch off the external PC and the instrument.
See also Chapter 3.1.10, "Switching on or off", on page 24.

2. NOTICE! Risk of device failure. The R&S SGT is equipped with a single lane PCIe
interface that supports hot plugging.
Do not connect an external PC to the PCIe connector of the instrument during
operation if this external PC does not support hot-plugging.
Connect the instrument and the controller with a permitted PCIe cable as specified
in "Permitted PCIe cables" on page 326.
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3. Switch on the instrument.

4. Wait until the instrument has completed the booting (the "POWER" LED on the
instrument's front panel is constantly on).

5. Switch on the external PC.

9.3.5  Enabling fast settings

► To enable the special PCI express feature fast settings, enable the function
rssgt_UseFastSettings (ViSession instrumentHandle, ViBoolean
fastEnabled, ViBoolean asynchronousEnabled) included in the instru-
ment driver.

Settings for some parameters like level and frequency accelerate.

To disable the fast settings, call the function rssgt_UseFastSettings with argu-
ment fastEnabled=false.

9.4  Advanced remote control using fast socket

Fast settings

The socket interface can be utilized not only to transfer text messages, e.g., SCPI
commands but also to carry register based remote control messages. The latter mode
is called fast settings mode. The fast socket communication is based on the Ethernet
protocol which does not support routing. Therefore a controller PC can only control
devices within its own network segment using the fast socket method.

To use the advantage of the fast settings, the following prerequisites must be fulfilled:
● On Windows operating systems, the fast socket driver must be installed.
● The application program must be run with root/administrator rights.
● The fast settings must be enabled with the function rssgt_useFastSettings

(see also Chapter 9.3.5, "Enabling fast settings", on page 327).

The instrument driver uses the fast settings method whenever possible. Fast settings
apply for the parameters frequency, level, RF state, I/Q modulator state, IQ wideband
state, digital attenuation, frequency offset, phase offset, trigger, segment trigger, next
segment index. In all other cases, SCPI messages are sent.

Advanced remote control using fast socket
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9.4.1  Setting up a remote control connection via fast socket

Download the required archive and extract the files on a remote PC, as described in
Chapter 9.3.2, "Downloading the drivers", on page 323.

Windows operating systems

To set up a remote control connection via fast socket for Windows operating systems,
perform the following steps:

1. Connect the controller and the instrument: See Chapter 3.1.13.2, "Connecting a
remote PC via LAN", on page 28.

2. Install the protocol driver to the controller: See Chapter 9.4.2, "Installing the proto-
col driver", on page 328.

3. On the controller, start the driver by using one of the following:

a) Start the Windows console user interface as an administrator.
Excute the command net start SGMANDISPROT.

b) Use a program for opening the driver.
See, for example, the example file SgtDriverDemo.c.

4. Start the application with administrator rights.

5. Enable fast settings: See Chapter 9.4.3, "Enabling fast settings", on page 329.

Linux operating systems

To set up a remote control connection via fast socket for Linux operating systems, per-
form the following steps:

1. Connect the controller and the instrument: See Chapter 3.1.13.2, "Connecting a
remote PC via LAN", on page 28.

2. Start the application as root.

3. Enable fast settings: See Chapter 9.4.3, "Enabling fast settings", on page 329.

9.4.2  Installing the protocol driver

The protocol driver defines the way to communicate with the instrument via the LAN
fast socket interface.

For Linux operating system, no special driver is needed.

For Windows operating systems, the SGMANDISPROT driver is required. The protocol
driver is installed automatically together with the installation of the R&S SGMA-GUI
software. It is also provided in the Low-Level SGT drivers file.

To install the driver manually on a Windows operating system:

1. Open "Control Panel > Network and Sharing Center".

2. Select the network adapter on which you want to install the driver.
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The "Local Area Connection Status" dialog opens.

3. Click "Properties" to open the "Local Area Connection Properties" dialog.

4. Click "Install" to open the "Select Network Feature Type" dialog.

5. Select "Protocol".

6. Select "Add".

7. In the "Select Network Protocol" dialog, select "Have Disk".

8. To select the driver, navigate to its storage directory.

9. Click "OK" to install the driver.

9.4.3  Enabling fast settings

► To enable the fast settings for the fast socket, call function
rssgt_UseFastSettings (ViSession instrumentHandle, ViBoolean
fastEnabled, ViBoolean asynchronousEnabled) included in the instru-
ment driver.

Settings for some parameters like level and frequency accelerate.

To disable the fast settings, call the function rssgt_UseFastSettings with argu-
ment fastEnabled=false.

9.5  Status reporting system

The status reporting system stores all information on the current operating state of the
instrument, and on errors which have occurred. This information is stored in the status
registers and in the error queue.

You can query both with the commands of the STATus subsystem.

9.5.1  Hierarchy of the status registers

The Figure 9-5 shows the hierarchical structure of information in the status registers
(ascending from left to right).
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Figure 9-5: Graphical overview of the status registers hierarchy

OPER = Operation Status Summary Bit
RQS/MSS = Service Request Generation
ESB = Standard Event Status Summary Bit
MAV = Message Available in Output Queue
QUES = Questionable Status Summary Bit
2 = Error- /Event-Queue
1, 0 = not used

Note: This legend explains the abbreviations to the Status Byte Register.

The R&S SGT uses the following status registers:
● Status Byte (STB) and Service Request Enable (SRE), see Chapter 9.5.3, "Sta-

tus byte (STB) and service request enable register (SRE)", on page 333.
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● Standard Event Status, i.e. the Event status Register (ESR) and the Event Status
Enable (ESE), see Chapter 9.5.4, "Event status register (ESR) and event status
enable register (ESE)", on page 334.

● Questionable Status and Operation Status, the (SCPI status registers, see
Chapter 9.5.2, "Structure of a SCPI status register", on page 331, Chapter 9.5.5,
"Questionable status register (STATus:QUEStionable)", on page 334 and Chap-
ter 9.5.6, "Operation status register (STATus:OPERation)", on page 335.

● Output-Queue
The output queue contains the messages that the instrument returns to the control-
ler. It is not part of the status reporting system but determines the value of the MAV
bit in the STB and thus is represented in the overview.

● Error-/Event-Queue
The error-/event-queue contains all errors and events that have occurred in the
past. When reading the queue, the instrument starts with the first occurred error/
event.

All status registers have the same internal structure.

SRE, ESE
The service request enable register SRE can be used as ENABle part of the STB if the
STB is structured according to SCPI. By analogy, the ESE can be used as the ENABle
part of the ESR command.

9.5.2  Structure of a SCPI status register

Each SCPI status register consists of five parts. Each part has a width of 16 bits and
has different functions. The individual bits are independent of each other, i.e. each
hardware status is assigned a bit number, which is valid for all five parts. Bit 15 (the
most significant bit) is set to zero for all parts. Thus, the contents of the register parts
can be processed by the controller as positive integers.

Figure 9-6: The status-register model
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Description of the five status register parts

The five parts of a SCPI status register have different properties and functions:

● CONDition
The CONDition part is written directly by the hardware or it mirrors the sum bit of
the next lower register. Its contents reflect the current instrument status. This regis-
ter part can only be read, but not written into or cleared. Its contents are not affec-
ted by reading.

● PTRansition / NTRansition
The two transition register parts define which state transition of the CONDition
part (none, 0 to 1, 1 to 0 or both) is stored in the EVENt part.
The Positive-TRansition part acts as a transition filter. When a bit of the
CONDition part is changed from 0 to 1, the associated PTR bit decides whether
the EVENt bit is set to 1.
– PTR bit =1: the EVENt bit is set.
– PTR bit =0: the EVENt bit is not set.

This part can be written into and read as required. Its contents are not affected by
reading.
The Negative-TRansition part also acts as a transition filter. When a bit of the
CONDition part is changed from 1 to 0, the associated NTR bit decides whether
the EVENt bit is set to 1.
– NTR bit =1: the EVENt bit is set.
– NTR bit =0: the EVENt bit is not set.

This part can be written into and read as required. Its contents are not affected by
reading.

● EVENt
The EVENt part indicates whether an event has occurred since the last reading, it
is the "memory" of the condition part. It only indicates events passed on by the
transition filters. It is permanently updated by the instrument. This part can only be
read by the user. Reading the register clears it. This part is often equated with the
entire register.

● ENABle
The ENABle part determines whether the associated EVENt bit contributes to the
sum bit (see below). Each bit of the EVENt part is "ANDed" with the associated
ENABle bit (symbol '&'). The results of all logical operations of this part are passed
on to the sum bit via an "OR" function (symbol '+').
ENABle bit = 0: the associated EVENt bit does not contribute to the sum bit
ENABle bit = 1: if the associated EVENt bit is "1", the sum bit is set to "1" as well.
This part can be written into and read by the user as required. Its contents are not
affected by reading.

Sum bit

The sum bit is obtained from the EVENt and ENABle part for each register. The result
is then entered into a bit of the CONDition part of the higher-order register.
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The instrument automatically generates the sum bit for each register. Thus an event
can lead to a service request throughout all levels of the hierarchy.

9.5.3  Status byte (STB) and service request enable register (SRE)

The STatus Byte (STB) is already defined in IEEE 488.2. It provides a rough over-
view of the instrument status by collecting the pieces of information of the lower regis-
ters. A special feature is that bit 6 acts as the sum bit of the remaining bits of the status
byte.

The STB is read using the command *STB? or a serial poll.

The STatus Byte (STB) is linked to the Service Request Enable (SRE) register.
Each bit of the STB is assigned a bit in the SRE. Bit 6 of the SRE is ignored. If a bit is
set in the SRE and the associated bit in the STB changes from 0 to 1, a service
request (SRQ) is generated. The SRE can be set using the command *SRE and read
using the command *SRE?.

Table 9-2: Meaning of the bits used in the status byte

Bit No. Meaning

0...1 Not used

2 Error Queue not empty

The bit is set when an entry is made in the error queue. If this bit is enabled by the SRE, each
entry of the error queue generates a service request. Thus an error can be recognized and
specified in greater detail by polling the error queue. The poll provides an informative error mes-
sage. This procedure is to be recommended since it considerably reduces the problems
involved with remote control.

3 QUEStionable status register summary bit

The bit is set if an EVENt bit is set in the QUEStionable status register and the associated
ENABle bit is set to 1. A set bit indicates a questionable instrument status, which can be speci-
fied in greater detail by querying the STATus:QUEStionable status register.

4 MAV bit (message available)

The bit is set if a message is available in the output queue which can be read. This bit can be
used to enable data to be automatically read from the instrument to the controller.

5 ESB bit

Sum bit of the event status register. It is set if one of the bits in the event status register is set
and enabled in the event status enable register. Setting of this bit indicates a serious error which
can be specified in greater detail by polling the event status register.

6 MSS bit (main status summary bit)

The bit is set if the instrument triggers a service request. This is the case if one of the other bits
of this registers is set together with its mask bit in the service request enable register SRE.

7 STATus:OPERation status register summary bit

The bit is set if an EVENt bit is set in the OPERation status register and the associated
ENABle bit is set to 1. A set bit indicates that the instrument is just performing an action. The
type of action can be determined by querying the STATus:OPERation status register.
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9.5.4  Event status register (ESR) and event status enable register (ESE)

The ESR is defined in IEEE 488.2. It can be compared with the EVENt part of a SCPI
register. The event status register can be read out using command *ESR?.

The ESE corresponds to the ENABle part of a SCPI register. If a bit is set in the ESE
and the associated bit in the ESR changes from 0 to 1, the ESB bit in the STB is set.
The ESE register can be set using the command *ESE and read using the command
*ESE?.

Table 9-3: Meaning of the bits used in the event status register

Bit No. Meaning

0 Operation Complete

This bit is set on receipt of the command *OPC exactly when all previous commands have been
executed.

1 Not used

2 Query Error

This bit is set if either the controller wants to read data from the instrument without having sent a
query, or if it does not fetch requested data and sends new instructions to the instrument
instead. The cause is often a query which is faulty and hence cannot be executed.

3 Device-dependent Error

This bit is set if a device-dependent error occurs. An error message with a number between
-300 and -399 or a positive error number, which denotes the error in greater detail, is entered
into the error queue.

4 Execution Error

This bit is set if a received command is syntactically correct but cannot be performed for other
reasons. An error message with a number between -200 and -300, which denotes the error in
greater detail, is entered into the error queue.

5 Command Error

This bit is set if a command is received, which is undefined or syntactically incorrect. An error
message with a number between -100 and -200, which denotes the error in greater detail, is
entered into the error queue.

6 User Request

This bit is set when the instrument is switched over to manual control.

7 Power On (supply voltage on)

This bit is set on switching on the instrument.

9.5.5  Questionable status register (STATus:QUEStionable)

This register contains information on questionable instrument states. Such states can
occur when the instrument is not operated in compliance with its specifications.

To read the register, use the query commands STAT:QUEST:COND? or
STAT:QUEST[:EVEN]?.
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Table 9-4: Meaning of the bits used in the questionable status register

Bit No. Meaning

0–15 Not used

9.5.6  Operation status register (STATus:OPERation)

This condition part contains information on the actions that the instrument currently
executes. The event part contains information on the actions that the instrument exe-
cuted since the last readout of the register.

To read the register, use the query commands STAT:OPER:COND? or
STAT:OPER[:EVEN]?.

Table 9-5: Meaning of the bits used in the operation status register

Bit No. Meaning

0 Calibrating

The bit is set during the calibration phase.

1–2 Not used

3 Not Used

4–15 Not used

9.5.7  Application of the status reporting system

The purpose of the status reporting system is to monitor the status of one or several
devices in a measuring system. For correct operation, the controller receives and eval-
uates the information of all devices. The status reporting system uses the following
standard methods:

● Service request (SRQ) initiated by the instrument
● Serial poll of all devices in the bus system, initiated by the controller to find out

who sent an SRQ and why
● Query of a specific instrument status by commands
● Query of the error queue

9.5.7.1  Service request

Under certain circumstances, the instrument can send a service request (SRQ) to the
controller. Usually this service request initiates an interrupt at the controller, to which
the control program can react appropriately. An SRQ is always initiated if one or sev-
eral of bits 2, 4 or 5 of the status byte are set and enabled in the SRE. Each of these
bits combines the information of the error queue or the output buffer. To use the possi-
bilities of the service request effectively, set all bits to "1" in the enable registers SRE
and ESE.

Status reporting system



Network operation and remote controlR&S®SGT100A

336User Manual 1176.8674.02 ─ 12

Example: 
Use command *OPC to generate an SRQ.
*ESE 1 - set bit 0 of ESE (Operation Complete)
*SRE 32 - set bit 5 of SRE (ESB).
After its settings have been completed, the instrument generates an SRQ.

The SRQ is the only possibility for the instrument to become active on its own. Each
controller program sets the instrument and initiates a service request if malfunctions
occur. The program reacts appropriately to the service request.

9.5.7.2  Serial poll

In a serial poll, just as with command *STB, the status byte of an instrument is queried.
However, the query is realized via interface messages and is thus clearly faster.

The serial poll method is defined in IEEE 488.1 and used to be the only standard pos-
sibility for different instruments to poll the status byte. The method also works for
instruments which do not adhere to SCPI or IEEE 488.2.

The serial poll is mainly used to obtain a fast overview of the state of several instru-
ments connected to the controller.

9.5.7.3  Query of an instrument status

Each part of any status register can be read using queries. There are two types of
commands:

● The common commands *ESR?, *IDN?, *IST?, *STB? query the higher-level
registers.

● The commands of the STATus system query the SCPI registers
(STATus:QUEStionable...)

The returned value is always a decimal number that represents the bit pattern of the
queried register. This number is evaluated by the controller program.

Queries are usually used after an SRQ in order to obtain more detailed information on
the cause of the SRQ.

9.5.7.4  Error queue

Each error state in the instrument leads to an entry in the error queue. The entries of
the error queue are detailed plain text error messages that can be looked up in the
Error Log or queried via remote control using SYSTem:ERRor[:NEXT]?. Each call of
SYSTem:ERRor[:NEXT]? provides one entry from the error queue. If no error mes-
sages are stored there any more, the instrument responds with 0, "No error".

The error queue should be queried after every SRQ in the controller program as the
entries describe the cause of an error more precisely than the status registers. Espe-
cially in the test phase of a controller program the error queue should be queried regu-
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larly since faulty commands from the controller to the instrument are recorded there as
well.

9.5.8  Reset values of the status reporting system

The following table contains the different commands and events causing the status
reporting system to be reset. None of the commands, except for *RST and
SYSTem:PRESet affect the functional instrument settings. In particular, DCL does not
change the instrument settings.
Table 9-6: Resetting the status reporting system

Event Switching on supply
voltage
Power-On-Status-
Clear

DCL,
SDC
(Device
Clear,
Selected
Device
Clear)

*RST or
SYSTem:
PRESet

STATus:
PRESet

*CLS

Effect 0 1

Clear STB, ESR - Yes - - - Yes

Clear SRE, ESE - Yes - - - -

Clear PPE - Yes - - - -

Clear error queue Yes Yes - - - Yes

Clear output buffer Yes Yes Yes 1) 1) 1)

Clear command processing
and input buffer

Yes Yes Yes - - -

1) The first command in a command line that immediately follows a <PROGRAM MESSAGE TERMINA-
TOR> clears the output buffer.

9.6  LXI configuration

"LAN eXtensions for Instrumentation" (LXI) is an instrumentation platform for measur-
ing instruments and test systems that is based on standard Ethernet technology. LXI is
intended to be the LAN-based successor to GPIB, combining the advantages of Ether-
net with the simplicity and familiarity of GPIB.

On the R&S SGT, the LXI functionality is already installed and enabled. Thus, the
instrument can be accessed via any web browser (like the Microsoft Internet Explorer)
to perform the following tasks:
● Modifying network configurations
● Remote control of the instrument
● Performing SCPI remote diagnostics

LXI configuration
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9.6.1  Default network settings

According to the LXI standard, an LCI must set the following parameters to a default
state.

Parameter Value

TCP/IP mode DHCP + Auto IP Address

Dynamic DNS Enabled

ICMP ping Enabled

Password for LAN configuration LxiWebIfc

The LAN reset also resets the following parameters for the R&S SGT:

Parameter Value

Hostname <Instrument-specific host name>

Description Signal generator

Negotiation Auto detect

VXI-11 discovery Enabled

The LAN settings are configured using the instrument's LXI browser settings.

9.6.2  LXI browser settings

You can access LXI borowser settings via a web browser.

Access:

► Type in the instrument's host name or IP address in the address field of the
browser on your PC, for example "http://10.111.0.97".
Note: Do not add the missing zeros in the IP address, while opening the instru-
ment home page.
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The instrument home page (welcome page) opens.

The navigation pane of the browser interface contains the following elements:
● "LXI"

– "Home" opens the instrument home page.
The home page displays the device information required by the LXI stan-
dard, including the VISA resource string in read-only format.

– "Device Indicator" activates or deactivates the LXI status indication.
When activated, the LXI LEDs flash in the browser dialog. A green LXI sta-
tus symbol indicates that a LAN connection has been established; a red
symbol indicates that no LAN cable is connected.

– "Lan Configuration" allows you to configure LAN parameters and to initiate
a ping, see Chapter 9.6.3, "LAN configuration", on page 339.

– "Status" displays information about the LXI status of the instrument.
– "Utilities" provides access to the LXI event log functionality required by the

LXI standard.
● "Diagnostics"

– "SCPI Remote Trace" records messages exchanged via the remote control
interface, see Chapter 9.6.3.4, "SCPI remote trace", on page 342.

● "Help"
– "Glossary" explains terms related to the LXI standard.
– www.rohde-schwarz.com opens the Rohde & Schwarz home page.

9.6.3  LAN configuration

The "LAN Configuration" web page displays all mandatory LAN parameters and allows
their modification.

It comprises the following navigation entries.

LXI configuration
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● IP configuration..................................................................................................... 340
● Advanced Config...................................................................................................340
● Ping client..............................................................................................................341
● SCPI remote trace.................................................................................................342

9.6.3.1  IP configuration

The "IP configuration" web page displays all mandatory LAN parameters and allows
their modification.

The "IP Address Mode" selects a configuration mode for the IP address of the instru-
ment. With static configuration, the entered IP address, subnet mask, and default gate-
way are used. With dynamic configuration via DHCP or dynamic link local addressing
(automatic IP), the instrument IP address is assigned automatically.

Password protection
Changing the LAN configuration is password protected and requires the security pass-
word. The default password is "instrument".

9.6.3.2  Advanced Config

The "Advanced Config" web page provides LAN settings that are not declared manda-
tory by the LXI standard.

LXI configuration
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The following advanced parameters are available:
● "mDNS and DNS-SD": The additional protocols "multicast DNS" and "DNS service

discovery" are used for device communication in zero configuration networks,
working without DNS and DHCP.

● "ICMP Ping": Must be enabled to use the ping utility.
If you disable this setting, the instrument does not answer ping requests. The set-
ting does not affect the LXI ping client. You can ping other hosts from the instru-
ment, even if the setting is disabled.

● "VXI-11 Discovery": Must be enabled to detect the instrument in the LAN.
If you disable this setting, the instrument cannot be detected by the VXI-11 discov-
ery protocol mechanism. The setting does not affect other detection mechanisms.
Setting up a VXI-11 connection via the IP address or the host name is independent
of this setting.

Password protection
Changing the LAN configuration is password protected and requires the security pass-
word. The default password is "instrument".

9.6.3.3  Ping client

The "Ping Client" page provides the ping utility to verify the connection between the
LXI-compliant instrument and another device.

The ping is initiated from the instrument. Using the ICMP echo request and echo reply
packets, the function checks whether the communication with a device via LAN is
working. Ping is useful for the diagnosis of IP network or router failures.
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To initiate a ping at the instrument:

1. On the "Ping Client" page, enter the IP address of the host in the "Destination
Address" field (for example 10.111.0.125).

2. Select "Submit".

9.6.3.4  SCPI remote trace

The remote trace functionality allows you to trace input and output strings at the
remote control interface of the R&S SGT, see Chapter 9.6.4, "How to record SCPI
commands and messages via LXI", on page 344.

A recorded trace (message log) can be evaluated directly in the dialog. Use the high-
lighting and navigation functions provided by the lower toolbar to locate error mes-
sages and messages containing arbitrary search strings. You can also export the mes-
sage log to a *.csv file and evaluate the file using a suitable program.

To trace and display messages, switch on "logging" and "live mode" in the toolbar.
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Toolbars

The toolbar at the top of the dialog provides basic settings and functions.

● "Live mode" / "logging": If logging is switched on, messages are traced. They are
stored in an internal database and can be displayed upon request, using the
refresh button (live mode off) or they can be displayed automatically (live mode
on).

● "Filter": applies a filter to columns and/or rows when working (live mode off)
● "Refresh": reads the message log from the internal database and displays it
● "Download": stores the SCPI trace log to a *.csv file
● "Clear": deletes all message log entries in the database and at the screen
● "Details": displays details of the selected message, for example a SCPI command

in hex format (also possible by double\-clicking a message)

Columns

The following columns are available if no column filter is applied:

● "Rec": record number of the message within the message log
● "MT": indicates the type of the message. Possible values and related message

contents are:
– > = incoming command
– < = outgoing response to a query
– E = error message, highlighted by red color
– T = execution time, i.e. time required by the instrument to process the com-

mand internally
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● I: number of the subinstrument
● "message": indicates the type of the message. Possible values and related mes-

sage contents are:
– > = incoming command
– < = outgoing response to a query
– E = error message, denoted in red
– T = execution time, i.e. time required by the instrument to process the com-

mand internally

9.6.4  How to record SCPI commands and messages via LXI

The remote trace functionality allows you to trace commands and messages
exchanged via a remote control interface of the R&S SGT.

To activate the SCPI remote trace:

1. Start a web browser that supports html5 (W3C compliant).

2. Enter the IP address of the R&S SGT in the browser's address bar.

The R&S SGT's welcome page is displayed.

3. In the navigation pane, select "Diagnostics > SCPI Remote Trace".

4. In the toolbar bar of the "SCPI Remote Trace" page, select "live mode > on" and
"logging > on".

"live mode > on" displays all commands and responses, and "logging > on" also
traces messages.

If you now control the R&S SGT with SCPI commands, using an appropriate tool,
the LXI function records the information sent and received.
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The function records all sent commands, received responses and messages, and
stores them in an internal database. If "live mode" is disabled, you can display the
recent traces upon request, using the "refresh" button. You can also store the log in
a file.

9.7  Monitoring remote control operation with R&S SGMA-
GUI

The R&S SGMA-GUI can be used to monitor the behavior of one or more instruments
while they are remote controlled.

A typical configuration consists of one monitor, controllers and instruments. The moni-
tor is the remote PC on which the R&S SGMA-GUI is installed and the controller is the
remote PC on which the application program runs.

Simultaneous control of an instrument from a controller and a monitor can lead to colli-
sions whenever both the controller and the monitor utilize the same remote channel.
These collisions are indicated by an error message in the "Info" line, e.g. "Query inter-
rupted" or "Resource locked". Simultaneous monitoring and control over the same
remote channel is only possible, if the used protocols support
viLock()/viUnlock() and the remote program use these functions.

The Table 9-7 shows whether a collision-free communication over a particular combi-
nation of remote channels is possible or not and if there are any restrictions.
Table 9-7: Cross reference between used remote channels and collision-free communication

Monitor/
Controller

LAN
(VXI-11)

LAN (HiSLIP) USB LAN (Socket) PCIe

LAN (VXI-11) OK* OK OK OK OK

LAN (HiSLIP) OK OK OK OK OK

USB OK OK viLock/viUnlock OK OK

LAN (Socket) OK OK OK X OK

PCIe OK OK OK OK X

Where:
● OK: communication possible, no collisions

*) the R&S SGMA-GUI always uses the LAN device name instr1, see also Chap-
ter 9.1.2.3, "VXI-11 protocol", on page 318.

● X: communication is not possible without collisions
● viLock/viUnlock: communication is only possible, if the remote control com-

mands are enclosed in a viLock () - viUnlock() pair.

The R&S SGMA-GUI uses the viLock()/viUnlock() functions.

Monitoring remote control operation with R&S SGMA-GUI
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The figure below shows an example of configuration where the monitor and the con-
troller are two different computers, connected to the same instrument over two different
hardware interfaces.

Figure 9-7: Example of a setup for remote control monitoring

Connecting and configuring the monitoring PCs

In the "Setup > Security > Security Settings" dialog, check the state of the LAN and
USB interfaces and enable them if necessary.

1. Connect the monitoring PC to the instrument.

Note: Choose the hardware interface considering the limitations described in
Table 9-7.

2. Configure the instrument in the R&S SGMA-GUI: See Chapter 5.5.2, "Managing
instruments with R&S SGMA-GUI", on page 71.

3. In the "SGMA-GUI > Setup > Instruments > Edit Instruments" dialog, disable
"Exclusive Access".

Note: The two functions "Exclusive Access" and monitoring are mutually exclusive.

4. Send remote control commands from the controller to the instrument.

5. Open the corresponding dialogs in the R&S SGMA-GUI. Observe the status of the
parameters.

Monitoring remote control operation with R&S SGMA-GUI
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10  Remote control commands
In the following, all remote-control commands are presented in detail with their param-
eters and the ranges of numerical values.

For an introduction to remote control and the status registers, refer to the following sec-
tions:
● "Information on network operation and remote control" on page 312
● Chapter 9.5, "Status reporting system", on page 329

Conventions used in SCPI command descriptions

The following conventions are used in the remote command descriptions:
● Command usage

If not specified otherwise, commands can be used both for setting and for querying
parameters.
If a command can be used for setting or querying only, or if it initiates an event, the
usage is stated explicitly.

● Parameter usage
If not specified otherwise, a parameter can be used to set a value and it is the
result of a query.
Parameters required only for setting are indicated as Setting parameters.
Parameters required only to refine a query are indicated as Query parameters.
Parameters that are only returned as the result of a query are indicated as Return
values.

● Conformity
Commands that are taken from the SCPI standard are indicated as SCPI con-
firmed. All commands used by the R&S SGT follow the SCPI syntax rules.

● Asynchronous commands
A command which does not automatically finish executing before the next com-
mand starts executing (overlapping command) is indicated as an Asynchronous
command.

● Reset values (*RST)
Default parameter values that are used directly after resetting the instrument (*RST
command) are indicated as *RST values, if available.

● Factory preset values
Default parameter values that are reset only by factory preset.

● Default unit
The default unit is used for numeric values if no other unit is provided with the
parameter.

● Manual operation
If the result of a remote command can also be achieved in manual operation, a link
to the description is inserted.
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Commands

● Common commands.............................................................................................348
● General commands...............................................................................................353
● Preset commands................................................................................................. 354
● CALibration subsystem......................................................................................... 354
● CLOCk subsystem................................................................................................ 357
● CONNector subsystem......................................................................................... 358
● DIAGnostic subsystem..........................................................................................360
● FORMat Subsystem..............................................................................................361
● MMEMory subsystem............................................................................................363
● Fast speed commands..........................................................................................372
● OUTPut subsystem...............................................................................................373
● SCONfiguration subsystem...................................................................................374
● SENSe, READ, INITiate and SLISt subsystems................................................... 375
● SOURce subsystem..............................................................................................389
● STATus subsystem................................................................................................529
● SYSTem subsystem..............................................................................................533
● TEST subsystem...................................................................................................551
● UNIT subsystem....................................................................................................552
● List of R&S SGT commands................................................................................. 553

10.1  Common commands

Common commands are described in the IEEE 488.2 (IEC 625-2) standard. These
commands have the same effect and are employed in the same way on different devi-
ces. The headers of these commands consist of "*" followed by three letters. Many
common commands are related to the Status Reporting System.

Available common commands:

*CLS.............................................................................................................................349
*ESE.............................................................................................................................349
*ESR?...........................................................................................................................349
*IDN?............................................................................................................................349
*IST?............................................................................................................................ 349
*OPC............................................................................................................................350
*OPT?...........................................................................................................................350
*PRE............................................................................................................................ 350
*PSC............................................................................................................................ 350
*RCL.............................................................................................................................351
*RST.............................................................................................................................351
*SAV.............................................................................................................................351
*SRE............................................................................................................................ 351
*STB?...........................................................................................................................352
*TRG............................................................................................................................ 352
*TST?........................................................................................................................... 352
*WAI.............................................................................................................................352
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*CLS

Clear status

Sets the status byte (STB), the standard event register (ESR) and the EVENt part of
the QUEStionable and the OPERation registers to zero. The command does not
alter the mask and transition parts of the registers. It clears the output buffer.

Usage: Setting only

*ESE <Value>

Event status enable

Sets the event status enable register to the specified value. The query returns the con-
tents of the event status enable register in decimal form.

Parameters:
<Value> Range: 0 to 255

*ESR?

Event status read

Returns the contents of the event status register in decimal form and then sets the reg-
ister to zero.

Return values: 
<Contents> Range: 0  to  255

Usage: Query only

*IDN?

Identification

Returns the instrument identification.

Return values: 
<ID> "Rohde&Schwarz,<device type>,<part number>/<serial num-

ber>,<firmware version>"

Example: Rohde&Schwarz,SGT100A,
1412.0000K02/000000,3.1.17.1-03.01.158

Usage: Query only

Manual operation: See "IDN String" on page 293

*IST?

Individual status query
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Returns the contents of the IST flag in decimal form. The IST flag is the status bit
which is sent during a parallel poll.

Return values: 
<ISTflag> 0 | 1

Usage: Query only

*OPC

Operation complete

Sets bit 0 in the event status register when all preceding commands have been execu-
ted. This bit can be used to initiate a service request. The query writes a "1" into the
output buffer when all preceding commands have been executed, which is useful for
command synchronization.

*OPT?

Option identification query

Queries the options included in the instrument. For a list of all available options and
their description, refer to the data sheet.

Return values: 
<Options> The query returns a list of options. The options are returned at

fixed positions in a comma-separated string. A zero is returned
for options that are not installed.

Usage: Query only

Manual operation: See "OPT String" on page 293

*PRE <Value>

Parallel poll register enable

Sets parallel poll enable register to the indicated value. The query returns the contents
of the parallel poll enable register in decimal form.

Parameters:
<Value> Range: 0  to  255

*PSC <Action>

Power on status clear
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Determines whether the contents of the ENABle registers are preserved or reset when
the instrument is switched on. Thus a service request can be triggered when the instru-
ment is switched on, if the status registers ESE and SRE are suitably configured. The
query reads out the contents of the "power-on-status-clear" flag.

Parameters:
<Action> 0 | 1

0
The contents of the status registers are preserved.
1
Resets the status registers.

*RCL <Number>

Recall

Loads the instrument settings from an intermediate memory identified by the specified
number. The instrument settings can be stored to this memory using the command
*SAV with the associated number.

It also activates the instrument settings which are stored in a file and loaded using the
MMEMory:LOAD <number>, <file_name.extension> command.

*RST

Reset

Sets the instrument to a defined default status. The default settings are indicated in the
description of commands.

The command is equivalent to SYSTem:PRESet.

Usage: Setting only

*SAV <Number>

Save

Stores the current instrument settings under the specified number in an intermediate
memory. The settings can be recalled using the command *RCL with the associated
number.

To transfer the stored instrument settings in a file, use the command :MMEMory:
STORe:STATe.

*SRE <Contents>

Service request enable

Sets the service request enable register to the indicated value. This command deter-
mines under which conditions a service request is triggered.
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Parameters:
<Contents> Contents of the service request enable register in decimal form.

Bit 6 (MSS mask bit) is always 0.
Range: 0  to  255

*STB?

Status byte query

Reads the contents of the status byte in decimal form.

Usage: Query only

*TRG

Trigger

Triggers all actions waiting for a trigger event. In particular, *TRG generates a manual
trigger signal. This common command complements the commands of the TRIGger
subsystem.

*TRG corresponds to the INITiate:IMMediate command.

Usage: Event

*TST?

Self-test query

Initiates self-tests of the instrument and returns an error code.

Return values: 
<ErrorCode> integer > 0 (in decimal format)

An error occurred.
(For details, see the Service Manual supplied with the instru-
ment).
0
No errors occurred.

Usage: Query only

*WAI

Wait to continue

Prevents servicing of the subsequent commands until all preceding commands have
been executed and all signals have settled (see also command synchronization and
*OPC).

Usage: Event
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10.2  General commands

:LOCK?.........................................................................................................................353
:UNLock........................................................................................................................353

:LOCK? <LockRequestId>

Sends a lock request ID which uniquely identifies the controller to the instrument.

Parameters:
<LockRequestId> Number

0
test query to prove whether the instrument is locked
Controller ID
request lock from the controller with the specified Controller ID

Return values: 
<Value> Number

0
request refused; the instrument is already locked to other <Lock
Request Id>, i.e. to another controller
1
request granted

Example: :LOCK? 12345
Response: 1
:UNL 12345

Usage: Query only

Manual operation: See "Exclusive Access" on page 60

:UNLock <UnlockId>

Unlocks an instrument locked to a controller with Controller ID = <Unlock Id>.

Setting parameters: 
<UnlockId> Number

Unlock ID which uniquely identifies the controller to the instru-
ment. The value must match the Controller ID <Lock Request
Id> set with the command :LOCK?.
0
Clear lock regardless of locking state

Usage: Setting only

Manual operation: See "Exclusive Access" on page 60
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10.3  Preset commands

The preset commands are not bundled into one subsystem. Therefore, they are listed
separately in this section. These specific commands are described in the associated
subsystems.

The following presetting actions are available:
● Activating the default state of all internal instrument functions (*RST on page 351).

Functions that concern the integration of the instrument into a measurement setup
are not changed, e.g. TCP/IP address or reference oscillator source settings.

● Activating the original state of delivery (factory reset,:SYSTem:FPReset
on page 354). Only functions that are protected by a password remain unchanged
and the passwords themselves.

:SOURce<hw>:PRESet
:SYSTem:PRESet
Triggers an instrument reset. It has the same effect as:
● The *RST command
● The "SGMA-GUI > Instrument Name > Preset" function.

However, the command does not close open GUI dialogs like the function does.

Example: SYST:PRES
All instrument settings (also the settings that are not currently
active) are reset to their default values.

Usage: Setting only

:SYSTem:FPReset

Triggers an instrument reset to the original state of delivery.

Example: SYST:FPR
all instrument settings (also those that are not currently active)
are reset to the factory values.

Usage: Event

Manual operation: See "Execute Factory Preset" on page 295

10.4  CALibration subsystem

:CALibration<hw>:BBIN[:MEASure]?................................................................................355
:CALibration:ALL[:MEASure]?......................................................................................... 355
:CALibration:FREQuency[:MEASure]?..............................................................................355
:CALibration:IQModulator:BBANd[:STATe]........................................................................ 355
:CALibration:IQModulator:FULL?..................................................................................... 356
:CALibration:IQModulator:LOCal?....................................................................................356
:CALibration:IQModulator:IQModulator[:STATe]................................................................. 356
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:CALibration:LEVel[:MEASure]?.......................................................................................356
:CALibration:FREQuency:TEMPerature?..........................................................................356
:CALibration:LEVel:TEMPerature?................................................................................... 356
:CALibration:IQModulator:TEMPerature?..........................................................................356
:CALibration:ROSCillator:DATA:MODE.............................................................................357
:CALibration:ROSCillator[:DATA]......................................................................................357

:CALibration<hw>:BBIN[:MEASure]?

Starts adjustment of the analog I/Q input. The I/Q input is adjusted with respect to DC
offset and gain.

Return values: 
<Measure> 0 | 1 | OFF | ON

*RST: 0

Example: CAL:BBIN:MEAS?
starts the adjustment of the analog I/Q input.
Response: 0
adjustment has been performed successfully.

Usage: Query only

:CALibration:ALL[:MEASure]?

Starts all internal adjustments for which no external measuring equipment is required.

Return values: 
<All> 1 | ON | 0 | OFF

Usage: Query only

Manual operation: See "Adjust All" on page 272

:CALibration:FREQuency[:MEASure]?

Performs all adjustments which affect the frequency.

Return values: 
<Synthesis> 1 | ON | 0 | OFF

Usage: Query only

Manual operation: See "Synthesis" on page 272

:CALibration:IQModulator:BBANd[:STATe] <Modulator>

Parameters:
<Modulator> OFF | ON | 1 | 0

Manual operation: See "Baseband" on page 273
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:CALibration:IQModulator:FULL?

Starts the adjustment of the I/Q modulator for the entire frequency range. The I/Q mod-
ulator is adjusted with respect to carrier leakage, I/Q imbalance and quadrature.

Return values: 
<Modulator> 1 | ON | 0 | OFF

Usage: Query only

Manual operation: See "I/Q Modulator" on page 273

:CALibration:IQModulator:LOCal?

Starts the adjustment of the I/Q modulator for the current frequency. The I/Q modulator
is adjusted with respect to carrier leakage, I/Q imbalance and quadrature.

This adjustment is only possible when :OUTPut[:STATe] ON and
[:SOURce]:IQ:STATe ON.

Usage: Query only

Manual operation: See "Adjust I/Q Modulator at Current Frequency" on page 272

:CALibration:IQModulator:IQModulator[:STATe] <Modulator>

Acitvates/deactivates a separat internal adjustment procedure for the I/Q modulator.

Parameters:
<Modulator> OFF | ON | 1 | 0

Manual operation: See "I/Q Modulator" on page 273

:CALibration:LEVel[:MEASure]?

Starts all adjustments which affect the level.

Return values: 
<Level> 1 | ON | 0 | OFF

Usage: Query only

Manual operation: See "Level" on page 272

:CALibration:FREQuency:TEMPerature?
:CALibration:LEVel:TEMPerature?
:CALibration:IQModulator:TEMPerature?
Queries the delta temperature since the last performed adjustment.

Return values: 
<Temperature> string

Usage: Query only
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:CALibration:ROSCillator:DATA:MODE <Mode>

Defines whether the factory provided or a custom defined calibration value is used to
adjust the reference oscillator.

Parameters:
<Mode> FACTory | CUSTomer

*RST: FACTory

Example: :CALibration1:ROSCillator:DATA:MODE CUSTomer
:CALibration1:ROSCillator:DATA 35600

Manual operation: See "Active Adjustment Data" on page 301

:CALibration:ROSCillator[:DATA] <Data>

Sets the calibration value for the custom defined external adjustment.

Parameters:
<Data> integer

Range: 0  to  INT_MAX
*RST: 0

Manual operation: See "Calibration Value" on page 301

10.5  CLOCk subsystem

:CLOCk:INPut:FREQuency?........................................................................................... 357
:CLOCk:INPut:SLOPe.................................................................................................... 358
:CLOCk:OUTPut:MODE..................................................................................................358
:CLOCk:SYNC[:STATe]?................................................................................................. 358

:CLOCk:INPut:FREQuency?

Queries the measured frequency of the external clock signal. An external clock refer-
ence must be supplied at the [USER1/2] input.

Return values: 
<Frequency> float

Range: 0  to  max
Increment: 0.001
*RST: 0

Example: CLOC:INP:FREQ?
queries the measured frequency of the external clock reference.

Usage: Query only

Manual operation: See "Measured External Clock" on page 134
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:CLOCk:INPut:SLOPe <Slope>

The command sets the active slope of an externally applied clock signal at the [USER
1/2] connector.

Parameters:
<Slope> NEGative | POSitive

*RST: POSitive

Example: CLOC:INP:SLOP NEG
The active slope of the external clock signal is the falling slope.

:CLOCk:OUTPut:MODE <Mode>

The command sets the output of bit or symbol clock pulses at the [USER 1/2] connec-
tor at the rear panel.

Parameters:
<Mode> SYMBol | BIT

*RST: SYMBol

Example: CLOC:OUTP:MODE SYMB
The internal symbol clock is output.

:CLOCk:SYNC[:STATe]?

Requires instruments working in secondary synchronization mode.

Queries the status of the external clock source. The status indicates, if the external
clock source of the secondary instrument is synchronized or not synchronized yet.

Return values: 
<State> 0 | 1 | OFF | ON

*RST: n.a. (no preset. default: 0)

Example: :CLOCk:SYNC:STATe?
// Response: "1"
// The clock source of the secondary instrument
is synchronized.

Usage: Query only

Manual operation: See "Synchronisation State" on page 134

10.6  CONNector subsystem

:CONNector:REFLo:OUTPut........................................................................................... 359
:CONNector:USER<ch>:OMODe.....................................................................................359
:CONNector:USER<ch>:THReshold................................................................................ 360
:CONNector:USER<ch>:CLOCk:IMPedance.....................................................................360
:CONNector:USER<ch>:TRIGger:IMPedance...................................................................360
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:CONNector:USER<ch>:CLOCk:SLOPe...........................................................................360
:CONNector:USER<ch>:TRIGger:SLOPe.........................................................................360

:CONNector:REFLo:OUTPut <Output>

Determines the signal provided at the output connector [REF/LO OUT] (rear of the
instrument).

Parameters:
<Output> REF | LO | OFF

*RST: REF

Manual operation: See "REF/LO Output" on page 221

:CONNector:USER<ch>:OMODe <Omode>

Sets the operation mode of the user connector.

Parameters:
<Omode> MKR1 | MKR2 | TRIGger | CIN | COUT | SIN | SOUT | NEXT |

LOW | MLATency | MARRived | HIGH | SVALid | SNValid |
PVOut | PETRigger | PEMSource | TOUT
MKR1/2
Marker 1/2
TRIGger
Trigger
TOUT
Trigger out
CIN
Clock in
COUT
Clock out
SIN
Sync in
SOUT
Sync out
NEXT
Next trigger
SVALid|SNValid
Signal valid /not valid
PVOut
Pulse generator video out
PETRigger
Pulse generator external trigger
PEMSource
External pulse modulator source

Manual operation: See "Mode" on page 259

CONNector subsystem



Remote control commandsR&S®SGT100A

360User Manual 1176.8674.02 ─ 12

:CONNector:USER<ch>:THReshold <Threshold>

Sets the threshold for the user connector.

Parameters:
<Threshold> float

Range: 0  to  2
Increment: 0.1
*RST: 1

Manual operation: See "Threshold" on page 262

:CONNector:USER<ch>:CLOCk:IMPedance <Impedance>
:CONNector:USER<ch>:TRIGger:IMPedance <Impedance>
Selects the input impedance for the external trigger/clock inputs, when :CONNector:
USER<ch>:OMODe is set to TRIGger or CIN/COUT.

Parameters:
<Impedance> G50 | G10K

G10K
Provided only for backward compatibility with other R&S signal
generators.
The R&S SGT accepts this values and maps it automatically to
G1K.
*RST: G10K

Manual operation: See "Impedance" on page 262

:CONNector:USER<ch>:CLOCk:SLOPe <Slope>
:CONNector:USER<ch>:TRIGger:SLOPe <Slope>
Sets the polarity of the active slope of an applied instrument trigger/clock.

Parameters:
<Slope> NEGative | POSitive

*RST: POSitive

Manual operation: See "Trigger Slope" on page 262

10.7  DIAGnostic subsystem

:DIAGnostic:POINt:CATalog?...........................................................................................360
:DIAGnostic[:MEASure]:POINt?.......................................................................................361

:DIAGnostic:POINt:CATalog?

Queries the test points available in the instrument.

Usage: Query only
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:DIAGnostic[:MEASure]:POINt? <Name>

Triggers voltage or temperature measurement at the specified test point and returns
the measured value.

Use the command :DIAGnostic:POINt:CATalog? to retrieve a list of the available
test points.

For description of the test points, see the service manual.

Query parameters: 
<Name> string

Return values: 
<Value> number

Default unit: V or °C

Usage: Query only

10.8  FORMat Subsystem

The FORMat subsystem contains the commands which determine the format of the
data that the R&S SGT returns to the controller. This affects all query commands which
return a list of numerical data or block data. Reference is made to this in the descrip-
tions of the commands.

:FORMat:BORDer..........................................................................................................361
:FORMat[:DATA]............................................................................................................ 362
:FORMat:SREGister.......................................................................................................362

:FORMat:BORDer <Border>

Determines the sequence of bytes within a binary block. This only affects blocks which
use the IEEE754 format internally.

Parameters:
<Border> NORMal | SWAPped

NORMal
The instrument expects (with setting commands) and sends
(with queries) the least significant byte of each IEEE754 floating-
point number first and the most significant byte last.
SWAPped
The instrument expects (with setting commands) and sends
(with queries) the most significant byte of each IEEE754 floating-
point number first and the least significant byte last.
*RST: NORMal

Example: FORM:BORD SWAP
The data is transferred with the most significant bit first.
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:FORMat[:DATA] <Data>

Determines the data format which the R&S SGT uses to return data. When data is
transferred from the control computer to the instrument, the instrument detects the data
format automatically. In this case, the value set here is irrelevant.

Parameters:
<Data> ASCii | PACKed

ASCii
Numerical data is transferred as plain text separated by com-
mas.
PACKed
Numerical data is transferred as binary block data. The format
within the binary data depends on the command. The various
binary data formats are explained in the description of the
parameter types.
*RST: ASCii

Example: FORM ASC
The data is transferred as ASCII data.

:FORMat:SREGister <Format>

Determines the numerical format which is returned when the status registers are quer-
ied.

Parameters:
<Format> ASCii | BINary | HEXadecimal | OCTal

ASCii
The register content is returned as a decimal number.
BINary
The register content is returned as a binary number. #B is
placed in front of the number.
HEXadecimal
The register content is returned as a hexadecimal number. #H is
placed in front of the number.
OCTal
The register content is returned as an octal number. #Q is
placed in front of the number.
*RST: ASCii

Example: FORM:SREG HEX
The register content is returned as a hexadecimal number.

FORMat Subsystem
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10.9  MMEMory subsystem

The MMEMory subsystem (Mass Memory) contains the commands for managing files
and directories as well as for loading and storing complete instrument settings in files.

The files are stored on the internal flash memory of the instrument or on external USB
memory devices.

The default directory is determined using the command MMEMory:CDIR.

Use the command :SYSTem:MMEMory:PATH:USER? to query the path of the direc-
tory for user-defined data.

The /opt directory is a protected and therefore a not accessible system directory. The
files on this directory contain data that must not be changed. Therefore, this directory
should not be accessed, since reconstruction of the system partition will lead to data
loss.

10.9.1  File naming conventions

To enable files in different file systems to be used, the following file naming conven-
tions should be observed.

The file name can be of any length and is case-sensitive, meaning it is distinguished
between uppercase and lowercase letters.

The file and the optional file extension are separated by a dot. All letters and numbers
are permitted (numbers are, however, not permitted at the beginning of the file name).
If possible, special characters should not be used. The use of the slashes "\" and "/"
should be avoided since they are used in file paths. A number of names are reserved
for the operating system, e.g. CLOCK$, CON, AUX, COM1...COM4, LPT1...LPT3, NUL
and PRN.

In the R&S SGT all files in which lists and settings are stored are given a characteristic
extension. The extension is separated from the actual file name by a dot (see Chap-
ter 10.9.2, "Extensions for user files", on page 364 for an overview of the file types).

The two characters "*" and "?" function as "wildcards", meaning they are used for
selecting several files. The "?" character represents exactly one character, while the "*"
character represents all characters up to the end of the file name. "*.*" therefore stands
for all files in a directory.

When used in conjunction with the commands, the parameter <file_name> is speci-
fied as a string parameter with quotation marks. It can contain either the complete path
including the drive, only the path and the file name, or only the file name. The file name
must include the file extension. The same applies for the parameters
<directory_name> and <path>.

Depending on how much information is provided, either the values specified in the
parameter or the values specified with the command MMEM:CDIR (default directory)
are used for the path and the drive settings in the commands.
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Before the instrument settings can be stored in a file, they have to be stored in an inter-
mediate memory using common command *SAV <number>. The specified number is
subsequently used in the :MMEMory:STORe:STATe on page 372 command. Also,
subsequently to loading a file with instrument settings with command :MMEMory:
LOAD:STATe on page 371, these settings have to be activated with the common com-
mand *RCL <number>.

10.9.2  Extensions for user files

Table 10-1: Automatically assigned file extensions in the instrument

Function Contents File suffix

R&S SGMA-GUI Save As/Open Software settings *.savrcl

10.9.3  Examples

In these examples, the current instrument setting is stored in the file
test.savrcltxt in the directory /var/user/..

Storing and Loading Current Settings

1. Store the current setting in an intermediate memory with the number 4. This setting
can be called using command *RCL and the associated number of the memory, for
example *RCL 4.
*SAV 4

2. To store the settings in a file in a specific directory, specify the complete path.
MMEM:STOR:STAT 4,"/var/user/test.savrcltxt"

3. To store the settings in a file in the default drive, set the default drive and specify
only the file name.
MMEM:CDIR '/var/user/'*SAV 4
MMEM:STOR:STAT 4,"test.savrcltxt"

4. Load the file test.savrcltxt in the user directory.
MMEM:LOAD:STAT 4,'/var/user/test.savrcltxt'

5. Activate the instrument setting of the file test.savrcltxt.
*RCL 4

Working with Files and Directories

1. Read out all files in the specified directory.
MMEM:CAT? 'usbuser'
Response: 127145265,175325184,"test,DIR,0","temp,DIR,0",
"readme.txt,ASC,1324","state.savrcltxt,STAT,5327",
"waveform.wv,BIN,2342"

MMEMory subsystem



Remote control commandsR&S®SGT100A

365User Manual 1176.8674.02 ─ 12

the directory usbuser contains the subdirectories test and temp as well as the
files readme.txt, state.savrcltxt and waveform.wv which have different
file types.

Tip: To query only the subdirectories of the current or specified directory, perform:
MMEM:DCAT? 'usbuser'
Response: 'test', 'temp'
To query only the number of subdirectories in the current or specified directory, per-
form:
MMEM:DCAT:LENG? 'usbuser'
Response: 2

2. To query the number of files in the current or specified directory, perform:
MMEM:CAT:LENG? 'usbuser'
Response: 3

3. Create a new subdirectory for mass memory storage in the specified directory.
MMEM:MDIR 'usbnew'

4. Copy the file state to a new file.
MMEM:COPY '/var/user/state.savrcltxt','usbnew'

5. Rename the file state.
MMEM:MOVE 'state.savrcltxt','state_new.savrcltxt'

6. Remove the test directory.
MMEM:RDIR 'usbtest'

10.9.4  Remote control commands

:MMEMory:CATalog?......................................................................................................366
:MMEMory:CATalog:LENGth?......................................................................................... 366
:MMEMory:CDIRectory...................................................................................................366
:MMEMory:COPY...........................................................................................................367
:MMEMory:DATA............................................................................................................367
:MMEMory:DATA:UNPRotected.......................................................................................368
:MMEMory:DCATalog?....................................................................................................369
:MMEMory:DCATalog:LENGth?....................................................................................... 370
:MMEMory:DELete.........................................................................................................370
:MEMory:HFRee?.......................................................................................................... 370
:MMEMory:LOAD:STATe.................................................................................................371
:MMEMory:MDIRectory...................................................................................................371
:MMEMory:MOVE.......................................................................................................... 371
:MMEMory:MSIS............................................................................................................371
:MMEMory:RDIRectory...................................................................................................372
:MMEMory:STORe:STATe...............................................................................................372
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:MMEMory:CATalog? <path>

Returns the content of a particular directory.

Query parameters: 
<path> string

String parameter to specify the directory.
If you leave out the path, the command returns the contents of
the directory selected with :MMEMory:CDIRectory.
The path may be relative or absolute.

Return values: 
<UsedDiskSpace> Byte size of all files in the directory.

<FreeDiskSpace> Remaining disk space in bytes.

<FileInfo> <NameFileN>,<SuffixFileN>,<SizeFileN>
List of files, separated by commas
<NameFileN>
Name of the file.
<SuffixFileN>
Type of the file. Possible suffixes are: ASCii, BINary, DIRectory
<SizeFileN>
Size of the file in bytes.

Usage: Query only

:MMEMory:CATalog:LENGth? <Path>

Returns the number of files in the current or in the specified directory.

Query parameters: 
<Path> string

String parameter to specify the directory. If the directory is omit-
ted, the command queries the content of the current directory,
queried with :MMEMory:CDIRectory command.

Return values: 
<FileCount> integer

Number of files.

Usage: Query only

:MMEMory:CDIRectory <Directory>

Changes the default directory for mass memory storage. The directory is used for all
subsequent MMEM commands if no path is specified with them.
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Parameters:
<Directory> <directory_name>

String containing the path to another directory. The path can be
relative or absolute.
To change to a higher directory, use two dots '..' .

Usage: SCPI confirmed

:MMEMory:COPY <SourceFile>[,<DestinationFile>]

Copies an existing file to a new file. Instead of just a file, this command can also be
used to copy a complete directory together with all its files.

Setting parameters: 
<SourceFile> string

String containing the path and file name of the source file

<DestinationFile> string
String containing the path and name of the target file. The path
can be relative or absolute.
If <DestinationFile> is not specified, the <SourceFile> is
copied to the current directory, queried with the :MMEMory:
CDIRectory command.
Note: Existing files with the same name in the destination direc-
tory are overwritten without an error message.

Usage: Setting only
SCPI confirmed

:MMEMory:DATA <Filename>, <BinaryBlock>
:MMEMory:DATA? <Filename>

The setting command writes the block data <BinaryBlock> to the file identified by
<Filename>.

Tip: Use this command to read/transfer stored instrument settings or waveforms
directly from/to the instrument.

Parameters:
<BinaryBlock> #<number><length_entry><data>

#: Hash sign; always comes first in the binary block
<number>: the first digit indicates how many digits the subse-
quent length entry has
<length_entry>: indicates the number of subsequent bytes
<data>: binary block data for the specified length.
For files with a size with more than nine digits (gigabytes), the
instrument allows the syntax #(<Length>), where <Length>
is the file size in decimal format.
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Parameters for setting and query: 
<Filename> string

String parameter to specify the name of the file.

Example: MMEMory:DATA '/var/user/test.txt',#15hallo
Writes the block data to the file test.txt.
The digit 1 indicates a length entry of one digit; the digit 5 indi-
cate a length of the binary data (hallo) in bytes.
MMEMory:DATA? '/var/user/test.txt'
Sends the data of the file test.txt from the instrument to the
controller in the form of a binary block.
Response: #15hallo

Usage: SCPI confirmed

:MMEMory:DATA:UNPRotected <Msus>, <Data>

The setting command sends the I/Q data and the marker data to the file defined with
the <Msus> parameter. The required tags are created automatically so that the file
content follows the waveform file format.

The query reads out the I/Q data part or the marker information of the specified file.

Waveform files can also be created with the command [:SOURce<hw>]:BB:
ARBitrary:WAVeform:DATA. In this case, the complete content of the waveform file
must be specified, i.e. not only the I/Q or marker data but all required tags.

Parameters:
<Msus> <Identifier>:<file name>

Mass Storage Unit Specifier
A string that specifies whether I/Q data (NVWFM) or marker data
(NVMKR) is transferred and the file name the data is stored in.
If the file with the specified name does not exist, a file is created.
Any existing content in the file is overwritten.
Complete file path and file extension may also be specified. If
omitted, files are stored in the default directory and the exten-
sion *.wv is assigned to the file name.

Setting parameters: 
<Data> block data

I/Q data or marker binary data, where the number of marker ele-
ments has to be equal to the number of I/Q samples
Binary block data follows the syntax:
#<Digits><Length><I0Q0..IxQx…IN-1QN-1> or
#<Digits><Length><M0M1…Mx…MN-1>
#
Indicates the start of the data block

MMEMory subsystem



Remote control commandsR&S®SGT100A

369User Manual 1176.8674.02 ─ 12

<Digits>
Decimal value
Gives the number of decimal digits used for the <Length>
value
<Length>
Decimal value
Number of bytes that follow in the <Binary data> part
I0Q0..IxQx…IN-1QN-1
Binary data in ASCII format
IxQx… represents binary data (16-bit signed integer in 2's com-
plement notation) containing the I and Q component alternately
and starting with the I component. Each I and Q component con-
sists of 2 bytes in MSB format (most significant byte first).
The values of the 2 bytes in an I component and a Q component
are in the range: -32767 to +32767.
M0M1…Mx…MN-1
Binary data in ASCII format
Mx represents one marker byte, where only the 4 least signifi-
cant bits are used. These 4 bits are assigned to the 4 possible
markers of the instrument, 1 bit per marker: Bit0 = Marker 1, ...
Bit3 = Marker 4.
One 4-bit marker element is required for every I/Q sample.

Example: :MMEM:DATA:UNPR "NVWFM:/var/user/wave.wv",#220<I0Q0..IxQx>
// the binary data <I0Q0..IxQx> is added to a file named wave.wv 
// and saved in the selected directory
// <I0Q0..IxQx> contains of 20 bytes, i.e. 5 I/Q samples, 
// 2 bytes for each I and Q component
// <I0Q0..IxQx> is a placeholder; 
// the actual ASCII values are not printable

:MMEMory:DATA:UNPRotected? "NVWFM:/var/user/wave.wv"
:MMEMory:DATA:UNPRotected "NVMKR:/var/user/wave.wv",#15<M0M1…M5>
// the specified marker data is added to a file named wave.wv
// in the specified directory
// used are printable values; 
// used are only the 4 least significant bits of a byte
:MMEMory:DATA:UNPRotected? "NVMKR:/var/user/wave.wv"
// note that, the query returns binary values
SOURce1:BB:ARBitrary:WAVeform:CLOCk "/var/user/wave.wv",1.1E6
SOURce1:BB:ARBitrary:WAVeform:CLOCk? "/var/user/wave.wv"

:MMEMory:DCATalog? <path>

Returns the subdirectories of a particular directory.
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Query parameters: 
<path> String parameter to specify the directory. If the directory is omit-

ted, the command queries the content of the current directory,
queried with :MMEMory:CDIRectory command.

Return values: 
<Catalog> <file_entry>

Names of the subdirectories separated by colons. The first two
strings are related to the parent directory.

Usage: Query only

:MMEMory:DCATalog:LENGth? [<Path>]

Returns the number of subdirectories in the current or specified directory.

Query parameters: 
<Path> String parameter to specify the directory. If the directory is omit-

ted, the command queries the contents of the current directory,
to be queried with :MMEMory:CDIRectory command.

Return values: 
<DirectoryCount> integer

Number of parent and subdirectories.

Usage: Query only

:MMEMory:DELete <Filename>

Removes a file from the specified directory.

Setting parameters: 
<Filename> string

String parameter to specify the name and directory of the file to
be removed.

Usage: Event
SCPI confirmed

:MEMory:HFRee?

Returns the used and available memory in Kb.

Return values: 
<TotalPhysMemKb> integer

Total physical memory.

<ApplicMemKb> integer
Application memory.

<HeapUsedKb> integer
Used heap memory.
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<HeapAvailableKb> integer
Available heap memory.

Usage: Query only

:MMEMory:LOAD:STATe <SavRclStateNumb>, <file_name>

Loads the specified file stored under the specified name in an internal memory.

After the file has been loaded, the instrument setting must be activated using an *RCL
command.

Setting parameters: 
<SavRclStateNumb> Determines to the specific <number> to be used with the *RCL

command, e.g. *RCL 4.

<file_name> String parameter to specify the file name with extension
*.savrcltxt.

Usage: Setting only

:MMEMory:MDIRectory <Directory>

Creates a subdirectory for mass memory storage in the specified directory. If no direc-
tory is specified, a subdirectory is created in the default directory. This command can
also be used to create a directory tree.

Setting parameters: 
<Directory> string

String parameter to specify the new directory.

Usage: Event

:MMEMory:MOVE <SourceFile>, <DestinationFile>

Moves an existing file to a new location or, if no path is specified, renames an existing
file.

Setting parameters: 
<SourceFile> string

String parameter to specify the name of the file to be moved.

<DestinationFile> string
String parameters to specify the name of the new file.

Usage: Event
SCPI confirmed

:MMEMory:MSIS <Msis>

Defines the drive or network resource (in the case of networks) for instruments with
windows operating system, using msis (MSIS = Mass Storage Identification String).
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Note: Instruments with Linux operating system ignore this command, since Linux does
not use drive letter assignment.

Usage: SCPI confirmed

:MMEMory:RDIRectory <Directory>

Removes an existing directory from the mass memory storage system. If no directory
is specified, the subdirectory with the specified name is deleted in the default directory.

Setting parameters: 
<Directory> string

String parameter to specify the directory to be deleted.

Usage: Event

:MMEMory:STORe:STATe <savrcl_state_nr>, <file_name>

Stores the current instrument setting in the specified file.

The instrument setting must first be stored in an internal memory with the same num-
ber using the common command *SAV.

Setting parameters: 
<savrcl_state_nr> Corresponds to the specific <number> defined with the *SAV

command, e.g. *SAV 4.

<file_name> String parameter to specify the file name with extension
*.savrcltxt.

Usage: Event

10.10  Fast speed commands

This section describes special commands that allow a fast frequency and level setting.

:FFASt.......................................................................................................................... 372
:PFASt.......................................................................................................................... 373

:FFASt <Freq>

Special command to set the RF output frequency with minimum latency. No unit (e.g.
Hz) allowed.

Bypasses the status system so command *OPC? cannot be appended.

Parameters:
<Freq> float

Example: FFASt 12750000000
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:PFASt <Pow>

Special command to set the RF output level with minimum latency at the RF output
connector. This value does not consider a specified offset. No unit (e.g. dBm) allowed.

Bypasses the status system so command *OPC? cannot be appended.

Parameters:
<Pow> float

Example: :PFASt -20

10.11  OUTPut subsystem

:OUTPut:AFIXed:RANGe:LOWer?...................................................................................373
:OUTPut:AFIXed:RANGe:UPPer?....................................................................................373
:OUTPut:AMODe........................................................................................................... 373
:OUTPut[:STATe]............................................................................................................374
:OUTPut[:STATe]:PON....................................................................................................374

:OUTPut:AFIXed:RANGe:LOWer?

Queries the minimum level which can be set without the attenuator being adjusted
(Attenuator FIXed).

Return values: 
<Lower> float

Usage: Query only

Manual operation: See "Level Range" on page 228

:OUTPut:AFIXed:RANGe:UPPer?

Queries the maximum level which can be set without the attenuator being adjusted
(Attenuator FIXed).

Return values: 
<Upper> float

Usage: Query only

Manual operation: See "Level Range" on page 228

:OUTPut:AMODe <AMode>

Switches the mode of the attenuator at the RF output.

Parameters:
<AMode> AUTO | FIXed | APASsive
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AUTO
The attenuator is switched automatically. The level settings are
made in the full range.
APASsive
The attenuator is switched automatically. The level settings are
made only for the passive reference circuits. The high-level
ranges are not available.
FIXed
The level settings are made without switching the attenuator.
When this operating mode is switched on, the attenuator is fixed
to its current position and the resulting variation range is defined.
*RST: AUTO

Manual operation: See "Mode" on page 227

:OUTPut[:STATe] <State>

Activates the RF output signal ([RF on/off]).

Parameters:
<State> 1 | ON | 0 | OFF

Manual operation: See "RF On/Off" on page 68

:OUTPut[:STATe]:PON <Pon>

Selects the state of the RF output when the instrument is switched on.

Parameters:
<Pon> OFF | UNCHanged

OFF
Deactivates the output when the instrument is switched on ([RF
off]).
UNCHanged
Restores the initial state of the RF output before the last turn off.
*RST: UNCHanged

Manual operation: See "Power-On State" on page 229

10.12  SCONfiguration subsystem

:SCONfiguration:MODE.................................................................................................. 374

:SCONfiguration:MODE <Configuration>

Switches between standard mode and ARB mode for envelope tracking.

Parameters:
<Configuration> STANdard | AFETracking
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STANdard
Standard mode used for signal generation.
AFETracking
ARB foe Envelope Tracking: enables the usage of an extra
baseband for enabling the envelope tracking ARB generation.
*RST: STANdard

Manual operation: See "System Configuration" on page 86

10.13  SENSe, READ, INITiate and SLISt subsystems

These subsystems contain the commands for configuring the power measurements
with R&S NRP power sensor connected to the R&S SGT.

The local state is set with the INIT command. Switching off the local state enhances
the measurement performance. Measurements results can be retrieved in local state
on or off.
Sensor parameters are set with the SENSe commands.
To start the measurement and retrieve the result, use the :READ<ch>[:POWer]?
command.

Suffix Value range Description

SENSe<ch> [1] to 4 Indicates the sensor

Use the :SLISt commands to change the sensor mapping

READ<ch> [1] to 4 Sensor assignment

INIate<hw> [1] to 4 Sensor assignment

ELEMent<ch> [1] to 25 Sensor-mapping list
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Programming examples

Example: Detecting and assigning a power sensor
SLISt:LIST?
// Response: "NRP33SN-V-900007-USB Legacy","NRP-Z211-900001-USB Legacy"
// Lists all automatically detected sensors.

SLISt:SCAN:STATe 1
// Searches for sensors connected in the LAN or via the USBTMC protocol.

SLISt:SCAN:LSENsor 'NRQ6',101624 // sensor name, serial number
SLISt:SCAN:LSENsor 11.123.1.123, 101624 // IP address, serial number
// Adds sensors to the list, that are connected to LAN.

SLISt:SCAN:USENsor 'NRQ6',101624 //sensor name, serial number
SLISt:SCAN:USENsor #H15b,101624  //device ID (hexadecimal), serial number
SLISt:SCAN:USENsor 347,101624    //device ID (decimal), serial number
// Adds a sensor to the list, that is connected to the USB interface.

SLISt:LIST?
// Response: "NRP33SN-V-900007-USB Legacy","NRP-Z211-900001-USB Legacy",
// "NRP33SN-V-900005-USBTMC","NRP33SN-V-900011-LAN"
// Lists all automatically detected sensors.

SLISt:ELEMent3:MAPPing SENS1
// Maps the third sensor from the list to the first sensor channel.

SLISt:SENSor:MAP "NRPS18S-100654-USB Legacy", SENS3
// Maps the sensor to channel 3.

SLISt:CLEar[ALL]
// Remove all sensors from the list.
SLISt:CLEar:LAN 
// Remove all sensors from the list, that are connected over LAN.
SLISt:CLEar:USB 
// Remove all sensors from the list, that are connected over USB.

Example: Performing a simple power measurement
Prerequisite: The sensor is connected to the instrument and mapped to the first sensor
channel.
INITiate1:CONTinuous ON
// Switches the continous power measurement on.

READ1?
// Triggers the measurement and displays the results.
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Example: Performing a power measurement with a fixed filter
Prerequisite: The sensor is connected to the instrument and mapped to the first sensor
channel.
SENSe1:SOURce RF 
// Sensor measures the power of the RF signal.

SENSe1:FILTer:TYPE NSRatio
// Selects fixed noise filter mode.

SENSe1:FILTer:NSRatio 0.02 DB
// Sets the maximum noise component in the result to 0.02 DB.

SENSe1:FILTer:NSRatio:MTIMe 10
//Limits the settling time to 10 seconds.

SENSe1:APERture:DEFault:STATe 0
// Deactivates the default aperture time of the sensor.

SENSe1:APERture:TIMe 10e-6
// Sets the aperture time to 10 us.

SENSe1:UNIT DBM
// Selects unit dBm for the measured value.

INITiate:CONTinuous ON
// Switches the continous power measurement on.

READ?
// Triggers the measurement and displays the results.

:SLISt[:LIST]?................................................................................................................ 378
:SLISt:SCAN[:STATe]......................................................................................................378
:SLISt:SCAN:LSENsor....................................................................................................378
:SLISt:SCAN:USENsor................................................................................................... 379
:SLISt:CLEar:LAN.......................................................................................................... 379
:SLISt:CLEar:USB..........................................................................................................379
:SLISt:CLEar[:ALL].........................................................................................................380
:SLISt:ELEMent<ch>:MAPPing........................................................................................380
:SLISt:SENSor:MAP.......................................................................................................380
:INITiate<hw>[:POWer]:CONTinuous............................................................................... 380
:READ<ch>[:POWer]?.................................................................................................... 381
:SENSe<ch>:UNIT[:POWer]............................................................................................381
:SENSe<ch>[:POWer]:APERture:DEFault:STATe.............................................................. 382
:SENSe<ch>[:POWer]:APERture:TIMe.............................................................................382
:SENSe<ch>[:POWer]:CORRection:SPDevice:SELect.......................................................382
:SENSe<ch>[:POWer]:CORRection:SPDevice:STATe........................................................383
:SENSe<ch>[:POWer]:CORRection:SPDevice:LIST?.........................................................383
:SENSe<ch>[:POWer]:DISPlay:PERManent:PRIority.........................................................383
:SENSe<ch>[:POWer]:DISPlay:PERManent:STATe........................................................... 383
:SENSe<ch>[:POWer]:FILTer:LENGth:AUTO?.................................................................. 384
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:SENSe<ch>[:POWer]:FILTer:LENGth[:USER].................................................................. 384
:SENSe<ch>[:POWer]:FILTer:NSRatio............................................................................. 385
:SENSe<ch>[:POWer]:FILTer:NSRatio:MTIMe.................................................................. 385
:SENSe<ch>[:POWer]:FILTer:SONCe.............................................................................. 385
:SENSe<ch>[:POWer]:FILTer:TYPE................................................................................. 386
:SENSe<ch>[:POWer]:FREQuency..................................................................................386
:SENSe<ch>[:POWer]:LOGGing:STATe............................................................................387
:SENSe<ch>[:POWer]:OFFSet........................................................................................ 387
:SENSe<ch>[:POWer]:OFFSet:STATe..............................................................................387
:SENSe<ch>[:POWer]:SNUMber?................................................................................... 387
:SENSe<ch>[:POWer]:SOURce.......................................................................................388
:SENSe<ch>[:POWer]:STATus[:DEVice]?......................................................................... 388
:SENSe<ch>[:POWer]:SVERsion?...................................................................................388
:SENSe<ch>[:POWer]:TYPE?......................................................................................... 389
:SENSe<ch>[:POWer]:ZERO.......................................................................................... 389

:SLISt[:LIST]?

Returns a list of all detected sensors in a comma-separated string.

Return values: 
<SensorList> String of comma-separated entries

Each entry contains information on the sensor type, serial num-
ber and interface.
The order of the entries does not correspond to the order the
sensors are displayed in the "NRP Sensor Mapping" dialog.

Example: See Example"Detecting and assigning a power sensor"
on page 376.

Usage: Query only

Manual operation: See "Sensor Mapping List" on page 254

:SLISt:SCAN[:STATe] <State>

Starts the search for R&S NRP power sensors, connected in the LAN or via the
USBTMC protocol.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Detecting and assigning a power sensor"
on page 376.

Manual operation: See "Scan" on page 254

:SLISt:SCAN:LSENsor <IP>

Scans for R&S NRP power sensors connected in the LAN.
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Setting parameters: 
<IP> string

*RST: 0

Example: See Example"Detecting and assigning a power sensor"
on page 376.

Usage: Setting only

Manual operation: See "Add LAN Sensor settings" on page 254

:SLISt:SCAN:USENsor <DeviceID>, <Serial>

Scans for R&S NRP power sensors connected over a USB interface.

Parameters:
<Serial> integer

Range: 0  to  999999

Setting parameters: 
<DeviceID> String or Integer

Range: 0  to  999999
*RST: 0

Example: See Example"Detecting and assigning a power sensor"
on page 376.

Usage: Setting only

Manual operation: See "Add USB Sensor settings" on page 255

:SLISt:CLEar:LAN

Removes all R&S NRP power sensors connected in the LAN from the list.

Example: See Example"Detecting and assigning a power sensor"
on page 376.

Usage: Event

Manual operation: See "Clear" on page 254

:SLISt:CLEar:USB

Removes all R&S NRP power sensors connected over USB from the list.

Example: See Example"Detecting and assigning a power sensor"
on page 376.

Usage: Event

Manual operation: See "Clear" on page 254
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:SLISt:CLEar[:ALL]

Removes all R&S NRP power sensors from the list.

Example: See Example"Detecting and assigning a power sensor"
on page 376.

Usage: Event

Manual operation: See "Clear" on page 254

:SLISt:ELEMent<ch>:MAPPing <Mapping>

Assigns an entry from the :SLISt[:LIST]? to one of the four sensor channels.

Parameters:
<Mapping> SENS1 | SENSor1 | SENS2 | SENSor2 | SENS3 | SENSor3 |

SENS4 | SENSor4 | UNMapped
Sensor channel.
*RST: UNMapped

Example: See Example"Detecting and assigning a power sensor"
on page 376.

Manual operation: See "Sensor Mapping List" on page 254

:SLISt:SENSor:MAP <SensorId>, <Mapping>

Assigns a sensor directly to one of the sensor channels, using the sensor name and
serial number.

To find out the the sensor name and ID, you can get it from the label of the R&S NRP,
or using the command :SLISt:SCAN[:STATe]. This command detects all R&S NRP
power sensors connected in the LAN or via 'USBTMC protocol.

Setting parameters: 
<SensorId> string

<Mapping> enum

Example: See Example"Detecting and assigning a power sensor"
on page 376.

Usage: Setting only

Manual operation: See "Sensor Mapping List" on page 254

:INITiate<hw>[:POWer]:CONTinuous <Continuous>

Switches the local state of the continuous power measurement by R&S NRP power
sensors on and off. Switching off local state enhances the measurement performance
during remote control.
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The remote measurement is triggered with :READ<ch>[:POWer]?). This command
also returns the measurement results. The local state is not affected, measurement
results can be retrieved with local state on or off.

Parameters:
<Continuous> 1 | ON | 0 | OFF

*RST: 0

Example: INIT1:CONT ON
Switches on the local state of continuous power measurement.

Manual operation: See "State" on page 249

:READ<ch>[:POWer]?

Triggers power measurement and displays the results.

Note: This command does not affect the local state, i.e. you can get results with local
state on or off. For long measurement times, we recommend that you use an SRQ for
command synchronization (MAV bit).

Suffix: 
<ch>

.
1 to 3

Return values: 
<Power> float or float,float

The sensor returns the result in the unit set with command :
SENSe<ch>:UNIT[:POWer]
Certain power sensors, such as the R&S NRP-Z81, return two
values, first the value of the average level and - separated by a
comma - the peak value.

Example: :SENS1:UNIT DBM
Selects unit dBm for presentation of measurement result.
:READ1?
Queries the measurement result of the sensor.
-45.6246576745440230
-45.6 dBm were measured at the given frequency.

Example: R&S NRP-Z81
:READ1?
-55.62403263352178,-22.419472478812476
-55.6 dBm is the measured average level, -22. 4 dBm is the
measured peak level at the given frequency.

Usage: Query only

Manual operation: See "Level (Peak) / Level (Average)" on page 249

:SENSe<ch>:UNIT[:POWer] <Power>

Selects the unit (Watt, dBm or dBμV) of measurement result display, queried with :
READ<ch>[:POWer]?.
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Parameters:
<Power> DBM | DBUV | WATT

*RST: DBM

Example: :SENS2:UNIT DBM
Selects dBm as unit for the measured value returned by com-
mand READ.
:READ2?
Response: 7.34
7.34 dBm are measured by sensor 2.

Manual operation: See "Level (Peak) / Level (Average)" on page 249

:SENSe<ch>[:POWer]:APERture:DEFault:STATe <UseDefAp>

Deactivates the default aperture time of the respective sensor.

To specify a user-defined value, use the command :SENSe<ch>[:POWer]:
APERture:TIMe on page 382.

Parameters:
<UseDefAp> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"Performing a power measurement with a fixed fil-
ter" on page 377.

Manual operation: See "Default Aperture Time" on page 252

:SENSe<ch>[:POWer]:APERture:TIMe <ApTime>

Defines the aperture time (size of the acquisition interval) for the corresponding sensor.

Parameters:
<ApTime> float

Range: depends on connected power sensor
Increment: 1E-9
*RST: depends on connected power sensor

Example: See Example"Performing a power measurement with a fixed fil-
ter" on page 377.

Manual operation: See "Aperture Time" on page 252

:SENSe<ch>[:POWer]:CORRection:SPDevice:SELect <Select>

Several S-parameter tables can be stored in a sensor. The command selects a loaded
data set for S-parameter correction for the corresponding sensor.

Parameters:
<Select> float

*RST: 0
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Manual operation: See "S-Parameter" on page 252

:SENSe<ch>[:POWer]:CORRection:SPDevice:STATe <State>

Activates the use of the S-parameter correction data.

Note: If you use power sensors with attenuator, the instrument automatically activates
the use of S-parameter data.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: :SENSe1:POWer:CORRection:SPDevice:STATe 1
Activates the use of the S-parameters correction data.

Manual operation: See "S-Parameter" on page 252

:SENSe<ch>[:POWer]:CORRection:SPDevice:LIST?

Queries the list of the S-parameter data sets that have been loaded to the power sen-
sor.

Return values: 
<List> string list

*RST: 0

Usage: Query only

Manual operation: See "S-Parameter" on page 252

:SENSe<ch>[:POWer]:DISPlay:PERManent:PRIority <Priority>

Selects average or peak power for permanent display.

Parameters:
<Priority> AVERage | PEAK

*RST: AVERage

Example: :SENS1:DISP:PERM:STAT ON
Turns on the permanent view.
:SENS1:DISP:PERM:PRI AVER
Sets the average power for display.

Manual operation: See "Display" on page 250

:SENSe<ch>[:POWer]:DISPlay:PERManent:STATe <State>

Activates the permanent display of the measured power level results. The instrument
also indicates the sensor type, the connection, the measurement source and the offset
if set.
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Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: :SENS1:POW:DISP:PERM:STAT ON
Turns on the permanent view.

Manual operation: See "Permanent" on page 250

:SENSe<ch>[:POWer]:FILTer:LENGth:AUTO?

Queries the current filter length in filter mode AUTO (:SENSe<ch>[:POWer]:
FILTer:TYPE)

Return values: 
<Auto> float

Range: 1  to  65536

Example: :SENS1:FILT:TYPE AUTO
Selects auto filter.
:SENS1:FILT:LENG:AUTO?
Queries the automatically set filter length.
Response: 1024

Usage: Query only

Manual operation: See "Filter Length" on page 251

:SENSe<ch>[:POWer]:FILTer:LENGth[:USER] <User>

Selects the filter length for SENS:POW:FILT:TYPE USER. As the filter length works as
a multiplier for the time window, a constant filter length results in a constant measure-
ment time (see also "About the measuring principle, averaging filter, filter length, and
achieving stable results" on page 245).

The R&S NRP power sensors provide different resolutions for setting the filter length,
depending on the used sensor type:
● Resolution = 1 for R&S NRPxx power sensors
● Resolution = 2n for sensors of the R&S NRP-Zxx family, with n = 1 to 16

Parameters:
<User> float

Range: 1  to  65536
*RST: 1

Example: :SENS1:FILT:TYPE USER
Selects user filter mode.
:SENS1:FILT:LENG 16
Sets a filter length of 16. E.g. using a sensor with 20 ms time
window, the resulting measurement time is 640 ms (2x16x20
ms)
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Manual operation: See "Filter Length" on page 251

:SENSe<ch>[:POWer]:FILTer:NSRatio <NSRatio>

Sets an upper limit for the relative noise content in fixed noise filter mode (:
SENSe<ch>[:POWer]:FILTer:TYPE). This value determines the proportion of intrin-
sic noise in the measurement results.

Parameters:
<NSRatio> float

Range: 0.001  to  1
Increment: 0.001
*RST: 0.01

Example: See Example"Performing a power measurement with a fixed fil-
ter" on page 377.

Manual operation: See "Noise Content" on page 251

:SENSe<ch>[:POWer]:FILTer:NSRatio:MTIMe <MTime>

Sets an upper limit for the settling time of the auto-averaging filter in the NSRatio
mode and thus limits the length of the filter. The filter type is set with command :
SENSe<ch>[:POWer]:FILTer:TYPE.

Parameters:
<MTime> float

Range: 1  to  999.99
Increment: 0.01
*RST: 4

Example: See Example"Performing a power measurement with a fixed fil-
ter" on page 377.

Manual operation: See "Timeout" on page 252

:SENSe<ch>[:POWer]:FILTer:SONCe

Starts searching the optimum filter length for the current measurement conditions. You
can check the result with command :SENS1:POW:FILT:LENG:USER? in filter mode
USER (:SENSe<ch>[:POWer]:FILTer:TYPE).

Example: SENS1:FILT:TYPE USER
Selects user filter mode.
:SENS1:FILT:SONC
Activates the search for the optimum filter length.
:SENS1:FILT:LENG?
Returns the found optimum filter length.
Response: 128

Usage: Event
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Manual operation: See "Auto Once" on page 251

:SENSe<ch>[:POWer]:FILTer:TYPE <Type>

Selects the filter mode. The filter length is the multiplier for the time window and thus
directly affects the measurement time.

Parameters:
<Type> AUTO | USER | NSRatio

AUTO
Automatically selects the filter length, depending on the mea-
sured value. The higher the power, the shorter the filter length,
and vice versa.
USER
Allows you to set the filter length manually. As the filter-length
takes effect as a multiplier of the measurement time, you can
achieve constant measurement times.
NSRatio
Selects the filter length (averaging factor) according to the crite-
rion that the intrinsic noise of the sensor (2 standard deviations)
does not exceed the specified noise content. You can define the
noise content with command :SENSe<ch>[:POWer]:FILTer:
NSRatio.
Note: To avoid long settling times when the power is low, you
can limit the averaging factor limited with the "timeout" parame-
ter (:SENSe<ch>[:POWer]:FILTer:NSRatio:MTIMe).
*RST: AUTO

Example: See Example"Performing a power measurement with a fixed fil-
ter" on page 377.

Manual operation: See "Filter" on page 251

:SENSe<ch>[:POWer]:FREQuency <Frequency>

Sets the RF frequency of the signal, if signal source :SENSe<ch>[:POWer]:SOURce
USER is selected.

Parameters:
<Frequency> float

*RST: 1 GHz

Example: :SENS1:SOUR USER
Selects user-defined source.
:SENS1:FREQ 2.44GHz
Sets the RF frequency of the source which is 2.44 GHz.

Manual operation: See "Frequency" on page 250
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:SENSe<ch>[:POWer]:LOGGing:STATe <State>

Activates the recording of the power values, measured by a connected R&S NRP
power sensor.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: :SENS:LOGG:STAT ON
Activates recording of the power measurement of the first sen-
sor.

Manual operation: See "Enable Logging" on page 252

:SENSe<ch>[:POWer]:OFFSet <Offset>

Sets a level offset which is added to the measured level value after activation with
command :SENSe<ch>[:POWer]:OFFSet:STATe. The level offset allows, e.g. to
consider an attenuator in the signal path.

Parameters:
<Offset> float

Range: -100.0  to  100.0
*RST: 0
Default unit: dB

Example: :SENS1:POW:OFFS 10.0
Sets a level offset of 10 dB

Manual operation: See "Level Offset State,Level Offset" on page 250

:SENSe<ch>[:POWer]:OFFSet:STATe <State>

Activates the addition of the level offset to the measured value. The level offset value is
set with command :SENSe<ch>[:POWer]:OFFSet.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: :SENS1:POW:OFFS 0.4dB
Sets a level offset of 0.4 dB
:SENS1:POW:OFFS:STAT ON
A level offset of 0.4 dB is added to the measured value.

Manual operation: See "Level Offset State,Level Offset" on page 250

:SENSe<ch>[:POWer]:SNUMber?

Queries the serial number of the sensor.
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Return values: 
<SNumber> string

Example: :SENS1:SNUM?
Queries the serial number.

Usage: Query only

Manual operation: See "Sensor type and serial number" on page 249

:SENSe<ch>[:POWer]:SOURce <Source>

Determines the signal to be measured.

Note: When measuring the RF signal, the sensor considers the corresponding correc-
tion factor at that frequency, and uses the level setting of the instrument as reference
level.

Parameters:
<Source> A | USER | RF

*RST: A

Example: See Example"Performing a power measurement with a fixed fil-
ter" on page 377.

Manual operation: See "Source" on page 250

:SENSe<ch>[:POWer]:STATus[:DEVice]?

Queries if a sensor is connected to the instrument.

Return values: 
<Status> 1 | ON | 0 | OFF

*RST: 0

Example: :SENS1:STAT?
Response: 1
A sensor is connected.

Usage: Query only

Manual operation: See "State" on page 249

:SENSe<ch>[:POWer]:SVERsion?

Queries the software version of the connected R&S NRP power sensor.

Return values: 
<SVersion> string

Example: :SENS1:POW:SVER?
Queries the software version of the power sensor.

Usage: Query only
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:SENSe<ch>[:POWer]:TYPE?

Queries the sensor type. The type is automatically detected.

Return values: 
<Type> string

Example: :SENS1:TYPE?
Queries the type of sensor.
Response: NRP-Z21
The R&S NRP-Z21 sensor is used.

Usage: Query only

Manual operation: See "Sensor type and serial number" on page 249

:SENSe<ch>[:POWer]:ZERO

Performs zeroing of the sensor.

Zeroing is required after warm-up, i.e. after connecting the sensor.

Note: Switch off or disconnect the RF power source from the sensor before zeroing.

We recommend that you zero in regular intervals (at least once a day), if:
● The temperature has varied more than about 5 °C.
● The sensor has been replaced.
● You want to measure very low power.

Example: :SENS1:ZERO
Executes zeroing.

Usage: Event

Manual operation: See "Zero" on page 249

10.14  SOURce subsystem

The SOURce subsystem contains the commands for configuring the digital and analog
signals.

SOURce<hw>

The R&S SGT is a one path instrument, therefore the keyword SOURce<hw> is
optional and can be omitted.

Exception are some commands used with option R&S SGT-K540, envelope tracking.
For details, see Chapter 10.14.4, "SOURce:BB:ARB subsystem", on page 401.

● SOURce general commands................................................................................ 390
● SOURce:AWGN subsystem..................................................................................392
● SOURce:BB subsystem general commands........................................................ 400
● SOURce:BB:ARB subsystem................................................................................401
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● SOURce:BB:ARBitrary:CFR subsystem............................................................... 449
● SOURce:BBIN subsystem.................................................................................... 455
● SOURce:BB:IMPairment subsystem.....................................................................462
● SOURce:BB:PROGress subsystem general commands......................................467
● SOURce:BB:POWer subsystem........................................................................... 468
● SOURce:CORRection subsystem.........................................................................469
● SOURce:IQ subsystem.........................................................................................478
● SOURce:IQ:OUTPut subsystem...........................................................................481
● SOURce:IQ:OUTPut:ENVelope commands..........................................................485
● SOURce:IQ:DPD subsystem................................................................................ 500
● SOURce:PHASe subsystem.................................................................................515
● SOURce:PULM Subsystem.................................................................................. 515
● SOURce:POWer subsystem.................................................................................520
● SOURce:ROSCillator subsystem..........................................................................527

10.14.1  SOURce general commands

[:SOURce]:FREQuency[:CW|FIXed].................................................................................390
[:SOURce]:FREQuency:OFFSet......................................................................................390
[:SOURce]:OPMode....................................................................................................... 391
[:SOURce]:LOSCillator:SOURce......................................................................................391
[:SOURce]:PATH:COUNt?...............................................................................................391

[:SOURce]:FREQuency[:CW|FIXed] <Cw>

Sets the RF frequency at the RF output connector of the selected instrument.

Note: Enabled frequency offset affects the result of this query. The query returns the
frequency, including frequency offset.

Parameters:
<Cw> float

*RST: 1 GHz

Example: See [:SOURce]:FREQuency:OFFSet on page 390.

Manual operation: See "Freq/Freq (Offs)" on page 67
See "Frequency" on page 218

[:SOURce]:FREQuency:OFFSet <Offset>

Sets a frequency offset, for example include the frequency shift of downstream instru-
ment.

Note: Enabled frequency offset affects the result of the query :SOURce:FRE 
Quency:CW?
The query returns the frequency, including frequency offset.
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Parameters:
<Offset> float

Range: -3e9  to  3e9
Increment: 1E-3
*RST: 0

Example: SOURce:FREQuency:OFFSet 0
SOURce:FREQuency:CW 2143000000
SOURce:FREQuency:OFFSet 20000000
SOURce:FREQuency:CW?
// 2163000000

Manual operation: See "Offset" on page 218

[:SOURce]:OPMode <OpMode>

Sets the operation mode.

Parameters:
<OpMode> NORMal | BBBYpass

NORMal
normal operation
BBBYpass
Baseband bypass mode
*RST: NORMal

Manual operation: See "Operation Mode" on page 217

[:SOURce]:LOSCillator:SOURce <Source>

Selects the source of the local oscillator signal.

Parameters:
<Source> INTernal | EXTernal

INT: use built in oscillator; EXT: use signal at [LO/ REF IN] con-
nector
*RST: INTernal

Manual operation: See "Source" on page 220

[:SOURce]:PATH:COUNt?

Queries the number of installed RF paths.

Return values: 
<Count> integer

Range: 1  to  INT_MAX
*RST: 1
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Example: PATH:COUN?
Queries the number of RF paths.
Response: 1
The instrument is equipped with one RF path.

Usage: Query only

10.14.2  SOURce:AWGN subsystem

The SOURce:AWGN subsystem contains the commands for setting the noise generator.

These commands are available in instrument equipped with the option R&S SGT-K62
(Additive White Gaussian Noise).

[:SOURce<hw>]:AWGN:BRATe....................................................................................... 392
[:SOURce<hw>]:AWGN:BWIDth......................................................................................393
[:SOURce<hw>]:AWGN:BWIDth:NOISe?..........................................................................393
[:SOURce<hw>]:AWGN:BWIDth:RATio............................................................................ 393
[:SOURce<hw>]:AWGN:CNRatio.....................................................................................394
[:SOURce<hw>]:AWGN:DISP:MODE...............................................................................394
[:SOURce<hw>]:AWGN:DISP:ORESults.......................................................................... 394
[:SOURce<hw>]:AWGN:ENRatio..................................................................................... 395
[:SOURce<hw>]:AWGN:FREQuency:RESult?...................................................................395
[:SOURce<hw>]:AWGN:FREQuency:TARGet................................................................... 395
[:SOURce<hw>]:AWGN:MODE....................................................................................... 396
[:SOURce<hw>]:AWGN:POWer:CARRier.........................................................................396
[:SOURce<hw>]:AWGN:POWer:MODE............................................................................397
[:SOURce<hw>]:AWGN:POWer:NOISe............................................................................397
[:SOURce<hw>]:AWGN:POWer:NOISe:TOTal?.................................................................397
[:SOURce<hw>]:AWGN:POWer:RMODe..........................................................................398
[:SOURce<hw>]:AWGN:POWer:SUM?.............................................................................398
[:SOURce<hw>]:AWGN:POWer:SUM:PEP?..................................................................... 399
[:SOURce<hw>]:AWGN:STATe........................................................................................399

[:SOURce<hw>]:AWGN:BRATe <BRate>

Sets the bit rate which is used for calculation of bit energy to noise power ratio from
carrier/noise ratio for Digital Standard signals.

Valid units are bps, kbps and mabps as well as b/s, kb/s and mab/s.

Parameters:
<BRate> float

Range: 400 bps  to  250E6 bps
Increment: 0.001
*RST: 100000

Example: SOURce1:AWGN:BRATe?
queries the bit rate which is used for calculation of the Eb/N0
value from the C/N value.

Manual operation: See "Bit Rate" on page 147
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[:SOURce<hw>]:AWGN:BWIDth <BWidth>

Sets the system bandwidth. The noise signal at the level which corresponds to the
specified carrier/noise ratio is generated in the bandwidth specified here.

This command is available for modes Additive Noise and Noise Only
(SOUR:AWGN:MODE ADD|ONLY).

Parameters:
<BWidth> float

Range: 1000  to  depends on the installed options
Increment: 100
*RST: 3.84E6

Example: SOURce:AWGN:MODE ADD
SOURce:AWGN:BWIDth 10 MHz
Sets a system bandwidth of 10 MHz.

Manual operation: See "System Bandwidth" on page 144

[:SOURce<hw>]:AWGN:BWIDth:NOISe?

This command is available for modes In Additive Noise and Noise Only
(SOUR:AWGN:MODE ADD|ONLY) modes, queries the real noise bandwidth.

Return values: 
<Noise> float

Range: 0  to  200E6
Increment: 100
*RST: 0

Example: AWGN:BWID:NOIS?
queries the noise bandwidth.

Usage: Query only

Manual operation: See "Noise Bandwidth" on page 146

[:SOURce<hw>]:AWGN:BWIDth:RATio <Ratio>

In Additive Noise and Noise Only (SOUR:AWGN:MODE ADD|ONLY) modes, sets the
ratio of minimum real noise bandwidth to system bandwidth.

The overall bandwidth is calculated as follows and may not exceed the total bandwidth
specified in the data sheet:

Overall Bandwidth = System BW x Min Noise/System BW Ratio

Parameters:
<Ratio> float

Range: 1  to  Max
Increment: 0.1
*RST: 1
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Example: AWGN:BWID:RAT 2
sets a minimum noise/system bandwidth ratio of 2.

Manual operation: See "Minimum Noise/System Bandwidth Ratio" on page 145

[:SOURce<hw>]:AWGN:CNRatio <CnRatio>

In Additive Noise and CW Interferer (SOUR:AWGN:MODE ADD|CW) mode, sets the car-
rier/interferer ratio. The value range depends on the selected AWGN mode.

Parameters:
<CnRatio> float

Range: -50  to  40
Increment: 0.01
*RST: 0
Default unit: dB

Example: AWGN:CNR 10
sets a carrier/noise ratio of 10 dB.

Manual operation: See "Carrier/Noise Ratio / Signal/Noise Ratio" on page 147

[:SOURce<hw>]:AWGN:DISP:MODE <Mode>

Selects the display mode to Bseband or RF.

Parameters:
<Mode> RF | BB

*RST: RF

Example: AWGN:DISP:MODE RF
Sets the display mode to RF

Manual operation: See "Display Mode" on page 146

[:SOURce<hw>]:AWGN:DISP:ORESults <OResults>

(requires option R&S SGT-K18, Digital Baseband Connectivity)

In additive Noise and Noise Only (SOUR:AWGN:MODE ADD|ONLY) modes and for Dis-
play Mode set to Baseband (AWGN:DISP:MODE BB), selects the display of output
results for the analog (DACIF) or the digital (BBOUT) signal path.

Parameters:
<OResults> ANALog | DIGital

*RST: ANALog

Example: SOURce:AWGN:MODE ONLY
activates the generation of a pure noise for path A.
SOURce:AWGN:DISP:MODE BB
sets the display mode
SOURce:AWGN:DISP:ORESults DIGital
displays the output results of the digital signal of path A.
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[:SOURce<hw>]:AWGN:ENRatio <EnRatio>

In Additive Noise mode, sets the ratio of bit energy to noise power density.

For Digital Standard signals, the bit rate used for calculation of Eb/N0 value from C/N
value is defined with command SOUR:AWGN:BRAT.
Parameters:
<EnRatio> float

Range: -50  to  depends on hardware
Increment: 0.01
*RST: 15.84
Default unit: dB

Example: AWGN:ENR 10
sets a ratio of bit energy to noise power density of 10 dB

Manual operation: See "Eb/N0" on page 148

[:SOURce<hw>]:AWGN:FREQuency:RESult?

In CW inerferer mode, queries the actual frequency of the sine.

The actual frequency may differ from the desired frequency, since the resolution is limi-
ted to 0.7 Hz.

Return values: 
<Result> float

Range: -40E6  to  40E6
Increment: 0.01
*RST: 0

Example: AWGN:FREQ:RES?
queries the actual frequency of the interfering sine

Usage: Query only

Manual operation: See "Resulting CW Frequency Offset" on page 145

[:SOURce<hw>]:AWGN:FREQuency:TARGet <Target>

Sets the desired frequency of the sine in AWGN:MODE CW mode.

The resulting frequency may differ from the desired frequency because of the limited
frequency resolution of 0.7 Hz.

Parameters:
<Target> float

Range: -40E6  to  40E6
Increment: 0.01
*RST: 0

Example: AWGN:FREQ:TARG 2kHz
sets a frequency of 2 kHz for the interfering sine.
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Manual operation: See "Target CW Frequency Offset" on page 145

[:SOURce<hw>]:AWGN:MODE <Mode>

Selects the mode for generating the interfering signal.

Parameters:
<Mode> ONLY | ADD | CW

ADD
The AWGN noise signal is added to the baseband signal.
ONLY
The pure AWGN noise signal is modulated to the carrier. The
connection to the baseband is interrupted.
CW
The sine interfering signal is added to the baseband signal.
*RST: ADD

Example: SOURce:AWGN:MODE ONLY
SOURce:AWGN:STATe ON
selects the generation of a pure noise and activates it

Manual operation: See "Mode" on page 144

[:SOURce<hw>]:AWGN:POWer:CARRier <Carrier>

available for Additive Noise and CW Interferer (SOUR:AWGN:MODE ADD|CW) modes

Sets/queries the carrier or signal power depending on the selected reference mode.
● SOUR:AWGN:POW:RMOD CARR

Sets the carrier power. The power of the noise signal is derived from the entered
C/N value.

● SOUR:AWGN:POW:RMOD NOIS
queries the carrier power which is derived from the entered C/N value. The noise
power is set with command SOUR:AWGN:POW:NOISe.

Parameters:
<Carrier> float

Increment: 0.01
*RST: 0
Default unit: dBm

Example: AWGN:POW:CARR?
queries the carrier power

Manual operation: See "Carrier Power / Signal Power" on page 148
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[:SOURce<hw>]:AWGN:POWer:MODE <Mode>

In Additive Noise (SOUR:AWGN:MODE ADD) mode, selects the mode for setting the
noise power.

Parameters:
<Mode> CN | SN | EN

CN|SN
The noise power is set on the basis of the value entered for the
carrier/noise or signal/noise ratio
(SOURce:AWGN:CNRatio|SNRatio).
EN
The noise power is set on the basis of the value entered for the
ratio of bit energy to noise power density (AWGN:ENR).
*RST: CN

Example: SOUR:AWGN:POW:MODE CN
the noise power is set on the basis of the value entered for the
carrier/noise ratio (AWGN:CNR).

Manual operation: See "Set Noise Power Via" on page 147

[:SOURce<hw>]:AWGN:POWer:NOISe <Noise>

Sets or queries the noise power in the system bandwidth depending on the selected
mode:
● SOUR:AWGN:MODE ADD|CW
● "Noise Only" mode

The command sets the noise power.

Parameters:
<Noise> float

Increment: 0.01
Default unit: dBm

Example: SOURce:AWGN:POWer:NOISe?
queries the noise power in the system bandwidth.
Response: 10
the noise power in the system bandwidth is 10 dBm.

Manual operation: See "Noise Power (System Bandwidth) / Interferer Power"
on page 148

[:SOURce<hw>]:AWGN:POWer:NOISe:TOTal?

In Additive Noise and CW Interferer (SOUR:AWGN:MODE ADD|CW) modes, queries the
noise power in the total bandwidth.

Tip: Use the command [:SOURce<hw>]:AWGN:DISP:ORESults to define the ana-
log or digital signal path before.
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Return values: 
<Total> float

Range: -145  to  20
Increment: 0.01
*RST: -30

Example: SOURce:AWGN:POWer:NOISe:TOTal?
queries the noise power in the total bandwidth.
Response: 15
the noise power in the total bandwidth is 15 dBm.

Usage: Query only

Manual operation: See "Noise Power (Total Bandwidth)" on page 149

[:SOURce<hw>]:AWGN:POWer:RMODe <RMode>

In Additive Noise and CW Interferer (SOUR:AWGN:MODE ADD|CW) modes and Display
Mode set to RF (AWGN:DISP:MODE RF), selects the mode for setting the interfering
signal.

Parameters:
<RMode> CARRier | NOISe

CARRier
The carrier power is kept constant when the C/N value or Eb/N0
value is changed. The noise power is adjusted.
NOISe
The noise power is kept constant when the C/N value or Eb/N0
value is changed. The carrier power is adjusted.
*RST: CARRier

Example: SOURce:AWGN:MODE ADD
selects Additive Noise mode.
SOURce:AWGN:DISP:MODE RF
sets the display mode to RF
SOURce:AWGN:POWer:RMODe NOISe
selects Reference Mode Noise. The noise power is kept con-
stant when the C/N value or Eb/N0 value is changed. The carrier
power is adjusted.

Manual operation: See "Reference Mode" on page 147

[:SOURce<hw>]:AWGN:POWer:SUM?

In Additive Noise and CW Interferer (SOUR:AWGN:MODE ADD|CW) modes, queries the
overall power of the noise signal plus useful signal.
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Return values: 
<Sum> float

Range: -145  to  20
Increment: 0.01
*RST: 0

Example: SOURce:AWGN:POWer:SUM?
queries the overall power of the noise signal plus useful signal.

Usage: Query only

Manual operation: See "Carrier + Noise Power / Signal + Noise Power (System
Bandwidth) / Carrier + Interferer Power / Signal + Interferer
Power" on page 150

[:SOURce<hw>]:AWGN:POWer:SUM:PEP?

In Additive Noise and CW Interferer (SOUR:AWGN:MODE ADD|CW) modes, queries the
peak envelope power of the overall signal comprised of noise signal plus useful signal.

Return values: 
<Pep> float

Range: -145  to  20
Increment: 0.01
*RST: 0

Example: SOURce:AWGN:POWer:SUM:PEP?
queries the peak envelope power of the overall signal.

Usage: Query only

Manual operation: See "Carrier + Noise PEP / Signal + Noise PEP (Total Band-
width) / Carrier + Interferer PEP / Signal + Interferer PEP"
on page 150

[:SOURce<hw>]:AWGN:STATe <State>

Activates or deactivates the white noise (AWGN = Averaged White Gaussian Noise).

Use the command [:SOURce<hw>]:AWGN:MODE to define the mode the AWGN gen-
erator is working in.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: SOURce:AWGN:STATe ON
Manual operation: See "State" on page 144
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10.14.3  SOURce:BB subsystem general commands

The following section describes the commands for setting the frequency shift and the
phase offset for the signal at the "Baseband" block output.

[:SOURce]:BB:FOFFset..................................................................................................400
[:SOURce]:BB:POFFset..................................................................................................400
[:SOURce<hw>]:BB:PGAin............................................................................................. 400
[:SOURce]:BB:INFO:PSEQuencer?................................................................................. 400

[:SOURce]:BB:FOFFset <Foffset>

Sets the frequency offset for the baseband signal. The offset affects the signal on the
baseband block output. It shifts the useful baseband signal in the center frequency.

Parameters:
<Foffset> float

Example: BB:FOFF 2MHZ
sets a frequency offset of 2 MHz.

Manual operation: See "Frequency Offset" on page 135

[:SOURce]:BB:POFFset <Phoffset>

Sets the relative phase offset of the baseband signal.

The phase offset affects the signal of the "Baseband Block" output.

Parameters:
<Phoffset> float

Example: BB:POFF 0.5DEG
sets a relative phase offset of 0.5 DEG for the baseband signal

Manual operation: See "Phase Offset" on page 135

[:SOURce<hw>]:BB:PGAin <PGain>

The command sets the relative path gain for the selected baseband signal compared
to the baseband signals of the other baseband sources (external baseband). The gain
affects the signal on the "baseband block" output.

Parameters:
<PGain> float

Range: -50  to  50
Increment: 1E-3
*RST: 0

[:SOURce]:BB:INFO:PSEQuencer?

Returns the baseband pulse sequencer information.
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Return values: 
<InfoXmlString> string

Usage: Query only

10.14.4  SOURce:BB:ARB subsystem

The ARB subsystem contains the commands for setting the ARB Generator. Settings
for clock and trigger interfaces and for external outputs are entered in the
SOURce:INPut and SOURce:OUTput subsystems.

For option R&S SGT-K540, envelope tracking, the ARB for envelope tracking can be
enabled when :SCONfiguration:MODE is set to AFETracking. Then the numeric
suffix to SOURce distinguishes between signal generation for "Baseband 1" and the
second ARB generated for the envelope tracking, "Baseband 2":

● SOURce[1] = Baseband 1
The keyword SOURce is optional and can be omitted

● SOURce2 = Baseband 2
The keyword SOURce is mandatory, i.e. the command must contain the keyword
with suffix 2.

The ARB waveform for the envelope tracking (SOURce2) uses the same trigger, marker
and clock settings as the first ARB waveform (SOURce1). Therefore those commands
are not defined for SOURce2.

● Common commands.............................................................................................401
● Clock commands...................................................................................................402
● Trigger commands................................................................................................ 405
● Marker commands................................................................................................ 412
● Test signal commands...........................................................................................415
● SOURce:BB:ARB:MCAR subsystem....................................................................418
● SOURce:BB:ARB:WAV subsystem.......................................................................433
● SOURce:BB:ARB:WSEG subsystem....................................................................438

10.14.4.1  Common commands

[:SOURce<hw>]:BB:ARBitrary:PRESet............................................................................ 401
[:SOURce<hw>]:BB:ARBitrary:STATe...............................................................................402
[:SOURce<hw>]:BB:ARBitrary:PRAMp[:STATe].................................................................402

[:SOURce<hw>]:BB:ARBitrary:PRESet

Sets all ARB generator parameters to their default values.

Example: SOURce1:BB:ARB:PRESet
Usage: Event

Manual operation: See "Set To Default" on page 91
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[:SOURce<hw>]:BB:ARBitrary:STATe <State>

Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.

You have to selecta an waveform first.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: SOURce1:BB:ARBitrary:WAV:SELect 'wave1'
loads waveform file from the default directory.
SOURce1:BB:ARBitrary:TRIGger:SEQ RETR
sets trigger mode Retrigger.
SOURce1:BB:ARBitrary:STATe ON
switches on the ARB generator. The selected waveform is out-
put straight away. A trigger event causes restart.

Manual operation: See "State" on page 90

[:SOURce<hw>]:BB:ARBitrary:PRAMp[:STATe] <ArbPramState>

If activated, the burst gate marker signal included in the ARB waveform file is used as
marker signal for the pulse modulator.

Parameters:
<ArbPramState> 0 | 1 | OFF | ON

*RST: 0

Example: SOURce1:BB:ARBitrary:WAVeform:SELect "/var/user/Pulse_PMod_Burst"
SOURce1:BB:ARBitrary:PRAMp:STATe 1
SOURce1:BB:ARBitrary:STATe 1

Options: R&S SGT-K22

10.14.4.2  Clock commands

The CLOCk subsystem contains the commands for setting the clock.

For option R&S SGT-K540, the ARB waveform for the envelope tracking (SOURce2)
uses the same clock settings as the first ARB waveform (SOURce1). Therefore these
commands are not defined for SOURce2.

[:SOURce<hw>]:BB:ARBitrary:CLOCk............................................................................. 403
[:SOURce<hw>]:BB:ARBitrary:CLOCk:MODE...................................................................403
[:SOURce<hw>]:BB:ARBitrary:CLOCk:MULTiplier............................................................. 403
[:SOURce<hw>]:BB:ARBitrary:CLOCk:SOURce................................................................404
[:SOURce<hw>]:BB:ARBitrary:CLOCk:SYNChronization:MODE......................................... 404
[:SOURce<hw>]:BB:ARBitrary:CLOCk:SYNChronization:EXECute..................................... 405
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[:SOURce<hw>]:BB:ARBitrary:CLOCk <Clock>

The command sets the clock rate in samples. Loading a waveform waveform
(ARB:WAV:SEL <name>) sets the clock rate that is defined in the waveform tag 'clock'.
The command subsequently changes the clock rate; see data sheet for value range.

In the case of an external clock source (selection ARB:CLOCk:SOURce EXTernal)
the clock for the external source must be entered with this command.

Parameters:
<Clock> float

Increment: 0.001
*RST: 1E6

Example: BB:ARB:CLOC:SOUR INT
selects the internal clock source for generating waveforms.
BB:ARB:CLOC 0.5 MHz
sets the clock rate to 0.5 MHz.

Manual operation: See "Clock Frequency" on page 92

[:SOURce<hw>]:BB:ARBitrary:CLOCk:MODE <Mode>

The command enters the type of externally supplied clock (:BB:ARB:CLOCk:SOURce
EXTernal). When MSAMple is used, a multiple of the sample clock is supplied via the
CLOCK connector and the sample clock is derived internally from this. The multiplier is
entered with the command :BB:ARB:CLOCk:MULTiplier.

Parameters:
<Mode> SAMPle | MSAMple

*RST: SAMPle

Example: BB:ARB:CLOC:MODE SAMP
selects clock type "Sample", i.e. the supplied clock is a sample
clock.

Manual operation: See "Clock Mode" on page 134

[:SOURce<hw>]:BB:ARBitrary:CLOCk:MULTiplier <Multiplier>

The command specifies the multiplier for clock type "Multiple Samples"
(:BB:ARB:CLOCk:MODE MSAM) in the case of an external clock source.

Parameters:
<Multiplier> integer

Range: 1  to  64
*RST: 4
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Example: BB:ARB:CLOC:SOUR EXT
selects the external clock source. The clock is supplied via the
CLOCK connector.
BB:ARB:CLOC:MODE MSAM
selects clock type Multiple Samples, i.e. the supplied clock has a
rate which is a multiple of the sample rate.
BB:ARB:CLOC:MULT 12
The multiplier for the external clock rate is 12.

Manual operation: See "Sample Clock Multiplier" on page 134

[:SOURce<hw>]:BB:ARBitrary:CLOCk:SOURce <Source>

Sets the source for the digital modulation clock.

Parameters:
<Source> INTernal|EXTernal

INTernal
The internal clock reference is used.
EXTernal
The external clock reference is supplied to the connector.
*RST: INTernal

Example: BB:ARB:CLOC:SOUR EXT
Selects an external clock reference. The clock is supplied via the
connector.
BB:ARB:CLOC:MODE SAMP
Enters clock type sample.

Manual operation: See "Clock Source" on page 134

[:SOURce<hw>]:BB:ARBitrary:CLOCk:SYNChronization:MODE <Mode>

Selects the synchronization mode.

This parameter is used to enable generation of very precise synchronous signal of sev-
eral connected R&S SGT.

Note: If several instruments are connected, the connecting cables from the primary
instrument to the secondary instrument one and between each two consecutive secon-
dary instruments must have the same length and type. Avoid unnecessary cable length
and branching points.

Parameters:
<Mode> NONE | PRIMary | SECondary | DIIN

NONE
The instrument is working in stand-alone mode.
PRIMary
The instrument provides all connected instrument with its syn-
chronisation (including the trigger signal) and reference clock
signal.

SOURce subsystem



Remote control commandsR&S®SGT100A

405User Manual 1176.8674.02 ─ 12

SECondary
The instrument receives the synchronisation and reference clock
signal from another instrument working in primary mode.
DIIN
The instrument receives the synchronisation and reference clock
signal from the "DIG I/Q" connector.
*RST: NONE

Manual operation: See "Sync Mode" on page 133

[:SOURce<hw>]:BB:ARBitrary:CLOCk:SYNChronization:EXECute

Performs automatically adjustment of the instrument's settings required for the syn-
chronization mode, set with the command [:SOURce<hw>]:BB:ARBitrary:CLOCk:
SYNChronization:MODE.

Example: BB:ARB:CLOC:SYNC:MODE PRIM
the instrument is configured to work as a primary instrument.
BB:ARB:CLOC:SYNC:EXEC
all synchronization's settings are adjusted accordingly.

Usage: Event

10.14.4.3  Trigger commands

The TRIGger subsystem contains the commands for setting the trigger.

For option R&S SGT-K540, the ARB waveform for the envelope tracking (SOURce2)
uses the same trigger settings as the first ARB waveform (SOURce1). Therefore these
commands are not defined for SOURce2.

[:SOURce<hw>]:BB:ARBitrary:TRIGger:ARM:EXECute..................................................... 406
[:SOURce<hw>]:BB:ARBitrary:TRIGger:EXECute............................................................. 406
[:SOURce<hw>]:BB:ARBitrary:TRIGger[:EXTernal]:SYNChronize:OUTPut...........................406
[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:DELay:MAXimum?........................... 407
[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:DELay:MINimum?.............................407
[:SOURce<hw>]:BB:ARBitrary:TRIGger:RMODe?............................................................. 407
[:SOURce<hw>]:BB:ARBitrary:TRIGger:SLENgth..............................................................408
[:SOURce<hw>]:BB:ARBitrary:TRIGger:SLUNit................................................................ 408
[:SOURce<hw>]:BB:ARBitrary:TRIGger:SMODe............................................................... 409
[:SOURce<hw>]:BB:ARBitrary:TRIGger:SOURce..............................................................409
[:SOURce<hw>]:BB:ARBitrary:TRIGger:DELay:UNIT........................................................ 409
[:SOURce<hw>]:BB:ARBitrary:TRIGger[:EXTernal<1|2>]:DELay.........................................410
[:SOURce<hw>]:BB:ARBitrary:TRIGger[:EXTernal<1|2>]:TDELay.......................................410
[:SOURce<hw>]:BB:ARBitrary:TRIGger[:EXTernal<1|2>]:RDELay?.....................................410
[:SOURce<hw>]:BB:ARBitrary:TRIGger[:EXTernal<1|2>]:INHibit......................................... 411
[:SOURce<hw>]:BB:ARBitrary[:TRIGger]:SEQuence......................................................... 411
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[:SOURce<hw>]:BB:ARBitrary:TRIGger:ARM:EXECute

The command stops waveform output for trigger modes Armed_Auto and Armed_Ret-
rigger. A subsequent internal or external trigger event restart waveform output.

Example: BB:ARB:TRIG:SOUR INT
sets internal triggering.
BB:ARB:TRIG:SEQ ARET
sets Armed_Retrigger mode, i.e. every trigger event causes
waveform output to restart.
BB:ARB:TRIG:EXEC
executes a trigger, waveform output is started.
BB:ARB:TRIG:ARM:EXEC
waveform output is stopped.
BB:ARB:TRIG:EXEC
executes a trigger, waveform output is started again.

Usage: Event

Manual operation: See "Arm" on page 123

[:SOURce<hw>]:BB:ARBitrary:TRIGger:EXECute

The command executes a trigger. The internal trigger source must be selected using
the command ARB:TRIGger:SOURce INTernal and a trigger mode other than
AUTO must be selected using the command :ARB:SEQuence.

Example: BB:ARB:TRIG:SOUR INT
sets internal triggering.
BB:ARB:SEQ RETR
sets Retrigger mode, i.e. every trigger event causes signal out-
put to restart.
BB:ARB:TRIG:EXEC
executes a trigger.

Usage: Event

Manual operation: See "Execute Trigger" on page 123

[:SOURce<hw>]:BB:ARBitrary:TRIGger[:EXTernal]:SYNChronize:OUTPut
<Output>

(enabled for "Trigger Source" External)

Enables/disables output of the signal synchronous to the external trigger event.

Parameters:
<Output> 0 | 1 | OFF | ON

SOURce subsystem



Remote control commandsR&S®SGT100A

407User Manual 1176.8674.02 ─ 12

ON
The signal calculation starts simultaneously with the external
trigger event but because of the instrument’s processing time
the first samples are cut off and no signal is outputted. After
elapsing of the internal processing time, the output signal is syn-
chronous to the trigger event.
OFF
The signal output begins after elapsing of the processing time
and starts with sample 0, i.e. the complete signal is outputted.
This mode is recommended for triggering of short signal sequen-
ces with signal duration comparable with the processing time of
the instrument.
*RST: ON

Example: BB:ARB:TRIG:SOUR EXT
sets external triggering.
BB:ARB:TRIG:EXT:SYNC:OUTP ON
enables synchronous output to external trigger

Manual operation: See "Sync. Output to External Trigger" on page 123

[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:DELay:MAXimum?
[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:DELay:MINimum?
The command queries the minimum marker delay for set-
ting :BB:ARB:TRIGger:OUTPut:DELay:FIXed ON.

Return values: 
<Minimum> float

Range: 0  to  16777215
Increment: 1E-3
*RST: 0

Example: BB:ARB:TRIG:OUTP:DEL:FIX ON
restricts the marker signal delay setting range to the dynamic
range.
BB:ARB:TRIG:OUTP:DEL:MIN
queries the minimum of the dynamic range.
Response: 0
the minimum for the marker delay setting is 0 samples.

Usage: Query only

Manual operation: See "Current Range without Recalculation" on page 132

[:SOURce<hw>]:BB:ARBitrary:TRIGger:RMODe?

The command queries the status of waveform output or all trigger modes with ARB on.

Return values: 
<RMode> STOP | RUN

SOURce subsystem



Remote control commandsR&S®SGT100A

408User Manual 1176.8674.02 ─ 12

RUN
The waveform is output. A trigger event occurred in the triggered
mode.
STOP
The waveform is not output. A trigger event did not occur in the
triggered modes, or waveform output was stopped by the com-
mand :BB:ARB:TRIG:ARM:EXECute (armed trigger modes
only).

Example: BB:ARB:TRIG:SOUR EXT
sets external triggering
BB:ARB:TRIG:MODE ARET
selects the Armed_Retrigger mode.
BB:ARB:TRIG:RMOD?
queries the current status of waveform output.
Response: RUN
the waveform is output, an external trigger was executed.

Usage: Query only

Manual operation: See "Running/Stopped" on page 122

[:SOURce<hw>]:BB:ARBitrary:TRIGger:SLENgth <SLength>

The command defines the length of the signal sequence to be output in the Single trig-
ger mode. The unit is defined with command SOUR:BB:ARB:TRIG:SLUNit. It is pos-
sible to output deliberately just part of the waveform, an exact sequence of the wave-
form, or a defined number of repetitions of the waveform.

Parameters:
<SLength> integer

Range: 1  to  dynamic
*RST: 1
Default unit: sample

Example: BB:ARB:SEQ SING
sets trigger mode Single.
BB:ARB:TRIG:SLUN SAMP
sets unit Samples for the entry of sequence length.
BB:ARB:TRIG:SLEN 200
sets a sequence length of 200 samples. The first 200 samples of
the current waveform will be output after the next trigger event.

Manual operation: See "Signal Duration" on page 122

[:SOURce<hw>]:BB:ARBitrary:TRIGger:SLUNit <SLUnit>

The command defines the unit for the entry of the length of the signal sequence
(SOUR:BB:ARB:TRIG:SLEN) to be output in the "Single" trigger mode
(SOUR:BB:ARB:SEQ SING).
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Parameters:
<SLUnit> SEQuence | SAMPle

*RST: SEQuence

Example: BB:ARB:SEQ SING
sets trigger mode Single.
BB:ARB:TRIG:SLUN SEQ
sets unit Sequence length for the entry of sequence length.
BB:ARB:TRIG:SLEN 2
sets a sequence length of 2 waveforms. The current waveforms
will be output twice after the next trigger event.

Manual operation: See "Signal Duration Unit" on page 122

[:SOURce<hw>]:BB:ARBitrary:TRIGger:SMODe <SMode>

The command selects the extended trigger mode for multi segment waveforms.

Parameters:
<SMode> SAME | NEXT | NSEam | SEQuencer

NSEam = Next Segment Seamless
*RST: NEXT

Example: SOUR:BB:ARB:SEQ AUTO
selects trigger mode AUTO.
SOUR:BB:ARB:TRIG:SMOD SAME
the same segment of the waveform is output repeatedly.

Manual operation: See "Next Segment Mode" on page 126

[:SOURce<hw>]:BB:ARBitrary:TRIGger:SOURce <Source>

Selects the trigger source.

Parameters:
<Source> INTernal|EXTernal

INTernal
manual trigger or *TRG.
EXTernal
trigger signal on the USER 1/2 connector.
*RST: INTernal

Example: SOURce1:BB:ARBitrary:TRIGger:SOURce EXTernal
sets external triggering via the USER 1 connector.

Manual operation: See "Trigger Source" on page 123

[:SOURce<hw>]:BB:ARBitrary:TRIGger:DELay:UNIT <TrigDelUnit>

Determines the units the trigger delay is expressed in.
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Parameters:
<TrigDelUnit> SAMPle | TIME

*RST: SAMPle

Manual operation: See "External Delay Unit" on page 124

[:SOURce<hw>]:BB:ARBitrary:TRIGger[:EXTernal<1|2>]:DELay <Delay>

The command specifies the trigger delay (expressed as a number of samples) for
external triggering.

Parameters:
<Delay> float

Range: 0  to  depends on other values
Increment: 0.01
*RST: 0
Default unit: sample

Example: BB:ARB:TRIG:SOUR EXT
selects an external trigger
BB:ARB:TRIG:DEL 200
sets a delay of 200 samples for the trigger.

Manual operation: See "Trigger Delay" on page 124

[:SOURce<hw>]:BB:ARBitrary:TRIGger[:EXTernal<1|2>]:TDELay <ExtTimeDelay>

Specifies the trigger delay for external triggering. The value affects all external trigger
signals.

Parameters:
<ExtTimeDelay> float

Range: 0  to  688
Increment: 1E-9
*RST: 0
Default unit: s

Manual operation: See "Trigger Delay" on page 124

[:SOURce<hw>]:BB:ARBitrary:TRIGger[:EXTernal<1|2>]:RDELay?

Queries the time (in seconds) an external trigger event is delayed for.

Return values: 
<ResTimeDelaySec> float

Range: 0  to  688
Increment: 0.25E-9
*RST: 0

Usage: Query only

Manual operation: See "Actual Trigger Delay" on page 124
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[:SOURce<hw>]:BB:ARBitrary:TRIGger[:EXTernal<1|2>]:INHibit <Inhibit>

Specifies the number of samples by which a restart is to be inhibited following a trigger
event. This command applies only in the case of external triggering.

Parameters:
<Inhibit> integer

Range: 0  to  67108863
*RST: 0
Default unit: sample

Example: BB:ARB:TRIG:SOUR EXT
selects an external trigger
BB:ARB:TRIG:INH 200
sets a restart inhibit for 200 samples following a trigger event.

Manual operation: See "Trigger Inhibit" on page 124

[:SOURce<hw>]:BB:ARBitrary[:TRIGger]:SEQuence <Sequence>

The command selects the trigger mode.

Parameters:
<Sequence> AUTO | RETRigger | AAUTo | ARETrigger | SINGle

AUTO
The waveform is output continuously.
RETRigger
The waveform is output continuously. A trigger event (internal or
external) causes a restart.
AAUTo
The waveform is output only when a trigger event occurs. After
the trigger event the waveform is output continuously. Waveform
output is stopped with command
SOUR:BB:ARB:TRIG:ARM:EXEC and started again when a trig-
ger event occurs.
ARETrigger
The waveform is output only when a trigger event occurs. The
device automatically toggles to RETRIG mode. Every subse-
quent trigger event causes a restart. Waveform output is stop-
ped with command SOUR:BB:ARB:TRIG:ARM:EXEC and star-
ted again when a trigger event occurs.
SINGle
The waveform is output only when a trigger event occurs. After
the trigger event the waveform is output once to the set
sequence length (SOUR:BB:ARB:TRIG:SLEN). Every subse-
quent trigger event causes a restart.
*RST: AUTO
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Example: BB:ARB:SEQ AAUT
sets the "Armed_auto" trigger mode; the device waits for the first
trigger (e.g. with *TRG) and then generates the signal continu-
ously.

Manual operation: See "Trigger Mode" on page 121

10.14.4.4  Marker commands

The TRIGger:OUTPut subsystem contains the commands for setting the marker.

For option R&S SGT-K540, the ARB waveform for the envelope tracking (SOURce2)
uses the same marker settings as the first ARB waveform (SOURce1). Therefore these
commands are not defined for SOURce2.

[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:MODE............................................. 412
[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:OFFTime......................................... 413
[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:ONTime...........................................413
[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:PATTern...........................................413
[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:PULSe:DIVider.................................413
[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:PULSe:FREQuency?........................ 414
[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut:DELay:FIXed...........................................414
[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:DELay............................................. 415

[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:MODE <Mode>

The command defines the signal for the selected marker output.

Parameters:
<Mode> UNCHanged | RESTart | PULSe | PATTern | RATio

UNCHanged
A marker signal as defined in the waveform file (tag 'marker
mode x') is generated.
RESTart
A marker signal is generated at every waveform start.
PULSe
A pulsed marker signal is generated. The pulse frequency (=
sample rate/divider) is defined with the
SOUR:BB:ARB:TRIG:OUTP:PULS:DIV command and can be
queried with the SOUR:BB:ARB:TRIG:OUTP:PULS:FREQ?
command.
PATTern
A marker signal is generated with the aid of a user-definable bit
pattern. The bit pattern is entered with the aid of com-
mand :BB:ARB:TRIGger:OUTPut:PATTern. The bit pattern
is a maximum of 32 bits long.
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RATio
A regular marker signal corresponding to the Time Off / Time On
specifications in the com-
mands :ARB:TRIGger:OUTPut:OFFTime
and :ARB:TRIGger:OUTPut:ONTime is generated.
*RST: UNCHanged

Manual operation: See "Marker Mode" on page 131

[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:OFFTime <OffTime>
[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:ONTime <OnTime>
The command sets the number of samples in a period (ON time + OFF time) during
which the marker signal in setting :ARB:TRIGger:OUTPut:MODE RATio on the
marker outputs is ON.

Parameters:
<OnTime> integer

Range: 1  to  14913079
*RST: 1

Example: BB:ARB:TRIG:OUTP2:ONT 20
sets an ON time of 20 samples for marker 2

Manual operation: See "Marker Mode" on page 131

[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:PATTern <Pattern>,
<BitCount>

The command defines the bit pattern used to generate the marker signal.

Parameters:
<Pattern> numeric

0 is marker off, 1 is marker on.
*RST: #H2

<BitCount> integer
Range: 1  to  64
*RST: 2

Example: BB:ARB:TRIG:OUTP:MODE PATT
BB:ARB:TRIG:OUTP:PATT #H39FE0000,32

Manual operation: See "Marker Mode" on page 131

[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:PULSe:DIVider <Divider>

The command sets the divider for the pulsed marker signal in the setting
SOURce:BB:ARB:TRIGger:OUTPut:MODE PULSe. The pulse frequency is derived
by dividing the symbol rate by the divider.
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Parameters:
<Divider> integer

Range: 2  to  1024
*RST: 2

Manual operation: See "Marker Mode" on page 131

[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:PULSe:FREQuency?

The command queries the pulse frequency of the pulsed marker signal in the setting
SOURce:BB:ARB:TRIGger:OUTPut:MODE PULSe. The pulse frequency is derived
by dividing the symbol rate by the divider. The divider is defined with com-
mand :BB:ARB:TRIG:OUTP:PULS:DIV.

Return values: 
<Frequency> float

Increment: 0.001

Example: BB:ARB:TRIG:OUTP2:PULS:DIV 4
sets the divider for the marker signal on the output to the value
4.
BB:ARB:TRIG:OUTP2:MODE PULS
enables the pulsed marker signal.
BB:ARB:TRIG:OUTP2:PULS:FREQ?
queries the pulse frequency of the marker signal.
Response: 33 000
the resulting pulse frequency is 33 kHz.

Usage: Query only

Manual operation: See "Marker Mode" on page 131

[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut:DELay:FIXed <Fixed>

The command restricts the marker delay setting range to the dynamic range. In this
range the delay can be set without restarting the marker and signal. If a delay is
entered in setting ON but is outside this range, the maximum possible delay is set and
an error message is output.

The setting always affects every marker.

Parameters:
<Fixed> 0 | 1 | OFF | ON

*RST: 0

Example: BB:ARB:TRIG:OUTP:DEL:FIX ON
restricts the marker signal delay setting range to the dynamic
range.

Manual operation: See "Fix marker delay to current range" on page 133
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[:SOURce<hw>]:BB:ARBitrary:TRIGger:OUTPut<ch>:DELay <Delay>

Sets the delay between the signal on the marker outputs and the start of the signals.

Parameters:
<Delay> integer

Range: 0  to  depends on other values
Increment: 0.001
*RST: 0
Default unit: Samples

Manual operation: See "Marker x Delay" on page 132

10.14.4.5  Test signal commands

[:SOURce<hw>]:BB:ARBitrary:SIGNal:TYPE.................................................................... 415
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:CIQ:CREate......................................................... 415
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:RECTangle:CREate...............................................415
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:SINE:CREate....................................................... 415
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:CIQ:CREate:NAMed............................................. 416
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:RECTangle:CREate:NAMed...................................416
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:SINE:CREate:NAMed............................................416
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:CIQ:I....................................................................416
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:CIQ:Q.................................................................. 416
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:RECTangle:AMPLitude.......................................... 416
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:RECTangle:FREQuency........................................ 417
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:RECTangle:OFFSet...............................................417
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:RECTangle:SAMPles.............................................417
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:SINE:FREQuency................................................. 417
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:SINE:PHASe........................................................ 418
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:SINE:SAMPles..................................................... 418

[:SOURce<hw>]:BB:ARBitrary:SIGNal:TYPE <ArbSignalType>

Selects the type of test signal.

Parameters:
<ArbSignalType> SINE | RECT | CIQ

*RST: SINE

Example: SORce1:BB:ARBitrary:SIGNal:TYPE SINE

[:SOURce<hw>]:BB:ARBitrary:TSIGnal:CIQ:CREate
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:RECTangle:CREate
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:SINE:CREate
Generates a signal and uses it as output straight away.

Example: BB:ARB:TSIG:SINE:CRE
generates a test sine signal and uses it as output straight away.

Usage: Event
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Manual operation: See "Generate Signal RAM" on page 118

[:SOURce<hw>]:BB:ARBitrary:TSIGnal:CIQ:CREate:NAMed <Filename>
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:RECTangle:CREate:NAMed <Filename>
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:SINE:CREate:NAMed <Filename>
Generates a signal and saves it to a waveform file.

Setting parameters: 
<Filename> string

Example: BB:ARB:TSIG:SINE:CRE:NAM 'sine_test'
generates a test sine signal and saves it into the wavefile
sine_test.

Usage: Setting only

Manual operation: See "Generate Signal File" on page 118

[:SOURce<hw>]:BB:ARBitrary:TSIGnal:CIQ:I <I>
[:SOURce<hw>]:BB:ARBitrary:TSIGnal:CIQ:Q <TSig>
Sets the value for the I/Q component of the test signal

Parameters:
<TSig> float

Range: -1  to  1
Increment: 0.001
*RST: 0
Default unit: FS

Example: BB:ARB:TSIG:CIQ:Q 0.5
sets the value for the Q component of the test signal.

Manual operation: See "Q Value" on page 120

[:SOURce<hw>]:BB:ARBitrary:TSIGnal:RECTangle:AMPLitude <Amplitude>

Sets the digital amplitude of the rectangular wave.

Parameters:
<Amplitude> float

Range: 0  to  1
Increment: 0.001
*RST: 0.800
Default unit: FS

Example: BB:ARB:TSIG:RECT:AMPL 0.5
sets the amplitude of the test signal

Manual operation: See "Amplitude" on page 119
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[:SOURce<hw>]:BB:ARBitrary:TSIGnal:RECTangle:FREQuency <Frequency>

Sets the frequency of the test signal.

Parameters:
<Frequency> float

Range: 100  to  depends on hardware
Increment: 0.01
*RST: 1000

Example: SOURce:BB:ARBitrary:TSIGnal:RECTangle:FREQuency
100 kHz
sets the frequency of the test signal of 100 kHz.

Manual operation: See "Frequency" on page 119

[:SOURce<hw>]:BB:ARBitrary:TSIGnal:RECTangle:OFFSet <Offset>

Sets the DC component.

Parameters:
<Offset> float

Range: -1  to  1
Increment: 0.001
*RST: 0
Default unit: FS

Example: BB:ARB:TSIG:RECT:OFFS 0.5
sets the DC component

Manual operation: See "Offset DC" on page 119

[:SOURce<hw>]:BB:ARBitrary:TSIGnal:RECTangle:SAMPles <Samples>

Sets the number of sample values required for the rectangular signal per period.

Parameters:
<Samples> integer

Range: 4  to  1000
*RST: 100

Example: BB:ARB:TSIG:RECT:SAMP 400
sets 400 samples per period

Manual operation: See "Samples per Period" on page 119

[:SOURce<hw>]:BB:ARBitrary:TSIGnal:SINE:FREQuency <Frequency>

Sets the frequency of the simple sinusoidal test signal. This signal is used as output via
the I channel. A sine wave of the same frequency but optionally phase-shifted is gener-
ated on the Q path (ARB:TSIGnal:SINE:POFFset).
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Parameters:
<Frequency> float

Range: 100  to  depends on hardware
Increment: 0.01
*RST: 1000
Default unit: Hz

Example: BB:ARB:TSIG:SINE:FREQ 100 kHz
sets a sine signal of 100 kHz.

Manual operation: See "Frequency" on page 117

[:SOURce<hw>]:BB:ARBitrary:TSIGnal:SINE:PHASe <Phase>

The command sets the phase offset of the sine wave on the Q channel relative to the
sine wave on the I channel.

Parameters:
<Phase> float

Range: -180  to  180
Increment: 0.01
*RST: 90
Default unit: DEG

Example: BB:ARB:TSIG:SINE:PHAS 90
sets a phase offset of 90 degrees.

Manual operation: See "Phase Offset Q" on page 118

[:SOURce<hw>]:BB:ARBitrary:TSIGnal:SINE:SAMPles <Samples>

The command sets the sample rate for the sine signal in samples per period.

The maximum value is automatically restricted by reference to the set frequency and
has to fulfill the rule Frequency * Samples <= ARB clock rate.

Parameters:
<Samples> integer

Range: 4  to  1000
*RST: 100
Default unit: 100 samples per period

Example: BB:ARB:TSIG:SINE:SAMP 100
sets a sample rate of 100 samples per period.

Manual operation: See "Samples per Period" on page 117

10.14.4.6  SOURce:BB:ARB:MCAR subsystem

The MCARrrier subsystem contains the commands for setting the Multi Carrier Wave-
form Generator.
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CARRier<ch>

The numerical suffix under CARRier distinguish between the carriers. The value range
is 0 .. 31.

[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier:COUNt.................................................419
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier:MODE................................................. 420
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier:SPACing.............................................. 420
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier<ch>:CONFlict?..................................... 421
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier<ch>:DELay.......................................... 421
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier<ch>:FILE............................................. 421
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier<ch>:FREQuency.................................. 422
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier<ch>:PHASe......................................... 422
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier<ch>:POWer......................................... 422
[:SOURce<hw>]:BB:ARBitrary:MCARrier:POWer:REFerence............................................. 423
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier<ch>:STATe...........................................423
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CFACtor:MODE..................................................423
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CLIPping:CFACtor.............................................. 424
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CLIPping:CUToff.................................................424
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CLIPping[:STATe]................................................425
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CLOad...............................................................425
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CLOCk?............................................................ 426
[:SOURce<hw>]:BB:ARBitrary:MCARrier:CREate..............................................................426
[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:DELay:STEP................................ 426
[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:DELay[:STARt]..............................427
[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:EXECute......................................427
[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:FILE............................................ 427
[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:PHASe:STEP............................... 428
[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:PHASe[:STARt].............................428
[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:POWer:STEP............................... 429
[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:POWer[:STARt].............................429
[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:STARt..........................................429
[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:STOP.......................................... 429
[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:STATe.......................................... 430
[:SOURce<hw>]:BB:ARBitrary:MCARrier:OFILe................................................................430
[:SOURce<hw>]:BB:ARBitrary:MCARrier:PRESet............................................................. 430
[:SOURce<hw>]:BB:ARBitrary:MCARrier:SAMPles?..........................................................430
[:SOURce<hw>]:BB:ARBitrary:MCARrier:SETTing:CATalog?..............................................431
[:SOURce<hw>]:BB:ARBitrary:MCARrier:SETTing:LOAD...................................................431
[:SOURce<hw>]:BB:ARBitrary:MCARrier:SETTing:STORe.................................................431
[:SOURce<hw>]:BB:ARBitrary:MCARrier:SETTing:STORe:FAST........................................432
[:SOURce<hw>]:BB:ARBitrary:MCARrier:TIME................................................................. 432
[:SOURce<hw>]:BB:ARBitrary:MCARrier:TIME:MODE...................................................... 432

[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier:COUNt <Count>

Sets the number of carriers in the ARB multi carrier waveform.
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Parameters:
<Count> integer

Range: 1  to  512
*RST: 1

Example: BB:ARB:MCAR:CARR:COUN 10
sets 10 carriers for the multi carrier waveform.

Manual operation: See "Number of Carriers" on page 107

[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier:MODE <Mode>

The command sets the carrier frequency mode.

Parameters:
<Mode> EQUidistant | ARBitrary

EQUidistant
Sets an equidistant carrrier spacing. The carrier frequency in the
carrier table is not configurable.
ARBitrary
Enables you to specify the carrier frequency in the carrier table.
Carrier spacing is irrelevant.
*RST: EQUidistant

Example: BB:ARB:MCAR:CARR:MODE EQU
sets an equidistant carrier spacing. The carrier frequency can
not be set.

Manual operation: See "Mode" on page 107

[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier:SPACing <Spacing>

The command sets the frequency spacing between adjacent carriers of the multi car-
rier waveform. The carriers are generated symmetrically around the RF carrier. The
maximum carrier spacing is limited to Carrier spacing = Total baseband bandwidth /
(Number of carriers - 1).

The total baseband bandwidth is 60, 120 or 160 MHz depending on the installed
options. .

Note:In order to avoid wrap-around problems, the effective "Carrier Spacing" might be
slightly modified. The "Carrier Spacing" is rounded in that way that the carrier closest
to the center RF frequency shows no phase jump assuming that the carrier is unmodu-
lated.
● For odd number of carriers:

RoundedCarrierSpacing=1/OutputSignalDuration* round(CarrierSpacing * Output-
SignalDuration);

● For even number of carriers:
RoundedCarrierSpacing=2/OutputSignalDuration*round(0.5 *CarrierSpacing * Out-
putSignalDuration);
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Parameters:
<Spacing> float

Range: 0.0  to  120E6
Increment: 0.01
*RST: 0
Default unit: Hz

Example: BB:ARB:MCAR:CARR:SPAC 10 MHz
sets a carrier spacing of 10 MHz.

Manual operation: See "Carrier Spacing" on page 107

[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier<ch>:CONFlict?

Queries carrier conflicts. A conflict arises when the carriers overlap.

Return values: 
<Conflict> 0 | 1 | OFF | ON

*RST: 0

Example: BB:ARB:MCAR:CARR2:CONF?
queries the multi carrier conflict state.
Response: 0 no conflict has occurred.

Usage: Query only

Manual operation: See "!!!" on page 115

[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier<ch>:DELay <Delay>

Sets the start delay of the selected carrier.

Parameters:
<Delay> float

Range: 0  to  1
Increment: 1E-9
*RST: 0
Default unit: s

Example: BB:ARB:MCAR:CARR15:DEL 5us
sets a start delay of 50 us for carrier 15.

Manual operation: See "Delay" on page 115

[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier<ch>:FILE <File>

Selects the file with I/Q data to be modulated onto the selected carrier.

Parameters:
<File> <file name>
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Example: BB:ARB:MCAR:CARR15:FILE "/var/user/IQ_wcdma"
selects file IQ_wcdma. The data of the file is modulated onto
carrier 15.

Manual operation: See "File" on page 115

[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier<ch>:FREQuency <Frequency>

Sets or indicates the carrier frequency, depending on the selected carrier frequency
mode.

The carrier frequency can be set in "Arbitrary Carrier frequency" mode. For "Equidis-
tant Carrier Spacing", the carrier spacing is determined automatically.

Parameters:
<Frequency> float

Value range depends on the max bandwidth, see data sheet
Range: -40E6  to  40E6
*RST: 0

Example: BB:ARB:MCAR:CARR:MODE ARB
Activates ARB multi-carrier mode.
BB:ARB:MCAR:CARR:FREQ 5.0
Sets 5.0 MHz carrier frequency.

Manual operation: See "Carrier Freq Offs." on page 115

[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier<ch>:PHASe <Phase>

The command sets the start phase of the selected carrier.

The phase settings are only valid if optimization of the crest factor is disabled
(:SOURce:BB:ARB:MCARrier:CFACtor:MODE OFF).

Parameters:
<Phase> float

Range: 0  to  359.99
Increment: 0.01
*RST: 0
Default unit: DEG

Example: BB:ARB:MCAR:CARR15:PHAS 90 DEG
sets a start phase of 90° for carrier 15.

Manual operation: See "Phase" on page 115

[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier<ch>:POWer <Power>

The command sets the gain of the selected carrier.
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Parameters:
<Power> float

Range: -80  to  0
Increment: 0.01
*RST: 0
Default unit: dB

Example: BB:ARB:MCAR:CARR15:POW -50 dB
sets the power of carrier 15 to -50 dB.

Manual operation: See "Gain" on page 115

[:SOURce<hw>]:BB:ARBitrary:MCARrier:POWer:REFerence <Reference>

Defines the way the individual carriers in a composed multi carrier signal are leveled.

Parameters:
<Reference> RMS | PEAK

*RST: RMS

Manual operation: See "Power Reference" on page 110

[:SOURce<hw>]:BB:ARBitrary:MCARrier:CARRier<ch>:STATe <State>

Enables/disables the selected carrier.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: SOURce1:BB:ARBitrary:MCARrier:CARRier15:STATe
ON

Manual operation: See "State" on page 115

[:SOURce<hw>]:BB:ARBitrary:MCARrier:CFACtor:MODE <Mode>

The command sets the mode for optimizing the crest factor by calculating the carrier
phases.

Parameters:
<Mode> OFF | MIN | MAX

OFF
There is no automatic setting for minimizing or maximizing the
crest factor. The Phase setting (command
BB:ARB:MCAR:CARR:PHAS) is in use.
MIN
The crest factor is minimized by internally calculating optimized
carrier phases. The Phase setting (command
BB:ARB:MCAR:CARR:PHAS) is invalid.
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MAX
The crest factor is maximized by internally calculating optimized
carrier phases. The Phase setting (command
BB:ARB:MCAR:CARR:PHAS) is invalid.
*RST: OFF

Example: BB:ARB:MCAR:CFAC:MODE OFF
switches off automatic crest factor optimization. The setting
SOUR:BB:ARB:MCAR:CARR:PHAS has an effect.

Manual operation: See "Crest Factor Mode" on page 108

[:SOURce<hw>]:BB:ARBitrary:MCARrier:CLIPping:CFACtor <CFactor>

Sets the value of the desired crest factor, if baseband clipping is enabled
(BB:ARB:MCAR:CLIP:STAT ON).

A Target Crest Factor above the crest factor of the unclipped multicarrier signal has no
effect.

Parameters:
<CFactor> float

Range: -50  to  50
Increment: 0.01
*RST: 50
Default unit: dB

Example: BB:ARB:MCAR:CLIP:STAT ON
enables clipping.
BB:ARB:MCAR:CLIP:CFAC 37 dB
sets the target crest factor.

Manual operation: See "Target Crest Factor" on page 108

[:SOURce<hw>]:BB:ARBitrary:MCARrier:CLIPping:CUToff <Cutoff>

Sets the cut off frequency of the final lowpass filter, if baseband clipping is enabled
(BB:ARB:MCAR:CLIP:STAT ON).

When the cut off frequency is set as half of the output sample rate, a final lowpass filter
improves the spectrum of the clipped multicarrier signal, but may also increase the
resulting crest factor.

Parameters:
<Cutoff> float

Range: 0  to  120E6
Increment: 0.01
*RST: 50E6
Default unit: MHz
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Example: BB:ARB:MCAR:CLIP:STAT ON
Enables clipping
BB:ARB:MCAR:CLIP:CUT 50 MHz
Sets the cut off frequency of the filter.

Manual operation: See "Filter Cut Off Frequency" on page 109

[:SOURce<hw>]:BB:ARBitrary:MCARrier:CLIPping[:STATe] <State>

Switches baseband clipping on and off.

Clipping reduces the peak power of the resulting multi carrier signal according to the
value set with the command BB:ARB:MCAR:CLIP:CFAC.

The resulting clipped peak power is defined by sum of the the RMS level of the unclip-
ped multi carrier signal and the input parameter Target Crest Factor. Note that clipping
reduces also the RMS level. Hence the resulting crest factor of the clipped signal is
slightly above the Target Crest Factor. In order to get the unclipped parts of the clipped
multicarrier signal matched with the unclipped multicarrier signal, the RF output power
should be reduced by the difference between resulting crest factor and Target Crest
Factor.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: BB:ARB:MCAR:CLIP:STAT ON
enables clipping
BB:ARB:MCAR:CLIP:CFAC 37 dB
sets the target crest factor.

Manual operation: See "Clipping" on page 108

[:SOURce<hw>]:BB:ARBitrary:MCARrier:CLOad

Creates and loads a multi carrier waveform using the current entries of the carrier
table.

This multi carrier waveform is saved with the file name specified with command
SOUR:BB:ARB:MCAR:OFIL. The file extension is *.wv.

Example: MMEM:CDIR '/var/user/waveform'
sets the default directory.
BB:ARB:MCAR:OFIL 'mcar1_2'
defines the file name mcar1_2.wv for the multi carrier wave-
form.
BB:ARB:MCAR:CLO
creates multi carrier waveform mcar1_2.wv.
The new multi carrier waveform is loaded.

Usage: Event

Manual operation: See "Create and Load" on page 111
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[:SOURce<hw>]:BB:ARBitrary:MCARrier:CLOCk?

The command queries the resulting sample rate at which the multi carrier waveform is
output by the arbitrary waveform generator. The output clock rate depends on the num-
ber of carriers, carrier spacing and input sample rate of the leftmost or rightmost carri-
ers.

Return values: 
<Clock> float

Range: 400  to  Max
Increment: 1E-3

Example: BB:ARB:MCAR:CLOC?
queries the ARB multi carrier output clock rate.

Usage: Query only

Manual operation: See "Clock Rate" on page 111

[:SOURce<hw>]:BB:ARBitrary:MCARrier:CREate

Creates a multi carrier waveform using the current settings of the carrier table. The
multi carrier waveform is saved into the file defined with command
SOUR:BB:ARB:MCAR:OFIL. The file extension is *.wv.

Example: MMEM:CDIR '/var/user/waveform'
sets the default directory.
BB:ARB:MCAR:OFIL 'multi_wv1'
defines the file name multi_wv1.wv for the multi carrier wave-
form.
BB:ARB:MCAR:CRE
creates multi carrier waveform multi_wv1.wv.

Usage: Event

Manual operation: See "Create" on page 111

[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:DELay:STEP <Step>

The command sets the step width by which the start delays of the carriers in the
defined carrier range will be incremented.

Parameters:
<Step> float

Range: -1  to  1
Increment: 1E-9
*RST: 0
Default unit: s
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Example: BB:ARB:MCAR:EDIT:CARR:DEL 5 us
sets a start delay of 5 us for the carriers in the carrier range.
BB:ARB:MCAR:EDIT:CARR:DEL:STEP 1 us
the start delay is incremented by 1us for each carrier, i.e. the
first carrier has a start delay of 5us, the second a start delay of 6
us, etc.

Manual operation: See "Delay Step" on page 114

[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:DELay[:STARt] <Start>

The command sets the start delay for the individual carriers in the defined carrier
range. If the command :BB:ARB:MCAR:EDIT:CARR:DEL:STEP is used to define a
step width, the delay entered here applies only to the starting carrier. The delays of the
remaining carriers are stepped up or down by the delay value specified in
the :BB:ARB:MCAR:EDIT:CARR:DEL:STEP command.

Parameters:
<Start> float

Range: 0  to  1
Increment: 1E-9
*RST: 0
Default unit: s

Example: BB:ARB:MCAR:EDIT:CARR:DEL 5us
sets a start delay of 5 us for the carriers in the carrier range.

Manual operation: See "Delay Start" on page 114

[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:EXECute

The command adopts the settings for the carrier range which has been defined using
the :BB:ARB:MCAR:EDIT:CARR:... commands.

Example: BB:ARB:MCAR:EDIT:CARR:STAR 4
the carrier range starts at carrier 2.
BB:ARB:MCAR:EDIT:CARR:STOP 20
the carrier range stops at carrier 20.
BB:ARB:MCAR:EDIT:CARR:STAT ON
sets all the carriers in the carrier range (2 to 20) to ON.
BB:ARB:MCAR:EDIT:CARR:EXEC
transfers the assistant settings for carrier 2 to 20 into the carrier
table.

Usage: Event

Manual operation: See "Apply Assistant Settings" on page 114

[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:FILE <File>

Selects input file
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Parameters:
<File> string

Example: BB:ARB:MCAR:EDIT:CARR:FILE "/var/user/IQ_wcdma'
Manual operation: See "Input Waveform File" on page 114

[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:PHASe:STEP <Step>

The command sets the step width by which the start phases of the carriers in the
defined carrier range will be incremented.

The phase settings are only valid if optimization of the crest factor is disabled
(:SOURce:BB:ARB:MCARrier:CFACtor:MODE OFF).

Parameters:
<Step> float

Range: -359.99  to  359.99
Increment: 0.01
*RST: 0
Default unit: DEG

Example: BB:ARB:MCAR:EDIT:CARR:PHAS 90 DEG
sets a start phase of 90° for the carriers in the carrier range.
BB:ARB:MCAR:EDIT:CARR:PHAS:STEP 1 DEG
the start phase is incremented by 1° for each carrier, i.e. the first
carrier has a start phase of 90°, the second a start phase of 91°,
etc.

[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:PHASe[:STARt] <Start>

The command sets the start phase for the individual carriers in the defined carrier
range. If the command :BB:ARB:MCAR:EDIT:CARR:PHAS:STEP is used to define a
step width, the phase entered here applies only to the starting carrier. The phases of
the remaining carriers are stepped up or down by the phase value specified in
the :BB:ARB:MCAR:EDIT:CARR:PHAS:STEP command.

The phase settings are only valid if optimization of the crest factor is disabled
(:SOURce:BB:ARB:MCARrier:CFACtor:MODE OFF).

Parameters:
<Start> float

Range: 0  to  359.99
Increment: 0.01
*RST: 0
Default unit: DEG

Example: BB:ARB:MCAR:EDIT:CARR:PHAS 90 DEG
sets a start phase of 90° for the carriers in the carrier range.

Manual operation: See "Phase Start" on page 113

SOURce subsystem



Remote control commandsR&S®SGT100A

429User Manual 1176.8674.02 ─ 12

[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:POWer:STEP <Step>

The command sets the step width by which the starting power of the carriers in the
defined carrier range will be incremented.

Parameters:
<Step> float

Range: -80  to  80
Increment: 0.01
*RST: 0
Default unit: dB

Example: BB:ARB:MCAR:EDIT:CARR:POW -80dB
sets a power of -80 dB for the carriers in the carrier range.
BB:ARB:MCAR:EDIT:CARR:POW:STEP 1 dB
the power is incremented by 1dB for each carrier, i.e. the first
carrier has -80dB, the second -79dB, etc.

Manual operation: See "Gain Step" on page 113
See "Phase Step" on page 114

[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:POWer[:STARt] <Start>

The command sets the power for the individual carriers in the defined carrier range. If
the command :BB:ARB:MCAR:EDIT:CARR:POW:STEP is used to define a step width,
the power entered here applies only to the starting carrier. The power of the remaining
carriers is stepped up or down by the power specified in
the :BB:ARB:MCAR:EDIT:CARR:POW:STEP command.

Parameters:
<Start> float

Range: -80  to  0
Increment: 0.01
*RST: 0
Default unit: dB

Example: BB:ARB:MCAR:EDIT:CARR:POW -50 dB
sets the power of the carriers in the carrier range to -50 dB.

Manual operation: See "Gain Start" on page 113

[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:STARt <Start>
[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:STOP <Stop>
The command selects the last carrier in the carrier range to which the settings with
the :BB:ARB:MCAR:EDIT:CARR:.. commands shall apply.

Parameters:
<Stop> integer

Range: 0  to  511
*RST: 0
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Example: BB:ARB:MCAR:EDIT:CARR:STOP 4
the carrier range stops at carrier 4.

Manual operation: See "Carrier Stop" on page 113

[:SOURce<hw>]:BB:ARBitrary:MCARrier:EDIT:CARRier:STATe <State>

The command switches all the carriers in the selected carrier range on or off.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1

Example: BB:ARB:MCAR:EDIT:CARR:STAT ON
sets all the carriers in the carrier range to ON.

Manual operation: See "Carrier State" on page 113

[:SOURce<hw>]:BB:ARBitrary:MCARrier:OFILe <OFile>

This command defines the output file name for the multi carrier waveform. This file
name is used when a waveform is calculated (command SOUR:BB:ARB:MCAR:CLOad
or SOUR:BB:ARB:MCAR:CREate). The file extension is *.wv.

Parameters:
<OFile> string

Example: MMEM:CDIR "/var/user/waveform"
sets the default directory.
BB:ARB:MCAR:OFIL 'mcar1_2'
defines the file name mcar1_2.wv for the multi carrier wave-
form file

Manual operation: See "Output File" on page 110

[:SOURce<hw>]:BB:ARBitrary:MCARrier:PRESet

Sets all ARB multi carrier parameters to their default values.

Example: SOURce1:BB:ARB:MCARrier:PRESet
Usage: Event

Manual operation: See "Set to Default" on page 105

[:SOURce<hw>]:BB:ARBitrary:MCARrier:SAMPles?

The command queries the resulting file size. The file size is returned in samples.

Return values: 
<Samples> integer

Range: 0  to  INT_MAX
*RST: 0
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Example: BB:ARB:MCAR:SAMP?
queries the file size of the currently calculated multi carrier
waveform.

Usage: Query only

Manual operation: See "File Size" on page 111

[:SOURce<hw>]:BB:ARBitrary:MCARrier:SETTing:CATalog?

Queries the available settings files in the specified default directory. The settings files
are used to set the ARB multi carrier submenu. Only files with the file extension
*.arb_multcarr will be listed.

Return values: 
<Catalog> string

Example: MMEM:CDIR '/var/user/waveform'
sets the default directory
BB:ARB:MCAR:SETT:CAT?
reads out all the settings files in the default directory.
Response: mcar1, mcar2
the directory contains the configuration files
mcar1.arb_multcarr and mcar2.arb_multcarr.

Usage: Query only

Manual operation: See "Save/Recall Frame" on page 106

[:SOURce<hw>]:BB:ARBitrary:MCARrier:SETTing:LOAD <Filename>

Loads the settings file. If a settings file with the specified name does not yet exist, it is
created. The file extension may be omitted. Only files with the file extension
*.arb_multcarr will be loaded or created.

Setting parameters: 
<Filename> string

Example: BB:ARB:MCAR:SETT:LOAD '/var/user/new'
creates settings file new.arb_multcarr.

Usage: Setting only

Manual operation: See "Save/Recall Frame" on page 106

[:SOURce<hw>]:BB:ARBitrary:MCARrier:SETTing:STORe <Filename>

The command stores the current settings of submenu "Multi Carrier" in a file in the
specified directory. The file extension may be omitted, the files are stored with the file
extension *.arb_multcarr.

Setting parameters: 
<Filename> string
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Example: BB:ARB:MCAR:SETT:STOR '/var/user/mcarr2'
stores settings file mcarr2.arb_multcarr in the default direc-
tory.

Usage: Setting only

Manual operation: See "Save/Recall Frame" on page 106

[:SOURce<hw>]:BB:ARBitrary:MCARrier:SETTing:STORe:FAST <Fast>

Determines whether the instrument performs an absolute or a differential storing of the
settings.

Enable this function to accelerate the saving process by saving only the settings with
values different to the default ones.

Note: This function is not affected by the "Preset" function.

Parameters:
<Fast> 0 | 1 | OFF | ON

*RST: 1

Manual operation: See "Save/Recall Frame" on page 106

[:SOURce<hw>]:BB:ARBitrary:MCARrier:TIME <Time>

Sets the user-defined signal period. This setting is only possible for Signal Period
Mode User (BB:ARB:MCAR:TIME:MODE USER).

Parameters:
<Time> float

Range: 0  to  1E9
Increment: 1E-9
*RST: 0
Default unit: s

Example: BB:ARB:MCAR:TIME:MODE USER
selects Signal Period Mode User.
BB:ARB:MCAR:TIME 10 s
sets a signal period of 10 seconds

Manual operation: See "Signal Period" on page 109

[:SOURce<hw>]:BB:ARBitrary:MCARrier:TIME:MODE <Mode>

Selects the mode for calculating the resulting signal period of the multi carrier wave-
form. The resulting period is always calculated for all carriers in the carrier table irre-
spective of their state (ON/OFF).

Parameters:
<Mode> LONG | SHORt | LCM | USER
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LONG
The resulting signal period is defined by the longest I/Q file in
the carrier table. Shorter I/Q files are periodically repeated.
SHORt
The resulting signal period is defined by the shortest I/Q file in
the carrier table. Only the first part of longer I/Q files is used.
USER
The signal period can be set with command [:SOURce<hw>]:
BB:ARBitrary:MCARrier:TIME. Shorter I/Q files are repea-
ted periodically, and only the first part of longer I/Q files is used.
LCM
The output file duration is the least common multiple of all input
file durations.
*RST: LONG

Example: SPOURce1:BB:ARBitrary:MCARrier:TIME:MODE LONG
selects signal period mode long

Manual operation: See "Signal Period Mode" on page 109

10.14.4.7  SOURce:BB:ARB:WAV subsystem

The WAVeform subsystem contains the commands for working with waveform files.

[:SOURce<hw>]:BB:ARBitrary:WAVeform:CATalog?.......................................................... 433
[:SOURce<hw>]:BB:ARBitrary:WAVeform:CATalog:LENGth?..............................................434
[:SOURce<hw>]:BB:ARBitrary:WAVeform:CLOCk............................................................. 434
[:SOURce<hw>]:BB:ARBitrary:WAVeform:DATA................................................................435
[:SOURce<hw>]:BB:ARBitrary:WAVeform:DELete............................................................. 435
[:SOURce<hw>]:BB:ARBitrary:WAVeform:FREE?..............................................................436
[:SOURce<hw>]:BB:ARBitrary:WAVeform:HDDStreaming:BLEVel?.....................................436
[:SOURce<hw>]:BB:ARBitrary:WAVeform:HDDStreaming:STATe........................................ 436
[:SOURce<hw>]:BB:ARBitrary:WAVeform:POINts?............................................................437
[:SOURce<hw>]:BB:ARBitrary:WAVeform:SELect..............................................................437
[:SOURce<hw>]:BB:ARBitrary:WAVeform:TAG?................................................................437

[:SOURce<hw>]:BB:ARBitrary:WAVeform:CATalog?

Reads out the files in the default directory. The default directory is set using command
MMEM:CDIRectory. When the names of the waveform files are returned they are sep-
arated by commas. Only files with the file extension *.wv will be listed.

Return values: 
<Catalog> string
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Example: MMEM:CDIR '/var/user/waveform'
sets the default directory.
BB:ARB:WAV:CAT?
reads out all the files in the default directory.
Response: sin1, wave
the directory contains the waveform files sin1.wv and
wave.wv.

Usage: Query only

[:SOURce<hw>]:BB:ARBitrary:WAVeform:CATalog:LENGth?

Reads out the files in the default directory and returns the number of waveform files in
this directory. The default directory is set using command MMEM:CDIRectory. Only
files with the file extension *.wv will be listed.

Return values: 
<Length> integer

Number of waveform files in default directory
Range: 0  to  INT_MAX
*RST: 0

Example: MMEM:CDIR '/var/user/waveform'
sets the default directory.
BB:ARB:WAV:CAT?
reads out all the files in the default directory.
Response: sin1, wave
the directory contains the waveform files sin1.wv and
wave.wv.
BB:ARB:WAV:CAT:LEN?
Response: 2

Usage: Query only

[:SOURce<hw>]:BB:ARBitrary:WAVeform:CLOCk <Filename>, <Clock>

Appends information on the ARB clock rate to specified waveform file. The file must
contain I/Q and/or marker data and have been created with the command :MMEMory:
DATA:UNPRotected on page 368.

Parameters:
<Filename> string

Complete file path and file name with file extension (*.wv).
If the file is in the default directory, the file path can be omitted.

Setting parameters: 
<Clock> float

Range: 400  to  100E6
Increment: 1E-3
*RST: 1E6
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Example: see :MMEMory:DATA:UNPRotected on page 368

[:SOURce<hw>]:BB:ARBitrary:WAVeform:DATA <Filename>, <Data>
[:SOURce<hw>]:BB:ARBitrary:WAVeform:DATA? <Tag>

The setting command writes the binary block data <data> to the file identified by
<filename>. The complete content of the waveform file is transmitted as a binary
data block.

The query command retrieves the content of the specified tag of the currently selected
waveform file or the waveform file specified with the <filename>.

By default, the waveform files are saved in the default directory of the instrument (/
var/instrument/Lists).

To access waveform files located in another directory, the complete file path and file
name are required.

Parameters:
<Filename> string

Specifies the name of the waveform file the binary data will be
copied to.
The file extension (.wv) may be omitted.

Setting parameters: 
<Data> block data

Contents of the waveform file as a definite length binary block.

Query parameters: 
<Tag> 'comment' | 'copyright' | 'date' | 'lacpfilter' | 'marker name' |

'poweroffset'
Indentifier of the tag which shall be retrieved from the waveform
file.

Example: Setting
BB:ARB:WAV:DATA "/var/sgt/temp/test1", <bin
data block>
writes the block data to file 'test1.wv' in the /var/
instrument/Lists directory.

Example: Query
BB:ARB:WAV:DATA? '/var/user/wave1.wv','comment'
queries the content of the 'comment' tag of file wave1.wv in
directory /var/user
Response: " #222Sinusoidal test signal"

[:SOURce<hw>]:BB:ARBitrary:WAVeform:DELete <Filename>

Deletes the specified waveform file. If the file is not on the default path, the path must
be specified at the same time. The file extension may be omitted. Only files with the file
extension *.wv will be deleted.
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Setting parameters: 
<Filename> string

Example: BB:ARB:WAV:DEL '/var/user/wave1.wv'
deletes waveform file wave1.wv.

Usage: Setting only

[:SOURce<hw>]:BB:ARBitrary:WAVeform:FREE?

Queries the free disk space on the default path of the instrument's harddisk.

Return values: 
<Free> integer

Range: 0  to  INT_MAX
*RST: 1

Example: MMEM:CDIR '/var/user/waveform'
Sets the default directory.
BB:ARB:WAV:FREE?
Queries the free disk space in directory.

Usage: Query only

[:SOURce<hw>]:BB:ARBitrary:WAVeform:HDDStreaming:BLEVel?

Queries the filling level of the streaming buffer.

Return values: 
<BLevel> integer

Range: 0  to  100
*RST: 0

Example: SOURce1:BB:ARBitrary:WAVeform:HDDStreaming:
STATe 1
Enables HDD streaming.
SOURce1:BB:ARBitrary:WAVeform:HDDStreaming:
BLEVel?
Queries the streaming buffer level.
Response: 94%

Usage: Query only

[:SOURce<hw>]:BB:ARBitrary:WAVeform:HDDStreaming:STATe <State>

Enables/disables the streaming of modulation data directly from the hard drive (HDD).

HDD streaming is recommended for processing of large files that require more ARB
memory than the currently installed one.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0
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Example: See [:SOURce<hw>]:BB:ARBitrary:WAVeform:
HDDStreaming:BLEVel? on page 436

[:SOURce<hw>]:BB:ARBitrary:WAVeform:POINts?

The command queries the number of samples in the waveform file selected using com-
mand :ARB:WAV:SEL. Only the file name has to be entered. Only files with the file
extension *.wv will be read out.

Return values: 
<Points> <waveform filename>

Range: 0  to  1000
*RST: 1

Example: BB:ARB:WAV:POINt?
queries the number of I/Q values pairs in the waveform file.
Response: 401
the waveform file contains 401 I/Q values pairs.

Usage: Query only

[:SOURce<hw>]:BB:ARBitrary:WAVeform:SELect <Filename>

Selects the waveform file. If the file is not on the default path, the path must be speci-
fied.

The file extension may be omitted. Only files with the file extension *.wv will be cre-
ated or loaded.

Parameters:
<Filename> string

Example: BB:ARB:WAV:SEL '/var/user/wave1.wv'
selects waveform file and loads it.

Manual operation: See "Load Waveform" on page 91

[:SOURce<hw>]:BB:ARBitrary:WAVeform:TAG?

The command queries the content of the specified tag of the selected Waveform file.

Return values: 
<Tag> string

Example: BB:ARB:WAV:SEL '/var/user/wave1.wv'
selects waveform file and loads it
BB:ARB:WAV:TAG? 'comment'
queries the content of the comment tag
Response: "Sine wave for test purposes"

Usage: Query only
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10.14.4.8  SOURce:BB:ARB:WSEG subsystem

The WSEGment subsystem contains the commands for setting the Multi Segment
Waveform Generator.

[:SOURce<hw>]:BB:ARBitrary:WSEGment?..................................................................... 438
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CLOad............................................................439
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:BLANk:APPend..............................439
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:CATalog?.......................................440
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:CLOCk.......................................... 440
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:CLOCk:MODE............................... 441
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:COMMent......................................441
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:DELete..........................................441
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:LEVel[:MODE]................................442
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:MARKer:ESEGment....................... 442
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:MARKer:FSEGment........................442
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:MARKer:MODE..............................443
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:OFILe............................................443
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:SEGMent:APPend..........................444
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:SEGMent:CATalog?........................444
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:SELect.......................................... 445
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CREate...........................................................445
[:SOURce<hw>]:BB:ARBitrary:WSEGment:LMODe...........................................................446
[:SOURce<hw>]:BB:ARBitrary:WSEGment:NAME?...........................................................446
[:SOURce<hw>]:BB:ARBitrary:WSEGment:NEXT............................................................. 446
[:SOURce<hw>]:BB:ARBitrary:WSEGment:NEXT:EXECute............................................... 447
[:SOURce<hw>]:BB:ARBitrary:WSEGment:NEXT:SOURce................................................ 447
[:SOURce<hw>]:BB:ARBitrary:WSEGment:SEQuence:APPend..........................................447
[:SOURce<hw>]:BB:ARBitrary:WSEGment:SEQuence:SELect...........................................448
[:SOURce<hw>]:BB:ARBitrary:WSEGment:LMODe...........................................................448

[:SOURce<hw>]:BB:ARBitrary:WSEGment?

This command queries the currently output segment of the multi segment waveform.

Return values: 
<WSegment> integer

Range: 0  to  1023
*RST: 0

Example: BB:ARB:WSEG?
queries the currently output segment.
Response 2
segment 2 is currently output.

Usage: Query only

Manual operation: See "Current Segment" on page 125
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[:SOURce<hw>]:BB:ARBitrary:WSEGment:CLOad <FilenameInput>

Creates a and loads a multi segment waveform using the current entries of the speci-
fied configuration file.

This multi segment waveform is saved with the file name specified in the configuration
file. The file extension is *.wv.

Setting parameters: 
<FilenameInput> string

Example: MMEM:CDIR '/var/user/'
sets the default directory.
BB:ARB:WSEG:CONF:SEL 'multi_sin'
creates the configuration file multi_sin.inf_mswv in the
default directory.
BB:ARB:WSEG:CONF:SEGM:APP 'sinus1'
includes waveform sinus1.wv as segment 1 in the configura-
tion file. The waveform must be available in the default directory.
BB:ARB:WSEG:CONF:SEGM:APP 'sinus2'
includes waveform sinus2.wv as segment 2 in the configura-
tion file. The waveform must be available in the default directory.
BB:ARB:WSEG:CONF:OFIL 'mseg1_2'
defines the file name mseg1_2.wv for the multi segment wave-
form.
BB:ARB:WSEG:CLO '/var/user/multi_sin.inf_mswv'
creates multi segment waveform mseg1_2.wv using the set-
tings of the configuration file multi_sin.inf_mswv.
The new multi segment waveform is loaded.

Usage: Setting only

Manual operation: See "Create and Load" on page 96

[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:BLANk:APPend
<SampCount>, <Frequency>

Adds a blank segment to the multi segment file.

Setting parameters: 
<SampCount> float

Specifies the number of samples.
Range: 512  to  1E7
Increment: 1
*RST: 1000

<Frequency> float
Determines the clock rate.
Range: 400 Hz  to  Max (depends on instrument type)
Increment: 0.001
*RST: 1E8

SOURce subsystem



Remote control commandsR&S®SGT100A

440User Manual 1176.8674.02 ─ 12

Example: SOUR:BB:ARB:WSEG:CONF:SEL "MSegFile"
selects a multi segment file.
SOUR:BB:ARB:WSEG:CONF:BLAN:APP 1000,100000000
adds a blank segment with 1000 samples and 100 MHz clock
rate to the selected multi segment file

Usage: Setting only

Manual operation: See "Clock Rate" on page 99
See "Samples" on page 99
See "Append Blank" on page 99

[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:CATalog?

Queries the available configuration files in the specified default directory. The configu-
ration files are used to create multi segment waveform files.

Return values: 
<Catalog> string

Example: MMEM:CDIR '/var/user/waveform'
sets the default directory.
BB:ARB:WSEG:CONF:CAT?
reads out all the configuration files in the default directory.
Response: mulit1, multi2
the directory contains the configuration files multi1.inf_mswv
and multi2.inf_mswv.

Usage: Query only

Manual operation: See "Load List" on page 96

[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:CLOCk <Clock>

This command defines the clock rate used for multi segment waveform output in case
of Clock Mode "User" (:BB:ARB:WSEG:CONF:CLOCk:MODE USER).

Parameters:
<Clock> float

Increment: 1E-3
*RST: max SampleRate

Example: BB:ARB:WSEG:CONF:CLOC:MODE USER
selects Clock Mode User.
BB:ARB:WSEG:CONF:CLOC 50MHz
defines a clock rate of 50 MHz.

Manual operation: See "User Clock Rate" on page 101
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[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:CLOCk:MODE <Mode>

Selects the clock rate mode for the multi segment waveform.

Parameters:
<Mode> UNCHanged | HIGHest | USER

UNCHanged
The segments are output with the clock rate defined in the wave-
form file.
HIGHest
The segments are output at the highest available clock rate.
USER
The segments are output with the clock rate defined with com-
mand [:SOURce<hw>]:BB:ARBitrary:WSEGment:
CONFigure:CLOCk
*RST: UNCHanged

Example: BB:ARB:WSEG:CONF:CLOC:MODE UNCH
selects clock mode unchanged. The segments are output with
the clock rate defined in the waveform file.

Manual operation: See "Clock" on page 100

[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:COMMent <Comment>

This command enters a comment for the configuration file. The configuration file must
be specified with command :BB:ARB:WSEG:CONF:SEL.

Parameters:
<Comment> string

Example: BB:ARB:WSEG:CONF:COMM <3gpp_up>
enters comment "3gpp_up".

Manual operation: See "Comment" on page 97

[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:DELete <Filename>

Deletes the configuration file. The configuration files are used to create multi segment
waveform files.

Setting parameters: 
<Filename> string

Example: MMEM:CDIR '/var/user/waveform'
sets the default directory.
BB:ARB:WSEG:CONF:DEL 'multi1'
deletes configuration file multi1.inf_mswv.

Usage: Setting only

Manual operation: See "Delete" on page 99
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[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:LEVel[:MODE] <Mode>

This command selects the level mode for the multi segment waveform.

Parameters:
<Mode> UNCHanged | ERMS

UNCHanged
The segments are output exactly as defined in the files.
ERMS
The segments are output so that all segments have the same
rms value.
*RST: UNCHanged

Example: BB:ARB:WSEG:CONF:LEV:MODE UNCH
selects level mode unchanged. The segments are output as
defined in the waveform file.

Manual operation: See "Level" on page 100

[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:MARKer:ESEGment
<Mode>

Enables/disables the generation of an additional marker restart signal in the output
waveform file.

If additional marker generation is enabled, the existing marker signals in the individual
segment waveform files are not considered.

Parameters:
<Mode> OFF | MRK1 | MRK2 | MRK3 | MRK4

OFF
No additional marker is generated.
MRK1|MRK2|MRK3|MRK4
Generates a restart marker signal at the beginning of each seg-
ment for the corresponding marker.
The segment begin is defined by the low-high slope of the
marker. This applies for switching between two segments as well
as in case of segment replay.
*RST: OFF

Example: BB:ARB:WSEG:CONF:SEL 'ConfComm'
BB:ARB:WSEG:CONF:MARK:ESEG MRK3

Manual operation: See "Segment Restart" on page 102

[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:MARKer:FSEGment
<Mode>

Enables/disables the generation of an additional marker restart signal in the output
waveform file.
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If additional marker generation is enabled, the existing marker signals in the individual
segment waveform files are not considered.

Parameters:
<Mode> OFF | MRK1 | MRK2 | MRK3 | MRK4

OFF
No additional marker is generated.
MRK1|MRK2|MRK3|MRK4
Generates a restart marker signal at the beginning of the first
segment for the corresponding marker.
Use this setting to generate a restart marker for the complete
sequence.
*RST: OFF

Example: BB:ARB:WSEG:CONF:SEL 'ConfComm'
BB:ARB:WSEG:CONF:MARK:FSEG MRK3

Manual operation: See "Sequence Restart" on page 101

[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:MARKer:MODE <Mode>

Defines the way the marker information within the separate segments is processed.

Parameters:
<Mode> IGNore | TAKE

IGNore
The marker information carried in the individual segment wave-
form files is not considered.
TAKE
The output waveform file contains the marker information as
configured in the individual waveform files.
*RST: TAKE

Example: BB:ARB:WSEG:CONF:SEL 'ConfComm'
BB:ARB:WSEG:CONF:MARK:MODE TAKE

Manual operation: See "Segment Marker" on page 101

[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:OFILe <OFile>

Defines the file name for the multi segment waveform. The file extension is *.wv.

Parameters:
<OFile> string
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Example: MMEM:CDIR '/var/user/waveform'
sets the default directory.
BB:ARB:WSEG:CONF:SEL 'multi1'
creates the configuration file multi1.inf_mswv in default
directory.
BB:ARB:WSEG:CONF:OFIL 'mseg1_2'
defines the file name mseg1_2.wv for the multi segment wave-
form file created using configuration file multi1.inf_mswv.

Manual operation: See "Save List" on page 96
See "Output file" on page 97

[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:SEGMent:APPend
<Waveform>

Appends the specified waveform to the configuration file.

Setting parameters: 
<Waveform> string

Example: MMEM:CDIR '/var/user/waveform'
sets the default directory
BB:ARB:WSEG:CONF:SEL 'new'
creates the configuration file new.inf_mswv in the default
directory.
BB:ARB:WSEG:CONF:SEGM:APP 'arb1'
appends waveform arb1.wv to configuration file new. Wave-
form arb1 will be the first segment of a multi segment waveform
created with configuration file new.

Usage: Setting only

Manual operation: See "Append" on page 99

[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:SEGMent:CATalog?

Queries the segments of the currently selected configuration file.

Return values: 
<Catalog> string

Example: MMEM:CDIR '/var/user/waveform'
sets the default directory.
BB:ARB:WSEG:CONF:SEL 'multi_sin'
selects the configuration file multi_sin.inf_mswv .
BB:ARB:WSEG:CONF:SEGM:CAT?
queries the segments of the selected configuration file.
Response: arb4, arb2
The configuration file includes the segments arb4.wv and
arb2.wv.

Usage: Query only
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Manual operation: See "Append" on page 99

[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:SELect <Filename>

Selects the configuration file in the default directory.

A path can also be specified, in which case the files in the specified directory are
selected. If a configuration file with the specified name does not yet exist, it is created.
The file extension may be omitted. Only files with the file extension *.inf_mswv will
be selected or created.

Parameters:
<Filename> string

Example: MMEM:CDIR '/var/user/waveform'
sets the default directory.
BB:ARB:WSEG:CONF:SEL 'new'
create configuration file new.inf_mswv in the default directory.

Manual operation: See "New List" on page 96
See "Load List" on page 96

[:SOURce<hw>]:BB:ARBitrary:WSEGment:CREate <FilenameInput>

Creates a multi segment waveform using the current settings of the specified configu-
ration file. The multi segment waveform is saved into the file defined in the configura-
tion file. The file extension is *.wv.

Setting parameters: 
<FilenameInput> string

Example: MMEM:CDIR '/var/user/'
sets the default directory
BB:ARB:WSEG:CONF:SEL 'new'
creates the configuration file new.inf_mswv in the default
directory.
BB:ARB:WSEG:CONF:SEGM:APP 'arb1.wv'
'includes waveform arb1.wv as segment 1 in the configuration
file. The waveform must be available in the default directory.
BB:ARB:WSEG:CONF:OFIL 'multi_wv1'
defines the file name multi_wv1.wv for the multi segment
waveform.
BB:ARB:WSEG:CRE '/var/user/new.inf_mswv'
creates multi segment waveform multi_wv1.wv using the set-
tings of the configuration file new.inf_mswv.

Usage: Setting only

Manual operation: See "Save List" on page 96
See "Create" on page 96
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[:SOURce<hw>]:BB:ARBitrary:WSEGment:LMODe <LevelMode>

Sets how the segments are leveled.

Parameters:
<LevelMode> HIGHest | UNCHanged

*RST: HIGHest

Example: :SOURce1:BB:ARBitrary:WSEGment:LMODe HIGHest

[:SOURce<hw>]:BB:ARBitrary:WSEGment:NAME?

This command queries the name of the waveform of the currently output segment of
the multi segment waveform.

Return values: 
<Name> string

Example: BB:ARB:WSEG:NAME?
queries the currently output segment.

Usage: Query only

Manual operation: See "Current Segment" on page 125

[:SOURce<hw>]:BB:ARBitrary:WSEGment:NEXT <Next>

Selects the segment to be output.

Parameters:
<Next> float

Range: 0  to  1023
*RST: 0

Example: MMEM:CDIR '/var/user/waveform'
sets the default directory.
BB:ARB:WSEG:NEXT 2
selects segment 2 to be output.
BB:ARB:TRIG:SMOD NEXT
selects extended trigger mode next, i.e. the segment specified
with command :BB:ARB:WSEG:NEXT will be output.
BB:ARB:SEQ AUTO
selects trigger mode Auto.
BB:ARB:WAV:SEL 'multi_wv1'
loads multi segment waveform multi_wv1.wv. Generation of
segment 2 starts.
BB:ARB:WSEG:NEXT 3
switched at once to output of segment 3.

Manual operation: See "Next Segment" on page 126
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[:SOURce<hw>]:BB:ARBitrary:WSEGment:NEXT:EXECute

Triggers manually switchover to the subsequent segment in the mutli segment file. A
manual trigger can be executed only when an internal next segment source
(BB:ARB:WSEG:NEXT:SOUR INT) has been selected.

To perform a switchover to any segment within the multi segment file, select the next
segment with the command BB:ARB:WSEG:NEXT.

This command is disabled, if a sequencing play list is enabled.

Example: BB:ARB:WSEG:NEXT:SOUR INT
selects internal next segment source.
BB:ARB:WSEG:NEXT 2
selects segment 2 to be output.
BB:ARB:WSEG:NEXT:EXEC
executes a switchover to the next segment.

Usage: Event

Manual operation: See "Execute Next Segment" on page 130

[:SOURce<hw>]:BB:ARBitrary:WSEGment:NEXT:SOURce <Source>

Selects the next segment source, i.e. determines whether the next segment is
switched upon receiving of an external trigger signal or upon executing of software trig-
ger .

Parameters:
<Source> INTernal | NEXT

INTernal
Switch over to any segment is triggered manually by means of
the command BB:ARB:WSEG:NEXT:EXEC.
NEXT
The trigger event for switching to the next segment is input on
the NEXT connector.
*RST: INTernal

Example: BB:ARB:WSEG:NEXT:SOUR INT
selects internal next segment source.

[:SOURce<hw>]:BB:ARBitrary:WSEGment:SEQuence:APPend <State>,
<Segment>, <Count>, <Next>

Appends a new segment to the selected sequencing play list.

Setting parameters: 
<State> ON | OFF

activates/deactivates the appended segment
*RST: ON

SOURce subsystem



Remote control commandsR&S®SGT100A

448User Manual 1176.8674.02 ─ 12

<Segment> integer
indicates the number of the segment as in the multi segment
waveform file
Range: 0  to  SegmentCount - 1

<Count> integer
defines how many times this segment is repeated
Range: 1  to  65535

<Next> NEXT | BLANk | ENDLess | SEG0 | SEG1 | ... | SEG31 |
0...maxSegment
determines the action after completing the current segment, like
for instance which segment is processed after the processing of
the current one is finished.

Example: BB:ARB:WSEG:SEQ:SEL '/var/user/play_list_1’
selects the sequencing list play_list_1.wvs.
BB:ARB:WSEG:SEQ:APP ON,3,15,BLANK
appends the segment number 3 as a new segment to the
sequencing list; this segment is activated and will be repeated
15 times and followed by a blank segment.

Usage: Setting only

Manual operation: See "Append" on page 103

[:SOURce<hw>]:BB:ARBitrary:WSEGment:SEQuence:SELect <Filename>

Selects the sequencing list (files with extension *.wvs)

Parameters:
<Filename> string

Example: BB:ARB:WSEG:SEQ:SEL '/var/user/play_list_1’
selects the sequencing list play_list_1.wvs.

Manual operation: See "Append" on page 103
See "New/Load Sequencing List" on page 104
See "Sequencing List" on page 130

[:SOURce<hw>]:BB:ARBitrary:WSEGment:LMODe <LevelMode>

Sets how the segments are leveled.

Parameters:
<LevelMode> HIGHest | UNCHanged

*RST: HIGHest

Example: :SOURce1:BB:ARBitrary:WSEGment:LMODe HIGHest
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10.14.5  SOURce:BB:ARBitrary:CFR subsystem

Option R&S SGT-K548 is required for the use of the following SCPIs.

Example: Preparing for CFR
// Load an ARB waveform file, e.g., the file "test.wv".
SOURce1:BB:ARBitrary:LOAD "test"
// Activate ARB.
SOURce1:BB:ARBitrary:STATe 1

Example: Applying clipping and filtering algorithm
// Set for filter and clipping CFR algorithm.
SOURce1:BB:ARBitrary:CFR:ALGorithm CLFiltering
SOURce1:BB:ARBitrary:CFR:DCFDelta -3
SOURce1:BB:ARBitrary:CFR:ITERations 5

// Configure simple filtering.
SOURce1:BB:ARBitrary:CFR:FILTer SIMPle
SOURce1:BB:ARBitrary:CFR:CSPacing 20E6
SOURce1:BB:ARBitrary:CFR:SBANdwidth 18E6

// Configure enhanced filtering.
SOURce1:BB:ARBitrary:CFR:FILTer ENHanced
SOURce1:BB:ARBitrary:CFR:PFReq 9E6
SOURce1:BB:ARBitrary:CFR:SFReq 11E6
SOURce1:BB:ARBitrary:CFR:FORDer 100

Example: Applying peak cancellation algorithm
// Set for peak cancellation CFR algorithm.
SOURce1:BB:ARBitrary:CFR:ALGorithm PCANcellation
SOURce1:BB:ARBitrary:CFR:DCFDelta -3
// Set a cancellation pulse bandwidth of 800 kHz.
SOURce1:BB:ARBitrary:CFR:CPBandwidth 800000
// Set a transition bandwidth of 10 kHz.
SOURce1:BB:ARBitrary:CFR:TBANdwidth 10000

Example: Activating and monitoring CFR characteristics
SOURce1:BB:ARBitrary:CFR:STATe 1
SOURce1:BB:ARBitrary:CFR:MEASure:STATe?
// Response: "1"
// Query the original crest factor.
SOURce1:BB:ARBitrary:CFR:OCFactor?
// Response: "6"
// Query the resulting crest factor.
SOURce1:BB:ARBitrary:CFR:RCFactor?
// Response: "3"
// Create the waveform file "cfr.wv" with reduced crest factor.
SOURce1:BB:ARBitrary:CFR:CREate "cfr"
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[:SOURce<hw>]:BB:ARBitrary:CFR[:STATe]..................................................................... 450
[:SOURce<hw>]:BB:ARBitrary:CFR:ALGorithm.................................................................450
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[:SOURce<hw>]:BB:ARBitrary:CFR:CSPacing.................................................................. 451
[:SOURce<hw>]:BB:ARBitrary:CFR:DCFDelta.................................................................. 451
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[:SOURce<hw>]:BB:ARBitrary:CFR:OCFactor?.................................................................452
[:SOURce<hw>]:BB:ARBitrary:CFR:PFReq...................................................................... 453
[:SOURce<hw>]:BB:ARBitrary:CFR:RCFactor?.................................................................453
[:SOURce<hw>]:BB:ARBitrary:CFR:SBANdwidth.............................................................. 453
[:SOURce<hw>]:BB:ARBitrary:CFR:SFReq...................................................................... 454
[:SOURce<hw>]:BB:ARBitrary:CFR:TBANdwidth.............................................................. 454
[:SOURce<hw>]:BB:ARBitrary:CFR:WAVeform:CREate..................................................... 454

[:SOURce<hw>]:BB:ARBitrary:CFR[:STATe] <ArbCfrState>

Enables the crest factor reduction calculation.

Parameters:
<ArbCfrState> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "State" on page 138

[:SOURce<hw>]:BB:ARBitrary:CFR:ALGorithm <ArbCfrAlgorithm>

Defines the algorithm for crest factor reduction.

Parameters:
<ArbCfrAlgorithm> CLFiltering | PCANcellation

CLFiltering
Clipping and filtering algorithm. This algorithm performs a hard
clipping of the baseband signal. It is followed by a low pass filter-
ing of the result in an iterative manner until the target crest factor
is reached. You can define the settings of the filter that is used
for the calculation.
PCANcellation
Peak cancelation algorithm. This algorithm subtracts Blackman
windowed sinc pulses from the signal wherever the amplitude is
above a defined threshold.
*RST: CLFiltering

Example: See Example"Applying clipping and filtering algorithm"
on page 449.

Example: See Example"Applying peak cancellation algorithm"
on page 449.
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Manual operation: See "Algorithm" on page 138

[:SOURce<hw>]:BB:ARBitrary:CFR:CPBandwidth <ArbCfrCancPulBw>

Sets the cancellation pulse bandwidth for peak cancellation CFR algorithm.

Parameters:
<ArbCfrCancPulBw> float

Range: 0  to  250E6
Increment: 0.1

Example: See Example"Applying peak cancellation algorithm"
on page 449.

Manual operation: See "Cancellation Pulse Bandwidth" on page 141

[:SOURce<hw>]:BB:ARBitrary:CFR:CSPacing <ArbCfrChanSpac>

Sets the channel spacing, if [:SOURce<hw>]:BB:ARBitrary:CFR:FILTer is set to
SIMPle.

Parameters:
<ArbCfrChanSpac> float

Range: 0  to  depends on the sample rate of the loaded file
Increment: 0.1
*RST: 250E6

Manual operation: See "Channel Spacing" on page 140

[:SOURce<hw>]:BB:ARBitrary:CFR:DCFDelta <ArbCfrDCFDelta>

Sets the value difference by which you want to change your crest factor.

Parameters:
<ArbCfrDCFDelta> float

Range: -20  to  0
Increment: 0.1
*RST: -3

Manual operation: See "Desired Crest Factor Delta" on page 138

[:SOURce<hw>]:BB:ARBitrary:CFR:FILTer <ArbCfrFilterMod>

Selects which filter mode is used for the filtering.

Parameters:
<ArbCfrFilterMod> SIMPle | ENHanced

*RST: SIMPle

Manual operation: See "Filter Mode" on page 139
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[:SOURce<hw>]:BB:ARBitrary:CFR:FORDer <ArbCfrMaxFilOrd>

Sets the maximum filter order, if [:SOURce<hw>]:BB:ARBitrary:CFR:FILTer is
set to ENHanced.

Parameters:
<ArbCfrMaxFilOrd> integer

Range: 0  to  300
*RST: 100

Example: See Example"Applying clipping and filtering algorithm"
on page 449.

Manual operation: See "Maximum Filter Order" on page 141

[:SOURce<hw>]:BB:ARBitrary:CFR:ITERations <ArbCfrMaxIter>

Sets the number of iterations that are used for calculating the resulting crest factor. The
iteration process is stopped when the desired crest factor delta is achieved by 0.1 dB.

Parameters:
<ArbCfrMaxIter> integer

Range: 1  to  10
*RST: 5

Manual operation: See "Max Iterations" on page 138

[:SOURce<hw>]:BB:ARBitrary:CFR:MEASure[:STATe]?

Queries the state of the crest factor reduction calculation.

Return values: 
<MeasureState> 1 | ON | 0 | OFF

ON: the original and resulting crest factors are already calcula-
ted.
*RST: 0

Example: See Example"Activating and monitoring CFR characteristics"
on page 449.

Usage: Query only

[:SOURce<hw>]:BB:ARBitrary:CFR:OCFactor?

Queries the original crest factor of the waveform after the calculation of the resulting
crest factor is completed. The original crest factor is calculated as an average over the
whole waveform, including any idle periods that might be present in TDD waveforms.
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Return values: 
<ArbCfrOCrestFac> float

Range: 1  to  100
Increment: 0.01
*RST: 6

Usage: Query only

Manual operation: See "Original Crest Factor" on page 139

[:SOURce<hw>]:BB:ARBitrary:CFR:PFReq <ArbCfrPassBFreq>

Sets the passband frequency, if [:SOURce<hw>]:BB:ARBitrary:CFR:FILTer is
set to ENHanced. Frequency components lower than the passband frequency are
passed through unfiltered.

Parameters:
<ArbCfrPassBFreq> float

Range: 0  to  depends on the sample rate of the loaded file
Increment: 0.1
*RST: 250E6

Example: See Example"Applying clipping and filtering algorithm"
on page 449.

Manual operation: See "Passband Frequency" on page 140

[:SOURce<hw>]:BB:ARBitrary:CFR:RCFactor?

Queries the resulting crest factor of the waveform after the calculations are completed.
The resulting crest factor is calculated as an average over the whole waveform, includ-
ing any idle periods that might be present in TDD waveforms.

Return values: 
<ArbCfrResCreFac> float

Range: 1  to  100
Increment: 0.1
*RST: 6

Example: See Example"Activating and monitoring CFR characteristics"
on page 449.

Usage: Query only

Manual operation: See "Resulting Crest Factor" on page 139

[:SOURce<hw>]:BB:ARBitrary:CFR:SBANdwidth <ArbCfrSignalBw>

Sets the signal bandwidth, if [:SOURce<hw>]:BB:ARBitrary:CFR:FILTer is set
to SIMPle.
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The value of the signal bandwidth should not be higher than the channel spacing ([:
SOURce<hw>]:BB:ARBitrary:CFR:CSPacing).

Parameters:
<ArbCfrSignalBw> float

Range: 0  to  depends on the sample rate of the loaded file
Increment: 0.1
*RST: 250E6

Manual operation: See "Signal Bandwidth" on page 140

[:SOURce<hw>]:BB:ARBitrary:CFR:SFReq <ArbCfrStopBFreq>

Sets the stopband frequency of the filter, if [:SOURce<hw>]:BB:ARBitrary:CFR:
FILTer is set to ENHanced. Frequency components higher than the stopband fre-
quency are filtered out by the lowpass filter.

Parameters:
<ArbCfrStopBFreq> float

Range: 0  to  depends on the sample rate of the loaded file
Increment: 0.1
*RST: 250E6

Example: See Example"Applying clipping and filtering algorithm"
on page 449.

Manual operation: See "Stopband Frequency" on page 140

[:SOURce<hw>]:BB:ARBitrary:CFR:TBANdwidth <DDArbCfrTranBw>

Sets the transition bandwidth of the cancellation pulse for peak cancellation CFR algo-
rithm.

Parameters:
<DDArbCfrTranBw> float

Range: 0  to  250E6
Increment: 0.1

Example: See Example"Applying peak cancellation algorithm"
on page 449.

Manual operation: See "Transition Bandwidth" on page 141

[:SOURce<hw>]:BB:ARBitrary:CFR:WAVeform:CREate <CreateWvFile>

With enabled signal generation, triggers the instrument to save the current settings in a
waveform file. Waveform files can be further processed.

The filename and the directory it is saved in are user-definable; the predefined file
extension for waveform files is *.wv.
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Setting parameters: 
<CreateWvFile> string

Example: See Example"Activating and monitoring CFR characteristics"
on page 449.

Usage: Setting only

Manual operation: See "Generate Waveform" on page 138

10.14.6  SOURce:BBIN subsystem

The SOURce:BBIN subsystem contains the commands for setting the external digital
baseband signals.

[:SOURce<hw>]:BBIN:ALEVel:EXECute...........................................................................455
[:SOURce<hw>]:BBIN:CDEVice?.....................................................................................456
[:SOURce<hw>]:BBIN:POWer:CFACtor............................................................................456
[:SOURce<hw>]:BBIN:CFACtor....................................................................................... 456
[:SOURce<hw>]:BBIN:DIGital:ASETting:STATe.................................................................456
[:SOURce<hw>]:BBIN:FOFFset.......................................................................................456
[:SOURce<hw>]:BBIN:GIMBalance..................................................................................457
[:SOURce<hw>]:BBIN:IQSWap[:STATe]........................................................................... 457
[:SOURce<hw>]:BBIN:MODE..........................................................................................457
[:SOURce<hw>]:BBIN:MPERiod......................................................................................458
[:SOURce<hw>]:BBIN:OFFSet:I...................................................................................... 458
[:SOURce<hw>]:BBIN:OFFSet:Q.....................................................................................458
[:SOURce<hw>]:BBIN:OLOad:HOLD:RESet.....................................................................458
[:SOURce<hw>]:BBIN:OLOad:HOLD:STATe?................................................................... 459
[:SOURce<hw>]:BBIN:OLOad:STATe?............................................................................. 459
[:SOURce<hw>]:BBIN:ODELay....................................................................................... 459
[:SOURce<hw>]:BBIN:PGAin.......................................................................................... 460
[:SOURce<hw>]:BBIN:POWer:PEAK............................................................................... 460
[:SOURce<hw>]:BBIN:POWer:RMS?............................................................................... 460
[:SOURce<hw>]:BBIN:SKEW..........................................................................................461
[:SOURce<hw>]:BBIN:SRATe[:ACTual]............................................................................ 461
[:SOURce<hw>]:BBIN:SRATe:SOURce............................................................................461
[:SOURce<hw>]:BBIN:STATe.......................................................................................... 462

[:SOURce<hw>]:BBIN:ALEVel:EXECute

This command starts measuring the input signal. The measurement estimates the
crest factor and the peak power.

Example: BBIN:ALEV:EXEC
starts measuring the input signal.

Usage: Event

Manual operation: See "Auto Level Set" on page 267

SOURce subsystem



Remote control commandsR&S®SGT100A

456User Manual 1176.8674.02 ─ 12

[:SOURce<hw>]:BBIN:CDEVice?

Digital Input only.

Indicates the ID of an externally connected R&S Instrument or R&S Device.

Return values: 
<CDevice> string

Example: BBIN:CDEV
queries the connected device ID.

Usage: Query only

Manual operation: See "Connected Device" on page 265

[:SOURce<hw>]:BBIN:POWer:CFACtor <CFactor>
[:SOURce<hw>]:BBIN:CFACtor <CFactor>
This command enters the crest factor of the external baseband signal.

Parameters:
<CFactor> float

Range: 0  to  30
Increment: 0.01
*RST: 0
Default unit: dB

Example: BBIN:CFAC 10
enters a crest factor of 10 dB for the external baseband signal.

Manual operation: See "Crest Factor" on page 267

[:SOURce<hw>]:BBIN:DIGital:ASETting:STATe <State>

Activates automatic adjustment of the baseband input signal.

The R&S SGT receives peak level, level and crest factor values directly from the con-
nected transmitter and recognizes changes automatically.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: BBIN:DIG:ASET:STAT ON
switches on automatic adjustment of the baseband input signal.

Manual operation: See "DIG IQ Auto Setting" on page 267

[:SOURce<hw>]:BBIN:FOFFset <FOffset>

Enters the frequency offset for the external baseband signal.

The complex I/Q bandwidth of the shifted useful signal must not exceed the total avail-
able baseband bandwidth (see data sheet).
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Parameters:
<FOffset> float

Range: -40E6  to  40E6
Increment: 0.01
*RST: 0
Default unit: Hz

Example: BBIN:FOFF 2 MHz
sets a frequency offset of 2 MHz.

Manual operation: See "Frequency Offset" on page 268

[:SOURce<hw>]:BBIN:GIMBalance <GImbalance>

This command enters a gain to the Q component of the external baseband signal.

Parameters:
<GImbalance> float

Range: -3  to  3
Increment: 0.001
*RST: 0
Default unit: dB

Example: BBIN:GIMB -1.0dB
amplifies the Q component of the external input signal with -1.0
dB.

[:SOURce<hw>]:BBIN:IQSWap[:STATe] <State>

This command swaps the I and Q channel if set to ON.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: BBIN:IQSW ON
swaps the I and Q channel of the external baseband signal.

Manual operation: See "I/Q-Swap" on page 265

[:SOURce<hw>]:BBIN:MODE <Mode>

This command selects the external input signal mode for the "Baseband In" block.

Parameters:
<Mode> ANALog | DIGital

ANALog
The external analog baseband signal is supplied via the inputs I
and Q.
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DIGItal
The external digital baseband signal is fed into the signal path
via the "Digital Input" connector. The internal signal processing
is based on a sample rate of 100 MHz. Input signals with a sam-
ple rate less than 100 MHz are upsampled. The sample rate can
be estimated or defined by the user in the appropriate entry
fields.
*RST: ANALog

Example: BBIN:SOUR ANAL
selects an external analog signal as the input signal. The signal
must be applied at the inputs I and Q.

[:SOURce<hw>]:BBIN:MPERiod <MPeriod>

Sets the recording duration for measuring the baseband input signal by Auto Level Set.

Parameters:
<MPeriod> integer

Range: 1  to  32
*RST: 2
Default unit: s

Example: BBIN:MPER 4s
sets the recording duration for Auto Level Set to 4 seconds.

Manual operation: See "Measurement Period" on page 267

[:SOURce<hw>]:BBIN:OFFSet:I <I>
[:SOURce<hw>]:BBIN:OFFSet:Q <Q>
This command enters a DC offset to the I / Q component of the external baseband sig-
nal.

Parameters:
<Q> float

Range: -10  to  10
Increment: 0.001
*RST: 0
Default unit: %FS

Example: BBIN:OFFS:Q -0.1PCT
sets -0.1 %FS DC offset to the Q component of the external
input signal.

[:SOURce<hw>]:BBIN:OLOad:HOLD:RESet

This command executes a reset of the Overload Hold State and LED.
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Example: BBIN:MODE DIG
selects the digital baseband input mode.
BBIN:OLO:HOLD:RES
resets the overload hold state.

Usage: Event

[:SOURce<hw>]:BBIN:OLOad:HOLD:STATe?

This command queries an overload since the last reset for evaluating the measure-
ment. The Overload Hold state can be reset via the "Reset" command, or is reset auto-
matically by starting a new measurement ("Auto Level Set") or by setting new values
(Crest Factor, Peak Level, Level).

Return values: 
<State> 0 | 1 | OFF | ON

*RST: 0

Example: BBIN:MODE DIG
selects the digital baseband input mode.
BBIN:OLO:HOLD:STAT?
queries the overload state.
Response: 0
the AC/DC converter has not been overloaded.

Usage: Query only

Manual operation: See "Overflow Hold" on page 268
See "Reset" on page 268

[:SOURce<hw>]:BBIN:OLOad:STATe?

This command queries the current overload state of the A/D converter.

Return values: 
<State> 0 | 1 | OFF | ON

*RST: 0

Example: BBIN:MODE DIG
selects the digital baseband input mode.
BBIN:OLO:STAT?
queries the overload state.
Response: 0
The AC/DC converter is not overloaded.

Usage: Query only

Manual operation: See "Overflow" on page 268

[:SOURce<hw>]:BBIN:ODELay <Delay>

Seds the output delay of the external baseband signal.
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Parameters:
<Delay> float

Range: 0  to  1
Increment: 1E-9
*RST: 0

[:SOURce<hw>]:BBIN:PGAin <PGain>

This command enters the relative gain for the external baseband signal compared with
the signals of the other baseband sources. The actual gain of the different baseband
signals depends not only on the path gain setting but also on the signal characteristics
such as the crest factor and on the number of used sources. used and on the total RF
output power. The gain affects the signal on the "Baseband" In block output.

Parameters:
<PGain> float

Range: -50  to  50
Increment: 1E-3
*RST: 0
Default unit: dB

Example: BBIN:PGA 3dB
sets the relative gain of 3 dB for the external baseband signal.

[:SOURce<hw>]:BBIN:POWer:PEAK <Peak>

This command enters the peak level of the external baseband signal relative to full
scale of 0.5 V (in terms of dB full scale).

Parameters:
<Peak> float

Range: -60  to  3.02
Increment: 0.01
*RST: 0
Default unit: dBfs

Example: BBIN:POW:PEAK -2
enters the peak level of -2 dBfs.

Manual operation: See "Peak Level" on page 267

[:SOURce<hw>]:BBIN:POWer:RMS?

This command queries the rms level of the external digital baseband signal.

Return values: 
<Rms> float

Range: -100  to  10
Increment: 0.01
*RST: 0
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Example: BBIN:POW:RMS
queries the estimated rms level.

Usage: Query only

Manual operation: See "Level" on page 267

[:SOURce<hw>]:BBIN:SKEW <Skew>

This command determines the delay between Q and I channel. Positive values repre-
sent a delay for Q versus I.

Parameters:
<Skew> float

Range: -1E-9  to  1E-9
Increment: 1E-12
*RST: 0
Default unit: s

Example: BBIN:SKEW -23PS
enters a delay between Q and I channel of 23 picoseconds.

[:SOURce<hw>]:BBIN:SRATe[:ACTual] <Actual>

Sets the sample rate of the external digital baseband signal.

Parameters:
<Actual> float

Range: 25E6  to  250E6
Increment: 5E6
*RST: 100E6

Example: :SOURce:BBIN:SRATe:ACTual 50E6
Manual operation: See "Sample Rate Value" on page 266

[:SOURce<hw>]:BBIN:SRATe:SOURce <Source>

Queries the source for estimating the sample rate of the digital input signal or defining
it by the user.

Parameters:
<Source> USER | DIN

*RST: USER

Example: BBIN:SRAT:SOUR?
Manual operation: See "Sample Rate Source" on page 266
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[:SOURce<hw>]:BBIN:STATe <State>

This command switches the feeding of an external analog signal into the signal path
on/off.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: BBIN:SOUR ANAL
selects an external analog signal as the input signal. The signal
must be applied at the inputs I and Q.
BBIN:STAT ON
switches on the Baseband In block. The external analog signal
is A/D-converted and fed into the digital signal.

Manual operation: See "State" on page 265

10.14.7  SOURce:BB:IMPairment subsystem

This subsystem contains the commands for the digital I/Q impairments.

The suffix <ch> in the IQOutput<ch> commands has the following values:
● <ch>= 0: I/Q Analog Outputs
● <ch>= 1: I/Q Modulator Digital Impairments

[:SOURce<hw>]:BB:IMPairment:DELay............................................................................462
[:SOURce<hw>]:BB:IMPairment:IQRatio[:MAGNitude].......................................................463
[:SOURce<hw>]:BB:IMPairment:LEAKage:I......................................................................463
[:SOURce<hw>]:BB:IMPairment:LEAKage:Q.................................................................... 464
[:SOURce<hw>]:BB:IMPairment:QUADrature[:ANGLe]...................................................... 464
[:SOURce<hw>]:BB:IMPairment:SKEW............................................................................464
[:SOURce<hw>]:BB:IMPairment:STATe............................................................................ 465
[:SOURce<hw>]:BB:IMPairment:OPTimization:MODE....................................................... 465
[:SOURce]:BB:IMPairment:POFFset................................................................................ 465
[:SOURce]:BB:IMPairment:IQOutput<ch>:STATe...............................................................465
[:SOURce]:BB:IMPairment:IQOutput<ch>:DELay.............................................................. 466
[:SOURce]:BB:IMPairment:IQOutput<ch>:IQRatio[:MAGNitude]..........................................466
[:SOURce]:BB:IMPairment:IQOutput<ch>:POFFset...........................................................466
[:SOURce]:BB:IMPairment:IQOutput<ch>:QUADrature[:ANGLe].........................................467
[:SOURce]:BB:IMPairment:IQOutput<ch>:SKEW.............................................................. 467
[:SOURce]:BB:IMPairment:IQOutput<ch>:LEAKage:I........................................................ 467
[:SOURce]:BB:IMPairment:IQOutput<ch>:LEAKage:Q.......................................................467

[:SOURce<hw>]:BB:IMPairment:DELay <Delay>

Sets the time delay of both I and Q vectors relative to the selected trigger and marker
or relative to the other instrument(s) working in the primary/secondary instrument
mode.
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A positive value means that the I and Q vectors delay relative to the marker/trigger or
to the other instrument and vice versa.

Parameters:
<Delay> float

Range: -500E-9  to  500E-9
Increment: 1E-12
*RST: 0

Example: BB:IMP:DEL 32.0E-9
Sets the I/Q delay

Manual operation: See "IQ Delay" on page 160

[:SOURce<hw>]:BB:IMPairment:IQRatio[:MAGNitude] <IqRatio>

This command sets the ratio of I modulation to Q modulation (amplification “imbal-
ance”). The input may be either in dB or %. The resolution is 0.001 dB, an input in per-
cent is rounded to the closest valid value in dB. A query returns the value in dB.

Parameters:
<IqRatio> float

Range: -1  to  1
Increment: 1E-4
*RST: 0

Example: BB:IMP:IQR 3 PCT
sets the imbalance to 3 percent.
BB:IMP:IQR?
queries the imbalance.
Response: 0.259000
the value is returned in dB

Manual operation: See "Gain Imbalance" on page 159

[:SOURce<hw>]:BB:IMPairment:LEAKage:I <I>

This command sets the carrier leakage amplitude for the I-signal component.

Parameters:
<I> float

Range: -10  to  10
Increment: 0.01
*RST: 0
Default unit: PCT

Example: BB:IMP:LEAK:I 3 PCT
sets the leakage for the I-component to 3 percent.

Manual operation: See "I/Q Offset" on page 159
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[:SOURce<hw>]:BB:IMPairment:LEAKage:Q <Q>

This command sets the carrier leakage amplitude for the Q-signal component.

Parameters:
<Q> float

Range: -10  to  10
Increment: 0.01
*RST: 0
Default unit: PCT

Example: BB:IMP:LEAK:Q 3 PCT
sets the leakage for the Q-component to 3 percent.

Manual operation: See "I/Q Offset" on page 159

[:SOURce<hw>]:BB:IMPairment:QUADrature[:ANGLe] <Angle>

This command sets the quadrature offset for the digital I/Q signal.

Parameters:
<Angle> float

Range: -10  to  10
Increment: 0.01
*RST: 0
Default unit: DEG

Example: BB:IMP:QUAD:ANGL -5DEG
sets the quadrature offset to -5 degrees.

Manual operation: See "Quadrature Offset" on page 159

[:SOURce<hw>]:BB:IMPairment:SKEW <Skew>

Sets the time offset between the I and Q vectors.

In an I/Q modulator without I/Q skew, the I and Q vectors are aligned to the marker.
With an I/Q skew, both vectors are shifted relative to the marker so that the offset of
each of the vectors to the marker will be the half of the I/Q skew value.

A positive I/Q skew means that the Q vector delays relative to the I vector and vice
versa.

Parameters:
<Skew> float

Range: -500E-9  to  500E-9
Increment: 1E-12
*RST: 0

Example: BB:IMP:SKEW 410.0E-9
sets the I/Q skew.

Manual operation: See "Skew" on page 159
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[:SOURce<hw>]:BB:IMPairment:STATe <State>

The command activates (ON) and deactivates (OFF) the three impairment or correc-
tion values LEAKage, QUADrature and IQRatio for the digital baseband signal prior to
input into the I/Q modulator.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: BB:IMP:STAT OFF
deactivates digital impairment.

Manual operation: See "State" on page 157
See "State" on page 159

[:SOURce<hw>]:BB:IMPairment:OPTimization:MODE <Mode>

This command sets the optimization mode.

Parameters:
<Mode> FAST | QHIGh

FAST
Optimization is reached by compensation for I/Q skew.
QHIGh
Optimization is reached by compensation for I/Q skew and fre-
quency response correction.
*RST: FAST

Example: BB:IMP:OPT:MODE FAST
sets the optimization mode Fast.

Manual operation: See "Optimization Mode" on page 155

[:SOURce]:BB:IMPairment:POFFset <PhaseOffset>

Adds a phase offset to the digital impairments in the I/Q modulator. The phase of the
digital impairments is shifted relatively to the I/Q samples.

Parameters:
<PhaseOffset> float

Range: -999.99  to  999.99
Increment: 0.01
*RST: 0

Manual operation: See "Phase Offset" on page 160

[:SOURce]:BB:IMPairment:IQOutput<ch>:STATe <State>

Activates the impairment or correction values LEAKage, QUADrature and IQRatio for
the corresponding stream.
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Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Manual operation: See "State" on page 159

[:SOURce]:BB:IMPairment:IQOutput<ch>:DELay <Delay>

Defines the time delay of both I and Q vectors between the marker signal at the marker
outputs relative to the signal generation start.

A positive value means that the I and Q vectors delay relative to the marker/trigger or
to the other instrument and vice versa.

Parameters:
<Delay> float

Range: -500E-9  to  500E-9
Increment: 1E-12
*RST: 0

Manual operation: See "IQ Delay" on page 160

[:SOURce]:BB:IMPairment:IQOutput<ch>:IQRatio[:MAGNitude] <IqRatio>

Sets the ratio of I modulation to Q modulation (amplification imbalance) of the corre-
sponding digital I/Q channel. The input may be either in dB or %. The resolution is
0.001 dB, an input in percent is rounded to the closest valid value in dB. A query
returns the value in dB.

Parameters:
<IqRatio> float

Range: -1  to  1
Increment: 0.0001
*RST: 0

Manual operation: See "Gain Imbalance" on page 159

[:SOURce]:BB:IMPairment:IQOutput<ch>:POFFset <PhaseOffset>

Adds a phase offset between Q vector and I vector in the corresponding stream. The
phase is shifted relatively to the I/Q samples.

Parameters:
<PhaseOffset> float

Range: -999.99  to  999.99
Increment: 0.01
*RST: 0

Manual operation: See "Phase Offset" on page 160
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[:SOURce]:BB:IMPairment:IQOutput<ch>:QUADrature[:ANGLe] <Angle>

Sets the quadrature offset. A positive quadrature offset results in a phase angle greater
than 90 degrees.

Parameters:
<Angle> float

Range: -10  to  10
Increment: 0.01
*RST: 0

Manual operation: See "Quadrature Offset" on page 159

[:SOURce]:BB:IMPairment:IQOutput<ch>:SKEW <Skew>

Sets a delay between the Q vector and the I vector of the corresponding stream.

Parameters:
<Skew> float

Range: -500E-9  to  500E-9
Increment: 1E-12
*RST: 0

Manual operation: See "Skew" on page 159

[:SOURce]:BB:IMPairment:IQOutput<ch>:LEAKage:I <I>
[:SOURce]:BB:IMPairment:IQOutput<ch>:LEAKage:Q <Q>
Determines the leakage amplitude of the I or Q-signal component of the corresponding
stream.

Parameters:
<Q> float

Range: -10  to  10
Increment: 0.01
*RST: 0

Manual operation: See "I/Q Offset" on page 159

10.14.8  SOURce:BB:PROGress subsystem general commands

In the R&S SGT, some calculation processes take longer time. While operating the
instrument manually, you can observe the status of an initiated process by the busy
indicator. The following commands fulfill the same task in the remote control operation.

Example: Querying the status of the Create Waveform file process
The following is an example on how to use these commands to retrieve information
about how many percent of the initiated process are completed.

SOURce subsystem



Remote control commandsR&S®SGT100A

468User Manual 1176.8674.02 ─ 12

[:SOURce<hw>]:BB:PROGress:MCODer?........................................................................468
[:SOURce<hw>]:BB:PROGress:MCODer:ARBitrary:MCARrier?..........................................468
[:SOURce<hw>]:BB:PROGress:MCODer:ARBitrary:WSEGment?.......................................468

[:SOURce<hw>]:BB:PROGress:MCODer?
[:SOURce<hw>]:BB:PROGress:MCODer:ARBitrary:MCARrier?
[:SOURce<hw>]:BB:PROGress:MCODer:ARBitrary:WSEGment?
Queries the status of an initiated process, like for example the calculation of a signal in
accordance to a digital standard, or the calculation of a multi-carrier or multi-segment
waveform file.

Return values: 
<WSegment> integer

Indicates the task progress in percent
Range: 0  to  100
*RST: 100

Example: See Example"Querying the status of the Create Waveform file
process" on page 467

Usage: Query only

10.14.9  SOURce:BB:POWer subsystem

This subsystem contains the commands for retrieving the level values of the digital
baseband signal.

[:SOURce<hw>]:BB:CFACtor?

This command queries the crest factor of the baseband signal.

Return values: 
<CFactor> float

Range: 0  to  100
Increment: 0.01
*RST: 0
Default unit: dB

Example: BB:CFAC
queries the crest factor of the baseband signal.

Usage: Query only

[:SOURce<hw>]:BB:POWer:PEAK?

This command queries the peak power of the baseband signal relative to full scale of
0.5 V (in terms of dB full scale).
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Return values: 
<Peak> float

Range: -145  to  30
Increment: 0.01
*RST: 0
Default unit: dBfs

Example: BB:POW:PEAK
queries the peak power of the baseband signal.

Usage: Query only

[:SOURce<hw>]:BB:POWer:RMS?

This command queries the power of the baseband signal relative to full scale of 0.5V
(in terms of dB full scale).

Return values: 
<Rms> float

Range: -145  to  30
Increment: 0.01
*RST: 0
Default unit: dBfs

Example: BB:POW:RMS
queries the power of the baseband signal.

Usage: Query only

10.14.10  SOURce:CORRection subsystem

The output level is corrected in the CORRection subsystem. Correction is performed
by user-defined table values being added to the output level for the respective RF fre-
quency. In the R&S SGT, this subsystem is used to select, transfer and activate user
correction tables.

Each list is stored as a file. The name of the user correction file can be freely selected.
The file extension *.uco is assigned automatically and cannot be changed.

The files can be stored in a freely selectable directory and opened from there. The
default directory is set using command :MMEMory:CDIRectory on page 366. In the
case of files which are stored in the default directory, only the file name has to be
specified in commands. Otherwise, the complete absolute path has to be specified with
every command. The extension can be omitted in any case.

In the following command examples, the files are stored in the default directory.

[:SOURce]:CORRection:CSET:CATalog?..........................................................................470
[:SOURce<hw>]:CORRection:CSET:DATA:FREQuency.....................................................470
[:SOURce<hw>]:CORRection:CSET:DATA:FREQuency:POINts?........................................471
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[:SOURce<hw>]:CORRection:CSET:DATA:POWer............................................................ 471
[:SOURce<hw>]:CORRection:CSET:DATA:POWer:POINts?...............................................471
[:SOURce<hw>]:CORRection:CSET:DATA[:SENSor<ch>][:POWer]:SONCe.........................472
[:SOURce]:CORRection:CSET:DELete.............................................................................472
[:SOURce<hw>]:CORRection:DEXChange:AFILe:CATalog?...............................................472
[:SOURce<hw>]:CORRection:DEXChange:AFILe:EXTension.............................................473
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SELect..................................................473
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:COLumn................................474
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:DECimal................................474
[:SOURce<hw>]:CORRection:DEXChange:EXECute.........................................................475
[:SOURce<hw>]:CORRection:DEXChange:MODE............................................................ 475
[:SOURce<hw>]:CORRection:DEXChange:SELect............................................................476
[:SOURce<hw>]:CORRection:CSET[:SELect]................................................................... 476
[:SOURce<hw>]:CORRection[:STATe]..............................................................................477
[:SOURce<hw>]:CORRection:VALue?..............................................................................477
[:SOURce<hw>]:CORRection:ZERoing:STATe.................................................................. 477

[:SOURce]:CORRection:CSET:CATalog?

Requests a list of user correction tables. The individual lists are separated by commas.

The lists are stored with the fixed file extensions *.uco in a directory of the user's
choice. The directory applicable to the commands is defined with the command
MMEMory:CDIR.

Return values: 
<Catalog> string

Example: MMEM:CDIR '/var/user/ucor'
selects the directory for the user correction files.
CORR:CSET:CAT?
queries which correction tables are available.
Response:UCOR1,UCOR2,UCOR3
the correction tables UCOR1, UCOR2 and UCOR3 are availa-
ble.

Usage: Query only

[:SOURce<hw>]:CORRection:CSET:DATA:FREQuency <Frequency>

Transfers the frequency data to the table selected with :CORRection:CSET:SELect.

The numerical suffix at SOURce must not be used for this command.

Parameters:
<Frequency> Frequency#1[, Frequency#2, ...]

Range: 300 kHz  to  RFmax (depending on model)

Example: CORR:CSET '/var/user/ucor1'
selects the table ucor1.
CORR:CSET:DATA:FREQ 100MHz,102MHz,103MHz,...
enters the frequency value in the table ucor1.
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Manual operation: See "Edit User Cor. Data" on page 232

[:SOURce<hw>]:CORRection:CSET:DATA:FREQuency:POINts?

Queries the number of frequency values in the selected table.

The numerical suffix at SOURce must not be used for this command.

Return values: 
<Points> integer

Range: 0  to  10000
*RST: 0

Example: CORR:CSET '/var/user/'
selects the table ucor1.
CORR:CSET:DATA:FREQ:POIN?
queries the number of frequency values in the table ucor1.
Response: 440
the table ucor1 contains 440 frequency values.

Usage: Query only

[:SOURce<hw>]:CORRection:CSET:DATA:POWer <Power>

Transfers the level data to the table selected with [:SOURce<hw>]:CORRection:
CSET[:SELect].

*RST does not affect data lists. The numerical suffix at SOURce must not be used for
this command.

Parameters:
<Power> Power#1[, Power#2, ...]

Example: CORR:CSET '/var/user/ucor1'
selects the table ucor1.
CORR:CSET:DATA:POW 1dB, 0.8dB, 0.75dB,...
enters the level values in the table ucor1.

Manual operation: See "Edit User Cor. Data" on page 232

[:SOURce<hw>]:CORRection:CSET:DATA:POWer:POINts?

Queries the number of level values in the selected table.

The numerical suffix at SOURce must not be used for this command.

Return values: 
<Points> integer

Range: 0  to  10000
*RST: 0
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Example: CORR:CSET '/var/user/ucor1'
selects the table ucor1.
CORR:CSET:DATA:POW:POIN?
queries the number of level values in the table ucor1.
Response: 440
the table ucor1 contains 440 level values.

Usage: Query only

[:SOURce<hw>]:CORRection:CSET:DATA[:SENSor<ch>][:POWer]:SONCe

The command fills the selected user correction list with the level values measured by
the power sensor for the given frequencies.

To select the used power sensor set the suffix in key word SENSe.

Example: CORR:CSET:DATA:SENS:POW:SONC
fills the user correction list with level values acquired by the
power sensor connector to the [SENSOR] connector.

Usage: Event

Manual operation: See "Fill User Correction Data with Sensor" on page 237

[:SOURce]:CORRection:CSET:DELete <Filename>

Deletes the specified table.

The lists are stored with the fixed file extensions *.uco in a directory of the user's
choice. The directory applicable to the commands is defined with the command
MMEMory:CDIR. A path can also be specified in command SOUR:CORR:CSET:CAT?,
in which case the file in the specified directory is deleted.

Setting parameters: 
<Filename> <table name>

Example: MMEM:CDIR '/var/user/ucor'
selects the directory for the user correction files.
CORR:CSET:DEL 'UCOR1'
deletes the table ucor1.

Usage: Setting only

Manual operation: See "User Cor. Data - User Correction" on page 232

[:SOURce<hw>]:CORRection:DEXChange:AFILe:CATalog?

Requests a list of available ASCII files for export/import of user correction data. The
individual files are separated by commas.

The ASCII files are stored with the fixed file extensions *.txt or *.csv in a directory
of the user's choice. The directory applicable to the commands is defined with the com-
mand MMEMory:CDIR.
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Return values: 
<Catalog> string

Example: MMEM:CDIR '/var/user/import'
selects the directory for the ASCII files with frequency and level
value pairs.
CORR:DEXC:AFIL:EXT TXT
selects that ASCII files with extension *.txt are listed.
CORR:DEXC:AFIL:CAT?
queries the available files with extension *.txt.
Response: 'ucor1,ucor2'
the ASCII files ucor1.txt and ucor2.txt are available.

Usage: Query only

[:SOURce<hw>]:CORRection:DEXChange:AFILe:EXTension <Extension>

Selects the file extension of the ASCII file to be imported or exported. Selection TXT
(text file) or CSV (Excel file) is available.

Parameters:
<Extension> TXT | CSV

*RST: TXT

Example: MMEM:CDIR '/var/user/import'
selects the directory for the ASCII files with frequency and level
value pairs.
CORR:DEXC:AFIL:EXT TXT
selects that ASCII files with extension *.txt are listed.
CORR:DEXC:AFIL:CAT?
queries the available files with extension *.txt.
Response: 'list1,list2'
the ASCII files ucor1.txt and ucor2.txt are available.

Manual operation: See "Extension" on page 234

[:SOURce<hw>]:CORRection:DEXChange:AFILe:SELect <Filename>

Selects the ASCII file to be imported or exported.

The ASCII files are stored with the fixed file extensions *.txt or *.csv in a directory
of the user's choice. The directory applicable to the commands is defined with the com-
mand MMEMory:CDIR. A path can also be specified in command
SOUR:CORR:DEXC:AFIL:SEL, in which case the files are stored or loaded in the
specified directory.

Parameters:
<Filename> <ascii file name>
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Example: CORR:DEXC:MODE IMP
selects that ASCII files with frequency and level value pairs are
imported and transferred into user correction lists.
CORR:DEXC:AFIL:SEL '/var/user/import_ucor.csv'
selects that ASCII file ucor.csv is imported.
CORR:DEXC:SEL '/var/user/import_ucor_imp'
selects that the ASCII file ucor.csv is imported into user cor-
rection list ucor_imp.

Manual operation: See "Select ASCII Source/Destination" on page 235

[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:COLumn <Column>

Selects the separator between the frequency and level column of the ASCII table.

Parameters:
<Column> TABulator | SEMicolon | COMMa | SPACe

*RST: COMMa

Example: CORR:DEXC:MODE EXP
selects that the user correction list is exported into an ASCII file.
CORR:DEXC:AFIL:SEL '/var/user/import_ucor.csv'
selects ASCII file ucor.csv as destination for the user correction
list data.
CORR:DEXC:AFIL:SEP:COL TAB
the pairs of frequency and level values are separated by a tabu-
lator.
CORR:DEXC:AFIL:SEP:DEC DOT
selects the decimal separator dot.
CORR:DEXC:SEL '/var/user/import_ucor_imp'
selects that the user correction list ucor_imp is imported into
ASCII file ucor.csv.

Manual operation: See "Column Separator" on page 235

[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:DECimal <Decimal>

Selects the decimal separator used in the ASCII data between '.' (decimal point) and ','
(comma) with floating-point numerals.

Parameters:
<Decimal> DOT | COMMa

*RST: DOT
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Example: CORR:DEXC:MODE EXP
selects that the user correction list is exported into an ASCII file.
CORR:DEXC:AFIL:SEL '/var/user/import_ucor.csv'
selects ASCII file ucor.csv as destination for the user correction
list data.
CORR:DEXC:AFIL:SEP:COL TAB
the pairs of frequency and level values are separated by a tabu-
lator.
CORR:DEXC:AFIL:SEP:DEC DOT
selects the decimal separator dot.
CORR:DEXC:SEL '/var/user/import_ucor_imp'
selects that the user correction list ucor_imp is imported into
ASCII file ucor.csv.

Manual operation: See "Decimal Point" on page 234

[:SOURce<hw>]:CORRection:DEXChange:EXECute

Starts the export or import of the selected file. When import is selected, the ASCII file is
imported as user correction list. When export is selected, the user correction list is
exported into the selected ASCII file.

Example: CORR:DEXC:MODE IMP
selects that ASCII files with frequency and level value pairs are
imported and transferred into user correction lists.
CORR:DEXC:AFIL:SEL '/var/user/import_ucor.csv'
selects that ASCII file ucor.csv is imported.
CORR:DEXC:SEL '/var/user/import_ucor_imp'
selects that the ASCII file ucor.csv is imported into user cor-
rection list ucor_imp.
CORR:DEXC:EXEC
starts the import of the ASCII file data into the user correction
file.

Usage: Event

Manual operation: See "Import/Export" on page 235

[:SOURce<hw>]:CORRection:DEXChange:MODE <Mode>

Selects if user correction lists should be imported or exported. Depending on the selec-
tion her, the file select command define either the source or the destination for user
correction lists and ASCII files.

Parameters:
<Mode> IMPort | EXPort

*RST: IMPort
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Example: CORR:DEXC:MODE IMP
selects that ASCII files with frequency and level value pairs are
imported and transferred into user correction lists.
CORR:DEXC:AFIL:SEL '/var/user/ucor.csv'
selects that ASCII file ucor.csv is imported.
CORR:DEXC:SEL '/var/user/ucor_imp'
selects that the ASCII file ucor.csv is imported into user cor-
rection list ucor_imp.

Manual operation: See "Mode - User Correction" on page 234

[:SOURce<hw>]:CORRection:DEXChange:SELect <Filename>

Selects the user correction list to be imported or exported.

The user correction files are stored with the fixed file extensions *.uco in a directory
of the user's choice. The directory applicable to the commands is defined with the com-
mand MMEMory:CDIR. A path can also be specified in command
SOUR:CORR:DEXC:SEL, in which case the files are stored or loaded in the specified
directory.

Parameters:
<Filename> string

Example: CORR:DEXC:MODE IMP
selects that ASCII files with frequency and level value pairs are
imported and transferred into user correction lists.
CORR:DEXC:AFIL:SEL '/var/user/import_ucor.csv'
selects that ASCII file ucor.csv is imported.
CORR:DEXC:SEL '/var/user/import_ucor_imp'
selects that the ASCII file ucor.csv is imported into user cor-
rection list ucor_imp.

Manual operation: See "Select Destination/Source" on page 235

[:SOURce<hw>]:CORRection:CSET[:SELect] <Filename>

Selects or creates a file for the user correction data.

If the file does not exist, the instrument automatically creates a new file with the name
you assigned. Note the predefined file extensions under Chapter 10.9.2, "Extensions
for user files", on page 364.

To determine the file location (directory/path) you can either enter it with the command
directly, or use the command MMEMory:CDIR.

To activate level correction use the command [:SOURce<hw>]:CORRection[:
STATe].

Parameters:
<Filename> <table name>
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Example: CORR:CSET '/var/user/ucor1'
selects the table ucor1.
CORR ON
activates level correction. Correction is performed using the
table ucor1.

Manual operation: See "User Cor. Data - User Correction" on page 232
See "Edit User Cor. Data" on page 232

[:SOURce<hw>]:CORRection[:STATe] <State>

Activates/deactivates level correction. Level correction is performed using the table
which has been selected with the command [:SOURce<hw>]:CORRection:CSET[:
SELect].

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: SOUR:CORR:CSET '/var/user/ucor1'
selects the table ucor1.
SOUR:CORR ON
activates user correction.

Manual operation: See "State" on page 231

[:SOURce<hw>]:CORRection:VALue?

Queries the current value for user correction.

Return values: 
<Value> float

Range: -100  to  100
Increment: 0.01
*RST: 0

Example: CORR:VAL?
queries the value currently used for level correction.
Response: -3
the correction value is - 3 dB.

Usage: Query only

Manual operation: See "User Correction" on page 231

[:SOURce<hw>]:CORRection:ZERoing:STATe <State>

Activates the zeroing procedure before filling the user correction data acquired by a
sensor.
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Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1

Manual operation: See "Fill User Correction Data with Sensor" on page 237

10.14.11  SOURce:IQ subsystem

This subsystem contains the commands for checking the I/Q modulation.

[:SOURce]:IQ:CREStfactor..............................................................................................478
[:SOURce]:IQ:IMPairment:IQRatio[:MAGNitude]................................................................478
[:SOURce]:IQ:IMPairment:LEAKage:I...............................................................................479
[:SOURce]:IQ:IMPairment:LEAKage:Q.............................................................................479
[:SOURce]:IQ:IMPairment:QUADrature[:ANGLe]...............................................................479
[:SOURce]:IQ:IMPairment[:STATe]................................................................................... 479
[:SOURce]:IQ:IMPairment:SWAP[:STATe].........................................................................479
[:SOURce]:IQ:STATe...................................................................................................... 480
[:SOURce]:IQ:SOURce...................................................................................................480
[:SOURce<hw>]:IQ:SWAP[:STATe].................................................................................. 480
[:SOURce]:IQ:WBSTate.................................................................................................. 480

[:SOURce]:IQ:CREStfactor <CrestFactor>

Sets the crest factor of the IQ modulation signal.

Parameters:
<CrestFactor> float

Range: 0  to  80
Increment: 0.01
*RST: 0

Manual operation: See "Crest Factor" on page 156

[:SOURce]:IQ:IMPairment:IQRatio[:MAGNitude] <IqRatio>

Sets the ratio of I modulation to Q modulation (amplification “imbalance”). The input
may be either in dB or %. The resolution is 0.001 dB, an input in percent is rounded to
the closest valid value in dB. A query returns the value in dB.

Parameters:
<IqRatio> float

Range: -1  to  1
Increment: 1E-3
*RST: 0

Manual operation: See "Gain Imbalance" on page 157
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[:SOURce]:IQ:IMPairment:LEAKage:I <I>

Sets the carrier leakage amplitude for the I-signal component.

Parameters:
<I> float

Range: -10  to  10
Increment: 0.01
*RST: 0

Manual operation: See "I/Q Offset" on page 157

[:SOURce]:IQ:IMPairment:LEAKage:Q <Q>

Sets the carrier leakage amplitude for the Q-signal component.

Parameters:
<Q> float

Range: -10  to  10
Increment: 0.01
*RST: 0

Manual operation: See "I/Q Offset" on page 157

[:SOURce]:IQ:IMPairment:QUADrature[:ANGLe] <Angle>

Sets the quadrature offset for the digital I/Q signal.

Parameters:
<Angle> float

Range: -10  to  10
Increment: 0.01
*RST: 0

Manual operation: See "Quadrature Offset" on page 158

[:SOURce]:IQ:IMPairment[:STATe] <State>

Activates/ deactivates the three impairment or correction values LEAKage, QUADra-
ture and IQRatio for the baseband signal prior to input into the I/Q modulator.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

[:SOURce]:IQ:IMPairment:SWAP[:STATe] <State>

When set to ON, this command swaps the I and Q channel for an external modulation
signal.
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Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "I/Q Swap" on page 154

[:SOURce]:IQ:STATe <State>

Switches the I/Q modulation on and off.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "I/Q Mod State" on page 68
See "State" on page 154

[:SOURce]:IQ:SOURce <Source>

Sets the input signal for the I/Q modulator.

Parameters:
<Source> ANALog | BASeband

*RST: BASeband

Manual operation: See "IQ Source" on page 154

[:SOURce<hw>]:IQ:SWAP[:STATe] <State>

When set to ON, this command swaps the I and Q channel.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: IQ:SWAP ON
swaps the I and Q channel.

Manual operation: See "I/Q Swap" on page 154

[:SOURce]:IQ:WBSTate <State>

Selects optimized settings for wideband modulation signals.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "I/Q Wideband" on page 155
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10.14.12  SOURce:IQ:OUTPut subsystem

Example: Enabling and configuring the analog output
SCONfiguration:OUTPut:MAPPing:IQOutput1:STReam1:STATe 1

SOURce1:IQ:OUTPut:ANALog:PRESet
SOURce1:IQ:OUTPut:ANALog:TYPE DIFF
SOURce1:IQ:OUTPut:ANALog:MODE VAR
SOURce1:IQ:OUTPut:LEVel 2
SOURce1:IQ:OUTPut:ANALog:BIAS:COUPling:STATe 1
SOURce1:IQ:OUTPut:ANALog:BIAS:I 1
SOURce1:IQ:OUTPut:ANALog:BIAS:Q?
// 1
SOURce1:IQ:OUTPut:ANALog:OFFSet:I 2
SOURce1:IQ:OUTPut:ANALog:OFFSet:Q 2.5
SOURce1:IQ:OUTPut:ANALog:STATe 1

[:SOURce<hw>]:IQ:OUTPut:ANALog:STATe.....................................................................481
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:PRESet.................................................................481
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:SETTing:CATalog?................................................. 482
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:SETTing:STORe.................................................... 482
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:SETTing:LOAD...................................................... 482
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:SETTing:DELete.................................................... 483
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:TYPE....................................................................483
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:BIAS:COUPling[:STATe]..........................................483
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:BIAS:I................................................................... 483
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:BIAS:Q................................................................. 483
[:SOURce<hw>]:IQ:OUTPut:LEVel...................................................................................484
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:MODE...................................................................484
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:OFFSet:I............................................................... 484
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:OFFSet:Q..............................................................484

[:SOURce<hw>]:IQ:OUTPut:ANALog:STATe <State>

Activates the specified analog I/Q output.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: SOURce:IQ:OUTPut:ANALog:STATe ON
Activates the output of the analog I/Q signal on the [I/Q Out 1]
connectors.

Manual operation: See "State" on page 161

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:PRESet

Sets the default settings (*RST values specified for the commands).
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Not affected are:
● The state set with the command [:SOURce<hw>]:IQ:OUTPut:ANALog:STATe.
● If SCONfiguration:EXTernal:PBEHaviour 1, the I/Q ouptput type set with

the command [:SOURce<hw>]:IQ:OUTPut[:ANALog]:TYPE.

Example: See Example"Enabling and configuring the analog output"
on page 481.

Usage: Event

Manual operation: See "Set to Default" on page 162

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:SETTing:CATalog?

Queries the files with I/Q output settings in the default directory. Listed are files with the
file extension *.iqout.

Return values: 
<Catalog> string

Usage: Query only

Manual operation: See "Save/Recall" on page 162

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:SETTing:STORe <Filename>

Stores the current settings into the selected file; the file extension (*.iqout) is
assigned automatically.

Setting parameters: 
<Filename> "<filename>"

Filename or complete file path

Usage: Setting only

Manual operation: See "Save/Recall" on page 162

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:SETTing:LOAD <Filename>

Loads the selected file from the default or the specified directory. Loaded are files with
extension *.iqout.

Setting parameters: 
<Filename> "<filename>"

Filename or complete file path

Usage: Setting only

Manual operation: See "Save/Recall" on page 162
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[:SOURce<hw>]:IQ:OUTPut[:ANALog]:SETTing:DELete <Filename>

Deletes the selected file from the default or specified directory. Deleted are files with
the file extension *.iqout.

Setting parameters: 
<Filename> "<filename>"

Filename or complete file path

Usage: Setting only

Manual operation: See "Save/Recall" on page 162

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:TYPE <Type>

Sets the type of the analog signal.

Parameters:
<Type> SINGle | DIFFerential | DAC

*RST: SINGle

Example: SOURce1:IQ:OUTPup:ANALog:TYPE DIFFerential
Manual operation: See "I/Q Output Type" on page 162

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:BIAS:COUPling[:STATe] <State>

Couples the bias setting of the I and Q signal components.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Enabling and configuring the analog output"
on page 481.

Manual operation: See "Couple I/Q Bias" on page 163

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:BIAS:I <I>
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:BIAS:Q <Q>
Specifies the amplifier bias Vbias of the respective I or Q component.

The value range is adjusted so that the maximum overall output voltage does not
exceed 4V, see "Maximum overall output voltage" on page 161.

Parameters:
<Q> float

Range: -3.6V to 3.6V
Increment: 1E-4
*RST: 0
Default unit: V
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Example: See Example"Enabling and configuring the analog output"
on page 481.

Manual operation: See "Bias (EMF)" on page 163

[:SOURce<hw>]:IQ:OUTPut:LEVel <Level>

Sets the off-load voltage Vp of the analog I/Q signal output.

The value range is adjusted so that the maximum overall output voltage does not
exceed 4V, see "Maximum overall output voltage" on page 161.

Parameters:
<Level> float

Range: 0.02V to 4V
Increment: 1E-4
*RST: 1
Default unit: V

Example: See Example"Enabling and configuring the analog output"
on page 481.

Manual operation: See "I/Q Level Vp EMF" on page 163

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:MODE <Mode>

Determines the mode for setting the output parameters.

Parameters:
<Mode> FIXed | VARiable

FIXed
Locks the I/Q output settings
VARiable
Unlocks the settings
*RST: FIXed

Example: See Example"Enabling and configuring the analog output"
on page 481.

Manual operation: See "Mode" on page 163

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:OFFSet:I <I>
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:OFFSet:Q <Q>
Sets an offset Voffset between the inverting and non-inverting input of the differential
analog I/Q output signal.

The value range is adjusted so that the maximum overall output voltage does not
exceed 4V, see "Maximum overall output voltage" on page 161.
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Parameters:
<Q> float

Range: -0.3V to 0.3V
Increment: 1E-4
*RST: 0
Default unit: V

Example: See Example"Enabling and configuring the analog output"
on page 481.

Manual operation: See "Offset (EMF)" on page 164

10.14.13  SOURce:IQ:OUTPut:ENVelope commands

The following remote control commands require software option R&S SGT-K540.

Example: Generating an RF envelope signal and defining the shaping function
// define the RF level and frequency
SOURce1:FREQuency:CW 2143000000
SOURce1:POWer:LEVel:IMMediate:AMPLitude -15
SOURce1:POWer:LEVel:IMMediate:OFFSet 0.5
SOURce1:CORRection:VALue?
// Response: 1

// enable RF envelope generation and define the settings
SOURce1:IQ:OUTPut:ANALog:ENVelope:STATe 1
SOURce1:IQ:OUTPut:ANALog:ENVelope:ADAPtion AUTO
SOURce1:IQ:OUTPut:ANALog:TYPE DIFF
SOURce1:IQ:OUTPut:ANALog:ENVelope:ETRak USER
SOURce1:IQ:OUTPut:ANALog:ENVelope:VREF VCC
SOURce1:IQ:OUTPut:ANALog:ENVelope:POWer:OFFSet?
// Response: 1.5

SOURce1:IQ:OUTPut:ANALog:ENVelope:VPP:MAX 4
SOURce1:IQ:OUTPut:ANALog:ENVelope:GAIN 0
SOURce1:IQ:OUTPut:ANALog:ENVelope:EMF:STATe 1
SOURce1:IQ:OUTPut:ANALog:ENVelope:RIN 50
SOURce1:IQ:OUTPut:ANALog:ENVelope:TERMination GROund
SOURce1:IQ:OUTPut:ANALog:ENVelope:BINPut 1
SOURce1:IQ:OUTPut:ANALog:ENVelope:VCC:OFFSet 2

SOURce1:IQ:OUTPut:ANALog:ENVelope:VCC:MIN 0.5
SOURce1:IQ:OUTPut:ANALog:ENVelope:VCC:MAX 2.5

SOURce1:IQ:OUTPut:ANALog:ENVelope:BIAS 0
SOURce1:IQ:OUTPut:ANALog:ENVelope:OFFSet -2
SOURce1:IQ:OUTPut:ANALog:ENVelope:VOUT:MAX?
// Response: 0.5
SOURce1:IQ:OUTPut:ANALog:ENVelope:VOUT:MIN?
// Response: -1.5
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SOURce1:IQ:OUTPut:ANALog:ENVelope:PIN:MIN -30
SOURce1:IQ:OUTPut:ANALog:ENVelope:PIN:MAX 0

SOURce1:IQ:OUTPut:ANALog:ENVelope:DELay 0.00000000001
SOURce1:IQ:OUTPut:ANALog:ENVelope:FDPD OFF

// enable envelope shaping
// SOURce1:IQ:OUTPut:ANALog:ENVelope:SHAPing:MODE DETR
// SOURce1:IQ:OUTPut:ANALog:ENVelope:SHAPing:DETRoughing:FUNCtion F3
// SOURce1:IQ:OUTPut:ANALog:ENVelope:SHAPing:DETRoughing:COUPling OFF
// SOURce1:IQ:OUTPut:ANALog:ENVelope:SHAPing:DETRoughing:FACtor 0.225
// SOURce1:IQ:OUTPut:ANALog:ENVelope:SHAPing:DETRoughing:PEXPonent 1

// quering the oprating point level, current PEP and levels
// SOURce1:IQ:OUTPut:ANALog:ENVelope:ADAPtion?
// Response: Auto
// SOURce1:IQ:OUTPut:ANALog:ENVelope:VCC:VALue:LEVel?
// Response: 0.927
// SOURce1:IQ:OUTPut:ANALog:ENVelope:VCC:VALue:PEP?
// Response: 1.922
// SOURce1:IQ:OUTPut:ANALog:ENVelope:VCC:VALue? 1,NORM,VOLT
// Response: 2.5
// SOURce1:IQ:OUTPut:ANALog:ENVelope:VCC:VALue? 0,NORM,VOLT
// Response: 0.563
// SOURce1:IQ:OUTPut:ANALog:ENVelope:PIN:MAX?
// Response: 0
// SOURce1:IQ:OUTPut:ANALog:ENVelope:PIN:MIN?
// response: -30
// SOURce1:IQ:OUTPut:ANALog:ENVelope:VCC:VALue? 0,DBM,POW
// Response: 2.5
// SOURce1:IQ:OUTPut:ANALog:ENVelope:VCC:VALue? -30,DBM,POW
// Response: 0.563

SOURce1:IQ:OUTPut:ANALog:ENVelope:SHAPing:MODE TABL
SOURce1:IQ:OUTPut:ANALog:ENVelope:SHAPing:PV:FILE:CATalog?
// Response: myLUT_pv
SOURce1:IQ:OUTPut:ANALog:ENVelope:SHAPing:PV:FILE:SELect "/var/user/myLUT_pv.iq_lutpv"
SOURce1:IQ:OUTPut:ANALog:ENVelope:SHAPing:INTerp LIN
SOURce1:IQ:OUTPut:ANALog:ENVelope:SHAPing:SCALe POWer

// change the envelope shaping mode
SOURce1:IQ:OUTPut:ANALog:ENVelope:SHAPing:MODE POLY
// query files with polynomial functions in the default user directory
SOURce1:IQ:OUTPut:ANALog:ENVelope:SHAPing:COEFficients:CATalog?
// Response: env_poly_evm,myPoly
SOURce1:IQ:OUTPut:ANALog:ENVelope:SHAPing:COEFficients:LOAD "myPoly"
SOURce1:IQ:OUTPut:ANALog:ENVelope:SHAPing:COEFficients?
// Response: 0.135,0.82
SOURce1:IQ:OUTPut:ANALog:ENVelope:SHAPing:COEFficients 0.135,0.83
SOURce1:IQ:OUTPut:ANALog:ENVelope:SHAPing:COEFficients:STORe "/var/user/myPoly.iq_poly"
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// enable the outputs
SOURce1:IQ:OUTPut:ANALog:STATe 1
OUTPut1:STATe 1

// store the settings
MMEMory:CDIRectory "/var/user/setups"
SOURce1:IQ:OUTPut:ANALog:SETTings:CATalog? 
// Response: etrak_v1-2
SOURce1:IQ:OUTPut:ANALog:SETTings:STORe "my_ET"

SOURce1:IQ:OUTPut:ANALog:PREset
// change the envelope voltage adaptation mode
SOURce1:IQ:OUTPut:ANALog:ENVelope:ADAPtion MAN

SOURce1:IQ:OUTPut:LEVel 4

SOURce1:IQ:OUTPut:ANALog:ENVelope:SHAPing:GAIN:PRE -3
SOURce1:IQ:OUTPut:ANALog:ENVelope:SHAPing:GAIN:POST 2.5

// change the envelope shaping mode
SOURce1:IQ:OUTPut:ANALog:ENVelope:SHAPing:MODE TABL
SOURce1:IQ:OUTPut:ANALog:ENVelope:SHAPing:FILE:CATalog?
// Response: myLUT_vv
SOURce1:IQ:OUTPut:ANALog:ENVelope:SHAPing:FILE:SELect "/var/user/myLUT_vv.iq_lut"

// set the shaping values in raw format
// SOURce1:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:FILE:DATA  0,0, 0.1,0.2, 1,1
// SOURce1:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:FILE:CATalog?
// Response: myLUT_vv
// set the shaping values and store them into a file
// SOURce1:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:FILE:NEW "LUT_vv_raw", 0,0, 0.1,0.2, 1,1.5
// SOURce1:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:FILE:CATalog?
// Response: myLUT_vv, LUT_vv_raw

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:STATe....................................................488
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:ADAPtion...............................................488
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:ETRak................................................... 489
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VREF.................................................... 489
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:DELay................................................... 489
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:FDPD.................................................... 490
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VOUT:MIN............................................. 490
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VOUT:MAX............................................ 490
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:BIAS......................................................490
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:OFFSet..................................................491
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VPP[:MAX].............................................491
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:EMF[:STATe].......................................... 491
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:RIN....................................................... 491
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:TERMination.......................................... 492
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:BINPut...................................................492
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:GAIN..................................................... 492
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[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VCC:OFFSet..........................................492
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VCC:MIN............................................... 493
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VCC:MAX.............................................. 493
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VCC:VALue:PEP?...................................493
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VCC:VALue:LEVel?.................................493
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VCC:VALue?..........................................494
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:PIN:MIN.................................................494
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:PIN:MAX................................................495
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:POWer:OFFSet?.................................... 495
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:MODE..................................... 495
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:SCALe.....................................496
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:GAIN:PRE............................... 496
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:GAIN:POST............................. 496
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:FILE:CATalog?......................... 496
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:PV:FILE:CATalog?.................... 496
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:FILE[:SELect]...........................496
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:PV:FILE[:SELect]......................496
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:FILE:DATA............................... 497
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:PV:FILE:DATA..........................497
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:FILE:NEW................................497
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:PV:FILE:NEW...........................497
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:INTerp..................................... 497
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:COEFficients............................497
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:COEFficients:CATalog?............. 498
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:COEFficients:STORe................ 498
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:COEFficients:LOAD.................. 498
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:CLIPping:FROM....................... 499
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:CLIPping:TO............................ 499
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:DETRoughing:FUNCtion........... 499
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:DETRoughing:COUPling........... 499
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:DETRoughing:FACTor...............500
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:DETRoughing:PEXPonent.........500

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:STATe <State>

Enables the output of a control signal that follows the RF envelope.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Manual operation: See "RF Envelope" on page 178

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:ADAPtion <AdaptionMode>

Defines the envelope voltage adaption mode.
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Parameters:
<AdaptionMode> AUTO | MANual | POWer

AUTO = Auto Normalized, POWer = Auto Power, MANual = Man-
ual
*RST: AUTO

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Manual operation: See "Envelope Voltage Adaptation" on page 178

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:ETRak <ETrakIfcType>

Selects one of the predefined interface types or allows user-defined settings.

See Table 6-3.

Parameters:
<ETrakIfcType> USER | ET1V2 | ET1V5 | ET2V0

*RST: USER

Example: SOURce1:IQ:OUTPut:ANALog:ENVelope:ETRak ET2V0
Manual operation: See "eTrak® Interface Type" on page 178

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VREF <VoltageReferenc>

Defines whether the envelope voltage Vout is set directly or it is estimated from the
selected supply voltage Vcc.

Parameters:
<VoltageReferenc> VCC | VOUT

*RST: VCC

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Manual operation: See "Envelope Voltage Reference" on page 179

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:DELay <Delay>

Enables a time delay of the generated envelope signal relative to the corresponding
RF signal.

Parameters:
<Delay> float

Range: -500E-9  to  500E-9
Increment: 1E-12
*RST: 0

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485
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Manual operation: See "Envelope to RF Delay" on page 185

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:FDPD <CalcFromDpdStat>

Enables calculation of the envelope from predistorted signal.

Parameters:
<CalcFromDpdStat> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Options: R&S SGT-K540/K541

Manual operation: See "Calculate Envelope from Predistorted Signal" on page 185

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VOUT:MIN <VoutMin>
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VOUT:MAX <VoutMax>
Queries the minimum and maximum values of the estimated envelope output voltage
Vout.

Parameters:
<VoutMax> float

Range: 0.04  to  8
Increment: 1E-3
*RST: 1

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Manual operation: See "VoutMin/Max" on page 179

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:BIAS <Bias>

Sets a bias.

Parameters:
<Bias> float

Range: -3.6V to 3.6V
Increment: 1E-4
*RST: 0
Default unit: V

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485.

Manual operation: See "Bias" on page 179
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[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:OFFSet <Offset>

Sets an offset between the envelope and the inverted envelope signal.

Parameters:
<Offset> float

Range: -8V to 8V
Increment: 1E-4
*RST: 0
Default unit: V

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485.

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VPP[:MAX] <VppMax>

Set the maximum value of the driving voltage Vpp of the used external DC modulator.

Parameters:
<VppMax> float

Range: -0.02V to 8V
Increment: 1E-3
*RST: 1
Default unit: V

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485.

Manual operation: See "VppMax" on page 182

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:EMF[:STATe] <EmfState>

Defines whether the EMF or the voltage value is used.

Parameters:
<EmfState> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Manual operation: See "EMF" on page 180

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:RIN <InputResistance>

Sets the input impedance Rin of the used external DC modulator.

Parameters:
<InputResistance> float

Range: 50|100  to  1E6
Increment: 0.1
*RST: 50
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Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Manual operation: See "Rin" on page 180

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:TERMination <Termination>

Sets how the inputs of the DC modulator are terminated.

Parameters:
<Termination> GROund | WIRE

*RST: GROund

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Manual operation: See "Termination" on page 180

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:BINPut <BipolarInput>

Enables the generation of a bipolar signal.

Parameters:
<BipolarInput> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Manual operation: See "Bipolar Input" on page 181

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:GAIN <Gain>

Sets the gain of the used external DC modulator.

Parameters:
<Gain> float

Range: -50  to  50
Increment: 0.01
*RST: 0

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Manual operation: See "Gain" on page 182

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VCC:OFFSet <VccOffset>

Applies a voltage offset on the supply voltage Vcc.
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Parameters:
<VccOffset> float

Range: 0  to  30
Increment: 1E-3
*RST: 0
Default unit: mV

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Manual operation: See "VccOffset" on page 182

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VCC:MIN <VccMin>
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VCC:MAX <VccMax>
Sets the maximum value of the supply voltage Vcc.

Parameters:
<VccMax> float

Range: 0.04  to  8
Increment: 0.001
*RST: 1

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Manual operation: See "VccMin/Max" on page 183

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VCC:VALue:PEP?

Queries the Vcc value of the current PEP of the generated RF signal.

Return values: 
<VccForCrtPep> float

Range: 0  to  38
Increment: 1E-3
*RST: 0

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Usage: Query only

Manual operation: See "Diagram" on page 194

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VCC:VALue:LEVel?

Queries the Vcc value of the current RMS power level (operating point).
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Return values: 
<VccForRfLevel> float

Range: 0  to  38
Increment: 1E-3
*RST: 0

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Usage: Query only

Manual operation: See "Diagram" on page 194

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VCC:VALue? <xValue>, <xUnit>,
<xScale>

Queries the VCC value for the selected <xValue>.

Query parameters: 
<xValue> float

Value on the x-axis
Value range depends on the selected "Envelope Voltage Adap-
tation" and PEPinMin and PEPinMax values.

<xUnit> NORMalized | DBM | V
*RST: NORMalized

<xScale> VOLTage | POWer
*RST: VOLTage

Return values: 
<VccValue> float

Range: 0  to  38
Increment: 1E-3
*RST: 0

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Usage: Query only

Manual operation: See "Diagram" on page 194

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:PIN:MIN <PinMin>

Sets the minimum value of the input power Pin.

Parameters:
<PinMin> float

Range: -145  to  20
Increment: 0.01
*RST: -30
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Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Manual operation: See "PEPinMin/Max" on page 184

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:PIN:MAX <PinMax>

Sets the maximum value of the input power Pin.

Parameters:
<PinMax> float

Range: -145  to  20
Increment: 0.01
*RST: -20

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Manual operation: See "PEPinMin/Max" on page 184

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:POWer:OFFSet?

Queries the current power offset, that is the sum of enabled "RF Level > Offset" and
"User Correction".

Return values: 
<PowerOffset> float

Range: -200  to  200
Increment: 0.01
*RST: 0

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Usage: Query only

Manual operation: See "Power Offset" on page 183

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:MODE <ShapingMode>

Enables envelope shaping and selects the method to define the shaping function.

Parameters:
<ShapingMode> OFF | LINear | TABLe | POLYnomial | DETRoughing | POWer

LINear = Linear (Voltage)
POWer = Linear (Power)
*RST: OFF

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485.

Manual operation: See "Shaping" on page 187
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[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:SCALe <Scale>

Determines the units used on the x and y axis.

Parameters:
<Scale> POWer | VOLTage

*RST: VOLTage

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Manual operation: See "Scale" on page 194

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:GAIN:PRE <PreGain>
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:GAIN:POST

<PostGain>
Sets a post-gain.

Parameters:
<PostGain> float

Range: -3  to  20
Increment: 1E-2
*RST: 0

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Manual operation: See "Post-Gain" on page 192

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:FILE:CATalog?
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:PV:FILE:CATalog?
Queries the available table shaping files in the default directory. Only files with the file
extension *.iq_lut or *.iq_lutpv are listed.

Return values: 
<Catalog> string

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Usage: Query only

Manual operation: See "Shaping Table" on page 193

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:FILE[:SELect]
<Filename>

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:PV:FILE[:SELect]
<Filename>

Selects an envelope shaping file (extension *.iq_lut or *.iq_lutpv).
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Parameters:
<Filename> string

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Manual operation: See "Shaping Table" on page 193

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:FILE:DATA
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:PV:FILE:DATA
Defines the shaping function in a raw data format.

See also [:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:PV:
FILE:NEW on page 497.

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:FILE:NEW
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:PV:FILE:NEW
Stores the shaping values into a file with the selected file name and loads it.

The file is stored in the default directory or in the directory specified with the absolute
file path. If the file does not yet exist, a new file is created. The file extension is
assigned automatically.

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Usage: Setting only

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:INTerp <Interpolation>

For envelope shaping with shaping tables, enables linear interpolation.

Parameters:
<Interpolation> OFF | LINear | POWer

LINear = Linear (Voltage)
POWer = Linear (Power)
*RST: OFF

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Manual operation: See "Interpolation" on page 193

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:COEFficients

Sets the polynomial coefficients.
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Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Manual operation: See "Polynomial Order" on page 197
See "Polynomial constant and coefficients" on page 197
See "Apply, OK" on page 197

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:COEFficients:
CATalog?

Queries the available polynomial files in the default directory. Only files with the file
extension *.iq_poly are listed.

Return values: 
<Catalog> string

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Usage: Query only

Manual operation: See "Save/Recall Polynomial" on page 197

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:COEFficients:STORe
<Filename>

Saves the polynomial function as polynomial file.

Setting parameters: 
<Filename> string

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Usage: Setting only

Manual operation: See "Save/Recall Polynomial" on page 197

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:COEFficients:LOAD
<Filename>

Loads the selected polynomial file.

Setting parameters: 
<Filename> string

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Usage: Setting only

Manual operation: See "Save/Recall Polynomial" on page 197
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[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:CLIPping:FROM
<ClippingFrom>

Enables clipping and defines its limits.

Parameters:
<ClippingFrom> integer

Range: 0  to  100
*RST: 0

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:CLIPping:TO
<ClippingTo>

Enables clipping and defines its limits.

Parameters:
<ClippingTo> integer

Range: 0  to  100
*RST: 100

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:DETRoughing:
FUNCtion <DetrFunction>

Sets the detroughing function.

Parameters:
<DetrFunction> F1 | F2 | F3

*RST: F1

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Manual operation: See "Detroughing Function" on page 191

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:DETRoughing:
COUPling <CouplingState>

Enables/disables deriving the detroughing factor (d) from the selected Vcc value.

Parameters:
<CouplingState> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485
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Manual operation: See "Couple Detroughing Factor with Vcc" on page 192

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:DETRoughing:FACTor
<DetrFactor>

Sets the detroughing factor.

Parameters:
<DetrFactor> float

Range: 0  to  2
Increment: 1E-3
*RST: 0.2

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Manual operation: See "Detroughing Factor (d)" on page 192

[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:DETRoughing:
PEXPonent <PowerExponent>

Sets the exponent (a) for the detroughing function F3.

Parameters:
<PowerExponent> float

Range: 1  to  10
Increment: 1E-3
*RST: 2

Example: See Example"Generating an RF envelope signal and defining
the shaping function" on page 485

Manual operation: See "Exponent (a)" on page 192

10.14.14  SOURce:IQ:DPD subsystem

The SOURce:IQ:DPD subsystem contains the commands for enabling and configuring
of digital predistortion.

Example: Defining correction coefficients and enabling digital predistortion
*RST

SOURce1:IQ:DPD:PIN:MIN -35
SOURce1:IQ:DPD:PIN:MAX -2.5

// select look-up table files with correction values
SOURce1:IQ:DPD:SHAPing:MODE TABLe
SOURce1:IQ:DPD:SHAPing:TABLe:AMAM:FILE:CATalog?
// Response: My_DPD_AM-AM,MyDPD_AM-AM
SOURce1:IQ:DPD:SHAPing:TABLe:AMAM:FILE:SELect "My_DPD_AM-AM"
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SOURce1:IQ:DPD:SHAPing:TABLe:AMPM:FILE:CATalog?
// Response: My_DPD_AM-PM,MyDPD_AM-PM
SOURce1:IQ:DPD:SHAPing:TABLe:AMPM:FILE:SELect "My_DPD_AM-PM"
SOURce1:IQ:DPD:SHAPing:TABLe:INTerp LINear
SOURce1:IQ:DPD:SHAPing:TABLe:INVert?
// Response: 0

// enable digital predistortion
SOURce1:IQ:DPD:AMPM:AMFirst 1
SOURce1:IQ:DPD:AMAM:STATe 1
SOURce1:IQ:DPD:AMPM:STATe 1
SOURce1:IQ:DPD:LREFerence BDPD
SOURce1:IQ:DPD:STATe 1

// enable the output
SOURce1:IQ:STATe 1
OUTPut1:STATe 1

// query the PEP, level and crest factor values before and after the DPD
SOURce1:IQ:DPD:INPut:PEP?
// Response: -3.43
SOURce1:IQ:DPD:INPut:LEVel?
// Response: -15
SOURce1:IQ:DPD:INPut:CFACtor?
// Response: 11.57

SOURce1:IQ:DPD:OUTPut:PEP?
SOURce1:IQ:DPD:OUTPut:LEVel?
SOURce1:IQ:DPD:OUTPut:CFACtor?

// change level reference and 
// query the PEP, level and crest factor values before and after the DPD
SOURce1:IQ:DPD:LREFerence ADPD
SOURce1:IQ:DPD:OUTPut:ERRor:MAX 0.1
SOURce1:IQ:DPD:OUTPut:ITERations:MAX 3
SOURce1:IQ:DPD:MEASurement:STATe?
// Response: 1
SOURce1:IQ:DPD:OUTPut:ERRor?
// Response: 0
SOURce1:IQ:DPD:OUTPut:PEP?
// Response: -3.57
SOURce1:IQ:DPD:OUTPut:LEVel?
// Response: -15
SOURce1:IQ:DPD:OUTPut:CFACtor?
// Response: 11.43

// enable static DPD and set the pre-gain
SOURce1:IQ:DPD:LREFerence SDPD
SOURce1:IQ:DPD:GAIN:PRE -18
// set the predistorion values in raw format
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SOURce1:IQ:DPD:SHAPing:TABLe:AMAM:FILE:DATA -30.4,-5.2, -25.1,-4.5, -18.5,-2.5, -10.5,-1
SOURce1:IQ:DPD:SHAPing:TABLe:AMPM:FILE:DATA -30.4, -5, -25.1, 5, -10, 0
SOURce1:IQ:DPD:SHAPing:TABLe:AMPM:FILE:CATalog?
// Response: My_DPD_AM-PM,MyDPD_AM-PM
// set the predistorion values and store them into a file
SOURce1:IQ:DPD:SHAPing:TABLe:AMPM:FILE:NEW "DPD_AM-PM_raw", -30.4, -5, -25.1, 5, -10, 0
SOURce1:IQ:DPD:SHAPing:TABLe:AMPM:FILE:CATalog?
// Response: My_DPD_AM-PM,MyDPD_AM-PM,DPD_AM-PM_raw
SOURce1:IQ:DPD:AMPM:VALue:PEP?
// Response: 4.255
SOURce1:IQ:DPD:AMPM:VALue:VALue? -30,DBM
// Response:-4.439

// change the shaping mode
SOURce1:IQ:DPD:SHAPing:MODE POLYnomial
// query files with polynomial functions in the default user directory
SOURce1:IQ:DPD:SHAPing:POLYnomial:COEFficients:CATalog?
// Response: MyDTD_Poly,myDTD_Poly4th
SOURce1:IQ:DPD:SHAPing:POLYnomial:COEFficients:LOAD "MyDTD_Poly4th"
SOURce1:IQ:DPD:SHAPing:POLYnomial:COEFficients?
// Response: 0,0,-0.25,0.2,0.6,-0.3,0.3,0.3,0.5,-0.4
SOURce1:IQ:DPD:SHAPing:POLYnomial:COEFficients:STORe "/var/user/myPoly.dpd_poly"

Commands:

[:SOURce<hw>]:IQ:DPD:STATe.......................................................................................503
[:SOURce<hw>]:IQ:DPD:PRESet.................................................................................... 503
[:SOURce<hw>]:IQ:DPD:SETTing:CATalog?.....................................................................503
[:SOURce]:IQ:DPD:SETTing:DELete................................................................................504
[:SOURce<hw>]:IQ:DPD:SETTing:LOAD..........................................................................504
[:SOURce<hw>]:IQ:DPD:SETTing:STORe........................................................................504
[:SOURce<hw>]:IQ:DPD:AMAM:STATe............................................................................ 504
[:SOURce<hw>]:IQ:DPD:AMPM:STATe............................................................................ 504
[:SOURce<hw>]:IQ:DPD:AMAM:VALue?..........................................................................505
[:SOURce<hw>]:IQ:DPD:AMAM:VALue:PEP?...................................................................505
[:SOURce<hw>]:IQ:DPD:AMAM:VALue:LEVel?.................................................................506
[:SOURce<hw>]:IQ:DPD:AMPM:VALue?..........................................................................506
[:SOURce<hw>]:IQ:DPD:AMPM:VALue:PEP?...................................................................506
[:SOURce<hw>]:IQ:DPD:AMPM:VALue:LEVel?.................................................................507
[:SOURce<hw>]:IQ:DPD:AMFirst.....................................................................................507
[:SOURce<hw>]:IQ:DPD:LREFerence..............................................................................507
[:SOURce<hw>]:IQ:DPD:OUTPut:ERRor?........................................................................507
[:SOURce<hw>]:IQ:DPD:OUTPut:ERRor:MAX..................................................................508
[:SOURce<hw>]:IQ:DPD:OUTPut:ITERations:MAX........................................................... 508
[:SOURce<hw>]:IQ:DPD:MEASurement:STATe?...............................................................508
[:SOURce<hw>]:IQ:DPD:INPut:CFACtor?.........................................................................509
[:SOURce<hw>]:IQ:DPD:OUTPut:CFACtor?..................................................................... 509
[:SOURce<hw>]:IQ:DPD:INPut:LEVel?.............................................................................509
[:SOURce<hw>]:IQ:DPD:OUTPut:LEVel?......................................................................... 509
[:SOURce<hw>]:IQ:DPD:INPut:PEP?...............................................................................509
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[:SOURce<hw>]:IQ:DPD:OUTPut:PEP?........................................................................... 509
[:SOURce<hw>]:IQ:DPD:PIN:MIN....................................................................................509
[:SOURce<hw>]:IQ:DPD:PIN:MAX...................................................................................509
[:SOURce<hw>]:IQ:DPD:GAIN:PRE................................................................................ 509
[:SOURce<hw>]:IQ:DPD:SHAPing:MODE........................................................................ 510
[:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMAM:FILE:CATalog?....................................... 510
[:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMPM:FILE:CATalog?....................................... 510
[:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMAM:FILE[:SELect].........................................510
[:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMPM:FILE[:SELect].........................................510
[:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMAM:FILE:NEW............................................. 510
[:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMPM:FILE:NEW............................................. 510
[:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMAM:FILE:DATA............................................. 511
[:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMPM:FILE:DATA............................................. 511
[:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:INTerp.............................................................. 511
[:SOURce<hw>]:IQ:DPD:SHAPing[:TABLe]:INVert.............................................................511
[:SOURce<hw>]:IQ:DPD:SHAPing:POLYnomial:COEFficients............................................ 511
[:SOURce<hw>]:IQ:DPD:SHAPing:POLYnomial:COEFficients:CATalog?............................. 512
[:SOURce<hw>]:IQ:DPD:SHAPing:POLYnomial:COEFficients:LOAD.................................. 512
[:SOURce<hw>]:IQ:DPD:SHAPing:POLYnomial:COEFficients:STORe................................ 513
[:SOURce<hw>]:IQ:DPD:SHAPing:NORMalized:DATA...................................................... 513
[:SOURce<hw>]:IQ:DPD:SHAPing:NORMalized:DATA:CATalog?........................................514
[:SOURce<hw>]:IQ:DPD:SHAPing:NORMalized:DATA:LOAD.............................................514
[:SOURce<hw>]:IQ:DPD:SHAPing:NORMalized:DATA:STORe...........................................514

[:SOURce<hw>]:IQ:DPD:STATe <State>

Enabels/disables the generation of digitally pre-distorted signals.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500

Manual operation: See "State" on page 204

[:SOURce<hw>]:IQ:DPD:PRESet

Sets the default DPD settings (*RST values specified for the commands).

Not affected is the state set with the command [:SOURce<hw>]:IQ:DPD:STATe.

Usage: Event

Manual operation: See "Set to Default" on page 204

[:SOURce<hw>]:IQ:DPD:SETTing:CATalog?

Queries the files with digital predistortion setting in the default directory. Listed are files
with the file extension *.dpd.
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Return values: 
<Catalog> string

Usage: Query only

Manual operation: See "Save/Recall" on page 205

[:SOURce]:IQ:DPD:SETTing:DELete <Filename>

Deletes the selected file from the default or specified directory. Deleted are files with
the file extension *.dpd.

Setting parameters: 
<Filename> "<filename>"

Filename or complete file path

Usage: Setting only

Manual operation: See "Save/Recall" on page 205

[:SOURce<hw>]:IQ:DPD:SETTing:LOAD <Filename>

Loads the selected file from the default or the specified directory. Loaded are files with
extension *.dpd.

Setting parameters: 
<Filename> "<filename>"

Filename or complete file path

Usage: Setting only

Manual operation: See "Save/Recall" on page 205

[:SOURce<hw>]:IQ:DPD:SETTing:STORe <Filename>

Stores the current settings into the selected file; the file extension (*.dpd) is assigned
automatically.

Setting parameters: 
<Filename> "<filename>"

Filename or complete file path

Usage: Setting only

Manual operation: See "Save/Recall" on page 205

[:SOURce<hw>]:IQ:DPD:AMAM:STATe <State>
[:SOURce<hw>]:IQ:DPD:AMPM:STATe <State>
Enabels/disables the AM/AM and AM/PM digital predistortion.
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Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500

Manual operation: See "AM/AM and AM/PM State" on page 206

[:SOURce<hw>]:IQ:DPD:AMAM:VALue? <XValue>, <XUnit>

Queries the delta power value of the generated RF signal for a selected <XValue>.

Query parameters: 
<XValue> float

Value on the x-axis.
Value range depends on the selected PEPinMin and PEPinMax
values.
Range: -100  to  100
Increment: 0.01

<XUnit> DBM | V

Return values: 
<DeltaPower> float

Range: -20  to  20
Increment: 0.01
*RST: 0

Example: See Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500.

Usage: Query only

[:SOURce<hw>]:IQ:DPD:AMAM:VALue:PEP?

Queries the delta power value for the current peak envelope power (PEP) level of the
generated RF signal.

Return values: 
<DeltaPower> float

Range: -20  to  20
Increment: 0.01
*RST: 0

Example: See Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500.

Usage: Query only
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[:SOURce<hw>]:IQ:DPD:AMAM:VALue:LEVel?

Queries the delta power value for the current root mean square (RMS) power level of
the generated RF signal.

Return values: 
<DeltaPower> float

Range: -20  to  20
Increment: 0.01
*RST: 0

Example: See Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500.

Usage: Query only

[:SOURce<hw>]:IQ:DPD:AMPM:VALue? <XValue>, <XUnit>

Queries the delta phase value of the generated RF signal for a selected <XValue>.

Query parameters: 
<XValue> float

Value on the x-axis.
Value range depends on the selected PEPinMin and PEPinMax
values.
Range: -100  to  100
Increment: 0.01

<XUnit> DBM | V
*RST: DBM

Return values: 
<DeltaPhase> float

Range: -180  to  180
Increment: 0.01
*RST: 0

Example: See Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500.

Usage: Query only

[:SOURce<hw>]:IQ:DPD:AMPM:VALue:PEP?

Queries the delta phase value for the current peak envelope power (PEP) level of the
generated RF signal.

Return values: 
<DeltaPhase> float

Range: -180  to  180
Increment: 0.01
*RST: 0
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Example: See Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500.

Usage: Query only

[:SOURce<hw>]:IQ:DPD:AMPM:VALue:LEVel?

Queries the delta phase value for the current root mean square (RMS) power level of
the generated RF signal.

Return values: 
<DeltaPhase> float

Range: -180  to  180
Increment: 0.01
*RST: 0

Example: See Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500.

Usage: Query only

[:SOURce<hw>]:IQ:DPD:AMFirst <AmAmFirstState>

Sets that the AM/AM predistortion is applied before the AM/PM.

Parameters:
<AmAmFirstState> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500

Manual operation: See "AM/AM First" on page 205

[:SOURce<hw>]:IQ:DPD:LREFerence <LevelReference>

Sets whether a dynamic (BDPD|ADPD) or a static (SDPS) adaptation of the range the
selected DPD is applied on.

Parameters:
<LevelReference> BDPD | ADPD | SDPD

*RST: BDPD

Example: See Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500

Manual operation: See "Level Reference" on page 205

[:SOURce<hw>]:IQ:DPD:OUTPut:ERRor?

Queries the resulting level error.
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Return values: 
<AchievedError> float

Example: see Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500

Usage: Query only

Manual operation: See "Achieved Output Level Error" on page 206

[:SOURce<hw>]:IQ:DPD:OUTPut:ERRor:MAX <MaximumError>

Sets the allowed maximum error.

Parameters:
<MaximumError> float

Range: 0.01  to  1
Increment: 0.01
*RST: 0.1

Example: see Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500

Manual operation: See "Maximum Output Level Error" on page 205
See "Maximum Number of Iterations" on page 205

[:SOURce<hw>]:IQ:DPD:OUTPut:ITERations:MAX <MaxIterations>

Sets the maximum number of performed iterations to achieving the required error set
with [:SOURce<hw>]:IQ:DPD:OUTPut:ERRor:MAX.

Parameters:
<MaxIterations> integer

Range: 1  to  10
*RST: 3

Example: See Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500

[:SOURce<hw>]:IQ:DPD:MEASurement:STATe?

Queries whether the interactions are competed.

Return values: 
<MeasureValidity> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500

Usage: Query only
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[:SOURce<hw>]:IQ:DPD:INPut:CFACtor?
[:SOURce<hw>]:IQ:DPD:OUTPut:CFACtor?
[:SOURce<hw>]:IQ:DPD:INPut:LEVel?
[:SOURce<hw>]:IQ:DPD:OUTPut:LEVel?
[:SOURce<hw>]:IQ:DPD:INPut:PEP?
[:SOURce<hw>]:IQ:DPD:OUTPut:PEP?
Queries the measured values the before and after the enabled digital predistortion.

Return values: 
<PEP> float

The query returns -1000 if the calculation is impossible or there
are no measurements results available.

Example: see Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500

Usage: Query only

Manual operation: See "Input/Output PEP, Level and Crest Factor" on page 206

[:SOURce<hw>]:IQ:DPD:PIN:MIN <PepInMin>
[:SOURce<hw>]:IQ:DPD:PIN:MAX <PepInMax>
Sets the value range of the input power.

Parameters:
<PepInMax> float

Range: -145  to  20
Increment: 0.01
*RST: 10

Example: See Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500

Manual operation: See "Input Range (PEPin) From/To" on page 209

[:SOURce<hw>]:IQ:DPD:GAIN:PRE <PreGain>

Sets a pre-gain (i.e. an attenuation) to define the range the static DPD is applied in.

Parameters:
<PreGain> float

Range: -50  to  20
Increment: 1E-2
*RST: 0

Example: see Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500

Manual operation: See "Pre-Gain" on page 209
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[:SOURce<hw>]:IQ:DPD:SHAPing:MODE <Shaping>

Selects the method to define the correction coefficients.

Parameters:
<Shaping> TABLe | POLYnomial | NORMalized

*RST: TABLe

Example: See Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500.

Manual operation: See "Shaping" on page 207

[:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMAM:FILE:CATalog?
[:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMPM:FILE:CATalog?
Queries the available table files in the default directory. Only files with the extension
*.dpd_magn(AM/AM) or *.dpd_phase(AM/PM) are listed.

Return values: 
<Catalog> string

Example: See Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500

Usage: Query only

Manual operation: See "Shaping Table" on page 209

[:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMAM:FILE[:SELect] <Filename>
[:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMPM:FILE[:SELect] <Filename>
Selects a file with correction values (extension *.dpd_magn (AM/AM) or
*.dpd_phase(AM/FM)).

Parameters:
<Filename> string

Example: See Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500

Manual operation: See "Shaping Table" on page 209
See "Pin (dBm), Delta Power (dB)/Pin (dBm), Delta Phase
(deg)" on page 211

[:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMAM:FILE:NEW
[:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMPM:FILE:NEW
Stores the correction values into a file with the selected file name and loads it.

The file is stored in the default directory or in the directory specified with the absolute
file path. If the file does not yet exist, a new file is created. The file extension is
assigned automatically.
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Example: See Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500

Usage: Setting only

[:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMAM:FILE:DATA
[:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMPM:FILE:DATA
Defines the predistortion function in a raw data format.

See also [:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:AMPM:FILE:NEW
on page 510.

Example: See Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500

[:SOURce<hw>]:IQ:DPD:SHAPing:TABLe:INTerp <Interpolation>

Enables a linear (voltage or power) interpolation between the defined correction val-
ues.

Parameters:
<Interpolation> OFF | POWer | LINear

POWer
Linear power interpolation
LINear
Linear voltage interpolation
*RST: OFF

Example: See Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500

Manual operation: See "Interpolation" on page 208

[:SOURce<hw>]:IQ:DPD:SHAPing[:TABLe]:INVert <InvertValues>

Inverts the defined correction values.

Parameters:
<InvertValues> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500

Manual operation: See "Invert Correction Values" on page 208

[:SOURce<hw>]:IQ:DPD:SHAPing:POLYnomial:COEFficients <I0>, <J0>, <J1>,
<J1>

Sets the polynomial coefficients as a list of up to 10 comma separated value pairs.
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In Cartesian coordinates system, the coefficients bn are expressed in degrees.

Parameters:
<I0> float

Range: -1E6  to  1E6
Increment: 1E-3
*RST: 0

<J0> float
Range: -1E6  to  1E6
Increment: 1E-3
*RST: 0

<J1> float
Range: -1E6  to  1E6
Increment: 1E-3
*RST: 0

<J1> float
Range: -1E6  to  1E6
Increment: 1E-3
*RST: 0

Example: See Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500.

Manual operation: See "Polynomial Order" on page 214
See "Apply, OK" on page 214

[:SOURce<hw>]:IQ:DPD:SHAPing:POLYnomial:COEFficients:CATalog?

Queries the available polynomial files in the default directory. Only files with the file
extension *.dpd_poly are listed.

Return values: 
<Catalog> string

Example: See Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500

Usage: Query only

Manual operation: See "Save/Recall Polynomial" on page 213

[:SOURce<hw>]:IQ:DPD:SHAPing:POLYnomial:COEFficients:LOAD <Filename>

Loads the selected polynomial file.

Setting parameters: 
<Filename> string

Example: See Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500
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Usage: Setting only

Manual operation: See "Save/Recall Polynomial" on page 213

[:SOURce<hw>]:IQ:DPD:SHAPing:POLYnomial:COEFficients:STORe <Filename>

Saves the polynomial function as polynomial file.

Setting parameters: 
<Filename> string

Example: See Example"Defining correction coefficients and enabling digi-
tal predistortion" on page 500

Usage: Setting only

Manual operation: See "Save/Recall Polynomial" on page 213

[:SOURce<hw>]:IQ:DPD:SHAPing:NORMalized:DATA <Data>

Defines the normalized predistortion function in a raw data format (binary data).

Parameters:
<Data> <#><LengthNoBytes><NoBytes><NormData>

<#>
The binary data must start with the sign #
<LengthNoBytes>
ASCII format
Sets the length of <NoBytes>, i.e. the number of digits used to
write <NoBytes>
<NoBytes>
An ASCII integer value that specifies the number of bytes that
follow in the <NormData> part
Each of the <NormData> parameters is coded with 8 bytes.
Then the number of bytes <NoBytes> is calculated as:
<NoBytes> = 8 + 8 + n(8+8+8), where n is the number of points
<NoPoints>.
<NormData>
<PinMax><NoPoints>{<VinVmax><DeltaV><DeltaPhase>}
Values in binary format, describing the maximum absolute input
power Pinmax, the number of subsequent points n and the nor-
malized values Vin/Vmax, ΔV/V, ΔPhase [deg].
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Example: SOURce1:IQ:DPD:SHAPing:NORMalized:DATA #240<values>
// the binary <values> are not printable
SOURce1:IQ:DPD:SHAPing:NORMalized:DATA:CATalog?
// norm
SOURce1:IQ:DPD:SHAPing:NORMalized:DATA:STORe "My_DPD_Normalized"
SOURce1:IQ:DPD:SHAPing:NORMalized:DATA:CATalog?
// norm,My_DPD_Normalized
SOURce1:IQ:DPD:SHAPing:NORMalized:DATA:LOAD "norm"
SOURce1:IQ:DPD:SHAPing:NORMalized:DATA?
// #3112
// the binary data <NormData> is 112 bytes long (3 points are defined)
// binary data is machine readable but not printable

Manual operation: See "Apply, OK" on page 216

[:SOURce<hw>]:IQ:DPD:SHAPing:NORMalized:DATA:CATalog?

Queries the available files with normalized data in the default directory. Only files with
the file extension *.dpd_norm are listed.

Return values: 
<Catalog> string

Example: See [:SOURce<hw>]:IQ:DPD:SHAPing:NORMalized:DATA
on page 513.

Usage: Query only

Manual operation: See "Save/Recall Normalized Data" on page 215

[:SOURce<hw>]:IQ:DPD:SHAPing:NORMalized:DATA:LOAD <Filename>

Loads the selected file.

Setting parameters: 
<Filename> string

Example: See [:SOURce<hw>]:IQ:DPD:SHAPing:NORMalized:DATA
on page 513.

Usage: Setting only

Manual operation: See "Save/Recall Normalized Data" on page 215

[:SOURce<hw>]:IQ:DPD:SHAPing:NORMalized:DATA:STORe <Filename>

Saves the normalized data in a file.

Setting parameters: 
<Filename> string

Example: See [:SOURce<hw>]:IQ:DPD:SHAPing:NORMalized:DATA
on page 513.
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Usage: Setting only

Manual operation: See "Save/Recall Normalized Data" on page 215

10.14.15  SOURce:PHASe subsystem

[:SOURce]:PHASe......................................................................................................... 515
[:SOURce]:PHASe:REFerence........................................................................................515

[:SOURce]:PHASe <Phase>

Specifies the phase variation relative to the current phase.

Parameters:
<Phase> float

Range: -360  to  360
Increment: 0.1
*RST: 0
Default unit: DEG

Manual operation: See "Delta Phase" on page 219

[:SOURce]:PHASe:REFerence

Adopts the phase set with command [:SOURce]:PHASe as the current phase.

Usage: Event

Manual operation: See "Reset Delta Phase Display" on page 219

10.14.16  SOURce:PULM Subsystem

This subsystem contains the commands for setting the pulse modulation.

Programming Examples

Example: Performing pulse modulation
This example shows a command sequence to perform pulse modulation.

// ******************************************************************
// Reset the instrument to start from an initial state
// ******************************************************************
*RST; *CLS

// ******************************************************************
// Set the RF signal frequency and level
// ******************************************************************
SOURce:FREQuency:CW 4000000000
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SOURce:POWer:LEVel:IMMediate:AMPLitude -25

// ******************************************************************
// Configure the pulse modulation settings
// ******************************************************************
// Select the internal modulation generator
SOURce:PULM:SOURce INT
// Set trigger mode
SOURce:PULM:TRIGger:MODE AUTO
// Select pulse mode
SOURce:PULM:MODE DOUB 

// ******************************************************************
// Alternatively configure the pulse modulation settings for 
// external modulation source
// ******************************************************************
// Select the external modulation source
SOURce:PULM:SOURce EXT
// Set the polarity of the externally applied modulation signal.
SOURce:PULM:POLarity NORMal
// Select the impedance for the external pulse modulation trigger input 
SOURce:PULM:TRIGger:EXTernal:IMPedance G10K

// ******************************************************************
// Configure the pulse generator settings
// ******************************************************************
// Set pulse period
SOURce:PULM:PERiod 10 us
// Set pulse width
SOURce:PULM:WIDth 8 us
// Set double pulse width
SOURce:PULM:DOUBle:WIDTh 0.0000012
// Set double pulse delay
SOURce:PULM:DOUBle:DELay 0.0000045

// ******************************************************************
// Activate the signal output
// ******************************************************************
SOURce:PGENerator:OUTPut:STATe 1
SOURce:PULM:STATe 1
OUTPut1:STATe 1

[:SOURce<hw>]:PULM:DELay........................................................................................ 517
[:SOURce<hw>]:PULM:DOUBle:DELay............................................................................517
[:SOURce<hw>]:PULM:DOUBle:WIDTh........................................................................... 517
[:SOURce<hw>]:PULM:MODE........................................................................................ 517
[:SOURce<hw>]:PULM:PERiod....................................................................................... 518
[:SOURce<hw>]:PULM:POLarity..................................................................................... 518
[:SOURce<hw>]:PULM:SOURce..................................................................................... 518
[:SOURce<hw>]:PULM:STATe.........................................................................................519
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[:SOURce<hw>]:PULM:TRIGger:EXTernal:GATE:POLarity.................................................519
[:SOURce<hw>]:PULM:TRIGger:EXTernal:IMPedance...................................................... 519
[:SOURce<hw>]:PULM:TRIGger:EXTernal:SLOPe............................................................ 519
[:SOURce<hw>]:PULM:TRIGger:MODE........................................................................... 520
[:SOURce<hw>]:PULM:WIDTh........................................................................................520

[:SOURce<hw>]:PULM:DELay <Delay>

Sets the pulse delay.

Parameters:
<Delay> float

Range: 0  to  100 s
Increment: 10 ns
*RST: 10 ns

Example: PULM:DEL 13 us
13 us elapse after a trigger before the first pulse is generated.

[:SOURce<hw>]:PULM:DOUBle:DELay <Delay>

Sets the delay from the start of the first pulse to the start of the second pulse.

Parameters:
<Delay> float

Range: 40 ns  to  100 s
Increment: 10 ns
*RST: 1 ns

Example: PULM:DOUB:DEL 22 us
22 us elapse between the beginning of the first pulse and the
beginning of the second pulse in double-pulse mode.

Manual operation: See "Double Pulse Delay" on page 258

[:SOURce<hw>]:PULM:DOUBle:WIDTh <Width>

Sets the width of the second pulse in case of double pulse generation.

Example: PULM:DOUB:WIDT 33 us
sets a width of 33 us for the second pulse.

Manual operation: See "Double Pulse Width" on page 258

[:SOURce<hw>]:PULM:MODE <Mode>

Sets the mode of the pulse generator.

Parameters:
<Mode> SINGle | DOUBle

SINGle
Enables single pulse generation.
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DOUBle
Enables double pulse generation. The two pulses are generated
in one pulse period.
*RST: SINGle

Example: PULM:MODE DOUB
enables double pulse generation.

Manual operation: See "Pulse Mode" on page 258

[:SOURce<hw>]:PULM:PERiod <Period>

Sets the period of the generated pulse. The period determines the repetition frequency
of the internal signal.

Example: PULM:PER 220 us
the pulse period is 220 us.

Manual operation: See "Pulse Period" on page 258

[:SOURce<hw>]:PULM:POLarity <Polarity>

Parameters:
<Polarity> NORMal | INVerted

NORMal
The RF signal is suppressed during the pulse pause.
INVerted
The RF signal is suppressed during the pulse.
*RST: NORMal

Example: PULM:POL INV
selects inverted polarity.

Manual operation: See "Polarity" on page 257

[:SOURce<hw>]:PULM:SOURce <Source>

Selects the source for pulse modulation.

Parameters:
<Source> INTernal | EXTernal

INTernal
The internal pulse generator is used for the pulse modulation.
EXTernal
The signal applied externally via the trigger connector is used for
the pulse modulation.
*RST: INTernal

Manual operation: See "Source" on page 257
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[:SOURce<hw>]:PULM:STATe <State>

Activates the pulse modulation.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: PULM:STAT ON
activates pulse modulation.

Manual operation: See "State" on page 257

[:SOURce<hw>]:PULM:TRIGger:EXTernal:GATE:POLarity <Polarity>

Selects the polarity of the Gate signal.

Parameters:
<Polarity> NORMal | INVerted

*RST: NORMal

Example: PULM:TRIG:EXT:GATE:POL NORM
The pulse signal is generated while the gate signal is high.

Manual operation: See "Gate Input Polarity" on page 260

[:SOURce<hw>]:PULM:TRIGger:EXTernal:IMPedance <Impedance>

Selects the impedance for external pulse trigger.

Parameters:
<Impedance> G50 | G10K

*RST: G50

Example: SOUR:PULM:TRIG:EXT:IMP G50
selects 50 Ohm as the trigger impedance for the external pulse
trigger.

Manual operation: See "External Impedance" on page 257

[:SOURce<hw>]:PULM:TRIGger:EXTernal:SLOPe <Slope>

Parameters:
<Slope> NEGative | POSitive

*RST: POSitive

Example: PULM:TRIG:EXT:SLOP NEG
The pulse generator is triggered on the negative slope of the
external trigger signal.

Manual operation: See "Ext. Trigger Input Slope" on page 260
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[:SOURce<hw>]:PULM:TRIGger:MODE <Mode>

Selects the trigger mode for pulse modulation.

Parameters:
<Mode> AUTO | EXTernal | EGATe

AUTO
The pulse modulation is generated continuously.
EXTernal
The pulse modulation is triggered by an external trigger event.
The trigger signal is supplied via the trigger connector.
EGATe
The pulse modulation is gated by an external gate signal. The
trigger signal is supplied via the trigger connector.
*RST: AUTO

Example: PULM:TRIG:MODE EXT
selects triggering by an external trigger event.

Manual operation: See "Trigger Mode" on page 260

[:SOURce<hw>]:PULM:WIDTh <Width>

Sets the width of the generated pulse. The width determines the pulse length. The
pulse width must be at least 20ns less than the set pulse period.

Example: PULM:WIDT 33 us
sets a width of 33 us for the pulse.

Manual operation: See "Pulse Width" on page 258

10.14.17  SOURce:POWer subsystem

[:SOURce]:POWer:ALC:DSENsitivity............................................................................... 521
[:SOURce]:POWer:ALC:SONCe...................................................................................... 521
[:SOURce]:POWer:ALC[:STATe]...................................................................................... 521
[:SOURce]:POWer:ATTenuation:DIGital............................................................................521
[:SOURce]:POWer:ATTenuation:RFOFf:MODE................................................................. 522
[:SOURce]:POWer:ATTenuation:SOVer[:OFFSet]..............................................................522
[:SOURce]:POWer:LIMit[:AMPLitude]...............................................................................522
[:SOURce]:POWer:LMODe............................................................................................. 522
[:SOURce]:POWer:POWer..............................................................................................523
[:SOURce]:POWer:PEP?................................................................................................ 523
[:SOURce]:POWer:SCHaracteristic..................................................................................523
[:SOURce]:POWer:SERVoing:SENSor............................................................................. 524
[:SOURce]:POWer:SERVoing:SENSor:APERture..............................................................524
[:SOURce]:POWer:SERVoing:SET?.................................................................................524
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[:SOURce]:POWer:SERVoing:TOLerance.........................................................................525
[:SOURce]:POWer:SERVoing:TRACking.......................................................................... 526
[:SOURce]:POWer[:LEVel][:IMMediate][:AMPLitude]..........................................................526
[:SOURce]:POWer[:LEVel][:IMMediate]:OFFSet................................................................ 526
[:SOURce]:POWer:RANGe:LOWer?................................................................................ 526
[:SOURce]:POWer:RANGe:UPPer?................................................................................. 526
[:SOURce]:POWer:WIGNore...........................................................................................527

[:SOURce]:POWer:ALC:DSENsitivity <Sensitivity>

Sets the power detector sensitivity. Used for compatibility reasons only.

Parameters:
<Sensitivity> OFF | LOW | MED | HIGH

*RST: OFF

Manual operation: See "Detector Sensitivity" on page 230

[:SOURce]:POWer:ALC:SONCe

Briefly activates level control for correction purposes.

Usage: Event

Manual operation: See "Readjust" on page 227

[:SOURce]:POWer:ALC[:STATe] <State>

Activates/deactivates automatic level control.

Parameters:
<State> 1 | OFFTable | OFF | ONTable | AUTO | ON

*RST: ONTable

Manual operation: See "State" on page 230

[:SOURce]:POWer:ATTenuation:DIGital <AttDigital>

Sets a relative attentuation value for the baseband signal.

Parameters:
<AttDigital> float

Range: 0  to  80
Increment: 1E-3
*RST: 0
Default unit: dB

Manual operation: See "Digital Attenuation" on page 225
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[:SOURce]:POWer:ATTenuation:RFOFf:MODE <Mode>

Determines the attenuator's state after the instrument is switched on.

Parameters:
<Mode> MAX | FATTenuated | FIXed | UNCHanged

MAX = FATTenuated
Sets attenuation to maximum when the RF signal is switched off.
This setting is recommended for applications that require a high
level of noise suppression.
FIXed = UNCHanged
Retains the current setting and keeps the output impedance
constant during RF off.
*RST: n.a. (factory preset: MAX)

Manual operation: See "RF-Off-Mode" on page 228

[:SOURce]:POWer:ATTenuation:SOVer[:OFFSet] <Offset>

Sets the switch-over offset value of the attenuator.

Parameters:
<Offset> float

Range: -10  to  10
Increment: 0.1
*RST: 0

Manual operation: See "SATT Switch-Over Offset" on page 228

[:SOURce]:POWer:LIMit[:AMPLitude] <Amplitude>

Sets the upper limit of the RF signal power.

An instrument preset does not affect this value. A factory preset (SYST:FPR) sets the
specified factory upper limit value.

Parameters:
<Amplitude> float

Range: -120  to  25
Increment: 0.01
*RST: n.a. (factory preset: 25)

Manual operation: See "Limit" on page 227

[:SOURce]:POWer:LMODe <LevMode>

Selects the level mode.

Parameters:
<LevMode> NORMal | LOWNoise | LOWDistortion
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NORM
automatic selection of the best settings
LNOISe
settings for lowest noise
LDIStortion
settings for lowest distortions
*RST: n.a. (factory preset: NORMal)

Manual operation: See "Mode" on page 226

[:SOURce]:POWer:POWer <Amplitude>

Sets the level at the RF output connector.

This value does not consider a specified offset. The command [:SOURce]:POWer[:
LEVel][:IMMediate][:AMPLitude] sets the level of the "Level" display, that
means the level containing offset.

Parameters:
<Amplitude> float

Range: -20  to  25
Increment: 0.01
*RST: -10

Example: POW:POW 15
sets the RF level at output to 15 dBm.

Manual operation: See "Level/Level Offset" on page 68

[:SOURce]:POWer:PEP?

Queries the RF signal peak envelope power.

Return values: 
<PEP> float

Usage: Query only

[:SOURce]:POWer:SCHaracteristic <Characteristic>

Selects the characteristic for the level setting.

Parameters:
<Characteristic> AUTO | UNINterrupted | CVSWr | USER | MONotone

UNINterrupted
uninterrupted level setting
CVSWr
constant-VSWR
MONotone
strictly monotone
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*RST: AUTO

Manual operation: See "Setting Characteristic" on page 226

[:SOURce]:POWer:SERVoing:SENSor <Sensor>

Sets the power sensor as mapped with the remote command :SLISt:
ELEMent<ch>:MAPPing on page 380.

Parameters:
<Sensor> SENS1 | SENS2 | SENSor2 | SENS3 | SENSor3 | SENS4 |

SENSor4 | SENSor1 | UNDefined
*RST: n.a. (no preset. default: SENS1)

Manual operation: See "Sensor" on page 241

[:SOURce]:POWer:SERVoing:SENSor:APERture <Aperture>

Sets the aperture time (size of the acquisition interval) of the power sensor during
power servoing.

Parameters:
<Aperture> float

Range: 10e-6  to  100e-3
Increment: 1e-6
*RST: 100e-6

Manual operation: See "Sensor Aperture Time" on page 242

[:SOURce]:POWer:SERVoing:SET? <Target>

Sets the target output power level and queries power servoing procedure status.

Parameters:
<Target> float

Starts a single power servoing setting cycle, see "About power
servoing" on page 239.
Sets the desired output power level required at the DUT, see[:
SOURce]:POWer:SERVoing:TARGet on page 525.

Return values: 
<Start> 0 | 1 | RUNning | STOPped

Queries the current status of the powerservoing procedure.
0|RUNning
Procedure is ok and or running without errors.
1|STOPped
Procedure is stopped due to an error.
*RST: n.a. (no preset. default: STOPped)

Usage: Query only

SOURce subsystem



Remote control commandsR&S®SGT100A

525User Manual 1176.8674.02 ─ 12

Manual operation: See "Start" on page 242

[:SOURce]:POWer:SERVoing:STATe <State>

Activates/deactivates power servoing.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "State" on page 241

[:SOURce]:POWer:SERVoing:TARGet <Targetlevel>

Sets the target output power level required at the DUT.

Parameters:
<Targetlevel> float

Range: -120  to  25
Increment: 0.01
*RST: n.a. (factory preset: -10)

Manual operation: See "Target" on page 241

[:SOURce]:POWer:SERVoing:TEST?

Queries the state of the power servoing procedure.

Return values: 
<Start> 0 | 1 | RUNning | STOPped

*RST: n.a. (no preset. default: STOPped)

Usage: Query only

Manual operation: See "Run Test" on page 299

[:SOURce]:POWer:SERVoing:TOLerance <Tolerance>

Sets the tolerance level interval, in which the "Target" output power level of the DUT
lies.

A large tolerance accelerates the power servoing procedure but also reduces the accu-
racy of the target output power level.

Parameters:
<Tolerance> float

Range: 0.01  to  3
Increment: 0.01
*RST: n.a. (factory preset: 0.1)

Manual operation: See "Tolerance" on page 242

SOURce subsystem



Remote control commandsR&S®SGT100A

526User Manual 1176.8674.02 ─ 12

[:SOURce]:POWer:SERVoing:TRACking <State>

Activates/deactivates level tracking. Activation increases measurement accuracy but
also measurement time.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "Level Tracking (500 ms)" on page 242

[:SOURce]:POWer[:LEVel][:IMMediate][:AMPLitude] <Amplitude>

Sets the RF level at the RF output connector of the instrument.

Parameters:
<Amplitude> float

Range: -120  to  25
Increment: 0.01
*RST: -10
Default unit: dBm

Manual operation: See "Level/Level Offset" on page 68

[:SOURce]:POWer[:LEVel][:IMMediate]:OFFSet <Offset>

Specifies the constant level offset of a downstream attenuator/amplifier. If a level offset
is entered, the level entered with :POWer no longer corresponds to the RF output
level.

The following correlation applies:

:POWer = RF output level + POWer:OFFSet.

Entering a level offset does not change the RF output level, but rather the query value
of :POWer.

Only dB is permitted as the unit here. The linear units (V, W, etc.) are not permitted.

Parameters:
<Offset> float

Range: -100  to  100
Increment: 0.1
*RST: 0

Manual operation: See "Offset / Offset (Gain)" on page 225

[:SOURce]:POWer:RANGe:LOWer?
[:SOURce]:POWer:RANGe:UPPer?
Queries the minimum/maximum level range in the current level mode
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Return values: 
<Upper> float

Usage: Query only

Manual operation: See "Level Range" on page 226

[:SOURce]:POWer:WIGNore <State>

Ignores level range warnings.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: n.a. (factory preset: 0)

Example: POW:WIGN ON
suppresses the level range warnings.

10.14.18  SOURce:ROSCillator subsystem

[:SOURce]:ROSCillator:SOURce..................................................................................... 527
[:SOURce]:ROSCillator:EXTernal:FREQuency.................................................................. 527
[:SOURce]:ROSCillator:OUTPut:FREQuency....................................................................528
[:SOURce]:ROSCillator:EXTernal:SBANdwidth..................................................................528
[:SOURce]:ROSCillator[:INTernal]:ADJust[:STATe].............................................................528
[:SOURce]:ROSCillator[:INTernal]:ADJust:VALue.............................................................. 529

[:SOURce]:ROSCillator:SOURce <Source>

Select the reference oscillator signal source.

Parameters:
<Source> INTernal | EXTernal

Manual operation: See "Ref. Oscillator Source/Ext Ref On/Off" on page 68

[:SOURce]:ROSCillator:EXTernal:FREQuency <ExtFreq>

Selects the frequency of the external reference.

Parameters:
<ExtFreq> 10MHZ | 100MHZ | 1000MHZ | 13MHZ

13MHZ requires RF board with part number 1419.5308.02.
To find out the RF board installed in the instrument:
Select "SGMA-GUI > instrument name > Setup > Hardware
Config" > "RF Assembly"
Observe the part number of the assembly "RfBoard".

Manual operation: See "Ext. Ref. Input Frequency" on page 222
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[:SOURce]:ROSCillator:OUTPut:FREQuency <OutputFreq>

Selects the output for the reference oscillator signal.

Parameters:
<OutputFreq> 10MHZ | 100MHZ | 1000MHZ | 13MHZ

13MHZ requires RF board with part number 1419.5308.02.

Manual operation: See "Output Frequency" on page 222

[:SOURce]:ROSCillator:EXTernal:SBANdwidth <SBandwidth>

Sets the synchronization bandwidth for an external reference signal.

Parameters:
<SBandwidth> WIDE | NARRow

NARRow
The synchronization bandwidth is.
WIDE
Synchronization bandwidth is.
*RST: n.a. (factory preset)

Example: ROSC:SOUR EXT
Selects the external source.
ROSC:EXT:FREQ 10 MHz
Informs the instrument that the external reference has a fre-
quency of 10 MHz.
ROSC:EXT:SBAN WID
Selects wideband setting for synchronization bandwidth.

Manual operation: See "Synchronization Bandwidth" on page 222

[:SOURce]:ROSCillator[:INTernal]:ADJust[:STATe] <State>

Determines whether the calibrated (OFF) or a user-defined (ON) adjustment value is
used for fine adjustment of the frequency.

If user-defined values are used, the instrument is no longer in the calibrated state.
However, the calibration value is not changed and the instrument resumes the calibra-
ted state after sending the com-
mand :SOURce:ROSCillator:INTernal:ADJust:STATe OFF.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: n.a. (factory preset: 0)

Example: ROSC:SOUR INT
Selects the internal source.
ROSC:ADJ ON
Activates use of a user-defined adjustment value.
ROSC:ADJ:VAL 1400
Sets the adjustment value to 1400.
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Manual operation: See "Adjustment Active" on page 223

[:SOURce]:ROSCillator[:INTernal]:ADJust:VALue <Value>

Allows an application to shift the reference oscillator frequency by a small amount.

The setting range depends on the reference oscillator type and its factory calibration
value. Allowed are the following ranges:

● For TCXO oscillator: Max - Min = 1023
● For OCXO oscillator: Max - Min = 65535 (option R&S SGT-B1 required.)

Parameters:
<Value> integer

Range: Min  to  Max
*RST: 0

Manual operation: See "DAC Value" on page 223

10.15  STATus subsystem

This system contains the commands for the status reporting system. See also Chap-
ter 9.5, "Status reporting system", on page 329 for detailed information.

*RST on page 351 has no effect on the status registers.

Value ranges

● Queries return the current value of the respective register, which permits a check of
the device status.
Return values: A decimal value in the range 0 to 32767 (=215-1)

● The configuration commands set the respective register thus determining which
status changes of the R&S SGT cause the status registers to be changed.
Setting values: A decimal value in the range 0 to 32767 (=215-1)

:STATus:OPERation:CONDition?.....................................................................................530
:STATus:OPERation:ENABle...........................................................................................530
:STATus:OPERation[:EVENt]...........................................................................................530
:STATus:OPERation:NTRansition.................................................................................... 530
:STATus:OPERation:PTRansition.....................................................................................531
:STATus:PRESet............................................................................................................531
:STATus:QUEStionable:CONDition.................................................................................. 531
:STATus:QUEStionable:ENABle.......................................................................................531
:STATus:QUEStionable[:EVENt]...................................................................................... 532
:STATus:QUEStionable:NTRansition................................................................................ 532
:STATus:QUEStionable:PTRansition................................................................................ 532
:STATus:QUEue[:NEXT]?................................................................................................532
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:STATus:OPERation:CONDition?

Quieries the content of the CONDition part of the STATus:OPERation register.

This part contains information on the action currently being performed in the instru-
ment. The content is not deleted after being read out because it indicates the current
hardware status.

Return values: 
<Condition> string

Example: :STATus:OPERation:CONDition?

Usage: Query only

:STATus:OPERation:ENABle <Enable>

Sets the bits of the ENABle part of the STATus:OPERation register. This setting deter-
mines which events of the Status-Event part are forwarded to the sum bit in the status
byte. These events can be used for a service request.

Parameters:
<Enable> string

Example: :STAT:OPER:ENAB 32767
all events are forwarded to the sum bit of the status byte.

:STATus:OPERation[:EVENt] <Event>

Queries the content of the EVENt part of the STATus:OPERation register. This part
contains information on the actions performed in the instrument since the last readout.
The content of the EVENt part is deleted after being read out.

Parameters:
<Event> string

Example: :STAT:OPER:EVEN?
queries the STATus:OPERation:EVENt register.

:STATus:OPERation:NTRansition <Ntransition>

Sets the bits of the NTRansition part of the STATus:OPERation register. If a bit is set, a
transition from 1 to 0 in the condition part causes an entry to be made in the EVENt
part of the register. The disappearance of an event in the hardware is thus registered,
for example the end of an adjustment.

Parameters:
<Ntransition> string

Example: :STAT:OPER:NTR 0
a transition from 1 to 0 in the condition part of the Status:Opera-
tion register does not cause an entry to be made in the EVENt
part.
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:STATus:OPERation:PTRansition <Ptransition>

Sets the bits of the PTRansition part of the STATus:OPERation register. If a bit is set, a
transition from 0 to 1 in the condition part causes an entry to be made in the EVENt
part of the register. A new event in the hardware is thus registered, for example the
start of an adjustment.

Parameters:
<Ptransition> string

Example: :STAT:OPER:PTR 32767
all transitions from 0 to 1 in the condition part of the Status:Oper-
ation register cause an entry to be made in the EVENt part.

:STATus:PRESet <Preset>

Resets the status registers. All PTRansition parts are set to FFFFh (32767), i.e. all
transitions from 0 to 1 are detected. All NTRansition parts are set to 0, i.e. a transition
from 1 to 0 in a CONDition bit is not detected. The ENABle parts of STATus:OPERation
and STATus:QUEStionable are set to 0, i.e. all events in these registers are not passed
on.

Parameters:
<Preset> string

Example: STAT:PRES
resets the status registers.

:STATus:QUEStionable:CONDition <Condition>

Queries the content of the CONDition part of the STATus:QUEStionable register. This
part contains information on the action currently being performed in the instrument.
The content is not deleted after being read out since it indicates the current hardware
status.

Parameters:
<Condition> string

Example: :STATus:QUEStionable:CONDition?
queries the Status:Questionable:Condition register.

:STATus:QUEStionable:ENABle <Enable>

Sets the bits of the ENABle part of the STATus:QUEStionable register. The enable part
determines which events of the STATus:EVENt part are enabled for the summary bit in
the status byte. These events can be used for a service request.

If a bit in the ENABle part is 1, and the correesponding EVENt bit is true, a positive
transition occurs in the summary bit. This transition is reportet to the next higher level.

Parameters:
<Enable> string
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Example: STAT:QUES:ENAB 1
Problems when performing an adjustment cause an entry to be
made in the sum bit.

:STATus:QUEStionable[:EVENt] <Event>

Queries the content of the EVENt part of the STATus:QUEStionable register. This
part contains information on the actions performed in the instrument since the last
readout. The content of the EVENt part is deleted after being read out.

Parameters:
<Event> string

Example: STAT:QUES:EVEN?
queries the Status:Questionable:Event register.

:STATus:QUEStionable:NTRansition <Ntransition>

Sets the bits of the NTRansition part of the STATus:QUEStionable register. If a bit is
set, a transition from 1 to 0 in the condition part causes an entry to be made in the
EVENt part of the register.

Parameters:
<Ntransition> string

Example: STAT:QUES:NTR 0
a transition from 1 to 0 in the condition part of the STA-
Tus:QUEStionable register does not cause an entry to be made
in the EVENt part

:STATus:QUEStionable:PTRansition <PTransition>

Sets the bits of the NTRansition part of the STATus:QUEStionable register. If a bit is
set, a transition from 1 to 0 in the condition part causes an entry to be made in the
EVENt part of the register.

Parameters:
<PTransition> string

Example: STAT:QUES:PTR 32767
all transitions from 0 to 1 in the condition part of the STA-
Tus:QUEStionable register cause an entry to be made in the
EVENt part

:STATus:QUEue[:NEXT]?

Queries the oldest entry in the error queue and then deletes it. Positive error numbers
denote device-specific errors, and negative error numbers denote error messages
defined by SCPI. If the error queue is empty, 0 ("No error") is returned.

The command is identical to :SYSTem:ERRor[:NEXT]? on page 537.
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Return values: 
<Next> string

Example: :STATus:QUEue?
queries the oldest entry in the error queue.
Response: 0, 'no error'
no errors have occurred since the error queue was last read out

Usage: Query only

10.16  SYSTem subsystem

The SYSTem subsystem contains a series of commands for general functions which do
not directly affect signal generation.

Example: Retrieving information on network-related settings
SYSTem:COMMunicate:NETWork:STATus?
// 1
SYSTem:PROTection1:STATe 0,123456

SYSTem:COMMunicate:NETWork:IPADdress:MODE STAT
SYSTem:COMMunicate:NETWork:IPADdress "10.113.0.104"
SYSTem:COMMunicate:NETWork:IPADdress:DNS "10.0.2.166"
SYSTem:COMMunicate:NETWork:COMMon:HOSTname?
// "SGT100A-101652"
SYSTem:COMMunicate:NETWork:IPADdress:GATeway "10.113.0.1"
SYSTem:COMMunicate:NETWork:IPADdress:SUBNet:MASK "255.255.252.0"
SYSTem:COMMunicate:NETWork:MACaddress "08 00 27 a3 a1 70"
SYSTem:PROTection1:STATe 1

Disabling LAN services

► NOTICE! Risk of loosing access over LAN. Disabling the LAN interface or the com-
mon services "LAN", "SCPI over LAN", "VNC" and "HTTP" locks the remote access
to the instrument.
Use the commands in Example"To disable the LAN interface and LAN services"
on page 533 to disable or enable the LAN interface and LAN interface services
individually.

a) For the first parameter of the command, enter the security password of your
instrument.
The default password is 123456.

b) For the second parameter of the command, enter the state: 1 (ON), 0 (OFF)

Example: To disable the LAN interface and LAN services
// *****************************************************************************
// Disable the LAN interface.
// *****************************************************************************
SYSTem:SECurity:NETWork:STATe "<password>", 0
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// *****************************************************************************
// Disable the LAN services individually.
// *****************************************************************************
SYSTem:SECurity:NETWork:RAW:STATe "<password>", 0
// Disables remote access over raw socket. 
SYSTem:SECurity:NETWork:SOE:STATe "<password>", 0
// Disables SCPI over Ethernet/LAN communication.
SYSTem:SECurity:NETWork:HTTP:STATe "<password>", 0
// Disables remote access over HTTP.
SYSTem:SECurity:NETWork:RPC:STATe "<password>", 0
// Disables remote access over remote procedure call (RPC).
SYSTem:SECurity:NETWork:SSH:STATe "<password>", 0
// Disables SSH network protocol that is used for service purposes.
SYSTem:SECurity:NETWork:FTP:STATe "<password>", 0
//    Disables FTP for file transfer.
SYSTem:SECurity:NETWork:SMB:STATe "<password>", 0
// Disables shared access over SMB.
SYSTem:SECurity:NETWork:AVAHi:STATe "<password>", 0
// Disables Avahi service for automatic instrument configuration in the network.
SYSTem:SECurity:NETWork:SWUPdate:STATe "<password>", 0
// Disables software updates over LAN.

:SYSTem:ERRor:ALL?....................................................................................................535
:SYSTem:ERRor:CODE:ALL?......................................................................................... 536
:SYSTem:ERRor:CODE[:NEXT]?.....................................................................................536
:SYSTem:ERRor:COUNt?...............................................................................................537
:SYSTem:ERRor[:NEXT]?...............................................................................................537
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:SYSTem:VERSion?.......................................................................................................538
:SYSTem:COMMunicate:GPIB:LTERminator.....................................................................538
:SYSTem:COMMunicate:GPIB:RESource?....................................................................... 538
:SYSTem:COMMunicate:GPIB[:SELF]:ADDRess...............................................................539
:SYSTem:COMMunicate:NETWork:IPADdress.................................................................. 539
:SYSTem:COMMunicate:NETWork:IPADdress:MODE........................................................539
:SYSTem:COMMunicate:NETWork:MACaddress...............................................................539
:SYSTem:COMMunicate:NETWork:STATus?.................................................................... 540
:SYSTem:COMMunicate:NETWork:RESTart..................................................................... 540
:SYSTem:COMMunicate:NETWork[:COMMon]:HOSTname................................................540
:SYSTem:COMMunicate:NETWork[:IPADdress]:DNS.........................................................540
:SYSTem:COMMunicate:NETWork[:IPADdress]:GATeway..................................................540
:SYSTem:COMMunicate:NETWork[:IPADdress]:SUBNet:MASK..........................................541
:SYSTem:COMMunicate:NETWork:RESource?.................................................................541
:SYSTem:COMMunicate:SERial:BAUD............................................................................ 541
:SYSTem:COMMunicate:SERial:PARity............................................................................541
:SYSTem:COMMunicate:SERial:RESource?.....................................................................542
:SYSTem:COMMunicate:SERial:SBITs.............................................................................542
:SYSTem:COMMunicate:HISLip:RESource?..................................................................... 542
:SYSTem:COMMunicate:PCIexpress:RESource?.............................................................. 542
:SYSTem:COMMunicate:SOCKet:PORT...........................................................................543
:SYSTem:COMMunicate:SOCKet:RESource?...................................................................543
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:SYSTem:COMMunicate:USB:RESource?........................................................................ 543
:SYSTem:IDENtification.................................................................................................. 544
:SYSTem:KLOCk........................................................................................................... 544
:SYSTem:LANGuage......................................................................................................544
:SYSTem:NINFormation?................................................................................................545
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:SYSTem:RESTart..........................................................................................................545
:SYSTem:SECurity:NETWork:AVAHi[:STATe].................................................................... 545
:SYSTem:SECurity:NETWork:FTP[:STATe]....................................................................... 545
:SYSTem:SECurity:NETWork:HTTP[:STATe].....................................................................546
:SYSTem:SECurity:NETWork:RAW[:STATe]......................................................................546
:SYSTem:SECurity:NETWork:REMSupport[:STATe]...........................................................546
:SYSTem:SECurity:NETWork:RPC[:STATe].......................................................................546
:SYSTem:SECurity:NETWork:SMB[:STATe]...................................................................... 547
:SYSTem:SECurity:NETWork:SOE[:STATe].......................................................................547
:SYSTem:SECurity:NETWork:SSH[:STATe].......................................................................547
:SYSTem:SECurity:NETWork:SWUPdate[:STATe]............................................................. 548
:SYSTem:SECurity:NETWork[:STATe].............................................................................. 548
:SYSTem:SHUTdown..................................................................................................... 548
:SYSTem:STARtup:COMPlete?....................................................................................... 548
:SYSTem:PROTect<ch>[:STATe]......................................................................................549
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:SYSTem:TIME:ZONE:CATalog?......................................................................................549
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:SYSTem:UPTime?........................................................................................................ 550
:SYSTem:MMEMory:PATH:USER?.................................................................................. 550
:SYSTem:SECurity:VOLMode[:STATe]..............................................................................550

:SYSTem:ERRor:ALL?

Queries the error/event queue for all unread items and removes them from the queue.

Return values: 
<All> string

Error/event_number,"Error/event_description>[;Device-depend-
ent info]"
A comma separated list of error number and a short description
of the error in FIFO order.
If the queue is empty, the response is 0,"No error"
Positive error numbers are instrument-dependent. Negative
error numbers are reserved by the SCPI standard.
Volatile errors are reported once, at the time they appear. Identi-
cal errors are reported repeatedly only if the original error has
already been retrieved from (and hence not any more present in)
the error queue.

Example: SYSTem:ERRor:ALL? 
// queries all entries in the error queue. 
Response: 0, 'no error' 
// no errors have occurred since the error queue was last read out.
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Usage: Query only

:SYSTem:ERRor:CODE:ALL?

Queries the error numbers of all entries in the error queue and then deletes them.

Return values: 
<All> string

Returns the error numbers. To retrieve the entire error text, send
the command :SYSTem:ERRor:ALL?.
0
"No error", i.e. the error queue is empty
Positive value
Positive error numbers denote device-specific errors
Negative value
Negative error numbers denote error messages defined by
SCPI.

Example: SYSTem:ERRor:CODE:ALL? 
// queries all entries in the error queue. 
Response: 0 
// no errors have occurred since the error queue was last read out.

Usage: Query only

:SYSTem:ERRor:CODE[:NEXT]?

Queries the error number of the oldest entry in the error queue and then deletes it.

Return values: 
<Next> string

Returns the error number. To retrieve the entire error text, send
the command :SYSTem:ERRor:ALL?.
0
"No error", i.e. the error queue is empty
Positive value
Positive error numbers denote device-specific errors
Negative value
Negative error numbers denote error messages defined by
SCPI.

Example: SYSTem:ERRor:CODE:NEXT? 
// queries the oldest entry in the error queue. 
Response: 0 
// no errors have occurred since the error queue was last read out.

Usage: Query only
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:SYSTem:ERRor:COUNt?

Queries the number of entries in the error queue.

Return values: 
<Count> integer

0
The error queue is empty.

Example: SYSTem:ERRor:COUNt? 
// queries the number of entries in the error queue. 
Response: 1 
// one error has occurred since the error queue was last read out.

Usage: Query only

:SYSTem:ERRor[:NEXT]?

Queries the error/event queue for the oldest item and removes it from the queue.

Return values: 
<Next> string

Error/event_number,"Error/event_description>[;Device-depend-
ent info]"
Error number and a short description of the error.
If the queue is empty, the response is 0,"No error"
Positive error numbers are instrument-dependent. Negative
error numbers are reserved by the SCPI standard.
Volatile errors are reported once, at the time they appear. Identi-
cal errors are reported repeatedly only if the original error has
already been retrieved from (and hence not any more present in)
the error queue.

Example: SYSTem:ERRor:NEXT? 
// queries the oldest entry in the error queue. 
Response: 0, 'no error' 
// no errors have occurred since the error queue was last read out.

Usage: Query only

:SYSTem:SERRor?

Returns a list of all errors existing at the time when the query is started. This list corre-
sponds to the display on the info page under manual control.

Return values: 
<Serror> string

Example: SYST:SERR
queries all errors existing in the error queue.
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Example: Response: -221, 'Settings conflict', 153,
'Input voltage out of range'
The two returned errors have occurred since the error queue
was last queried.

Usage: Query only

:SYSTem:VERSion?

Queries the SCPI version the instrument's command set complies with.

Return values: 
<Version> string

Example: SYSTem:VERSion 
// queries the SCPI version. 
Response: "1996" 
// the instrument complies with the SCPI version from 1996.

Usage: Query only

:SYSTem:COMMunicate:GPIB:LTERminator <LTerminator>

Sets the terminator recognition for remote control via GPIB bus.

Parameters:
<LTerminator> STANdard | EOI

EOI
The terminator must be sent together with the line message EOI
(End of Line). This setting is recommended for binary block
transmissions where a character could coincidentally have the
value LF (Line Feed) but is not intended as the terminator. This
setting must be selected for block data with undefined length.
STANdard
An LF (Line Feed) is recognized as the terminator regardless of
whether it is sent with or without EOI.
*RST: n.a. (factory preset: STANdard)

Example: SYSTem:COMMunicate:GPIB:LTERminator EOI
Only a character which is sent simultaneously with the line mes-
sage EOI is accepted as the terminator.

:SYSTem:COMMunicate:GPIB:RESource?

Queries the VISA resource string for remote control via the GPIB interface.

To change the GPIB address, use the command :SYSTem:COMMunicate:GPIB[:
SELF]:ADDRess.

Return values: 
<Resource> string
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Example: SYSTem:COMMunicate:GPIB:RESource?
queries the VISA resource string.
Response: "GPIB::28::INSTR"'

Usage: Query only

:SYSTem:COMMunicate:GPIB[:SELF]:ADDRess <Address>

Sets the GPIB address.

Parameters:
<Address> integer

Range: 0  to  30
*RST: n.a. (factory preset: 28)

Example: SYSTem:COMMunicate:GPIB:SELF:ADDRess 28
Sets GPIB address.

:SYSTem:COMMunicate:NETWork:IPADdress <IpAddress>

Sets the IP address.

Parameters:
<IpAddress> string

Range: 0.0.0.0.  to  ff.ff.ff.ff

Example: SYSTem:COMMunicate:NETWork:IPADdress "7.8.9.10"
sets the IP address of the instrument.

Manual operation: See "IP Address" on page 288

:SYSTem:COMMunicate:NETWork:IPADdress:MODE <Mode>

Selects manual or automatic setting of the IP address.

Parameters:
<Mode> AUTO | STATic

*RST: n.a. (factory preset: AUTO)

Example: SYSTem:COMMunicate:NETWork:IPADdress:MODE AUTO
The IP address is assigned automatically (DHCP)

Manual operation: See "Address Mode" on page 288

:SYSTem:COMMunicate:NETWork:MACaddress <MacAddress>

Queries the MAC address of the network adapter.

Parameters:
<MacAddress> string

Example: SYST:COMM:NETW:MAC
queries the MAC address.
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:SYSTem:COMMunicate:NETWork:STATus?

Queries the network configuration state.

Return values: 
<State> 0 | 1 | OFF | ON

Usage: Query only

:SYSTem:COMMunicate:NETWork:RESTart

Restarts the network connection to the instrument, terminates the connection and sets
it up again.

Example: SYSTem:COMMunicate:NETWork:RESTart
Usage: Event

:SYSTem:COMMunicate:NETWork[:COMMon]:HOSTname <Hostname>

Sets the individual host name of the R&S SGT.

Note: it is recommended that you do not change the host name in order to avoid prob-
lems with the networdk connection. However, if you change the host name be sure to
use an unique name.

The host name is a protected parameter, To change it, first disable protection level 1
with command :SYSTem:PROTect<ch>[:STATe] on page 549.

Parameters:
<Hostname> string

Example: SYSTem:PROTect1:STATe OFF,123456
SYSTem:COMMunicate:NETWork:HOSTname 'SIGGEN'
sets the individual computer name of the R&S SGT.

Manual operation: See "Hostname" on page 288

:SYSTem:COMMunicate:NETWork[:IPADdress]:DNS <DNS>

Determines or queries the network DNS server to resolve the name.

Parameters:
<DNS> string

Example: See Example"Retrieving information on network-related set-
tings" on page 533.

:SYSTem:COMMunicate:NETWork[:IPADdress]:GATeway <Gateway>

Sets the IP address of the default gateway.
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Parameters:
<Gateway> string

Range: 0.0.0.0  to  ff.ff.ff.ff

Example: SYSTem:COMMunicate:NETWork:IPADdress:GATeway
'1.2.3.4'
sets the IP address of the default gateway.

Manual operation: See "Default Gateway" on page 289

:SYSTem:COMMunicate:NETWork[:IPADdress]:SUBNet:MASK <Mask>

Sets the subnet mask.

Parameters:
<Mask> string

Example: SYSTem:COMMunicate:NETWork:IPADdress:SUBNet:
MASK '255.255.0.0'
determines the subnet mask.

Manual operation: See "Subnet Mask" on page 288

:SYSTem:COMMunicate:NETWork:RESource?

Queries the VISA resource string, used for remote control of the instrument with VXI-11
protocol.

Return values: 
<Resource> string

Example: SYSTem:COMMunicate:NETWork:RESource?
Response: "TCPIP::192.1.2.3::INSTR"

Usage: Query only

Manual operation: See "Visa Resource Strings" on page 290

:SYSTem:COMMunicate:SERial:BAUD <Baud>

Sets the baudrate for the serial remote control interface.

Parameters:
<Baud> 2400 | 4800 | 9600 | 19200 | 38400 | 57600 | 115200

*RST: n.a. (factory preset: 115200)

Example: SYSTem:COMMunicate:SERial:BAUD 115200
Sets 115200 baudrate.

:SYSTem:COMMunicate:SERial:PARity <Parity>

Sets the parity for the serial remote control interface.
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Parameters:
<Parity> NONE | ODD | EVEN

*RST: n.a. (factory preset: NONE)

Example: SYST:COMM:SER:PAR NONE
Selects parity NONE.

:SYSTem:COMMunicate:SERial:RESource?

Queries the VISA resource string for the serial remote control interface. This string is
used for remote control of the instrument.

Return values: 
<Resource> string

Example: SYSTem:COMMunicate:SERial:RESource?
queries the VISA resource string.
Response: "ASRL1::INSTR"

Usage: Query only

:SYSTem:COMMunicate:SERial:SBITs <SBits>

Sets the number of stop bits for the serial remote control interface.

Parameters:
<SBits> 1 | 2

*RST: n.a. (factory preset: 1)

Example: SYST:COMM:SER:SBIT 2
Selects 2 stop bits.

:SYSTem:COMMunicate:HISLip:RESource?

Queries the VISA resource string, used for remote control of the instrument with
HiSLIP protocol.

Return values: 
<Resource> string

Example: SYSTem:COMMunicate:HISLip:RESource?
Response: "TCPIP::192.1.2.3::hislip0::INSTR"

Usage: Query only

Manual operation: See "Visa Resource Strings" on page 290

:SYSTem:COMMunicate:PCIexpress:RESource?

Queries the visa resource string for remote control via the PCIe interface.

Return values: 
<Resource> string
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Usage: Query only

Manual operation: See "Visa Resource Strings" on page 290

:SYSTem:COMMunicate:SOCKet:PORT <ScpiEthPort>

Sets the port number for remote control via socket communication.

Parameters:
<ScpiEthPort> integer

Range: 1000  to  65535
*RST: n.a. (factory preset: 5025)

Example: SYSTem:COMMunicate:SOCKet:PORT 5030
// specifies the socket port number.

Manual operation: See "SCPI Port" on page 63

:SYSTem:COMMunicate:SOCKet:RESource?

Queries the VISA resource string for remote control via LAN interface, using TCP/IP
socket protocol.

Return values: 
<Resource> string

Example: SYSTem:COMMunicate:SOCKet:RESource?
Response: "TCPIP::10.113.1.150::5025::SOCKET"

Usage: Query only

Manual operation: See "Visa Resource Strings" on page 290

:SYSTem:COMMunicate:USB:RESource?

Queries the VISA resource string for remote control via the USB interface.

Return values: 
<Resource> string

Example: SYSTem:COMMunicate:USB:RESource?
queries the VISA resource string for remote control via the USB
interface.
Response: "USB::72::000000::INSTR"

Usage: Query only

Manual operation: See "Visa Resource Strings" on page 290
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:SYSTem:IDENtification <Identification>

Selects the mode the instrument identification is performed.

Parameters:
<Identification> AUTO | USER

AUTO
The *IDN string and the *OPT string are set automatically.
USER
Enables the selection of user definable *IDN and *OPT strings.
*RST: n.a. (factory preset: AUTO)

Example: SYST:IDEN USER
Selects the user-defined identification string.

Manual operation: See "Identification Mode" on page 293

:SYSTem:KLOCk <State>

Keyboard lock disables the front panel keys of the instrument.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: n.a. (factory preset: 0)

Example: SYST:KLOC ON
Locks the front panel and external controls. To enable the con-
trols, set SYST:KLOC OFF.

:SYSTem:LANGuage <Language>

Sets the command set to be used.

The instrument can also be remote controlled via the command set of several other
generators.

Note: While working in a emulation mode, the instrument's specific command set is
disabled, i.e. the SCPI command SYSTem:LANGuage will be discarded.

The return to the SCPI command set of the R&S SGT can only be performed by using
the appropriate command of the selected command set.

Parameters:
<Language> string

Example: SYSTem:LANGuage "SCPI"
sets the SCPI command set.

Manual operation: See "Language" on page 293
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:SYSTem:NINFormation?

Queries the oldest information message ("Error History > Level > Info") in the error/
event queue.

Return values: 
<NextInfo> string

Example: :SYSTem:NINFormation? 
// queries the oldest entry in the info message queue.
Response: 90,"Info;=== Instrument startup... ===" 
// Information message containing error number 90, that states, that the instrument startup is complete.

Usage: Query only

:SYSTem:REBoot

Restarts the firmware and the operating system.

Usage: Event

:SYSTem:RESTart

Restarts the firmware. The operating system remains active.

Usage: Event

:SYSTem:SECurity:NETWork:AVAHi[:STATe] <SecPassWord>, <AvahiState>

Disables the Avahi service for automatic configuration of the instrument in a network.

Parameters:
<AvahiState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example"To disable the LAN interface and LAN services"
on page 533.

:SYSTem:SECurity:NETWork:FTP[:STATe] <SecPassWord>, <FtpState>

Disables FTP protocol for file transfer between the instrument and host.

Parameters:
<FtpState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.
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Example: See Example"To disable the LAN interface and LAN services"
on page 533.

:SYSTem:SECurity:NETWork:HTTP[:STATe] <SecPassWord>, <HttpState>

Disables control of the instrument over HTTP, the protocol for hypermedia information
systems.

Parameters:
<HttpState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example"To disable the LAN interface and LAN services"
on page 533.

:SYSTem:SECurity:NETWork:RAW[:STATe] <SecPassWord>, <RawState>

Disables the LAN interface for remote control of the instrument over raw socket port.

Parameters:
<RawState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example"To disable the LAN interface and LAN services"
on page 533.

:SYSTem:SECurity:NETWork:REMSupport[:STATe] <NetRemSupport>

Disables communication over SSH (SCP) for service purposes.

Parameters:
<NetRemSupport> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 1)

Example: See Example"To disable the LAN interface and LAN services"
on page 533.

:SYSTem:SECurity:NETWork:RPC[:STATe] <SecPassWord>, <RpcState>

Enables the LAN interface for remote control of the instrument via remote procedure
calls (RPC).

Parameters:
<RpcState> 1 | ON | 0 | OFF
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Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example"To disable the LAN interface and LAN services"
on page 533.

:SYSTem:SECurity:NETWork:SMB[:STATe] <SecPassWord>, <SmbState>

Disables access to the file system, printers and serial ports in a network over SMB.

Parameters:
<SmbState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example"To disable the LAN interface and LAN services"
on page 533.

:SYSTem:SECurity:NETWork:SOE[:STATe] <SecPassWord>, <SoeState>

Disables control of the instrument over LAN using SCPI commands.

Parameters:
<SoeState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example"To disable the LAN interface and LAN services"
on page 533.

:SYSTem:SECurity:NETWork:SSH[:STATe] <SecPassWord>, <SshState>

Disables control of the instrument over LAN using the SSH network protocol.

Parameters:
<SshState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example"To disable the LAN interface and LAN services"
on page 533.
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:SYSTem:SECurity:NETWork:SWUPdate[:STATe] <SecPassWord>,
<SwUpdateState>

Disables software update over LAN.

Parameters:
<SwUpdateState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example"To disable the LAN interface and LAN services"
on page 533.

:SYSTem:SECurity:NETWork[:STATe] <SecPassWord>, <LanStorState>

Disables the LAN interface in general, including all services.

Parameters:
<LanStorState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.
The default password is 123456.

Example: See Example"To disable the LAN interface and LAN services"
on page 533

Manual operation: See "LAN Interface" on page 285

:SYSTem:SHUTdown

Shuts down the instrument.

Usage: Event

:SYSTem:STARtup:COMPlete?

Queries if the startup of the instrument is completed.

Return values: 
<Complete> 0 | 1 | OFF | ON

*RST: 0

Example: SYST:STAR:COMP?
// 1
// the startup of the instrument is completed

Usage: Query only
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:SYSTem:PROTect<ch>[:STATe] <State>[, <Key>]

Activates and deactivates the specified protection level.

Suffix: 
<ch>

.
Indicates the protection level.

Parameters:
<State> select

*RST: n.a. (factory preset: 1)

Setting parameters: 
<Key> integer

The respective functions are disabled when the protection level
is activated. No password is required for activation of a level. A
password must be entered to deactivate the protection level.
The password for the first level is 123456.

Example: // to activate protection level
SYSTem:PROTect1:STATe 1
// internal adjustments or hostname cannot be changed
// to unlock protection level 1
SYSTem:PROTect1:STATe 0,123456
// internal adjustments are accessible

:SYSTem:TIME:ZONE <TimeZone>

Sets the time zone. You can query the list of the available time zones with :SYSTem:
TIME:ZONE:CATalog?.

Parameters:
<TimeZone> string

Manual operation: See "Time Zone" on page 294

:SYSTem:TIME:ZONE:CATalog?

Querys the list of available time zones.

Return values: 
<Catalog>

Usage: Query only

Manual operation: See "Time Zone" on page 294

:SYSTem:OSYStem?

Queries the operating system of the instrument.

Return values: 
<OperSystem> string
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Example: SYSTem:OSYStem?
Response: "Linux"

Usage: Query only

:SYSTem:UPTime?

Queries the up time of the operating system.

Return values: 
<UpTime> "<ddd.hh:mm:ss>"

Example: SYSTem:UPTime?
Response: "0.08:11:00"

Usage: Query only

:SYSTem:MMEMory:PATH:USER?

Queries the user directory, that means the directory the instrument stores user files on.

Return values: 
<PathUser> string

Example: SYSTem:MMEMory:PATH:USER?
Response: "/var/user/"'

Usage: Query only

:SYSTem:SECurity:VOLMode[:STATe] <SecPassWord>, <MmemProtState>

Activates volatile mode, so that no user data can be written to the internal memory per-
manently.

To enable volatile mode, reboot the instrument. Otherwise the change has no effect.

Parameters:
<MmemProtState> 0 | 1 | OFF | ON

*RST: 0

Setting parameters: 
<SecPassWord> string

Current security password
The default password is 123456.

Example: SYSTem:SECurity:VOLMode:STATe "123456", 1
SYSTem:REBoot

Manual operation: See "Volatile Mode" on page 285
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10.17  TEST subsystem

The TEST system contains the commands for performing test routines.

Self tests return a "0", if the test is performed successfully, otherwise a value other than
"0" is returned. None of the commands of this system have an *RST value.

:TEST:ALL:STARt...........................................................................................................551
:TEST:ALL:RESult?........................................................................................................551
:TEST:KEYBoard[:STATe]............................................................................................... 551
:TEST:BBIN?................................................................................................................. 551
:TEST:BB:CONNection?................................................................................................. 552
:TEST:EIQMode.............................................................................................................552

:TEST:ALL:STARt

Starts the selftest. Use the command :TEST:ALL:RESult? to query the result.

Usage: Event

Manual operation: See "Start Selftest" on page 297

:TEST:ALL:RESult?

Queries the result of the performed selftest. Start the selftest with :TEST:ALL:STARt.

Return values: 
<Result> 0 | 1 | RUNning | STOPped

*RST: STOPped

Usage: Query only

Manual operation: See "Start Selftest" on page 297

:TEST:KEYBoard[:STATe] <State>

Enable/disable keyboard and LED test state.

Parameters:
<State> 1 | ON | 0 | OFF

:TEST:BBIN?

This command performs a selftest on the baseband input hardware options. Several
analog diagnostics points are checked to verify the correct function of the module.

Return values: 
<Bbin> 0 | 1 | OFF | ON

Example: TEST:BBIN?
Response: "0" on success, "1" on fail

Usage: Query only
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:TEST:BB:CONNection?

Queries the state of the connection between connectors [USER1] and [USER2].

A 0=PASS response indicates that the connection is established, whereas a response
1=FAIL stands for a faulty connection.

Return values: 
<Connection> 0 | 1 | PASS | FAIL

Usage: Query only

Manual operation: See "Execute Connection Test" on page 297

:TEST:EIQMode <EiqMode>

Triggers a connection test for testing the active external IQ devices.

Parameters:
<EiqMode> IQIN | IQOut

*RST: IQOut

10.18  UNIT subsystem

The UNIT subsystem contains the commands specifying which units are valid if no unit
is indicated in a command. These settings are valid for the entire instrument.

:UNIT:ANGLe <Angle>

Sets the default angle unit for remote control. Does not influence the manual control
parameter units and the display.

Parameters:
<Angle> DEGRee | RADian

*RST: RADian

Example: UNIT:ANGL DEG
sets DEG as a default unit for all commands which determine
angle values.

:UNIT:POWer <Power>

Defines the default unit for power parameters. This setting affects the GUI, as well as
all remote control commands that determine power values.

Parameters:
<Power> V | DBUV | DBM

*RST: DBM
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Example: UNIT:POW V
sets V as a default unit for all commands which determine power
values.

10.19  List of R&S SGT commands
:CALibration:ALL[:MEASure]?....................................................................................................................... 355
:CALibration:FREQuency:TEMPerature?...................................................................................................... 356
:CALibration:FREQuency[:MEASure]?.......................................................................................................... 355
:CALibration:IQModulator:BBANd[:STATe].................................................................................................... 355
:CALibration:IQModulator:FULL?...................................................................................................................356
:CALibration:IQModulator:IQModulator[:STATe]............................................................................................ 356
:CALibration:IQModulator:LOCal?................................................................................................................. 356
:CALibration:IQModulator:TEMPerature?......................................................................................................356
:CALibration:LEVel:TEMPerature?................................................................................................................ 356
:CALibration:LEVel[:MEASure]?.................................................................................................................... 356
:CALibration:ROSCillator:DATA:MODE......................................................................................................... 357
:CALibration:ROSCillator[:DATA]................................................................................................................... 357
:CALibration<hw>:BBIN[:MEASure]?.............................................................................................................355
:CLOCk:INPut:FREQuency?..........................................................................................................................357
:CLOCk:INPut:SLOPe....................................................................................................................................358
:CLOCk:OUTPut:MODE................................................................................................................................ 358
:CLOCk:SYNC[:STATe]?................................................................................................................................358
:CONNector:REFLo:OUTPut......................................................................................................................... 359
:CONNector:USER<ch>:CLOCk:IMPedance................................................................................................ 360
:CONNector:USER<ch>:CLOCk:SLOPe.......................................................................................................360
:CONNector:USER<ch>:OMODe.................................................................................................................. 359
:CONNector:USER<ch>:THReshold............................................................................................................. 360
:CONNector:USER<ch>:TRIGger:IMPedance.............................................................................................. 360
:CONNector:USER<ch>:TRIGger:SLOPe.....................................................................................................360
:DIAGnostic:POINt:CATalog?.........................................................................................................................360
:DIAGnostic[:MEASure]:POINt?.....................................................................................................................361
:FFASt............................................................................................................................................................372
:FORMat:BORDer..........................................................................................................................................361
:FORMat:SREGister...................................................................................................................................... 362
:FORMat[:DATA]............................................................................................................................................ 362
:INITiate<hw>[:POWer]:CONTinuous............................................................................................................ 380
:LOCK?.......................................................................................................................................................... 353
:MEMory:HFRee?.......................................................................................................................................... 370
:MMEMory:CATalog:LENGth?....................................................................................................................... 366
:MMEMory:CATalog?..................................................................................................................................... 366
:MMEMory:CDIRectory..................................................................................................................................366
:MMEMory:COPY.......................................................................................................................................... 367
:MMEMory:DATA........................................................................................................................................... 367
:MMEMory:DATA:UNPRotected.................................................................................................................... 368
:MMEMory:DCATalog:LENGth?.....................................................................................................................370
:MMEMory:DCATalog?...................................................................................................................................369
:MMEMory:DELete.........................................................................................................................................370
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:MMEMory:LOAD:STATe............................................................................................................................... 371
:MMEMory:MDIRectory..................................................................................................................................371
:MMEMory:MOVE..........................................................................................................................................371
:MMEMory:MSIS............................................................................................................................................371
:MMEMory:RDIRectory..................................................................................................................................372
:MMEMory:STORe:STATe............................................................................................................................. 372
:OUTPut:AFIXed:RANGe:LOWer?................................................................................................................ 373
:OUTPut:AFIXed:RANGe:UPPer?.................................................................................................................373
:OUTPut:AMODe........................................................................................................................................... 373
:OUTPut[:STATe]............................................................................................................................................374
:OUTPut[:STATe]:PON...................................................................................................................................374
:PFASt............................................................................................................................................................373
:READ<ch>[:POWer]?................................................................................................................................... 381
:SCONfiguration:MODE.................................................................................................................................374
:SENSe<ch>:UNIT[:POWer]..........................................................................................................................381
:SENSe<ch>[:POWer]:APERture:DEFault:STATe......................................................................................... 382
:SENSe<ch>[:POWer]:APERture:TIMe......................................................................................................... 382
:SENSe<ch>[:POWer]:CORRection:SPDevice:LIST?...................................................................................383
:SENSe<ch>[:POWer]:CORRection:SPDevice:SELect.................................................................................382
:SENSe<ch>[:POWer]:CORRection:SPDevice:STATe.................................................................................. 383
:SENSe<ch>[:POWer]:DISPlay:PERManent:PRIority................................................................................... 383
:SENSe<ch>[:POWer]:DISPlay:PERManent:STATe......................................................................................383
:SENSe<ch>[:POWer]:FILTer:LENGth:AUTO?..............................................................................................384
:SENSe<ch>[:POWer]:FILTer:LENGth[:USER]..............................................................................................384
:SENSe<ch>[:POWer]:FILTer:NSRatio.......................................................................................................... 385
:SENSe<ch>[:POWer]:FILTer:NSRatio:MTIMe..............................................................................................385
:SENSe<ch>[:POWer]:FILTer:SONCe........................................................................................................... 385
:SENSe<ch>[:POWer]:FILTer:TYPE.............................................................................................................. 386
:SENSe<ch>[:POWer]:FREQuency...............................................................................................................386
:SENSe<ch>[:POWer]:LOGGing:STATe........................................................................................................387
:SENSe<ch>[:POWer]:OFFSet......................................................................................................................387
:SENSe<ch>[:POWer]:OFFSet:STATe...........................................................................................................387
:SENSe<ch>[:POWer]:SNUMber?.................................................................................................................387
:SENSe<ch>[:POWer]:SOURce.................................................................................................................... 388
:SENSe<ch>[:POWer]:STATus[:DEVice]?..................................................................................................... 388
:SENSe<ch>[:POWer]:SVERsion?................................................................................................................388
:SENSe<ch>[:POWer]:TYPE?.......................................................................................................................389
:SENSe<ch>[:POWer]:ZERO........................................................................................................................ 389
:SLISt:CLEar:LAN..........................................................................................................................................379
:SLISt:CLEar:USB..........................................................................................................................................379
:SLISt:CLEar[:ALL].........................................................................................................................................380
:SLISt:ELEMent<ch>:MAPPing..................................................................................................................... 380
:SLISt:SCAN:LSENsor...................................................................................................................................378
:SLISt:SCAN:USENsor.................................................................................................................................. 379
:SLISt:SCAN[:STATe].....................................................................................................................................378
:SLISt:SENSor:MAP...................................................................................................................................... 380
:SLISt[:LIST]?.................................................................................................................................................378
:SOURce<hw>:PRESet................................................................................................................................. 354
:STATus:OPERation:CONDition?.................................................................................................................. 530
:STATus:OPERation:ENABle.........................................................................................................................530
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:STATus:OPERation:NTRansition..................................................................................................................530
:STATus:OPERation:PTRansition..................................................................................................................531
:STATus:OPERation[:EVENt].........................................................................................................................530
:STATus:PRESet............................................................................................................................................531
:STATus:QUEStionable:CONDition................................................................................................................531
:STATus:QUEStionable:ENABle.................................................................................................................... 531
:STATus:QUEStionable:NTRansition.............................................................................................................532
:STATus:QUEStionable:PTRansition............................................................................................................. 532
:STATus:QUEStionable[:EVENt]....................................................................................................................532
:STATus:QUEue[:NEXT]?.............................................................................................................................. 532
:SYSTem:COMMunicate:GPIB:LTERminator................................................................................................ 538
:SYSTem:COMMunicate:GPIB:RESource?...................................................................................................538
:SYSTem:COMMunicate:GPIB[:SELF]:ADDRess..........................................................................................539
:SYSTem:COMMunicate:HISLip:RESource?.................................................................................................542
:SYSTem:COMMunicate:NETWork:IPADdress............................................................................................. 539
:SYSTem:COMMunicate:NETWork:IPADdress:MODE..................................................................................539
:SYSTem:COMMunicate:NETWork:MACaddress..........................................................................................539
:SYSTem:COMMunicate:NETWork:RESource?............................................................................................541
:SYSTem:COMMunicate:NETWork:RESTart.................................................................................................540
:SYSTem:COMMunicate:NETWork:STATus?................................................................................................ 540
:SYSTem:COMMunicate:NETWork[:COMMon]:HOSTname......................................................................... 540
:SYSTem:COMMunicate:NETWork[:IPADdress]:DNS...................................................................................540
:SYSTem:COMMunicate:NETWork[:IPADdress]:GATeway........................................................................... 540
:SYSTem:COMMunicate:NETWork[:IPADdress]:SUBNet:MASK.................................................................. 541
:SYSTem:COMMunicate:PCIexpress:RESource?.........................................................................................542
:SYSTem:COMMunicate:SERial:BAUD.........................................................................................................541
:SYSTem:COMMunicate:SERial:PARity........................................................................................................ 541
:SYSTem:COMMunicate:SERial:RESource?.................................................................................................542
:SYSTem:COMMunicate:SERial:SBITs..........................................................................................................542
:SYSTem:COMMunicate:SOCKet:PORT.......................................................................................................543
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:SYSTem:ERRor:CODE[:NEXT]?.................................................................................................................. 536
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:SYSTem:ERRor[:NEXT]?..............................................................................................................................537
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:SYSTem:IDENtification................................................................................................................................. 544
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:SYSTem:LANGuage..................................................................................................................................... 544
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:SYSTem:PRESet.......................................................................................................................................... 354
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:SYSTem:SECurity:NETWork:HTTP[:STATe].................................................................................................546
:SYSTem:SECurity:NETWork:RAW[:STATe]..................................................................................................546
:SYSTem:SECurity:NETWork:REMSupport[:STATe]..................................................................................... 546
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:SYSTem:SHUTdown.....................................................................................................................................548
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:SYSTem:TIME:ZONE:CATalog?...................................................................................................................549
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:UNIT:ANGLe................................................................................................................................................. 552
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[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:COEFficients...................................................497
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:COEFficients:CATalog?...................................498
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:COEFficients:LOAD........................................ 498
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:COEFficients:STORe...................................... 498
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:DETRoughing:COUPling.................................499
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:DETRoughing:FACTor.....................................500
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:DETRoughing:FUNCtion.................................499
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:DETRoughing:PEXPonent..............................500
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:FILE:CATalog?................................................ 496
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:FILE:DATA...................................................... 497
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:FILE:NEW....................................................... 497
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:FILE[:SELect]..................................................496
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:GAIN:POST.....................................................496
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:GAIN:PRE.......................................................496
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:INTerp..............................................................497
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:MODE............................................................. 495
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:PV:FILE:CATalog?...........................................496
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:PV:FILE:DATA.................................................497
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:PV:FILE:NEW................................................. 497
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:PV:FILE[:SELect]............................................ 496
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:SHAPing:SCALe.............................................................496
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:STATe............................................................................. 488
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:TERMination...................................................................492
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VCC:MAX....................................................................... 493
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VCC:MIN.........................................................................493
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VCC:OFFSet...................................................................492
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VCC:VALue:LEVel?........................................................ 493
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VCC:VALue:PEP?.......................................................... 493
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VCC:VALue?...................................................................494
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VOUT:MAX..................................................................... 490
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VOUT:MIN.......................................................................490
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VPP[:MAX]......................................................................491
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[:SOURce<hw>]:IQ:OUTPut[:ANALog]:ENVelope:VREF.............................................................................. 489
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:MODE..............................................................................................484
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:OFFSet:I.......................................................................................... 484
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:OFFSet:Q........................................................................................ 484
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:PRESet............................................................................................481
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[:SOURce<hw>]:IQ:OUTPut[:ANALog]:SETTing:STORe..............................................................................482
[:SOURce<hw>]:IQ:OUTPut[:ANALog]:TYPE............................................................................................... 483
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[:SOURce<hw>]:PULM:DELay...................................................................................................................... 517
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[:SOURce<hw>]:PULM:DOUBle:WIDTh........................................................................................................517
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[:SOURce<hw>]:PULM:TRIGger:EXTernal:IMPedance................................................................................ 519
[:SOURce<hw>]:PULM:TRIGger:EXTernal:SLOPe.......................................................................................519
[:SOURce<hw>]:PULM:TRIGger:MODE....................................................................................................... 520
[:SOURce<hw>]:PULM:WIDTh......................................................................................................................520
*CLS...............................................................................................................................................................349
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11  Waveform and list format
The R&S SGT uses a tag-oriented format for externally or internally generated wave-
forms.

A waveform version number is not necessary due to the flexible, tag-based form.

Tags are self-contained information units. Their general format is {Name: Data} or
{Name-Length: Data}. The colon separates the name part and the data part. The
colon can be followed by a space for the sake of legibility.

The Name identifies the tag. It is always expressed in capital letters.

The Data is tag-specific, and usually it is in ASCII plain text.

The Length specifies the number of bytes in a WAVEFORM tag, a DATA LIST tag or a
EMPTYTAG (from : to }, ASCII integer).

Each waveform file must begin with the TYPE tag. The sequence of the remaining tags
is arbitrary. For each tag, an indication shows whether it must be included in the file
concerned (mandatory) or can be included (optional).

Unknown tags are not analyzed by the R&S SGT. They are left unchanged, are saved
without an error message and can be read back again.

R&S AMIQ waveforms can also be loaded on the instrument, where they are converted
internally into an R&S SGT waveform.

11.1  Tag description

This section first describes the mandatory TYPE tag which identifies the file and is
always located at the start of the file. The rest of the tags used in the R&S SGT are
then described in alphabetical order. Most tags are valid for all three file types. If a tag
is valid only for a single file type, e.g. only for a waveform, this fact is indicated in the
description.

{TYPE: magic, xxxxxxxx}................................................................................................ 566
{CLOCK: frequency}.......................................................................................................567
{COMMENT: string}........................................................................................................567
{COPYRIGHT: string}..................................................................................................... 567
{DATE: yyyy-mm-dd;hh:mm:ss}....................................................................................... 568
{EMPTYTAG-Length: #EmptySequence}.......................................................................... 568
{LEVEL OFFS: RMSOffset_dB,PeakOffset_dB}................................................................ 569
{SAMPLES: Samples}.................................................................................................... 570
{[TRACE] LIST [#]: Pos0:Val0;Pos1:Val1;...Posx:Valx;...PosN-1:ValN-1}...............................570
{WAVEFORM-Length: #I0Q0I1Q1...IxQx...IN-1QN-1…}......................................................571
{MWV_SEGMENT_COUNT: NumOfSeg}..........................................................................572
{MWV_SEGMENT_LENGTH: SamplesSeg0, SamplesSeg1, …, SamplesSegN-1}............... 572
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{MWV_SEGMENT_START:
SampleStartOffsetSeg0, SampleStartOffsetSeg1, …, SampleStartOffsetSegN-1}....... 572

{MWV_SEGMENT_CLOCK_MODE: Mode}......................................................................573
{MWV_SEGMENT_CLOCK: ClockSeg0, ClockSeg1, …, ClockSegN-1}...............................573
{MWV_SEGMENT_LEVEL_OFFS:

RMSOffs_dBSg0,PeakOffs_dBSg0, …, RMSOffs_dBSgN-1, PeakOffs_dBSgN-1}......574
{MWV_SEGMENT_FILES:

“FileNameSeg0.wv”, “FileNameSeg1.wv”, …, “FileNameSegN-1.wv”}........................574
{MWV_SEGMENTx_COMMENT: text}..............................................................................574
{CONTROL LIST WIDTH4–Length: #m0m1…mx…mM-1}..................................................575

{TYPE: magic, xxxxxxxx}

(mandatory, must be the first tag in the file)

Identifies the file as a valid R&S SGT file. It must be present and must be the first in
the waveform. If a file of the same name already exists on the target medium, it is over-
written.

Setting parameters: 
magic Designates the file type and has the following values:

SMU-WV
A valid R&S SGT waveform.
SMU-MWV
A valid R&S SGT multi-segment waveform.

xxxxxxxx This parameter is an ASCII-coded checksum of the data part of
the WAVEFORM tag in the file.
The checksum for waveforms is used for detecting transmission
errors. If the TYPE tag contains 0 or a non-numeric value for the
checksum, it is ignored.
It is calculated in accordance with the algorithm given below.
'start' is a pointer to the first byte after the '#' character in the
WAVEFORM tag. 'length' is the number of bytes between 'start'
and the closing curly bracket (excluding the latter; 'length' must
be divisible by 4 without a remainder):
UINT32 checksum(void *start, UINT32 length)
{
UINT32 i, result = 0xA50F74FF;
for(i=0; i < length/4; i++)
result = result ^ ((UINT32 *)start)[i];
return(result);
}

Example: {TYPE: SMU-WV,106656}
BB:ARB:WAV:TAG? 'TYPE'
Queries the content of the TYPE tag.
Response: 'SMU-WV,106656'
The waveform is valid.

Tag description
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{CLOCK: frequency}

(mandatory for waveforms)

The tag specifies the clock frequency at which the waveform has to be output, in Hz
(on multi-segment waveforms this tag contains the maximal clock of all segments).

A query of ARB:CLOCk? after loading the waveform returns the value set using the
CLOCK tag. This value can later be altered with the command ARB:CLOCk?.

Example: {CLOCK: 54000000}
BB:ARB:WAV:TAG? 'CLOCK'
Queries the content of the CLOCK tag.
Response: 54000000
The clock frequency is set to 54 MHz.

Usage: Setting only

{COMMENT: string}

The tag contains a plain text ASCII string of arbitrary length. The string is not analyzed
in the R&S SGT. It is used to describe the file. The string is allowed to contain all print-
able ASCII characters except the closing curly bracket.

Example: {COMMENT: File with data for 3GPP enhanced
channels}
BB:ARB:WAV:TAG? 'COMMENT'
Queries the content of the COMMENT tag of the selected wave-
form file.
Response: 'File with data for 3GPP enhanced
channels'
The comment on the waveform reads "File with data for 3GPP
enhanced channels".

Usage: Setting only

{COPYRIGHT: string}

The tag contains an ASCII string of arbitrary length. The string is not analyzed in the
R&S SGT. It is used to store copyright information about the file content.

Example: {COPYRIGHT: Rohde&Schwarz}
BB:ARB:WAV:TAG? 'COPYRIGHT'
Queries the content of the COPYRIGHT tag of the selected wave-
form file.
Response: 'Rohde&Schwarz'
Copyright resides with Rohde&Schwarz.

Usage: Setting only

Tag description
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{DATE: yyyy-mm-dd;hh:mm:ss}

(optional)

The tag contains the date and time at which the file was created. The year must be
expressed as four digits. The instrument does not analyze this tag.

Example: {DATE: 2009-04-02;14:32:12}
BB:ARB:WAV:TAG? 'DATE'
Queries the content of the DATE tag of the selected waveform
file.
Response: '2009-04-02;14:32:12'
The waveform was created on April 2, 2009 at 14 hrs 32 min.

Usage: Setting only

{EMPTYTAG-Length: #EmptySequence}

(mandatory in automatically generated one and multi-segment waveforms)

This tag is empty, i.e. contains no data, and is used as placeholder.

Setting parameters: 
Length An ASCII integer value that specifies the number of bytes in the

EMPTYTAG, i.e. defines the number of bytes from the colon : to
the end brace }
Note: If you change the content of a waveform file, change also
the {EMPTYTAG-Length} value. For example, if you add a tag
or add bytes to a tag, reduce the length by the number of newly
introduced bytes.

EmptySequence An empty sequence containing blanks only. The number of used
blanks is calculated as the difference between the hex
addresses of the {WAVEFORM} tag and the hash sign # in the
{EMPTYTAG}.
The {WAVEFORM} tag always starts at hex address #4000.

Tag description
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Example: {TYPE:SMU-WV, 837236424}
{COPYRIGHT:2003 Rohde&Schwarz SMU}
{DATE:2012-07-11;14:38:01}
{SAMPLES:80000}
{CLOCK:8666666.666666666}
{VECTOR MAX:1.000000038569158}
{LEVEL OFFS:3.333553817875577e-07,0}
{MARKER LIST 1:0:1;1:0;1249:0}
{MARKER LIST 2:0:1;1:0;1249:0}
{MARKER LIST 3:0:1;1:0;1249:0}
{MARKER LIST 4:0:1;1:0;1249:0}
{EMPTYTAG-15947:# ...}
{WAVEFORM-320017:#IQIQIQ...}

The example waveform file contains 436 (0x1b4) bytes before
the # sign in the EMPTYTAG; the hex address of the # sign is
0x1b5. The {WAVEFORM} starts at 0x4000. The EMPTYTAG con-
tains 15946 blanks and has a length of (15946+1) bytes.

Usage: Setting only

{LEVEL OFFS: RMSOffset_dB,PeakOffset_dB}

(recommended for waveforms)

The tag determines the level of the ARB signal in the waveform file. The offset levels
define the offset of RMS and peak value relative to the 16-bit full scale modulation
(-32767 to + 32767) = 0 dB.

Setting parameters: 
RMSOffset_dB Defines the RMS level offset of the signal relative to full scale

ARB signal in the WAVEFORM tag. The offset is defined in ASCII
float format. The value is always positive.
A 3 dB value indicates that the RMS level of the signal is 3 dBs
below the full scale.
full scale = max. amplitude of vector of I/Q samples = |SIQ|max =
sqrt(I2+Q2)max = 0 dB

PeakOffset_dB Defines the peak level offset of the signal relative to full scale for
the ARB signal in the WAVEFORM tag. The offset is defined in
ASCII float format.
The value usually equals 0 dB as usually the I/Q samples
(signed 16-bit integer values) are modulated to full scale: Full
scale = 0 dB = max. amplitude of vector of I/Q samples = |SIQ|
max = sqrt(I2+Q2)max = (215)-1 = 32767.
A positive PeakOffset_dB value indicates that a headroom to
full scale is provided when generating the waveform. A negative
PeakOffset_dB value indicates that overrange is likely for some
samples, i.e. clipping might occur.
The crest factor can be calculated from the two values as fol-
lows:

Tag description
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Crest Factor = |PeakOffset_dB - RMSOffset_dB|
Example: {LEVEL OFFS: 3.45,2}

BB:ARB:WAV:TAG? 'LEVEL OFFS'
Queries the content of the LEVEL OFFS tag of the selected
waveform file.
Response: 3.45,2
The level of the waveform is below full scale, clipping does not
occur.

Usage: Setting only

{SAMPLES: Samples}

(recommended for waveforms)

The tag contains the number of I/Q samples in the waveform in ASCII format.

On multi-segment waveforms, this tag contains the total I/Q samples of all segments.

Example: {SAMPLES: 4333}
BB:ARB:WAV:TAG? 'SAMPLES'
Queries the content of the SAMPLES tag of the selected wave-
form file.
Response: '4333'
The waveform contains 4333 I/Q samples.

Usage: Setting only

{[TRACE] LIST [#]: Pos0:Val0;Pos1:Val1;...Posx:Valx;...PosN-1:ValN-1}

(Optional for waveforms)

The tag contains the data for the marker and control signals in the control list or the
marker signals of ARB waveforms. To select which of these signals is defined,
[TRACE] and the associated number are used. For ARB waveforms, it is only mean-
ingful to define marker signals (on ARB multi-segment waveforms these tags are
ignored).

Setting parameters: 
[TRACE] Specifies the name of the marker or control signal.

You can choose from the following names:
MARKER; BURST; LEVATT; CW MODE; HOP, MAP

[#] Specifies the number, if control signals and marker signals have
the same name. There is a choice between 4 markers and 3
LEVATT signals. The lines LEVATT 1 and LEVATT 2 are needed
for internal purposes. Do not use them.

Pos Specifies the number of the position in the sequence in ASCII
format. The binary state of the marker or of the control signal
changes from 0 to 1 or from 1 to 0.

Tag description
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Val Specifies the binary state of the marker or of the control signal
{0; 1} from Posx to Posx+1 exclusive in ASCII format.

Example: {MARKER LIST 1: 0:0;10:1;20:0;30:1}
BB:DM:CLIS:TAG? 'MARKER LIST 1'
Queries the content of the MARKER LIST 1 tag of the selected
control list file.
Response: '0:0;10:1;20:0;30:1'
The marker setting for samples 0 to 9 = 0 (low), for 10 to 19 = 1
(high) and for 20 to 29 = 0. From sample 30 onward the marker
setting = 1.

Example: {LEVATT LIST 1: 0:0;10:1;20:0;30:1}
BB:DM:CLIS:TAG? 'LEVATT LIST 1'
Queries the content of the LEVATT LIST 1 tag of the selected
control list file.
Response: '0:0;10:1;20:0;30:1'
Level attenuation applies to data values 10 to 19 (high) and from
data value 30 onward.

Usage: Setting only

{WAVEFORM-Length: #I0Q0I1Q1...IxQx...IN-1QN-1…}

(mandatory for waveforms)

The tag contains the actual waveform data or multi-segment waveform data (I/Q
stream).

Setting parameters: 
Length Specifies the number of bytes in a WAVEFORM tag and is calcula-

ted as follows:
Length = Number of I/Q pairs * 4 (2 bytes per I and 2
bytes per Q value) + 1 byte (the length of the #)

IxQx IxQx… represents binary data (16-bit signed integer in 2's com-
plement notation) containing the I and Q component alternately
and starting with the I component. Each component consists of 2
bytes in Little endian format representation, i.e least significant
byte (LSB) first.
The values of the 2 bytes in an I component and a Q component
are in the range 0x0 to 0xFFFF (-32767 to +32767). This value
is transferred to the D/A converter.
This tag is also used to store multi-segment waveforms. The I/Q
streams of the individual waveforms are directly concatenated to
one collectively waveform I/Q stream.
The number of segments and the start offset and length of the
individual segments inside the total waveform I/Q stream is
determined by the additional tags MWV_SEGMENT_COUNT,
MWV_SEGMENT_START, and MWV_SEGMENT_LENGTH.
Further MWV_SEGMENT_... tags are also available, for example
for level and clock information.

Tag description
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Example: One segment waveform
{WAVEFORM-401:#I0,Q0,I1,Q1,I2,Q2,...I99,Q99}
100 I/Q pairs with 4 bytes each are transmitted - none multi-seg-
ment

Example: Multi-segment waveform
{WAVEFORM-1201:
#I0,Seg0,Q0,Seg0,I1,Seg0,Q1,Seg0,...I99,Seg0,Q99,Seg0,I0,Seg1,Q0,Seg1,I1,Seg1,
Q1,Seg1,… I199,Seg1,Q199,Seg1}
2 segments: segment 0 with 100 I/Q pairs; segment 1 with 200
I/Q pairs. Each I/Q pair consists of 2*16 bit = 4 bytes

Usage: Setting only

{MWV_SEGMENT_COUNT: NumOfSeg}

(mandatory for multi-segment waveforms)

The tag contains the number of segments in the multi-segment waveform in ASCII inte-
ger format.

Example: {MWV_SEGMENT_COUNT: 2}
Multi-segment waveform with 2 segments

Usage: Setting only

{MWV_SEGMENT_LENGTH: SamplesSeg0, SamplesSeg1, …, SamplesSegN-1}

(mandatory for multi-segment waveforms)

The tag contains a list of I/Q sample lengths for every segment in the multi-segment
waveform in ASCII integer format.

Example: {MWV_SEGMENT_LENGTH: 100,200}
2 segments: 100 samples in segment 0 and 200 samples in seg-
ment 1.

Usage: Setting only

{MWV_SEGMENT_START:
SampleStartOffsetSeg0, SampleStartOffsetSeg1, …, SampleStartOffsetSegN-1}

(mandatory for multi-segment waveforms)

The tag contains a list of I/Q sample start offsets for every segment in the multi-seg-
ment waveform in ASCII integer format.

Example: {MWV_SEGMENT_START: 0,100}
2 segments with 100 samples in segment 0 and 200 samples in
segment 1.
The start offset of first segment is 0 samples, start offset of next
segment 1 is the sample length of segment 0 = 100 samples.

Usage: Setting only

Tag description
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{MWV_SEGMENT_CLOCK_MODE: Mode}

(mandatory for multi-segment waveforms)

The tag contains a string in ASCII format which supplies the clock rate mode, that was
used for calculation of the multi-segment output waveform.

The tag CLOCK contains always the highest clock rate of all segments.

The tag MWV_SEGMENT_CLOCK contains the clock rates of the individual segments.

Setting parameters: 
Mode UNCHANGED

The segments can have different clock rates.
During the multi-segment calculation, the clock rates of all indi-
vidual original waveforms were taken over unchanged in the
segments of the multi-segment output waveform (no software
resampling is done).
If the segments have different clock rates, there are some
restrictions on signal output, i.e. switching per external trigger
and seamless switching between segments is not possible.
If all segments have already an identical clock rate, this mode is
usually set to HIGHEST.
HIGHEST
All segments have an identical clock rate, which is the highest
clock rate of all original waveforms.
If the original waveform has a lower clock rate, the instrument
upsamples to the highest clock rate when calculating the multi-
segment output waveform.
USER
All segments have an identical clock rate, which is given by the
user.
Note: Only upsampling is allowed, no downsampling.
If the original waveform has a lower clock rate, the instrument
upsamples to the highest clock rate when calculating the multi-
segment output waveform.

Example: {MWV_SEGMENT_CLOCK_MODE: UNCHANGED}
{MWV_SEGMENT_CLOCK_MODE: HIGHEST}
{MWV_SEGMENT_CLOCK_MODE: USER}

Usage: Setting only

{MWV_SEGMENT_CLOCK: ClockSeg0, ClockSeg1, …, ClockSegN-1}

(mandatory for multi-segment waveforms)

The tag contains a list of clock frequencies for every segment in the multi-segment
waveform in ASCII floating point format.

Tag description
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Example: {MWV_SEGMENT_CLOCK: 100e6,80e6}
2 segments: clock of segment 0 is 100 MHz, clock of segment 1
is 80 MHz.
Note: If the segments have different clock frequencies, there are
some restrictions on signal output, i.e. seamless switching
between segments is only possible, if all segments have the
same clock frequency. Software resampling (upsampling) can be
used to bring all segments to the same clock.

Usage: Setting only

{MWV_SEGMENT_LEVEL_OFFS:
RMSOffs_dBSg0,PeakOffs_dBSg0, …, RMSOffs_dBSgN-1, PeakOffs_dBSgN-1}

(mandatory for multi-segment waveforms)

The tag contains a list of level pairs in ASCII floating point format, one pair for every
segment in the multi-segment waveform. The first value of a level pair defines the rms
offset and the second value the peak offset relative to the 16-bit full-scale modulation
(-32767; + 32767) = 0 dB. The meaning of one level value pair is the same as in the
LEVEL OFFS tag for normal waveforms.

Example: {MWV_SEGMENT_LEVEL_OFFS: 3.0,0.0,6.0,0.0}
2 segments: RMS level of segment 0 is 3dB below full scale;
RMS level of segment 1 is 6dB below full scale. Peak level of
both segments is 0 dB full scale.

Usage: Setting only

{MWV_SEGMENT_FILES:
“FileNameSeg0.wv”, “FileNameSeg1.wv”, …, “FileNameSegN-1.wv”}

(optional for multi-segment waveforms)

The tag contains a list of file names for every segment in the multi-segment waveform
in ASCII format.

Example: {MWV_SEGMENT_FILES: "/var/user/sine.wv",
"/var/user/rect.wv"}

Usage: Setting only

{MWV_SEGMENTx_COMMENT: text}

(optional for multi-segment waveforms)

The tag contains a user comment for a specific segment x = [0…NumOfSeg-1] in the
multi-segment waveform in ASCII format.

Example: {MWV_SEGMENT1_FILES: segment 1 contains a QPSK
signal.}

Usage: Setting only

Tag description
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{CONTROL LIST WIDTH4–Length: #m0m1…mx…mM-1}

(optional for waveforms and multi-segment waveforms)

The tag contains a binary marker element stream, which is transmitted synchronously
to the I/Q sample sequence. One marker element 'mx' consists of 4 bit, which are
assigned to the 4 possible marker lines of the instrument (one bit per marker line). One
4-bit marker element is needed for every I/Q sample in the WAVEFORM tag, The number
of marker elements M is equal to the number of I/Q samples. The CONTROL LENGTH
tag has to contain the number of all marker elements M.

Figure 11-1: Marker element in 4-bit binary format bit order

For standard waveforms, the MARKER LIST x tags are a more compact way to define
markers, but in principle this CONTROL LIST WIDTH4 format can also be used
instead of the MARKER LIST x tags.

For multi-segment waveforms, this CONTROL LIST WIDTH4 format is required for
marker definition. The binary marker streams of the individual segments are directly
concatenated (without any gap) to one collectively marker stream.

Setting parameters: 
Length Defines the number of bytes in the CONTROL LIST WIDTH4 tag

in ASCII Format and is calculated as follows:
Length = Size of "#" (1 byte) + Number of marker elements mx *
(4 bit) / (8 bits/byte)
The value is rounded up for byte alignment.

mx Marker element in 4-bit binary format.

Example: {CONTROL LIST WIDTH4-51: #m0m1…mx…m99}
100 marker elements, each marker element with 4 bits

Usage: Setting only

11.2  How to manually create a waveform using tag file for-
mat

The provided example uses a sine function in the I channel and a cosine function in the
Q channel, each with 20 points. The example uses a short program written in the pro-
gramming language C to calculate the sine and cosine values (see Example"C-pro-
gram for creating a waveform file" on page 578). They are saved in the file
SICO.txt. The decimal values in SICO.txt are normalized such that they are

How to manually create a waveform using tag file format
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between –1.0 and +1.0. The data is converted into binary format. The appropriate man-
datory tags are added and the data is packed into the WAVEFORM tag. As result, the
waveform file SICO.wv is generated.

This example follows the general principle of creating of a waveform manually, using
the tag file format. The Figure 11-2 illustrates this general workflow.

Figure 11-2: Principle of creating a waveform manually

The following steps outline how to create the waveform file SICO.wv:

1. Calculate the sine and cosine values, e.g. use the SICO.cpp program.

The result is saved in the file SICO.txt.

Figure 11-3: Contents of SICO.txt: first column Sine (I), second column Cosine (Q)

How to manually create a waveform using tag file format
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2. Convert the values from the file SICO.txt into binary format consisting of 16-bit
signed integer numbers. The numeric range between –1.0 and +1.0 corresponds to
the modulation range of the waveform 16-bit D/A converter of -32767 to +32767.

+1.0 -> 32767 -> = 0x7FFF

0.0 -> 0 -> = 0x0000

-1.0 -> -32767 -> = 0x8001

The Figure 11-4 shows the calculation and conversion steps. The highlighted col-
umns contain the resulting I and Q values represented in Little endian format.

Figure 11-4: I and Q values calculation and conversion

3. Use an ASCII editor which is able to handle binary data. Create and add the follow-
ing mandatory tags before this binary data set can be further processed:
● CLOCK
● LEVEL OFFS
An example of the SICO.wv file contents could be:

{TYPE: SMU-WV, 0}{CLOCK: 10e6}{LEVEL OFFS: 3.010300,0.000000}
0000FF7F8E27BB79 ... 72D8BB79
To simplify the example, the checksum is set to 0, i.e. the instrument does not eval-
uate a checksum.

Tip: The tags TYPE, CLOCK, LEVEL OFFS and WAVEFORM are mandatory for each
waveform. All other tags are optional and can be inserted after the TYPE tag in
arbitrary order.

4. Pack the binary data into a WAVEFORM tag with the described structure.

{WAVEFORM-Length: #I0Q0I1Q1I2Q2 ... InQn}
● Calculate the Length

Length = Number of I/Q pairs * 4 + 1 = 20*4 + 1 = 81 bytes

How to manually create a waveform using tag file format
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● Place the string {WAVEFORM-81:# at the beginning of the data set
● Place the symbol } at the end of the data set

The contents of the waveform file SICO.wv for 20 I/Q pairs is now ready for opera-
tion and reads:
{TYPE: SMU-WV,0}
{CLOCK: 10e6}
{LEVEL OFFS: 3.010300,0.000000}
{WAVEFORM-81:#I0Q0I1Q1...InQn}
Note: There is no readable representation for binary values in this document. This
is why we use the sequence I0Q0I1Q1...InQn to characterize the binary code in
the present example.
The following figure shows this waveform in a data editor.

Example: C-program for creating a waveform file
C-program SICO.cpp for creating the file SICO.txt containing 20 sine and cosine
pairs, converting them into binary data and creating the waveform file SICO.wv.

// SICO.cpp 
// Defines the entry point for the console application

#include "stdafx.h"
#include <stdlib.h>
#include <stdio.h>
#include <math.h>

int _tmain(int argc, _TCHAR* argv[])
{
    const unsigned int samples = 20;
    const float pi = 3.141592654f;
    int i;

// SICO.txt
// Creating the file SICO.txt containing 20 sine and cosine pairs
    float grad, rad;
    FILE *fp;
    fp = fopen("SICO.txt", "w");

How to manually create a waveform using tag file format
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    if (fp == 0)
        return;
    for (i=0; i<samples; i++)
    {
        grad = (360.0f / (float)samples) * (float)i;
        rad = grad * (pi / 180.0f);
        fprintf(fp, "%f %f\n", sin(rad), cos(rad));
    }
    fclose(fp);

// SICO.wv
// Generating a binary data set from the I/Q pairs in the file SICO.txt
// and storing the result to file SICO.wv
    FILE *fp_sour, *fp_dest;
    float i_float, q_float;
    unsigned short i_usint, q_usint;
    fp_sour = fopen("SICO.TXT", "rt");
    if (fp_sour == 0)
        return -1;
    fp_dest = fopen("SICO.WV", "wb");
    if (fp_dest == 0)
    {
        fclose(fp_sour);
        return -1;
    }
    // Write required tags to waveform file
    fprintf(fp_dest, "{TYPE: SMU-WV,0}");
    fprintf(fp_dest, "{CLOCK: 10e6}");
    fprintf(fp_dest, "{SAMPLES: %d}", samples);
    // RMS, Peak
    fprintf(fp_dest, "{LEVEL OFFS: %f,%f}", -1.0f * 20.0f * log10(1.0f/sqrt(2.0f)), 0.0f);
    fprintf(fp_dest, "{WAVEFORM-%d:#", (samples * 4) + 1);
    for (i=0; i<samples; i++)
    {
      // Read I/Q pair from ASCII file
         if (fscanf(fp_sour, "%f %f", &i_float, &q_float) == EOF)
            break;
        // Convert I/Q pair to unsigned short
        i_usint = (unsigned short)floor((i_float * 32767.0) + 0.5);
        q_usint = (unsigned short)floor((q_float * 32767.0) + 0.5);
        // Write converted I/Q pair to waveform file
        fwrite(&i_usint, 2, 1, fp_dest);
        fwrite(&q_usint, 2, 1, fp_dest);
    }
    fprintf(fp_dest, "}");
    fclose(fp_dest);
    fclose(fp_sour);
return 0;
}

How to manually create a waveform using tag file format
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11.3  Editing waveform files

You can edit the internally and externally crated waveform files. The waveform contains
binary and ASCII data.

Consider the following rules while editing files with binary data.

Rules for editing binary data (waveforms, data and control lists)

● Use hex data editor
Always use a hex data editor to edit files containing binary data.
Editing of binary data file with a text editor, even if you only change the ASCII part
of the file, corrupts the file.

● Adapt the length information in the {EMPTYTAG}
If you change the content of a waveform file, you have to change the
{EMPTYTAG-Length} value.
For example, if you add a new tag or add bytes to an existing tag, reduce the
length information by the number of newly introduced bytes.

Editing waveform files
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12  Error messages and troubleshooting
This chapter describes the error messages of the R&S SGT. The error messages are
output in the "Info" line on the screen and entered in the error/event queue of the sta-
tus reporting system.

A great variety of different messages such as status messages, error messages, warn-
ings or information are displayed in the header field of the screen. Some error mes-
sages require that the error must be eliminated before correct instrument operation can
be ensured. The "Info" window with a list of current messages and a detailed descrip-
tion of each message can be opened with the "Info" button (see also Chapter 5.2.1,
"Info dialog", on page 64).

12.1  Status information

The status messages are displayed in the Info line of the R&S SGMA-GUI main panel.
The status information gives the user an overview of the main operating states and set-
tings of the instrument. The states are indicated for information only and do not neces-
sitate any action by the user.

Status Information displayed in the Info line

AttFixed
Attenuator fixed mode is active.
The uninterrupted level settings are made in a fixed range without attenuator switching.
The variation range is set automatically when this mode is activated. The range is dis-
played with the parameter "SGMA-GUI > Instrument Name > Level > Attenuator Fixed
Range".

12.2  Error messages

Messages indicate errors in the instrument. They are displayed in the info line in differ-
ent colors depending on their importance and display duration. Errors (e.g. no calibra-
tion data) are displayed in red, information (e.g. file not found) and warnings in black.
Warnings indicate less significant errors (e.g. the instrument operates outside specified
data).

See also Chapter 5.2.1, "Info dialog", on page 64 and Chapter 5.2.2, "Understanding
the messages in the info bar", on page 65.

12.2.1  Volatile messages

Volatile messages report automatic settings in the instrument (e.g. switching off of
incompatible types of modulation) or on illegal entries that are not accepted by the

Error messages
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instrument (e.g. range violations). They are displayed in the info line on a yellow back-
ground. They are displayed on top of status information or permanent messages.

Volatile messages do not normally demand user actions and disappear automatically
after a brief period of time. They are stored in the history, however.

SCPI command: :SYSTem:ERRor:ALL? and :SYSTem:ERRor[:NEXT]?.

12.2.2  Permanent messages

Permanent messages are displayed if an error occurs that impairs further instrument
operation, e.g. a hardware fault. The error signaled by a permanent message must be
eliminated before correct instrument operation can be ensured.

The message is displayed until the error is eliminated. It covers the status display in
the info line. After error elimination, the message automatically disappears and is also
recorded in the history.

SCPI command: :SYSTem:SERRor?

12.3  SCPI-Error messages

The SCPI error messages are the same in all SCPI instruments. Detailed information
and an overview of all error messages as defined in SCPI standard can be found in the
corresponding documentation.

The errors are assigned negative numbers. The error text being entered into the error/
event queue or being displayed is printed in bold face on the left together with the error
code. Below the error text, there is an explanation as to the respective error.

12.4  Device-Specific error messages

The following table contains all error messages specific for the instrument in alphabeti-
cal order, and an explanation of the error situation. The positive error codes mark the
errors specific of the instrument.

The device-specific error messages set bit 3 in the ESR register.

The index provides a list of the error messages sorted according to their error codes.

Device-Specific error messages
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Error
Code

Error Description Remedy

180 Adjustment failed Adjustment could not be executed The adjustment data have to be
generated first by an internal or
external adjustment or to be loa-
ded into the device.

182 Adjustment data miss-
ing

Adjustment data are missing. The adjustment data have to be
generated first by an internal or
external adjustment or to be loa-
ded into the instrument.

183 Adjustment data inva-
lid

Adjustment data are invalid and must
be restored.

The adjustment data have to be
generated again by an internal or
external adjustment or to be loa-
ded into the instrument.

200 Cannot access hard-
ware

The data transmission to a module
was unsuccessful.

The module is not installed, not
properly installed or missing.

201 Hardware revision out
of date

A later version of certain parts of the
instrument is necessary to execute
the function selected.

The driver does not support the
installed version of a module.

202 Cannot access the
EEPROM

An error occurs when writing or read-
ing a EEPROM.

The EEPROM can be defective
and requires replacement.

203 Invalid EEPROM data   

204 Driver initialization
failed

Initialization of a driver fails when
booting the instrument firmware.

The driver is not compatible with
the hardware or software config-
uration of the instrument.

241 No current list There is no list selected. To execute the required opera-
tion, a list has to be selected in
the related dialog. If no list is
available, a new list must be cre-
ated.

242 Unknown list type
specified

The list type selected is not valid for
the required operation.

For instance, the file extension for
mapping files is *.map. It is not possi-
ble to enter another file extension
when selecting a list.

Check the selected list type.

460 Cannot open file The selected file cannot be opened. Check the path and file name.

461 Cannot write file The file cannot be written. Check if the file is read-only.

462 Cannot read file The file cannot be read. Check if the file contents are
compatible with the file type.

463 Filename missing The required operation cannot be
executed because the file name is not
specified.

A file name has to be entered
when creating a list.

464 Invalid filename exten-
sion

The file extension is not valid for the
required operation.

Check the file extension.

For instance, the file extension
for the mapping files is *.map. It
is not possible to enter another
file extension when storing a list.

Device-Specific error messages
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Error
Code

Error Description Remedy

465 File contains invalid
data

The selected file contains data that is
not valid for the file type.

Check the file extension.

The file extension determines the
data that is valid for this file type.
If the file extension is changed,
the lists are no longer recognized
and the data are therefore inva-
lid.

468 Cannot find directory Required folder cannot be found. Check drive and path.

469 No files found Folder is empty  

12.5  Contacting customer support

Technical support – where and when you need it

For quick, expert help with any Rohde & Schwarz product, contact our customer sup-
port center. A team of highly qualified engineers provides support and works with you
to find a solution to your query on any aspect of the operation, programming or applica-
tions of Rohde & Schwarz products.

Contact information

Contact our customer support center at www.rohde-schwarz.com/support, or follow this
QR code:

Figure 12-1: QR code to the Rohde & Schwarz support page

Contacting customer support

https://www.rohde-schwarz.com/support
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13  Transporting
Lifting and carrying

See:
● "Lifting and carrying the product" on page 12
● Chapter 3.1.1, "Lifting and carrying", on page 18.

Packing

Use the original packaging material. It consists of antistatic wrap for electrostatic pro-
tection and packing material designed for the product.

If you do not have the original packaging, use similar materials that provide the same
level of protection. You can also contact your local Rohde & Schwarz service center for
advice.

Securing

When moving the R&S SGT in a vehicle or using transporting equipment, make sure
that the R&S SGT is properly secured. Only use items intended for securing objects.

Transport altitude

Unless otherwise specified in the data sheet, the maximum transport altitude without
pressure compensation is 4500 m above sea level.
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14  Maintenance, storage and disposal
The product does not require regular maintenance. It only requires occasional clean-
ing. It is however advisable to check the nominal data from time to time.

14.1  Cleaning

How to clean the product is described in "Cleaning the product" on page 13.

Do not use any liquids for cleaning. Cleaning agents, solvents, acids and bases can
damage the front panel labeling, plastic parts and display.

14.2  Storage

Protect the product against dust. Ensure that the environmental conditions, e.g. tem-
perature range and climatic load, meet the values specified in the data sheet.

14.3  Disposal

Rohde & Schwarz is committed to making careful, ecologically sound use of natural
resources and minimizing the environmental footprint of our products. Help us by dis-
posing of waste in a way that causes minimum environmental impact.

Disposing of electrical and electronic equipment

A product that is labeled as follows cannot be disposed of in normal household waste
after it has come to the end of its life. Even disposal via the municipal collection points
for waste electrical and electronic equipment is not permitted.

Figure 14-1: Labeling in line with EU directive WEEE

Rohde & Schwarz has developed a disposal concept for the eco-friendly disposal or
recycling of waste material. As a manufacturer, Rohde & Schwarz completely fulfills its
obligation to take back and dispose of electrical and electronic waste. Contact your
local service representative to dispose of the product.

Disposal



Telnet program examplesR&S®SGT100A

587User Manual 1176.8674.02 ─ 12

Annex
A  Telnet program examples

The following program example shows a simple TcpClient class that is intended to
explain on how to get started with programming of sockets.

The example sets up a socket communication to R&S SGT and opens a simple user
interface, very similar to the telnet, which allows input of commands. To enable real
automation, further development of the program is required.

TcpClient.h

#include <string>
//defines structs for socket handling
#include <netinet/in.h>
using namespace std;
typedef struct sockaddr_in SockAddrStruct;
typedef struct hostent     HostInfoStruct;
class TcpClient
{
  public:
    TcpClient();
    ~TcpClient();
    void connectToServer( string &hostname, int port );
    void disconnect( );
    void transmit( string &txString );
    void receive( string &rxString );
    string getCurrentHostName( ) const;
    int    getCurrentPort( ) const;
  private:
    string           currentHostName;
    int              currentPort;
    int              currentSocketDescr;
    SockAddrStruct   serverAddress;
    HostInfoStruct * currentHostInfo;
    bool             clientIsConnected;
    int              receiveBufferSize;
};

TcpClient.cpp

#include <string>
//defines structs for socket handling
#include <netinet/in.h>
using namespace std;
typedef struct sockaddr_in SockAddrStruct;
typedef struct hostent     HostInfoStruct;
class TcpClient
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{
  public:
    TcpClient();
    ~TcpClient();
    void connectToServer( string &hostname, int port );
    void disconnect( );
    void transmit( string &txString );
    void receive( string &rxString );
    string getCurrentHostName( ) const;
    int    getCurrentPort( ) const;
  private:
    string           currentHostName;
    int              currentPort;
    int              currentSocketDescr;
    SockAddrStruct   serverAddress;
    HostInfoStruct * currentHostInfo;
    bool             clientIsConnected;
    int              receiveBufferSize;
};

#include <netdb.h>
#include <netinet/in.h>
#include <unistd.h>
#include "TcpClient.h"
TcpClient::TcpClient()
: currentHostName( "" )
, currentPort( 0 )
, currentSocketDescr( 0 )
, serverAddress ( )
, currentHostInfo( NULL )
, clientIsConnected( false )
, receiveBufferSize( 1024 )
{
}
TcpClient::~TcpClient()
{
  currentHostInfo = NULL;
}

void TcpClient::connectToServer( string &hostname, int port )
{
  currentHostInfo = gethostbyname( hostname.c_str( ) );
  if( currentHostInfo == NULL )
  {
    currentHostName   = "";
    currentPort       = 0;
    currentHostInfo   = NULL;
    clientIsConnected = false;
    printf("error connecting host\n" );
  }
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  currentHostName = hostname;
  currentPort     = port;
  currentSocketDescr = socket(AF_INET, SOCK_STREAM, 0);
  if( currentSocketDescr == 0 )
  {
    currentHostName   = "";
    currentPort       = 0;
    currentHostInfo   = NULL;
    clientIsConnected = false;
    printf("can't create socket\n" );
  }
  serverAddress.sin_family = currentHostInfo->h_addrtype;
  serverAddress.sin_port   = htons( currentPort );
  memcpy( (char *) &serverAddress.sin_addr.s_addr, 
  currentHostInfo->h_addr_list[0], currentHostInfo->h_length );
  if( connect( currentSocketDescr, ( struct sockaddr *) &serverAddress, 
  sizeof( serverAddress ) ) < 0 )
  {
   throw string("can't connect server\n" );
  }
  clientIsConnected = true;
}
void TcpClient::disconnect( )
{
  if( clientIsConnected )
  {
    close( currentSocketDescr );
  }
  currentSocketDescr = 0;
  currentHostName    = "";
  currentPort        = 0;
  currentHostInfo    = NULL;
  clientIsConnected  = false;
}
void TcpClient::transmit( string &txString )
{
  if( !clientIsConnected )
  {
  throw string("connection must be established before any data can be sent\n");
  }
  char * transmitBuffer = new char[txString.length() +1];
  memcpy( transmitBuffer, txString.c_str(), txString.length() );
  transmitBuffer[txString.length()] = '\n'; //newline is needed!
  if( send( currentSocketDescr, transmitBuffer, txString.length() + 1, 0 ) < 0 )
  {
    throw string("can't transmit data\n");
  }
  delete [] transmitBuffer;
}
void TcpClient::receive( string &rxString )
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{
  if( !clientIsConnected )
  {
  throw string("connection must be established before any data can be received\n");
  }
  char * receiveBuffer = new char[receiveBufferSize];
  memset( receiveBuffer, 0, receiveBufferSize );
  bool receiving = true;
  while( receiving )
  {
    int receivedByteCount = recv( currentSocketDescr, 
    receiveBuffer, receiveBufferSize, 0 );
    if( receivedByteCount < 0 )
    {
      throw string("error while receiving data\n");
    }
    rxString += string( receiveBuffer );
    receiving = ( receivedByteCount == receiveBufferSize );
  }
  delete [] receiveBuffer;
}
string TcpClient::getCurrentHostName( ) const
{
  return currentHostName;
}
int TcpClient::getCurrentPort( ) const
{
  return currentPort;
}

TelnetClient.cpp

#include <iostream>
#include "TcpClient.h"
void printUsage()
{
  cout<<"usage: EthernetRawCommand <server-ip> [scpi-command]"<<endl;
}
int main( int argc, char *argv[] )
{
  int errorCode         = 0; //no error
  bool useSingleCommand = false;
  string singleCommand  = "";
  string hostname       = "";
  int    port           = 5025;
  string input          = "";
  TcpClient client;
  switch( argc )
  {
    case 3:
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      useSingleCommand = true;
      singleCommand    = argv[2];
    case 2:
      hostname         = argv[1];
      break;
    default:
        printUsage();
        return(-1);
  }
  try
  {
    client.connectToServer( hostname, port );
    bool terminate = false;
    while( !terminate )
    {
      char buffer[1024];
      if( useSingleCommand )
      {
        input =  singleCommand; //send string
      }
      else
      {
        cin.getline( buffer, 1024 );
        input = buffer;
        if( input == "end" )
        {
          terminate = true;
        }
      }
      if( !terminate)
      {
        client.transmit( input ); //send string
        int qPos = input.find( "?", 0 );
        //receive string only when needed
        if( qPos > 0 )
        {
          string rcStr = "";
          client.receive( rcStr );
          cout << rcStr << endl;
        }
      }
      if( useSingleCommand )
      {
        terminate = true;
      }
    }
  }catch( const string errorString )
  {
    cout<<errorString<<endl;
  }



Telnet program examplesR&S®SGT100A

592User Manual 1176.8674.02 ─ 12

  client.disconnect( );
  return errorCode;
}
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Glossary: References
Symbols

1GP103: Rohde & Schwarz application note 1GP103 "Connecting and Interfacing with
SGMA Instruments" available at:
https://www.rohde-schwarz.com/appnote/1GP103

1GP109: Rohde & Schwarz application note 1GP109 "Remote Emulation with the
R&S®SGT100A SGMA Vector RF Source " available at:
https://www.rohde-schwarz.com/appnote/1GP109

1MA028: Rohde & Schwarz application note 1MA028 "IQWizard IQ-Signal Measur-
ment & Conversion" available at:
https://www.rohde-schwarz.com/appnote/1MA028

R
R&S NRQ6 Power Servoing application sheet: Rohde & Schwarz application sheet
of the power servoing functionality R&S NRQ6-K2 of the R&S NRQ6 available at:
https://www.rohde-schwarz.com/manual/NRQ6

R&S Pulse Sequencer software user manual: Rohde & Schwarz user manual of the
R&S Pulse Sequencer software available at:
https://www.rohde-schwarz.com/manual/pulse-sequencer/

R&S WinIQSIM user manual: Rohde & Schwarz user manual of the R&S WinIQSIM
signal generation software available at:
https://www.rohde-schwarz.com/manual/winiqsim2

 

https://www.rohde-schwarz.com/appnote/1GP103
https://www.rohde-schwarz.com/appnote/1GP109
https://www.rohde-schwarz.com/appnote/1MA028
https://www.rohde-schwarz.com/manual/NRQ6
https://www.rohde-schwarz.com/manual/pulse-sequencer/
https://www.rohde-schwarz.com/manual/winiqsim2
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Adjustment active ............................................................ 223
Adjustment frequency ..................................................... 223
Advanced configuration

LXI ............................................................................ 340
AM/AM predistortion

Normalized data ........................................................216
Shaping table ............................................................ 211

AM/AM, AM/PM
Which DPD applies first ............................................ 205

AM/PM predistortion
Normalized data ........................................................216
Shaping table ............................................................ 211

Analog impairments ........................................................ 157
Analog wideband .............................................................154
Aperture time

Power sensors .......................................................... 252
Append .............................................................................. 99

Sequencing play list .................................................. 103
Append blank .................................................................... 99
Application cards ............................................................... 16
Application notes ............................................................... 16

Apply
Normalized data ........................................................216
Polynomial function ...........................................197, 214

Apply assistant settings ................................................... 114
Apply Assistant Settings ..................................................427
Apply network settings .................................................... 289
ARB multi carrier

Carrier frequency ...................................................... 115
Conflict ...................................................................... 115
Mode ......................................................................... 107

ARB Multi Carrier
conflict .......................................................................421
mode ......................................................................... 420

Arm ..................................................................................123
Arm Trigger ..................................................................... 406
Armed_Auto .................................................................... 121
Armed_Retrigger ............................................................. 121
AttFixed ........................................................................... 581
Auto ................................................................................. 121
Auto level set ...................................................................267
Auto Level Set - Baseband Input .................................... 455
Auto once

Power sensors .......................................................... 251
Power viewer ............................................................ 251

Average level
Power viewer ............................................................ 249

AWGN
Display mode ............................................................ 146

AWGN mode ................................................................... 144

B
Baseband In - Crest-Faktor ............................................. 456
Basics

Fill table ............................................................. 195, 211
Bench top, placing .............................................................19
Bias

Envelope, E .............................................................. 179
I/Q OUT .................................................................... 163
Inverted envelope, E BAR ........................................ 179

Binary data
Edit, rules .................................................................. 580

Bipolar input
DC modulator ............................................................181

Bit energy to noise power density ................................... 148
Brochures .......................................................................... 16

C
Carrier + Interferer

PEP ...........................................................................150
Carrier + Noise

PEP ...........................................................................150
Carrier delay .................................................................... 115
Carrier frequency .............................................................115
Carrier gain ......................................................................115
Carrier graph ................................................................... 116
Carrier index .................................................................... 114
Carrier power .................................................................. 148
Carrier spacing

Depends on .............................................................. 107
Carrier Spacing ............................................................... 420
Carrier start ......................................................................113
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Carrier Start .....................................................................429
Carrier state ............................................................. 113, 115
Carrier State .................................................................... 430
Carrier stop ......................................................................113
Carrier Stop ..................................................................... 429
Carrier table .....................................................................110
Carrier Table Assistant .................................................... 429
Carrier/Noise ratio ........................................................... 147
Carrying the instrument ..................................................... 18
CFR

Algorithm ...................................................................138
Cancellation pulse bandwidth ................................... 141
Channel spacing ....................................................... 140
Desired delta .............................................................138
Filter mode ................................................................ 139
Generate waveform file .............................................138
Maximum filter order ................................................. 141
Maximum iterations ...................................................138
Original ..................................................................... 139
Passband frequency ................................................. 140
Resulting ................................................................... 139
Signal bandwidth ...................................................... 140
State ......................................................................... 138
Stopband frequency ..................................................140

Change password ........................................................... 286
Channel x ........................................................................ 131
Checking the instrument ................................................... 18
Cleaning .......................................................................... 586
Clear

NRP sensor mapping ................................................254
Clear status

Remote ..................................................................... 349
Clipping ........................................................................... 108
Clock Frequency ............................................................... 92
Clock mode ..................................................................... 134
Clock Mode ..................................................................... 403
Clock multiplier ................................................................ 134
Clock Multiplier ................................................................ 403
Clock parameter .............................................................. 133
Clock rate .................................................................... 92, 99
Clock rate mode .............................................................. 100
Clock source ................................................................... 134
Column separator Import/Export - user correction data .. 235
Command sequence

Remote ..................................................................... 352
Comment ...........................................................................97
Computer name .............................................................. 288

Changing .................................................................. 308
CONDition ....................................................................... 332
Configuration list

Multi segment waveform ............................................. 94
Configure instruments

Add instrument ............................................................59
Available instruments .................................................. 57
Clear instrument list .................................................... 57
Delete instrument ........................................................57
Edit instrument ...................................................... 57, 59
Export instrument mapping ......................................... 57
Hostname prefix ..........................................................58
IP address ...................................................................58
New instrument ........................................................... 57
Prefix length ................................................................ 58
Scan ............................................................................57
Scan subnet ................................................................ 58

Confirm password ........................................................... 286
Conflict .....................................................................115, 421
Connected device ........................................................... 265

Connected device - Baseband Input ............................... 456
Connecting

LAN ............................................................................. 22
Power ..........................................................................21
RF ......................................................................... 22, 23

Connector
AC power supply .........................................................35
DIG I/Q ........................................................................36
I ................................................................................... 36
I/Q Bar ........................................................................ 35
I/QI .............................................................................. 35
LAN ............................................................................. 35
LO IN .......................................................................... 36
LO OUT ...................................................................... 36
PCIe ............................................................................ 36
Q ................................................................................. 36
REF IN ........................................................................ 36
REF OUT .................................................................... 36
RF 50Ω ................................................................. 36, 37
USB IN ........................................................................ 36
USER 1/2 .................................................................... 36

Connector mode
USER 1/2 .......................................................... 259, 261

Connectors ........................................................................ 35
Constant I/Q test signal ..................................................... 88
Control list

Edit, rules .................................................................. 580
Coordinates, polynomial

Cartesian, cylindrical .................................................214
Couple I/Q bias ............................................................... 163
Create ........................................................................ 96, 111
Create and load ......................................................... 96, 111
Crest factor

Match ........................................................................ 263
Crest Factor .................................................................... 267
Crest Factor - Basisband In ............................................ 456
Crest factor (I/Q) ............................................................. 156
Crest factor mode ............................................................108
Crest Factor Mode .......................................................... 423
Crest factor reduction

Activating .................................................................. 137
Current frequency ........................................................... 272
Current range without recalculation ................................ 132
Current Range without Recalculation ..............................407
Current segment ............................................................. 125
Customer support ............................................................584
CW frequency ................................................................. 145
CW interferer ................................................................... 144

D
Data list

Edit, rules .................................................................. 580
Data sheets ....................................................................... 16
DC modulator

Bipolar input .............................................................. 181
Characteristics .......................................................... 180
Common voltage mode .............................................180
Driving voltage, peak-to-peak ................................... 182
EMF state ................................................................. 180
Gain .......................................................................... 182
Impedance ................................................................ 180
Input impedance ....................................................... 180
Input termination ....................................................... 180
Supply voltage offset .................................................182
Vcc offset .................................................................. 182
Vpp ........................................................................... 182
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Deactivated licenses ....................................................... 280
Decimal point Import/Export - user correction data ......... 234
Default instrument settings ................................................26
Default settings ......................................................... 91, 105

Digital predistortion ................................................... 204
I/Q output analog .............................................. 162, 177

Default values
Remote ..................................................................... 351

Delay start ....................................................................... 114
Delay Start .............................................................. 421, 427
Delay step ........................................................................114
Delay Step .......................................................................426
Delete ................................................................................ 99

Sequencing list ......................................................... 104
Delete instrument settings ...............................................370
Delta phase ..................................................................... 219
Delta power, delta phase

Shaping table ............................................................ 211
Destination import/export

User correction data ................................................. 235
Detector sensitivity

ALC ........................................................................... 230
Detroughing

Exponent, RF envelope ............................................ 192
Factor, couple with Vcc ............................................. 192
Factor, RF envelope ................................................. 192

Detroughing function
About ........................................................................ 169
Settings ..................................................................... 191

Device ID .........................................................................279
NRP sensor mapping ................................................255

Device identify ................................................... 60, 290, 291
DHCP ................................................................................ 29
DIG I/Q

Connector ................................................................... 36
DIG IQ auto setting ......................................................... 267
Digital attenuation ........................................................... 225
Digital predistortion

Achieved level error .................................................. 206
Enable .......................................................................204
Enable AM/AM, AM/PM ............................................ 206
First AM/AM or AM/PM ............................................. 205
Input/Output crest factor ........................................... 206
Input/Output level ......................................................206
Input/Output PEP ...................................................... 206
Invert correction values .............................................208
Level reference ......................................................... 205
Maximum interactions ............................................... 205
Maximum level error ................................................. 205
Range ....................................................................... 205
RF envelope ............................................................. 186
Static DPD ................................................................ 205

Display
Power sensors .......................................................... 249

Displaying
All messages .............................................................. 76

Disposal .......................................................................... 586
Documentation overview ................................................... 16
Double pulse delay

PULM ........................................................................ 258
DPD

Normalized data ........................................................216
See predistortion, digital ........................................... 198
Shape ....................................................................... 207

Duration
Measurement period external digital signal .............. 263

E
Edit

Binary data ................................................................580
Edit User Correction Data ............................................... 232
Effect of ET

Observing ................................................................. 166
EMF

DC modulator ............................................................180
Emulation language ........................................................ 293
Enable

LAN connection ........................................................ 285
LAN interface ............................................................ 285

ENABle ............................................................................332
Enable registers

Remote ..................................................................... 350
Enter license key ............................................................. 279
Envelope

Select interface type ................................................. 178
Envelope detector ........................................................... 165
Envelope shaping

Settings ..................................................................... 187
Envelope tracking

After predistortion ..................................................... 185
Settings ..................................................................... 184

Envelope Tracking
Envelope shaping ..................................................... 167

Envelope tracking power amplifiers tests ........................ 162
Envelope voltage

Reference ................................................................. 179
Set by Vcc .................................................................179
Value range ...............................................................179

Envelope voltage Vout .................................................... 165
Error

Key ..............................................................................34
Error message

Query interrupted ...................................................... 345
Resource locked ....................................................... 345

Error messages ............................................................... 581
Adjustment data invalid (183) ................................... 583
Adjustment data missing (182) ................................. 583
Adjustment failed (180) ............................................. 583
Cannot access hardware (200) .................................583
Cannot access the EEPROM (202) .......................... 583
Cannot open file (460) .............................................. 583
Cannot read file (462) ............................................... 583
Cannot write file (461) ...............................................583
Driver initialization failed (204) ..................................583
Driver invalid EEPROM data (203) ........................... 583
File cannot find directory (468) ................................. 584
File contains invalid data (465) ................................. 584
Filename missing (463) ............................................ 583
Hardware revision out of date (201) ......................... 583
Invalid filename extension (464) ............................... 583
No current list (241) .................................................. 583
No files found (469) .................................................. 584
SCPI ......................................................................... 582
Unknown list type specified (242) ............................. 583

Error messages - display list ........................................... 537
Error queue ..................................................................... 333
ESE (event status enable register ) ................................ 334
ESR ................................................................................. 330
ESR (event status register) ............................................. 334
ET

Suitable ARBB signal ................................................166
EVENt ............................................................................. 332



IndexR&S®SGT100A

597User Manual 1176.8674.02 ─ 12

Event status enable register (ESE) ................................. 334
Remote ..................................................................... 349

Event status register (ESR) .............................................334
Remote ..................................................................... 349

Execute BBIN A/B Selftest .............................................. 551
Execute next segment .....................................................130
Execute Next Segment ................................................... 447
Execute trigger ................................................................ 123
Execute Trigger ............................................................... 406
Expiration date of option ................................................. 276
Exponent

Detroughing, RF envelope ........................................ 192
Export deactivation response .......................................... 279
Export license key ........................................................... 280
Ext. trigger

Gate polarity ............................................................. 260
Input slope ................................................................ 260

Extension Import/Export - user correction data ............... 234
External controller ............................................................. 26
External devices ................................................................ 26
External impedance

Pulse modulation ...................................................... 257
External reference

Input frequency ......................................................... 222

F
Factory preset ................................................................. 295
Factory recovery

See service manual ...................................................311
Fast settings ............................................................ 322, 327
File ...................................................................................115

Exit .............................................................................. 54
Menu ........................................................................... 54
New .............................................................................54
Open ........................................................................... 54
Save ............................................................................54
Save as ....................................................................... 54

File format
DPD, normalized data ...............................................202
DPD, polynomial ....................................................... 200
DPD, table ................................................................ 201
Envelope shaping file, polynomial ............................ 170
Envelope shaping file, table ...................................... 170

File list ............................................................................. 366
File management .............................................................. 91
File size ........................................................................... 430
File, save

Shaping table ............................................................ 195
Fill table

Basics ................................................................195, 211
Fill table range .................................................................236
Fill with sensor list files ....................................................237
Filter

Power sensors .......................................................... 251
Filter cut off frequency .....................................................109
Filter length

Auto .......................................................................... 251
User-defiend ............................................................. 251

Firmware update
Several instruments .................................................. 308

Firmware version .............................................................276
Fix marker delay to current range ........................... 133, 414
Fixed mode

I/Q Out ...................................................................... 163
Floating licenses ............................................................. 276

Frequency
At the RF output ........................................................218
Incl. RF offset .............................................................. 67
Offset ........................................................................ 218
Power sensors .......................................................... 250
Without RF offset ...................................................... 218

Frequency - test signal ARB ............................................117
Frequency offset

ARB .......................................................................... 135
BB IN ........................................................................ 268

Full range ........................................................................ 273
Functional checks ............................................................. 24

G
Gain .................................................................................422

DC modulator ............................................................182
impairment ................................................................ 152

Gain imbalance ............................................................... 152
Gain Imbalance - Baseband In ........................................457
Gain start ......................................................................... 113
Gain step ......................................................................... 113
Gate input polarity ........................................................... 260
Gateway .......................................................................... 289
Generate signal file .......................................... 118, 119, 120
Generate Signal HD ........................................................ 416
Generate Signal HD - Test Signal ................................... 416
Generate Signal HD - Test Signal ARB ........................... 416
Generate signal RAM ...................................... 118, 119, 120
Generate Signal RAM ..................................................... 415
Generate Signal RAM - Test Signal ARB ........................ 415
GPIB ................................................................................312

Characteristics .......................................................... 320
Graphic, ET shaping

Scale ......................................................................... 194
Ground

Termination, DC modulator ....................................... 180

H
Hardware

Requirements ............................................................. 27
Hardware options ............................................................ 275
Help ................................................................................... 16
HiSLIP ............................................................................. 312

Protocol .....................................................................317
Resource string .........................................................316

History ............................................................................... 76
Host name

NRP sensor mapping ................................................254
Hostname ........................................................................ 288

Changing .................................................................. 308
Default ........................................................................ 74

Hotspots
Envelope tracking ..................................................... 184

I
I offset ..............................................................................151
I Offset - Baseband In ..................................................... 458
I value

Test signal const I/Q ................................................. 120
I/Q

Connector ............................................................. 35, 36
I/Q Bar

Connector ................................................................... 35
I/Q delay .......................................................................... 160
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I/Q impairments
Non-linear ................................................................. 198

I/Q modulation ........................................................... 68, 154
Crest factor ............................................................... 156

I/Q modulator
Nonlinearity ............................................................... 198

I/Q output
RF envelope ..................................................... 162, 178

I/Q output analog
Settings ..................................................................... 160

I/Q output type
Differential .........................................................162, 179
Envelope, E ...................................................... 162, 179
Inverted envelope, E BAR ................................ 162, 179
Single ended ..................................................... 162, 179

I/Q phase offset ............................................................... 160
I/Q skew .......................................................................... 159
I/Q swap .......................................................................... 154
I/Q wideband ................................................................... 155
I/Q-Skew - Baseband Input ............................................. 461
I/Q-Swap ......................................................................... 265
I/Q-Swap - Baseband Input ............................................. 457
ID

Key ..............................................................................34
Identification

Remote ..................................................................... 349
Identification mode .......................................................... 293
IDN string ........................................................................ 293
Imbalance ........................................................................159
Imbalance - I/Q analog .................................................... 157
Impairment

Non-linear ................................................................. 198
Impairments analog .........................................................157
Impairments digital .................................................. 159, 465
Import license key ........................................................... 279
Import/Export

User correction data ......................................... 234, 235
Inactive licenses .............................................................. 280
Input

Pulse polarity ............................................................ 257
Input impedance

DC modulator ............................................................180
Input power

Power offset, power amplifier ....................................183
Range, power amplifier ..................................... 184, 209

Input slope
External trigger ......................................................... 260

Input waveform file .......................................................... 114
Install FW ........................................................................ 308
Installed assembly ...........................................................274
Installing

PC, CPU, VGA ............................................................27
R&S SGMA-GUI ......................................................... 27
Requirements ............................................................. 27
Software ......................................................................27
Uninstalling the old version ......................................... 27
Update ........................................................................ 27

Instrument
Carrying ...................................................................... 18
Checking ..................................................................... 18
Lifting .......................................................................... 18
Operating site ....................................................... 18, 19
Unpacking ................................................................... 18

Instrument control ............................................................. 45
Instrument help ................................................................. 16
Instrument name ............................................................... 67

Instrument settings
Recall ................................................................ 351, 371
Save ..................................................................351, 372

Interfaces
GPIB ......................................................................... 320
USB .......................................................................... 319

Internal adjustments
I/Q modulator ............................................................ 273

Internal baseband I/Q in .................................................. 154
Interpolation

Shaping table ............................................................ 208
Interrupt ........................................................................... 335
Invert correction values

AM/AM, AM/PM ........................................................ 208
IP address ......................................................... 67, 288, 316

Changing .................................................................... 29
NRP sensor mapping ................................................254

IP address mode ............................................................. 288
IP configuration

LXI ............................................................................ 340
IST ...................................................................................330
IST flag

Remote ..................................................................... 349

K
Key

ID ................................................................................ 34
LAN ............................................................................. 34
POWER ON/STANDBY .............................................. 33
RF ON .........................................................................33

L
LAN

Configuration .............................................................. 28
Connecting ..................................................................22
Connector ................................................................... 35
Environment ................................................................22
Interface .................................................................... 316
IP address .................................................................316
Key ..............................................................................34
Main services ............................................................ 285
Reset ........................................................................ 338
VXI protocol .............................................................. 318

LAN configuration
LXI ............................................................................ 339

LAN connection
Enable .......................................................................285
Reset address mode .................................................288

LAN interface
Enable .......................................................................285

LAN status .......................................................................291
Leakage .......................................................................... 159
Leakage - I/Q digital ........................................................ 463
LED

ERROR / WARNING ...................................................34
REF EXT .....................................................................33

Level
I/Q output signal ........................................................163
RF output ............................................................ 68, 224

Level limit ........................................................................ 227
Level mode ......................................................................100
Level mode - ARB ........................................................... 442
Level offset

Power sensors .......................................................... 250
State (power sensors) ...............................................250
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Level range
RF output .................................................................. 226

License for software option ............................................. 276
License key ..................................................................... 276
Lifting the instrument ......................................................... 18
Linear function

About ........................................................................ 168
Settings ..................................................................... 192

Linux ..................................................................................26
LO

Coupling source ........................................................ 303
LO IN

Connector ................................................................... 36
LO OUT

Connector ................................................................... 36
Load instrument settings ......................................... 351, 371
Load list ............................................................................. 96
Load waveform ..................................................................91
Loaded modules ..............................................................276
Local oscillator ................................................................ 219

Coupling source ........................................................ 303
Source ...................................................................... 220

Look up table, LUT
Enabling, settings ..................................................... 187

Lost LAN connection to an instrument ............................ 288
LucasFonts

RSCorpid EULA ........................................................ 276
LXI

Advanced configuration ............................................ 340
configuration ............................................................. 337
IP configuration ......................................................... 340
LAN configuration ..................................................... 339
Ping ...........................................................................341
Remote trace (SCPI) ................................................ 342
Reset (LCI) ............................................................... 338

M
Maintenance ....................................................................586
Managing files ................................................................... 50
Manual Trigger ................................................................ 406
Marker CH x .................................................................... 412
Marker mode ................................................................... 131
Marker x delay .................................................................132
Matching

Crest factor ............................................................... 263
Maximum overall output voltage ..................................... 161
Measured external clock ................................................. 134
Measurement period

How long ................................................................... 263
Measurement Period ....................................................... 267
Measurement Period - Baseband Input .......................... 458
Memory effects

Preventing, settings .................................................. 185
Message ............................................................................64

Additional information ................................................. 75
All messages .............................................................. 76
Brief ............................................................................ 76
Deleting .......................................................................76
Deleting all .................................................................. 76
Deleting brief ...............................................................76
Displaying ................................................................... 76
Error ............................................................................ 76

Message level ................................................................... 64
MIPI Alliance

Conform ET signal .................................................... 181

Mode ....................................................................... 107, 420
I/Q Out ...................................................................... 163
PULM ........................................................................ 258
Pulse modulation ...................................................... 258
RF level .....................................................................226
User correction data ................................................. 234

Mode IP address ............................................................. 288
Modulation I/Q ................................................................. 154
Monitoring

Collisions .................................................................. 345
Same remote channel ...............................................345

Mounting, in a rack ............................................................ 20
Multi segment table ........................................................... 98
Multiplier .......................................................................... 403

N
Network

Environment ................................................................22
Network settings ..............................................................286
New instrument

Scan ............................................................................72
Search ........................................................................ 72

New list ..............................................................................96
New password .................................................................286
Next segment .................................................................. 126
Next segment mode ........................................................ 126
Noise bandwidth

AWGN ....................................................................... 146
Noise only ....................................................................... 144
Noise power

System bandwidth .................................................... 148
Total bandwidth ......................................................... 149

Noise ratio
Power sensors .......................................................... 251

Normalized data
File format ................................................................. 202
Pin, max .................................................................... 216
Predistortion ..............................................................210
Save in file ................................................................ 215

NRP power viewer .......................................................... 245
Settings ..................................................................... 247
Use S-Parameter ...................................................... 252

NRP sensor mapping ...................................................... 253
Add LAN sensor ........................................................254
Add sensor ................................................................254
Add USBTMC sensor ............................................... 255
Clear ......................................................................... 254
Connector ................................................................. 254
Device ID .................................................................. 255
Host name ................................................................ 254
IP address .................................................................254
Protocol .....................................................................254
Scan ..........................................................................254
Sensor name .................................................... 254, 255
Serial number ........................................................... 255
Settings ..................................................................... 253

NTRansition .................................................................... 332
Number of carriers ...................................................107, 112
Number of licenses ......................................................... 276

O
Offset ...............................................................157, 225, 241

Envelope, E .............................................................. 164
Frequency ................................................................. 218
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I/Q OUT .................................................................... 164
Inverted envelope, E BAR ........................................ 164

Old password .................................................................. 286
ON/OFF ratio marker ...................................................... 131
ON/OFF Ratio Marker ..................................................... 413
Online help

Working with ............................................................... 47
Open source acknowledgment ..........................................16
Open-source acknowledgments ................................62, 276
Operating site

Choosing .....................................................................18
Setting up the instrument ............................................ 19

Operating system .............................................................. 26
Operation complete

Remote ..................................................................... 350
OPT string ....................................................................... 293
Optimization mode .......................................................... 155
Optimize crest factor ....................................................... 108
Optimize Crest Factor ..................................................... 423
Option

Hardware .................................................................. 275
Software ....................................................................275

Options
Identification (remote) ............................................... 350

OSA ...................................................................................16
Output file .................................................................. 97, 110

Multi segment waveform ............................................. 94
Output frequency .............................................................222
Output queue .................................................................. 330
Output voltage

Envelope detector ..................................................... 179
Output voltage, max

I/Q OUT .................................................................... 161
Overload ..........................................................................268
Overload - Basisband In ..................................................459
Overload Hold ................................................................. 268
Overload Hold - Basisband In ......................................... 459

P
Parallel poll register enable

Remote ..................................................................... 350
PCIe

Connecting ..................................................................31
Connector ................................................................... 36

Peak Level ...................................................................... 267
Peak Level - Baseband Input .......................................... 460
Peak-to-peak driving voltage

DC modulator ............................................................182
Peak-to-Peak voltage

Circuit board ............................................................. 179
PEP

Carrier + Noise ..........................................................150
Period ................................................................................ 99

PULM ........................................................................ 258
Phase offset

ARB .......................................................................... 135
BB IN ........................................................................ 269
I/Q ............................................................................. 160

Phase Offset Q - Test Signal ........................................... 418
Phase offset Q - test signal ARB ..................................... 118
Phase start ...................................................................... 113
Phase Start ..................................................................... 422
Phase step .......................................................................114
Phase Step ......................................................................428
Ping

LXI ............................................................................ 341

Placing, on a bench top .....................................................19
Play list ...................................................... 94, 102, 103, 130
Play list file

Sequencing list file ...................................................... 94
Playlist

See play list ................................................................ 94
Polarity

Pulse modulation ...................................................... 257
Polynomial coefficients

Predistortion ..............................................................210
Polynomial constant

Settings ............................................................. 197, 214
Polynomial function

About ........................................................................ 169
Coefficients ............................................... 193, 197, 214
Coordinates .............................................................. 214
File format ......................................................... 170, 200
Order .................................................................197, 214
Save in file ........................................................ 197, 213
Settings ..................................................................... 196

Polynomial order
Settings ............................................................. 197, 214

Power
Carrier + Interferer .................................................... 150
Carrier + Noise ..........................................................150
Connecting the instrument .......................................... 21
Signal + Interferer ..................................................... 150
Signal + Noise ...........................................................150

Power amplifier
Input power, Pin ................................................ 184, 209
Power offset .............................................................. 183
Supply voltage, Vcc .................................................. 183

Power amplifiers testing
Envelope ........................................................... 162, 178

Power of starting carrier .......................................... 113, 422
Power offset

Cable loss compensation ..........................................183
POWER ON/STANDBY

Key ..............................................................................33
Power reference .............................................................. 110
Power sensors

Activation .................................................................. 249
Aperture time ............................................................ 252
Auto once ..................................................................251
Filter .......................................................................... 251
Filter length ............................................................... 251
Frequency ................................................................. 250
Level (average) ......................................................... 249
Level (peak) .............................................................. 249
Level offset ................................................................250
Noise ratio .................................................................251
Sensor ...................................................................... 249
Serial number ........................................................... 249
Source ...................................................................... 250
State ......................................................................... 249
State (level offset) ..................................................... 250
Timeout ..................................................................... 252
Unit ........................................................................... 249
Update ...................................................................... 247
Use default aperture time ......................................... 252
Zero .......................................................................... 249

Power Sensors
Display ...................................................................... 249

Power servoing ............................................................... 238
About ........................................................................ 239
How to .......................................................................240
Test setup ................................................................. 239
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Power Start ..................................................................... 422
Power Step ......................................................................429
Power viewer

Auto once ..................................................................251
PPE ................................................................................. 330
Predistortion

Digital ........................................................................ 198
Interpolation, shaping table .......................................208
Shaping table ............................................................ 209

Predistortion, digital
AM/AM, AM/PM ........................................................ 198

Preset instrument settings .................................................26
Protection .................................................................. 62, 281
Protocol

VXI ............................................................................ 318
PTRansition .....................................................................332
PULM

Double pulse width ................................................... 258
Mode ......................................................................... 258
Period ....................................................................... 258

Pulse
Length ....................................................................... 258
Width .........................................................................258

Pulse divider marker ....................................................... 131
Pulse Divider Marker ....................................................... 413
Pulse Frequency marker ................................................. 131
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File ............................................................................ 371

Resampling
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Save/recall
Normalized data ........................................................215
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Save/Recall ..................................................................... 106
Digital predistortion ................................................... 205
I/Q output analog .............................................. 162, 178
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Scan
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Error messages ........................................................ 582
Version ...................................................................... 313

SCPI remote trace
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Select ASCII destination

User correction data ................................................. 235
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Selftest ............................................................................ 296
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Settings
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Shaping table
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File format ......................................................... 170, 201
Interpolation ...................................................... 193, 208
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Vin/Vmax, Vcc/Vmax ................................................ 195

Shaping, DPD
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Signal Duration Unit - Trigger .......................................... 408
Signal Level (RMS) ......................................................... 469
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Pulse modulation ...................................................... 257
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User correction data ................................................. 235

SRE ................................................................................. 330
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Standard settings ...................................................... 91, 105
Standby ..................................................................... 25, 306
Start delay ............................................................... 114, 421
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Starting gain .................................................................... 113
Starting power ................................................................. 422
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ALC ........................................................................... 230
AM/AM, AM/PM ........................................................ 206
AWGN ....................................................................... 144
Digital predistortion ................................................... 204
I/Q modulation ............................................................ 68
Power sensors .......................................................... 249
Pulse modulation ...................................................... 257
User correction ......................................................... 231

State - Baseband Input ................................................... 462
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State ARB ......................................................................... 90
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Status
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Status byte
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STB ................................................................................. 330
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Time delay, PA
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Trigger
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Unpacking the instrument ................................................. 18
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Update package
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Connecting ..................................................................31
Interfaces .................................................................. 319
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Connector ................................................................... 36
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USER 1/2
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User Clock .......................................................................440
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User correction data ........................................................ 232
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User manual ...................................................................... 16
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IndexR&S®SGT100A

604User Manual 1176.8674.02 ─ 12

V
Value

User correction ......................................................... 231
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Vcc, power amplifier ................................................. 183

Vin/Vmax, Vcc/Vmax
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HiSLIP string ............................................................. 290
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PCIe string ................................................................ 290
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Wait

Remote ..................................................................... 352
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